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Welcome
Welcome to Solution Series – e-MDs’ premier suite of office automation tools!
Solution Series Bill is our full-featured practice management application. It works in
conjunction with the other Solution applications to meet your practice healthcare
records management needs. All applications reside in a common database, with no
data bridges, affording remarkable flow of information from one module to another.
In addition to those fundamental programs, other modules improve workflow
processes, enhance communication, and enable the office to truly operate in a
paperless environment. See the e-MDs Solution Series Utilities Guide for information
on using the following tools:
• DocMan
• TaskMan
• Snapshot (Digicam)
• Forms/Letter Builder
• Spell Checker
• Signatures
• Continuity of Care Records (CCR)
• Continuity of Care Documents (CCD)
Visit us at http://www.e-MDs.com to check out our latest product offerings!

Continued on the next page...
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Using This Guide
This guide provides instructions for working with insurance codes and electronic claims, setting fee
schedules and rules, defining policies, posting and billing transactions and reversals, and performing
numerous other practice management tasks.
As you go through this guide, you will notice that each set of steps to perform a task begins with an
indented heading starting with "To" and ending with a colon (:). That heading is then followed by indented
steps to be performed in a prescribed sequence. For example, after a brief overview of why you may
want to post charges manually, the procedure looks like the contents of the following box:

To use Quick Steps to post charges manually:
1. Open the posting window.
2. Load a patient.
3. Click New Invoice.
4. Enter the diagnosis codes by typing each code, followed by the Enter key.
5. Tab to the CPT/HCPCS tab.
6. Enter charges by typing in known codes followed by pressing the Enter key. If necessary, use
the keyboard shortcuts to include modifiers, diagnosis linking, unit counts or panel codes.
7. Save the invoice.
8. If this entry is an insurance invoice and the Claim Prepare window appears, review and make any
changes necessary then close.
9. Print patient education and/or an invoice/cash receipt if those options were checked.
Note: For this example we streamlined the steps a little for illustration purposes only. See the
appropriate section for the actual, detailed steps.

Related Documentation
Documentation for Solution Series modules is provided in PDF (Portable Document Format) files for
viewing and printing individually, and in Help format for easy access from each product module. Both
formats and access methods provide the same information. The documentation library is updated
extensively for each major product release as well as updated and corrected periodically, as needed. For
the latest version of any Solution Series documentation, go to the documentation section of the e-MDs
Support site at Online Support > Downloads > Documentation.
The following documents are available to all Solution Series users:
•

e-MDs Solution Series Administration Guide is your starting point for initializing and customizing
Solution Series modules for use in your organization. This guide provides step-by-step instructions
for licensing your software, adding system users and defining access levels, adding and modifying
user groups, and setting up default handling of various module tasks.

•

e-MDs Solution Series Chart User Guide leads you from the beginning of an office visit through the
visit conclusion when billing is enabled. Using Chart you can track and code a patients medical
information and provide prenatal, maternity and postnatal care. This guide also details Chart's
prescription processing, lab interfaces, and telephone interactions with patients.

•

e-MDs Formulary Benefits User Guide describes how to determine the pharmacy benefits and drug
copays for a patient’s health plan, determine if a prescribed medication is covered (in formulary)
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under a patient’s plan, display therapeutic alternatives with preference rank (if available) within a drug
class for non-formulary medications, determine if a patient’s health plan allows electronic prescribing
to mail order pharmacies, and download a historic list of all medications prescribed for a patient by
any provider.
•

e-MDs Solution Series Installation and Upgrade Guide leads you through the preparation of your site
for Solution Series, the database and application installation steps, and post-installation configuration.
If Solution Series is already installed at your facility, use the update instructions provided to update
your system.

•

e-MDs Solution Series Schedule User Guide leads you through scheduling and tracking
appointments, setting up and modifying patient accounts, blocking time on the calendar to restrict
appointment scheduling, checking patients into the facility and tracking their progress through each
encounter with a provider, and checking eligibility.

•

e-MDs Solution Series Reports User Guide lists the reports available through Solution Series. A
description of each report is provided, along with the location of the report within Solution Series
modules, the available fields and filters used to select specific data for the report, and samples of
most reports, illustrating what you can expect when running a report at your facility.

•

e-MDs Solution Series Utilities Guide covers tools and utilities that may be used with various Solution
Series modules. This includes using:
○ DocMan to graph lab results, process incoming faxes, and generate and send documents to
patients and external resources such as specialist referrals and labs.
○ TaskMan to automatically send messages, implement secure e-mail, and track tasks to be
performed within Solution Series.
○ Snapshot/Digicam to capture images of patients/staff and add them to patient and user
records.
○ Forms/Letter Builder to generate, print and send forms and letters from within Solution
Series. This includes the use of Microsoft Word and the e-MDs database to create
customized/merged letters and documents.
○ Registry Processor to create, view, distribute and print customized reports based on patient
demographics and healthcare records.

Additional documentation is also available on the e-MDs Support site for performing specific tasks and for
using e-MDs interface products for working with labs and other organizations. See the e-MDs Support
site for access to the latest versions of these documents.

Getting Additional Help and Information
e-MDs realizes that one of the most important elements of any software system is the support services
backing it up. There are a number of support resources available to help you optimize the use of your
system and participate in the e-MDs community.

Help Screens
Help is accessible on each Solution Series application and module by going to Help > Search Topic on
each application's top toolbar. Related help files, such as this guide, the Utilities Guide, and the Reports
User Guide, are generally accessible from the same help screen. After opening each help file, you can
use the table of contents, index or search function to locate the specific information you need.
Online Help files are also available through the application toolbar for Portal applications by clicking the
question mark. The following Help is available for the Portal application:
•

e-MDs Patient Portal: The Clinic’s Guide to Using the Portal provides instructions for maintaining
user access on a Patient Portal, working with patient appointments scheduled through the Portal,
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communicating with patients through a Portal e-mail interface, processing prescription refill
requests, and auditing Patient Portal usage.
•

e-MDs Patient Portal: The Patient’s Guide to Using the Portal instructs patients on the use of the
Patient Portal to communicate with their healthcare provider, view their own healthcare
information, and submit requests for appointments and prescription refills. This HTML file is
provided on your Patient Portal for easy online viewing or printing by patients.

User Guides
The e-MDs Solution Series user guides contain comprehensive information about all standard product
functions. This includes dealing with many of the complex situations that can arise in a medical office.
Use the table of contents, index or search option to locate items of particular interest. These guides are
very similar to the application help screens. See "Related Documentation" for a brief description of the
Solution Series user guides available.
Solution Series guides are always available in electronic format (Adobe .pdf files). You can put copies on
each computer in the network. You can download the Adobe Acrobat Reader for free from
www.adobe.com Updated user guides are included on the CD-ROMs you will receive with each upgrade,
as well as on the support pages at www.e-mds.com.
To download files from the e-MDs Support site, you will need your clinic password. Instructions on how to
apply for a password are on the Web site. Only one password is issued per customer account, so please
ensure you communicate this to your staff.

Using the e-MDs Support Center
The e-MDs Support Center is an online customer meeting place for clients with an active account. It is
accessed from the Support pages at www.e-MDs.com or
http://supportcenteronline.com/ics/support/default.asp?deptID=3222 . If you don’t have an account, you
can request one by using the Request New Account button on the login page. We strongly encourage
each staff member in a clinic to have their own logins instead of one generic one for all people. The
primary reason for this is that when we need to push information such as update notifications it is sent to
everyone meaning there is a smaller chance that the information will not be disseminated such as if
someone is sick or ignores the message.
Support Center includes the following tools that can be of great assistance to helping your practice work
more efficiently with the e-MDs Software:
•

Forums/Newsgroups: The online forums are an e-MDs User Community where you can post
messages related to support, general discussions, suggestions, tips and more. It is a great nonurgent support tool and is also searchable. You can subscribe to various forums that interest you
and get an e-mail notification if someone posts to them. You can also elect to get an e-mail if
someone posts to a specific message. This is really useful if you post a question and want to
know when it is answered. Support forums are monitored by the e-MDs support team and a
number of our customers also chip in with their knowledge.

•

Downloads: Downloads include shared templates for Chart, Word Forms, reports, updates to
content such as ICD and CPT codes, bug patches, etc.

•

Knowledge Base: The knowledge base includes an extensive list of articles that you can use for
troubleshooting, setup and so on. These are generally posted based on questions from
customers.

•

Troubleshooter: This search utility makes it easy to quickly locate the information you’re looking
for. It cross-references multiple parts of the support center and returns hyperlinks to articles,
downloads and the like.

•

Surveys: Occasionally e-MDs will gauge your opinions about something via surveys which can
be distributed via Support Center.
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•

“Push” e-mails: If we want to let you know about something, we can push information to you
from Support Center.
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Bill Navigation
Because Bill is such a full function application, we will start off with an overview of
how to navigate Bill to perform practice management tasks such as billing, posting,
and filing insurance claims. This section provides an overview of what you will see as
you move around the Bill application.
Continued on the next page ...
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The Main Window
The main window includes all the visible elements of the e-MDs Bill program. These are:
•

Title Bar: This is the very top line that displays the application name, as well as the facility name.
The right side also includes three buttons for minimizing, maximizing, or closing the application.

•

Menu Bar: These are items that can be clicked to access all functions within e-MDs Bill. Each
separate set of functions in e-MDs Bill is grouped together under menu items.

•

Toolbar: This gives access to many of the commonly visited parts of Bill, as well as to the
Schedule and TaskMan modules.

•

Work Area: This is the large area of the screen in which windows applicable to the function being
performed will appear. Users can size and move these windows to their preference.

•

Status Bar: This is the line at the very bottom of the e-MDs Bill window. It shows the current user
name, as well as the date and time. When using the system, users should ensure that their user
name is displayed since all information and audit trails will be tracked to that user.

Menu Items
The following is a brief description of what users can find under the items in the menu bar. More detailed
help for each entry screen is dealt with in the applicable section of this manual.
Functions can be accessed using keystrokes preceded by the Alt key. Each menu item has an underlined
letter used in conjunction with Alt. Pressing that letter starts the function so you can stay on the keyboard.
This is typically much faster than using a mouse.
Depending upon whether a user is logged in or not, the File menu changes. When logged in, the items in
the following table are available.
File Menu
Security
Options
Medical Facilities

Log Off

Exit

Where users and user groups are set up.
A place where operational preferences can be set.
Where the address, telephone and tax ID for the facility/ies set up within the system
are stored. It is also where users in a multi-facility environment select the one in
which they are currently working. The current active facility is displayed in the
window title bar.
e-MDs Bill tracks all transactions by user. Log On presents the user with a login
window in which they can enter their user ID and password. Log Off disconnects the
current user’s link from the local workstation to the database and grays out most of
the menu items and tool buttons. Users should always log off when they leave their
workstation.
Closes the program and returns the user to the Windows desktop.

Demographics
Demographics give users access to databases within e-MDs Bill. Most of these selections are available
from within other parts of the system because this facilitates a more logical workflow. For example, the
patient file gives interactive access to the referral, guarantor and other databases without requiring the
user to leave the patient registration process.
The system uses an entity structure for all facility and person demographic data types.
Following is a list of the databases that can be accessed from the Demographics menu item:
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•

Patients

•

Guarantors

•

Providers

•

Non-Staff Providers/Referrals

•

Insurance

•

Persons/Contact

•

Employees

•

Organizations

•

Employers

•

External Medical Facilities

Posting
This menu item gives immediate access to the main Posting window where invoices, payments and
adjustments are entered into the system.
Posting Menu
Ledger
Payment Source

Closeout Options

The main Posting window for adjusting invoices and payments.

Payment Source indicate what entity is making a payment. You can select
the Patient Payment button or Insurance Payment button in the posting
window and the type is set automatically in the payment screen.
The posting closeout function is used to close a financial period up to the
date entered and for the facilities selected. Once the closeout is performed
you can not change or add any transactions with a post date up to and
including the date specified.

Claims
Insurance output functions for both paper and electronic claims are accessed under this menu item.
Claims Menu
NSF Definitions

EDI Options
Clearing Houses
e-Claims
Electronic Remittance
e-Claims Batch History

Clearing House Interface

This is an important part of the electronic filing flexibility of e-MDs Bill. The
definitions file controls the structure of the NSF 3.01 format used to send out
electronic claims. WARNING: This selection should only be used by persons with a
strong understanding of the construct of an electronic claim file – changing a field
selection can result in wholesale rejection of claims batches. It should not be altered
or modified unless specifically instructed to do so by e-MDs support staff. For every
element in the NSF electronic file, the definition file contains a field that identifies
that element and its construct. System administrators can control the output of a
claim file by changing some of the constructs of the definitions file.
Provides a data entry screen for entering the electronic control numbers and other
default identification fields for your clinic.
Used to set up clearing houses and direct connections used for claims, remits and
eligibility files.
Used for building electronic claim files before transmitting them to carriers or
clearinghouses.
Access the electronic postback module.
Opens the Batch File History screen to lookup a batch file. The history can also be
accessed through the Rebuild and Reactivate functions in e-Claims by clicking the
browse button.
A utility program which can be configured to simplify transmitting and receiving
claim, remit, eligibility and response files.
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HCFA Definitions & CMS
Definitions
HCFA Wizard
View ANSI File

Administration functions where users can customize the printed data elements in
most fields in the HCFA-1500 (12/90) and CMS-1500 claim forms so as to meet
payor requirements.
Where HCFA-1500 claim form print jobs are activated.
Access a text file viewer. It automatically previews the last ANSI file created and has
search functions related to that claim structure, but can also be used to view any
text file from within e-MDs Bill.

Reports
Almost every report in the system can be printed from the Reports menu. Some can also be printed from
other parts of e-MDs Bill in a more interactive mode where they are called from specific interfaces. See
the e-MDs Reports User Guide for examples of the Bill reports available.

Reference
Reference Menu
Support Tables

ICD Search
CPT Search
HCPCS Search
Code Linker
Modifier
Fee Schedules & Rules
CPT Panel
Revenue Codes
Group Codes

Reason Code
Patient Recall Types
Patient Education
City, State, Zip
Follow Up Action
Invoice Status
Contracts
Policies
Sliding Scales
Poverty Guidelines
Insurance Classes
Specialty

Gives access to various tables used within other data entry processes. These
include payment types accepted by the clinic, zip codes with links to cities, financial
groups, comments, and Type of Service, Place of Service and Specialty codes.
Access the ICD master database and search tool.
Access the CPT master database and search tool.
Access the HCPCS master database and search tool.
A tool for creating linked code sets to improve billing and workflow, particularly for eMDs Solution Series users.
Master modifier database with tools to link to CPT groupings.
Where fee schedules and code-based rules are created.
Where coding shortcuts are created. Also known as burst or explosion codes.
Revenue codes for institutional and rural health billing.
A list of insurance adjustment group codes that can be received from payors on
paper EOB’s or in electronic ERA files. The table conforms to the ANSI X.12 HIPAA
standard. You can delete any entries from the table.
Master table of ANSI adjustment reason codes where users can set default posting
flags.
Where users set up custom recall types.
Access the patient education editor.
Where users can maintain the master table of these codes.
Table of collections follow up actions that are linked to invoices.
Tracking codes that can be linked to invoices automatically or manually.
Insurance contracts.
Policies which comprise a number of trackable requirements which can be linked to
fee schedules and cases.
Practice discount structure based on family income and poverty guidelines.
Federal poverty guidelines table.
Insurance class master table. Insurance classes are a way to aggregate insurances
for reporting and other purposes.
Provider specialty master table.

Tools
Tools Menu
Charge Sets

Can be used to create time saving pre-built invoices for commonly seen visits in
which diagnosis and procedure codes are almost always the same.
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Invoice Payment Due By
Invoice Administration

Superbill, Superbill Audit
Referral/Authorization
Collections
Update Invoice Balances

Update Invoice
Responsibility
Update Invoice Charges
Daily Work List
Schedule
TaskMan
Spell Check Configuration
Patient Case Management

This is a utility allowing users to change the invoice responsibility with a simple
double click of the mouse.
A tool for invoices that allows you to update the status, send or release invoices to
Agency Collections and edit invoices. The filters can be set to search by various
criteria.
Is where you can design and print custom superbills as well as run an audit to
ensure that all printed superbills are accounted for at the end of the day.
A workflow tool for managing referrals.
A workflow tool for managing collections tasks.
A utility that searches through all the invoices in the system. It searches for a nonzero balance, checks the calculation and ensures the responsibility is set correctly.
The utility should be run the night before a statement run, or before running a
detailed accounts receivable report. It is used by some reports for faster
processing.
The same tool as for Invoice Balances, but includes zero balance invoices and takes
longer.
Similar tool to the above two, it verifies total charges on invoices.
Opens the Daily Work List tool, a major work flow utility that gives access to many
parts of the entire e-MDs Solution Series.
Opens e-MDs Schedule.
Opens e-MDs TaskMan.
Where spelling and macro/auto-replace functions are accessed.
The patient case management tool.

Options
Optional selections allow changing the look of toolbar buttons.

Help
Help Menu
Contents
About

Opens the user guide PDF.
Where you can see the current version number of your copy of e-MDs Bill.

Searching for Records
Solution Series provides an extensive search capability in Bill. That includes three main types of search
windows, as well as the procedures for locating records in each database.

Standard Search Window
To complete numerous billing processes, searching for particular records is necessary first. For the most
part, search windows in e-MDs Bill all look much the same. Only the database being searched is different.
The exceptions to the rule are the Insurance Company, and ICD, CPT and HCPCS search windows.
These are laid out slightly differently, but still follow the same search principals.
The top part of each search window contains different search keys that can be used by themselves or
together. Remember that the more filters entered, the more likely the search will not return any matches.
Depending on the database, there are also different functions available from within the search windows,
but all will have options to add new records, edit existing records, and so on.
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To search for records in a database:
1. Navigate to the database you wish to search by selecting the applicable menu items, or function
buttons.
Enter text into the search fields. You can enter all the characters in a name or other field, or some of the
start letters. Person name search fields permit both first and last name searches using a comma to
separate the two. Be sure to enter the last name BEFORE the first name. For example, enter “smith,j” to
search for a patient named John Smith.
Press the Enter key OR click the Search button (usually Alt+S). The system will respond by displaying all
records matching the search string. The process is the same regardless of criteria.
The following table shows typical Search window functions:
Search Options
New
Edit
Delete
Search
Help
Exit

This button does not require a search in advance. Use this button to enter new
records.
Used to load a database record for viewing and editing purposes. To use the button,
click on the record to be edited, then click the Edit button.
Deletes records where possible.
Starts a search based on the search criteria. Press Enter for the same function.
Opens contact-sensitive help if there is a link to the particular window, or the master
help files.
Used after selecting a record to either close the search window, or to use the
selected record in a particular process.

The Patient Search screen has two extra options worth noting.
Patient Search Options
Copy

Used to save time when registering new patients who have other family members
already in the database. Before using this key, search for and highlight the patient
whose record is to be copied. Clicking Copy starts a new record with all common
information already filled out. Only information such as patient first name, date of
birth and social security number needs to be added.

Insurance Company Search Window
The Insurance Company search window is significantly different from others. A special screen is needed
because e-MDs Bill allows users to attach multiple insurance groups to each insurance carrier. Insurance
companies can only be located by name or by address.
To search for an insurance company, enter some of the starting letters of the name or address, and then
click Search Insurance. You can also search for insurance groups linked to companies.

Searching in the Posting Window
The posting window can be used to search for invoices, patients for whom financial transactions need to
be entered, or, in those sites using the integrated e-MDs Chart system, patient visits which are ready to
bill.
The fields at the top of the Posting window are all search options.
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Posting Search Options
Patient Guarantor
Searches

Invoice Searches

e-MDs Chart Visits

These can be conducted in two ways. To search for a patient by name, enter part of
the name into the Patient (Last, First) field, then click Find Patient to search the
patient database. Alternatively, click Last Patient to load the last patient accessed in
any other part of the system using the same computer in the network. It saves
having to search for the same patient. You can also find patients by entering a
known chart number into the Account Number field. To search for a guarantor by
name, either enter part of the name into the Guarantor (Last, First) field and enter,
or the user can select the magnifying glass and the Search Guarantor window
opens with a list of names that matched the user defined criteria. User would then
highlight the appropriate name and click on the select option if the name appeared.
User can select the Add option if a new guarantor needs to be created.
This feature is used when an invoice number is known. Enter the number into the
Invoice No field and press the Enter key. The patient record with all financial
transactions will be loaded with the applicable invoice highlighted.
These are automatically sent to e-MDs Bill if users are running e-MDs Solution
Series. This saves users having to re-enter diagnosis and procedure codes. Click
Visits to see a list of all the visits ready to be billed. Select the applicable visit, then
click Build Invoice. This loads the patient as well as a new invoice screen with the
codes from the visit, so it is not necessary to load a patient first.
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Entering Data
Almost all entry screens in e-MDs Bill follow a logical order. Users start on the top left,
and gradually work down to the bottom right. This makes the workflow much easier to
understand. This part of the manual gives users some hints about how to use the
keyboard and other data entry tools to the maximum benefit, as well as conventions
about entering and deleting data in the system.
Continued on the next page ...
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Moving Around
e-MDs Bill follows Windows-standard navigation rules where possible. To move between fields, use the
Tab key. To move backwards, hold down the Shift key, then press Tab and release both. You can also
use the mouse, but this is slower.
The Enter key is used when a field requires a database lookup. For example, when in the posting window
users can enter ICD or CPT codes. If the Enter key is used after entering a code, e-MDs Bill looks up the
code and displays related information such as the description associated with the code, and billing
warning messages. The cursor will remain in the same field waiting for the next code. To move to the next
active field without making the database lookup, use the Tab key.

Deleting Data
The Back Space key is used to delete the character immediately prior to the cursor. If the field is being
edited at a later time, tab to the field. When all the data is highlighted, press the Escape key to clear. The
Escape key is used to clear date fields, and fields that have been filled using a linked database, or special
fields with an input mask.

Typing vs. Mouse Clicks
As a general rule, using the keyboard is always quicker than using a mouse, even for slow typists.
•

Drop Down Listboxes: A list box contains a list of options that can be used to fill the field. If you
know the option, you can type the starting letter. The list will immediately advance to the first
element starting with this letter. In some cases, you can continue to type the second character to
further shorten the list. If this is not the case with the field, use the arrow keys to scroll the list.
The alternative to this is to click on the drop down arrow on the right of the list box and scroll
through the list before selecting the option.

•

Alt+Key Shortcuts: Many menu items and buttons have keyboard shortcuts. These are shown
with an underlined letter. Hold down the Alt key, then press the underlined letter and release both.
If the Alt key makes a menu appear, this menu is active and it is not necessary to use the Alt key
combination when pressing the key reference for other underlined letters.

•

Ctrl+Tab: When the cursor is in a field located in a screen tab, users can move to the next tab
using the keyboard. Press the Ctrl key, then press Tab and release both.

Learning these Windows standards of moving around screens can save a great deal of time when
entering data into e-MDs Bill. We encourage you to use the keyboard over the mouse since this
enhances productivity.

Window Sizing and Positioning
Users have some flexibility with how windows are displayed on screen. This includes the ability to change
the size and position of windows. This can improve the amount of data displayed (which varies depending
upon screen resolution). Moving windows allows users to see background information if necessary.
To size a window, point the mouse cursor over the edge of the window. It will change to a double-sided
black arrow. When this happens, press the left mouse button, and, while still holding it, drag the edges of
the window until you are happy with the size. Then release the mouse button.
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To move a window, point the mouse cursor at any point in the window title bar (the blue line at the top of
each window with the window name on the left). Hold down the left mouse button and drag the window to
the position desired before releasing the mouse button.
You can also change the width of columns in some windows (Posting Window, Invoice CPT's). Point the
mouse at the vertical black lines between column headings. A double-sided arrow will appear. Drag the
column to the width you require.
Window and column sizes and positions are remembered by workstation and by user. Make sure you
close the specific window you sized before closing the application in order to store the settings.

Data Consistency
e-MDs Solution Series is a very advanced data management system. As much as it can, it will enforce
integrity of data. The following are ways the system will try to maintain this:
•

Required Fields: Data entry windows have required fields that are denoted with an asterisk (*). If
a required field is not filled out, upon saving the record an error prompt will appear and force the
user to go back and complete the record.

•

Duplication Checking: Certain records have built in duplication checks. These include patient
last and first name matches, insurance company address and zip code matches, and no
duplications of SSN or account numbers permitted.

•

Common Addresses and Telephone Numbers: Data files store these elements of person or
facility files. Once an address or phone has been entered in the system, it can be used for all
other records with the benefits of more rapid data entry, and automatic changing of all linked
records if the phone or address changes (for example, when a family moves house). An added
benefit is that when an existing phone number is entered, it is linked to the address so using that
phone again prefills the address in subsequent records.

The Human Factor and the Effect of Strong Management and Training
Unfortunately, e-MDs Solution Series cannot control all data entry. This would make the system extremely
rigid and unfriendly. For this reason, it is possible to create records that may be duplicates. The best
example of this is post office boxes. Some people are used to entering them as POB, others as PO Box,
and yet others as P.O. Box. At the database level, these are all completely different. Although it’s not
serious, there are some problems with this duplication. For example, your reporting may become
fragmented if you create duplicate insurance company records.
For this reason, we strongly encourage your facility to establish and enforce data entry standards. There
aren’t many, but mistakes can be hard to rectify. Include the way you enter mailing addresses, accepted
abbreviations for records like insurance company names, and the like.
Effective management of data entry and retraining when users are consistently ignoring your policies can
have a marked effect on how you use your data. At the end of the day a computer system is about data
and manipulation of that data. The easier it is to work with, the better your investment.
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Getting Started with Bill
e-MDs Bill is a very comprehensive application. It uses a relational database in which
files are cross-linked so that when information is entered in one part of the system, it
can be accessed elsewhere without having to repeat data entry. The key to ensuring
a smooth implementation is to take the time to enter the foundation information
correctly so that you only have to do it once.
The relational nature of the system requires you to set up files in a logical,
hierarchical order. Some files cannot be created before others. For example, you
cannot create a patient without assigning a financial group or provider. User options
that affect daily operations must also be set. The process does not take a great deal
of time, but planning is important.
Many setup options are designed to expedite data entry. Others control data access
and help with real time decision-making such as the choice of insurance filing type.
You can always change baseline information at a later date, but this is more timeconsuming than if proper planning is done in advance.
Continued on the next page ...
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License Key Activation
See the e-MDs Solution Series Administration Guide for detailed instructions on licensing your Solution
Series applications.

Insurance Database Population
The choice of whether or not you enter all your insurance companies in advance or at the time of entering
patients and guarantors is one you need to make internally. Our recommendation is based upon how
many carriers you contract with, and the source of information on these carriers. If you have hundreds of
carriers, it will be a time-consuming task to sit down and enter them all at once. It would be easier to enter
your major carriers and government plans such as Medicare and Medicaid first. The rest can be entered
interactively. However, interactive data entry may not be suitable if the information on the carriers is not
readily available as might be the case in a large office. Patient insurance cards will usually show all the
necessary information, but it is then extremely important that data entry staff ensure the carrier has not
already been entered.
We cannot recommend that clinics print a roster of insurance companies from a previous billing system. It
is our experience that over time, other systems are populated with a vast number of unnecessary
duplicates. The reason for this is to avoid duplicating insurance companies since this has many
drawbacks. Since e-MDs Bill also allows multiple groups to be stored in one insurance company file, this
redundancy can be avoided so the duplication is not entered in the new files. This makes reporting much
harder. If you must work off such a roster, spend some time working through the print out and deleting
those duplications, as well as multiple name entries for the same carrier.

Electronic Claims and Remittance Setup
Electronic claims are absolutely required if an office wishes to get its claims processed quickly but it is
important to understand that there are some setup steps required. You cannot just switch it on. A smooth
claims setup is characterized by following a simple series of steps. The responsibility for completing each
step might be yours, or e-MDs’, or a clearinghouse. The steps below are general. Once you have
selected a particular clearinghouse, specific instructions will be sent to you.
Note: Regardless of how familiar you are with electronic claims, and how quickly you think your staff
may be able to set up the claims, CONTINUE TO FILE CLAIMS ON PAPER UNTIL YOU ARE SET TO
LIVE. Do not risk inflating your receivables. Once you are live, you can file all the claims printed for
quicker processing.

To set up electronic claims and remittances:
1. Select a claims transmission broker and inform e-MDs. Customer.
2. Mail necessary paperwork including payment information, enrolment contracts and major payor
contracts. e-MDs. Check clearinghouse.
3. See payor lists to see if there are any other payors that require agreements. Request these from
e-MDs. Customer.
4. Mail additional agreements to customer. e-MDs.
5. Complete paperwork, paying particular attention to legal agreements. These must be filled out by
the correct authorized parties, numbers entered perfectly and original signatures (not stamps)
used. Note: based on experience this is where the most delays occur. EDI agreements are legal

e-MDs Solution Series Bill User Guide 8.0 R00

18

contracts and incorrect entries will be sent back. Given that some take 6 weeks to be approved,
each delay will add this to your setup time. Mail to e-MDs. Customer.
6. Read instructions for clearinghouse setup. Customer.
7. Check paperwork and verify with client. Mail to clearinghouses or back to client. e-MDs.
8. Setup files, run necessary database scripts. e-MDs.
9. If necessary, create test claims. These can be claims that have already been filed and paid
previously. Test claims are not processed for payment, only for data integrity. e-MDs and
Customer.
10. Upon passing tests, wait for payor approvals and start filing live claims to customers. e-MDs and
Customer.
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5

Using the Dashboard
The e-MDs Dashboard is a system that hosts applications/modules. It does not have
to be used but there are several advantages.
• User Application and Toolbar Preferences: Dashboard remembers a user’s
preferred applications, whether to open them automatically or not, and also the
preference of where buttons are located on the Dashboard toolbar.
• Multiple User Sessions: Dashboard also permits multiple sessions of certain
applications to be run on the same computer for different logins. This
accommodates the workflow in many practices that share a computer. One
user can log in and start working on his/her set of tasks using various modules
and then log out. Another user who logs in on the same computer will see
his/her own set of preferences and in some cases can be using exactly the
same module but on a different task. It’s worth noting that because multiple
instances of modules may be started, this can affect memory/performance of
the workstation. Eventually Dashboard will notify a user trying to log in that
there is not enough free memory to run modules optimally. It does not know
what effect third-party applications have, so if you have a lot of system sharing
with many users, consider adding more than the minimum memory required
per workstation.
• Task Counts: The Dashboard button for some modules displays a task count
when they are actively running. These are TaskMan, Refill Requests, Order
Tracking, Phone In Scripts and Unsigned Notes. Thus, no matter which other
modules you are in, you can see if other tasks are being added to your queues
and can easily flip to them to knock down these work “stacks” and therefore
shorten the end of day load.
Continued on the next page ...
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Logging in to Dashboard and Setting Application
Preferences
Dashboard is the default entry point for any e-MDs Solution Series installation. The shortcut icon on the
desktop automatically loads the Dashboard.
Notes about how the Dashboard uses the System Registry and running in a Terminal Services
Environment:
Each user has their own HKey_Current_User (HKCU) registry hive. The values associated with an HKCU registry
entry, therefore, can be different if desired for each user of the system.
There are some installation constraints for Terminal Services, however, that must be understood for operators
that wish to concurrently support multiple clinics on the same physical Server/Terminal Server. At application
installation time, the default registry key values for database access are entered into the HKey_Local_Machine
(HKLM) registry hive which is unique to the hardware server and globally readable by all users running Terminal
Services on that server. When a user initially executes an e-MDs application such as dashboard, the application
will first check its HKCU hive for the database access information. If the HKCU registry key containing database
access info is empty, then the application will look in the HKLM for the info and will copy it to the HKCU. If the
HKCU registry key is not empty, then its values will be used for database access and the previously described
copy from the HKLM occur.
This means that if multiple clinics are to be running under Terminal Services on the same physical hardware, then
one of the following things must be done at or prior to application installation:
Run an instance of a software virtual machine (VM) for each supported clinic. In this way each clinic will have its
own separate HKLM as provided by the VM instances.
The administrator can set the registry key in the HKCU of each user at application installation time.
Each user can be supplied with database logon information to be used at initial login.

To log in and out of the dashboard:
1. Double-click the e-MDs desktop
shortcut.
2. Enter your user name and
password.
3. If necessary, verify that you are
pointed to the correct login group
(database and server) by clicking
the button with the downward
arrows. See the e-MDs Solution
Series Administration Guide for
information about login groups.
4. Click OK. The dashboard will
open.

To log out of the dashboard:
Simple Log Out Method: Click the button at the top left of the Dashboard bar with a key icon, or the
minimize button at top right. This minimizes everything and presents a login window. It does not
close modules so if the same user logs in again, the system returns to the last place worked for most
applications. If another user logs in, that user’s preferences are loaded in a different session.
OR
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Close Session Applications Without Shutting Down: To log out of a session completely and close
all the modules you are using, click the button next to it with the key and squares. The system
attempts to close all modules correctly. In some cases a particular task will prevent it from doing this.
When this happens, a window appears showing the logged in user sessions and the applications they
are running. It is best to note the ones in your user “tree,” then click “Do not shutdown,” then go into
the different modules and close them correctly. Once all modules are closed down, the system
minimizes and shows the login window again.
OR
Full Dashboard Exit: To close Dashboard completely, click the X at top right. The dashboard will
attempt to close all modules. If it cannot close them, it shows which are still running so you can
complete any processes and then try to close again.
Note that setting the Run > Options timeout value is a way to execute a simple logout and preserve
security should a user forget to minimize or log out.

To set up dashboard applications and preferences:
1. Click Run. A menu of applications appears. The list is determined by how many of the
Dashboard security privileges were added for the user. If applications are on the list but are
grayed out, it usually means that the program file was not installed.
2. Click an application to add a button for it to the Dashboard bar. Repeat for additional modules.
You can add any modules you wish but may have to scroll to see the buttons for these in the
Dashboard bar depending on the number and your screen resolution.
When you add applications from the Run menu they are also started at the same time. The next
time you log in, you will see this application button on the bar. You can click a button at any time
to toggle to the module.

Dashboard Button Options
You can right-click a Dashboard application button to display a menu that provides further customization
options.
Dashboard Button
Options
Button Order
Auto Run

The Move options let you set the order of applications on the Dashboard.
To start the application automatically when you log in to Dashboard, click this option.
A check mark appears to the left of the Auto Run option for those with this property.
Click it again to undo. If you typically use several applications during a session, it’s
a good idea to set this for all of them. Although it will take slightly longer to open the
system it saves you from waiting a few seconds the first time you click each button
to go into the application. The application you typically use first should be moved to
the right of the bar since Dashboard opens them left to right. It’s also a good idea to
open any modules that have task counters (e.g. TaskMan, Order Tracking, Refill
Requests, Phone In Scripts) since the counters are only displayed when the
application is running.

To remove an application from the bar:
1. Make sure the application is closed.

Note: Buttons for open applications have a background color which can be selected from the
options (explained in the next section) screen found on the Dashboard’s run menu, the default
color is light beige.
2. Locate the application to be closed, and right-click the button.
3. Click Remove.
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Dashboard Options
There are two options accessed by going to Run > Options.
Dashboard Run Options
Time Out

Colors

This automatically logs the user out and minimizes all applications so information is
protected. The time out applies to all modules so even if you run them in standalone
mode outside Dashboard, this is where you must make the setting.
Depending on your screen, the default light beige background for module buttons on
the Dashboard bar that are currently running can sometimes be hard to distinguish
from the standard Windows gray or other color preferences you’ve set up. Select a
color keeping in mind that it should be fairly light so it does not make the black or
red application button label text hard to read.

○ This option allows you to enable or disable an Internet search
from the Dashboard. This Search Bar allows you to search a
designated online repository for medical information. By default,
the Search Bar Enabled check box has been selected
(activated). To disable this option, click the check box to
deselect it. The Search Bar will appear on the Dashboard only if
it is enabled on this screen.

Search Bar

The UpTo Date option is set as the default search engine. If you prefer a
different option, click the down-arrow in the Default Search Engine field
and select a different search engine.
Click Save to retain any changes made on this screen. For instructions on
using the Search Bar after it is enabled, see Searching External Databases
for Medical Information.

Dashboard Sessions
As explained previously, you can run multiple sessions of Dashboard for different users on the same
computer. In some cases, different instances of the specific modules are run in system memory, but for
most of the clinical modules this is not the case. Depending on the number of users logging in on a
computer as well as the number of modules they like to run, this can obviously take up memory.
Eventually the system will notify a user trying to log in that there is not enough free memory to operate
optimally. If some modules have been swapped to disk for a logged out user, it may take a little longer to
start up again but that is temporary. Of course, this is not really an issue for users with a dedicated
computer or tablet.
The log out options described previously can optimize the system. For example, logging out and closing
applications frees up resources for the next user.
You can see which users are logged into a computer as well as the number of modules that they have
open and memory usage by going to Run > Sessions. Shared Memory indicates modules that do not
have separate sessions for each login.
It is very important that you close all your applications correctly when decide to completely end your
session. This means you must click the button for each application then close any open processes. To
be sure, use the Exit function within the module. If another user has an open session on the computer, it
can be closed by going to the Run > Sessions window, selecting the user and clicking the button with the
red X.
To see the details of the sessions for a user, select the line then click the View Details button. This
shows the specific module and how much memory it is using.

Searching External Databases for Medical Information
The Solution Series Dashboard provides a method of accessing online resources for medical information
without leaving the application. This option is enabled by default, but can be suppressed if a user prefers
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or if your facility does not have an account that allows you to access those sites. The following resources
are currently supported through this feature:
•

UpToDate is an online repository of medical information that has been submitted, peer-reviewed
and is maintained by expert clinicians. See http://www.uptodate.com/home/about/index.html for
more information.

•

Physician's Desk Reference (PDR) is a commercially published compilation of manufacturers'
prescribing information on prescription drugs, updated annually. The PDR Network is the online
source for that guide. See http://www.PDR.net for more information.

•

Apixio: See http://www.apixio.com/ for more information.

Note: You must have an active membership to access these databases. When you use the search
function to go to those sites through the Dashboard for the first time, you will be prompted to provide
your account information.
•

WebEx option will open a web browser to the e-MDs Webex website conveniently from within the
Solution Series application. This allows you to quickly begin a Webex session with the e-MDs
Support Team if necessary.

To search an online resource through Dashboard:
1. With Dashboard active on your desktop, locate the Search Bar in the upper-right corner of the
Dashboard.
2. If you prefer to search a different resource rather than the default search engine, click the downarrow next to the search engine icon and select a different option. Note that the search engine
icon will change to reflect the currently-selected search engine.

3. Type your search string in the field and click the search engine icon immediately after the search
field (or press Enter on your keyboard).
Using your default Internet browser, a new window will open at the selected site.

Note: If this is the first time you have accessed the site, you will be asked to enter your account
information to register.
4. Review the information that is returned or begin a new search on the site, as needed.
5. When you have completed viewing the information, close the browser window.
Note: If you want to disable the Search Bar, select Options from this drop-down list to go directly to
the Chart Options screen. To disable this option, click the check box next to Search Bar Enabled to
deselect it, then click Save. The Search Bar will disappear from the Dashboard.

Logging In/Opening Schedule
The scheduling application can be run on its own, from within the e-MDs Dashboard (the default method),
or from within other modules. You can run multiple instances of Schedule at the same time depending on
where you open it from.
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To log in/open Schedule:
•

Dashboard Module: The e-MDs Dashboard is a tool that lets users run multiple modules at the
same time with a single login. If you have the Dashboard Schedule security privilege, then an
entry for Schedule appears on the Run menu. Clicking this adds it to the Dashboard bar as a
prefered application. Right-clicking it’s button on the toolbar gives you some options to
automatically start Schedule upon logging in to Dashboard, as well as the order it appears.

•

Standalone: This requires users to manually add a shortcut for Schedule to the desktop since
the default installation places the e-MDs Solution Series icon which starts Dashboard. Right-click
the Windows Start button and click Explore. Navigate to c:\program files\e-mds\solution
series\apps. This is the default installation directory so if your applications were installed
elsewhere, browse to that location. Then right-click on the topsSchedule.exe file and go to Send
To > Desktop (create shortcut). Double-clicking this shortcut will open Schedule by itself.

•

Other Modules: Regardless of whether other modules are being run from within Dashboard or in
standalone mode, many provide access points to Schedule. Note that in some cases the full
Schedule module is opened and in others just segments like an appointment history for the
selected patient. Full access points:
○ Bill: Click the Schedule button on the toolbar.
○ Tracking Board: Double-click a date in the calendar at bottom left.

Note: The system remembers that last facility used by user AND by workstation. The first time you
log in to a workstation where you have not established your user preference the Internal Medical
Facility search window will appear automatically so you can select a default. From that point forward
any changes you make are remembered. If the Internal Medical Facility search window does not
appear automatically, go to File > Medical Facilities, which will access the Internal Medical Facility
search window. Highlight the desired facility and click Select.

Logging In/Opening Bill
The billing application can be run on its own, from within the e-MDs Dashboard (the default method), or
from within other modules. You can run multiple instances of Bill at the same time depending on where
you open it from.
•

Dashboard Module: The e-MDs Dashboard is a tool that lets users run multiple modules at the
same time with a single login. If you have the Dashboard Schedule security privilege, then an
entry for Bill appears on the Run menu. Clicking this adds it to the Dashboard bar as a prefered
application. Right-clicking it’s button on the toolbar gives you some options to automatically start
Bill upon logging in to Dashboard, as well as the order it appears.

•

Standalone: This requires users to manually add a shortcut for Bill to the desktop since the
default installation places the e-MDs Solution Series icon which starts Dashboard. Right-click the
Windows Start button and click Explore. Navigate to c:\program files\e-mds\solution series\apps.
This is the default installation directory so if your applications were installed elsewhere, browse to
that location. Then right-click on the topsbill.exe file and select Send To > Desktop (create
shortcut). Double-clicking this shortcut will open Bill by itself.

Note: The system remembers that last facility used by user AND by workstation. The first time you log
in to a workstation where you have not established your user preference the Internal Medical Facility
search window will appear automatically so you can select a default. From that point forward any
changes you make are remembered.
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Using Reference Tables
e-MDs Solution Series provides a rich set of reference tables to streamline your
record maintenance and management tasks. Some of these table values can be
customized to meet your unique environment. Other values are predefined and
cannot be edited. This section provides an overview of those reference tables and
includes directions for customizing the ones that can be modified.
Continued on the next page ...
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City, State, Zip
In order to save keystrokes, e-MDs Bill is supplied with a master table of all US zip codes and their
associated cities and states. If a zip is entered which has previously been used, the city and state fields
are filled automatically. In the event that you need to change the city and state association with a zip
code (such as when cities incorporate others), you can do this through a reference editor.

To change the city/state association with a zip code:
1. Click Reference > City, State, Zip Code.
2. Search for and select the code you are looking for.
3. Click Edit.
4. Save your changes.

Comments
Comments are used in several places throughout the system.
Comment Options
Statement Comments

Superbills

Invoice Titles

Referral/Authorization
Fax Comments
Reversal Comments
Appointment Comments

These are entered in the payment windows. Using comments to describe special
circumstances associated with invoices and associated payments and adjustments
is a recommended accounting process because they can explain the reason for
transactions to guarantors, thus improving communication and potentially reducing
the number of calls to billing staff. An additional benefit of this type of comment
structure is standardization; and therefore, reflects the professionalism of an
organization. Users can add an unlimited number of comments to an invoice. Each
is printed in chronological order.
Superbill comments can be extremely valuable to a practice. The system allows
users to attach a comment to each patient file (in the Misc tab). The comment is
printed in bold at the top of the superbill and can be used to add insurance-specific
warnings, clinical alerts, or social comments. The provider of care will see this at the
time of the visit, thus preventing possible problems. For example you can alert the
doctor that the patient’s insurance does not cover lab work routinely done in-house.
To make superbill comments easier to link to patients, the group code must be SB.
Only comments with this code can be linked to patients.
These are a good way to simplify the reason for a visit. Many patients will call a
clinic when they receive statements because they cannot understand some of the
complex medical terminology detailed in a claim. Invoice titles are a good
alternative. The patient statement can be set to reflect only the invoice title, thus
saving the cost of the telephone call, and in some cases, printing and paper costs if
the clinic chooses to omit ICD and CPT detail.
A comment can be added to a referral. The comment is accessed when adding or
editing a patient referral.
You can add one or more custom comments to outbound fax cover pages if they are
in the FAX comment group.
A comment should be added when performing a reversal to track the reason for the
transaction.
Appointment comments can be added to provide information to staff.

To add or edit comments:
1. Go to Reference > Support Tables (Alt+R, S).
2. Select the Comment table from the list of table names on the left (Up and Dn arrow keys).
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3. Click New (Alt+N) to enter a new comment, or Edit (Alt+E) to modify.
4. Enter or change the Group and Comment fields. Group is the 4-character classification used to
associate related comments.
5. Click Save (Alt+S).
Here are some examples of statement comments added to payments and adjustments.
•

INS: Insurance Paid – Balance Due From Patient

•

INS: Insurance Declined Payment – Balance Due From Patient

•

INS: Balance Applied to Deductible – Balance Due From Patient

•

GEN: Statement Mailed This Date to Patient’s Guarantor

•

GEN: Second Statement Mailed This Date to Patient’s Guarantor

•

STAT: Credit transferred from invoice #…

•

STAT: Credit transferred to invoice #…

Superbill comments added in patient file:
•

SB: Lab Alert: Send Urinalysis Out

•

SB: Lab Alert: No In-House X-Rays Permitted By This Plan

•

SB: Allergies: Penicillin, Sulfa

Invoice titles
•

INVT: Headache

•

INVT: Physical

Referral/Authorization Comments:
•

REFL: Obtain refl for knee surgery

•

REFL: Obtain refl for myofascial release therapy

Faxing:
•

FAX: Comments in this group are available to be added to the cover sheet of outbound faxes.

Financial Groups
Financial Groups are a critical component of e-MDs Bill. At first glance, it would appear that financial
groups are directly related to insurance companies, but they are not. There is some correlation between
the financial group and insurance company, but the primary purpose of these classifications is for data
collection and report segregation.
They are used to segregate patient invoices according to type. The type is often linked to the billing
conditions for each invoice. Financial groups are extremely powerful because they permit greater
flexibility with reporting and they can also control the way claims are transmitted to insurance companies.
Additionally, some financial groups will trigger special functions within the system.
Most reports in e-MDs Bill can be segregated using a financial group. This creates an extra ‘layer’ for
reporting purposes because of the grouping nature of financial groups. For example, if users wished to
see how much activity was with PPO type insurance, they could run individual reports for each of the
PPO insurance companies, and then add these all up using a calculator. However, if all invoices for PPO
insurance companies are classified as PPO, then users could run the report for this financial group and eMDs Bill will aggregate the data automatically.
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Financial groups are also used for insurance filing. For example, the system is supplied with some default
codes such as MDC, MDD, and so on. These control where the x’s are printed in Box 1 of some paper
claims. Electronic claims filing is also segregated according to financial group classification. In the event
that users have a conflict between deciding on financial group based on reporting or insurance filing
requirements, the insurance requirement should always take precedence.
Note: If a payor issues your practice with special group or pin numbers (that are not standard numbers
like UPIN, TaxID, State License Number or SSN), then you must create a financial group for this so that
ANSI claims can insert these numbers.
There are some financial groups with special functionality.
Financial Group
Options
CAP

WMC

PVP

This is extremely important for clinics with capitation contracts. All capitation
invoices should be set to CAP. This does several things. The first is that it will ask
users if they wish to automatically adjust the invoice to zero after taking a
copayment (a standard procedure for most capitation plans). Additionally, all
capitation invoices can be split into a separate reporting category – extremely
important because capitation contracts expose clinics to risk, so there is a strong
need to ensure that copayments, carve-outs and capitation checks are greater than
the adjustment amount.
Permits the guarantor insurance to be used on an invoice instead of the patient
insurance. Additionally, users can browse prior invoices with the same diagnosis
code for a date of first injury.
Cash invoice classification. Automatically transfers the total responsibility of all
charges to the patient account, regardless of whether there is insurance in the
invoice or not.

Financial groups are linked to invoices through the patient file. When a patient is added, a financial group
is required. This financial group is the default for each invoice generated for this patient, but can be
changed at the invoice level. One example of where this might occur is when a patient comes to the clinic
for a Workers’ Comp related visit instead of a normal insurance visit.
Users can also change the financial group of an invoice through the billing cycle. An example is if a
patient has Medicare primary and secondary insurance. Since MDC (the Medicare financial group) is a
claims filing filter, if the claim is going to be filed for supplementary insurance, it is necessary to change
the financial group in order for this claim to be included in a batch other than the Medicare batch. Another
example is if a claim is sent to a collections agency. Changing the financial group to a code created for
this allows the clinic to report on all claims sent to collections.
e-MDs Bill is supplied with a preloaded listing of financial groups. Do not, under any circumstances,
delete the following entries, even if you use them. Each has special uses in e-MDs Bill.
Special Bill Financial
Group Options
BCS
MDC
MDD
PVP
CAP
WMC

Blue Cross and Blue Shield (if your state has separate Blue Cross and Blue Shield
carriers, create a financial group for Blue Shield too, e.g. BSH)
Medicare. Puts the “X” in the correct part of Box 1 of the CMS-1500.
Medicaid. Puts the “X” in the correct part of Box 1 of the CMS-1500.
Private Pay (Cash accounts with no insurance)
Capitation Plans
Workers’ Compensation

If your clinic files Champus, Champva, or FECA claims, you will need to set up the groups CHP, CHV and
FEC respectively. The system is programmed to put the “X” in the correct part of Box 1 of the CMS-1500
if these are used.
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Financial Group Database Maintenance
When adding additional financial groups, it is advised that a limit be set to keep the list meaningful.
Having too many groups is not necessarily a good thing. For example, it is not necessary to create an
individual financial group for each independent insurance carrier because they can easily be grouped
under a single classification of PVI for all independent carriers. Most reports in e-MDs Bill will allow the
user to collect information on a single insurance carrier, as well as financial group.
Never delete a financial group if it has already been linked with invoices. This will affect the accuracy of
historical reporting.

To add or edit a financial group:
1. Click Reference > Support Tables (Alt+R, S).
2. Select the Financial Group table from the list of table names on the left.
3. Click New to enter a new financial group, or Edit to modify.
4. Enter or change the Code and Description fields.
5. Click Save (Alt+S).
A provider can include/exclude secondary identifications in each electronic claim by defining a set of
filters. Facility, State and Financial Groups are each filters normally used to determine the scope of use
for secondary IDs. To include a secondary ID without filtering, the “All” option is available for each filter
option.

To apply an Alternate ID for all financial groups:
1. Log in to e-MDs Bill.
2. In the Claims menu, click Clearing Houses.
3. In the Clearing House dialog box:
a. Select a Clearing House.
b. Click the Provider 2nd ID tab.
c. Click the New Provider ID button.
d. Select All from the drop down menu in "Financial Group."
e. Click Save.
Close the window to Exit.

Patient Types
Patient types are internal codes linked with certain patients that designate a certain condition. Patient
types cannot have to be added to all patients. When a patient is linked to a type, the type code is
displayed in his/her demographic file. If a patient type is associated with a color, the background for all
appointments in Schedule and Tracking Board also appear in this color. Other functions such as the
collections module in Bill also show the type code with the color.
Thus, the patient type is a mainly a communication tool to alert users about special conditions pertaining
to the patient. Some examples of patient types:
•

Patients with billing problems (overdue balances, have to pay cash).

•

Patients with physical conditions that staff should be aware of (disabled, hearing or vision
problems, etc.).

•

VIP patients.
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•

Information required (new patients can be assigned this so check in staff know to give them a
demographics form).

•

Translator required.

Patient types should be used carefully and require some planning. Do not overuse them, and avoid using
too many colors. Likewise, avoid using colors that are system colors (the blocked slots color). Finally,
patient type colors should be light since they are the background color of appointments. When dark colors
are used, it makes the appointment detail hard to read.

To add patient types:
1. Click Reference > Patient Types. This table can also be accessed from the Type of Patient field
when linking patient types to patients.
2. Click New.
3. Enter a patient type code of up to 3 alphanumeric characters.
4. Enter a description explaining the meaning of the code for other users (a legend of patient types
with descriptions is available on the Help > Legend window).
5. Use the drop down arrow in the color field to select from the palette of standard windows colors,
or click the paintbrush to browse for additional ones.
6. Click Save.

To link patient types to patients:
1. Click Demographics > Patients. You can also access patient demographics when making or
editing appointments.
2. Open a record in Edit or New patient mode.
3. Using the drop down arrow, select a patient type code in the Type of Patient field.
4. Click Save.

Payment and Adjustment Types
The payment type offers a control feature for helping your office balance the computer system with the
cash registers used throughout the clinic. For every revenue entry, a revenue type is requested. The
payment type database also provides for a list of adjustment types to be entered.
Using payment types to segregate revenue into meaningful categories is an efficient control function, but
it is best not to create too many. These will become difficult to use and fragment the summation reports.
For example, it is not necessary to set up an adjustment for each insurance group, because one will work
for all. Add only the payment types you are certain will be needed in the beginning, then add others as the
need arises and when a clearer understanding of their use is established.

Notes:
•

The adjustment codes added to this table are used in the payment summation for a particular
claim. ANSI-standard adjustment reason codes are preloaded into the Reason Code table and
are used for rapid entry of ANSI-standard, HIPAA mandated adjustment codes that appear on
paper EOBs. See Revenue Codes on page 76.

•

The adjustment code AERN used for electronic remittance adjustments cannot be deleted. This
code is used to indicate that higher level ANSI reason codes are on the payment.
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To add or edit a payment or adjustment type:
1. Go to Reference > Support Tables.
2. Select the Payment Type table from the list of table names on the left.
3. Click New to enter a new payment or adjustment type, or Edit to modify.
4. Enter the 4-character code that will be used to identify the type. The code, not the description, is
what appears on most reports.
5. Click the applicable Flag radio button depending on whether it is an adjustment or payment. This
is important because it determines the lists in which the entry will appear.
6. Enter a description. The description is what users will see in payment entry screens, so each
similar type should start with the same description. The descriptions are also printed on guarantor
statements, so they should be clear as to what they represent.
7. Click Save.

Referral Types/Invoice Split Ranges
Referrals tracked by e-MDs Bill can include the CPT codes authorized in the treatment. The system can
also automatically split invoices based on codes. To save time entering these when adding new referrals
or linking split ranges to contracts, users can enter a standard CPT code range with a description for
accurate data entry.

To add referral type/invoice split range:
1. Go to Reference > Support Tables, then select Referral Types/Inv Split Range.
2. Click New. Enter data as follows:
Code: An internal reference for this type.
Description: Extended information for users.
CPT Range: Enter valid CPT code ranges in both fields.
Click Save.

Place of Service, Type of Service and Specialty Codes
These tables are standardized and follow national mandates. Depending on the place to where claims are
sent, e-MDs sends users special set up database scripts that set these codes appropriately.

e-MDs Solution Series Bill User Guide 8.0 R00

33

ICD-9 Search

The ICD-9 Search is an extremely powerful tool. It contains all the ICD-9 codes as well as tens of
thousands of alternate descriptions. You can add to these. Outline, descriptive or code based searches;
the ability to search by short lists and commonly used abbreviations virtually eliminate time-consuming
and expensive searching in paper-based references. Color-coding shows the billable status of each item,
and billing notes also assist users in selecting the right codes. A simple tree-based structure that lets
users rapidly drill down to greater levels of specificity ensures cleaner claims.
The ICD-9 Search is typically used from within an invoice, but can be loaded from other places for
administrative and other functions. This includes Code Linker, the superbill editor, from the Reference
menu, and charge sets.
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ICD-9 Search Customization
The ICD-9 Search is an extremely powerful tool. Users have several customization options:

View Options
ICD-9 Search
Customization Options
View Options

Search By Options
Alternate Descriptions and
Search Keywords

Different levels of information can be displayed in the screen. These are controlled
by several buttons on the toolbar.
•
Details: Loads a pane on the right of the window that shows the default
display, billing and detail descriptions. Additional information includes the
billable status, code valid dates and tabs for billing rules, includes and excludes
information, and a custom notes tab. See ICD-9 Details below.
•

View: Filters the code search for current, previous and future codes. Each ICD
code is identified by the date that it was added to the database. Searches
automatically default to searching the database for current codes. To view
codes that were valid in the previous year, click the button labeled View, and
then select the Previous Codes option. This is a valuable tool when
resubmitting claims from a previous year, and for use during the first quarter of
the year, when some carriers recognize new codes while other payers have not
yet converted from the old ones. In addition, it is possible to add future codes to
the database and set the start date for sometime in the future. For example, if
you receive notice that new codes are coming, those codes can be added to the
database ahead of time. To view future codes, click View and then select the
Future Codes option.

•

Exclude: Allows users include or exclude other specified and/or unspecified
codes from search results. These are denoted in search results with green and
yellow icons respectively. Click the button, then click the codes to
include/exclude on the pop-up menu that appears.

•

Legend: Replaces the details pane with an legend that shows what the various
icons next to a code mean, including expanded billable status descriptions. See
ICD-9 Legend below.

•

Labels: A toggle that affects whether the toolbar buttons have labels or not.

You can search by keyword, outline, or ICD-9 code. Keyword searches also have
different options that control the number and specificity of the matches.
Users can add their own custom descriptions (synonyms) and include abbreviations
to the list for a particular code. This eliminates problems where physicians use
different names for the same diagnosis and makes things easy for billers who are
only looking for the right ICD-9 to send to insurance.

ICD-9 Code Searches
Once the ICD-9 Search window has been accessed from any of the above places, you can search using
several options. A search will return all matches including duplicates. You can change this setting by
right-clicking the ICD-9 Search result line and clicking “Remove Duplicates” on the menu.
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To search by outline:
1. Click the Outline button (Alt+O) on the ICD-9 Search toolbar to display the entire ICD-9 database
in outline form. The first level of the outline lists general categories (for example, Infectious and
Parasitic Diseases, ICD code range 001-139).
2. Click the plus sign next to any category to further expand the tree, displaying the subcategories
(for example, Intestinal Infectious Diseases, ICD code range 001-009). Continue clicking the plus
signs to drill down to individual codes.

To search by keyword:
Searches can be by short list or full depending on the button clicked (Alt+S, or Alt+F). Short list
searches are much faster. A short list search only returns the ICDs that have a check in the box to the
left of the code. You can type the start letters for up to 3 words simultaneously, in any order and in
capitals or lower case. To minimize the chances of typing or spelling errors, it’s not necessary to enter
the entire description, although at least 3 characters are recommended to avoid longer searches with
too many results.
1. Type part of the ICD description into the Keywords field (see "ICD-9 Keyword Descriptions"
table). The Begins with, Contains and Exact Match buttons, and the And/Or radio button
settings above the field determine the rigidity of the search:
2. Press Enter on the keyboard, or click Search.
ICD-9 Keyword
Descriptions
Begins With (Alt+W)

Only finds diagnoses with words anywhere in the description that start with this letter
combination. For example, “che” would return “chest pain” and “cut to cheek”. This is
the most popular search. For example “che pai” eliminates “cut to cheek”.

Contains (Alt+T)

Looks for the keyword combination anywhere in a word. The above search would
also return “escherichia” and “foreign body in trachea”.
Only full words with an exact match for the description are returned. For example,
you must type “chest” to return “chest”. Typing “che” return anything.

Exact Match (Alt+M)

And/Or Radio Buttons
(Alt+N or Alt+R)

Used for multi-word searches. And would return any descriptions that contain both
words, while or returns descriptions that contain either. For example “chest pain”
returns all descriptions that have both words when set to And, and a great deal more
descriptions when set to Or because it will also return descriptions with either
“chest” or “pain” but not necessarily both, e.g. “barrel chest” (e.g. “psychogenic
pain”).

Notes:
•

If a Short List search is initiated and no matches are found, the search automatically converts to a
full database search.

•

Avoid entering search strings that have many possible matches in the database by typing at least
3 characters in the keywords, and avoid using non-descriptive words (e.g. “the”) or conjunctions
(e.g. “and”).

•

For codes that are used a lot during the day, click the list box arrow at the end of the Keywords
field to return your most recent searches. Select the keyword and click Search.
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To search by ICD-9 code:
1. Click the ICD-9 Code button (Alt+C).
2. Enter the starting numbers of the code and press Enter on the keyboard or click Search.

Using the "Parent" Button
Highlight any item in an ICD-9 search result and click Parent to display the code that immediately
precedes the selected code in the tree hierarchy. This is useful when a search returns an unspecified
code (represented by a yellow icon), as this function will then display more specific, related codes that are
more appropriate for billing purposes. For example, a search for "colon cancer" returns the four-digit,
unspecified code 153.9: Malignant Neoplasm of the Colon" (among other items). Highlight this result and
click Parent to display the three-digit parent ICD code, 153. Then click the plus sign next to this parent
code to expand the tree and reveal all of the four-digit children codes, including the more specific, billable
choices.

ICD-9 Legend
Whether searching by Outline or by Keyword, individual ICD codes are displayed with color-coded icons.
To review the meaning of these colors, click the toolbar button labeled Legend.
ICD-9 Icon Colors
White
Red

Green

Yellow

Blue

The white icon signifies billable codes.
Red identifies non-billable, three or four-digit codes that must be further specified by
a fourth or fifth digit, respectively. Payers uniformly reject these codes. Click the plus
sign next to any red code to expand the tree and display the more specific four and
five-digit code choices.
Non-specified codes, represented by green icons, are used when the ICD database
does not contain a specific code for the diagnosis in question. For example, expand
the three-digit ICD code 250: Diabetes. Specific four-digit codes identify various
diabetic complications (for example, 250.1: Diabetes with Ketoacidosis). However,
some fairly specific diagnoses (for example, Cardiovascular Complications of
Diabetes) cannot have a corresponding code. In this case, the most appropriate
code is the non-specified code 250.8: Diabetes with Other Specified Manifestation.
These codes are acceptable to most third-party payers, but medical documentation
should accompany the claim.
Unspecified codes, identified by yellow icons, should be avoided at all costs
because many insurance companies automatically deny payment of CPT codes
linked to these unspecified diagnoses. Typically, more specific codes exist in the
same code family and should be used instead. For example, avoid the yellow code
461.0: Acute Sinusitis, Unspecified. Instead, choose a more specific, billable
diagnosis, such as 461.0: Acute Maxillary Sinusitis.
Blue icons represent manifestation codes, which identify conditions caused by
another disease. The causative disease must be coded along with the manifestation
code. For example, the manifestation code 366.41: Diabetic Cataract must be
accompanied by a code from the 250: Diabetes code family.
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ICD-9 Details
Click the Details toolbar button to review detailed billing notes for each ICD code. Click Details a second
time to close the Details window, if desired. The individual fields in the Details window are explained
below.
Details Window Options
Display Description

Billing Description
Detail Description

Billing Status

Code Valid

Potential
Severity/Complexity
Inherit Severity

Billing Rules Tab

Acute Condition

Add to Problem List

Includes Tab

The display description is used in e-MDs Chart which gives users the ability to select
different descriptions for the same code. In e-MDs Chart, this description appears in
the Assessment section of a Visit Note and in the Current Problem list. This field is
non-editable for e-MDs-entered codes. This is a calculated description whose
appearance depends on which of the display-building buttons (labeled Self, Parent,
and Parent, Self) is selected. If Self is chosen, the display description will be the
same as the official description that is entered in the ICD outline tree (see ICD code
001 for an example). If Parent is selected, that particular item will display the
description of its parent code, which is the code immediately preceding in the tree
hierarchy (see ICD code 001.9 for an example). If Parent, Self is chosen, the
description will be that of the parent code, followed by a comma, and then the official
description (see ICD code 001.0 for an example.)
This description is the one used by e-MDs Bill and appears in the invoice, as well as
patient statements.
Official, full-text, detailed description of the individual code. This field is unalterable
for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255
characters in length may be typed.
The colored-coded billing status of each ICD code is set in this window (refer to the
Legend for an explanation of the colors.) These selections are unalterable for eMDs-entered codes, but the window is active for user-entered codes.
This field indicates the date range in which each code is active. For example, if a
new code is adopted on January 1st, 2001, that date will appear in the "From" field.
st
When codes are discontinued, the discontinuation date (typically December 31 ) will
appear in the "Through" field. These dates cannot be edited for e-MDs-entered
codes, but the field is active for user-entered codes.
This is used by the system in several places including automatic E&M coding in
Chart, and also to set the urgent/emergency exclamation icons in Schedule when a
visit reason linked to the ICD is selected for an appointment.
This is available when you add an alternate description for a code and gives you the
ability to have different severities based on the descriptors for a code. This may
affect E&M coding. If you wish to use the same Potential Severity/Complexity as the
setting for the code to which you are adding the description, check this box.
Otherwise, set the severity using one of the radio buttons.
This window, accessed by clicking the Billing Rules tab, displays helpful billing rules
and tips. Many codes have official billing rules entered by e-MDs, although this
section is editable by the user.
Used in Chart. When a diagnosis is added to the problem list, it can be acute or
chronic. Acute conditions are displayed in normal text and automatically age off the
list. Chronic conditions are displayed in bold and remain on the problem list until
manually removed. This default can be changed on a patient-specific basis.
Used in Chart. When a diagnosis is added to an encounter/progress note, it can be
automatically added to the problem list. The default can be changed on a patientspecific basis.
This window, opened by clicking the Includes tab, lists related diseases that are
encompassed by the selected ICD code. Many codes have Includes text entered by
e-MDs, although this section is editable by the user.
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Excludes Tab

Notes Tab

This window, opened by clicking the Excludes tab, lists diseases that are similar to
the selected code, but which have their own ICD codes. These diseases can be
billed with the selected code. In most cases, the appropriate ICD code follows the
disease description in parentheses. Many codes have Excludes text entered by eMDs, although this section is editable by the user.
This is a free-text memo field with a 255-character length. Billing memos of any type
related to the selected ICD code may be entered.

ICD-9 Short Lists
Short lists are the set of ICD-9 codes used most frequently by your practice. The short list is searched first
when the Short search option is selected. Searches are much quicker using short lists but if no matches
are found, TopsSearch automatically searches the rest of the codes too. Short lists can also be built to
only include billable codes, thus reducing the amount of time required to search.

To add codes to the short list:
1. Search for the ICD-9 by code or description.
2. Check the box to the left of the code. It is recommended that you try to check white (billable
codes), not other unbillable classifications.

Note: To remove a code from the short list, simply uncheck the box.

ICD-9 Alternate Descriptions

Many ICD codes already have alternate descriptions listed. Click the plus sign next to an individual ICD
code to expand the tree and reveal a node labeled Alternate Descriptions. Click the plus sign next to this
node to view all synonyms currently linked to this ICD code. Users may want to add more synonyms,
such as commonly used terms in your individual practice, to assist the billing staff in correct coding.

To add, edit or delete an ICD-9 Alternate Description:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right-click the Alternate Descriptions folder and click Add an Alternate Description on the
context-sensitive pop-up that appears.
4. Type the new description in the box that appears and press Enter. The description appears in the
Alternate Descriptions list.
5. If you want this alternate description to have the same severity/complexity level as the code to
which it is being added, check the Inherit Severity box in Details pane to the right. (If you cannot
see the Details pane, click the Details button at the top of the ICD-9 Search window.) Otherwise,
set a different severity. This can affect E&M coding.

Notes:
•

To edit an Alternate Description, select it and right click. Choose the Edit Description menu
option. Make changes as desired in the pop-up window. Press either the Enter or Tab key when
finished.
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•

To delete an Alternate Description, select it and right click. Choose the Delete Description
menu option.

ICD-9 Search Keywords

Although keywords have already been linked to each ICD code, additional words may be added, if
needed, to improve search results and improve office speed and efficiency.

To add or delete a keyword:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right-click Search Keywords and click Add Linked Keywords on the context-sensitive pop-up.
4. Enter keywords in the box that appears. If more than one word is added, separate them with a
space. Press Enter or Tab when done.

Note: To delete a Keyword, select it and right click and select Remove Keyword Link.
To copy keywords to use on other codes:
Adding the same keyword to additional codes is simplified by creating a Keyword Copy List.
1. Right-click any keyword.
2. Go to Keyword Copylist Operations > Add Selected Keyword(s) to List. A box appears with
the keyword.
3. Repeat for additional keywords that are to be added to the copy list. You can multi-select by
holding down the Shift key, then using the up and down arrow keys, or hold down the Control key
and click multiple noncontiguous keywords.
4. Search for and select the code to which this list will be copied and expand to Keywords.
5. Right-click Keywords.
6. Go to Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. You
can also select specific items on the copy list using Shift and Ctrl, then use Keyword Copylist
Operations > Insert Copylist > Insert Selected Items.

Notes:
•

When a new ICD code is added to the database, its description is automatically parsed into the
keyword list. However, if that description is edited at any point, the new words automatically be
added. At that point, simplify the task of adding the new keywords by right clicking on the
description and selecting the menu option labeled Parse Title into Keyword List.

•

To remove an individual keyword, select that word and right click. Choose the Remove Keyword
Link right click menu option.

e-MDs Solution Series Bill User Guide 8.0 R00

40

Adding and Deleting ICD-9 Codes
To add, edit or delete ICD categories:
The ICD table is divided into categories and subcategories, each representing a range of related
diagnosis codes. The category ranges created by e-MDs cannot be altered, but new sub-categories
may be added within them. The main ICD outline contains 19 pre-defined parent-level categories.
Any new category that is added must fall within one of these parent ranges.
1. Select an existing code range (yellow folders in outline tree) and right click.
2. Select Add Category from the right click menu.
3. In the pop-up Category Entry window, enter the ICD code range in the From and To fields. This
must be within the range of the category selected.
4. Enter a Description for that category range. Press either the Enter or Tab key when finished.

Note: ICD categories created by e-MDs cannot be edited or deleted. You can edit or delete
your categories by right-clicking the description, then selecting the applicable option from the
menu.
To add, edit or delete ICD codes:
If necessary, custom codes can be added to the ICD search. Updates are sent out to current
customers by e-MDs when the official classification is changed. This is typically on an annual basis.
1. Find the appropriate category (or subcategory) range for the new ICD code. (Note: If the ICD
does not fit within a pre-defined category range, first create a new category.)
2. Right-click the category description and click Add ICD. You can also right-click an existing ICD so
long as it does not have a 5th digit.
3. In the pop-up Add ICD window, enter the ICD code and a description of up to 100 characters. If
an ICD was selected when adding, that code will already be in the code field so only the extra
numbers need to be appended.
4. Press Enter or Tab to add the code.
5. Click the Details button on the toolbar.
6. Edit the Billing and Detail Descriptions if necessary.
7. Set the Self, Parent or Parent, Self radio button to set whether the description entered, the
parent description, or both are used. Clicking each option updates the descriptions above so you
can see the effect.
8. Click a Billing Status.
9. Set a Code Valid date range.
10. Enter Billing Rules, Includes and Excludes. To copy the rules from the next code up the tree right
click the code in the tree on the left and go to Inherit > Billing Rules, Inherit > Includes, and
Inherit > Excludes.
11. Enter a custom memo in the Note field.

Note: ICD codes created by e-MDs cannot be edited. Right-click the code and select Edit ICD or
Delete ICD to make changes.
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CPT Search

The CPT Search tool contains the complete CPT table along with various descriptions, fees and other
billing related data. Users are able to add additional custom codes as well as different search keywords.
Outline, descriptive or code based searches, short lists, commonly used abbreviations and other features
make the CPT search a powerful tool that goes beyond simply being a reference tree.
NDC code maintenance tasks can be performed including editing and adding more than one NDC code
per CPT or HCPCS code.
The CPT Search is typically used from within an invoice, but can be loaded from other places for
administrative and other functions. This includes Code Linker, the superbill editor, from the Reference
menu, CPT shortcut panels, and charge sets.
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CPT Search Customization
The CPT Search is an extremely powerful tool. Users have several customization options.
CPT Search
Customization Options
View Options

Search By Options
Alternate Descriptions and
Search Keywords

Different levels of information can be displayed in the screen. These are controlled
by several buttons on the toolbar:
•
Details: Loads a pane on the right of the window that shows default information
about a selected code including POS, TOS, office fee, RVUs, code valid dates,
etc. See CPT Details below.
•

View: Filters the code search for current, previous and future codes. Each code
is identified by the date that it was added to the database. Searches
automatically default to searching the database for current codes. To view
codes that were valid in the previous year, click the button labeled View, and
then select the Previous Codes option. This is a valuable tool when
resubmitting claims from a previous year. In addition, it is possible to add future
codes to the database and set the start date for sometime in the future. For
example, if you receive notice that new codes are coming, those codes can be
added to the database ahead of time. To view future codes, click View and then
select the Future Codes option.

•

Labels: A toggle that affects whether the toolbar buttons have labels or not.

You can search by keyword, outline, or CPT code. Keyword searches also have
different options that control the number and specificity of the matches.
Users can add their own custom descriptions (synonyms), include abbreviations to
the list for a particular code. This eliminates problems where procedures have
similar descriptions, but your office only performs one of them. It is easier for billers
to select from a list that only returns matches based on the descriptions submitted
by physicians.

CPT Code Searches
There are several ways to search for a CPT code.

To search by outline:
1. Click the Outline button (Alt+O) on the toolbar to display the entire CPT database in outline form.
The first level of the outline lists general categories (for example, Anesthesia: CPT code range
00100-01999).
Click the + sign next to any category to further expand the tree, displaying the subcategories (for
example, Head: CPT code range 00100-00222). Continue clicking the plus signs to drill down to individual
codes.

To search by keyword:
Search can be by short list or full depending on the button clicked (Alt+S, or Alt+F). Short list
searches are much faster since they only return the codes that have a check in the box to the left of
the code. You can type the start letters for up to 3 words simultaneously, in any order, and in capitals
or lower case. To minimize the chances of typing or spelling errors, it’s not necessary to enter the
entire description, although at least 3 characters are recommended to avoid longer searches with too
many results.
1. Type part of the description into the Keywords field. The Begins With, Contains and Exact Match
buttons above the field determine the rigidity of the search.
○ Begins With: (Alt+W) Only finds diagnoses with words anywhere in the description that start
with this letter combination. For example, “dest” would return anything with words that start
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with this, e.g. “destruction”. This is the most popular search. For example “dest mal” reduces
the results further to malignant destructions.
○ Contains: (Alt+T) Looks for the keyword combination anywhere in a word. For example “cal”
would return “scalp”.
○ Exact Match: (Alt+M) Only full words with an exact match for the description are returned. For
example, you must type “chest” to return “chest”. Typing “che” return anything.
2. Press Enter on the keyboard, or click Search.

Notes:
•

If a Short List search is initiated and no matches are found, the search automatically converts to a
full database search.

•

Avoid entering search strings that have many possible matches in the database by typing at least
three characters in the keywords, and avoid using non-descriptive words (e.g. “the”) or
conjunctions (e.g. “and”).

•

For codes that are used a lot during the day, click the list box arrow at the end of the Keywords
field to return your most recent searches. Select the keyword and click Search.

CPT Details
Click the Details toolbar button to review detailed billing notes for each CPT code. Click Details a second
time to close the Details window, if desired. The individual fields in the Details window are explained
below. When changes are made to CPT properties, clicking anywhere else in the window saves those
changes.
CPT Details Options
Type of Service

Type of Service is required when billing a CPT code. A default Type of Service has
been chosen for each CPT.

Default Place of Service

Place of Service is required when billing a CPT code. A default Place of Service has
been chosen for each CPT.
The default that will be used for institutional/RHC claims that require them. Click the
button to the right of the field to search for and select a revenue code. None is
displayed when there is no default, or you will see the code and related description.
The description used in invoices, statements and other reports.
Official, full-text, detailed description of the individual code. This field is unalterable
for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255
characters in length may be typed.
This field indicates the date range in which each code is active. For example, if a
new code is adopted on January 1, 2001, that date will appear in the "From" field.
When codes are discontinued, the discontinuation date (typically December 31) will
appear in the "Through" field. These dates cannot be edited for e-MDs-entered
codes, but the field is active for user-entered codes.

Default Revenue Code

Billing Description
Detail Description

Code Valid
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Total, Work, Malpractice,
PE Facility and PE Non
Facility Relative Value
Units

Private
Cost
ABU
NDC
In House

ABN
Link ICDs

In House

Cat 25

Lab Tracking

Kind of Service
Categorical Modifiers

Notes

If desired, the determining factors for the Relative Value Unit (RVU) assigned to
each code may be entered into the appropriate fields. The fields represent the total
RVU, the Work portion, Practice Expense, and Malpractice Cost. Updates are
distributed by e-MDs keep these current. The RVUs are also a component of the
formula used to calculate Medicare and Medicare-based fee schedules. The facility
and non-facility practice expense multipliers are used based on whether users
update fee schedules or costs using the facility or non-facility update options in
Reference > Fee Schedules and Rules.
The office fee for the procedure. This is the fee used when there is no facility default
fee schedule set up in the fee schedules reference table.
A cost can be entered for profitability reporting.
Enter default anesthesia billing units for anesthesia CPTs. When generating claims,
this will be used in conjunction with minutes to calculate the total units.
The NDC (National Drug Codes) can be set for codes that are drugs. The system
will build the code into claims where there is a requirement for these.
Used by e-MDs Chart to determine whether the code is typically performed in house
(and therefore is billed for and appears in the e-MDs Bill invoice when the note is
billed), or send out.
Not used since 6.0 which added ABN prompting to fee schedules and rules.
If this option is set, when a CPT is entered on an invoice with multiple ICD codes,
the system automatically links all the ICDs to the CPT saving the user from having
to do this manually. It is typically set for all E&M codes as well as any others to
which this requirement applies.
The default in-house or send out status for a code. This is adopted when fee
schedules are generated from scratch. The property can be set in fee schedules
based on profitability by insurance. Fee schedules also include the ability to set
pass-through/purchased services as send-out billable. The setting determines
whether Bill pulls the code from a Chart note or not when an invoice is automatically
generated.
If this is set for a code, when that code is used in an invoice which also has an E&M,
then the modifier -25 is added to the E&M. Typically this is only used when there
are no fee schedules in the system.
Used by Chart. When the On box is checked, users are automatically notified via
TaskMan if results for labs, a referral consult, radiology reports, etc. have not been
received back after the number of Days set. The Chart Lab Tracking module also
has a global view should staff wish to see all outstanding orders for a patient.
Used by e-MDs Chart to determine which of the end of visit note order forms are
populated.
Modifiers that apply to the entire category in which a particular code falls can be
listed in this field. Some modifiers have already been assigned. Users can add or
remove modifiers by right-clicking in the field, or by using the Reference > Modifier
tool. Modifiers in this list appear in a helpful short list in the invoice window (but
users can use other ones too).
This is a free-text memo field with a 255-character length. Billing memos of any type
related to the selected CPT code may be entered.

CPT Code Short Lists
Short lists are the set of CPT codes used most frequently by your practice. The short list is searched first
when the Short search option is selected. Searches are much quicker using short lists but if no matches
are found, TopsSearch automatically searches the rest of the codes too. Short lists can also be built to
only include billable codes, thus reducing the amount of time required to search.

To add codes to the CPT Short List:
1. Search for the code.
2. Check the box to the left of the code.

Note: To remove a code from the short list, uncheck the box.
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Add an Alternate Description for a CPT Alternate Descriptions

Many CPT codes already have alternate descriptions listed. Click the plus sign next to an individual CPT
code to expand the tree and reveal a node labeled Alternate Descriptions. Click the plus sign next to this
node to view all synonyms currently linked to this CPT code. Users may want to add more synonyms,
such as commonly used descriptions in your individual practice, to assist the billing staff in correct coding.

To add, edit or delete a CPT Alternate Description:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right click Alternate Descriptions and click Add an Alternate Description.
4. Type the new description in the box that appears and press Enter.

Notes:
•

To edit an Alternate Description, select it and right click. Choose the Edit Description menu
option. Make changes as desired in the pop-up window. Press either the Enter or Tab key when
finished.

•

To delete and Alternate Description, select it and right click. Choose the Delete Description
menu option.

CPT Search Keywords

Although keywords have already been linked to each CPT code, additional words may be added, if
needed, to improve search results and improve office speed, accuracy and efficiency.

To add or delete a keyword:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right-click Search Keywords and click Add Linked Keywords on the pop-up.
4. Enter keywords in the box that appears. If more than one word is added, separate them with a
space. Press Enter or Tab when done.

Note: To delete a keyword, right-click the keyword to select it, then select Remove Keyword Link.
To copy keywords to use on other codes:
Adding the same keyword to additional codes is simplified by creating a Keyword Copy List.
1. Right-click any keyword.
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2. Go to Keyword Copylist Operations > Add Selected Keyword(s) to List. A box appears with
the keyword.
3. Repeat for additional keywords that are to be added to the copy list. You can multi-select by
holding down the Shift key, then using the up and down arrow keys, or hold down the Ctrl key
and click multiple noncontiguous keywords.
4. Search for and select the code to which this list will be copied and expand to Keywords.
5. Right-click Keywords.
6. Go to Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. You
can also select specific items on the copy list using Shift and Ctrl, then go to Keyword Copylist
Operations > Insert Copylist > Insert Selected Items.

Notes:
•

When a new CPT code is added to the database, its description is automatically parsed into the
keyword list. However, if that description is edited at any point, the new words automatically be
added. At that point, simplify the task of adding the new keywords by right clicking on the
description and selecting the menu option labeled Parse Title into Keyword List.

•

To remove an individual keyword, select that word and right-click. Choose the Remove Keyword
Link right-click menu option.

Adding and Deleting CPT Codes
The CPT table is divided into categories and subcategories, each representing a range of related
procedure codes. The category ranges created by e-MDs cannot be altered, but new categories may be
added. A new category should be set up for custom codes (see below). The main CPT outline contains 6
pre-defined parent-level categories, and then other sub-level categories.

To add, edit or delete CPT categories:
1. Select an existing code range (yellow folders in outline tree) and right click.
2. Select Add Sub Category from the right click menu.
3. In the pop-up Category Entry window, enter the CPT code range in the From and To fields and
enter a Description for that category range.
4. Press either the Enter or Tab key when finished.
Note: CPT categories added by e-MDs cannot be edited or deleted. You can edit or delete your
categories by right-clicking the description, then selecting the applicable option from the menu.

To add, edit or delete CPT codes:
1. Right-click the appropriate category or sub-category.
2. Click Add CPT on the pop-up.
3. Enter the CPT code and its description and press Enter.
4. Set the Kind of Service in the Details section.
5. Check the In House flag if you perform this service in house.
6. Check the ABN flag if an Advanced Beneficiary notice is typically needed for this CPT.
7. Select appropriate type and place of service descriptions.
8. Modify the billing and detail descriptions if required.
9. Set a Code Valid date range if required.
10. Enter a Private (Office) fee, and a cost if known.
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11. Enter Categorical Modifiers by right-clicking in the box. Modifiers in this list appear in a helpful
short list in the invoice window (but users can use other ones too).
12. Enter a custom note.
Note: You cannot edit or delete CPTs created by e-MDs. To edit or delete a custom CPT, right-click
the description then select the applicable choice from the pop-up menu. See below for adding
custom and star codes.

Add Custom Codes to the CPT Table
Custom codes can be added to the CPT master tables in the Unofficial/Custom codes category. Custom
codes used for billing must be in the range X0000-ZZZZZ which is set up as the Custom Billing Codes
category. (Other custom codes are used by the rules editor that alerts clinicians in the Health
Maintenance windows). Custom codes are internal codes that are used to bill things like NSF Charges,
Medical Records Fees, No Show charges, and other products sold by the business.
Custom codes must be added to the Unofficial/Custom codes category in the CPT Search. Once this has
been done, custom codes can be added in the normal manner.

To add a category for custom CPTs:
1. Go to Reference > CPT Search (Alt+R, C).
2. Click Outline (Alt+O).
3. Right-click the CPT Outline (Current Codes) folder at the top and click Add Category.
4. Enter the code range and the description for the category. Note that this cannot overlap an
existing CPT category, and overlap a HCPCS category in the HCPCS search.
5. Press Enter to create the category.
Note: Charges for custom codes are entered into an invoice in exactly the same manner as entering
a CPT code.

Adding CPT “Star” Codes
You can create custom iterations of existing CPT codes using an asterisk (star). This is useful if you use
exactly the same code but with something slightly different such as a fee, lab tracking period in chart, etc.
Another example is if you may need to bill the professional and technical components of a fee instead of
the individual (e.g. 71020-26 and 71020-TC instead of 71020). In this example, adding custom codes
which can then be mapped to default modifiers in fee schedules and automatically pulled using a CPT
panel is used. When claims are generated, the system ignores the star and the code itself, but it will
appear in the Profit Center, etc.
Creating star codes is the same as creating custom codes, but when you enter the code, add an asterisk
and then a single alphanumeric character code (e.g. 99213*1).

HCPCS Search
The HCPCS Search tool contains the complete Level II HCPCS table along with various descriptions,
fees and other billing related data. Users are able to add additional custom codes as well as different
search keywords. Outline, descriptive or code based searches, short lists, commonly used abbreviations
and other features make the HCPCS search a powerful tool that goes beyond simply being a reference
tree.
The HCPCS Search is typically used from within an invoice, but can be loaded from other places for
administrative and other functions. This includes Code Linker, the superbill editor, from the Reference
menu, HCPCS shortcut panels, and charge sets.
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HCPCS Search Customization
The HCPCS Search is an extremely powerful tool. Users have several customization options.
HCPCS Search Options
View Options

Search By Options
Alternate Descriptions and
Search Keywords

Different levels of information can be displayed in the screen. These are controled
by several buttons on the toolbar:
•

Details: Loads a pane on the right of the window that shows default information
about a selected code including POS, TOS, office fee, RVUs, code valid dates,
etc. See HCPCS Details below.

•

View: Filters the code search for current, previous and future codes. Each code
is identified by the date that it was added to the database. Searches
automatically default to searching the database for current codes. To view
codes that were valid in the previous year, click the button labeled View, and
then select the Previous Codes option. This is a valuable tool when
resubmitting claims from a previous year. In addition, it is possible to add future
codes to the database and set the start date for sometime in the future. For
example, if you receive notice that new codes are coming, those codes can be
added to the database ahead of time. To view future codes, click View and then
select the Future Codes option.

•

Labels: A toggle that affects whether the toolbar buttons have labels or not.

You can search by keyword, outline, or HCPCS code. Keyword searches also have
different options that control the number and specificity of the matches.
Users can add custom descriptions (synonyms), include abbreviations to the list for
a particular code. This eliminates problems where procedures have similar
descriptions, but your office only performs one of them. It is easier for billers to
select from a list that only returns matches based on the descriptions submitted by
physicians.

HCPCS Code Searches
There are several ways to search for a HCPCS code.

To search by outline:
1. Click the Outline button (Alt+O) on the toolbar to display the entire HCPCS database in outline
form. The first level of the outline lists general categories (for example, Medical and Surgical
Supplies: HCPCS code range A4000-A8999).
2. Click the plus sign next to any category to further expand the tree, displaying the subcategories
(for example, Miscellaneous Supplies: HCPCS code range A4206-A4290). Continue clicking the
plus signs to drill down to individual codes.
Search can be by short list or full depending on the button clicked (Alt+S, or Alt+F). Short list searches
are much faster since they only return the codes that have a check in the box to the left of the code. You
can type the start letters for up to three words simultaneously, in any order, and in capitals or lower case.
To minimize the chances of typing or spelling errors, it’s not necessary to enter the entire description,
although at least three characters are recommended to avoid longer searches with too many results.

To search by keyword:
1. Type part of the description into the Keywords field. The Begins With, Contains and Exact Match
buttons above the field determine the rigidity of the search.
○ Begins With: (Alt+W) Only finds diagnoses with words anywhere in the description that start
with this letter combination.
○ Contains: (Alt+T) Looks for the keyword combination anywhere in a word.
○ Exact Match: (Alt+M) Only full words with an exact match for the description are returned.
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2. Press Enter on the keyboard, or click Search.
○ If a Short List search is initiated and no matches are found, the search automatically converts
to a full database search.
○ Avoid entering search strings that have many possible matches in the database by typing at
least 3 characters in the keywords, and avoid using non-descriptive words (e.g. “the”) or
conjunctions (e.g. “and”).
○ For codes that are used a lot during the day, click the list box arrow at the end of the
Keywords field to return your most recent searches. Select the keyword and click Search.

HCPCS Details
Click the Details toolbar button to review detailed billing notes for each HCPCS code. Click the button a
second time to close the Details window, if desired. The individual fields in the Details window are
explained below. When changes are made to HCPCS properties, clicking anywhere else in the window
saves the changes.
HCPCS Details Options
Type of Service

Type of Service is required when billing a HCPCS code. A default Type of Service
has been chosen for each HCPCS.

Default Place of Service

Place of Service is required when billing a HCPCS code. A default Place of Service
has been chosen for each HCPCS.
The default that will be used for institutional/RHC claims that require them. Click the
button to the right of the field to search for and select a revenue code. None is
displayed when there is no default, or you will see the code and related description.
The description used in invoices, statements and other reports.
Official, full-text, detailed description of the individual code. This field is unalterable
for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255
characters in length may be typed.
This field indicates the date range in which each code is active. For example, if a
new code is adopted on January 1st, 2001, that date will appear in the "From" field.
st
When codes are discontinued, the discontinuation date (typically December 31 ) will
appear in the "Through" field. These dates cannot be edited for e-MDs-entered
codes, but the field is active for user-entered codes.
If desired, the determining factors for the Relative Value Unit (RVU) assigned to
each code may be entered into the appropriate fields. The fields represent the total
RVU, the Work portion, Practice Expense, and Malpractice Cost. Updates are
distributed by e-MDs keep these current. The RVUs are also a component of the
formula used to calculate Medicare and Medicare-based fee schedules. The facility
and non-facility practice expense multipliers are used based on whether users
update fee schedules or costs using the facility or non-facility update options in
Reference > Fee Schedules and Rules.
The office fee for the procedure. This is the fee used when there is no facility default
fee schedule set up in the fee schedules reference table.
A cost can be entered for profitability reporting.

Default Revenue Code

Billing Description
Detail Description

Code Valid

Total, Work, Malpractice,
PE Facility and PE Non
Facility Relative Value
Units

Private
Cost
ABU
NDC
In House
ABN

Enter default anesthesia billing units for anesthesia CPTs. When generating claims,
this will be used in conjunction with minutes to calculate the total units.
The NDC (National Drug Codes) can be set for codes that are drugs. The system
will build the code into claims where there is a requirement for these.
Used by e-MDs Chart to determine whether the code is typically performed in house
(and therefore is billed for and appears in the e-MDs Bill invoice when the note is
billed), or send out.
Not used since 6.0 which added ABN prompting to fee schedules and rules.
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Link ICDs

In House

Cat 25
Lab Tracking

Kind of Service
Categorical Modifiers

Notes

If this option is set, when a code is entered on an invoice with multiple ICD codes,
the system automatically links all the ICDs to the code saving the user from having
to do this manually. It is typically set for all E&M codes as well as any others to
which this requirement applies.
The default in-house or send out status for a code. This is adopted when fee
schedules are generated from scratch. The property can be set in fee schedules
based on profitability by insurance. Fee schedules also include the ability to set
pass-through/purchased services as send-out billable. The setting determines
whether Bill pulls the code from a Chart note or not when an invoice is automatically
generated.
If this is set for a code, when that code is used in an invoice which also has an E&M,
then the modifier -25 is added to the E&M. Typically this is only used when there
are no fee schedules in the system.
Used by Chart. When the On box is checked, users are automatically notified via
TaskMan if results for labs, a referral consult, radiology reports, etc. have not been
received back after the number of Days set. The Chart Lab Tracking module also
has a global view should staff wish to see all outstanding orders for a patient.
Used by e-MDs Chart to determine which of the end of visit note order forms are
populated.
Modifiers that apply to the entire category in which a particular code falls can be
listed in this field. Some modifiers have already been assigned. Users can add or
remove modifiers by right-clicking in the field, or by using the Reference > Modifier
tool. Modifiers in this list appear in a helpful short list in the invoice window (but
users can use other ones too).
This is a free-text memo field with a 255-character length. Billing memos of any type
related to the selected HCPCS code may be entered.

HCPCS Code Short Lists
Short lists are the set of HCPCS codes used most frequently by your practice. The short list is searched
first when the Short search option is selected. Searches are much quicker using short lists but if no
matches are found, TopsSearch automatically searches the rest of the codes too. Short lists can also be
built to only include billable codes, thus reducing the amount of time required to search.

To add codes to the HCPCS Short List:
1. Search for the code.
2. Check the box to the left of the code.
Note: To remove a code from the short list, uncheck the box.

Add an Alternate Description for a HCPCS Alternate Descriptions
Many HCPCS codes already have alternate descriptions listed. Click the plus sign next to an individual
HCPCS code to expand the tree and reveal a node labeled Alternate Descriptions. Click the plus sign
next to this node to view all synonyms currently linked to this HCPCS code. Users may want to add more
synonyms, such as commonly used descriptions in your individual practice, to assist the billing staff in
correct coding.

To add, edit or delete a HCPCS Alternate Description:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right-click Alternate Descriptions and click Add an Alternate Description.
4. Type the new description in the box that appears and press Enter.
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Notes:
•

To edit an Alternate Description, select it and right click. Choose the Edit Description menu
option. Make changes as desired in the pop-up window. Press either the Enter or Tab key when
finished.

•

To delete and Alternate Description, select it and right click. Choose the Delete Description menu
option.

HCPCS Search Keywords
Although keywords have already been linked to each HCPCS code, additional words may be added, if
needed, to improve search results and improve office speed, accuracy and efficiency.

To add or delete a keyword:
1. Search for the code.
2. Click the + sign to the left of the code.
3. Right-click Search Keywords and click Add Linked Keywords on the pop-up.
4. Enter keywords in the box that appears. If more than one word is added, separate them with a
space.
5. Press Enter or Tab when done.
Note: To delete a keyword, select it and right-click, then select Remove Keyword Link.
Adding the same keyword to additional codes is simplified by creating a Keyword Copy List.

To copy keywords to use on other codes:
1. Right-click any keyword.
2. Go to Keyword Copylist Operations > Add Selected Keyword(s) to List. A box appears with
the keyword.
3. Repeat for additional keywords that are to be added to the copy list. You can multi-select by
holding down the Shift key, then using the up and down arrow keys, or hold down the Ctrl key
and click multiple noncontiguous keywords.
4. Search for and select the code to which this list will be copied and expand to Keywords.
5. Right-click Keywords.
6. Go to Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. You
can also select specific items on the copy list using Shift and Ctrl, then go to Keyword Copylist
Operations > Insert Copylist > Insert Selected Items.

Notes:
•

When a new HCPCS code is added to the database, its description is automatically parsed into
the keyword list. However, if that description is edited at any point, the new words automatically
be added. At that point, simplify the task of adding the new keywords by right clicking on the
description and selecting the menu option labeled Parse Title into Keyword List.

•

To remove an individual keyword, select that word and right click. Choose the Remove Keyword
Link right click menu option.

Adding and Deleting HCPCS Codes
The HCPCS table is divided into categories and subcategories, each representing a range of related
procedure codes. The category ranges created by e-MDs cannot be altered, but new categories may be
added. The main HCPCS outline contains 6 pre-defined parent-level categories, and then other sub-level
categories.

e-MDs Solution Series Bill User Guide 8.0 R00

52

To add, edit or delete HCPCS categories:
1. Select an existing code range (yellow folders in outline tree) and right click.
2. Select Add Sub Category from the right click menu.
3. In the pop-up Category Entry window, enter the HCPCS code range in the From and To fields
and enter a Description for that category range.
4. Press either the Enter or Tab key when finished.
Note: HCPCS categories added by e-MDs cannot be edited or deleted. You can edit or delete your
categories by right-clicking the description, then selecting the applicable option from the menu.

To add, edit or delete HCPCS codes:
1. Right-click the appropriate category or sub-category.
2. Click Add HCPCS on the pop-up.
3. Enter the HCPCS code and its description and press Enter.
4. Set the Kind of Service in the Details section.
5. Check the In House flag if you perform this service in house.
6. Check the ABN flag if an Advanced Beneficiary notice is typically needed for this HCPCS.
7. Select appropriate type and place of service descriptions.
8. Modify the billing and detail descriptions if required.
9. Set a Code Valid date range if required.
10. Enter a Private (Office) fee, and a cost if known.
11. Enter Categorical Modifiers by right-clicking in the box. Modifiers in this list appear in a helpful
short list in the invoice window (but users can use other ones too).
12. Enter a custom note.
Note: You cannot edit or delete CPTs or HCPCSs created by e-MDs. To edit or delete a custom
CPT or HCPCS code, right-click the description and select the applicable choice from the pop-up
menu.

NDC Code Maintenance
The functionality to add, remove and edit NDC codes for a specific HCPCS or CPT code, is found within
the HCPCS and CPT search windows. Once a code is highlighted code, the Edit NDC Codes button
becomes active and clicking the button opens the NDC Codes window. If no code(s) is highlighted, the
Edit button will not be active.
There is an option on this screen to select the “Default” code by pressing the star adjacent to the code.
Once selected, the star will appear orange. Only one code will have the ability of being the “Default” code
at a time.
Right-click functionality allows you to add a new code, edit an existing code, delete a code or change the
default code.
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NDC Code Maintenance
Options
New

The functionality of this button is to associate a new NDC for a HCPCS or
CPT code. There is no limit to how many codes can be attached at one
time.

Edit

This is used to edit the selected (highlighted) NDC Code. In the instance
that no code is selected, the Edit button will not be active.
This button is used to remove any codes associated. If you attempt to
delete a code marked as the Default code, you will receive the message,
“You are about to delete the default code. Do you wish to continue?” This
button is not active if no code is highlighted.
This column functions the same as in the HCPCS or CPT search. You
have the ability to select and change the default code with the star. The
window will update automatically and pull the primary NDC on top. A
default code is required and by default will be the first code entered.

Remove

Default Code

To add multiple NDC codes to single HCPCS/CPT code:
1. From the HCPCS or CPT Search windows, click the Edit NDC Codes button in the lower right
pane.

2. In the NDC Codes window, click the New button. This opens the Add New NDC Code window.
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3. Type the new NDC Code and Description in the provided fields. Select a Unit of Measure from
the drop-down menu and type a Quantity. Click Save.

Code Linker
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Code Linker is a utility within e-MDs Solution Series that enables the user to link various data items
together to help shortcut documentation. Items that can be linked include Billing Codes (ICD-9, CPT,
HCPCS), Educational Documents (Patient Education, Drug Education, and Curbside Consults),
Templates, Appointment Instructions, and Medical Art. The code linker is an extremely powerful tool
because it automates many routine functions, thus ensuring quicker data entry, better charge capture and
higher reimbursement.
The majority of links are used in e-MDs Chart. e-MDs Bill currently uses the tool to link a panel of HCPCS
to a CPT so that users are notified that there may be billable items linked to a CPT. If a CPT is entered in
an invoice which has linked items, the New Inv HCPCS button label turns from black to bold green. Users
can click the button and select from the list of HCPCS.
Detailed instructions on setting up links for e-MDs Chart are in that module’s user guide, but here are a
few examples of how it uses links:
•

Template-to-ICD: When a diagnosis (ICD) is chosen in History of Present Illness (e.g. abdominal
pain), the appropriate templates (e.g. HPI: Abdominal Pain, PLAN: Abdominal Pain) are available.
Although the user can search "all templates," it is quicker to present the linked templates so that a
search is not required.

•

ICD-to-CPT: For a specific diagnosis (ICD), appropriate orders (CPT codes) are available in the
Plan section of the Visit Note. Again, the user can search "all CPTs," but it is helpful to display a
list of linked orders first.

•

ICD-to-Patient Education: Rather than search thousands of documents, the user is presented
with a short list of Patient Education handouts linked to the diagnoses (ICDs) assigned in that
visit.

You can link either way. These instructions assume that you are linking HCPCS to a CPT. If you have a
standard panel that will be applied to multiple CPTs, refer to Copying Links from One Item to Another
below.
Note: Many links are created automatically by e-MDs Chart. When a user searches for and selects a
HCPCS code for a procedure, the system automatically assumes this is a standard and makes the link.

To create a CPT/HCPCS link or panel:
1. Go to Reference > Code Linker (Alt+R, O).
2. Click CPTs on the left and search for the CPT code and click Accept (Alt+A) to select. Code
Linker automatically opens all sections that already have a linkage. To make things easier to work
with, click the – sign on the blue bar separating sections. This collapses the list.
3. Click the + sign on the HCPCS section if it is not already open.
4. Click the Add button. The HCPCS Search appears.
5. Search for HCPCS codes. To link a single item, highlight it. To link multiple items, right-click the
HCPCS code and choose the option to Add Code(s) to Select List. This opens a Select List
window, listing all chosen items. Additional searches can be performed at this time. When all
desired items are in the Select List, click Accept. To select multiple codes at one time, click the
first code to be linked, hold down the Shift key, and then click another code to select a contiguous
series of codes. Or if the codes are not in a series, click the first code to be linked, and then while
holding down the Ctrl key, click the other codes. When the group of codes is properly highlighted,
right click and choose Add Code(s) to Select List.
6. Click Accept to load the item(s) into Code Linker.

To delete a link:
1. Highlight the HCPCS code to be deleted. Multiple codes can be selected by clicking the Select
All link or by using the Ctrl key and selecting specific items.
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2. Click Remove Selected.

Copying Links from One Item to Another
A helpful feature is the ability to copy links. For example, suppose a standard HCPCS panel with syringes
and rubber gloves is created for one CPT. The same panel can be used for many other CPTs.

To copy links:
1. Open the Code Linker so that an item is highlighted and all of its links are visible.
2. Select the codes that will be copied using Select All or the Ctrl key.
3. Click Copy Selected, then click CPT on the menu that appears. The system automatically opens
the CPT Search.
4. Search for the next CPT code that will use this panel. You can search for all the CPTs to which
this panel will be applied by right-clicking each in the CPT Search window and choosing the Add
Code(s) to Select List menu option. You can also select multiple codes from within the CPT
Search results using Shift and Control, then right-clicking and adding to the select list. This opens
a Select List window, listing all chosen items. Additional searches can be performed at this time.
5. When all desired items are in the Select List, click Accept.

Modifiers
Many procedure codes are billed with modifiers. Modifiers add further information to the procedure and
the use of modifiers can affect the reimbursement received. For example, rural health modifiers, modifiers
indicating the number and kind of practitioners performing the procedure, difficulty, timing, and even
specific fingers and toes. Use of modifiers can reduce claim rejections.
In e-MDs Bill, up to four modifiers can be added to a procedure. This is done at the time of invoicing.
Users can either enter a known modifier by adding a dash after the CPT code, and then typing the
modifier codes, or double-click the procedure after it is entered and pick from a group of modifiers related
to the procedure. Users are not limited to the group linked to the procedure. This is a guide.

To add or edit a modifier:
1. Go to Reference > Modifier (Alt+R, M).
2. To add a modifier, click New Modifier. To edit a modifier, search for the modifier, highlight and
click Edit Modifier.
3. Add or enter the modifier code and description. The memo field accepts up to 256 characters
which can be used to describe usage. This is viewable when posting charges and can be helpful
to billers.
4. Click Save (Alt+S).

To add, edit or remove a modifier from a group:
1. Highlight the modifier.
2. Click Edit Group.
3. In the CPT Modifier Group window, a list of the groups to which this modifier is already linked
appears. Select additional groups from the list box at the top of the window, then click Add. The
group will appear in the list. To remove from a group, highlight from the group in the list and click
Delete.
4. Click Close.
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Fee Schedules and Rules
Fee schedule based rules are one of the types of rules in the system that encourage cleaner billing and
work flow. These CPT and HCPCS based linked trigger alerts and other actions in Scheduling, Charting
and Billing and DocMan.
•

Schedule: Visit reasons can be linked to CPT codes. If there are rules associated with the CPT
code, appointments that use the visit reason trigger alerts to the user.

•

Chart: When physicians enter orders in the plan, these can trigger alerts.

•

Bill: When charges are saved, alerts can pop up. In some cases, the rules that have been set are
implemented automatically by the system. Other examples are rules that automatically cross
over codes, or split a procedure into the professional and technical components with modifiers.

•

DocMan: The ABN/Forms manager can be used to show a list of forms-based tasks generated
by rules so that users can scan the forms easily into patient charts and also ensure that all forms
are collected.

Note that you don’t have to use all the modules for the rules to be useful. The Fee Schedules & Rules
module is available in Bill, Chart and Schedule although some alerts may be displayed differently or are
not applicable in different modules.
If you use different e-MDs Solution Series modules, the system is able to link all the main elements of an
encounter (appointment, chart note and invoice) together using a common appointment ID. This ensures
that redundant alert prompts are not invoked when the rule has already been satisfied earlier in the
process. For example, if someone is scheduled for a procedure that requires an ABN form or referral, if
this is taken care of in Schedule the clinicians using Chart and the billers generating the claim will not
receive the notification. At the same time, if something is not dealt with there are multiple chances to take
care of it. Given that you are only likely to set up rules that are necessary, it is obviously a good thing if
you are nagged to take care of it when it has not been done.
Bear in mind that some requirements may only manifest themselves “down the line” because of new
actions that occur in the clinical or billing process which trigger new alerts. For example, a patient might
be scheduled for a generic visit reason that does not trigger warnings. When the physician treats the
patient, diagnoses might be made that are treated with procedures that do have rules. Likewise, a biller
might make coding edits to the ones pulled from the Chart and those could fire more rules. Thus, if a rule
is not or cannot be satisfied during the scheduling or check in process, users “down the line” will be
alerted to these. On the other hand, if they are taken care of up front, this will smooth the process for
other users and where this is possible, it is a recommended best practice.
Although most rules are available in all modules, some rule types are only fired in particular modules. For
example, adding modifiers is not done when scheduling. Thus, the warnings presented in the
CPT/HCPCS Alert window can be different depending on where it is accessed.

Hierarchy of Precedence for Insurance Based CPT Rules
Rules can be created for every insurance company. They are fired based on the allowed fee schedule
linked to a patient’s primary insurance group. If there is no allowed/contract/exception fee schedule, then
the billed/office one is used. For example, a patient scheduled for a procedure who is on Medicare can
trigger an alert to fill out an ABN. Another patient on a different insurance scheduled for the same
procedure could trigger an alert to get an authorization first. Rules can also be provider, specialty and
facility-specific meaning that different rules can be invoked for the same CPT code depending on for
whom and where the visit is scheduled.
The way this is handled is by associating a fee schedule to which the rules are assigned to an insurance
company. Insurance companies can be linked to both an allowed fee schedule (to ensure payments
match contracted rates) and a billed fee schedule (typically the office rates). In some cases users might
also choose not to link the fee schedules to insurances. Depending on how the system is set up, an
instance of CPT with its associated properties such as modifiers, POS/TOS and provider/specialty/facility
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specificity might not exist in a schedule. The latter is particularly true when users build what is known as
an “exception” fee schedule. This is where the fee schedule does not include every CPT code but only
those that trigger alerts, i.e. the exceptions to the general rule.

The Fee Schedules Window
The fee schedules window contains a lot of data, as well as functions and filters that make it easier to
manage them.
Fee Schedule Window
Toolbar

Access to the Fee Schedules Roster/Comparison report which is also under the
Reports menu in Bill.

Filters

The filters are very useful for generating shorter and more manageable lists.
•
From CPT/HCPCS and To CPT/HCPCS: The CPT or HCPCS label changes
depending on whether you arein the CPT or HCPCS tab of the fee schedule.
Lets you work on a shorter range. This results in quicker retrieval, refreshing
and less page scrolling.
•

Specialty: Permits filtering by any specialty specific codes you haveset up.

•

Provider: Filter for provider specific fees.

•

Facility: Filter for facility specific fees. Note that one can also set up default fee
schedules that are facility specific. This is typically only done with the default
office rates fee schedule.

•

Sort By: Gives options to sort by Code, Specialty, Provider, Facility, POS and
TOS. When this is done, it makes it easier to do a multi-select then right-click
to update multiple fees at the same time.

Fee Schedule List

The list to the left shows all the fee schedules in the database. You can narrow the
list using a name search which support wild cards (e.g. %aetna% lists all schedules
with “aetna” in the name). The fee schedule in bold in the default for the current
facility. Bear in mind that this can be different depending on which facility you are
logged into. You can set the default by right-clicking or under File > Options.

Options

These options as used for editing.
•

Hold Columns 1-8: There are more columns in the fee schedule grids than you
will fit on most screen resolutions. When you scroll right and left to view and set
properties it’s easy to forget which code you areworking on if it is hidden. This
button locks the first 8 columns and scrolls the rest.

•

Edit Fees Manually: When this is checked you can type valid values directly
into the grid at right. This can sometimes be the fastest way to update fees and
other properties because it is very much like typing into a spreasheet where you
put in a value then hit enter or use arrow keys to save and go to the next cell.
worry about typing in a value that is not valid – the system will give you a
prompt if that happens.

•

Applies To: This is also a tool that assists with editing. You can apply cost, fee
and rounding to all codes in a grid or a selected range. The Selected option is
extremely useful when you want to apply the same property/rule to a range of
codes. When this is the mode, you can select multiple codes and make
changes that apply to the entire selection. How this is done is discussed later.
To multiselect, hold down the left mouse button while dragging over the range
of codes; or click the first code and hold down the Shift key then use the up or
down arrow keys; or hold down the Ctrl key and click individual codes. Rightclick to modify the fees.
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Functions Tab

This tab gives you access to functions that help set fees and costs.

•

Rounding: You can round all or selected fees up, down or to the
nearest increment specified.

•

Cost Calculations: Costs are easy to set based on RVUs or
percentages of the fee. We recommend that these are set to give you a
rough idea of profitability. Manually enter costs for codes like labs
where you know an exact cost. The RVU cost calculation uses the
Malpractice and Practice Expense components.

•

Fee Calculations: There are a number of ways to set and update fees
automatically using RVU, cost and % or fixed markups. When RVUs
are used, the system references the Conversion Factor, Anesthesia
Conversion Factor and GPCIs in the facility File > Options window.
Codes that have a TOS of 7 or 07 use the anesthesia CF instead of the
general CF.

Contracts Tab

This shows all the contracts linked to a fee schedule and also gives you the ability to
manage links. The link type codes are B for a Billed link and E for an
Exception/Allowed link.

CPT & Fee and
HCPCS & Fee Grids

CPTs and HCPCS are in separate tabs.
•

Column sizing: You can set column widths to your preference by dragging the
vertical bar between each column heading. Then click the X at top right of the
fee schedules window to store the preference.

•

Column heading colors: These denote the specific data type. Gray is used
for the basic code and fee information. Green is for general options, blue for
global options and red for policy links.

•

Functions: You can use the buttons below the grids to modify and add fees.
You can also right-click a selection to open a window in which you can set and
apply properties to more than one fee, or make copies of a range but with a
slightly different property. For example, you can copy a range of codes and
create a provider-specific iteration of them in the same fee schedule.

Setting Up Fee Schedules, Rules and Rule Types
These instructions show you how to create a fee schedule and also describe the rules that can be
associated with each code. The next sections will cover how those alerts are presented to users and how
to take action on them, as well as how to link fee schedules to insurances.
Note: When you are in the Fee Schedules window, click the button with the blue question mark to open
the legend. This defines fields and columns and has basic editing instructions.
There are two ways to add a fee schedule. You can start a new one from scratch, or you can copy one.
The latter option is useful if you want to create a schedule with most of the same properties as an existing
one and can thus save a lot of time.

To create a new fee schedule:
1. Go to Reference > Fee Schedules and Rules.
2. Click New Schedule.
3. Enter a name in the Description field and click Save. A prompt appears asking if you wish to
add all the CPTs and HCPCS to the list. If you answer yes it will load every CPT and HCPCS
code from the master reference table. This can take a minute or two depending on your system
specifications. Clicking No creates a blank fee schedule into which codes will be added
manually. Most times you will add every code unless you are creating an exception schedule.
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4. If you need to add codes to the list, click Retrieve Fees. This enables the New CPT Fee button
below the list. If the code you want to add is a HCPCS code, click the HCPCS & Fee button first.
5. Add codes using a lookup or manually. You can do this in a mini editor or directly into the grid.
○ Editor:
a. Click New CPT Fee or New HCPCS Fee (as appropriate). The fee window opens.
b. If you know the code, enter it in the Code field, then press the Enter key. The values
for the Default Unit, POS, TOS, and other fields appear.
c. If you do not know the code, click the Find button to the right of the Code field, then
search for and select the appropriate codes.
○ Directly in the Grid:
a. Click the Edit Fees Manually button below the list of fee schedules.
b. Click the first empty cell in the CPT or HCPCS column of the grid (if you have already
entered codes, it is after the last code in the list). Using Esc will clear an entry and
uncheck the Edit Fees Manually box.
c. Type in a known code and press Enter. The values for the Default Unit, POS and
TOS fields for that code appear, and the cursor moves to the next cell, much like
entering data in a spreadsheet.
d. Continue this process until you are finished. If you end up with a blank line at the end,
press Esc.
Set the fees for the schedule. You can do this several ways:
○ Directly in the Grid: Follow the procedure in the previous step above.
○ RVU Based: You can set prices based on RVU for all the codes or just a selected range. This
requires you to have downloaded the latest RVUs in your database and also the correct
conversion factor and GPCI codes in File > Options. The RVU update, CF and GPCIs are
published on the support pages at www.e-MDs.com. Non-Facility RVU fees are for clinics and
such like. Facility fees can be used for hospitals. You can have both in the same fee
schedule if you use the filtering and sorting as well as the Applies To Selected options.
○ Percent Change and Fixed Mark Up: Updates the existing allowed fees by a fixed or
percentage amount. Click the applicable button, then enter the amount or percent. For a
percentage, the amount you enter is added to 100% of the existing fee. For example, if the
fee is $10.00 and you enter 10, the new fee will be $11.00.
○ Cost +: If you have a cost for the codes, you can set cost plus fees as a percentage of the
cost.
○ Rounding: Rounded numbers are easier to work with and many practices set them for their
private fees. You can round to 10c, $1.00 or $10.00 increments. This can be done for All or
Selected codes using the Applies To option. Set this option and then select the codes if for a
specific range. Click the Up, Down or Nearest direction radio button to determine how you
want to round. Then set the Increment and click Round.
The copy function expedites the process of creating a fee schedule that is similar to another one. You will
not have to set up as many rules and can also modify fees using the automated tools. For example, if
you want to set up a new fee schedule which is based on an existing Medicare one plus a certain %, you
can copy the Medicare and then use the percent change function.

To copy a fee schedule:
1. Go to Reference > Fee Schedules and Rules.
Select the fee schedule you want to copy in the Description box at screen left.
Click Copy Schedule.
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Enter a description for the new fee schedule.
Click Save. The new schedule is created with all the same codes, fees and properties as the copied one.
Depending on the number of codes in the copied schedule, this might take a minute or two depending on
your system speed.
If you are going to update properties or prices, use the functions described elsewhere in this section to do
those.
You should be familiar with the fee schedules window before you set rules and fees.

To set up code-based rules and rule types:
1. Go to Reference > Fee Schedules and Rules.
2. Select the fee schedule in the list at left.
3. Make sure you have the correct CPT or HCPCS tab open depending on the code you are editing.
4. Set code, specialty, provider and facility filters and sort options to retrieve a list that is easier to
work with.
5. Click Retrieve to load the codes into the right-side grid.
6. Select the code(s) for which you want to set properties. Remember that you can use the Hold
Columns 1-8, personal column width settings, Edit Fees Manually, and Applies To All or Selected
to make this process faster, depending on what you are doing.
○ Type into Grid: Allows you to type directly into the grid spreadsheet style. The system will
validate your entries and prompt if you enter unacceptable data.
○ Esc: Will clear an entry and uncheck the Edit Fees Manually box.
○ Edit Single Fee: Select the code and click the Edit button below the grid.
○ Range: Click the Applies to Selected option which lets you select a range of codes using
Ctrl+click or Shift+Arrow. When you have selected the codes, right-click in the grid and click
the Modify or Copy Selected Fees box to open the Modify Fees window. Properties you set
here can be applied to all the codes, or you can use this to make a copy of the range but with
a different identifier (e.g. provider or POS)
○ All Codes: Click Select All, then right-click the selection.
Set the properties. You can click the ? legend button for a brief description of each column. An important
note here is that, because some rules result in codes being substituted for each other, it could be possible
to generate an infinite loop so rules only apply one level deep. Specific property types are listed in the
"Properties Window" table below.
Save the changes. If you are working with a range of codes, click either the Apply to Selected Codes or
Copy Codes with Modifications button.
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Fee Schedule Options
Toolbar

Access to the Fee Schedules Roster/Comparison report which is also under the
Reports menu in Bill.

Filters

The filters are very useful for generating shorter and more manageable lists.
•
From CPT/HCPCS and To CPT/HCPCS: The CPT or HCPCS label changes
depending on whether you arein the CPT or HCPCS tab of the fee schedule.
Lets you work on a shorter range. This results in quicker retrieval, refreshing
and less page scrolling.

Identifier Grid Columns

General Grid Columns
(green columns)

•

Specialty: Permits filtering by any specialty specific codes you haveset up.

•

Provider: Filter for provider specific fees.

•

Facility: Filter for facility specific fees. Note that one can also set up default fee
schedules that are facility specific. This is typically only done with the default
office rates fee schedule.

•

Sort By: Gives options to sort by Code, Specialty, Provider, Facility, POS and
TOS. When this is done, it makes it easier to do a multi-select then right-click
to update multiple fees at the same time.

•

CPT or HCPCS Code: The code(s) to which the properties apply. This does
not appear when a range is selected since the list is in the grid below the tabs.

•

Units: The default number of units that are set when the code is added in Chart
or Bill. If this is blank, the assumption is a value of 1.

•

Modifiers 1-4: Add modifiers by typing valid ones into the cells or using the
Find function so you can create modifier specific iterations of fees (e.g.
professional and technical components). This is not where you set up default
modifiers to apply to a code.

•

POS: If a POS iteration of a code is used, the fee/rule is applied based on the
facility in which the code is used. This is the code linked to the internal or
external medical facility. If you have a POS match for the facility, then the
system will locate based on the first code it finds. This is actually quite
standard. For example a typical medical clinic that is POS 11 (office) where the
doctors renders services in a local hospital that is POS 21 will not have the
inpatient codes set up with POS 11 so mobile software tools or other data entry
method will pick up on the individual code. This is a critical value. If a CPT or
custom CPT is added manually to the Reference tables without a POS, or there
is no match for a fee schedule entry in the Reference > CPT table, the system
will not be able to set fees or run rules.

•

TOS: Typically not used since services are generally specific to a TOS. PreHIPAA, custom codes were used by some payors.

•

Specialty, Provider: You can set up fees and rules specific to any of these.
Provider and Specialty are mutually exclusive. The rule selected is based on
the provider for the appointment, in the progress note, or the DOS on an
invoice. The specialty link is based on the primary specialty in a provider file.

•

Facility: This refers to internal medical facilities. For default/office schedules,
creating facility specific iterations of a code in one fee schedule can be easier to
maintain than setting up multiple schedules. Simply add the “exceptions” for a
specific facility.

•

Fee & Cost: Enter a fee and cost. Remember that these can also be set
automatically using RVUs.

•

Requires Authorization (RA): If set to Y, the system checks to see if there is
an active, inbound authorization linked to the patient or to a case linked to the
visit. If so, this satisfies the rule (although it is possible that the referral may
have additional alerts if it is expired or invalid codes are used).
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•

Coverage (Cov?): This can be Y (covered), N (not covered), or ABN (requires
ABN). A message notifies users if this is N. If it’s set to ABN, then the system
adds or prompts for a modifier depending on the ABN Modifier property.

•

ABN Modifier (ABN Mod): This is used when generating an invoice and only if
the Coverage is ABN. ABN requires a modifier. If the ABN Mod is not set, then
users are prompted to add one in the alert. If a modifier such as GA is set here,
it is automatically added to the code. Click ABN Mod to load a list of modifiers
linked to the code and select one. If the one you want is not in the list, it can be
linked using the lookup editor in Bill, or you can type it directly into the field in
the grid or in the properties Options tab. You may also wish to link the ABN
form to the Word Form property on these codes.

•

Capitated (CAP): Only used when generating an invoice. Flags a code as
being capitated as opposed to carve out/FFS. If a contract is linked to the
patient’s insurance, that contract can be set up to automatically adjust capitated
codes at the time of creating the claim using a predefined adjustment code.
Carve out codes are left alone.

•

Paper Claim Only (Paper): Most claims are generated electronically, but it is
possible that some codes invariably result in a request for further information
from the payor. When this happens, the claim is typically printed and mailed
along with the requested information, so if you know this is likely to happen, you
can shorten the payment cycle by automatically dropping the claim to paper
immediately instead of waiting 10 to 30 days or so for the EOB request.

•

Use in Claim (Claim): Set this option to N if you never want the code to be in a
printed or electronic claim. An example of use is for custom tracking codes,
supplies codes that are typically bundled under another code but which you
want to track, or products that you sell over the counter which are paid for by
the patient. You can build them all into one invoice so that you have a better
system to track financials per visit instead of breaking them into a separate
invoice.

•

Cross Over (XO): Cross over codes are slowly being eliminated by payors but
this is still used. For example, many CPT codes must be billed to Medicare
using an equivalent G code. If you are also using Chart, this is beneficial
because the physicians can document the procedure description using the
same template and shortcuts and the billing system will handle sending the
valid code. Using these as an example, in the Medicare fee schedule, you can
set the G codes in the XO column for the codes that are normally used. Type
known codes directly into the grid or if editing a fee into the grid or click Cross
Over Code to do a lookup. The XO rule can also pull in a CPT Panel. This is
extremely useful where you may need to automatically splitting a procedure into
technical and professional components with modifiers, or add additional codes
(in this latter example your panel would include the original code plus other
codes). You can enter a panel code into the fee schedule just as you can when
posting charges by preceding the code with a forward slash (/). NOTE: When
you save the rule, you will not see the forward slash in the field. When the
invoice is saved the system will then cross over the entered code to the ones in
the panel. Examples of the uses described above is substituting single
procedure codes for ones that must be reported in their individual technical (TC) and professional (-26) codes with modifiers. Unlike most rules which run
one level deep in terms of executing on rule properties, rules will also run
against the crossed over panel codes so that default modifiers such as the -26
and –TC can also be automatically linked.

•

Bundle Code: Bundle codes are only used in Bill. If multiple codes are added
to an invoice that all have the same bundle code, the system will combine them
with a unit count of 1. This is also useful if a physician requests a lab in Chart
for multiple diagnoses using standard template charge sets. One cannot
typically bill for multiple iterations of the same lab. In the claim, the ICDs for the
diagnoses to which the order applies are automatically set in the 1 through 4
links.
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•

Revenue Code Roll Up Rules (RU, RUCode and RUMod): Only used for
Institutional claim formats (ANSI X.12 X096 claim, UB-92/HCFA-1450, and UB04). This automatically rolls up multiple CPTs with the same Revenue Code
onto the same line item with the option to add a modifier, and also affects the
printing of boxes 42 and 43 in the UB claim. There are multiple rules and
options associated with what prints. These can be viewed in the UB-04 field
datasource table on page 345. Note that the unit count for the items rolled up
will increment. Revenue codes for CPTs and HCPCS are linked under
Reference > CPT and Reference > HCPCS. It is important to note that this
only occurs at the claim file generation or printing level. The invoice still reflects
the individual CPTs so that you can maintain tracking of payments, utilization
and profitability against these.

•

Word Form: Click the button to browse for and select a form. This form will be
required when the code is used. The system alerts users if the form is not
completed and also provides a means to fill out forms on line, or print them and
scan them back into the system against the specific requirement so it’s
satisfied. Forms can be used in tandem with another property such as for ABN
codes with modifiers, or Letters of Medical Necessity. They can also simply be
information sheets for users to read or print for patients (e.g. a form linked to a
custom code created to track clinical trials patients).

•

Taxable (Tax): If charges are taxable, set the property to Y. When an invoice
is saved, the system checks for codes with this setting. If they exist, it then
adds a tax line item with applicable amount automatically. The code and rate
used for the tax is set up in Bill’s File > Options window.

•

In-House/Send Out/Send Out Billable (I/O): This is used when orders are
entered in Chart. When an invoice is generated from Chart, only codes that are
in-house or send-out/billable (pass through or purchased services) are pulled
into the claim. This setting can be used to control costs. For example, if you do
certain tests in house but a particular insurance company does not reimburse
this at a level sufficient to make a profit, you can set the default to send out and
the patient can get the test elsewhere. Physicians can override this default if
necessary.

•

Routing: You can link orders to a routing facility (or a department set up in the
external facilities demographics). Only facilities which have the Routing box
checked in the demographics form are available for selection in this field.

•

Co-Insurance Due (CI): This property determines whether or not the standard
co-insurance on an invoice applies or whether it is automatically zeroed out. It
is also only used in Bill. When the invoice is saved, a check is done against the
CPTs to see if any have this set to Y (the default). If ALL the codes are set to
N, then the co-insurance expectation on the invoice that is based on the primary
insurance group is set to 0.00.

•

Co-Pay Due: This option allows you to distinguish between co-payment and
coinsurance responisiblity when calculating different procedure calles. This
option can be set on a code-by-code basis or can be implemented for multiple
selected codes (by right clicking the Modify or Copy Selected Fees menu
option). The default setting for a new CPT/HCPCS code and fee added to a
schedule is to have the option checked (Co-Pay Due is selected). In order to
use this option, it must be linked to an allowed fee schedule.
The setting for this option appears in a new CP column on the CPT and HCPCS
tabs on the Fee Schedule screen. The values set for this new option also
appear in the detail grid of the Fee Schedule Roster report.

•

E&M Modifier Required (E&MMR) and E&M Modifier (E&MM): If the E&M
Mod Required Option is set to Y, when a claim is saved the system checks to
see if there is an E&M code on the invoice. If so, it automatically adds the
default modifier set in the E&M Mod field to the first code in the invoice that is in
the E&M range (99201-99499). If there is no default, then the user is prompted
to provide this.
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Global Grid Columns (blue
columns)

•

Default Modifier (DM) and Default Modifier Required (DMR): If the same
modifier such as QW for CLIA-waived lab tests is always required for a specific
payor, add it to the DM column. If a modifier is required but it is not always the
same one (e.g. F1-FA for fingers and thumbs or T1-TA on procedures), set the
DMR option so that users are prompted to add a modifier and can select one
from a shortlist.

•

Global Period (GP): The GP is the number of days that apply to the code. If
the code is used again within this period with the same primary diagnosis, then
the other global rules are invoked. In addition to the properties listed below,
when patients are scheduled or checked in using Schedule, or a note is opened
in Chart, or an invoice is created in Bill, a global alert is triggered if the patient is
in a global period for any code. In Chart and Schedule getting this alert is
based on a user File > Options preference but it always happens in Bill. The
detail of the alert can be viewed to see the codes and date of service that
triggered it, what the global period end date is, the physician who did the
procedure and the diagnosis. This will help staff if they need to schedule an
appointment outside the date range, waive a copay for a global follow up, add
modifiers, and so on. Note that the RVU update file that e-MDs provides for
users includes an option to update all fee schedules with the Medicare global
periods.
The RVU update installation fields that are posted on e-MDs Support Center
include an option to add Medicare global periods to all codes in all fee
schedules.

Policy Grid Columns (red
columns)

•

Addition Code (GP-Add), Addition Modifier (GAM) and Global Addition
Code Modifier Required (GAMR): These fields work together when saving an
invoice in Bill. If, within a global period, a specific code with the same primary
ICD is used again, then the addition code is automatically added to the invoice.
Should the GAM be set with a default modifier, this is added to the addition
code. In the event that a modifier is required but there is no default, setting the
GAMR property to Y will result in a prompt to the user to add a modifier.

•

Substitution Code (Sub Code), Sub Modifier (SCM) and Global
Substitution Code Modifier Required (SMR): These fields work together
when saving an invoice in Bill. If, within a global period, the code is used again
with the same primary ICD, then it is substituted for this code. For example,
substituting a consultation E&M code for the 99024 post-op follow up consult
code. You can also set a default modifier for this code if necessary in the SCM
field, or if there is no default but a modifier is required, check the modifier
required option. Note that you can substitute a code for itself if necessary to
use the modifier properties.

•

Conflict Modifier (CM): The global rules are based on a CPT with same
primary ICD being used in the global period. If the CPT is used again but with a
different ICD, the system automatically applies the conflict modifier (e.g. -24, 25).

•

Overall Period (MDays), Overall Modifier (MDDM), Overall Modifier
Required (MDMR): If the same CPT code is used again, but it is outside the
global period (GP), but within another period set by the payor (e.g. 365 days),
this applies a default modifier or modifier prompt to the code entered. For
example, a patient gets one hip replaced, then the other side several months
later. The same procedure codes would probably be used.

You can set up policies with specific requirements related to each that can be
presented to user based on a code being used in Schedule, Chart or Bill. Examples
of policy requirements are paperwork that might be needed for a new patient visit or
clinical trials patient, instructions to get lab work done in advance, or the need to fill
out a surgery scheduling form. The user can review the list of requirements linked
to a policy, and if a case is linked to visit you can actually satisfy these interactively.
Although it is typically simpler to set up one policy for a visit that encompasses all
the scheduling, billing and charting requirements so that different staff can satisfy
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these requirements. Once a policy is set up, it is linked to a CPT or HCPCS using
the Find buttons in the Policies tab of the CPT & Fee edit window. It is very
important to note that you can create custom codes as a way to link policies not
non-CPT based visits.

Linking Fee Schedules to Insurances
Fee schedules are used based on the link to the primary insurance group for a patient. The group can be
set manually, but it is much easier to set a default for the company to which the group is linked. Users
can also set up contracts. When a contract is linked to an insurance company, it sets the default fee
schedule which then applies to the groups. Bear in mind that a group can have both allowed and billed
fee schedules. As described earlier in this section, the system uses rules based on a hierarchy that starts
from the allowed fee schedule looking for exceptions, then goes to the billed/office, then the facility default
if it’s different to the billed, etc.

To link fee schedules to insurances:
1. Go to Demographics > Insurance. (You can also access insurance from within a patient file
which can be opened from multiple places.)
2. Search for and select the insurance company.
3. Click Edit.
4. Select fee schedules for the Allowed and Billed Fee Schedule fields. If you want to link based
on a contract, select the contract name first, then tab through the field. It will set the fee
schedules automatically.
5. Save the insurance company. This links the fee schedules to each group under the company.

About Allowed Fee Schedules
As noted previously, two fee schedules should be linked to each insurance company:
•

A Billed Fee Schedule (typically the Office fee schedule) containing the fees that the office or
facility charges for services and procedures.

•

An Allowed Fee Schedule (the Insurance fee schedule) containing the fees the insurance
company allows (contracted rates) for services and procedures.

Importance of the Allowed Fee Schedule
The system automatically enters certain invoice information based on the allowed fee schedule that is
linked to the patient’s primary insurance. For example, when a CPT code is added to an invoice, the
system searches the allowed fee schedule for that code and enters the associated fee in the allowed
amount field in the invoice.
However, if no allowed fee schedule is linked to the patient’s primary insurance, the system searches the
Default fee schedule for the fee associated with the CPT code and substitutes that fee for the allowed
amount because the allowed amount cannot be left blank. You must then remember to edit the invoice
and correct the allowed amount when you post a payment from the primary insurance if you are going to
file with a secondary.
Note: Remembering to correct the allowed amount is especially important if you use the posting
closeout feature available in e-MDs Solution Series. For example, if you file with a secondary insurance,
the allowed amount in the original invoice is one of the items the secondary requires in order to determine
their responsibility. If that invoice is included in a closed financial period, and you did not correct the
allowed amount before the closeout, it would be necessary to reverse the charge to correct the allowed
amount. You can avoid that situation by maintaining accurate allowed fee schedules for each insurance
company.
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The allowed fee schedule is also the source of code-based Insurance rules, such as notifications for
procedures that require pre-authorization.

Options for Building an Allowed Fee Schedule (Insurance Fee Schedule)
There are four standard options for building an insurance fee schedule:
•

Some insurance companies determine allowed amounts based on a percent or dollar amount
above what Medicare allows; in that case, you can create the insurance fee schedule by copying
the Medicare fee schedule and then updating the fees.

•

You can create a fee schedule and add the fees manually.

•

If you post payments manually rather than using an electronic EOB, you can create a fee
schedule and use the Fee Schedule Alert button to automatically enter amounts allowed by the
insurance company as payments are posted.

•

If the insurance company provides a spreadsheet containing allowed fees, you can contact eMDs Support for assistance with importing the fees from the spreadsheet to a fee schedule in eMDs Solution Series.

To build an insurance fee schedule based on the Medicare fee schedule:
1. In the menu bar of the Bill module, go to Reference > Fee Schedules and Rules.
2. In the Fee Schedules window, select the Medicare fee schedule.
3. Click Copy Schedule.
4. In the Description field, enter a name for the fee schedule.
5. Click Save.
6. Add a percentage or a dollar amount to set the fees:
To add a percentage:
a. Click the Percent Change button.
b. Enter the percent change desired.
Note: The percent change refers to the amount that will be added to 100% of the
Medicare allowable.
So, for example, if the desired result is to create fees that are double the Medicare
allowable amounts (in other words, 200% of Medicare allowable, or %100 above
Medicare allowable), the difference is 100%, so you enter 100 in the percent change
field. If the desired result is fees that are 150% of Medicare allowable, you enter 50 in
the percent change field. If the desired result is fees that are 95% of Medicare, you enter
(-5) in the percent change field. (In this case, you use a negative number because 95%
of Medicare allowed would be 100% minus 5%).
c. If you make a mistake, click Non Facility RVU to start over.
d. Click OK.
Note: Medicare does not reimburse for all codes, so there may be some codes with
dollar amounts of $0.00. Update these codes manually.
To add a fixed dollar amount:
a. Click the Fixed Mark Up button.
b. Enter the dollar amount that is to be added to each fee.
c. Click OK.
Customize the fee schedule as needed (edit codes, add custom codes, add rules).
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Link the fee schedule to the insurance company as the allowed fee schedule.

To build an insurance fee schedule and manually enter fees:
1. In the menu bar of the Bill module, go to Reference > Fee Schedules and Rules.
2. In the Fee Schedules window, click the New Schedule button.
The system displays the New Fee Schedule dialog box.
3. In the Description field, type a name for the fee schedule (typically the name of the insurance
company) and click Save.
The system displays a message box indicating that it may take several minutes to add all the
codes and requesting confirmation that you want to continue.
4. Click Yes. When all codes have been added to the fee schedule, the system displays a message
box indicating that all codes have been added.
5. Click OK. The codes are added to the schedule, but are not visible in the CPT and HCPCS tabs.
6. To view the CPT and HCPCS codes, highlight the name of the fee schedule and then click
Retrieve Fees.
7. When the codes are displayed, select Edit Fees Manually to “unlock” the fee schedule grid and
click in the cell containing the first fee to be entered.
Note: You can scroll to the codes for which you want to enter fees, or you can filter to retrieve a
range of codes.

Type the fee amount directly in the cell.
To enter the next fee, press the Enter key or click in the next fee cell.
When all fees are entered, clear (uncheck) the Edit Fees Manually option to save the fees.
Link the fee schedule to the insurance company as the allowed fee schedule.

To build an insurance fee schedule and use the fee schedule alert button to add fees:
1. In the menu bar of the Bill module, go to Reference > Fee Schedules and Rules.
2. In the Fee Schedules window, click the New Schedule button.
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The system displays the New Fee Schedule dialog box.
3. In the Description field, type a name for the fee schedule (typically the name of the insurance
company) and click Save.
The system displays a message box indicating that it may take several minutes to add all the
codes and requesting confirmation that you want to continue.
4. Click Yes. When all codes have been added to the fee schedule, the system displays a message
box indicating that all codes have been added.
5. Click OK.
6. Exit the fee schedule and link it to the insurance company as the allowed fee schedule.
All fees in the fee schedule are now $0.00, so when you create an invoice, the system will add
the $0.00 as the allowed amount for any code.
7. Send the invoice to the insurance company. When you receive the EOB and check, post the
payment.
8. Since the allowed amount ($0.00) is different from the amount posted, the system activates the
Fee Schedule Alert button.
9. Click the Fee Schedule Alert button to add the posted amount to the fee schedule. The allowed
amount for the code will be updated to reflect the payment amount posted.

Note: This must be done line by line. Clicking the Fee Schedule Alert button for the first line
item does not automatically update the allowed fee schedule for all line items on the invoice.
Populating allowed fees using the Fee Schedule Alert button should be delegated to only one person (or
two, at most). Either the office manager or a very senior biller is often responsible for this task. The
process should go on for a designated timeframe only. Typically about 2 weeks will capture 80% of the
codes the office uses.
Why restrict access to one or two people and a limited time frame?
•

To ensure that the amounts added are correct, the designated person should be someone who is
familiar with codes and what (approximately) to expect for payments. If a modifier is missing, for
example, the payment might be only $20 when should be paid $60. An experienced biller would
know to correct the modifier on the claim and not add the $20 to the fee schedule.

•

To avoid developing a habit. If billers routinely click the Fee Schedule Alert button after the
allowed amounts have been set, the fees may be overwritten with secondary insurance payments
or other adjustments and have the wrong values.

•

To avoid confusion regarding who is doing what in the fee schedules.
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Fee Schedule Rule Alerts and How to Satisfy Them

Alerts for various fee schedule rules appear in Schedule, Chart and Bill. The system can link all the
elements of a visit to an appointment and thus tracks whether rules have been satisfied, reducing the
incidence of pop-ups. The idea is to ensure that tasks are completed in a timely and appropriate manner.
For example, alerts to get a referral or forms should be taken care of as a function of scheduling or check
in. A policy alert such as a treatment protocol or instructions for notifying a health authority for a
reportable condition could be in the chart, and modifier and other billing edits should appear there.
It’s worth recapping how appointments, notes and invoices are linked so that the system knows if a rule is
satisfied. In Chart, when a progress note is started the appointment to which it is linked is displayed in
the Note Details window. It can be changed using the search function for the field. When an invoice is
generated from a note, the link is set there too. If an invoice is generated for an appointment using the
Daily Work List, the system will establish the appointment at that time and users can also use the manual
linking tools in the DWL to accomplish the same thing.
The CPT/HCPCS Alert window is very comprehensive. The sections of the screen are broken out to
match the alert types described previously in this section. While the mere presence of information in a
section will indicate an alert, some of them are in red to draw attention. To reduce pop-up fatigue, the
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Alerts window also encompasses other alerts that are independent of specific CPT or custom-CPT based
rules.
Alerts Window
Requires Authorization

Shows the CPT(s) that need an authorization. To satisfy this rule, click Cancel to
close the alert window, then add an authorization to the patient, invoice, or case.

Not Covered by Insurance

Shows the CPT(s). To satisfy this rule, you will either need to change the code
being used, or should probably stop scheduling, etc. or inform the patient that the
procedure is not covered.

Codes That Require Forms
and Forms Needed

The first part shows the specific code(s). If the code requires an ABN, this is
indicated with a Y in the ABN column. The form required for the code is also
displayed. The Forms Needed section is the total list of distinct forms. Thus, if 3
codes are used, but all require the same form, the system assumes that only one
instance of it is needed. To fill out a form, click the Manage Forms/ABNs button at
the bottom of the alerts window and open, print or scan the form from there. More
detailed help on this is on page 292. With tablets or signature pads you can even
get a form signed on screen and automatically saved in DocMan if you have
licensed it.

Unauthorized Codes

This is not technically a fee schedule alert. It is based on a referral/authorization
being linked to the appointment, progress note or invoice. If the referral has
restrictions on the specific ICDs and CPTs authorized but other codes are entered,
the system shows which codes are authorized and which are not. It also shows the
PCP/Referring physician and the authorization number. To satisfy this rule either
the codes need to be changed, or a new authorization applied for. If it’s just a case
of the default authorization being the wrong one, the alerts window can be closed
and then the demographics or invoice updated to add or change the default one.
Access to the referrals module is available in all places too.

Policy Alerts

The name of the policy is displayed. Click the Details button to view the
requirements on the policy. Policy requirements can only be satisfied interactively if
you have a case linked to the visit. Clicking the View Case button at bottom left to
get the interactive requirements where you can print forms.

Case Match Alerts

If a case is linked to the visit but the provider, provider specialty, supervisor or
facility match what is permitted in the case, this section of the notification is
populated. You can satisfy this alert by modifying the case (if permissable) by
clicking View Case. Alternatively, schedule the appointment and set the chart
provider or invoice provider for different resources or a different location.

Supervisor Warning

This alert only appears in Bill if the supervisor on the claim who is used as the
rendering is not credentialled with the patient’s primary insurance. You will need to
select a different supervisor.

Modifier and Code Change
Warnings

These only appear in the practice management system. Codes being added or
changed are shown. If modifiers are added and they are defaulted, then these are
displayed automatically and if there are no other alert types, the system does not
even display the alerts window. If the modifier requirement is a prompt to add one,
but there is no default “Not Found” is displayed. Double-click the cell to load a short
list of modifiers to make your selection.

Specific alert notifications and access points in modules are listed below:
Schedule Appointment
Save

Upon saving an appointment, the system checks to see if there are any alerts
associated with the code linked to a visit reason. If there are any, the alert window
appears.

Schedule Alerts/ABNs
Button in Edit
Appointment Window

Click this button on the toolbar to open the alerts window.
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Chart

If a code is used that triggers an alert, a yellow triangle with a red exclamation
pmark appears to the left of the code and the P(lan) button has a red border. Click
the alert icon, or the arrow on the plan button then Process Alerts.

Bill

Upon saving an invoice, the window appears automatically if any rules need to be
satisfied. You can also click the Process Alerts/ABN button at the bottom of the
Charges section. Worth noting is that if you click Cancel from the CPT/HCPCS Alert
window in Bill, the system will warn you every time you edit the invoice. However,
when rules have been satisfied and you click Accept, then the alert does not appear
again. This is based on the IsProcessed column in the charges grid. Once the
setting is Y, then the system assumes that whether you haveexecuted on the rules
or not, you want to be warned again. If you make coding changes to an invoice that
was generated from a chart note, the system automatically inserts a time and date
stamped invoice addendum on the note that details these.

DocMan

The Process Alerts/ABN button is on the toolbar or under Tools > ABN/Forms
Manager. When opened without a patient being loaded, you can list all outstanding
forms that the system expects as a result of rules being triggered. Thus the
scanning personnel can select one of the entries and then scan the form, saving
having to check off the rule or name the form. Think about these entries as
“expected forms requests”.

Fee Schedule Reports
There are several reports linked to fee schedules. These include reports that give you the ability to
compare fee schedules with each other based on contracts, service dates, utilization and other factors.
•

Fee Roster/Comparison Report: This generates several reports. There is a roster that shows
all the properties for fees and can also include contract linkages. The comparison tool is a very
powerful way to analyze fee schedules using historic utilization and reimbursement ratios.

•

Fee Schedule Insurance Crystal Report: This is a much simpler list that shows the very basic
fee information without the extended rules and options.

RVU Updates and Fee Schedules
Fee schedules and costs can be calculated using the RBRVS using a formula that combines the annual
conversion factor (CF), geographic practice cost indices (GPCIs) and anesthesia CF, and relative value
units (RVUs) for each CPT.
The RVUs (and Medicare global periods) can be updated by downloading an update file posted by e-MDs
each year. We also publish the GPCI and CF values in a table on the web site.

To obtain the RVU table update:
1. Back up your database.
2. Connect to the Internet, then navigate to e-MDs Support Center at
http://supportcenteronline.com/ics/support/default.asp?deptID=3222.
3. Log in. If you have an account yet, click the button to Request for a New Account – a login will be
sent back to you after e-MDs has verified your account.
4. Navigate to the Downloads and/or Knowledge base to find the appropriate files for the calendar
year. You can also use the search functions to find the information you are looking for.
5. Download the update file and help documents to your network.
6. Once you have copied the file to your local system, double-click it to start the update.
7. Click Next in the first step of the wizard.
8. Enter your database login. If you know this, contact your system administrator who set it up.
Then click Next.

e-MDs Solution Series Bill User Guide 8.0 R00

73

9. Enter the name of the database. This is typically TopsData. Click Next.
10. Click Install. The system adds the facility and non-facility RVU values for all the CPTs in both the
master reference and fee schedule tables.
11. Click Finish when the wizard is complete.

To update the GPCI and conversion factors used in the RVU formula:
1. Go to the Support pages at www.e-MDs.com.
2. Locate the GPCI table for the current year.
3. Open Bill and go to File > Options.
4. Enter CPT Conversion Factor which is also published on the GPCI page.
5. Look up your Medicare locality in the GPCI table and enter the applicable Work GPCI, PE GPCI,
MP GPCI and Anesthesia Conversion Factor.
6. Save the options. If you have facilities located in multiple localities with fee schedules for each,
log into each facility in turn and repeat.

Deleting Fees and Fee Schedules
As with all deletions in e-MDs Bill, a hierarchy must be satisfied before a fee schedule can be deleted.
You must first delete all fees within a schedule, as well as remove all links to insurance groups as per the
instructions above. The Delete Schedule button is available until this has been done.

To delete a single CPT fee:
1. Select the fee schedule, and then select the fee.
Click Delete CPT Fee, and then click Yes.

To delete all CPT fees in a schedule:
1. Select the fee schedule.
2. Click Delete All, and then click Yes.

To delete a fee schedule:
1. Select the fee schedule.
2. Click Delete Schedule, and then click Yes.

Archiving Fee Schedules
The Archive function in fee schedules creates a copy of the fee schedule that you archive and at the
same time, it links all the charges that were entered under this fee schedule to this copy so that the
historical links are also maintained. The historic copy can then be used for reporting purposes without
affecting the integrity of the data as it was when it was valid. For example, you might want to run the
comparison report to see if your projections for the year based on a prior year actually turned out the way
you expected.
Whenever a charge is entered in an invoice, the system also stores the fee schedule detail record ID with
the charge. This helps to cross reference rules but is also part of the archiving process. When the fee
schedule is archived the same function searches the table where all the charges are stored and switches
the fee schedule detail identifier to the identifier for the archived copy.
Because the archive is a copy of the fee schedule used when entering charges, you will then need to
apply new fees and other properties after creating the copy. This is done to the same fee schedule that
you have always used. The benefit of doing it this way is that the system is always using the current
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record and you have to go and update the links to the fee schedule in contracts, insurance companies,
and insurance groups.
The update function is usually done at the same time that you archive contracts which are linked to the
fee schedule. Refer to the contracts section of the user guide for more information about this process.
Note: Because this operation updates all historic fees billed under the schedule, you may want to
perform this operation during a time when activity on the network is relatively light. It can take some time
depending on the number of records and hardware.

To archive a fee schedule:
1. Ensure that you have completed all the charge entry for the period during which the fee schedule
was valid.
2. This is an irreversible operation, so please perform a database backup to protect your data.
3. Go to Reference > Fee Schedules and Rules.
4. Select the contract you are going to archive in the fee schedule list.
5. Click Archive. A warning prompt appears notifying you that this is an irreversible operation.
6. Click Yes to continue or click No to stop.
7. Enter a description for the copy. This can be done in a way so that it goes to the bottom of lists
and maybe includes a date identifier. For example “Z2005 Aetna”. If this example is used for all
2005 schedules, they will appear together. You can also put the year at the end so all historic
Aetna fee schedules appear next to each other.
8. If you are not sure you want to continue, click Cancel. Otherwise, click Save.
9. A confirmation prompt appears indicating again that this operation cannot be reversed. Click No
if you want to stop; otherwise, click Yes.
The system will begin to update all the historic fees linked to the fee schedule. Depending on the
number in your system, this could take a while. When the operation is complete, the new fee
schedule name appears in the list.
10. If you are using contracts that are linked to these fee schedules, you should archive the contract
(see the contracts section) and then link the archived copy of the fee schedules to the contract.
11. If you want to change the name of the current schedule, select it and click Edit Schedule, then
save your changes.
12. Update the current fee schedule to reflect the new fees and other properties.
13. Notify your staff that they can now enter charges for the new contract period.

ABN/Forms Manager
The ABN/Forms Manager is a tool that is used to satisfy forms based rules which are triggered by cases
or fee schedule rules.

CPT Panels
A CPT panel is a set of CPTs linked to a short cut code. Panels of commonly used CPT combinations are
set up to speed data entry. For example, a Chem 7 would take 42 keystrokes to enter if the CPT for each
lab is entered individually. But all of these can be linked to a code such as C7 which, with the Enter key,
is only 3 keystrokes. This is a significant speed and efficiency improvement.
Another example of the use of CPT Panels is where users may typically enter one code such as an order
for a procedure in Chart, but it has to be billed to a payor as multiple other codes. Medicare, for example,
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often requires a procedure to be billed using the technical and professional components with the –TC and
-26 modifiers. A panel can be set up to include two custom CPTs which are then mapped to default
modifiers in the Medicare fee schedule. For example, if billing a 71020 X-Ray, you can build 71020*T
and 71020*P custom (starred) CPT codes, add those to your fee schedule for Medicare with default
modifiers of TC and 26 respectively, and then map a panel to the original 71020 which will pull the
components automatically.

Notes:
•

CPT Panels are also known as burst, explosion and shortcut codes.

•

CPT Panels are loaded using the Panel field in an invoice.

•

Users can also create charge sets that can include ICD codes. A charge set can include a CPT
Panel. See Charge Sets for more information.

To create a CPT panel:
Go to Reference > CPT Panel.
1. Click New.
2. Enter a Panel Code. This code will be used to load the panel into an invoice.
3. Enter a Panel Description.
4. Click Save.
5. Ensuring the name of the panel is highlighted in the top section of the window, enter CPT and
HCPCS codes into the appropriate fields in the middle of the CPT Panel window and press Enter
to load them into the panel.

To delete a panel or a code in a panel:
1. Go to Reference > CPT Panel.
2. Select the panel in the CPT Panel window.
3. To delete the entire panel, click Delete and then answer the confirmation prompt in the
affirmative.
4. To remove a code from a panel, highlight the code in the bottom section of the CPT Panel
window and click Delete Link.

To use a CPT panel:
1. Type the Panel Code into the Panel field of the invoice window.
2. Press Enter. The CPT and HCPCS codes will drop into the invoice.

Revenue Codes
Revenue codes are used for rural health and institutional billing. They are linked to CPTs so that they
become the default for the practice when billing with particular CPT. Revenue codes are reported in Box
42 of the UB-92.

To add a revenue code:
1. Go to Reference > Revenue Code (Alt+R, R).
2. Click New (Alt+N).
3. Click New again (Alt+N).
4. Enter the code and the description.
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5. Click Save (Alt+S).

To link a default revenue code to a CPT/HCPCS:
A default revenue code can always be changed at time of invoicing in the Edit CPT/HCPCS window.
1. Go to Reference > CPT Search (Alt+R, C) or Reference > HCPCS Search (Alt+R, H).
2. Search for and select a code.
3. Make sure the Details button is selected so the expanded information about codes displays at
the right.
4. Click the button to the right of the Default Revenue Code field to open the Revenue Code
Search window.
5. Enter a code or description in the Search field and press Enter or click the Search button.
6. Click the appropriate revenue code.
7. Click OK (Alt+O).

Adjustment Group Codes
This table is used to maintain the list of insurance adjustment group codes that can be received from
payors on paper EOBs or in electronic ERA files. The table conforms to the ANSI X.12 HIPAA standard.
You delete any entries from the table.

Adjustment Reason Codes
The adjustment reason codes table is used to maintain the codes that can be received from payors on
paper EOBs or in electronic ERA files. The table conforms to the ANSI X.12 HIPAA standard. Users
delete any entries from the table. The main reason the table is editable by system administrators is to
change the post/non-post flag, as well as to add your own personal codes for more rapid data entry.
Most reason codes sent in an electronic remittance are information only and are not actually posted
against a line item’s balance although some are posted in the other adjustment code columns for COB
purposes. Users will, however, make decisions are to whether or not to refile a claim, transfer the balance
to the patient or something else so even non-posted items are displayed in the remittance window. (Items
that are posted against the balance of a line item are show in the remittance window with a green check
mark.)
In the event that a particular reason code in the database is marked incorrectly, the auto post status
should be changed in this reference table to prevent users have to remember to manually change the
status with each remittance that contains the code.
Adjustment reason codes can also be entered by hand for those EOBs that are posted manually. This
facilitates more rapid data entry because the description is already linked to the codes which are at most,
4 characters long.

To change the reason code auto post setting:
1. Go to Reference > Reason Code (Alt+R, N).
2. Search for and select the reason code, then click Edit (Alt+E).
3. Click the Yes or No radio buttons, as appropriate.
4. Click Save (Alt+S).
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Patient Recall Types
The Patient Recall Types table is where the different types of recalls for patient follow ups are created.
Recalls can be linked to a patient file. A recall can be linked multiple times to one patient file for different
dates, and there is no limit to the number per patient. Thus, these become flexible custom date fields. The
Patient Dates Roster, Notice Processor, and Patient List reports can be used to retrieve batches of
patients matching a recall type.

To add a recall type:
1. Go to Reference > Patient Recall Types (Alt+R, A).
2. Click New (Alt+N).
3. Enter an Internal Name. This is the name that users will see when linking to patients.
4. Enter a description, if required.
5. Click Save (Alt+S).

Patient Education
The patient education tables contain nearly over 1,000 handouts that can be printed for patients. Most of
these have also been translated into Spanish. Users can add, copy, import and customize documents.
You can also add additional translations to meet specific physician communication requirements to
improve patient compliance with treatment and also reduce the number of callbacks from patients after
they leave your office.
Patient education documents included in the system cover the following general areas:
•

Disease, sickness and injury information.

•

Visit type information (physicals, well child, etc.)

•

Test and procedure explanations and reasoning.

•

Alternative medicine information.

•

Other such as preventive education, weaning and baby feeding, etc.

•

General information (car safety seats, gun safety).

You can create documents from scratch using the patient education document editor which is much like
Microsoft’s Word Pad. This includes rich text functionality such as bold, underline, italics, font sizing and
coloring. Embedding images in the documents is not currently supported (although you can use the Word
Forms editor if this is a must).
There are many sources of excellent patient education such as medical specialty societies. If there are
no copyright restrictions on those sources, you can copy and paste, or import .txt (text) or .rtf (rich text)
files into the patient education system.
Note: As with all master content, if you wish to modify e-MDs supplied information, we recommend that
you make a copy and modify the copy so that your changes are not overwritten by e-MDs content
upgrades. In the patient education tables, all documents that have a blue book icon are master content.
Your content has a gold book icon.

To create or import patient education handouts:
1. Go to Reference > Patient Education.
2. Click Add.
3. Enter a title and press Enter. A basic document editor opens.
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4. If creating a document from scratch, start typing, or copy and paste from a source that does not
have copyright restrictions. To import a .txt or an .rtf file, go to File > Load, select the applicable
type from the Files of Type list box in the Open window, then browse for and open the document.
You may still need to work at the formatting to meet your needs.
5. Click Save . You can also add translations and search keywords to make the document easier
for staff to locate.
Translations:
a. Click the + sign to the left of the patient education document, then right-click the
translations icon.
b. On the Add Translation menu, select the language.
c. Type a document title and press Enter to open the editor in which you can create the
document just as for the master English document.
Search Keywords:
a. Click the + sign to the left of the patient education document, then right-click Search
Keywords.
b. Click Add Linked Keywords.
c. Enter keywords separated by commas, then press Enter.
You can print one or more patient education documents at a time. For clinics which use Chart the
documents are typically printed for the patient as part of using that module, but you can also print directly
from the patient education search and when saving invoices.
Depending on the type of document, these can be printed at checkout and handed to the patient. In
some cases, it may be beneficial to send these along with patient instructions handouts in an e-mail sent
prior to an appointment.

To print patient education documents:
1. Go to Reference > Patient Education.
2. Using the Short List search, enter keywords and press Enter. (Short List documents are those
that have a checkmark in the box to the left of the title. If documents are not found in the Short
List search, the system automatically goes to the Full Search. You can also search by Outline.)
3. Click the document title, then click Print.
OR
If printing a translation, prior to printing, click the + signs to the left of the document title, click the
Translations heading, and click the appropriate translation.

Notes:
•

If you have Chart, it is usually easier to print patient education when signing off the note. The
Code Linker tool makes it easy to link documents to specific diagnoses so that the physician can
rapidly select targeted documents for the patient. Code Linker also remembers selections
automatically so that the next time you are looking for documents for something specific, you will
have a short list.

•

The invoice window has an option to Print Patient Education. When checked a window appears
on save with a list of the documents linked via Code Linker to the ICDs and CPTs in the invoice.
The default language is set to the home language in patient demographics if a translation exists,
otherwise it will be English. You can double-click a title to view it, or open the full patient
education search by clicking Search.
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City, State, Zip
This is a master content table supplied and updated by e-MDs. The only time that it should be necessary
to modify this is where a city might change it’s incorporation, and thus the city and state that are filled out
when a zip is entered are different than reality.

To modify a zip code:
1. Go to Reference > City, State, Zip Code.
2. Search for the Zip, City or State.
3. Highlight the record and click Edit.
4. Change the information.
5. Click Save.

Follow Up Actions
The follow up actions reference table is used to enter standardized collections activities. A follow up
action can include a specified number of days by which the action should occur. The days are added to
the date the action is linked to the invoice. You can also specific an assigned follow up user who is
responsible for performing the task. Follow up actions can be added to invoices manually or
automatically. They ensure timely and informed collections processing. The collections module includes
filters that let users search on follow up actions as well as follow up dates and assigned users.
Before entering follow up actions, consider the typical collections activities in your practice. These might
include automatically refiling a claim if there is no response within a certain number of days, calling
patients a week after they have promised to send a check in the mail if it is not received, and so on. In
some cases, these activities may also be assigned to billers who are best at that activity. This activity or
assignment may even be based on a specific insurance class. All of these are elements in follow up
actions.

Automatic Follow Up Actions
Automatic follow up actions can be set up based on filing an invoice to insurance, or printing a statement.
These are dependent upon setting up follow up actions that are named exactly “INSFILED” or
“STATEMNT”. When these exist and the actions are performed, notes are automatically added to
invoices along with the follow up days and assigned user. An additional benefit to automatic follow up
actions is that these can be associated with an invoice status code which adds another search and
display dimension for revenue cycle management. These follow up actions are part of the master content
in the system. If you want the automated actions, edit these master entries and change the description.
You can create duplicates with different follow up users for different insurance classes if necessary.
The invoice note entries generated when these follow up actions are used are:
•

INSFILED: Date/time and user stamp; invoice note showing file status, insurance filed to, batch
number and financial group (e.g. “EF Claim filed to Medicare, Batch Number: 1032, Fin Grp:
MDC”). Depending on how the action is set up, you may also have an assigned to user and
follow up date, and an invoice status code.

•

STATMNT: Date/time and user stamp; invoice note that reads “Printed Statement.” Depending
on how the action is set up, you may also have an assigned to user and follow up date, and an
invoice status code.
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To enter a follow-up action:
1. Go to Reference > Follow Up Action.
2. Click New or select an existing code and click Copy. Copy is particularly useful for creating
follow up actions that are the same but for different insurance classes.
3. Enter a Description for the follow up action (e.g. Verify receipt of patient payment). This can be
duplicated if you are creating like actions for different insurance classes. To automatically
generate follow up actions based on a claim being generated or a statement printed which
includes an invoice, use INSFILED or STATEMNT (see above for detail of what they do).
4. If required, enter the number of days from the date of entry at which this action must be
performed. The default is 1 day. When users select this follow up action, a follow up date is
automatically set by adding this number to the current date (e.g. if the number of days is 7, and
the action is entered on 1/1/04, the follow up date is 1/8/04).
5. If necessary, enter a Default Assigned User.
6. If necessary, enter an Insurance Class Code. This permits duplication of follow up descriptions
where some other element of the follow up is different. For example, one biller may be assigned
MDC and MDD collections tasks, while another is assigned the same task but for all other
insurances. When selecting actions with the same description for different classes, the system
displays only one instance of the description but selects the action based on the class.
7. Link to an invoice status code to add an extra collections dimension that is also displayed
prominently in various posting and collections windows.
8. Click Save.

Invoice Status Codes
Invoice status codes give users a way to segregate invoices for collections and other purposes. An
invoice can be marked with a particular status which is then displayed in the invoice and payment
windows. The code also appears (with the assigned color if applicable) in the posting window, collections
module and daily work list. Status codes are a filter in the collections module, daily work list and the main
posting ledger window. Marking an invoice with a status is done via pick lists in the invoice and payment
windows, as well as by assigning a follow up action that is linked to a status code. An invoice status can
also be set automatically based on certain criteria.
An invoice status may change as it goes through the billing cycle. If you want to keep a history of how the
status has changed over time, add the status codes using the invoice notes. Each invoice note has a
status code field in its database record which is maintained over time in addition to updating the code for
the invoice whereas simply modifying the status code in the Posting or Charges & Payments window is
updating the current code.
The following are some examples of how you might use invoice status codes:
•

Link an appeal status code to an appeal follow up action that has a set number of follow up days.

•

Link a hold code so users can utilitize this as well as the hold flag in the claim prepare to ensure
held invoices are eventually corrected and filed.

•

Mark an invoice as closed when the balance is zero.

•

Mark an invoice that has been transferred to a collections agency.
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Automatic Status Codes
Invoice status codes can be set automatically when certain setup items are enabled and actions are
performed:
•

P_INS: When an invoice with insurance is saved, or an insurance is reflagged for filing, the status
is set to this upon saving the invoice. The requirement is to have this exact status code.

•

Insurance Filed: You can link an invoice status code to the INSFILED follow up action. The
status code can be the master code or FILED or any other code you choose.

•

Statement Printed: You can link an invoice status code such as STMT to the STATEMNT follow
up action. When a statement is printed that includes an invoice, the follow up action and
associated status code are automatically set.

Each of the status codes can be in your own custom color and if they are linked to follow up actions that
are insurance class specific, you can even have different status codes for the same follow up action
based on the insurance.
If you want the P_INS and FILED status codes to be set automatically, change the P_INS and FILED
master entries in the Invoice Status Code table to something else (e.g. Z_INS, ZILED).

To create an invoice status code:
1. Go to Reference > Invoices Status.
2. Click New.
3. Enter a status code of up to 5 characters.
4. Enter a description.
5. If needed, select a color. Colors can be useful to draw attention to the invoice status in the
posting window, daily work list and collections work list.
6. Click Save.
Note: Future releases will set invoice status codes automatically. In the current system, there are
two master entries that will be used in the future: P_INS (pending insurance) and FILED (claim has
been filed). Do not try to change these codes – any upgrade will reverse your changes.

Setting Invoice Status Codes
There are multiple ways to set an invoice status code:
•

Invoice & Payment Windows: Open an invoice or payment and select the code from the list
boxes in the windows.

•

Invoice Notes: Select a follow up action that is linked to a status code, or select the code from
the pick list at the top of the invoice notes window.

Retrieving Invoices With a Status Code
There are three ways that an invoice with a specific status code can be retrieved. It is important to note
that these only search on the current invoice status code for invoices. The only way to review a history of
status codes is if they were set using invoice/collections notes and then opening the notes window for the
invoice.
•

Collections Module: Use the status code filter, or search using a follow up action linked to the
status code.

•

Daily Work List: Select one or more status codes in the Filters section of the daily work list. To
select more than one, hold down Ctrl and click the codes needed. Then click the Work List link at
the top of the window to retrieve the list. Status codes for items retrieved appear in the IS
column. You can sort entries in the list by clicking the IS column heading. (If you double click the
IS cell, it opens the invoice notes.)
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•

Invoice Status Administration Tool: This tool is used to update multiple invoices matching
date, balance or current status criteria. See Invoice Status Administration on page 264.

Contracts
The insurance contracts system gives you the ability to track and manage contracts. The contract
management system includes the following primary functions:
•

Contract demographics: (name, organization to which it applies, insurance class, contact
information, etc.).

•

Contract effective dates: These are useful because they give you the ability to monitor which
contracts need review because they are coming due.

•

Contract scan: You can scan a copy of the contract to make it easier to retrieve for review
purposes.

•

Memo/Notes: You can add free text notes to the contract so you can track conversations, etc.

•

Fee schedule and eligibility defaults which are in turn linked to insurance companies under this
contract.

•

FQHC/RHC Auto Charge Entry: You can specify an encounter code to add to each invoice.

•

Automatic contract and capitation adjustments: You can set properties that help in the
payment posting process by saving time and also ensuring adjustment reason code data is
captured for later analysis.

•

Contract reporting: The Contract Management reports include the ability to print rosters and
build interactive work lists for contract review purposes. The reports also have the ability to track
utilization and reimbursement by contract and compare to other contracts so that you can make
sound business decisions when it comes to negotiating rates.

•

Withhold tracking and reporting: You can set up third party withhold information so you can
track adjustments, costs and expected reimbursements.

Why Use Contracts?
While you can use the contracts system to simply keep track of basic contract information, if you want to
take advantage of its full analysis and time saving potential, you need to understand how contracts work
in conjunction with insurance companies and groups, and charge entry particularly as this relates to the
use of fee schedules and also some split billing scenarios.

Fee Schedules and Contracts
Part of a contract’s setup is to associate default billed and allowed/exception fee schedules with it. The
insurance company demographics file has similar fields. They are set automatically to the contract
defaults when you link a contract to the company. For every group created underneath the insurance
company, these fee schedules are also defaulted because they are adopted from the insurance company.
When charges are entered for a patient who has insurance, the system checks to see which allowed and
billed fee schedules are associated with the primary insurance group on the invoice. (While the ability to
link down to the group gives you extreme flexibility, for simplicity’s sake we recommend that you avoid
updating the fee schedules for groups – do it at the company level.)
When those fee schedules are pulled into the invoice, they populate the billed and allowed columns and
the database IDs for the fee schedules are saved with each line item charge. At the same time, the
database ID for the contract which is linked to the company is saved as part of the invoice. This means
that there is a now a fixed record of the contracts and fees that were in place when the charges were
entered and this is where the true power of the contract and fee schedule management and analysis
system starts to work.
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The fees may have special rules associated them which are triggered automatically. These are described
in detail in the Fee Schedules and Rules section of this guide, but an example of a rule might be to add
an ABN modifier and present the ABN form to the physician. If codes are capitated, they can be
automatically adjusted off. When payments are posted against the fees, the system knows which
contract was used and can therefore apply any rules or properties that were set up. The system can set
the payment level adjustment code and line item reason codes automatically. The contractual adjustment
amount (the difference between the billed and allowed fees) can also be set automatically. This is
obviously a huge time saver since pretty much every EOB payment from an insurance company has this.
It can make the time it takes to set up an accurate fee schedule seem quite trivial by comparison.
From the analysis standpoint, using the contract management system gives you a powerful tool to track
utilization and reimbursement. You can create fee schedules for proposed contracts and run the contract
management reports to see the actual impact of the changes on your practice based on your utilization.
Since this is down to the specific code, if you do have any negotiating power it can be a very powerful tool
to bring to the table. If you, the reports may simply be helping you make a good decision in terms of
staying with or dropping some contracts. This can be useful is if a payor offers you multiple contract
options and you want to make the most advantageous business decision for the practice. For example,
some payors will offer fees based on Medicare, but give you options such as Medicare 2002 plus 1.5% or
Medicare 2003 plus 1.4%. You can quickly set up both options and run the analysis.
In the same way, you can also review the impact of prior decisions. You might wish to review how a
utilization change affected what you thought your reimbursement was going to be by running the Fee
Schedule Roster/Comparison report using the contracts for the two periods, or by running the Contract
Management report to see existing utilization (or both and comparing them with each other and/or other
financial reports).
You are able to do this because of the contract and fee schedule archiving tools. These let you create
archived copies of fee schedules and contracts. At the same, they update the database IDs for the
historic charges so that historic integrity is maintained. The archiving tools thus eliminate the need to
update all the contract, fee schedule, insurance company and insurance group linkages. You are always
working with a current contract which is modified to reflect signed parameters.

Default Codes and Split Billing
Contracts can also be used to simplify some complex billing scenarios where certain invoices always
need to have a code, and/or codes must be split out to bill under another payor such as for RHC/FQHC
encounters where some codes must be billed using professional and others using institutional formats
(e.g. Medicare Part A and Part B). This can be done automatically using some of the contract properties.
Thus, utilizing all the functionality offered by the contracts system is something that your practice should
explore.

To add or update an insurance contract:
1. Go to Reference > Contracts.
2. Search for an existing contract, select it and click Edit, or click New to create a new contract.
3. Set the General Tab field values. See the "General Tab" table for more information.
If you have licensed DocMan and want to link a copy of the paper contract, click the Scans tab.
Using the scanning functions, scan or import and save the contract file/image. This can be very useful for
later reference. The tab label is red if there is a linked file.
To add any free text notes, click the Memo tab and type them in. Up to 5,000 characters including
spaces, carriage returns and so on are supported. This is also a spell checker and macro enabled text
blob. If there is any text in the tab, the Memo label turns red.
Click the Misc tab to Set Automatic CPT/HCPCS Code & Auto-Split Rules. See the "Misc Tab" table for
more information.
Click Save to store the contract.
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General Tab
Contract Parent
Organization

This lets you link to an organization entity file. Any organization, including insurance
companies, that is added to the system has a base organization file. You can
search for the insurance company. If you have multiple addresses for the same
company, the one that is used most often should be selected. Alternatively, you can
create an “umbrella” organization. For example, a simple “Blue Cross & Blue
Shield” which covers all the separate addresses in the insurance company
database.

Contract Plan Name

Enter your own description. This is what appears in the contract search screen and
so should probably include something that makes it clear about which insurance it
is. We recommend starting with the insurance name since that is a logical way to
search for contracts.

Contract Plan Type

You can enter anything here, but might wish to include other important identifiers
such as PPO, etc.

Effective Date

The date that the contract became valid.

Anniversary Date

This is the date on which the contract expires. Both the contract search window and
the Contract Management reports have filters to search by this field so you can build
work lists of expiring contracts that need review.

Contact Information

All the fields in this section are populated from the demographics file of the person
linked to the record by clicking the Find button. The address is the Business
address type that can be set up in the Addresses tab for the person.

Fee Information

This section is where you can set defaults and other properties that can have a big
impact on data entry by setting fields and presenting prompts.
•

Insurance Class: An information only field that can confirm to users which
insurance this contract is linked to. Select a class from the list.

•

Allowed/Exception Fee Schedule: This is the fee schedule that will be used to
populate the allowed columns of the invoice as well as fire rules if they exist.
Select the fee schedule that applies for this contract.

•

Billed Fee Schedule: This is the rate that will actually be billed to the insurance
and from which you will take a contractual adjustment.

•

Auto Adjustment Code 1: When a payment is posted for insurance companies
which are linked to this contract you can save posting staff from having to set
the overall payment level adjustment code by setting a default here. Users can
still override the code if they need to. Note that this code will also override the
default electronic remittance adjustment code of AERN if it is populated.

•

Line Item Reason Code: This is also a default adjustment code, but applies to
the individual CPT line items which are posted. This is typically set to the
standard contractual adjustment reason code (A2 or 42).

•

Set Contract Adj Automatically: When payments are posted for companies
which are linked to this contract, the system automatically enters the difference
between the billed fee schedule and the allowed fee schedule in the first
adjustment cell using the default line item reason code. You can still override
this if necessary, but it can save a huge amount of typing and time if your
allowed fee schedules are set up correctly.

•

Auto Adjustment Code 2: This is the same as the Auto Adjustment Code 1. It
sets a default code if you make multiple adjustments per line item, such as for
third party withholds.

•

Capitation Auto Adjustment Code: This property is used to enter automatic
adjustments for capitated codes under such contracts. The system can ajdust
them off based on fee schedule properties when an invoice is saved and if so,
will use this as the payment level adjustment.

•

Cap. Line Item Reason Code: This is the line item code that will be used when
making an automatic cap adjustment.
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Withhold Information

Eligibility Check Interval

•

Prompt for Cap Adjustments: This field can be checked to give users the
option to have the system generate the automatic capitation adjustment if there
are capitated codes in an invoice. If it is not checked and there are such codes,
the adjustment is automatic.

•

Automatically Generate Fees From Payments: This option is available if
there is an allowed fee schedule linked to the contract. When it is checked, a
prompt gives users the ability to update or add new fees to the fee schedule
when posting primary insurance payments. Thus you can create a new fee
schedule without any CPTs and after a few months will have generated a fairly
accurate schedule based on payments. Be sure to uncheck this when the fee
schedule is built.

This is where you can set up properties that are used to automatically apply and
track withholds for third party organizations that perform administrative and billing
work for insurances on your behalf.

•

Auto Adjust Withhold/Disallowance: Check this box if you want the system
to automatically apply a withhold adjustment at the time an invoice is saved. If
you check this box, the rest of the fields are for information only and be used
at all.

•

Contract/Withhold %: This is the percent amount of the allowed fees on an
invoice that the system will adjust off automatically when an automatic
adjustment is generated.

•

Withhold Cost %: This amount is used in the withhold reports. It is
really the administrative fee that the third party administers. This is a
percentage of the total allowed amount for the claim, not the withhold %
amount. Any expected payments after the withhold period will be the
withhold adjustment amount minus this cost.

•

Withhold Period: A value in days after the service date for after which the
amount should be released to your practice. This is a key component of the
withhold report since you will want to accurately judge the amount you expect to
receive.

•

Default Withhold Adjustment Reason Code: When a withhold is
automatically applied, this is the payment level adjustment code that will be
used by the system. Select a code that you want to use for tracking and
reporting withholds for this contract.

•

Default Withhold Reason Code: The line item reason code used for automatic
adjustments.

The interval during which a patient will not be checked if they have had a prior check
in this number of days. This field is purely used as a default which is applied to any
insurance company to which the contract is linked.

Misc Tab
Automatic CPT/HCPCS
Code

If a code is entered here, any time an invoice is generated for a patient with a
primary insurance linked to the contract, a prompt will ask to drop in this code. It is
useful for FQHC/RHC encounter codes needed on any claim where T1015 is used
for the encounter.

Auto-Split CPT Ranges

Enter any codes that will be split out from an invoice into a separate one. (That
separate invoice will use the same payor if only one is on the claim, or if there are
two it will split to that other insurance with each being removed from the other). You
can enter known codes into the two fields or use the Find key to pull predefined
ranges. For a single code, enter it as the starting and ending code.

Financial Group

Set the financial group that the system will use for the second invoice. This is
critical since it will help you automatically set different billing rules (e.g. definitions
and claims filtering) as well as reporting.
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Linking a Contract to an Insurance Company
Once a contract has been set up, you can link it to insurance companies so that default settings and other
extended properties can be used. Bear in mind that when an invoice is created, the system looks at the
properties for the contract linked to the primary insurance on the claim.
1. Open an insurance company in edit mode.
2. Select the contract name in the Contract field, then tab to the next field. When you hit tab, notice
the Allowed Fee Schedule, Billed Fee Schedule and eligibility Check Interval.
The next time you open this insurance company in edit mode notice that the Contract field is grayed out.
If you want to change a link, delete the billed and allowed fee schedule names first to enable the Contract
field.

Building Contract Management Work Lists
Part of having the contract management system is the ability to generate work lists for things such as
reviewing the contracts that are coming due for renewal, or to review utilization and reimbursement.
There are a number of ways that this can be done.
•

Simple Work List: The Find Contract window has filters that let you search by name, anniversary
date range and contact. This is a quick and simple way to review a list of coming due contracts
since the results presented in the search window also let you open each to review the details.

•

Contract Management Report: This is a powerful report. You can set a number of parameters
to show things like utilization with Top N options by code, payments, or count. You can also filter
by anniversary date range, service and code ranges. In addition to the reports that are
generated, the system presents a list of the contracts. You can preview and report and then drill
into the contract details by double-clicking a name in the list at the bottom of the filters window.

Comparing Contracts
You can compare contracts with each other using two tools:
•

Contract Management Report: You can print utilization reports that show which contracts are
reimbursing better according to their contracted amounts and which are not.

•

Fee Schedule Roster/Comparison: This report lets you review fees for one contract against
utilization and historical collections ratios for another one. It’s a powerful tool for analyzing
whether new fee schedules should be accepted or to review contract performance.

Contract Update/Archive Function
The update/archive function lets you maintain copies of a contract for historic reporting purposes. This
means that you are always working with the same contract record for day to day properties and linking to
insurances so you have to update the links to all the insurance companies.
To understand this, we’ll recap how charges and invoices are linked to fee schedules and contracts.
When an invoice is created for an insurance company which has a contract linked to it, the system saves
the contract ID used on the invoice and the fee schedule ID for each CPT. This is how it can generate
reports that are based on the contract used at the time of charge entry. However, when you update a
contract, you want these same database identifiers to apply since your data will start to skew based on
pricing and other changes in effect and you certainly want to go through every insurance group updating
the fee schedule linkages. This is where the archive system comes in. When it creates a copy of the
contract, it automatically locates all the invoices which were linked to the current contract ID and changes
these to the archive copy ID. The same principal applies when you archive fee schedules.
If a contract is linked to fee schedules that are also changing, you will need to archive those first.
Before you start the archive process, ensure your billing staff has finished entering all charges for dates of
service that fall within the valid period for the contract. While you are doing the fee schedule and contract
archive, they post any more charges.
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To archive a contract:
1. Click Reference > Contracts.
2. Search for and select the contract you want to archive, and then click Edit.
3. Review the contract and make sure it is the one you want to archive.
4. Click the Update/Archive button at the top of the screen.
5. Review the confirm message carefully. You will not be able to reverse this process if you
continue.
6. If you are unsure that you wish to continue, click Yes. Otherwise, click No to continue the
archiving process.
7. Enter the Historic Name that you want to use for the archived version of the contract. One
naming method you may wish to consider is adding the year to the start of the name. If you are
still not sure that you want to continue, click Cancel. Otherwise click Save.
8. Review the confirm message carefully. Again, if you continue you will not be able to reverse this
process. Click Yes if you want to quit. Otherwise, click No to start the archive process.
9. If you clicked No, the system starts the archive. Depending on the number of invoices linked to
the contract this may take a little while. When it is finished, the cursor appears in the Contract
Maintenance window just as it would if you were going to make changes.
10. Once the system has finished, change the contract information to reflect the new terms. The
following should be considered:
○ Effective and Anniversary Dates.
○ Allowed/Exception & Billed Fee Schedule. This is less likely since we recommend that, like
contracts, you update the current versions and create archive copies of the prior fees.
○ Contract Scans. Replace the prior scan with the new contract that you have signed.
○ Memo text.
Save the current contract.
In the Find Contract window, search for the archive copy and open it in edit mode.
Update the Allowed/Exception and Billed Fee Schedule links to the archived copies that were created
before you started this process.
Save the archived copy.

Policies and Policy Requirements
Policies can be set up to guide staff to complete particular tasks based on cases or the use of specific
procedure codes. The tasks are set up as requirements. The requirement types you can set up are:
•

A text prompt: It might be to get a referral, contact an employer for a WC type visit, or just a
simple cue to your staff.

•

A prompt linked to a Word Form that can be opened and completed on screen or printed, filled
out and then scanned back into the system. You may have a form set up for a patient intake,
surgery scheduling, an insurance referral/authorization form, a consent, or anything else.

•

A prompt to scan a document or import a file. For example you might need to get an employer or
insurance company to fax an authorization to treat. Alternatively, you may want to import a file
such as a PDF document, video, image or anything else that is needed to treat and ensure
payment.
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Policy requirement alerts are presented to users at several places in the system. The alerts might appear
because the patient has a case with policy requirements. It might also pop up because a CPT code
linked to a policy is used when scheduling a patient (the code is linked to the visit reason), entering CPTbased orders in a chart note, or when the charges are entered in an invoice in the billing system.
Regardless of where the policy alert is presented, because appointments, chart notes and invoices are
linked to each other by the appointment records, and each of these encounter elements can also be
linked by a common case for multiple visits, the system can track satisfaction of requirements. This
means that you can set up the system in such a way as to ensure that forms, referrals and other things
that need to be taken care of prior to an appointment or series of appointments is done in advance or at
check in. Likewise, if certain procedures or other orders are entered in the chart or invoice, additional
prompts can be queued.
In order to set up requirements, you must have at least one policy. However, since many requirements
might be the same for different policies, you can link one to as many policies as necessary to avoid
duplicate data entry.

To set up a policy and requirements:
1. Click Reference > Policies.
2. Click New.
3. If you have set up policy categories and want to link one, select it from the list. A category filter in
the Policy Search window lets you narrow down searches for policies which are useful if you have
a lot in the system. To set up a category click the button to the right of the list box to open the
Category Management window. Examples of categories could be “MVA,” “WC” (workers comp),
or “Employment”.
4. Enter a Description. Examples of descriptions that relate to categories are insurance company
names (for categories set up for at fault auto insurance cases, or state workers comp carriers),
employer company names (for employer physicals). You may also have more generic ones such
as “Surgery Scheduling” that will be used for cases or procedures that are for surgeries.
5. Click Save.
6. Click Add. The Policy Requirements search window appears.
7. If the requirement you need is already set up, select it. Otherwise click Add and follow the
instructions below for adding a requirement, then save and select it. To select more than one
requirement from the list, hold down Ctrl and click each one, or hold down the Shift key and then
the up or down arrows. When all the requirements you want are highlighted, click Select.
8. Click Exit in the Policy Edit window.

To add a policy requirement:
1. Click Reference > Policies.
2. Select a policy and click Edit. You can also do this when adding a new policy.
3. Click Add to open the Policy Requirements search window.
4. Click New.
5. Enter a Description.
6. Set the Required option to Yes or No. This is displayed in a case’s policy requirements list as
well as in the CPT/HCPCS Alert Policy Alert Viewer. It also controls whether or not a form
appears in the ABN/Forms Manager work list. Only those which are mandatory (set to Yes) are
listed.
7. Set the Days Due. When a policy is added to a case, this number is added or subtracted from
the date of entry. The base date can also be set manually within a case. An example of where
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this may be done is if a patient has a case where the policy requirements for the case are based
on the first appointment for the treatment. The appointment might be well in the future so instead
of using the case create date, the base date is set to the first appointment date and therefore
requirement due dates are based on this. A negative number would then mean the requirement
is due before the appointment. The ABN/Forms Manager can generate a list of requirements for
all patients who have requirements due in a date range. The patient case also shows overdue
requirements in red.
8. If the requirement uses a Word Form, click the Form field Find button and select it.
9. If you expect to scan another document (not a Word Form) for this requirement, you can set the
category so that when it is scanned DocMan automatically files it in this category folder. This
does not affect the category in which a Word Form that is filled out on screen is saved into since
you can set up a default category as part of the form setup.
10. Click Save. When you have finished adding requirements, be sure to click Exit from the Policy
Requirements and Policy Edit windows unless you want to link the requirement to the policy used
to access the requirements editor.

To copy a policy:
Some policies can have very similar requirements. The copy function makes it easy to set these up
so that all you have to do is add or remove a few requirements and give the policy a different name.
1. Click Reference > Policies.
2. Select the policy you want to copy.
3. Click Copy.
4. Enter a name for the new policy.
5. Click OK. The new policy is created.
6. Select the policy and click Edit.
7. Change the policy category if necessary.
8. Add or remove requirements if necessary.
9. Click Save, then click Exit.

Linking Policies to Cases or CPTs
A policy is linked to a case by clicking the Link Policies button. The requirements and requirement details
are displayed in a list in the case.
A policy can be set up to appear based on the use of a CPT or HCPCS code in Schedule, Chart or Bill.
In the fee schedules the red columns provide for separate policies to be linked to the same code. While
this gives you the flexibility to have different policy prompts for schedulers, clinicians and billers, it does
mean that extra setup of policies is required and that all staff cannot help to satisfy requirements. Thus it
is probably more practical to create one policy that covers all the bases and link it to all three columns.
Both of these are described in more detail in the Patient Case Management and Fee Schedules section
of this user guide.

Satisfying Policy Requirements and the ABN/Forms Manager
If a policy is linked to a case, you can use interactive functions to satisfy the requirement. If it is a policy
linked to a CPT however, you can only view the list of requirements.
In both cases though, the warning about the policy is presented in the CPT/HCPCS Alert window. Alerts
are triggered and can be accessed in different modules as follows:
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•

Schedule: The visit reason is linked to a CPT with a Schedule Policy set up for that CPT in the
patient’s primary insurance allowed fee schedule, or the patient has a case with policy
requirements. The CPT/HCPCS Alert appears when you save the appointment or can be opened
manually by clicking the Alerts/ABN button.

•

Chart: One or more orders entered in a note’s plan section are linked to a Chart policy in the
patient’s primary insurance allowed fee schedule, or the patient has a case with policy
requirements. The codes that triggered the alert are displayed with an icon that is a yellow
triangle with a red exclamation mark and the navigation bar P button (for Plan) has a red border.
You can open the CPT/HCPCS Alert window by clicking on the icon, or by clicking the arrow to
the right of the P and selecting Process Alerts on the menu that appears.

•

Bill: One or more charges entered in an invoice are linked to a Chart policy in the patient’s
primary insurance allowed fee schedule, or the patient has a case with policy requirements. The
CPT/HCPCS Alert window appears when you save the window or by clicking the Process
Alerts/ABN button below the charges grid.

When the CPT/HCPCS Alert window is open, a list of policies that triggered the alert is displayed in red in
the Policy Alerts section. If the policies are CPT based, then they will be specific to the module in which
they appear (Schedule, Chart or Bill) although you will usually link the same policy for all parts. Clicking
the Details button opens the Policy Alert Viewer in which you can see:
•

Who triggered the policy and when.

•

The policy requirements.

•

The codes that triggered the alert.

When you see a case-based policy alert, you can deal with the requirements using a combination of the
patient case window and/or the ABN Forms Manager which comes into play when a policy requirement is
linked to a Word form or document/file scan category. The CPT/HCPCS Alert window has View Case
and Manage Forms/ABNs buttons.
The View Case button is only available when there is a case linked to the encounter. It opens the patient
case window. In this window you can view the requirements for the policy and use the function buttons to
the right of this section to open and fill out Word forms, scan in others, or simply mark a requirement as
complete. This last function can be used even if the requirement is forms or scan based but the
document is not in the system yet because it has not been scanned in but you want to continue getting
the prompt.
This is where the ABN/Forms Manager comes in. In addition to being accessible from the CPT/HCPCS
Alert window, you can open it in DocMan. It is an interactive work list of all requirements with forms or
scans but is more geared towards processing these as a separate task. Importantly, it only lists the ones
where the required flag is set to Yes. As with the patient case window, you can fill out forms on screen or
mark them as complete. It has filtering criteria that let you build lists to simplify scanning forms that were
completed, or to look up outstanding requirements.

Sliding Scales
The sliding scales table is where you can set up discount levels, copayments and adjustment tracking
codes that will be applied when a patient who qualifies for such is billed for services rendered. You can
either set up levels based on a federal contract, or you can create your own. Users who save charges
are notified about patients who qualify for a discount and the system provides the opportunity to
automatically create the adjustment with associated adjustment codes.

To create a sliding scale discount structure:
1. Click Reference > Sliding Scales.
2. Review the list of entries if any exist and either select one and click Edit to modify it, or click New.
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3. The Sliding Scale Edit window appears. If you clicked New, the Level is automatically set to the
next one in the sequence based on existing records. You cannot duplicate the level.
4. Enter data in the other fields as described in the "Sliding Scale Edit Window" table.
Click Save.
Sliding Scale Edit
Window
Copay

The copayment amount that is required. This is not mandatory but will override any
insurance fixed copayment on an invoice.

Discount

The discount amount that will applied against charges on the invoice. This will be
applied after any fixed copayment is factored for the primary CPT on the invoice.

Adjustment Code

This is the payment/adjustment level code that will be used for tracking and
reporting. You can use the same code for all your levels, but it might be useful to
create one for each since that gives you the extra reporting data of showing the total
amount of sliding scale discounts as well as the count within each level.

Reason Code

This is the line item adjustment reason code that is automatically added when the
adjustment is taken.

Poverty Start % and End %

This the percent of the poverty guidelines within which the patient falls. It is based
on cross-referencing the patient’s family income as a percentage of the federal
poverty guidelines in the Poverty Guidelines reference table. You cannot have
overlapping ranges for different levels in your sliding scale, but should obviously set
them up so that they are consecutive.

Poverty Guidelines
The poverty guidelines table is where the federal poverty guidelines are stored. This is master data
supplied by the government and which e-MDs includes in the database. If you are not an FQHC or
similar entity that has means-based discounting, you can still use this for your own discounting structure
by modifying the data for the state in which you are located.
The table includes the fiscal year, state code, valid date range, and incomes for first and additional family
members that are the basis of the poverty guidelines. Sliding scale discounts are calculated and applied
as a percentage of these using the valid date range and also by cross-referencing the state to the one in
which the invoice is generated. It also looks at the Poverty Level information set up in the patient
demographics Misc. tab to see where the patient falls as a percentage of the family income to determine
the sliding scale level.
If you wish to add or modify data to this table, it is quite easy. The only thing to remember is that you
cannot duplicate any entries.
Simply access the table under Reference > Poverty Guidelines, then use the New or Edit functions and
enter the data.

Insurance Classes
These are used to group companies together for the purpose of reporting aggregation, particularly in Bill.
They are especially useful for those insurances that are entered in the database multiple times with
different addresses (e.g. Aetna, Blue Cross). It is much simpler to analyze insurances by class than
having to add up each “address” for the same company.
Insurance classes give an added dimension to reporting by allowing users to aggregate payors that are
duplicated due to address requirements. In many reports, users can filter by insurance class.
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Note: If you wish to add insurance classes, create EXACT duplicates of the financial groups used in the
system, and then link these to the insurances as you would for selecting patient financial groups based on
insurance classes.
For example if you use the BCS financial group for all patients with Blue Cross and Blue Shield
insurance, make the insurance class for all Blue Cross and Blue Shield addresses BCS. Failure to do so
will result in significant insurance claims filing problems when the system transitions to using the classes
and not the groups for the definitions that determine the selection of particular provider numbers, etc.

To add an insurance class:
1. Click Reference > Insurance Classes (you can also access the table by clicking the search to
the right of the class field in an insurance company or insurance contract).
2. Click New.
3. Enter a class Code (up to 3 characters) and a Description.
4. Click Save.

To link a class to a company:
This is easy to do manually. Simply select the class in the like named field of the insurance company
maintenance window. If you want to do this for a lot of companies at the same time, e-MDs provides
some utility scripts on the FTP pages that let you do it by name or parts of the name.

Specialty Codes
Specialty codes are a standardized set used in e-MDs Bill for electronic claims. If an invalid code is used,
claims will be rejected.

To add or edit specialty codes:
1. Click Demographics > Provider.
2. Search for and select a provider, then click Edit, or click New as if to add a provider.
3. Open the Provider Maintenance window.
4. Click the Add or Edit buttons above the list of specialty codes. The Provider Specialty Link
Maintenance window appears.
5. Click the magnifying glass icon in the Specialty field. The Find Specialty window appears.
6. Click New to add a record, or Edit to modify an existing record.
7. Change the specialty Code or Description.
8. Click Save. Then click Exit, and Cancel to return to the provider window.

Secondary Reference Tables
The system uses several secondary tables that are stored in the database. They necessarily have a
specific References menu access point, but can be accessed throughout the system from various input
windows to which they are linked. Several are already populated with standardized data that is used for
claims filing so exercise caution when making any changes or additions. They include:
•

Insurance Types, Indicator Codes, and Filing Status Codes.

•

Medical Facility Types

•

Zip Codes, Cities and States
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•

Telephone and address types

•

Patient relationship codes

Insurance Types, Indicator Codes/Origin IDs, and Default Filing
Method Codes
•

Insurance types are used in e-MDs Bill for claims. When setting up an insurance company, a type
must be associated with each otherwise electronic claims will be denied. The type is carried
through to the patient file when insurance is linked to that patient. At the patient level, it may be
necessary to change the type, particularly when adding secondary insurance. The section on
adding insurance companies includes lists of types and more detail on how they are used. Avoid
making changes to this table.

•

Indicator Codes/Origin IDs are similar to types and are required for users that have Bill and will be
filing electronic claims. These are used by EDI connections to determine the type of payor.
Origin IDs are now mostly redundant since they were used for NSF, while Indicator codes are
part of the ANSI transaction set. Thus there is some overlap so be sure to select the correct
codes dependent upon the standard used for filing. Avoid making changes to this table.

•

Insurance Filing Method Codes are critical to the functioning of the claims system in e-MDs Bill.
You can create your own custom filing method types to segregate by claim type if it makes it
easier than using the standard EF and NF designations (e.g. electronic claims, CMS-1500,
HCFA-1500, UB-92/HCFA-1450, Illinois IDPA HCFA-1500, MassHealth Form 5).

The insurance type, indicator codes, and filing types tables are accessed when adding insurance
companies.

To enter insurance company information:
1. Go to Demographics > Insurance Companies.
2. Click New to open the Insurance Company Maintenance window.
3. Click the magnifying glass icon at the end of the field used to select data from the table you are
editing. The applicable Find window appears.
4. Click New to add a record, or Edit to modify an existing record.
5. Change the data.
6. Click Save.
Note: Add default filing methods with a second letter of X. When a claim is created, e-MDs Bill sets
the second character of the filing status flag to X so it can separate filed vs. unfiled claims.

Medical Facility Types
Medical Facility Type codes are an editable secondary reference table.
Note: Medical Facility Codes are a standardized set that are really place of service codes used in e-MDs
Bill for electronic claims. If an invalid code is used, claims will be rejected.

To add or edit medical facility types:
1. Open a medical facility window (File > Facility, then New or Edit, or through the user window
under File > Security > Users).
2. Click the magnifying glass icon in the Medical Facility Type field. The Medical Facility Type
window appears.
3. Click New to add a record, or Edit to modify an existing record.
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4. Change the Code or Description.
5. Click Save.

Telephone and Address Types
The e-MDs demographics database gives users the ability to add an unlimited number of phones and
addresses to organizations and persons. Depending on the entry screen, the default type stored
changes. For example, when adding phone and address to patients, there are fields provided that
automatically set home data, whereas when adding an organization, these would be business. In almost
all demographics entry screens, there is an Addresses tab where additional data can be added. For
example, one may wish to add a second home address and phone to a patient. In most cases, the type
is selected from a list already in the database, but you can add more types.

To add or edit telephone and address types:
1. Click the Addresses tab for the entity you are adding.
2. Click the Add/New button for either telephone or address.
3. Click the magnifying glass icon in the Address Type or Phone Type field. A search window will
open.
4. Click New, add the type and save. This can now be linked to any record.

Relationship Codes
The relationship table is used when linking patients to guarantors, defining the relationship of an
emergency contact to a patient, and policyholder relationships to the patient. The table contains
numerous codes that have been added in recent years, but the most commonly used relationships are
Self, Spouse, Child and Other.
The Relation table only allows the addition new descriptions and is accessed by clicking the button with
the magnifying glass next to any relationship field. You are strongly cautioned against making changes to
this table. The relationship codes in the system are a HIPAA transaction set required for insurance
claims filing.

Case Dispositions
The case management system includes the ability to set the current disposition for a case. Examples of
dispositions are Open/Active, Closed: cured, Closed: Permanent & Stationery, and New/Temporary.
A set of dispositions is included in the master content but you can add or remove entries if you wish. The
editor is only accessible from within a patient case.

To add, edit or delete case dispositions:
1. Click Tools > Patient Case Management.
2. Click New as if you were going to create a new case (you can also open an existing case in edit
mode).
3. Click the search button to the right of the Disposition field.
4. Use the New, Edit or Delete buttons as needed. Each disposition entry is a simple single line text
field.
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7

Demographics
e-MDs uses an advanced database that has been programmed to take into account
the needs of all sizes of medical business: from the small solo practice to very large
enterprises. In the past, databases have tended to become clogged with junk data in
the form of either bad characters, or duplicated records.
Bad characters are where users typed the wrong information into a field and then
saved the record. The e-MDs Solution Series system eliminates much of this by
enforcing integrity using required fields, masks (which control what type of data can
be typed into a field), and other checks. The problem with junk data is that your
system gets cluttered with records that may not be searchable, skew reporting data,
and can lead to other errors.
Duplicate data is a much bigger problem. It can lead to multiple clinical and billing
records, which can be very serious. For example, if a patient has a particular drug
allergy, the duplicated record does not know this because it is totally separate.
Likewise, maintaining multiple financial balances is very costly in terms of collections
and public relations. Duplication is also very costly in terms of productivity. The eMDs Solution Series database includes many checks and warnings to tell users if it
thinks duplications might be occurring. In some cases, duplication of certain fields
such as social security number is absolutely not permitted. The root of this system is
what is called an entity.
Continued on the next page ...
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Entities
An entity is either a person entity or an organization entity (business). Any time either of these is added to
the database, they are added to the entity table. The entity table is the root of all data in e-MDs Solution
Series. Further down the data tree, various attributes are given to records that control whether data is
stored in the person table or organization table. Likewise, other attributes can further classify different
kinds of people and organizations. A person may be a user, a patient, a provider, a nurse, a referring
physician, a guarantor, a contact or even a combination of several or all of these. An organization can be
internal or external (your clinic or another facility like a lab with which you do business).
The main point is that once an entity has been created, the system tries to prevent users from creating
duplications of that entity. Thus, no matter which facility you are working in, when a patient exists in the
system you can use that record. Of course, user access rights will control higher levels of information
such as clinical, scheduling and billing data that are facility or clearance controlled.
There is a definite hierarchy in the system whereby entities can be classified as being part of other
entities. An example of this is a large network that has multiple facilities. You can set up the network, then
have each of the facilities created as children of this parent organization. Person entities are then
associated with various facilities in the network. They might be users who are given rights to one or more
of the facilities, patients who visit one facility and may be referred to other physicians who work in various
places, and so on.
Although they are not entities, street address and telephone information is also stored in a common
database. There is, technically, no limit to the amount of telephone numbers or addresses you can store
for a person or organization entity. For practical purposes, there are some predefined types (home
telephone, fax, home address, and billing address) that the system uses as defaults or for other
processes like statement printing. The system lets you free type any address so duplication can occur
with these, but if one already exists, there are great advantages to linking entities to existing addresses or
telephones. For example, if a family moves, you can update the telephone and address information for all
records simply by changing any one of them.

Person Entities
It is important that you understand how people are added to the system and the effect this has on how
and where you can use their records. Refer also to Entity Overview.
A person entity is any kind of human entered into the e-MDs Solution Series database. The demographic
entry window for all person entities always includes certain fields including name, prefix, suffix, date of
birth, gender, telephone and address. Then, depending upon the type of person entity you are creating,
further information may be required. For example, a patient will require guarantor and possibly insurance
information. A physician will need licensure information.
When a person entity is created in a particular part of the system, it will be identified as being an entity of
that type (user, patient, provider, etc.). Thus, someone who is set up as a user will not appear in the Find
Patient window. If you subsequently try to add this person as a patient, the system will warn you at
several stages of the entry process that there are matches in the system. When this happens, you have
the opportunity to view the matching records and then select one instead of creating a new record. In this
example, you can then add the billing information that is not part of the user access record. Upon saving
the record, it will be given attributes that classify it as both patient and user person types, but it still would
have the necessary attributes to make it appear in the provider or other search windows.

Organization Entities
It is important that you understand how organizations are added to the system and the effect this has on
whether they are classified as internal or external organizations (facilities), and how those are used. Refer
also to Entity Overview.

e-MDs Solution Series Bill User Guide 8.0 R00

97

An organization entity is any kind of business entered into the e-MDs Solution Series database. This
includes your practice, clinic or hospital. They also include facilities with which you interact and do
business such as labs, hospitals, nursing homes and insurance companies. The demographic entry
window for all organization entities always includes certain fields such as the name and address. Then,
depending upon the type of organization, further information may be required. For example, an insurance
company will have a field for the electronic filing payor ID and a place to add linked insurance groups. A
medical facility must have a type (hospital, clinic, etc.).
Medical facilities can also be classified as internal (part of your business) or external. Both are
organizations, but only the applicable ones appear on the internal or external medical facility searches.
Unlike the person entity database, not all organization entities are available in all places. You can create
an insurance company, but this will never be displayed in the internal and external medical facility
windows even though much of the base information is stored in a common location.

Addresses
In e-MDs Solution Series, street addresses are all stored in a common location regardless of the entity to
which they are tied (patients, facilities). This has several advantages:
•

Automatic updating of all like records when one address is changed.

•

Speedier data entry for complex addresses.

•

Data integrity.

When you add an address to an entity, you have two choices. You can either free type the address into
the fields, or you can look up an existing address. When you know you are adding a brand new address
(e.g. the first member in a family to be a patient in your practice), free text is the most rapid way of adding
the address. Upon saving the record, this address is automatically added to the address database and
the system compares like addresses so it can prompt users to update other entities with the same
address if one of these is edited. The typical example is updating an address for patients linked to the
same guarantor. This is obviously beneficial.
You can store an unlimited number of addresses for an entity. The system automatically sets the address
type based upon the data entry window. This may be a business address for providers or medical
facilities, or a home address for patients. For example the address fields in the main part of a medical
facility demographics screen automatically classifies the type as the business address whereas the same
fields for a patient are set as the home address. A system administrator can add other address types
should they be necessary.
As an extension of this concept, you can have multiple addresses of the same type for an entity, but only
one can be the default or “system” address. The one marked as the system address is used by the
system when printing various reports. Others are simply a way for you to keep historic data. There is
also a note field that you can use to record further information such as a date on which a patient moved
from an address that you deleted.
The following table is a summary of address types used automatically in e-MDs Solution Series. If
duplicate address types are added, one of them must be set as the primary so that the system knows
which one to use.
e-MDs Solution
Series Module
e-MDs Bill

Report Name
Accounts Receivable
Activity Analysis
Chart Cover

Electronic Claims Summary
HCFA-1500
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Entity
Facility
Facility
Patient
Guarantor
Insurance
Facility
Facility
Insurance

Address Type(s)
Business
Business
Home
Home, Business
Business
Business
Business
Business
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e-MDs Solution
Series Module

Report Name
HCFA Claims Summary
Hold Summary (Elec & Paper)
Insurance Company Roster
Insurance Status
Invoice
Notice Processor

Patient List
Patient Dates Roster (Recall)
Patient Roster
Prepayment
Profit Center
Receipt
Referral Roster
RVU Tracking
RVU Time Tracking
Statement

Super Bill
Till Reconciliation
Visit Compliance

Entity
Facility
Facility
Insurance
Facility
Facility
Patient
Facility
Patient
Insurance
Guarantor
Facility
Patient
Facility
Patient
Patient
Facility
Facility
Facility
Facility
Provider
Facility
Facility
Facility
Guarantor
Facility
Facility
Facility
Facility
Facility

Address Type(s)
Business
Business
Business
Business
Business
Home
Business
Home
Business
Home
Business
Home
Business
Home
Business
Business
Business
Business
Business
Business
Business
Business
Home
Business
Billing
Business
Business
Business

Telephone Numbers
In e-MDs Solution Series, telephone numbers are all stored in a common location regardless of the entity
to which they are tied (patients, facilities). This has several advantages:
•

Automatic updating of all linked records when one address is changed.

•

Data integrity.

Every time a telephone number is changed for a patient, and there are other patients linked to the same
guarantor, a different prompt gives you the option to update phones for patients linked to the same
guarantor.
A further benefit of the telephone number linking system is that e-MDs Solution Series automatically
creates a link between the telephone number and address. When you enter a number that already exists
in the system, the address information will also appear, although it can be changed.
You can store an unlimited number of telephone numbers for an entity. The system automatically sets the
number type based upon the data entry window. This may be an Office Number or Office Fax for
providers or a Home number for patients. In the event that there is more than one number of a particular
type, the Primary or “system” one is displayed in other forms or on reports. This setting is automatic
when entering in the General tab of a demographics window, or can be changed by editing a specific
number in the Addresses tab. Other phones of the same type are essentially a way for you to keep
historic information. There is also a note field that you can use to record further information such as a
date on which a patient changed the phone number.
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The following table is a summary of telephone types used automatically in e-MDs Solution Series. If
duplicate phone types are added, one of them must be set as the primary so that the system knows which
one to use.
e-MDs Solution
Series Module
e-MDs Bill

Report Name
Accounts Receivable

Patient List
Patient Roster
Referral Roster
Statement
Super Bill
Visit Compliance
Appointment Reminder Res.
Appointment Schedule

Entity
Guarantor
Patient
Guarantor
Patient
Employer
Insurance
Patient/Guarantor
Facility
Insurance
Insurance
Guarantor
Patient
Insurance
Facility
Patient
Patient
Referral
Facility
Facility
Insurance
Patient
Patient

No Show
Automated Reminder Calls

Patient
Patient

Chart Cover

HCFA-1500
Insurance Company Roster
Insurance Status
Notice Processor

e-MDs Schedule

TeleVox

Phone Type(s)
Home
Home
Home, Home Fax
Home, Home Fax, Pager
Office, Office Fax
Office
Home
Work (Box 32)
Claims
Office, Claims
Home, Office
Home, Office
Office, Office Fax
Office, Office Fax
Home
Home
Office
Billing
Office, Office Fax
Office
Home, Cell
Number selected by
user
Home
Home, Cell and/or Work

Internal Medical Facilities
In e-MDs Solution Series, all entities are stored in a common organization entity data table, regardless of
whether they are part of your business, or are other facilities such as laboratories with which you do
business. However, each facility is assigned particular attributes that identify what kind of organization it
is. The attributes control the find/search windows that the facility appears in (internal, external). Insurance
companies, pharmacies and some other organization types are not considered to be medical facilities and
have their own search windows. Internal medical facilities are your business locations – your practice or
practices if you are a multi-site group.

Notes:
•

Internal Medical Facilities also contain options that affect run time operations (such as patient
account numbering method).

•

Users are only able to access and view information in a facility if they are given users rights to the
facility. The user who adds a medical facility is automatically given rights to it.

•

Refer to Facility Entities to get a better understanding of how e-MDs Solution Series stores
facilities in the database.
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Adding Internal Medical Facilities
Internal medical facilities are facilities that are part of your business and for which appointments, progress
notes and claims can be generated.

To add internal medical facilities:
1. Click File > Medical Facilities.
2. Click New.
3. Type data in the Internal Medical Facility window fields (see the "General Tab" table below).
An asterisk (*) next to a field label indicates that it is required.
4. Click Save (Alt+S). If any required fields have been omitted, the system responds with an
error prompt telling you what needs to be added before the record can be saved.
5. In order to use the facility in various modules, you may need to complete additional important
steps:
a. Link the facility to the login accounts of users.
b. Set up resources in Schedule so that appointments can be made for the location.
c.

Set options in Bill and Schedule so that data entry activities are correct and complete.
Examples are facility default Superbills and fee schedules.

d. For EDI transactions, go to Claims > EDI Options and Claims > Clearing Houses and
set the facility-specific fields for each.

Note: The red X buttons in the data entry window are used to clear information entered in the
fields.
General Tab
Parent Organization

If this facility is part of a large network, you can show that hierarchy by entering the
next highest level facility entity in this field.

Phone

If the number already exists in the system, click the magnifying glass at the end of
the field and search for the number in the Phone Number database. This is
recommended because it will then allow you to automatically update all entities that
share this phone number should it change. Using a linked number also automatically
enters the Address, Zip, City and State.

Phone (Fax)

Again, you can look up an existing number.

Address Line 1

If the address already exists in the system, click the magnifying glass at the end of
the field and search for it in the Address database. The same advantages as using
existing phone numbers.

Zip

Upon entering a known zip code, the system automatically fills in the City and State.

Email Address

Enter a clinic address.

Tax ID

Enter a facility-specific Tax ID. This prints in the HCFA-1500 box 25 if the rendering
provider on a claim has a tax type set to Federal Tax ID.Medical Facility Type:
Select the type that matches your facility.

Medical Facility Type

Select the type that matches your facility.

Hospital NPI

Enter if applicable. This is used on certain claim types.

Active?

Check this box to indicate an active facility. If unchecked, the facility will not be
available for scheduling, billing or charting functions. The active setting is used
instead of deleting a facility that has historical information required for reporting and
audit purposes.
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Routing

Enables this as a routing facility that can be selected in fee schedules so you can
create reports to show orders by internal or external facility.

Facility Code

A short name for a facility. This code is used in several parts of e-MDs Solution
Series to display a facility name without using up too much space, including the Bill
Posting window. You must fill this field out.

Color

This field is important if you have multiple facilities. In All Facilities View (which is
used to show appointments in multiple facilities), appointment cell borders are
displayed in the facility color to distinguish them from each other. The facility name
is also displayed with this color in the blue appointment details box at bottom left in
this view. Thus, the color should be fairly bright so that it stands out on that blue.
Avoid using red – this conflicts with the overbooking border color.

Taxonomy

Select a taxonomy code for the group/practice specialty. This is used on claims
where it is required by payors.

Default Area Code

Enter the first three digits of your telephone area code. This is used to save
keystrokes in other demographic windows. It can be overwritten if necessary.

Default Zip Code

Enter the first three digits in the zip code to prefill zip fields in other demographic
entry screens.

Short Name

This field is used for SureScripts e-Prescribing. The SureScripts system only
supports a maximum of 35 characters for a facility name so enter your descriptor
here so that data can be parsed and routed correctly. If you have multiple facilities
that have similar names, be sure to make them unique.

Addresses Tab

Enter additional addresses or telephone numbers, if required.

Providers Tab

Allows users set up the providers who work in a particular facility. When you add
new insurance companies to the database the system automatically links the
providers in this list to that insurance’s list of credentialed providers. You can also
denote whether a provider works in this facility by default. Although you can change
the list at the insurance company level, most clinics will link all providers in the
database to this list to speed up insurance registration. Each time a new provider is
added, add him/her to this window.

Options Tab

Options settings affect how the system behaves or sets fields when using the
application.

Account Numbering
Options

There are 2 automatic patient account numbering options. If the alphanumeric box is
checked, account numbers are set based on the first 3 characters of the last name,
first 3 characters of the first name, and a 4 digit sequential number that maintains
uniqueness when the letter combination is the same. For example, John Smith will
be SMIJOH0001. Johanna Smithers SMIJOH0002, and so on. When the sequential
option is set patients are assigned an incremental 10 digit numeric account number.
If there is any data in the Account Numbering ID field of the provider file, it is added
to the front of the sequence for patients assigned to this provider.

Insurance Options

An insurance company file requires at least one credentialed provider. The person
in the Default Insurance Credentialed Provider field is used for this if there are no
entries in the Providers tab. The Default Clearinghouse is used for eligibility
checking should there be no connection defined for a specific insurance.

Other Options: Default
Gender

The radio button setting selected here automatically sets the gender for new
patients. An OB/Gyn office, for example, would set this to Female.

Collections Agency
Options

Individual checkboxes for patient and guarantor can be set to warn users with an
alert note that a patient and/or guarantor invoice is assigned to collections agency.
With this option set, the user will be prompted that the patient has or guarantor has
an invoice in Collections. This will appear whenever the patient/guarantor is
accessed in Bill or Schedule. Aging totals can also be viewed from the Alert Note by
clicking the Aging Totals button.
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UDS Tab

This tab contains fields that are used for generating the UDS report used by FQHC
clinics. Fill out the fields based on your particular location(s). The fields must be
filled out for each internal medical facility that will be reported on for FQHC
purposes. Data is pulled into the report based on activity that occurs within facilities
that have the Service Delivery Location box checked. The report gives you the
ability to designate the primary clinic for the Grantee Profile Cover Sheet of the UDS
report and other service delivery locations are listed in the addition parts of this
section.

Alternate IDs Tab

The alternate IDs tab is where you can add custom fields to the record. An
administrator with appropriate security privileges can set up a list of available fields.
To add one of these to the record, click Add, select the Alternate ID Type by clicking
the list box to see the field names, then enter the Value specific to this record and
click Save. You can use the alternate IDs in claims by setting up definitions.

Setting a Default Internal Medical Facility
The default medical facility is the one that appears when a user logs into e-MDs Schedule. Because
computers are generally in a static location, the setting is workstation, not user specific. If the default
setting for a workstation is for a facility to which a user does not have access rights, then the user is
presented with a blank schedule upon logging in.

To set a default internal medical facility:
1. Select one from the list box above the calendar.
OR
Go to File > Facilities (Alt+F, M).
2. Search for the facility, highlight it and click Select (Alt+L).

Active and Inactive Facilities
In order to preserve historical reporting and audit trails, e-MDs Solution Series does not allow facilities to
be deleted if they have linked information. To make facilities unavailable for scheduling, billing or charting
functions, make them inactive. This removes them from the list available for scheduling, billing or charting.
The following procedure will make sure no other users have rights to the facility.

To view data for an inactive facility and reactivate it:
1. Go to File > Medical Facilities.
2. Search for and highlight the facility, then click Edit.
3. Check or uncheck the Active field. When checked, the facility is active.
4. Click Save.

External Medical Facilities (Hospitals, Laboratories,
Nursing Homes, etc.)
In the course of providing medical care, other facilities such as hospitals, skilled nursing facilities and labs
are often used. Depending on the type of claim, or the procedures in the claim, insurance companies
usually require the facility to be included in the claim. For example, if place of service is 21 or 22, then the
hospital must be identified. Likewise, if lab work is performed or ordered, the lab needs to be identified. In
the HCFA-1500 claim form and electronic equivalent, the place where services are rendered is printed in
Box 32 (unless it is the same as the place identified in Box 33, in which case the word “SAME” is
entered).
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Adding or Editing a Medical Facility
External medical facilities are entities with which you do business. They include laboratories, hospitals,
nursing homes or other places that may be needed for e-MDs Bill claim information. Every facility added
to the database, whether internal or external, is first added to the external database.
Medical facilities can be added from within claims and other context-specific windows but these
instructions are based off the menu bar.

To add or edit a medical facility:
1. Go to Demographics > External Medical Facilities.
2. Click New.
3. Type data into the External Medical Facility Maintenance window fields. An asterisk (*) next
to a field label indicates that it is required. See the table below for a description of these
fields.
4. Click Save. If any required fields have been omitted, the system responds with an error
prompt telling you what needs to be added before the record can be saved.
If you link this facility to a user, it will automatically change to being an internal medical facility and will
no longer be available on the Find External Medical Facility search window. Internal facilities have
more fields that are needed in e-MDs Solution Series. Refer to “Adding Internal Medical Facilities” for
more information.
Note: The red X buttons in the data entry window are used to clear information entered in the fields.
General Tab
Office Number

Not generally used, but fill in, if applicable.

Departments

For reference only.

Parent Organization

If this facility is part of a large network, you can show that hierarchy by entering the
next highest level facility entity in this field.

Phone

If the number already exists in the system, click the magnifying glass at the end of
the field and search for the number in the Phone Number database. This is
recommended because it will then allow you to automatically update all entities that
share this phone number should it change. Using a linked number also automatically
enters the Address, Zip, City and State.

Phone (Fax)

Again, you can look up an existing number.

Address Line 1

If the address already exists in the system, click the magnifying glass at the end of
the field and search for it in the Address database. The same advantages as using
existing phone numbers.

Zip

Upon entering a known zip code, the system automatically fills in the City and State.

Medical Facility Type

Select the type that matches your facility.

Hospital NPI

Enter the NPI (often called the Medicare number) for the facility. This is required if
you use the facility on a e-MDs Bill claim.

Active?

Check this box to indicate an active facility. If unchecked, the facility will not be
available for scheduling, billing or charting functions. The active setting is used
instead of deleting a facility that has historical information required for reporting and
audit purposes.

Routing

Enables this as a routing facility that can be selected in fee schedules so that you
can create reports to show orders by internal or external facility.

Facility Code

A short name for a facility.
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Color

The color selected will be the color around the border of an appointment slot
scheduled for an external facility so that it is easily distinguished from internal
locations. This is also the text color used in the blue appointment details box at
bottom left of the main view when the appointment is selected, so make sure the
one you select contrasts with blue. Avoid using red – this conflicts with the
overbooking border color.

Taxonomy

Select a description that best describes this facility type. The associated taxonomy
code is used on electronic claims where necessary.

Add to Short List

It is possible to schedule for external facilities in e-MDs Schedule (e.g. for a surgery
at a local OR) and display these embedded into your main office schedule. To avoid
having to scroll through long lists of facilities that are in the master database but do
not apply to your geographic area, only facilities on the short list are available for
external scheduling. Check the box for all those you work in.

Other Tabs
Addresses Tab

Enter additional addresses or telephone numbers, if required.

Alternate IDs Tab

The alternate IDs tab is where you can add custom fields to the record. An
administrator with appropriate security privileges can set up a list of available fields.
To add one of these to the record, click Add, select the Alternate ID Type by clicking
the list box to see the field names, then enter the Value specific to this record and
click Save. You can use the alternate IDs in claims by setting up definitions.

Linking a Medical Facility to a Claim
There are several places within a claim that the facility can be linked. Depending on the claim output (e.g.
CMS, UB-04, ANSI), some or all are used depending on a hierarchy. Fields in the prep screen used for
this function included Hospitalization, Lab and HPSA (Health Professional Shortage Area). The patient
and provider files also contain fields for default hospitals to be established. If these are used, the
Hospitalization field in the prep screen is automatically filled and will be inserted into insurance claims
when required.
Upon saving an insurance invoice, the insurance claim prep screen appears automatically. Alternatively, if
adding the facility later, you can open the invoice in edit mode, and click the Claim Form button.

To link a medical facility to a claim:
1. Under the Invoice tab, there are Find buttons for hospital and lab. To link a HPSA, go to the
Misc Options tab.
2. Search for and highlight the facility, then click OK.

Patients
The patient file is usually the most time-consuming data entry process since it requires collection of data
from many sources. e-MDs Bill tries to expedite the process as much as possible by making numerous
cross-references to other databases so users can access information already stored elsewhere, as well
as by making use of special copy features. However, there will still be extra information required. It is eMDs’ experience that the extra time spent up front in ensuring that all possible data is entered will be
saved ‘nine-fold’ later on.
For billing purposes, only the demographic information at the top of the patient window and in the
Insurance tab is required. Once this is complete, users can save the file and continue. However, the
additional tabs store valuable information about that patient. This information may be useful later on, so
enter it if you can. Examples of this are emergency contacts, insurance authorization, and even social
memos. All this can help office staff if situations such as emergencies or collections tracking arise.
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Adding Patients
Because patient records may already exist in your system for individuals that indicate they are new
patients, you must always search the database for potential existing accounts before adding a new
patient. Therefore, when adding a new patient, first follow the patient search procedure below and then, if
a match is not found, perform the new patient addition steps that follow. Failure to search for an existing
patient before adding a new account may result in duplicate accounts that will ripple through the system,
affecting everything from patient health records to lab reports and financial accounting.

To search before adding a new patient:
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu
option.
OR
Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the
Find Chart Patient window.

Note: Pressing Cancel at any time during the search process will return you to the Find Chart
Patient window.

2. Type at least the first few characters of the patient’s last name in the Name field. This can be as
little as one letter (A, C, F, etc.) or as much as the patient’s full last (Smith, Jones, Rodriguez,
etc.).
3. Click Search to list any patients that match the search criteria. The names of matches that are
found display on the screen in the top patient list.
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Note: When searching for a patient, you may prefer to select a value in the Alternate ID field to
list only patients that have a specific Alternate ID assigned to them.
4. If possible matches are found, review the list to determine if the patient may already have an
account in the system. Since Social Security numbers are unique, check that column first. If you
find a close match, select that name and then click Edit to open the Patient Maintenance window
to view that patient’s information.
○ If the selected chart appears to be a valid match, verify the chart information with the patient to
ensure it is indeed the same person. If it is the same person, update the Patient Maintenance
screen as necessary and save the changes. Since a valid match was found, it will not be
necessary to create a new account.
○ If the selected chart is not a valid match upon further investigation, close that window to return
to the Find Chart Patient window and repeat this step for any other possible matches.
Continue with step 5 below.
5. If no valid matches were found on your system, continue with “To add a new patient after
searching.”

To add a new patient after searching:
1. Return to the Find Chart Patient window and click New to open the Patient Maintenance window.
2. Begin to enter a first or last name on the screen.
At this time, Chart will automatically perform a secondary search to determine if another person,
who is already in the system, may match the information appearing on this screen.
3. If a matching person is found, you will be prompted to accept or reject the matching person’s
information. If you accept that information, the Patient Maintenance screen will be updated with
the found person’s information, overwriting any information in pre-populated fields.
OR
If a matching person is not found, or if you reject a found person’s information, nothing will be
changed on the screen.
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4. Continue inserting information in any blank fields on the Patient Maintenance screen. The only
required fields (under all tabs) are the patient’s name, date of birth, and gender. Fields of note
include:
5. Click Save to update and close the Patient Maintenance window.

General Tab
Prefix, Suffix

Form of address and following letters.

Last, First, Middle

If a last-first name combination that already exists for another person entity is
entered, a system prompt asks if you wish to view matches as described in step 3
above.

Display

This is for nicknames or other names by which the person prefers to be addressed
and is displayed in e-MDs Chart and on patient super bills.

Birth/Maiden Name

Self-explanatory and is a searchable field.

Date of Birth

Self explanatory. If a patient is less than 2 years old, additional fields appear for
Time of Birth, Normal Birth and Premature checkbox options, and fields to enter
Gestational age at birth. These are used for plotting preemie growth charts in eMDs Chart.

Gender

Self explanatory. The gender is set automatically if one has been designated under
the Options tab for the internal medical facility in which the patient is added.

Race

Use this field to select the patient’s race. This information is particularly helpful in
diagnosing conditions that are prevalent with some races and for gathering
statistical information for various reports. See “To designate a patient’s race as
multi-racial” for instructions on specifying more than one race for this option.

Ethnic Group

Select the main ethnic origin that the patient associates with his/her heritage. To
select Hispanic subgroups, select Hispanic or Latino, click the Search button, then
select the appropriate subgroup. If an appropriate option is not listed, you can leave
the field blank (<none>) or select Declined.

Language

Select the language most commonly spoken by the patient. This will help identify
the need for an interpreter if the patient’s primary language is not normally spoken in
the clinic.

Account Number

Set automatically based on the internal medical facility account numbering options.

SSN

Other than a blank field, duplicates are not permitted for person records. A warning
appears if a duplicate is entered.

Guarantor

Click Self to automatically create a guarantor account with the same information
contained in the patient’s demographics. This automatically sets the relationship
field to Self. If the guarantor is someone other than the patient, click the magnifying
glass to search for or create a different guarantor, then set the correct relationship.
It should be noted that the guarantor is not always the policyholder, although it is
used as a default to save time when adding insurance for the patient. For billing
purposes, this is the financially responsible party in the event that insurance does
not pay. It may be the patient, or a child’s parent, or an elderly adult’s child. It might
also be a legal entity for personal injury patients, or an employer for corporate
patients.

Relationship to Guarantor

If the patient is the Guarantor, leave this option with Self selected. However, if the
Guarantor is someone other than the patient, use the drop-down list to select a
different relationship.
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Primary Provider

If the appointment is being made for a provider resource, the provider should be set
to that person’s name. Otherwise, select a default for the patient either by typing
letters to filter the list, or clicking the magnifying glass to search. The system adds
this person automatically as the DOS Provider when generating invoices that are not
from Chart.

Address Lines 1 & 2

Self explanatory.

Zip

Upon entering a known zip code, the system automatically fills in the City and State.

Phone Numbers

Solution Series provides space for up to three phone numbers for each account. To
designate one of these phone numbers as the favorite/preferred phone number,
click the star-shaped button next to the field. Only one phone number can be
designated as the favorite phone number. By default, the first phone number
entered will become the "favorite" phone number or, if only one number is provided
for the account, that number will be the favorite phone number. If additional phone
numbers are added to the account, the option to select a favorite number will be
activated and a different number can be selected, if desired.
•

Phone (H): If a number is entered that is already in the system for other person
entities, the address details are filled automatically.

•

Phone (Cell): Self explanatory.

•

Phone (Work): Self explanatory.

E-Mail

An e-mail account is required for access to the e-MDs Patient Portal. This e-mail
address will receive messages that are sent from the portal regarding appointment
reminders, appointment confirmation and history forms needed prior to the next
appointment.

Preferred Contact Method

Use this option to designate a patient's preferred contact method. The available
options are Phone, Text Message, Mail, Email, Secure Email, and Patient Portal.
When a contact method is selected here, the corresponding information field must
already be populated with the appropriate information. For example, if Phone is
selected as the preferred method, at least one phone number must be provided for
this account. If the related information is missing for a method selected here, an
error message will display when this option is selected.

Note: If the patient is not an active Portal patient, the Patient Portal method will
be unavailable for selection here.
Preferred Reminder
Method

Use this option to designate a patient's preferred contact method for reminders. The
available options are Cell Phone, Cell Phone Only, Home Phone, Home Phone
Only, Office Phone, Office Phone Only, Mail, Mail Only, Email, Email Only,
Patient Portal, and Patient Portal Only. As with the Preferred Contact Method
option, the corresponding information field must be complete for the method
selected and the Patient Portal methods will be disabled for patients who do not
have active Portal accounts.

Note: The available methods listed for this option are very specific to avoid
excessive reminders going to patients using multiple methods. If a method
indicating "Only" is selected, no alternative method should be used to remind the
patient of upcoming appointments or procedures.
Financial Group

Extremely important field for e-MDs Bill users. Select the Financial Group Code
(such as MDC, PPO, HMO ) that identifies the type of financial resource being
used. This code is also used when filtering accounts for reporting purposes.

Type of Patient

Patients can be assigned to one of the types set up in the Patient Type reference
database. The background color of any appointment for the patient is filled with this
to alerting users about any special conditions that apply to this type.
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Default Referral

Set a default referral for a patient if required. If the patient is Medicare, and this is
primary care clinic, the field should be set to the same person as the Provider to
default on claims with lab or diagnostic tests. When the record is saved, a
referral/authorization for the patient is created under the Tools >
Referral/Authorization work list and appears in red for which there can only be one
for a patient. The default referral is used on claims unless another one is created for
a specific authorization, or the User Provider as Referral if None Set option in the
Bill > Options window is checked.

Marital Status

Select from the list. A faster method is by starting to type the start letters of a known
status and then pressing tab when it is highlighted.

Driver's License No, Date
Expired, State

Driver’s license information. This is useful for skip tracing in e-MDs Bill. To store an
image of the driver’s license, click the camera button at the end of the field. This
loads a window in which the image(s) can be stored. You can capture the image
directly from a scanner or camera using the scanner button above each image
section (refer to the help on the Image Capture tool). You can also import an image
by clicking the folder icon to open a window from which you can browse for and
select a .jpg image previously scanned. To clear an image, click the button with the
minus sign in the scans window. The Driver License Photos and the Patient
Maintenance window can be positioned side by side so you can open the driver
license image and then type the information into the demographics at the same
time.

Insurance

To add an insurance company, click the Add button. A search window for insurance
companies appears. Search for an insurance company and select a group to return
to the Patient Insurance Maintenance window where the policy number, as well as
effective dates and images of the insurance card can be added. Click Save. For
expanded help, refer to the “Patient Insurance” section below.

Addresses Tab
Addresses

If necessary, add additional addresses and phone numbers for the patient. The ones
added in the General tab will appear here when the record is saved. Each one
added here must be given a type. You can add an unlimited number for any entity,
although most reports will use specified types. If you add two addresses of phones
for a patient of the same type, the one with the Primary flag set to Y will be used
where necessary for reporting and other display purposes.

Misc. Tab
External Medical Facility

The default external facility where the patient is treated should they be hospitalized,
in a nursing home, etc. Having a default external facility set can save a great deal of
time during daily operations. It will preset the facility for a patient when scheduling
rounds visits, and is also used by e-MDs Bill to prefill insurance claim forms where
the place of service is not home or office. In both cases, users can change the data
for the round or claim if it is not the default.

Alternate FileID

A place to store a different record number such as a medical chart number, or a
number used by a previous computer system.

Country of Origin

If the patient’s country of birth is listed for this field, select that country. If no
appropriate country is listed, leave this field blank (<none>).

First Visit Date, Last Visit
Date, Release Date,
Release Flag, Patient
Signed Date

The first, release and signed dates are set automatically to the date of first
registration, but can be overtyped. The Last Visit date is updated by e-MDs Bill
every time and invoice is generated. The release flag relates to the level of release
of information authorized by the patient and is used on claims. Most clinics typically
make patients sign a release that authorizes them to supply all information required
to pay a claim (Y). Otherwise, set the flags to N (No), or M (Conditional).
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Account Status

Set to Active, Hold, Collect or Inactive. The Active/Hold/Collect/Deceased settings
control statement printing in e-MDs Bill. When a patient is set to Inactive, the record
is hidden from searches in the patient search window unless the Include Inactive
Patients? Flag is checked. Note that the system still performs duplication checks
against inactive patients.

Super Bill ID

A special Superbill can be printed for patients who generally don’t get the normal
one. Setting the default here helps staff who don’t have to remember to select the
special one every time the patient is seen.`

Super Bill Comment

Free text or lookup field. This prints in bold at the top of Superbills generated for the
patient, as well as the top of the e-MDs Chart window. The purpose is to serve as an
alert to the provider of care. Text can be added to a lookup comment. The comment
group code must be SB in order to be stored in this field. You can add a
combination of a comment and text by loading the comment then adding text.

Billing Block

This is used if a patient is on hold for accounting reasons. When set, it generates
warnings in various e-MDs Solution Series applications as the patient is loaded and
can be used in tandem with the account status and a patient alert to stop staff from
scheduling such patients.

Marketing Referral

Is used in e-MDs Bill for a marketing tracking report that looks at business volume
by referral. Link the marketing source for the patient such as word-of-mouth, Yellow
Pages, advertisement, etc.

Poverty Level

These fields are used in Bill for indigent care billing. Enter the # Family Members
and Family Income, then check the Set Poverty Level box. This cross references to
the Sliding Scale and Poverty discount reference tables in Bill. If the box is
checked, when generating an invoice for patients with no insurance, the discount
adjustment and copay are automatically calculated.

Recall Dates

e-MDs Bill has a recall system including the Notice Processor which includes a list
report, and the Patient Dates Roster reports based on recall dates. Click Add, then
select the recall type and date. There is no limit to the number of recalls per patient.
The same recall type with different dates can be linked multiple times to one patient.
Note that although the purpose is similar, this is different to the clinical
rules/preventive reminders created for patients by Rule Manager in Chart which can
also be used for recall report printing. These fields can also be used for purposes
other than recalls.

Other Tabs
Contacts Tab

An unlimited number of family and emergency contacts can be linked to a patient.
The primary contact can be free text typed and upon saving is added to the list at
the bottom of the screen. Additional contacts must be added by clicking the + button
at the top of the list at the bottom. A relationship is required. To edit the default
contact whose information appears in expanded form at the top of the Contacts tab,
select the record from the list and click Edit. The name information will be grayed
out after it is saved for the first time making it non-editable.

Fax Contacts Tab

This is where a list of fax contacts related to the patient can be added. These f chart
ax contacts show up in the Fax Recipient form when a user is faxing from within a
patient or DocMan account. These contacts are people or organizations that you
typically need to copy documentation to when you see the patient. For example,
these could be insurance companies, specialists or referring physicians. Click the
Add button then search for entities by Provider, Organization or Person. Make sure
you have a fax number for the entity.

Note: The patient’s default referral physician is added to this list automatically.
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Facilities Tab

The facilities tab is used by Chart. Enter the External Medical Facility (i.e., hospital,
nursing home, etc.) Registration Facility and any Pharmacies where a patient
normally fills prescriptions. The pharmacies will appear on a short list for doctors
when prescribing medications, making it quicker to fulfill the prescription
electronically. Multiple pharmacies can be linked to a patient but only one can be
designated as the Default.

Employment Tab

Allows viewing of demographic information tied to the patient/person guarantor. This
data shows the current employer demographics, as well as a complete employment
history, sorted in date order. Only the most recent one is used for claims. The
default status is set to Unknown.

Note Tab

Used as an internal communication tool for billing and other messages between
users. The check boxes above the note can be set to make this note appear as a
warning in other e-MDs Solution Series modules. If the e-MDs Schedule option is
checked, the note pops up automatically upon scheduling a patient, and the Edit
Appointment window Alert button label is red. In e-MDs Bill, there is a red alert
button in the invoicing module and in Chart there is a yellow triangle icon on the
patient toolbar with an exclamation mark that turns red. Up to 5,000 characters are
supported. An example of a note “Patient owes $20.00 copay from 10/02/2002 visit,
transfer to billing office before scheduling an appointment!”.

Aging Totals Tab

Shows current aged balances in e-MDs Bill.

File History Tab

This is where users can generate a report of any claim generated for the patient.
The specific claims histories are located in the claims themselves. Click the Print
button for a hard copy of the report.

Alternate IDs Tab

The alternate IDs tab is where you can add custom fields to the record. An
administrator with appropriate security privileges can set up a list of available fields.
To add one of these to the record, click Add, select the Alternate ID Type by clicking
the list box to see the field names, then enter the Value specific to this record and
click Save. You can use the alternate IDs in claims by setting up definitions. This
option can also be used to filter groups of patients when performing a search.

Managing Patient Accounts
Here are a few useful tips to remember when working with patient accounts:
•

Instead of giving established patients a blank intake form, print the Chart Cover report and ask the
patient to verify the information on this report. That will save time for both you and patient.

•

If you change a telephone number, be sure to read the prompts regarding guarantor linking or linking
to other entities. Failure to do so can result in other entities with the same number or no number
being updated. As part of being able to update family groups from one screen the system checks for
other entities with the same number. If you have used a placeholder number, or have left it blank,
you may be prompted to update other entities with the new number. Only do so if you are absolutely
sure. In most cases you should select option to create a new one. You may have patients calling
other patients because all entities linked will be affected (patients, organizations, etc.). If you need to
clear a number, use the red X button. Do not enter blanks.

•

Patients can only be deleted if they are not linked to other data. As soon as a medical record, invoice
or appointment has been generated for a patient record, it cannot be deleted until the other data is
deleted first. If any information for that patient has been locked such as signed off in e-MDs Chart,
then it is impossible to delete the patient.

To edit or delete a patient:
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu
option.
OR
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Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the
Find Patient window
2. Enter search criteria into any of the fields (such as patient name, social security number, or
account number) and then press Enter or click Search.
○ Searches can be performed on either all or only part of a patient name.
○ To search on first and last name, type a few letters of the last name, followed by a comma,
then a few letters of the first name.
3. To edit patient demographics, highlight the correct patient from the search results, and click Edit.
Make changes as desired, and then click Save.
4. To delete a patient, highlight the correct patient from the search results, and click Delete. If visit
notes are attached to the patient, deletion is not allowed.

To designate a patient’s race as multi-racial:
1. Click the down-arrow to the right of the Race field. A basic list of races appears.
2. Click Other Race to select that option.
3. Click the Search button (magnifying glass) to the right of the Race field to open the Select Race
window.
4. Scroll down the screen to locate the first race to be selected.
OR
Type a search string in the Description field and click Search to locate the matching race(s).
5. If the first race is to be specified as the Primary race, click the checkbox in the second column
(under the gold star) before the race name.
6. If the first race is not the Primary race, click the checkbox in the first column.
7. Continue to locate additional races to be specified and click the appropriate checkbox before
each race. (There can be only one Primary race selected.)
8. After all appropriate races have been selected, click the Save button to save your selections and
close the window.
9. When you return to the Misc. tab, notice that the Race field is no longer selectable. However, if
you move the mouse over the field, the selected races will be listed in a hint box (for example,
Other Race, African American (Primary), American Indian).
10. If you need to change the race designation after selecting multi-racial values, click the Search
(magnifying glass) icon next to the Race field. From this screen you can:
○ Click the red X button at the bottom of the window to specify Remove Selected Races.
○ Click to uncheck one or more races selected earlier.
○ Click additional checkboxes to add one or more races to the selection.
11. If you change anything on the Select Race window, click Save to keep your changes and close
the window.

To add a provider fax contact to a patient account:
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu option.
OR
Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the
Find Patient window
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2. Enter the search criteria into any of the fields (such as patient name, social security number, or
account number) and then press Enter or click Search.
3. Select the desired patient from the search results and click Edit.
4. Click the Fax Contacts tab and click + Add.
5. Type the provider contact information in the appropriate fields.
6. Click Save to retain the changes and close the window.

Patient Insurance
There is no limit to the number of insurance companies that can be stored in a patient file. Insurances can
be classified as current or expired based on the effective dates. e-MDs Bill adds every current insurance
to invoices generated for the patient and each will be billed in turn.
Users should be familiar with how e-MDs Bill handles insurance companies, company types, insurance
groups, and copayment and percentage responsibilities. You may also wish to review the contract setup.
When insurance companies have been set up correctly, there is very little to do when adding them to the
patient files. Occasionally secondary coverage will require some defaults to be changed.
Much of the information required to add an insurance company can be obtained from the patient’s
insurance card.
Note: Changes to insurance companies in the patient file cannot affect invoices already created.

To add patient insurance coverage information:
1. Open the patient file and ensure you are in the General tab.
2. Click the Add button in the Insurance section at the bottom of the window (Alt+A). The system
opens the insurance company search window.
3. Search for and highlight the insurance company name.
4. Next locate the group and click the Select button (Alt+L). The system goes to the patient
Insurance Maintenance window.
5. Verify the insurance company and group information.
6. Complete the fields in the window as described in the Insurance Maintenance Options table.
7. Click Save. The system returns to the patient window.

Note: To change the assignment order, highlight the insurance and clicking the blue arrow
buttons.
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Insurance Maintenance
Options
Insurance Type

Defaults to setting in the master insurance company file. Changes are usually not
necessary unless the following scenarios exist. The scenarios are dependent upon
the electronic claims format being used to file claims to the payor.
•

NSF: Medicare or Medicaid is being added as secondary and type is MP.
Change to OT.

•

NSF: Group insurance (GP) is being added secondary to Medicare, and is a
Medigap policy. Change to MG.

•

NSF: Other situation exists where insurance company is classified as GP
(Group), but the particular group is another kind for liability insurance or other.

•

ANSI: If the insurance is Medicare Secondary, then one of the following types
may be used:
12 – Medicare Secondary Working Aged Beneficiary or Spouse with Employer
Group Health Plan;
13 – Medicare Secondary ESRD Beneficiary in the 12 month coordination
period with an employer’s group health plan;
14 – Medicare Secondary, No-Fault Insurance including Auto is Primary;
15 – Medicare Secondary Worker’s Compensation;
16 – Medicare Secondary Public Health Service (PHS) or Other Federal
Agency;
41 – Medicare Secondary Black Lung;
42 – Medicare Secondary Veteran’s Administration;
43 – Medicare Secondary Disabled Beneficiary Under Age 65 with Large Group
Health Plan (LGHP);
47 – Medicare Secondary, Other Liability Insurance is Primary.

Policy Number

Click SSN (Alt+N) to use the guarantor social. Extra characters can be added to the
SSN (use the Home and End keys to move to the start and end of the field if you
prefer to type). If there are spaces or hyphens in the policy number, enter them
unless the payor requires them. Most electronic claims formats permit these. This
populates boxes 1a and 9a of the CMS/HCFA-1500, and box 60 of the UB-92.

Policy Holder, Patient
Relationship

Defaults to the guarantor in the patient file. If necessary, click the Guarantor button
on the Policy Holder field to add another. There is also a shortcut to copy common
information from the patient. A patient can have policyholders that are different to
the guarantor, and different policyholders for each insurance. There is NO need to
duplicate patients as some older/legacy systems required in cross-billing situations.
The default can be changed for each insurance by clicking the Guarantor button.
Browse for a guarantor by type (person or organization) and select. The policyholder
information populates boxes 4 and 7, and the relationship box 6 of the CMS/HCFA1500, and boxes 58 and 59 of the UB-92.

Route Code

Typically not used any more. In the past, it was used by Blue Cross to track plan
types (XGA, etc.), but most of the Blue Cross carriers now require this number to be
added to the front of the policy number.

COB Indicator

Coordination of Benefits refers to the NEXT type of supplementary (also called
secondary) insurance, if applicable. Some insurance companies require information
about the type of secondary when the primary claim is filed. Each type of secondary
has an associated numeric reference. Click ‘?’ to see a table of references with
associated descriptions. Leave the setting to zero if there is only one insurance
company, or if the insurance you are adding is the final supplementary.

Date Effective, Date
Terminated Date

Coverage dates. If the current date is after the termination date, the insurance turns
red in the patient file to indicate terminated insurance. Only current insurance is
used when starting a new invoice.
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Carrier Code

Carrier Codes are issued by one insurance to identify another insurance. If a patient
has two insurances for example, and Medicaid is one of them, Medicaid provides a
list of carrier codes to identify the other insurance company. In this case you would
pick the other insurance company’s carrier code from Medicaid list and use it to
identify the other insurance on the record.

Deductible, Policy Limit,
Max Benefit, Last
Eligibility Check Date
Notes

Eligibility information. If an electronic check is performed, these are updated
automatically.

Insurance Card Scans

Click the buttons with folder icons, or right-click in the image placeholders to load an
insurance card image. Browse for .jpg files. Highlight the file and click Open. NOTE:
The browser will remember the last directory browsed, so save all your insurance
card scans to this. If the image is scanned at a high resolution, it might not fit into
the box but you can still drag it around to view data that might be hidden.

Free text area for notes about patient insurance. If electronic eligibility is done, then
this is populated with expanded information. Data that is considered important will
be in red.

Contact Information
The ability to add further contact information to a patient file can be invaluable. It can be used for
emergency contacts, school information, etc. Having a database of contacts is useful because it saves
users having to find this information in paper files.
Because contact information does not require much more than name and address information, the data
from these is pulled from the person tables which are the basis for all person entity records. If a contact
is added as a new person, he/she will be available in the master patient index to add as a patient at a
later date. If the person already existed in the database as a guarantor, patient, etc. then the system will
link to that record. In addition to the patient contacts tab, you can access contacts under the
Demographics > Persons/Contacts tab in Bill.

To add contact information:
1. Access the patient file as described previously.
2. Click the Contact tab.
3. Click Add Contact.
4. Browse the person/contact database for an existing record, then highlight it, or add a new one.
5. Click OK.
6. Select a Relation to Patient from the available list or type your own entry.
7. Click Save.

Patient Employment/Schools
When a new patient is added, the employment status, a required field, is automatically set to Unknown.
The employer database can also be used to add school, university or other applicable information. If an
employment classification is set, the employer name prints in Box 11b of the CMS/HCFA-1500. .
The system permits an unlimited number of employers for a patient. The list is sorted by the date the
employment ended. The last employer is used in claims.

To add patient employment information:
1. Access the patient file as described previously.
2. Click the Employment tab.
3. Set the patient employment status
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4. Click Add (Alt+A) to add the employer, specifying values for the following options:
○ Organization: Click the magnifying glass button to search for and select an organization.
○ Employee ID: Enter if applicable.
○ Title: Employee job title or position.
○ Start Date: The date the patient started working at this company.
○ End Date: The date the patient left the company.
○ Hours Start, Hours End: Patient’s work hours.
○ Email Address: Patient work e-mail.
5. Click Save (Alt+S).

Take a Patient Photo with e-MDs Snapshot
The patient demographics window has a placeholder for a photograph. The most recent photo can also
be seen in e-MDs Chart and e-MDs Schedule. It’s a good way to make sure you are working with the right
patient. Worth noting is that you can double-click it to see prior saved photos – particularly useful for
pediatrics.
Any TWAIN compatible digital camera can be used to capture patient images. e-MDs recommends one of
the inexpensive models that will be permanently plugged into a particular computer’s USB or other port.
The photo computers can be at vitals stations, or near check-in. Take into account the fact that people
often like their pictures to be taken in front of others, so a station behind the waiting room door or similar
can be suitable.
Tips for making it easy for your staff to take photos:
•

Paint a line or foot marks on the floor so you have to focus each picture.

•

Mount the camera on a rail for height adjustment. Many cameras come with a screw mount that
can be attached to a clip.

Note: This only needs to be done on the workstations where the digital camera is located.

To take a patient photograph:
1. Select the patient in Snapshot.
2. Click Take when the patient is ready. The image will appear on screen.
3. If necessary, click Take again to take a different picture.
4. If necessary, crop the picture by dragging it from the top left to the bottom right of the area to be
saved, then clicking the Crop button.
5. Click Save to store the image. This replaces any previous photos of the patient in the
placeholders found in the patient demographics, e-MDs Chart and e-MDs Schedule windows.
Note: Previous images can still be viewed by double-clicking the placeholder in e-MDs Chart.

Capturing Insurance Card Images
The patient insurance maintenance windows can store front and back images of an insurance card. This
can be a very useful function. The card images are instantly accessible to billers who need them for
claims submissions. The hidden cost of retrieving insurance information or making photocopies for the
patient chart is surprisingly high.
Any windows-compatible scanning or camera device can be used to capture the images so long as they
are saved as .JPG files (JPEG). Follow the instructions for that device for setup and scanning.
Tips for scanning insurance cards:

e-MDs Solution Series Bill User Guide 8.0 R00

117

•

Scan in black and white. Color is allowed, but the files are larger.

•

If your scanner permits, create custom scan profiles to avoid having to crop images. Scanners
made specifically for cards have been known to work well.

•

Save the scanned images using file names that are easy to locate. After a while the scan
directory will have thousands of images. When linking to patient insurance (see above), you can
filter the list by typing some of these letters.

Copying Patients
The Copy feature is used to speed up data entry for new patients that share demographic information
with others already in the system. The fields that are not copied are: First, Middle, Prefix, Suffix, Display,
Maiden, DOB, Gender, SSN, Marital Status, Account Number and relationship to Guarantor. All insurance
information is also copied, although the policyholder relationship must also be edited.

To create patient records using the Copy key:
1. Go to Demographics > Patient (Alt+D, P).
2. Search for the patient already in the database and highlight the record.
3. Click Copy (Alt+C). A new patient data entry screen appears with many fields already filled.
4. Enter missing information and overtype fields in which the information needs to be altered.
5. Open each insurance on the file and change the policy holder relationship.
6. Click Save (Alt+S).

Eliminating Duplicate Records with Person Merge
The person merge utility is designed to “eliminate” duplicate records that may exist in the system due to
bridging, conversions from other systems, or data entry errors. Users can select a record to keep, and
then select another record to merge. The Keep record must be a patient, but the merge record can be
any person type, so if you are trying to merge different person types (e.g. doctors), you must create a
patient record for them first.

Merging Records
All data such as invoices, appointments, chart visits, FlowSheet values, and documents that were linked
to the merged record are re-linked to the record that is being kept. In some cases, if the merge record has
data that is not in the keep record, this will be added. The merge, however, combine any information in
the following sections of the Chart Health Summary: Past Medical History/Family History, Surgical History
(PMH/FMH/SH), Tobacco/Alcohol/Supplements, Substance Abuse History, Mental Health History, and
Communicable Disease History. Before merging, ensure that any information in the record you are
merging is added to the keep record.
The merge utility opens a Bill Patient maintenance form in read-only mode. It displays all the data as it will
look after the merge. Once a merge is started, it cannot be undone, therefore the Demographics: Person
Merge security privilege required to use this module should only be assigned to people who can be
trusted to execute merges correctly.

Trial Feature
The system includes a trial function that lets the user see the effect of a merge on the demographic
record. It displays exactly what the record will look like after the merge. For safety’s sake, a trial is
required before the user can merge.
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Merge Suspect Lists
Suspect lists can be created to identify possible duplicate records. You can merge from the suspect list
window. The lists can be saved so that users can work through a list based on specific criteria. Save lists
are dynamic in that as persons/patients on the list are merged, the list changes.

To create a suspect list:
1. In the Person Merge screen, click the List button.
2. Click New.
3. Enter your suspect filter fields and criteria. For example, you may want to find patients
whose last name starts with “Smith,” so enter smith in the Last Name Filter field, then select
Starts With in the Suspect Criteria field.
4. Click Search. The system retrieves a list of matches. This list shows all the potential
matches so you will see what appears to be “duplicates”. This is because the left side shows
patients that will be kept and the right side has information about those who will be merged.
Each potential merge is listed, and each one will appear both ways (so you can merge into
either record). Thus, 3 people could have 6 entries per the example below:
John Smith, John Smithers
John Smithers, John Smith
John Smithy, John Smith
John Smithy, John Smithers
John Smith, John Smithy
John Smithers, John Smithy
5. Click Save List and enter a name.

To delete people from a suspect list:
Potential suspects form a saved list so that the list can be worked to its conclusion. Deleting from the
list does not delete the patient or person – it just removes the item from the list.
1. Open the Suspect List in Edit mode.
2. Select a record to be removed and click the Delete button.
3. Click Yes when prompted to confirm the deletion.
4. Click Save List to store the changes.
Note: If you click Search from the same list, the system queries the database using the same
original criteria and thus records that were deleted from the list may reappear. If you do this by
mistake, exit from the list without saving the changes.

To merge people using the suspect list:
It is a good policy to ensure that you have a backup prior to merging records because the action
cannot be undone if you make a mistake. If you have not created a backup, do so now before
continuing.
1. Open the list (you can do this in Edit mode if you think you might change the criteria, or just
select it).
2. Click the record you want to merge and verify the information to ensure you have the correct
record.
3. Click Trial. Verify the names in the confirmation prompt and, if you are sure you want to
continue, click Yes.
The system loads the record as it would look if you executed the merge. Review the information
in each tab to ensure you have the correct record.
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4. Click Exit. If prompted to save changes, you do not have to do this.
5. Click OK. The merge begins. When it is complete, a “Merge Complete” prompt appears.
6. Open the patient in a Solution Series module and verify that the information is correct.
For example, you may need to change the primary/system flag for the default phone and address
types, or delete duplicate phone and address entries. Also check the sequence of insurances in
the patient file and make sure you have the correct sequence for primary, secondary, and so
forth.

Merging Persons
Before merging any records, perform the following important steps:
•

Ensure you have a good backup. If you merge the records without a valid backup and there are
problems, you will not be able to restore the original record structure automatically. You cannot
unmerge.

•

Merges should be done when no other users are on the system. Although the merge may work,
users will encounter problems and error messages if any data related to records being worked on
is open in the system.

•

e-MDs recommends that the record being retained is given a special identifier prior to merging
(such as putting a character after the last name which can be removed after merge). This will
ensure users do not merge the person record for the patient they are keeping since this will set
the record status to deleted making it seem like all records have been deleted.

•

The merge program file (personmerge.exe) is installed in the same directory as the other e-MDs
applications (by default that is c:\program files\e-mds\solution series\apps), but a shortcut is not
created by default. You need to create this on the administrator’s computer.

•

You must have the Demographics: Person Merge security privilege to use this module.

•

Telephone and address records are not merged. After the merge you will need to open the
record and ensure you remove any duplicates and set the default/system option for phones or
addresses of the same type (e.g. Home). Failure to do this may result in duplication and
balancing errors on financial reports.

•

Insurance companies linked to the patients are only merged if they are exactly the same
company with the same group, policy #, date terminated, copay, insurance type and indicator
code.

•

Insurance companies linked to the patients are only merged if they are exactly the same
company with the same group, policy number, date terminated, copay, insurance type and
indicator code.

To merge persons:
1. Open the Person Merge Utility.
2. Click Find. The main part of the window displays two search windows. The left side is used to
find the patient to keep. The right side is used to find the person to be merged.
3. Enter the search criteria for the patient to keep on the left, then click Search. Matching
records will appear.
4. Enter the search criteria for the person to merge on the right, then click Search.
5. To view either the keep or merge records in read-only mode, highlight and click the View
button for the applicable side of the window.
○ For patients (left side), a Bill Patient Maintenance form appears.

e-MDs Solution Series Bill User Guide 8.0 R00

120

○ For persons (right side), the Show Person form appears. It is highly recommended that you
review the data by opening the forms.
Click Exit to return to main merge window.
6. If both records have the same social security number, using the Bill demographics, open the
person record that will be removed under Demographics > Persons/Contacts and delete
the social security number.
7. Back in the Person Merge utility, highlight the record you want to keep (on the left) and click
the Select button (on the left).
8. Highlight the record you want to merge (on the right) and click the Select button (on the
right).
9. Click the Trial button located on the toolbar at the top right of the window.
At this point, the system will mimic the merge without actually doing anything.
10. When a confirmation prompt appears, click Yes. A preview of what the merged record will
look like appears.
11. Review the merged record preview and then click Exit to close the preview window.
12. If you want to actually merge the previewed record, click the Save button on the toolbar at the
top left.
Again, a merge confirmation appears.
13. If you are sure you want to continue, click Yes.
Another prompt appears indicating that when the merge is underway and it may take some time.
The time is dependent upon amount of data being merged and system resources.
14. Click OK. and the merge begins.
When the merge is complete, a “Merge Complete” prompt appears.
15. Open the patient record in a Solution Series module and verify that the information is correct.
For example, you may need to change the primary/system flag for the default phone and
address types, or delete duplicate phone and address entries. Also check the sequence of
insurances in the patient file and make sure you have the correct sequence for primary,
secondary, and so forth.

Important! If you get a “timeout expired” message during the merge, it may indicate that the system
does not have the necessary resources to execute the merge. Try again at a time when there is less or
no network activity, or on a more powerful workstation. There is a built-in system timeout function that
stops the process after a number of minutes to ensure it does not hang. If you see this, repeat the merge
until all the data is merged and the Merge Complete prompt appears.
Notes:
•

After merging, some further clean up work may be required. For example, if both records had
different insurances, or phone numbers, users will need to delete those that do not apply. If you
do not do this, you may see duplicate displays in various searches and reports. Failure to do this
may result in duplication and balancing errors on financial reports.

•

Depending on the amount of data linked to the records, each merge may take a few minutes
depending on your system specifications.

•

Check all the invoices for the kept patient and make sure the guarantor on those invoices is not
the merged one. To check, just change the name of one entity and see if both update. If it is a
different record, you must change the links to avoid problems with reports.
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Guarantors
A guarantor is the person, organization or other entity ultimately responsible for payment of services
rendered. A guarantor must be established for each patient. Statements are mailed to guarantors linked
to invoices, not to patients. One guarantor can be responsible for as many patients as necessary and a
unified (family) statement for all invoices on the account is sent to the guarantor.
A patient can be his or her own guarantor, or may be a head-of-house guarantor, or an organization (such
as an employer or state welfare service), or a legal firm. The guarantor’s responsibility is for balances due
after all insurance settlements. Head-of-house guarantors render payment for all members of the
household, consisting of a spouse and several children. Organizations or legal firms can render payment
for many unrelated patients.

Notes:
•

Although a default guarantor is added to a patient, e-MDs Bill supports easy cross-billing to other
guarantors at the case and invoice levels, so you have to duplicate the patient record for different
visit types (e.g. workers’ comp, litigation). This is extremely important since it enables patient
clinical information to be kept in one longitudinal record, while payment responsibilities are
assigned to whoever is responsible. Alternate guarantors can be linked to a visit manually, or by
linking a case to the patient.

•

Although the same data tables are used for guarantors and policyholders, they are treated very
separately from the billing standpoint. Policyholder information is what goes on a claim, and each
insurance company in a patient file can have a separate policyholder. When a policyholder is
added to the system, it is stored in the guarantor tables.

•

Not only is it possible to cross-bill to different guarantors, but e-MDs Bill can also cross-bill to the
guarantor’s insurance.

•

The guarantor table is also where legal referrals are stored.

Adding Guarantors
Guarantors can be added in many ways depending on the workflow. The most typical way is at the same
time as adding a patient.

To add a self guarantor while adding a patient:
Click the Self button (Alt+L) in the patient Demographics window. This adds a complete guarantor
record, and also sets the relationship to the patient as Self.

To add a guarantor manually:
Start adding a new guarantor using one of the following methods:
1. Click Demographics > Guarantors, then click New.
OR
While adding a new patient, click the blue plus sign (+) button at the end of the Guarantor field
or use the Self button which automatically creates a new guarantor record based on the patient
demographics.
2. Select the Guarantor entity type (person or organization). This field is set automatically
depending on the type of guarantor selected in the next step.
3. If the guarantor is being added from the patient record and is a person with many shared
demographics (e.g. a family member), click the Copy from Current Patient button which
automatically fills out most of the fields leaving you with just first, DOB, gender and a few
others. Then save. Otherwise…
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4. Select the Guarantor Type. This will change the appearance of the window to
accommodate the different demographics requirements for persons or organizations. See
Guarantor Windows Options for information on the options available on this screen.
5. Click Save.
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Guarantor Window Options
General Tab
Account Number

An alphanumeric account number based on the guarantor name is added
automatically. Overtype if required.

Account Status

There are five settings.
•

Active: Whenever a statement run is generated, this guarantor will be included.

•

Hold: This guarantor will be skipped in statement runs. This is a useful setting
for Medicaid and other balances that you cannot bill to the guarantor. Keep in
mind that you can have an active guarantor but hold printing for some patients
by setting the patient account status. If the guarantor has been turned over to
an external collections agency, set to Hold to prevent illegal double-billing.

•

Collect: An internal classification that is displayed in various collections tools.
Statement printing is not with held.

•

Deceased

•

Inactive: Hides the guarantor record from basic searches.

Insurance

Add insurances in the same way as for patients. If the guarantor being added is
already a patient in the system, the insurance will already be filled out.

Phones & Address

Pulled from the person or organization file. Depending on the type you will see
person or business oriented phone types and the address is also saved as home or
business.

Other Tabs
Addresses Tab

Pulls data from the linked demographics entity (person or organization). If the
guarantor is a person and you want to mail statements to an address other than the
home address, enter a Billing address. The system will use this if one is found.

Employment Tab

Add guarantor employment in the same way as for patients. The status is set to
Unknown by default.

Aging Totals Tab

Shows the guarantor aged balances, last statement date and last payment date
when there is activity on the account.

Statement History Tab

This screen displays a record for each statement printed for the guarantor including
date and age balances. The history can be printed. Please note that if the save
local copy is turned on, you can also access a copy of the statement here.

Alternate IDs Tab

The alternate IDs tab is where you can add custom fields to the record. An
administrator with appropriate security privileges can set up a list of available fields.
To add one of these to the record, click Add, select the Alternate ID Type by clicking
the list box to see the field names, then enter the Value specific to this record and
click Save. You can use the alternate IDs in claims by setting up definitions.

Insurance Companies and Groups
Adding insurance companies is a three-step process. The first step is to add the insurance company
demographics. Second, add at least one linked group (plans, products) and its associated fee schedule if
applicable. Then, link providers credentialed to render services for the payor.
Multiple insurance groups can be associated with each insurance company. These are the different
employer and other plans or products offered by the company. Each group can contain different payment
information including copayment, deductible and patient percentage responsibility. If a patient has a
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group requiring a percentage of payment, the system automatically calculates patient balances and
prompts users for this payment at the time of invoicing. Each group can also have a unique fee schedule.
Once an insurance company is added to the database, it is duplicated unless there is a special reason
such as for reporting segregation. This ensures better consolidation of data for reporting purposes. The
defining answer to “when is it necessary to add a new insurance company” is if there is no other entry
with the same mailing address. The following are situations where insurance companies may be
duplicated:
•

There is more than one mailing address even though the company name is the same. Insurance
companies will specify different addresses for location tracking purposes.

•

The group to which the patient belongs is a Medigap carrier (Medicare supplementary). Since the
electronic filing payor ID (the electronic mailing address) and the Medigap number use the same
field, this is a situation requiring duplication. Medigap carriers are also defined as a different
insurance type. Note that this is not an absolute – the code identifying a group as a gap plan can
be set on a patient level.

•

Your facility wants to separate a particular plan for reporting purposes.

Adding Insurance Companies
Before adding insurance, make sure you understand the entity structure of the e-MDs Solution Series
database and how this can speed up data entry as well as maintain data integrity.
Insurance Groups are added to insurance companies. A single insurance can have many groups under it.
Do not create a new insurance company each time a new group number is entered – simply add it to the
existing insurance address.
A standard format for entering insurance company names and addresses should be established and
rigidly enforced by the clinic. This reduces the chances of duplication and improves reporting. For
example, always use the same format when entering PO Boxes (versus POB, or P.O. Box) because
address and zip duplication checks cannot tell the difference. Likewise, establish a protocol for naming
insurance companies like Blue Cross (BCBS, BCS, BSH, BC/BS, etc. are all duplicates of the same
thing).

To add insurance companies:
1. Go to Demographics > Insurance Companies.
OR
From the patient file, click Add in the Insurance section. The Find Insurance Company window
appears. Check to see if the insurance company is in the system before adding a new record.
Address searches are usually best for this.
2. Click New.
3. If you are adding an insurance company that is very similar to an existing one, search for and
select it first, then click Copy.
4. Type data in the Insurance Company Maintenance window fields. (See Insurance Company
Maintenance Options for more information.) An asterisk next to a field label indicates that it is
required.
5. Click Save. If any required fields have been missed out, the system responds with an error
prompt that specifies what is missing.
Note: The red X buttons in the data entry window are used to clear information entered in the fields.
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Insurance Company Maintenance Options
General Tab
Name

Use the name in the claims address on the patient insurance card. It is strongly
recommended that you have an established protocol fo rinsurance company names
to prevent duplication. For example, always call Blue Cross and Blue Shield the
same thing (e.g. BCBS, BC/BS, BCS, Blue Cross, Blue Shield and other
combinations cause problems because the system sees them as different records).

Office Number

If applicable – some insurance networks associate a number with each regional
office.

Department

If applicable. This is not used anywhere. "Claims" is a common use.

Network

Use to enter insurance network information (e.g. PHCS) if applicable. This shows on
the search screen and makes it easier for users to identify particular carriers.

Parent Organization

If necessary, link to a parent organization. For example, you may have many
entries with the same to account for different addresses, but can link to the umbrella
organization.

General Phone

This is the office phone number. A claims inquiry number can be entered in the
Addresses tab. If the phone has been used before, the address, city, state and zip
are automatically entered.

Phone (Fax), Claims
Phone, Referral Phone,
Eligibility Phone

Self-explanatory. Each will appear in different places in the system e.g. referrals
module, collections module in Bill.

Address Lines 1 & 2

The address used on printed and electronic claims – usually included on patient
insurance cards. Use a consistent scheme for entering post office box addresses.
(PO Box, POB, P.O. Box are all different.) The system performs a duplication check
based on address and zip code. If the characters in the address are different, the
system will not find matches.

Zip, City, State, Country

Upon entering a known zip code, the system automatically fills in the City, State and
Country.

E-Mail Address

E-mail address for contacting this insurance company.

Insurance Type

This is a critical field that must be set correctly if you file claims with the system.
Failure to do so will result in denials. In addition to being used in electronic claims,
the system will also use it in certain paper claim formats to enter data in boxes on
those forms. There is some crossover of data depending on whether you file ANSI
or NSF. ANSI codes are indicated by their descriptions. Note that when linking this
insurance to a patient, it may be necessary to change the type at the patient
insurance level such as to indicate Medicare Secondary Payor. This will not affect
the setting in the master insurance file. Refer to the section on adding insurance to
patients on page 114 for more on this. The default setting is C1 (commercial).

Insurance Class

Insurance classes are a way to group insurances together for reporting aggregation.
Future releases of this software will continue the transition to using insurance class
instead of the invoice financial group when using definitions to pull specific data for
claims. If financial groups with specific definitions are being used, use an insurance
class that matches them exactly. This will ensure when this transition occurs, the
definitions will not need to be reset. To add a class, click the magnifying glass
button.

AN Increment

Used in e-MDs Bill to calculate anesthesia units for anesthesia type of service
procedures. The usual value is 15.

Payor ID

Used for electronic claims. This can be found on the list of payors for a
clearinghouse. The most recent lists are usually available on clearinghouse web
sites. Without a payor ID you cannot send claims electronically. Entering the wrong
payor ID will result in the claims going to the wrong payor and being denied until a
correction is made.
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Medigap ID

Enter the Medigap number for Medicare supplementary payors. This is transmitted
on claims to assist with co-ordination of benefits. If a Medigap ID is available and
this payor is the secondary on a claim, the system will use this to change the way it
fills in the HCFA-1500 boxes 9 to 9d and the electronic claim equivalent.

Default Filing Method

Set to the method for how claims will be sent to this payor. The classifications
determine whether the claim is queued for electronic claims (EF), or for paper (all
types can be selected using this format). You can create other classifications to
make it easier to segregate claims if you have to submit on a special form. The
primary ones in the system are:
•
NF: National Form (HCFA-1500 and other paper formats).
•
EF: Electronic Filing. If there is no payor ID, the system will set claims to NF. All
claims set to EF will be retrieved when building insurance files. Note that if you
want to segregate institutional and professional electronic claims, you can set
up an additional filing status such as IF.

•

UB: UB-04/UB-92 (HCFA-1450).

Origin ID/Indicator Code

The origin ID is used in several places throughout the system to determine data
requirements such as when filling out claims. Use CI if in doubt. For ANSI claims,
make the selection based on the indicator code in the second column using the
following key:
•
09: Self Pay
•
10: Central Certification
•
11: Other Non-Federal Programs
•
12: Preferred Provider Organization (PPO)
•
13: Point of Service (POS)
•
14: Exclusive Provider Organization (EPO)
•
15: Indemnity Insurance
•
16: Health Maintenance Organization (HMO) Medicare Risk
•
AM: Automobile Medical
•
BL: Blue Cross/Blue Shield
•
CH: Champus
•
CI: Commercial Insurance Company. This is the default setting.
•
DS: Disability
•
HM: Health Maintenance Organization (HMO)
•
LI: Liability
•
LM: Liability Medical
•
MB: Medicare Part B
•
MC: Medicaid
•
OF: Other Federal Program
•
TV: Title V
•
VA: Veteran Administration Plan
•
WC: Worker’s Compensation Health Claim
•
ZZ: Mutually Defined/Unknown

National Plan ID

Used for claim filing. NPIs are being implemented as part of HIPAA, but progress
has been slow for submitting this for the insurance identifier.

Formulary ID

Similar to the electronic claims payor ID, this number is used by e-MDs Chart to link
to a specific formulary so that the system can warn physicians if they are prescribing
out of formulary.

PAR

If the clinic accepts contracted rates for this payor, check the box. Do not uncheck
this box if in doubt about whether the practice takes assignment or not because if
you uncheck it, this affects the default for claims which can then result in insurance
companies sending payments to patients instead of the practice.
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Print in Secondary When
Primary

Used by Bill when printing HCFA claims. If a secondary claim is being printed, and
this insurance is the primary with the box checked, it’s information will print in Box 9,
etc. Typically used for Medicare and payors that follow their CMS/HCFA-1500
claims filing rules.

Use National Provider ID

Controls whether to use physician NPIs on electronic claims. This functionality is
linked to the Use National Provider ID for All Insurance Companies option field in the
Clearing House maintenance. If that is not set then the system checks each payor
when building electronic claim files using the clearing house to see if the NPI must
be included. If it is set, then this insurance level setting is moot. The point is to be
able to transition to full use of the NPI in 2007 as different insurances begin
requiring it, but without forcing users to have an all or nothing setup.

CHIP, Public Insurance
and Managed Care

These checkbox fields help distinguish between different iterations of the same
insurance for reporting on the FQHC clinic UDS reports.

Use X12n v5010

If you have identified this insurance company as being ready to receive
transmissions in ANSI 5010 format, you can check this option to enable that
formatting for the selected insurance company only. If you choose to use the 5010
format in this way, always run a test with each insurance company selected to
ensure that they receive the data correctly. Note that another option is available in
clearing house setup when you are ready to transmit all data in 5010 format. See
Clearing House Options for a description of that option.

Contract

Linking a contract to an insurance presets the fee schedules and eligibility check
interval to the default values in the contract, thus reducing the chances of users
entering the wrong values. It can also be used to automatically add codes and split
claims which is usually very important for some clinics with lines of business like
RHC/FQHC encounters. The billing system also tracks which contract is in use for
the insurance whenever it is used on a claim for the patient. These links are
required if you want to fully utilize the contract analysis reports, automatic
contractual adjustments when posting EOBs, withhold tracking and reporting and
some other functions.

Allowed Fee Schedule and
Billed Fee Schedule

This is how fee schedules are linked to the insurance company. The fields can be
set automatically if a contract is selected. The billed fee schedule is the one that is
reported on claims. The allowed is used to track true expected amounts and to
warn users when these are not posted. The system also execute rules by checking
in the allowed fee schedule first to see if there is a specific rule/exception for a payor
that differs from normal rules. Neither field needs to be set but it is highly
recommended. If you have linked a contract, then you cannot change the fee
schedules manually because they are based on the contract settings.

ERN GS02

Not used.

Default Statement Hold
Period

This option allows you to specify a number of days to hold a statement for this
particular insurance company. This can be useful if you know that an insurance
company needs a set amount of time to process a claim. By specifying a number of
days value here, invoices included in statements to that company can be held until
the insurance company has had sufficient time to process the associated claims.

Eligibility

Eligibility checking is performed when either of these options are checked:
•
Check Next Payor: If this option is checked and a patient has other insurance
after this one, then eligibility files include requests for the secondary/tertiary
payors. The default is unchecked so that it will not check those additional
insurances. Depending on where eligibility check files are sent, this can save
transaction charges.
•

Check Interval

Include ICD/CPT: If this option is checked, those codes are included.

This determines how often the system checks eligibility for a patient on this
insurance and is also a cost saver. In some practices it is not really necessary to
check eligibility for the patient every time they have an appointment. The system
checks to see if the patient has had eligibility checked within this interval and, if so,
does not execute another check.
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Eligibility/Secondary
Payor ID

If an eligibility or secondary payor ID is available for this insurance company, enter it
here.

Clearing House

By default eligibility check files are built for the clearing house or other EDI
connection set up in the Options tab of the internal medical facility. This will override
that setting in the event that the check file is being routed elsewhere.

Other Tabs
Addresses Tab

Enter additional addresses or telephone numbers if required.

Groups Tab

Every insurance company requires at least one group. See the section on Adding
Insurance Groups below. This can be a group with “None” as the group number.
Duplicate group numbers are permitted to allow for different copayments, etc. Click
the Add button to add, then enter a Group Number, Description if desired, and
copay information. If the group is linked to a fee schedule, the link can be made
here.

Credentialed Providers
Tab

Each insurance company requires at least one provider to be linked to an insurance
company. This is part of the credentialing check performed by the system. When a
new insurance is added, all the active providers set up in the Providers tab of he
internal medical facility in which the insurance is added are automatically linked. If
there are none, then the default credentialed provider for the internal medical facility
is set based on the Default Insurance Credentialed Provider field in the Internal
Medical Facility file, but additional providers must be added manually.
You can also change the default billing supervisor for the provider to someone else
on an insurance-by-insurance basis. If invoices are generated where the supervisor
is not on this list, a warning message appears. Click Link All to rapidly link all the
providers in this facility to the payor. The Use Supervisor for Filing flag controls
which provider on the claim (Date of Service or Supervisor) will be printed for the pin
information. In general, the default is the billing supervisor (which can be the same
person as the supervisor), but for some payors such as Medicare and Medicaid
where mid-level providers are credentialed in their own right and must file claims
under their own numbers, set the flag to N. To do this, highlight the record and click
Edit, then uncheck the flag.

To edit insurance companies:
1. Go to Demographics > Insurance Companies.
2. Search for and highlight the insurance company, then click Edit.
3. Make necessary changes to the Insurance Company Maintenance window fields.
4. Click Save.

To delete insurance companies:
Before deleting an insurance company, all groups and other linked information associated with the
company must be removed. Do NOT delete the insurance if there is any outstanding dollar amount
receivable from the insurance company.
1. Go to Demographics > Insurance Companies.
2. Search for and highlight the insurance.
3. Click Delete. A confirmation prompt will appear.
4. Click Yes if you are sure you want to delete the company. The system removes the record if
there is no linked information, or a message appears if it cannot.

Adding Insurance Groups
Insurance groups are added as a sub-set of the parent insurance company. This eliminates the need to
add the same insurance company address many times. Unlike some other systems where the group
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number is typed into the patient file after linking insurance, e-MDs Solution Series only requires the group
to be set up once (although duplication of group numbers with different plan information is permitted).
Group information is displayed in the Check In and View Patient Status windows of e-MDs Schedule to
make collection of co pays and deductibles easier.

To add insurance groups:
1. Go to Demographics > Insurance Companies.
2. Search for and select a company (or add a new one).
3. Click the Groups tab.
4. Click the Add (+) button.
5. Enter information in the Insurance Group Maintenance window fields (see “Insurance Group
Maintenance Options” table.)
6. Click Save.
Insurance Group
Maintenance Options
Insurance Company

Prefilled with the name of the company for which the group is being added.

Group Number

Copy this from the patient insurance card. Do not enter spaces, hyphens or other
characters.

Description

If necessary, enter the group name.

Co Pay

The fixed co pay amount to be paid by the patient for each visit.

Deductible

The annual deductible that must be met by the patient before the insurance
company pays claims.

Percent Insurance

The percentage of allowed charges that will be paid by insurance. The patient
percentage is calculated from this by multiplying the inverse of the insurance % by
the allowed fees on a bill.

Fee Schedules

Click the drop down arrow in the list boxes to link this group to a fee schedule.
Although the setting is typically made at the company level, fee schedules are
actually linked to insurance groups in the database, not companies since each
insurance company may have multiple schedules. However, if you want to have a
group-specific link, the recommendation is to create a new company with the group
since updating the fee schedule links at the company level automatically applies the
change to all groups under the company.

Providers
A staff provider is any person providing a service for the clinic where the service is to be tracked and
billed and include mid-level practitioners such as physician assistants and nurse practitioners. All activity
is either directly or indirectly linked to a specific provider. Patients entered into the system must be
assigned a Provider. The provider in the patient file is the default. If another provider sees the patient, that
provider can be linked to the visit for productivity and insurance reporting purposes.
In e-MDs Solution Series, providers can be staff or non-staff and all are stored as Health Care
Professionals with entity attributes that designate them as such. Staff providers are those who work in a
particular organization and can be set up for scheduling, charting, and billing purposes. Non-staff
physicians are not part of the facility and are generally referring physicians. By default, staff providers are
automatically available to be linked to claims as referring physicians too.
e-MDs Bill uses a unique “Supervising” provider system for insurance claims purposes as well as for
clinical notes. Do not confuse the billing supervisor with a clinical supervisor. The billing supervisor is a
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provider who is credentialed with insurance companies and under whose name claims are submitted.
Thus, mid-level providers may have an M.D. or D.O. as their default billing supervisor with others being
set up at the insurance company level. Naturally, providers can be their own supervisor. In fact, this is the
default unless otherwise specified. A supervising provider may also be one used for billing if an
insurance company has a call-covering clause for non-credentialed and locum tenens providers. A billing
supervisor must be assigned, even if this provider is his or her own supervisor because the supervisor’s
name and identification numbers will be used in claims.
Users should be aware that anyone created as a provider can be used in multiple parts of the e-MDs
Solution Series for billing, scheduling and charting. You should never set up dummy doctors because
licensing, logins and a number of important workflow utilities are provider-specific. Even if you did this in
a different system, you will probably find the need is not there in e-MDs due to the ways that data can be
segmented.
These instructions assume that the staff providers are being added from the Demographics menu. There
are a lot of other places in the system that access the same demographics editor but due to the billing,
prescribing and other setup requirements, new staff providers tend to be set up completely before being
used for visits.

To add a provider:
To avoid duplicate listings of providers, search for the new provider before performing the following
steps.
1. Go to Demographics > Providers. The Find Staff Provider window appears.
2. Click New.
3. Type data in the Provider Maintenance window fields (see “Provider Maintenance Options”).
An asterisk next to a field label indicates that it is required.
4. Click Save. If any required fields are missing, the system responds with an error prompt.
Note: The red X buttons in the data entry window are used to clear information entered in the fields.

Provider Maintenance Options
General Tab
Last, First, Middle

As with other person records, the system will check for duplication if a last first
combination matches another one in the system.

Prefix

Select from the list.

Suffix

Use this for the qualifications – those are entered in the Licensure tab.

Display

Nickname or other.

Phone (Office):

If the number already exists in the system, it automatically enters the Address, Zip,
City and State. If the address or telephone change for any people, users will have
the option to update it for all linked records.

Office Address Line 1

If the address already exists in the system, click the magnifying glass at the end of
the field and search for it in the Address database. The same advantages as using
existing phone numbers apply.

Zip

Upon entering a known zip code, the system automatically fills in the City and State.

Active?

For a provider to be available in the system, he/she must be must be active. The
licensing component of e-MDs Solution Series will warn users when the number of
licensed active providers is exceeded and will prevent data entry in various modules
for unlicensed doctors.

Taxonomy

ANSI standard provider taxonomy code required for HIPAA-standard electronic
claims. This is a specialty code. It can be looked up at www.wpc-edi.com.
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Provider Type

This field affects e-MDs Chart and e-MDs Bill which classify providers differently for
clinical and billing reasons. Select the appropriate type.

Specialty

Click Add to link a specialty to the provider. Any number of specialties can be added
but only the primary is a search key. The resource list and visit reasons in e-MDs
Schedule can be filtered by specialty. The provider will be included in searches for
any of the specialties listed here, but only the primary one is used in e-MDs Bill
electronic claims. Note that there are specialty codes for P.A.’s, N.P.’s and other
mid-level providers. The short list specialty is also used in e-MDs Chart (coding
search lists) and DocMan (category folders). Another use is to set short list searches
in the ICD-9 and CPT code search windows which are also the codes that are
synch’d to the e-MDs Companion PDA software.

Addresses Tab
Addresses

Enter additional addresses or telephone numbers, if required.

Misc. Tab
Tax Type

The tax type setting determines where the system retrieves information for the
HCFA-1500 box 25 and electronic equivalents. If set to Federal Tax ID, the tax ID
stored in the internal medical facility file is used (unless overridden by a HCFA
definition). If set to SSN, the number in this provider’s file is used.

Tax ID

The federal Tax ID for the provider. It may be the same as the facility Tax ID.

SSN

Provider social security number.

Print Options

Controls whether the provider Business address or the internal medical facility
address is printed in Box 33 of HCFA claim forms.

Accept Assignment

Defaults the setting for Box 27 of the CMS/HCFA-1500 claim form. This can be
changed on a per claim or insurance basis. It is very rare that this is not set to Yes
because insurance companies will send payment for claims directly to the patient if
they receive a claim with the flag set to No. Thus your collections will suffer if the
patients cannot pay you.

Licensure Tab
Certification

Enter the qualifications for the provider (M.D., P.A., etc.). Any text is accepted.

UPIN

Required.

EPSDT

If your practice participates in the government’s Early and Periodic Screening,
Diagnosis and Testing program for pediatric patients, this number is required on
claims. The program has different names depending on the state (e.g. Health Steps,
Healthy Kids, etc.)

Anesthesia License #:

Enter if applicable.

NPI

National Provider Identifier that the government is expecting to replace Upins. Many
M.D.s and D.O.s cannot have these, but N.P.s and P.A.s credentialled for
Medicare/Medicaid do.

CHAMPUS #:

Enter if required.

DEA

Enter DEA number. Required if using e-MDs Chart and writing prescriptions for
controlled substances.

Mammogram #:

Enter if certified.
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Medicare, Medicaid, Blue
Cross Numbers

These are critical for claims. Enter the provider numbers for the major
state-based payors. Alternate IDs will be used for other payor-specific
numbers. If you do rural health billing, enter the Medicare and Medicaid
RHC numbers in the appropriate alternate ID fields for each. If you are a
solo practice and have both group and rendering numbers, enter the same
number in both fields.

State License Numbers

Numbers for any state can be entered. The state code is used to select the
correct number when printing claims that require a state specific license
number, as well as on prescriptions in e-MDs Chart.

Fax Contacts Tab
Fax Contacts

Supervisors Tab

This is where a physician can add a “circle of friends” or “buddies” that he/she
typically refers patients to. This list is used when you fax information from the
system and gives you a short list of the most common entities you send to making
the faxing process much quicker. You can select multiple recipients in one window.
The alternative is having to go through an extra step of looking up each (which you
can, of course, still do for those not on your buddy list). It works in tandem with the
patient’s fax contacts which are people or organizations that you typically need to
copy on progress when you see the patient. Click the Add button then search for
entities by Provider, Organization or Person. Make sure you have a fax number for
the entity.

This is used to designate other persons that will be used for e-MDs Chart progress
note sign-off (for residents, mid-levels, etc.) and e-MDs Bill claims. A supervisor is
required for e-MDs Bill users. The provider is automatically entered as his/her own
supervisor if the record is saved without entering anyone else.

Default Supervisor

Used in e-MDs Chart. If a provider has a supervisor, the default will show up in the
Note Details when starting a visit, saving you from having to select one.

Clinical Supervisor

Used in e-MDs Chart. Any clinical supervisor for provider is available in the Note
Details window should the default not be supervising a particular visit.

Billing Supervisor

Used in e-MDs Bill, usually for mid-levels, although all providers must have a billing
supervisor, even if it is themselves. The billing supervisor PIN numbers are printed
on insurance claims. If an insurance like Medicare credentials mid-levels and
requires claims to be filed under their name and not the supervisor, you can change
the default billing supervisor for that company in the applicable insurance
demographics.

Requires co-signature on
visit notes

When this is set all notes for the provider are also routed to the supervisor
designated on the visit note.

Alternate IDs Tab
Alternate IDs

This is where you can add custom fields to the record. An administrator with
appropriate security privileges can set up a list of available fields. To add one of
these to the record, click Add, select the Alternate ID Type by clicking the list box to
see the field names, then enter the Value specific to this record and click Save. You
can use the alternate IDs in claims by setting up definitions.

To edit providers:
1.
2.
3.
4.

Go to Demographics > Providers.
Search for and highlight the staff provider, then click Edit.
Make the necessary changes to the Provider Maintenance window fields.
Click Save.
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Deleting Providers
Providers can only be deleted if no information is linked to them. This is done to preserve historical
reporting and audit trails. Make the provider inactive (see below).

To delete a provider:
1. Click Demographics > Providers.
2. Search for and highlight the staff provider.
3. Click Delete. A confirmation prompt will appear.
4. Click Yes if you are sure you wan to delete the provider selected. The system will remove the
record if there is no linked information, or will tell you it cannot delete the record.

Making Providers Inactive
When a provider is set to inactive, he/she appear on the schedule, cannot be selected for NEW progress
notes in e-MDs Chart, and cannot be added to NEW invoices in e-MDs Bill (they are still linked and
displayed on old invoices). You can still view and edit historic data for inactive providers who are no
longer in the clinic.

To make a provider inactive:
1. Click Demographics > Providers.
2. Search for and highlight the provider.
3. Click Edit.
4. Uncheck the Active? box located near the bottom of the General tab.
5. Click Save.

Non-Staff Providers/Referrals
If a patient is referred from one doctor to another, it is necessary to identify the referring physician for
insurance and tracking purposes. Medicare requires referring physician information for all claims with lab
or diagnostic procedures, even if the provider is a primary care physician. For this reason, all providers in
your database should also be set up with a referral file.

To add a referring physician or rendering provider:
1. Go to Demographics > Non-Staff Providers/Referrals.
2. Click New.
3. Fill out information as described in “Referral Options.”
4. Click Save (Alt+S). If any required fields are missing, the system responds with an error
prompt that notes the elements required.

Referral Options
General Tab
Last, First, Middle

As with other person records, a duplication check is made on the first and last
combination. If the person already exists in the system, select that person.

Prefix

Select from the list.

Suffix

Use this for the qualifications – those are entered in the Licensure tab.

Display

Nickname or other.
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Phone (Office)

If the number already exists in the system, it automatically enters the Address, Zip,
City and State. If the address or telephone change for any people, users have the
option to update it for all linked records. The office number is a search key for nonstaff providers.

Office Address Line 1

If the address already exists in the system, click the magnifying glass at the end of
the field and search for it in the Address database. The same advantages as using
existing phone numbers apply.

Zip

Upon entering a known zip code, the system automatically fills in the City and State.

Active?

For a provider to be available in the system, he/she must be must be active. The
licensing component of e-MDs Solution Series will warn users when the number of
licensed active providers is exceeded and prevents data entry in various modules.

Taxonomy

ANSI standard provider taxonomy code required for HIPAA-standard electronic
claims. This is a specialty code. It can be looked up at http://www.wpcedi.com/codes/Codes.asp.

Specialty

Click Add to link a specialty to the provider. Any number of specialties can be added
but only the primary is a search key. The resource list in e-MDs Schedule has a filter
for specialty. Note that there are specialty codes for P.A.’s, N.P.’s and other midlevel providers.

Misc. Tab
Tax Type, Tax ID, SSN

Select the type, then fill in the numbers. You cannot save if the field for the
applicable tax type is not filled.

Accept Assignment

Not used for referrals.

E-Mail, Confidential E-Mail

Placeholders for the e-mail addresses.

Licensure Tab
Certification

Enter the qualifications for the provider (M.D., P.A., etc.). Any text is accepted.

UPIN

Self-explanatory.

NPI

National Provider Identifier that the government is expecting to replace Upins. Many
M.D.s and D.O.s cannot have these, but N.P.s and P.A.s credentialled for
Medicare/Medicaid do.

License Number

Add state medical license numbers here.

Fax Contacts Tab
Fax Contacts

This is typically not used for non-staff providers since it is these providers
themselves who are added to patients so that staff physicians have a quick way to
contact the patient’s providers. However, if the non-staff provider is also a patient
you will see his/her own “circle of contacts”.

AlternateID Tab
An unlimited number of alternate IDs, or custom fields can be entered. Once an alternate ID is created, it is
available for all staff and non-staff providers. Click Add (Alt+A) to add an ID. Select one from the list, then enter the
value specific to this provider. To add a new ID, click the magnifying glass button on the Alternate ID Type field in
the Alternate IDs Maintenance window. An alternate ID has 3 fields.
Internal Name

Automatically assigned by the system. This is the identifier referenced for claims.
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Alternate ID User Name

User defined, this gives the alternate ID a readily identifiable label. Example: “Aetna
PIN Number”.

Value

The value specific to this provider.

Hierarchy of Automatic Referring Provider Linking on a Claim
There are multiple ways to do this. You can create a case with one or more authorizations. When the
case is linked to the visit, the current referral is used. You can also set up an active inbound
referral/authorization for a patient who is retained by the system until it is retired and marked as inactive.
The default can be overridden with another one if necessary. If there is no case or patient authorization,
the system automatically uses the default referral in the patient’s demographics. If that field is blank, the
“Use Provider as Referral if None Set” preference in the Bill or Schedule File > Options window sets the
referral on a claim to the patient default. This last method is useful for Medicare claims that have
diagnostic tests.

Persons/Contacts
The contact database is purely for reference purposes. It is a place where you can store family and
emergency contacts for a patient.

To add or edit a contact and link to patients:
Contacts are best added from within the patient file since this will also give users the opportunity to
specify the relationship of the contact to the patient.
1. From within the patient file, click the Contacts tab.
2. To add a new record or search for the existing record, click the Add button in the lower half of
the screen. The Find Contact screen opens
3. In the Name field, enter a contact name. Choose to search by Provider or Person, then click
Search.

4. Double-click or highlight the name and click Select to edit the record.
5. On the Contact Maintenance screen, enter the contact’s demographics. Click Save to
conclude the update to the database and return to the Find Contact screen.
6. Click Exit.

Employees
Employees are persons who are linked to a specific organization. This is usually done as part of entering
patient information and filling out the Employment tab. You are required to select the organization that
the person works for and can then fill out the job information.
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The Find Employee window under Demographics > Employees is a good tool to look up a list of
patients by organization. You can also search by person to see who they work for although if this is a
patient, there is more information by going through the patient file.

Organizations/Employers
The employer (or company) database is used for reference purposes. Employers can be linked to both
patient and guarantor files. Upon making the links, users will be able to add employee-specific information
such as job title, e-mail address and telephone extension numbers. As with all the reference databases,
e-MDs recommends that you make these links because it can help later on with issues like skip tracing.

To search and edit an organization/employer by telephone number:
1. Go to Bill > Demographics > Organizations and select Organizations/Employers.
2. On the Find Organization screen, type in an Organization Name and the known digits. Click
Search.

3. The query results will appear in the lower pane of the screen.

4. With the name highlighted, click Edit to open the Organization Maintenance screen. When edits
are complete, click Save.

To add or search for an employer and link to patient/person guarantor:
Employers are normally added or linked from the patient or guarantor files.

e-MDs Solution Series Bill User Guide 8.0 R00

137

1. From within the Patient Maintenance screen or from the Guarantor/Policy Holder
Maintenance screen, click the Employment tab.
2. To add or search for an existing employer record, click the Add button above the
Organization Name field. The Find Organization screen opens.
3. On the Find Organization screen, click New. The Organization Maintenance screen opens.
4. On the General tab, add the employer Name (required). Other demographics can be added
on this tab and also the Addresses and Misc. tabs. Click Save.
5. On the Find Organization screen, with the newly created employer name highlighted, click
Select and the Employee Maintenance screen opens with the new organization name
highlighted.
6. On the Employee Maintenance screen, Employee ID, Title and more may be added. Click
Save to return to the Guarantor/Policyholder Maintenance screen.
7. Click Save on the Guarantor/Policyholder Maintenance screen to link the employer to the
patient or guarantor.

Collection Agencies
To access Demographics Collection Agencies;
1. Go to Bill > Demographics > Organizations and select Collection Agencies.
2. On the Find Collections Agency screen, the user’s Read/Write/Delete privileges will determine the
ability to access: New, Edit, Delete and Search functions.

Accessing Demographics Privileges
To access Demographics Organization/Employers:
1. Go to Bill > Demographics > Organizations and select Organizations/Employers.

On the Find Organization screen, the user’s Read/Write/Delete privileges will determine the ability to
access: New, Edit, Delete and Search functions.
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To access demographics provider:
1. Go to Bill > Posting and click Referrals.

2. In Referral/Authorization window, click New.
3. In the New Patient Referral window, under PCP/Referring Physician*, click Find.

4. In the Find Provider window, type a percentage sign (%) in the Name field and click Search.
The Provider privilege will populate the window with a full list of staff and non-staff providers.
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To access guarantor/policy holder organizations:
1. Go to Bill > Demographics > Guarantors/Policyholders.

You can search for both a person guarantor and an organization guarantor at once. Additional search
filters include SSN, Date of Birth, Phone, Address, Zip and Account Number. If a search produces both
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an organizations and person record, both will be displayed as results.

To access demographics person insurance:
1. With user privilege set to Deny, go to Bill > Posting. Retrieve a patient and click Edit Patient.

In the Patient Maintenance window, insurance in the patient demographics is blank. With user privilege
set to Read, it can be viewed but not edited.
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To access demographics organization insurance:
1. Go to Bill > Demographics > Guarantors/Policyholders.

2. Type in a Guarantor Name and click Edit.

3. In the Guarantor/Policyholder Maintenance window, on the General tab, the organization’s
Insurance demographics will be shown only if you have Read/Write privileges. If this privilege is
set to Deny, the Insurance demographics will not be shown.
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8

Posting
This section of the user guide describes the various functions and windows related to
posting. There is information on:
• The windows in the posting section including function buttons, columns, etc.
• How to post charges and payments and to make changes.
• Tips on how special functions, how to post faster using the keyboard, etc.
Because there are many cross-references to sections within this same chapter, we
recommend that you read it thoroughly. There are a lot of functions that have a lot of
power to speed up data entry, ensure it is comprehensive, make edits faster, and set
defaults to smooth the billing process which you will miss if you only read small
sections.

Continued on the next page ...
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The Posting Window
The posting window is a ledger of invoices where you can view and add to transactions for one or more
patients based on a variety of filtering criteria. Users post charges, payments, adjustments and other
financial activity from this window and can also use it as a secondary collections tool.
Invoices are displayed in the top section of the posting window. If an invoice is bold, it has a credit
balance. You may also see different colored status codes or icons in the N and M columns. The colors
help draw attention to specific items.
The bottom of the window shows payments and adjustments for a highlighted invoice. Selecting a
different invoice updates the payment section.
Note: Bill uses an open item accounting process. This means that each invoice is considered to be an
item and remains open until its balance is reduced to zero by payments and adjustments posted directly
to the invoice. The advantage of open item invoicing over a balance forward system (whereby payments
are made to the total account balance) is that it simplifies the visit and line item level tracking required by
medical billing so you can track your collections activities more accurately.

Posting Window Functionality
The posting window has a number of buttons, filters and options that control the invoices retrieved and
functions that can be used. The window is mostly keyboard enabled. Many of the functions have
underlined letters on their button labels. This means that you can press the Alt key and then the
underlined letter to invoke the feature. This is often faster than using the mouse. You can also use the
standard menu button on your keyboard where it is enabled.
Posting Options
User Column and Sizing
Preferences

Each user can change the Posting window size and column widths to their
preference. The settings are stored on the workstation. Move the mouse pointer
over the edges of the window, or over the vertical black lines between each column
label. Then hold down the left mouse button and drag. Click the X at the top right of
the Posting window to save settings.

Title Bar

The title bar is the top border. If you have maximized the posting window, it
becomes part of the Bill module title bar. For the selected invoice it shows the
patient name and the primary provider from the patient file which may not be the
DOS provider on the invoice. When a list is loaded for a specific patient, an invoice
count is also appended.

Searching & Filters

You can control the invoices and payments displayed using a number of filters.
These make the posting window both a charge and payment entry tool as well as a
collections tool because you can retrieve individual claims for things like EOB
posting, or a list of invoices for multiple patients and guarantors meeting some kind
of research criteria.

Retrieve, Clear All, & Exit
Buttons

These are used to load invoices matching filters. They are not needed when using
the Patient, Account # and Invoice # fields since you can press Enter after typing
characters in those fields. If you load a list of invoices using filters other than the
Patient, Account # and Invoice # fields, be sure to click the Clear All button
otherwise your next list may not pull up as you expected since the system caches
the filter settings.
•

Patient, Guarantor, Account and Invoice #: Allow you to filter for specific
invoices. These are commonly used for rapid charge and payment entry, or to
research all activity for a specific account. To load by patient name, enter
characters in last, first format then press Enter or click the search button. This
opens the patient search with appropriate matches displayed so you can select
one. If only one is returned, that information would populate the posting window
immediately. If you know an account number, enter it in that field and hit enter
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to load the patient without going to the search. The Invoice # field can speed
up payment entry because if it is entered it saves time because it automatically
loads the patient and selects the invoice instead of you having to search for a
patient, and then select an invoice. For guarantors, the search allows for both
person and organization searches . You can set up the system to send/print
invoice numbers on claims so that payors report these and not account
numbers on EOBs. The X clears the field.
•

Last: A shortcut option that loads the last patient on which you worked.

•

Date Range: A range of invoices for one or more patients can be loaded by
date range. Check the Use Date Range box, then select Post Date or DOS
Date (based on invoice DOS) and set the date range.

•

DOS Provider: Provider on the invoice.

•

Facility: Where the charges were rendered. If you see all facilities in the
database, check your security privileges.

•

Claim Batch #: Each time the system creates and electronic or printed claim, a
batch number is linked to that invoice for tracking and retrieval.

•

Financial Group: Based on the current financial group on an invoice, not the
patient default financial group.

•

Posting Batch #: Users can set personal batch numbers for charge and
payment entry within the charges and payments window. This filter is based on
those.

•

Balance Range: A great collections filter. Check the Balance Range box, then
set the minimum and maximum range.

•

Status: Based on the current invoice status code. Because an invoice can go
through multiple statuses in the billing cycle, this filter is based on the most
recent code.

•

Due By: You can retrieve patient due, insurance due, or both invoices.

•

Zero(0) Balance: This gives you the option to show open or open and closed
invoices. It can be used to rapidly show a list of invoices that have outstanding
balances so users have to locate these among long lists. Remembers user
preference.

•

Show Locked: Users with the Billing Show Locked security privilege can hide
potentially sensitive invoices from those who cannot have this privilege by rightclicking an invoice and using a function on the right-click menu (e.g. HIV+
diagnosis). By default these invoices are displayed if the privilege exists, but
you can hide them by un-checking the box. Remembers user preference.

•

Show Guarantor Invoices: This option is used to display all invoices lilnked to
a particular guarantor. It is useful when researching how a specific guarantor’s
outstanding balance is derived and also for posting a single payment that is
applied to multiple open items for the guarantor without needing to search for
and locate each patient invoice individually (e.g. family groups, employer based
payments).

•

Exclude Invoices in Agency Collections: This option is selected by default
and will exclude invoices from the grid that are in Collections.

•

Include Invoices in Agency Collections: This option is selecetd to include all
invoices regardless of Collections status in the invoice grid.

•

Include Only Invoices in Agency Collections: This option will only populate
the invoice grid with invoice that are in Collections.
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Account Status & Billing
Block Note

The patient’s current account status is displayed in the middle of the window next to
the Show Guarantor Invoices filter. The color of the text is dependent upon the
status. Active = black, Collect = bold red; Hold = bold orange; Deceased = bold
black; Inactive = purple. If the billing block flag is also set then “Billing Block Set!” is
also displayed in bold red text.

Posting Window Options Above Grid

•

Title: If an invoice title is entered in an invoice, it displays here, making it easier
to reference to visit reason. The title is set automatically if the invoice is built
from an appointment using Chart or the Daily Work List.

•

New Invoice, Edit Invoice: Buttons for posting and editing invoices. New
Invoice starts an invoice for whichever patient’s name is displayed in the Patient
field so it can be used when the posting window is being run in patient or non
patient-centric modes.

•

Copy Invoice: Allows the user to copy a single selected invoice. It will copy:
ICDs, CPTs, modifiers, unit counts, symptom date and symptom date indictor,
cases, service dates, provider, referral and guarantor. The function is
particularly useful for repeat visits in practices that are not generating claims
from Chart.

•

Move Amount: Special utility used to move amounts between invoices. It is
available when the total or patient due balances are negative.

•

Print: Used to reprint an invoice.

•

Visits: Shows a list of patient visits with notes created in e-MDs Chart or e-MDs
Companion PDA, whether they are signed off or not, and if they are ready to
bill. Use the Build Invoice button to auto-generate charges without having to
search for patients or manually enter codes. This window is described in more
detail in Auto Posting Charges Using the Visits Window.

•

Audit: Only visible to users with the Billing Invoice Audit security privilege. It
loads a transaction level audit trail of activity on a selected invoice, as well as a
tool to find deleted invoices.

•

Invoice Note: Opens the invoice notes window to show notes for a highlighted
invoice. The button label turns red if there is at least one note linked to the
invoice and the invoice is selected. Invoices with a note also have a yellow
page icon in the N column.

•

Print Form: A quick way to print a Word form after a patient has checked out.
Because the patient is already known, it saves having to select the patient as
one must if printing forms from the Reports menu.

•

Print HCFA: A way to print a paper claim for the selected invoice.

•

Pat Balance, Gurn Balance: Looks up aged balances broken out by patient,
insurance and total. It is recommended that the Gurn Balance is always
checked first to ensure the total account information is displayed.

•

Edit Pat: Opens the demographics window for the patient whose invoice is
selected. It is a quick way to rapidly check insurance or other information.

•

Appts: Opens the Appointment History window for the patient so you can see
prior and future appointment dates. This window can also be used to copy
existing appointments to create an identical follow up visit.

•

Legend: The button to the right with the blue question mark provides
information on columns, icons and other functionality in the window.

•

Invoice Section Columns: The default sort order for the invoice section is
invoice # with most recent at the top but you can sort ascending or descending
by clicking any column heading. This provides a great deal of flexibility. For
example, you can show invoices with patient due balances at the top of the list,
or sort the list to find invoices with a particular status code or for a particular
doctor.

•

Invoice Title: This is not a column – it’s the line above the New Invoice button.
If an invoice title is set for the invoice, it is displayed here when the invoice is
selected so that users can see an overview of the encounter reason without
needing to open the invoice. The title may be set automatically to the

Invoice Section
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appointment visit reason, or using comments or free text.

Posting Window Options Below Grid

•

Invoice #, Acct #, Patient, FGP, Facility, DOS Provider, Post Date, DOS
Date: General information from the invoice. If the invoice was posted to the
wrong facility, it can be changed by opening the invoice in edit mode, or by
using the right-click menu. With the correct security privilege access, an Invoice
# associated with Collections status (bad debt) will appear in red.

•

Charges, Payments, Adjustments, P-Due, Balance: Financial information
from the invoice. The patient due amount is based on primary insurance
responsibility setup (copay, % payment) or if the balance was transferred
completely to the patient.

•

D: Due by. This can be I for insurance, or P for patient. When set to I, patient
balances such as co-insurance may also be due. P is generally set when the
entire balance becomes the patient’s responsibility. The responsibility can be
set when posting charges or payments, as well as by right-clicking the invoice.

•

Status: Displays the current invoice status code using a color (if assigned) for
that status. The status codes are set from within the invoice, payments, or
invoice notes. They may also be set automatically to reflect pending insurance,
filed or statement printed activity.

•

N: If there are collections notes on an invoice, a yellow page icon is displayed in
this column. Selecting the invoice and clicking the Invoice Note button opens
the notes.

•

M: A free text memo can be added to an invoice. Similar to collections notes,
but not as flexible, they might be used for other reasons than collections and
follow up activities. If there is text in the invoice memo screen, a red icon is
displayed in this column.

•

Guarantor: Shows the name of the guarantor linked to the invoice.

•

User: The user who originally added the invoice.

•

L: The lock status of an invoice. This is N or Y. Only users with the Billing
Show Locked Invoices security privilege can see locked invoices. They must
also check the Show Locked box below the invoice list.

•

Patient Payment, Insurance Payment, Edit Payment: Buttons for creating
and editing payments. They all load the same window, but depending on the
insurance or patient option will save a keystroke by presetting the payment
source.

•

Print Receipt: Use this button (not the invoice Print button) to reprint a

•

Pre Payment: Special feature for storing advance copayments and other
prepayments.

•

Reverse Payment/Adjustments: Open the Reverse Payment/Adjustments
window to reverse the selected payment or make an adjustment to the account.

receipt for the selected payment.

Invoice Section RightClick Menu Functions

The right-click menu makes it easy to do common tasks without having to open an
invoice. Note that this can also be opened by hitting the menu button on your
keyboard, saving the time it takes to get the mouse if you are a keyboard power
user.
•

Change Financial Group: A list of financial groups appears.

•

Change Responsibility: Patient or Insurance.

•

Change Facility: A list of facilities to which you have security rights appears.
All activity for the invoice will now be tracked under the new facility.

•

Change Invoice Status: A list of status codes.

•

Collections: Requires Invoice Collections Status security privilege. Set Agency
Collections Status or Release Agency Collections Status.

•

Change Statement Hold Status: Change status of selected invoices to Clear
Hold, Set Hold and/or Hold until date. Add comments as needed.

•

Lock Invoice: Requires appropriate security privilege. Used to hide invoices.
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Payments Section

•

View Invoice Notes: Another way to view notes.

•

Print HCFA: Another way to print a paper claim.

•

Print Invoice: Another way to print an invoice.

•

Date Posted: The date that the payment will reflect on financial reports, set by
the user when entering payments.

•

Payment, Pmt Type: The payment amount and type code.

•

Adj1, Adj Type 1, Adj 2, Adj Type 2: Adjustment amounts and types for the
payment. Two can be added at the same time.

•

Paid By, Check #, Classification: Insurance payments show the insurance
company name in the Paid By column, and Payment in the Classification
column. Patient payments have Patient in the Paid By column, and then
Copay, Payment or Deposit in the classification column. The Check # will also
reflect a credit card number.

•

Comment: Shows statement comments that were added as part of the
payment.

•

D: A check indicates that the payment was distributed to specific CPT line items
in the invoice. Versions prior to 6.0 permitted payments to be posted without
distribution.

•

User: The name of the person who originally posted the payment.

Billing Workflow
Each medical facility does things in a unique way, but the overall process is fairly similar. The following
might describe some or all of your daily work flow. Other e-MDs Solution Series applications are included
in this summary. Depending on the size of a facility, some of these operations may be unique positions or
shared responsibilities.
Appointments and Eligibility Staff:
○ Appointment Scheduled, instructions mailed/e-mailed to patient.
○ Verify eligibility and benefits.
○ If needed, obtain referral/authorization information.
○ Confirm appointment manually (using Appointment Reminder Results tool or Daily Work List),
or automatically.
Check-In Staff:
○ Check in patient using check in module accessed from e-MDs Schedule or Daily Work List.
Clinicians using Tracking Board are alerted to their presence.
○ If used, print superbills in batches for entire day, or print as patients check in.
○ Print patient demographics sheet, or print Chart Cover report for established patients. Update
or enter demographics.
○ Print e-MDs Chart FastForm for patients fill out while they wait, then scan completed forms.
These prepopulate the EMR with past medical history and HPI elements.
○ Take patient photograph using e-MDs DigiCam
○ Scan patient insurance card/s.
○ Post patient copay to Pre Payment if taking at check-in. Create deposit invoices if necessary.
Print receipts for patients.
○ Scan other forms such as HIPAA consents, etc. into DocMan.
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Clinicians:
○ Move patient through clinic and visit using Tracking Board, Chart & DocMan. Charges and
other orders are captured. The charges may also be captured from a rounds visits using
mobile software.
Check-Out Staff:
○ Enter charges in the posting window. This can be done manually using superbills, or
automatically using Visits button in Posting window or using the Daily Work List.
○ Transfer prepayment to invoice or enter a new patient payment and print receipt.
○ Print and give patient any other information generated by e-MDs Chart, e.g. prescriptions,
patient education, copy of visit note.
○ Print statement if patient has additional charges that they cannot pay today.
○ Daily closeout: Verify all visits billed by checking flag in visits window, or printing superbill
audit report, verify all pre payments posted to charges using prepayment report, print till
reconciliation to balance with cash register and make deposit.
Billers:
○ Batch insurance claims on a periodic basis and create electronic files or print claims. Transfer
or mail to payors.
○ Post insurance EOB checks manually or using electronic remittance module.
○ Transfer residual balances to secondary payors not automatically crossed over, or reprint
denied claims with copy of note for resubmission, or transfer balance to patients.
○ Print patient statements individually or in batches.
○ Post patient payments.
○ Keep track of claim activity using invoice notes.
○ Ensure timely filings and payments using Collections Module and other reports, as well as
mail merge notice processor.
○ Print daily reports: Till Reconciliation for bank deposit,
Managers:
○ Print daily reports such as till reconciliation, activity analysis.
○ Periodic Reporting for Practice Management: Activity Analysis to analyze business volume
and payor performance, Accounts Receivable for collections performance, Profit Center for
utilization and supplies ordering, RVU Analysis, etc.
Staff Management:
○ Create work lists in collections module, print user productivity reports, print audit trails,
organize corrective action.

Charge and Payment Entry Windows
Most of the time, posting charges is a straightforward task requiring only the entry of diagnosis and
procedure codes. Sometimes a payment is applied to those charges at the time of service. This is a
rapid process that is accomplished very quickly. Should changes need to be made to things like unit
counts or other information, this is extremely easy to do.
Note: Keyboard Data Entry: The posting system is designed to take advantage of the keyboard as much
as possible because it is so much faster than using a mouse. Keyboard operated functions are denoted
by an underlined letter on buttons and elsewhere. The number pad is also heavily supported. Each set of
instructions below includes both the keyboard shortcut and mouse clicks. You should also review the
legends for each of the posting windows to see shortcuts and data entry tips.
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The Charges and Payments window is where charges and payments can be entered provides access to
all the information needed to create a claim. Understanding all the elements of the window is important.
There are four parts to this window. Each is described in more detail on the following pages:
•

Header: This is where commonly information about the invoice is stored.

•

Charges Tab: Where charges are entered.

•

Payment Tab: Where payments are entered.

•

Insurance Information: Shows patient insurance companies linked to the invoice.

The window itself and the grids within each can be sized and positioned. This is useful if you want to see
more information such as patient due amounts by CPT, or to take advantage of posting payments with a
scan of the EOB side-by-side on a high resolution monitor. To make changes to the window size, make
sure it’s not maximized, then drag the edges. Position the window by clicking in the title bar and dragging
it to where you want. To change column widths, move the mouse pointer over the vertical bar between
column headings. When it changes to an icon with arrows on either side, drag it left or right.

Charges and Payments Window Header
The header is the section above the Charges and Payments tabs. It contains function buttons and
“default” information that typically remains static for most invoices but is occasionally changed to meet
reporting and other needs.
Charges and Payments
Window Toolbar
Save

Saves entries in the invoice. The button may not always be available even if you
have made changes. This is because some changes are done in other sections that
are saved automatically.

Cancel

Gives the user the option to stop what is being done. A verification appears.

Delete

Gives users the option to delete an invoice, but only after diagnoses, charges,
payments and invoice insurance is removed first. An audit trail keeps up with these
deletions.

HCFA

After entering all diagnoses and charges, users can preview an image of a HCFA1500 claim form. Due to screen limitations, some fields on the preview may be
truncated, so print a form to be sure if you think some fields are missing characters.
When the button is clicked a prompt will ask they user if he/she wishes to print all
charges regardless of filing status. Answering no will only print those with an unfiled
status such as NF. If the claim has more than 6 CPTs Previous and Next buttons in
the preview let you see each form.

Aging

Shows a breakdown of aged patient and insurance balances.

Gurn

Shows a breakdown of aged guarantor balances.

Chg Set

Lets you quickly load a predefined charge set of commonly used ICDs and CPTs to
save time and ensure complete charge capture. See the next topic, as well as page
262.

Claim

This accesses the insurance Claim Prepare window that comes up automatically
after saving an invoice. The Claim Prep is used to enter additional information
about the claim which may be needed for insurance processing.

Alert

Opens the patient memo. The button label is red if there is a patient alert. It should
be part of your office protocol that staff must check the button and read the note.
The note can be appended or cleared if necessary.

Form

Quick access to the Word Forms printing module. If you use this to open a form that
has invoice merge fields you will not have to select the invoice again.
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Memo

This is used for invoice-specific memos. If used, the button label turns red the next
time the invoice or a related payment screen is used. The M column in the posting
window will have a red icon. You can enter up to 5,000 characters. The Notes
option is recommended over the Memo.

Notes

Users can enter multiple time and date stamped collections tickler notes on an
invoice to log collections activity. The last note is also searchable by assigned user,
follow up date, and follow up action in the Collections module. The notes label
turns red when notes are attached to the invoice.

Check Err

Runs the same edits against the invoice as occur when building paper or electronic
batches. This is more typically used at that time so that if an invoice has multiple
edits a user can quickly remind him/herself what those are without having to return
to the claims wizards.

Edit Pat

Opens the patient demographics window.

Chart

With appropriate security, this provides access to the patients chart without leaving
the claim. This is extremely useful for billers who may need to reference the
documentation for claims (e.g. an appeal, or to print the narrative). Another
powerful function is that if a claim needs to be put on hold pending a question to the
provider, you can open the chart and then, from within that workspace, attach the
specific encounter to a TaskMan message and send it to the doctor, making it easy
for that person to take care of the issue and reply back to you.

DocMan

Open the patients DocMan folders without leaving the claim. An example of where
this is extremely powerful is if you need to reference any patient consents or other
forms that could affect payment.

Charges and Payments
Window Header Fields
Invoice #

An automatically incrementing number set by the system. Other names you might
be familiar with for an invoice number are ticket #, or claim #.

Facility

Shows the facility to which this invoice and all it’s payments are linked and which is
reflected in all reporting. For manually entered charges or those from mobile
software, the facility is set to the one logged into and displayed in the main Bill
window title bar. For charges captured automatically from Chart the facility is set to
the location specified in the note. To change the facility select from the list box
which shows those to which the user has access rights. You can also change an
invoice facility from the main posting window by right-clicking the invoice.

Default Date

This is a critical field. While it is not saved anywhere, it is a utility that sets the
default DOS and Post Dates for all charges and payments entered. While users can
manually change these at the invoice or payment or even CPT level, this utility will
save a great deal of time. It is workstation specific too and is thus a way for a user
to batch charges and payments that are being posted. One user can be posting
activity to one date, and others to different dates. The Post Date will thus keep
reports accurate and ensure payments match deposit dates and so on. Worth
noting that if charges are built automatically from Chart or Companion, the service
dates are set based on when those were created, not the default date. If you
change the Default Date, each subsequent invoice and payment entered will use
this until the date is reset manually or by exiting from Bill and then logging in again.
See also page 320.
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Case

Shows if there is a case linked to the invoice. If “Default” is displayed, there is no
case and the system will use the default guarantor and insurance information in the
patient file. If a case is being used, it’s name is displayed. When a patient has
active cases the field is set automatically to the last case used. Changing the case
may result in prompts to change guarantor, insurance, and other invoice information
to comply with the cross-billing requirements of the case. You can add a new case
from this field too by clicking the button to the right of the field. See the case
management section of this user guide for more information.

Title

The invoice title is an optional field that can be used to display a summary of what
it’s about. The title is displayed in the main posting window above the invoice list so
that a user can click it and, without having to open the invoice, get an idea of it’s
contents. If Schedule has an appointment for the patient and an invoice is built from
the Chart note for the appointment, or using the Daily Work List, the invoice title is
automatically set to match the appointment visit reason. You can also enter a free
text description, or use the search button to the right of the field to look up and
select a standardized entry from the Comments table.

FGP

The current invoice financial group. The field is set automatically to match the
financial group in the patient file unless there is a case linked to the invoice which
has set it differently. The financial group can often change during the billing cycle.
You can select a different group using this list box, or by right-clicking the invoice in
the main posting window.

Status

The current collections/information status code linked to the invoice. The code may
be set manually by selecting one from the list box or by right-clicking in the main
posting window. If your administrator has set this up, it may also change
automatically to reflect pending insurance, filed and statement printed codes.

Posting Batch #

Shows the user’s current posting batch number which is a tool that can be used to
aggregate activity in reports or by using the filter provided in the main posting
window. Note that although this field is in the header section, there may be different
batch numbers for the charges and different payments posted to the invoice so the
field will update accordingly. The default number is the last one used, but you can
select a different one from the list, add a new one by clicking the + button to the right
of the field, or by adding a new one. You will be prompted to confirm the change.
Note again that the numbers are user specific.

Print HCFA on Save &
Include Text?

Gives users the option to print a HCFA when saving charges or payments. The
default is based on the Print HCFA with New Invoice setting in File > Options. When
checked, the system prints a paper claim immediately after saving the invoice. To
print the form outline too (in black and white), check the Include Text option as well.
When the invoice save button is clicked, a prompt appears that lets you select the
insurance company to print for.

Print Statement

Gives users the option to preview and print a statement when saving charges or
payments. This includes all open charges for the patient and uses the current
statement printing preferences that are under Reports > Statement.

Print Invoice/Receipt for
New Invoice

If this is checked then a print options pop-up appears after saving new invoices so
you can print either of these reports. It is exactly the same as the window that
appears if you click the Print button above the list of invoices in the main ledger.
This option remembers the last setting by user. In most cases it is left unchecked
because most users are not printing an invoice for every charge entryso you want
the extra click to cancel the window.
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Print Patient Education

This option is really for users who have Chart because most times the physician will
choose what to print when closing the note. If it is checked, when you save the
invoice a window appears with a list of the patient education documents linked (via
Code Linker) to the ICDs and CPTs entered. You can check off the ones to print
and can also change the language (if there is a translation which matches the home
language in the patient’s demographics, this is automatically selected). You can
also view and make on-the-fly customizations to a document prior to printing by
double-clicking it. Customizations are not saved when done from this window. Use
the right-click options to set fonts, bold, colors, etc. If the linked list does not contain
a document you want, click Search to open the full patient education search.
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Charges Tab
As you would expect, the charges tab is where diagnoses and charges are entered for an encounter.
There are also some default fields.
Note: Use the legend button for help on how to enter charges and for column heading information. This
is the button with the blue question mark to the right of the Diagnosis entry field.
Charges Tab Default
Fields
DOS Provider

Defaulted to the provider in the patient file for manual billing, or the provider in the
Chart note. If a different doctor sees the patient, use the drop down list to select an
active provider.

Supervisor

Shows the default billing supervisor for the DOS provider which is set up in the
provider demographics file. This can be changed if necessary and can also be
defaulted by insurance company. Note that the rendering provider on the claim
prepare is set based upon the provider/supervisor/primary insurance settings.

Referral

Displays the referral that set the referral field in the claim prep which is what is used
for the claim. If there is a case with a referral this is used first. If not, then the
system uses the default referral from the patient’s demographics and if that is blank
but the File > Options setting to “Use Provider as Referral if None Set” is checked,
then it sets this field to the patient’s primary provider. When the invoice is saved,
the referral is used to fill the referral physician and authorization number fields in the
Claim Prepare window. To use a different one, click the search button to the right of
the field to load a list of referrals for the patient. That window also lets you add a
new referral/authorization. To clear the field, click the X. Keep in mind that if you do
have the previously mentioned option set, then the next time you open the invoice
the field will be repopulated.

Guarantor

Defaults to show the patient’s default guarantor unless there is a case with a
different guarantor which overrides the default. For cross-billing purposes you can
change the guarantor by selecting a case, or by clicking the search button next to
the field and selecting another.

Balance Due By

Shows the current responsible party. When set to Patient, the entire balance is due
from the patient. When set to insurance, there may still be a patient portion if there
is an outstanding copay or co-insurance.

DOS

The service date default. This is set automatically if charges are built from a Chart
note, otherwise it is set to the Default Date but can also be changed manually.
Manually entered CPTs use this as the start and end service dates (although you
can change them for each line item). This field is also a way to update all the start
and end service dates for CPTs if they are incorrect. Change the date in this field,
then hit tab. A prompt asks you if you wish to set the dates for each CPT to match
this new date.

Post Date

This is the main accounting date on which the invoice activity appears by default in
financial reports.

Symptom Date and
Indicator

Set automatically to the Date of Onset in the properties of the primary ICD for
charges built from a Chart note or if there is an ICD that falls within 630 - 677, V22 V24.2, V27 - V27.9, V28 - V28.9, V61.5 - V61.7 and V72.4. If there is a case on the
invoice, the date is set to the Injury/Illness Date in the case. In both default cases
st
the indicate is set to date of 1 symptoms. You can also enter a date and indicator
manually. Be sure to select an indicator code of 2 (LMP) for OB care.

Superbill

Defaults to the last superbill printed for the patient. You can also select from one of
the last 5 printed for the patient as well, or can enter a number. This must be a valid
(printed) number which was printed for this specific patient. The superbill audit
report reconciles superbills printed with charges entered. If a superbill was printed
for the patient on the same date, it is prefilled automatically.
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Collections Section
Options
Collections

Use this button to open the Invoice Collections History screen.

Transfer to Collections
Date/Collections Agency

The date and agency is populated if the invoice is currently in collections. Date is
based on the most recent date the invoice was put in collections.

Diagnosis Section
Options
This is where diagnoses are entered and displayed. When a new invoice is started, this field is where the cursor is
located so you can enter diagnoses and then tab to the Charges field for CPTs & HCPCS. If you arebuilding an
invoice from Chart or Companion, you can still append diagnoses.
Diagnosis

Where ICDs are entered. Type in a code and press Enter. If the code exists, it is
added to the list. If there is a more specific ICD, you will be prompted that this is not
billable and have the option to accept or cancel.

New Inv ICD

If you know a code, click this button (Alt+V) to load the ICD Search in which you
can find your code by description, code or by browsing the ICD tree.

Delete ICD

Click an ICD already in the grid and click this button to remove it. If it’s linked to a
CPT, you must delete the code from the ICD1-4 column(s) in the CPT grid first.

Set Prim. ICD

By default the first ICD is set as the primary. It is displayed in bold and will be
printed in the appropriate sections of claim forms. To change the primary to another
code, select it in the grid and click this button.

Blue Arrows

Used to change the ICD order.

ICD Grid

The grid has a line for each ICD entered in the invoice. It’s self-explanatory. BS
stands for billable status which should be white. Click New Inv ICD and then look at
the details or legend in the ICD search to see the color codes. The # is the
sequence which is useful to know when entering CPTs with their related ICDs since
you can enter the CPT followed by these numbers to rapidly set the linkages using
the keyboard.

Charges Grid Options
This is where charges are entered. There are multiple ways to capture charges rapidly with hints provided in the
legend above the diagnoses grid. You can set the column widths in the CPT grid to match your preference by
dragging the sides of each column heading left or right and then clicking the X at the top right of the Charges &
Payments window to store the preference.
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CPT/HCPCS

Where CPTs are entered or searched for. Type known CPT or HCPCS codes and
hit enter to load them. There are also some special keyboard shortcut codes to
encourage more rapid data entry and the use of the number pad. While you have
to enter each code should one of the properties not apply, the order of entry is
important. See the legend for examples of using multiple characters on one code.
•

* (asterisk): Lets you use a custom/started iteration of a code that you
havecreated, e.g. 99213*1.

•

- (hyphen): Precede each modifier for the CPT with a hyphen (e.g. -99-50-80).

•

. (period): Precedes the ICD linkages. The numbers entered after the period
are the ICD sequence #s in the ICD grid. For example, 99213.13 links the CPT
to ICDs 1 and 3.

•

+ (plus sign): Changes the unit count from a default of 1. For example A4556.6.

•

/ (forward slash): The fastest way to enter a known panel/burst/explosion code
set. Follow the / with the panel code (e.g. /C7) then press enter for all the
codes linked to the panel to drop into the invoice.

CPT

To do a CPT search, press the Tab key to highlight this button and then hit Enter (or
click the button).

HCPCS

To do a HCPCS search, press the Tab key to highlight this button and then hit Enter
(or click the button).

HCPCS Panel

If a CPT is entered which is linked to HCPCS codes in Code Linker, the button label
turns green. Click it to load a list of the linked codes, then check off and select the
ones you want in the invoice.

PANEL

Although not as quick as using the forward slash in the CPT/HCPCS field (see
above), this is where you can enter a known panel code, or click the search button
to the right of the field to search for a burst/explosion charge set. Similar to the Chg
Set button in the toolbar.
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Edit CPT

The Edit CPT button opens the Invoice (CPT) Edit window where you can edit codes
by selecting them and then setting properties. There are options to select shortlists
of modifiers for the code, set ICD linkages, POS & TOS, service dates, units, fees,
anesthesia and other information in this window. However, it’s typically not as fast
as making most of these edits by typing directly into the cells of the CPT/HCPCS
grid. This is also where you can enter a narrative if necessary.
CPT tab
Add CPT: This and the Find button will open the CPT Search screen.
Revenue Code: Click the Find button to open the Revenue Code search screen.
Modifiers: Up to 4 modifiers can be linked to each CPT. To add a modifier, click on
the Find button. The modifiers listed in this window are linked through the CPT or
HCPCS Search windows.
ICD: These fields are used to change the linkage of the ICD-9 codes.
Fee: Edit fee related data including Place of Service (POS) and Type of Service
(TOS), Start/End Dates, Units and Unit Fees.
•

Cost: Only required if the service is a diagnostic test purchased from another
source. If you are entering costs for your CPTs, make sure the cost is what your
office is billed for the service, since this is used in electronic claims.

•

Purchased Services: If the service is a diagnostic test purchased from another
medical facility, (they are doing the test and billing your office for it, but you are
billing insurance), you must indicate this on the claim. Check this box, then
enter the charge your clinic will pay the other facility in the Cost field. In such
cases, you are also required to enter the name of the provider who performed
the test in the Purchasing Provider field of the Claim Prepare form.

•

Narrative: A short narrative can be added to a claim. Depending on the payor
and clearinghouse to which you send electronic claims, a short narrative can be
transmitted electronically. These narratives are typically cryptic, payor-specific
codes indicating a special circumstance with a patient. The NSF claims format
only permits one narrative per claim (not per CPT) of up to 280 characters.
Enter this for the first CPT.

Details tab
The NTE, MEA and PWK segments will activate when you click the check-box under
the segment name.
CPT Segment: Use to set multiple NDC codes (National Drug Code) per HCPCS.
Select the NDC Code and Unit of Measure from the drop-down menu’s and type a
Quantity in the field provided.
NTE Segment: Use to show additional information relating to a specific line item.
Select a Reference Code from the drop-down menu and add your comment in the
Required Information field.
MEA Segment: Use to add information to the ANSI file in loop 2400. Select a
Reference Code and Measurement Qualifier from the drop-down menu and type the
Measurement Value.
PWK Segment: Use to notify a payer or clearinghouse that supporting
documentation and it’s trasmission method will be sent. Select a Report Type and a
Transmission Type from the drop-down menu’s, then type a Control Number in the
provided field.

Delete CPT

Removes the selected CPT/HCPCS code from the invoice.
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Set Prim CPT

The primary CPT is the one against which the system automatically applies a fixed
copayment. When an invoice is saved, the first E&M code (99201-99499) is set as
the primary. In the event that there is no E&M, the first code on the invoice is set.
To change the setting manually, select the code in the grid and click this button.

CPT Grid

This is where the CPT codes appear. Most of the cells in the grid accept data entry
and this is the fastest way to make edits to codes. You can move around the grid
with the arrow keys, but be sure to hit the Enter key to validate and save any
changes made. There are additional functions using the right-click CPT/HCPCS
Functions described later. You can size the column widths by dragging the borders
for each and then clicking the X at the top right of the invoice to save the preference.
•

Description: Change the default description here if necessary. This is useful
for adding descriptors to generic “catch all” unlisted procedure or HCPCS
codes.

•

M1-M4: If modifiers where not entered in the CPT/HCPCS fields using the
hyphen shortcut code, you can type them into the grid. You cannot enter invalid
modifiers. The first modifier can be defaulted based on fee schedule rules. An
example of this is –QW for CLIA-waived tests.

•

SDOS & EDOS: Service dates.

•

POS & TOS: Defaulted to the master settings for the code. Change by entering
a known code. You cannot enter invalid ones. See CPT/HCPCS Functions
below too.

•

Fee: Defaulted to either the Billed Fee Schedule for the primary insurance, or
the facility default fee schedule (which is usually the same one).

•

Unit: Unless the unit count was set in Chart or by using the keyboard shortcut
when entering the code manually, change the count here. The unit count is
typically set to 1 unless a different default is set up in fee schedules or it is
calculated for anesthesia codes based on the minutes and ABUs. Anesthesia
unit billing is described separately in this guide.

•

ICD1-ICD4: Displays the ICD linkages. These can be set automatically if the
Link ICDs option is set in the CPT or HCPCS search for the code. For
automatic charge entry from Chart or Companion, the primary linkage is set
based on how they are in the note or visit. The linkage may also be set using
the keyboard shortcut for manual entry, but if none is specified the system sets
ICD1 to the diagnosis highlighted at the time the CPT is entered. To set the
linkage by typing in the grid, enter one of the codes in the ICD grid. See
CPT/HCPCS Functions below for advanced ICD linking.

•

All-Fee: Defaulted to the Allowed Fee Schedule for the primary insurance if
there is one, otherwise the facility default.

•

P-Due: Shows the patient responsibility for the code. This is calculated based
on the primary insurance:patient percentage responsibility and fixed copay (for
the primary CPT).

•

IsProcessed: Shows whether any fee schedule rules or alerts have been
processed. Once rules are processed, this value is set to N so redundant alerts
keep annoying users when the invoice is opened in edit mode. Refer to the
section on fee schedules and rules for how to set these up.

•

AllowOverwrite: With appropriate privileges users can allow alerts to be
overridden by changing this property. When the column is set to Y, any rules
that are normally valid for this code are not triggered. An example of use is
when you may not want to fill out a form for a CPT that would otherwise require
it.

•

FS: The file status for each line item in the claim. Typically this matches the
primary insurance file status, but fee schedule rules to include codes in claims
or automatically drop them to paper, as well as EOB posting and line item
reflagging can make these different. It affects whether a code is included in a
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claim based on parameters and options set when generating the claim.
•

In Claim: Indicates whether the line item will be included in printed or electronic
claims or not. The default for this property comes from the allowed fee
schedule link.

•

RVU: The total RVU for the code. If the Sort by RVU option at the bottom right
of the window was checked when the invoice was started all the CPTs are
automatically ordered by RVU weight.

•

InvCPT_ID: This is the database record identifier which is displayed for those
users who are writing their own reports and queries. and want to verify the
results.

CCI Check

If checked a CCI code edit is done when the invoice is saved. The setting is
remembered by user.

CPT/HCPCS Functions

Opens a menu with options to rapidly set and change ICD linkages for CPTs and
also change the POS and TOS codes. This menu can be invoked using the
keyboard menu button if the cursor is in a grid cell.
•

Link ICD to CPT: Fills the next blank ICD link spot with the currently highlighted
ICD.

•

Link ICD in Order: Sets ICD linkages for the CPT to match the order in the
diagnosis grid. It overwrites any existing linkage.

•

Fill Remaining ICD Links: Fills blank ICD linkage spots with any unlinked ICDs
based on their order in the diagnosis grid.

•

Unlink ICD from CPT: Removes the right-most ICD link.

•

Reverse ICD Linkage: Flips the order of linkages. This and the shift functions
are often used for rebilling secondary payors.

•

Shift ICD Linkage Left: Moves each ICD one place to the left, and moves the
first ICD to the right.

•

Shift ICD Linkage Right: Moves each ICD one place to the right and moves
the last ICD to ICD1.

•

Unlink All ICDs: Clears all linkage boxes.

•

Change TOS: Pops up a prompt into which a valid TOS code can be entered.

•

Change POS: Pops up a prompt into which a valid POS code can be entered.

•

Delete CPT/HCPCS: Removes the code.

•

Split: This function is used to split one or more codes into a separate invoice.
Select the code then click Split. The new invoice is generated with this code.
Everything else (defaults, patient, diagnoses, etc.) are the same so you may
need to change some of it.

Process Alerts/ABN

Opens the alerts window manually. This is the same window that appears
automatically when an invoice is saved where codes that have rules which have not
been processed (IsProcessed column setting is N). The Alerts window is where you
can view outstanding issues as well as invoke additional functionality to correct
some of them such as printing ABN forms or adding required modifiers.

Total Charges, Total
Payments &
Adjustments, Balance

Self-explanatory.

Sort by RVU

Check this option to automatically sort charges by RVU weight, a strategy that can
improve reimbursement.
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Insurance Information
The insurance information section of the Charges & Payments tab is always available regardless of
whether you are in the Charges or Payments tabs. Unless there is a case, when a new invoice is started
for a patient the insurance that is active at the time is loaded into this section. Regardless of what
happens to the insurance in the patient file or case, the invoice information remains static unless you
choose to modify or remove it from the invoice. This ensures that historical integrity is maintained, i.e. the
insurance at the time of the services remains as it was and does not necessarily reflect subsequent
changes to the patient defaults which cannot apply to the past visits.
The following table displays the company/ies in the order that they will be filed. Most of the information is
self-explanatory.
Insurance Information
Grid Options
FS

The file status is set for the primary insurance based on the default in that insurance
company file. When it is filed, the status will change. Later in the billing cycle users
can choose to flag the secondary insurances which will then have codes in this
column.

Copay & % Pat

Set based on insurance group unless it is overridden. This can occur if a case is
linked to the invoice, or if all the CPTs on the invoice have the co-insurance property
in fee schedules set to N.

Seq

The filing order. The default is based on the order the insurances are loaded from
the patient file or a case. The order can be changed using the blue up and down
arrow keys below the grid.

+ Pat Ins

Refreshes the insurance and adds any new insurances added to the patient file
since the invoice was originally created. Additional insurances are appended to the
existing list.

+ Gurn Ins

Refreshes the insurance and adds companies linked to the guarantor if this is a
different entity than the patient. Additional insurances are appended to the existing
list.

- All Ins

Removes all insurances on the invoice so long as there are no insurance payments
linked. To delete an individual insurance from an invoice, click Edit and then use the
delete button in that window.

Edit

Opens the highlighted insurance in edit mode. This is done if you need to reset the
filing status, change copay responsibility manually, or change the insurance type. If
you change the type a prompt will ask if you wish to update the status codes for
each CPT to match this type.

File History

Opens a complete filing history for this claim.

Arrow Buttons

Changes the filing order.

Resequence

If the Seq is not in sequence this will reset the number. A sequence may change if
insurance is removed.

Statement(s) printed…

Number of times this invoice has been billed to a guarantor since the last patient
payment. Can be manually changed.

Payments Tab
The payments tab of the Charges & Payments window is where payment information is entered. Every
payment has a source. That source is then distributed to the line items on the invoice. Payments cannot
be posted without distribution. This section describes each of the fields in the Payments tab. Later
sections in the user guide explain how to actually enter sources & payments, link EOB scans, etc.
The area at the top left of the Payments tab with a dark gray background is where payment source
information is set up.
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Sources Section
Options
Source Type

Radio buttons indicating what entity is making a payment. When a payment is
started from the posting window the type is set automatically depending on whether
the Patient Payment or Insurance Payment button was clicked. As described in the
section on prepayments, when a source is a prepayment, the system changes it to
Patient upon saving.

Payment Classification

For patient or prepayment sources, a classification can be set. This is really only for
information purposes.

Insurance Name

This list box shows the insurances on an invoice when posting an insurance
payment. When the payment is saved, the financial reports will track this activity to
that insurance. It is set automatically when a payment is started to the last
insurance company with a filed File Status. If none have been filed, the primary is
displayed. The company can be changed using this list box.

Check No/Credit Card No

Self-explanatory.

Check Date

The actual date that the check was cut by the source. While this is not tracked for
activity reports, it can be useful for research purposes since the source entity will
have this date, not the date when you actually posted and deposited the payment.
The Payment Source search window which is accessed by clicking the Get button in
this window or from the main window’s Posting menu has a check date search filter.

Source Amount

The total amount of the source, not just the amount being applied to this invoice.

Source Balance

The current balance on the source. Calculated by the system based on prior
payments distributed against the source.

Payment, Adjustment 1 &
2

System calculated fields showing the sum of the payments & adjustments against
line items in the distribution grid.

Type

The payment & adjustments types such as check, cash, provider discount, etc.
These fields can be set automatically if the source type is an insurance company
linked to a contract with default preference settings.

Get

Depending on whether the source type is patient, insurance or prepayment, the
button opens the Payment Sources windows applicable to each of those types so
that you can search for and select an existing source. Each of the source windows
is different. For example, the prepayment source loads the prepayments window for
the patient. If the Get button label is red, it indicates that there is a source for this
patient that has a non-zero balance. It’s not necessary to use this function every
time you start a new payment for the same source since these are typically posted
one after another. For example, when posting an insurance EOB the source is only
added once, then as each invoice claim is loaded you will use the Last button since
that is the last one you worked on.

New

Clears the fields so you can add another source. Do not forget to save the previous
source first.

Save Source

Saves the source you areadding. You must click this button prior to distributing.

Clear

Clears the fields.

Last

Use this button to quickly load the last source used. It is computer specific so that
users in a network can rapidly post checks that are being applied to multiple
invoices without having to click the Get button and search for the source. The Alt+t
keystroke shortcut is one of the most important any poster who wishes to be
productive should learn when posting.

Delete

Deletes the loaded source. You cannot delete a source that has already been
linked to one or more payments.

Scan EOB

Used to scan and view the EOB for the payment.

Scan Check

Used to scan and view the check for the payment.
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Distribution Grid Function
Buttons and Fields

This is the section where one enters the payment detail. It can be done using the
function buttons and fields above the grid as well as by typing directly into the cells.

Dist

This button is used to start entering payments and adjustments manually in the grid,
mostly for insurance payments. It is typically clicked (Alt+i) immediately after the
source is saved. It immediately places the cursor in the Payment cell for the first
CPT. When you click this button you may also see additional CPTs appear in the
distribution grid. These are ones with 0.00 balances which are not shown when a
payment is first started.

FIFO (F2)

The First In First Out button automatically posts the source balance to CPTs with an
applicable insurance or patient balance until the source amount is zero or there are
no more CPTs with balances. This is by far the recommended method for posting
patient payments since it’s much quicker than manually entering amounts and
reduces error rates. If you areusing the patient payment feature that lets you post to
more than one invoice in the same screen, FIFO will satisfy CPTs on the oldest
invoices first. The system always posts to CPTs within an invoice from the first one
to the last. The F2 function button can be used for this.

LIFO (F3)

The Last In First Out button is also an automatic posting option that sets payments
for individual CPTs. It differs from FIFO by posting to the most recent invoice first
when posting to multiple invoices at the same time. This is not recommended in
most cases since it creates the potential to leave older and older balances which get
harder to collect on. The F3 function button can be used for this.

Prorate (F4)

The Prorate function automatically posts a payment source to individual CPTs using
a prorate method. This only applies if the source amount is less than the total
balances (insurance or patient source to balance matching still applies here). It is a
useful way to distribute patient payments and ensure that CPTs which are typically
last on an invoice show up as being ones that are not collected on as well as the
first ones since most users post top down. An example is the best way to illustrate
how prorating works. Assume that you have a patient payment source balance of
$50 which needs to be posted against two CPTs which have patient due balances of
$60 and $40 respectively for a total of $100. The $50 source balance is 50% of the
total patient due balance. The prorate function multiplies each balance by 50% and
posts $30 and $20 to each of the CPTs. The F4 function button can be used for
this.

Delete

This deletes whichever CPT is selected at the time the button is clicked if you
answer a confirmation prompt in the affirmative. An audit trail tracks the deletion.

Date Posted

The date on which this payment will be reflected in activity reports. For batching
purposes, it is defaulted to the default date at the top of the window when the new
payment is started. You can change it if necessary.

Show All Open Items

Only applicable to patient payments, this lets you view all open items for multiple
invoices at the same time.

Pmt Bal

Used when posting manually, this automatically enters the patient or insurance due
balance (depending on source type) for the CPT you areworking on.

Adj1 Diff (Alt+j)

Also used when posting manually, this sets the Adj1 cell to the patient or insurance
due balance for the CPT you areworking on.

Adj All (F5)

Used to adjust off the insurance or patient balance of all CPTs depending on the
payment type you areentering. The F5 function button can be used for this.

RC Desc

Shows the description for the first adjustment reason code entered in the distribution
grid for a CPT.

Run Rule

Used to manually run rules based on the information enetered in the Payment
Distribution Grid cells, but will override any information entered in the screen. All
rules apply to manually posted payments except for the “Auto Post” rule. This rule is
ignored for any payments posted manually.
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Statement Comment

The statement comment is a very important field. You can enter any explanatory
information that you want to appear on a patient statement in this. It can thus be
used to communicate why patients owe specific amounts. A good example is
“Balance is applied to annual deductible”. For commonly used comments like this
you can click the Find button and load them from the comments table. We strongly
recommend that use of this table since standards comments are consistent, easy to
understand, and have spelling errors. They can thus encourage more rapid
payment and less time consuming calls from patients when they receive their
statements. If necessary, you can create multiple 0.00 payments with the sole
purpose of adding comments to statements.

Legend

All users should review the legend since it explains a lot about payments, payment
scanned images and how to enter data fast.

Payment Distribution
Grid Cells
When starting a new payment, the system automatically loads CPTs & HCPCS with a balance due. If there are
additional codes with 0.00 balances, they appear once you start to post out to the line items. Most of the cells are
not editable. Be sure to review the section on how to post into this grid to take advantage of a design that tries to
optimize use of the keyboard, particularly the number pad since this is by far a much more efficient way to post than
relying on the mouse.
Inv#

Shows the invoice number for the CPT. Useful when posting to multiple invoices at
the same time.

Code and M1-M4

The CPT or HCPCS code and modifiers. Use this to match to an EOB to ensure
you are distributing correctly.

DOS

Date of Service.

Charges

Original billed amount for the CPT.

All-Total

Allowed or contract amount for the CPT.

P-Due

The current patient due amount on the CPT which is the sum of the copay (for a
primary CPT) plus the patient % based on the allowed amount. If the invoice is set
to patient due or is PVP financial group, this also sets the P-Due amount.

I-Due

The insurance due portion on the CPT.

Payment

When you enter the payment amount for the CPT. It can also be set automatically
using the FIFO, LIFO or Prorate functions.

Adj1

Where you enter the primary adjustment. It can be set automatically if this is an
insurance payment and the insurance is linked to a contract with auto adjustment
options set up.

RC

Where you can type a standard HIPAA/ANSI adjustment reason code based on the
EOB (e.g. 01, 15, A2, 42). This can also be set automatically for insurance
contractual adjustments. To view the description for the reason code, click the RC
Desc button above the grid.

GC

The adjustment group code. If you arefiling secondary claims electronically you
must enter the code from the EOB (e.g. OA, PR).

Adj2

A secondary adjustment field. The purpose of this is to give users the ability to enter
multiple adjustments on one line without having to start another payment. Note that
you cannot enter a reason code. The most typical use for this is withholds and
similar adjustments.

D

The due by flag can be I (insurance) or P (patient). Changing this for one CPT
changes it for all of them and is the same as using the Balance Due by field in the
Charges tab or by right-clicking the invoice in the main posting window.
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Comment

A line item comment used for internal purposes. You can use this to indicate why
you might be refiling a specific line.

FS

The current file status of the specific CPT. You can set different file status
for a specific CPT such as if you wish to refile some of the codes in an
invoice, but not all of them. When doing this, be sure to check and possibly
change the file status for the insurance to which you want to file the code so
it fits into the standard selection criteria in the EF or NF wizards. While you
can certainly filter for “unfiled items in filed invoices,” most users default to
batching by unfiled invoices with CPTs flagged for filing. Deviating from that
norm can result in some claims not being refiled as quickly as you would
like.

Status

A listbox with some internal options for you to indicate if the payment is a
downgrade (DG), was omitted/never included on the EOB (OM), was rejected (RJ),
a short payment (SP), or an overpayment (LP).

OthRC, OthGC, OthAdj

Other Reason Code, Other Group Code and Other Adjustment. These fields are
used to post adjustments which must be reported on secondary claims, but cannot
count against the balance of the invoice. A classic example is if the claim will be
filed to MSP (Medicare Secondary Payor). Medicare requires the claim include the
patient due responsibilities based on the primary insurance. Clinics cannot want to
post these as normal adjustments because they are not – they are to be collected
from the patient. Thus, anything in these fields is information only for
secondary/tertiary payors.

DistID, InvoiceCPT_ID and
Payment_ID

Database record identifiers. These columns are typically set to their narrowest width
to hide the data, but advanced users who query the database for various reasons
may want to use these to verify their data.

Payment History Grid
Cells
This is the section below the distribution grid which shows a history of payments against CPTs in the invoice.
Statement(s) printed for
this invoice since last
payment

This field shows the number of times this invoice has been included on a statement
since the last patient payment made against it. The field is updated automatically
when printing statements in batch or singleton modes, but can also be updated if
necessary if you print one in error.

Show all CPT/HCPCS

Gives you the choice to show all CPTs on the invoice, or just the one to which you
arecurrently posting. In the minimum screen resolution of 1024x768, only 5 lines
can be shown at once so showing multiple items with multiple prior payments can
lead to the need to scroll up and down as opposed to having the system just show
the item with which you are currently concerned.

Charges, Pmts & Adjs, Bal

Financial summary for the invoice. You can refresh the totals by clicking the button
with the red circular arrow.

Fee Schedule Alert

This button is available for insurance payments. The label turns red if you
areposting a primary insurance payment and the amount does not match the
allowed amount so that users are notified if the payment is not matching the
contract. Copay and coinsurance amounts are also factored in. Click the button to
view the expected fee and differential. Users with appropriate fee schedules
security rights can update the master allowed fee schedule for this insurance from
this window. It’s a quick way to build fee schedules on the fly. If the user selects
the Fee Schedule Alert button when posting a payment distribution, you will also
have the option to update the allowed fees on the specific invoice you are working
on. Note that an option setting in a contract linked to the primary insurance can be
used to automatically generate a fee schedule based on payments. See fee
schedules for more.
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History Grid

The grid shows the invoice #, code, prior payment description (insurance company
name or “Patient”), charges, payment, adjustment1 & adjustment 2 and current
balance. For each source type such as the patient, the amounts are totals of all
payments and adjustments from that source. Lines with a white background are
CPT totals by source. Lines with a yellow background are totals for all sources
against the CPT including the current CPT balance. When the Show all
CPT/HCPCS option is checked, a grand totals line with a black background
appears.

Check and EOB Scans
You can store images of EOBs and checks for a payment that are directly linked to the payment source.
This is an important point: because the scans are linked to the source (check, cash, etc.) for the payment
entry, if that source is distributed to multiple invoice balances, the scans are automatically available from
any of those payments without you having to rescan the same document for every payment.
Source and check scans have several benefits:
•

The images are immediately available for research. This is significantly quicker than having to
get up, walk to the place where you store the originals, find the document you want, and then
repeat the process to put it back again.

•

You can print the scans if they need to be submitted with secondary claims or for other purposes.

•

Posters can view the image and post payments at the same time, potentially eliminating the need
to work through paper stacks.

•

Reduced paper storage requirements.

The check and EOB scanning system requires DocMan to be licensed and installed. The images are
stored in the same DocMan folders that are used for clinical information, standard forms, and Word forms.

To scan or import an EOB or check:
1. Save a payment source. This can be done in the Payments tab of the Charges & Payments
window, or by going to Posting > Payment Source. Once the source is saved, the buttons for
EOB and check scanning are available. For patient payments, only the check option is used.
2. Click the applicable button to scan the EOB or the check. The DocMan Image Viewer opens.
3. Scan or import the document. See the "Scan and Import Options" table for more information.
Review the scan (see options below) and then click the Save button to store it. The Scan EOB or Scan
Check button label in the payments tab changes to green. In the Posting > Payment Source window
where there are separate scan and view buttons. The view labels also turn green.
Scan and Import
Options
Scan Document

The quickest way, this uses the default scanner settings to create a multi-page .tif
file.

Scan Custom

Loads the driver software for the default scanner so you can use that software
interface for size, resolution and other settings.

Scan Color

Creates a color scan. This is not typically recommended since color documents are
typically much larger files that take up more disk space and also take longer to load.
EOBs and checks can typically be scanned very well in black and white.

Select TWAIN Source

Loads a list of installed TWAIN compliant drivers/devices installed on your system
so you can select a different image capture device.
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Import Document

Loads a file browser so you can select and import any Windows-based file. While
any file type is supported, the DocMan viewer typically expects tif and jpg files. If a
non-native image type is imported, DocMan may use external applications to open
the file. For example, if you import a Word document, it will open Microsoft Word
when you want to view the file.

To replace a scan:
If you have saved a scan and then realize it is not the correct one, or you want to make adjustments
to the resolution, you can replace the scan. Note that if you have not saved the scan, you can rescan
without going through these steps.
1. Click the Scan EOB or Scan Check buttons in the Payments tab.
2. At the prompt that tells you there is already a scan for this payment; click No to replace the
image.
3. Scan and save as usual.

To view a scan:
Scans can be viewed at any time. Click the Scan EOB or Scan Check button in the Payments tab, or
click the applicable Check or EOB view button in Posting > Payment Sources. You can navigate a
multi-page .tif scan using the thumbnails and paging buttons.

Posting Payments Using a Scanned EOB Instead of Paper
You can also view scans at the same time as posting payments. In such a case, this can replace the
need to have the paper copy at hand. This is only practical with dual monitors or a larger monitor capable
of displaying the scan and the payments window side by side. The larger footprint required for these on
your desktop replaces the clipboard that many billers use to hold up an EOB while they post it.
The first thing is set your personal window positioning and sizing preferences.

To set personal window position and size preferences:
1. Click the Scan EOB button in the Payments tab. If there is already a scan loaded, click Yes at
the prompt to leave it unchanged. If there is no scan, scan the document.
2. Make sure the image viewer window is not maximized.
3. Drag the window to a position that lets you see all the fields using in posting payments by clicking
in the title bar at the top, holding down the left mouse button, and moving to where you want it.
4. Size the window if necessary by moving the mouse pointer over the edges of the image view
window until it turns into a double-sided arrow, then hold down the left mouse button and drag.
5. Hit the X to close the window and save the window settings.
When posting payments the image can be loaded automatically. Because the window is positioned
where you can see it at the same time as the Payments tab fields, it is very much like posting from a
paper EOB. These steps follow the basic posting process, illustrating how the scan is originally set up,
and then how it is viewed for subsequent payments.

To set up and view subsequent payments:
1. Select the first invoice against which the payment is going to be made and click Insurance
Payment.
2. Enter the source information as usual and click Save Source.
3. Scan and save the EOB.
4. Click back in the Payment tab and distribute the first payment then save it.
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5. Search for and select the second invoice (it can be for any patient). You will notice that the EOB
scan close when the first payment was saved and closed so you can use it as a reference.
6. Click Insurance Payment to start this payment.
7. Click Last to load the same source and continue posting. Again, you will notice that the scan
stayed in view. It only closes when you close it manually or if you close the main posting window.
Scan Image Viewing,
Printing and Faxing
Options
Print

Prints the selected page.

Print All

Prints all pages.

Fax

Use this to fax the document. The system will request a printing explanation for the
audit trail first (the list is set up in the DocMan administration section). Once this is
given, a window loads in which you can enter the fax number, title, etc.

Thumbnails

For multipage scans, you can view a thumbnail of each page down the left side by
clicking the Show Thumbnail button. Up to 4 pages can be displayed in this bar.
Clicking on a thumbnail loads the page in the main viewer. You can also move
between pages using the Prior Page and Next Page buttons, and can show the next
4 thumbnails using the Prior Thumbnail and Next Thumbnail buttons at bottom left.

Zoom

The buttons with + and – magnifying glass icons allow you to zoom in or out on
sections of the page. There is also a box that you can drag over an area to zoom in.
If thumbnails are hidden, you can also drag the image around the viewable area to
see any parts that might be hidden.

Full Screen View

Double-click a thumbnail to show the page in full screen. Click it or press any key to
go back to the other viewer.

Rotate

Rotate an image using the button with the red circular arrow.

Image Statistics

At the bottom left of the image viewer you can see a page count, image dimensions
and file size.

Insurance Claim Prepare Window
The Claim Prepare window pops up automatically when an insurance invoice is saved. It is used to add
any information required for the claim that is not already in the patient, provider, guarantor and other
linked files. For most office visits, the default settings are sufficient and all that is needed when posting
charges is to exit from the window.
Claim Prepare Window
Options
Prior Authorization

When treatment requires authorization by an insurance company in order to receive
payment, the authorization number must be filed with the claim. It can be entered
manually into the field, or will auto-populate from the current active
referral/authorization in the patient file.

1st Illness Date

Use this field to indicate the first date on which the current ailment started. This is
usually required for claims such as Workers Comp and prints in Box 14 of the
st
CMS/HCFA. (Box 14 prints the invoice date if no 1 Illness Date is entered.) If the
Symptom Date Indicator in the invoice is set to 1, this field is filled automatically.

Similar Illness Date

Required if the claim for this visit is related to a previous similar illness. It prints in
Box 15 of the CMS/HCFA.
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Condition Related To

Usually set to None. It is automatically set to Employment if the primary insurance
company origin id/indicator code is WC, or Auto Accident if it’s AM. If an option other
than None is selected, you may be required to furnish further information about the
accident. Most of this is done in the Workmen Comp tab. This prints in Box 10 of the
CMS/HCFA.

Employment Status

A drop-down list linked to the Employment Status setting in the patient file. This
prints in Box 8 of the CMS/HCFA.

Provider Sig Ind

This indicates that the provider of service reported on the claim acknowledges that
services were performed and payment is authorized and his/her signature is on file
in the provider’s office. Since most insurance companies require this, e-MDs Bill
checks it by default.

Assignment

In the data file for each provider, you can specify if payment should be mailed to the
clinic or the patient. By default, this is usually set to Yes, meaning that the clinic
should receive the payment. If this is the case, the check is automatically entered
into the prep, but can be changed at invoice level by users. Prints in Box 27 of the
CMS/HCFA.

Note: If in doubt, ALWAYS ensure this box is checked because it is hard to collect
monies mistakenly sent to patients by the insurance company.
Release Date

The date the patient’s release signature was filed. It is linked to the patient file where
this information is stored under the Miscellaneous tab.

Visit an Emergency

Select the appropriate option from the drop-down box.

Signature Source and
Information Release

Drop down boxes showing how boxes 12 and 13 are printed on the CMS/HCFA.
The fields are filled using the information in the patient file.

Frequency Type

Used on ANSI claims, this can be used to indicate whether this is a resubmission,
etc. Most payors require this – Medicaid EPSDT in certain states often does.

Delay Reason

Used on ANSI claims to indicate why a claim is being filed late.

Report Type

Still not used by most payors, but this sets a flag in an ANSI claim that indicates
what form accompanying documentation is in.

Admission Type

A list box that populates CL101 in loop 2300 of an ANSI institutional claim, and Box
19 in the UB-92.

Admission Source

Populates CL102 in loop 2300 of an ANSI institutional claim and Box 20 of the UB92.

Patient Status

Populates CL103 in loop 2300 of an ANSI institutional claim and Box 22 of the UB92.

Consult/Surgery Date

Where needed, this field can be set to populate a CMS/HCFA claim using the Claim
Form/InsPrep_ConsultDate definition. The field is automatically set to the first start
DOS for a CPT on the claim where the code is in the 10000 to 60000 range and the
type of service code is 1, 01, or 15. You can also set it manually.
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Invoice, Workers Comp
and Misc. Options
EPSDT & Program Code

Indicates the claim is related to Medicaid’s Early and Periodic Screening, Diagnosis
and Treatment Program which provides children under the age of 21 and on
Medicaid with regular preventive health checkups, immunizations and treatment for
health problems. Depending on payor requirements, you may only need to check
the box, or may need to provide additional information using the 3 list boxes. When
the box is checked 24H of the HCFA will be filled with an “E” and the 24K (HCFA) or
24J (CMS) column will include the EPSDT number from the provider demographics
file. It also sets SV111 in an ANSI professional claim. Medicaid usually only
authorizes a small number of physicians in a region for EPSDT, with the idea being
that the patient volume will offset the low fees.. The Program Code sets loop 2300
CLM12 of the ANSI professional. When the EPSDT box is check, the system
default this to 01 (EPSDT/CHAP) on the claim.

Family Planning

Indicates the visit is related to such and will also fill the H column of box 24 of the
CMS/HCFA with an F.

Home Health

Check this box if a claim is home health. It sets specific ANSI institutional format
flags.

Filing Hold & Comment

Only used if you know the information on this claim is incomplete. The filing hold is a
convenient way of putting the claim on hold until you can add the extra information
and switch off the hold. At the same time, it ensures that the claim is still created.
The hold feature puts the claim into the billing cycle, but will not file the claim until
the hold is deactivated. You can add a short reason for the hold in the Comment
field. A list of claims on hold along with the comment can be printed by choosing the
appropriate option in the HCFA wizard, or the NSF wizard. Thus, the claim fall
through the cracks.

Statement Hold

Select this option if the invoice should be held for a specified time period before it is
sent. Selecting this option requires that a value be entered in the corresponding
Hold Until field on this screen.

Hold Comment

Use this field to document why a hold was put on this invoice in the Statement Hold
field.

Hold Until

Specify the date after which the invoice can be sent out when the Statement Hold
option has been enabled. Note that this hold option is different from the Insurance
Demographics Default Statement Hold Period but does work in conjunction with it.
If an insurance company associated with this account already has a Default
Statement Hold Period specified in the Insurance Demographics, the Hold Until
field will already be prepopulated with a date. For the currently selected account,
you can either accept that preset date to use for the Statement Hold function, or you
can type a new date that will override (take precidence over) the insurance
company's Default Statement Hold Period setting.
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The next five fields are used if additional provider names are needed for the claim. To attach a name to any of the
fields, click the Find button to search the referral database.
Referral Provider &
Referral Organization

You can set a person or organization as a referral, but not both. The fields are
populated based on the Referral in the invoice. It is related to the Prior
Authorization number too. If a referral has not already been defaulted, click Find
and add one. The referring physician can always be replaced by searching for
another, or removed by clicking in the field and pressing the Escape key. The
referring physician name is printed in box 17 of the CMS/HCFA and the Upin
number in box 17a. You cannot enter a referral provider if a referral organization is
used. The fields are filled automatically based on a hierarchy.
•

If there is a case with referrals on the invoice, the referral is set to one of the
authorizations in the case.

•

If there is an active inbound referral/authorization in the patient file, this is used.

•

If not, the system checks to see if there is a default referral in the patient file
and uses that. (Default referrals appear in red in the Tools >
Referrals/Authorizations window.) For example, Medicare requires a referring
physician for lab procedures. To save data entry time, users can keep the
referring physician in the patient file (and is often the same person as the
patient’s primary provider).

•

If there is no referral in the patient file, but the Use Provider as Referral if None
Set File > Option is set, the patient’s primary provider is used.

Legal Referral

Sometimes required for claims involving workers’ compensation or personal injury
cases. If there is a case with a legal referral on the invoice it populates this field.
Legal referrals may be people or organizations (a law firm) so they are set up in the
guarantor table.

Rendering Provider

The field automatically displays the supervising provider on the invoice, unless the
provider link setting for the primary insurance is set to use the DOS provider.
Insurance companies require the rendering (performing) provider identification to be
attached to the claim if submitting under a group ID. When a claim is created, the
system locates the applicable rendering number depending upon the financial group
or insurance company and fills it in Box 33 Pin of the CMS/HCFA or electronic
claims equivalent.

Ordering Provider

If the claim is related to an order put in by another provider, this provider must be
identified here.

Purchasing
Provider/Purchasing
Organization

If a diagnostic test was ordered from another medical facility, but your office is billing
insurance for the test (and is getting billed by the other site), then the purchasing
provider or organization for the item must be identified (i.e. the provider from whom
the service was purchased). One of these fields must be populated if you checked
the Purchasing Provider box in the Invoice (CPT) Edit window (see Changing
Invoice Information on page 181).

Operating Physician

Used on institutional claims.

Hospitalization Name and
Admission/Discharge
Dates

The hospitalization fields are used if the charges are for services rendered in a
hospital or another medical facility. Click Find to browse the medical facility
database. If used, the information will print in Box 32 of the CMS/HCFA. You should
also fill in the admission and discharge dates for Box 18 of the claim. To remove a
date, tab to the field and press Escape. If a default facility is entered in the patient
file, this will already fill and is useful for nursing home and similar patients. If the
POS in the claim is not home or office, the dates are filled out automatically. The
field can be defaulted if needed by entering an External Medical Facility in the Misc
tab of the patient’s demographics. This is useful for nursing home and similar
patients since users have to search for and select one every time a claim is
generated for the patient.

Admission/Discharge
Times

Times are presented in Military notation (24 hour clock).
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Lab Name

If outside lab services are ordered, click Find to browse the medical facility database
for a laboratory. Depending upon your location, if lab services are performed in
house, you may or may not be required to enter lab information. The information
prints in Box 32 of a professional paper claim. In some cases, it may also be
necessary to create a medical facility with the name “Same” to cater to insurance
requirements.

Lab Charge

If required by the insurance carrier, indicate the total of lab charges. It prints in Box
20 of the CMS/HCFA.

Outside Lab

Check this box if lab orders were performed by another facility. If the invoice
financial group is MDC, and outside lab is not checked, then the CLIA ID in your
Setup Options file will be used in box 23 of the CMS/HCFA.

The Workmen’s’ Comp tab includes fields required for work related claims.
Accident

Click the drop down arrow and select the applicable accident related option.

State

Some claims require the state in which the accident occurred to be identified. Enter
the two letter state code.

Hour

If the time of the accident is required, use this field.

Unable to Work, Total and
Partial Disability Dates

Unable to work sets Box 16 of the CMS/HCFA. These fields are updated
automatically to the values in a case if one is linked to the invoice.

The Miscellaneous Options tab contains several fields which can be used when an insurance carrier has special
identifiers for providers or facilities, as well as additional facility information.
Upin

If the insurance carrier requires a number other than the Upin to be entered next to
the pin heading in Box 33, it can be entered here. It is better to do this by creating
HCFA definitions to save having to make changes each claim. (See the sections on
HCFA and CMS Definitions.)

Group No

As with the Upin, you can change the group number on a per claim basis.

Print K Column

By default, the provider Medicare or other identifier is printed in this column
depending upon the type of claim. For example, EPSDT claims may require the
EPSDT number to be printed in the column. This prep form option allows the user to
override the default settings and enter a different identifier. Again, using HCFA
definitions is better.

Original ICN/DCN
(Medicaid Resubmission
Code)

Also referred to as the ICN/DCN, this is a claim tracking or other number assigned
by Medicaid. The Claim Form/InsPrep_MedicaidResubCode definition can be used
to include the first 8 characters in the CMS/HCFA. It populates the CLM05 and a
REF segment in ANSI claims.

Abuse Indicated

This flag should be checked if the clinic suspects that a child might be abused. This
should alert welfare services by inserting a code into electronic claims.

Health Professional
Shortage Area

If a procedure code in the invoice used the modifiers QB, QU or AQ to indicate that
the service was rendered in a Health Professional Shortage Area (also known as
Rural Health), then the physical location where the service was rendered must be
entered if other than at home. The system automatically checks the HPSA box and
sets the HPSA Facility to the current one when a claim is saved with either of these
modifiers. This prints in Box 32. These claims may be reimbursed at a higher rate in
order to encourage doctors to provide services to communities that would otherwise
be underserved.

Custom Fields

Additional fields that can be used to send claims information using CMS and HCFA
definitions for Claim Form/InsPrep_Custom1 to Custom10.

The Occurrence tab is used to set Occurrence Codes and Dates for Boxes 32a through 36b on a UB-92
claim.
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To modify an invoice preparation:
1. Select the invoice to which the preparation is attached by highlighting it in the Posting window.
2. Click Edit Invoice (Alt+T).
3. Click Claim (Alt+M).
4. Change field values, or add to them, as required.
5. Click Save (Alt+S), then close the invoice.

Claim Default Window
The Claim Default window stores static information for the patient which can be used for claims, usually
institutional/UB format such as for home health or hospitalization. The data is actually stored by patient,
not by invoice because it typically remains the same (e.g. disabilities, amputations). Changing the date
on one invoice updates the data for other invoices.
The window is opened from within the claim prepare by clicking the Claim Default button.
Claim Default Options
Prognosis

List box of types for home health/nursing home. ANSI institutional CR601.

Skilled Nursing Facility
Indicator (if known)

ANSI Institutional CR606.

Certification Type

ANSI Institutional CR608.

Last Discharge Location
Type

ANSI Institutional CR617.

Certification Date Range

ANSI Institutional CR604.

Verbal Order Date

ANSI Institutional CR612.

Last Physician Contact
Date

ANSI Institutional CR614.

Functional Limitation

Home Health. Up to 3 can be selected. ANSI Institutional CRC.

Activities

Home Health Permitted Activities. ANSI Institutional CRC.

Mental Status

Home Health Mental Status. ANSI Institutional CRC.

Condition Codes

ANSI Institutional HI, UB-92 boxes 24-30. Double-click a cell and then user the
search window to select codes.

Charge Entry
Charges can be posted from manually and automatically. The system supports manual editing of
automatically entered charges too. These instructions include sections on how to enter charges
manually, using the Daily Work List, and using the automated functions to pull charges from Chart.

Posting Charges Manually
These instructions explain the details of entering charges by hand. Depending on what you are doing, it
might not be necessary to use every step so quick steps are described in the next section. Even if you
plan to enter charges using Chart or Companion, you should also be familiar with manual charge entry
since even automatically entered codes will need editing occasionally.
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Utilizing the keyboard as much as possible is strongly recommended. It is significantly faster to navigate
using the keyboard rather than the mouse. The legends in each window provide tips on keyboard
shortcuts and data entry methods. These instructions also show the Alt+ keyboard shortcuts used to
access functions where enabled.
For an expanded detail on each of the fields and functions in the screens, refer to the section on Charge
and Payment Entry Windows which starts on page 150. Anesthesia code entry is also described
separately.
There are several ways to start a new invoice for manual charge entry:
1. In the Posting window, click the Posting button or go to Posting > Ledger. (Alt+P, L).
2. Load the patient. There are several ways to do this:
○ Name search: Enter starting characters from the last and/or first name separated by a comma
then hit the Enter key (or click the search button). The patient search appears with any
matches loaded. Select one.
○ Account #: Enter a known account number and hit Enter.
○ Last: If the patient was the last one worked on, click the shortcut Last button.
3. Review and take action on any warning messages that might appear. These may be:
○ Billing Block Warning: Based on the billing block check box in the patient demographics
Misc tab.
○ Patient Alert: If the free text memo in the patient file is checked to pop up automatically in Bill.
You can update the alert if necessary.
○ Referral Alert: If the patient has an active, inbound referral that has no more authorizations,
has no more allowed dollars, or is outside the date range.
○ Case Alert: If the patient has an active case and there are problems with this such as the
invoice being generated in the wrong facility, or if a referral is invalid.
4. Start the new invoice. You can do this with a blank invoice, or you can copy an existing invoice.
○ Click New Invoice (Alt+W). The Charges & Payments window opens to the Charges tab with
the cursor in the Diagnosis tab.
○ Copy Invoice: Select the invoice you want to copy, then click Copy Invoice. The Charges &
Payments windows opens with the following copied: ICDs & CPTs with all associated
properties and linkages but will pull current fees and rules, Symptom Date and Symptom Date
Indicator, Provider and other default properties. Other properties such as referrals and cases
are pulled based upon current settings/appointments.
5. Review the default information in the invoice and make any changes necessary. Each field is
described in detail starting on page 150. The basic sections are:
○ Toolbar: Gives you the ability to look up patient or guarantor aged balances, read alerts, edit
demographics, etc. Most of these have an underlined letter in the button label which is the
Alt+ keyboard shortcut. If the Alert button label is red, it means there is a patient alert.
○ Header Defaults: Shows the current facility in which charges are being built, default date, the
case linked to the invoice, invoice title which can be defaulted from an appointment or set
using comments or free text, financial group default from patient file or case, current invoice
status and posting batch # (see separate section on these).
○ Invoice Defaults: The DOS Provider is defaulted from patient file and the supervisor is that
doctor’s default billing supervisor. The Referral is set by a case or the last active, inbound one
used for this facility. The balance due by shows insurance or patient depending on the invoice
type. The Guarantor comes from the patient file but can be changed for cross-billing purposes
if needed. The DOS and Post Date are set by the Default Date batching utility. Note that the
Post Date is the primary accounting date in the system. The Symptom Date & Indicator can
be set manually. You can enter a Superbill number to reconcile with the Tools > Superbill
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Audit report. The number is set automatically if a superbill was printed for the patient on the
same date.
○ Insurance Information: This is the active insurance from the patient file. If changes need to
be made, you can do this by using the Edit button, or by clicking Edit Pat in the toolbar,
changing the insurance in the patient demographics, then using the – All Ins and + Pat Ins
buttons to remove and refresh the insurance. You can also replace the patient insurance with
guarantor insurance for cross-billing purposes. Note that the insurance policy holder and
guarantor are not necessarily the same person or organization. The copay and % Pat
information is based on the group but can be modified or removed such as for nurse visits that
’ require them. Note that you can automate this using fee schedules functionality.
6. Enter Diagnoses and CPT/HCPCS using free entry of known codes, the applicable search
functions, charge sets or CPT Panels. You can use a combination of all of these as needed for
speed and accuracy. For typical ICD and CPT entry, enter the ICDs, tab to the CPT/HCPCS field
and type those in.
○ Diagnoses: Enter known codes and hit Enter, or use the New Inv ICD search function (Alt+v).
Delete a selected code using the Delete ICD button. The first code entered is bold indicating it
is the primary but you can select another and click the button. The primary is printed first on
claims.

Note: Before you can delete an ICD, you must remove any links to the ICD in the CPT grid.
○ CPT/HCPCS Codes: Enter known codes. You can also use shortcut keys available on the
number pad (described in the legend that is in the Charges tab) to use custom “starred
codes,” add modifiers, designate ICD linkages and set unit counts as well as use panels. You
can tab onto the CPT or HCPCS buttons then hit Enter, or just click them to open the search
tools for codes you know. The primary CPT is in bold. It’s set automatically upon save to the
first E&M if one is on the claim, or the first code. This is the code to which the system
automatically applies a fixed copayment.


Starred Codes: Enter the CPT followed by an asterisk followed by the star code to load
one of your custom iterations of the CPT. Example: 99213*A



Modifiers: Add a hyphen before each modifier. Up to 4 per CPT are permitted.
Example: 27130-99-50-80.



ICD Linking: The CPT automatically links to the ICD highlighted at the time it is entered,
or if the Link ICDs property in the CPT/HCPCS search is checked, to all ICDs in order.
Link ICDs is typically set for E&M codes. You can also specify your own linking using a
period followed the the number in the # column for the ICD. For example, if entering a
st
nd
th
99213 CPT that you want to link to the 1 , 2 and 4 ICDs, you would type 99213.124.



Unit Counts: Precede with a + sign. Although decimals are supported for unit counts,
they cannot be entered using this method because the period is used for ICD linking.
Example: A4556+6



Keystroke Combinations: You can use a combination of the above if necessary. While
not every item is required, the order is very important. Examples: J1000*1.13+2; 9921325.12



Shortcut CPT/HCPCS Panels/Charge Sets: For reference panels, enter a / followed by
a panel code in the CPT/HCPCS field. You can also type the code into the Panel field
although this wastes time since you have to get to the field first. To search for a panel,
click the search button to the right of the Panel field.



HCPCS Panel: If you have set up a Code Linker HCPCS panel for a CPT, the HCPCS
Panel button label turns green when the code is entered. Click the button to see the list
of possible HCPCS codes. To use them, check the box to the left of the code and click
Select.
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Charge Sets: Similar to panels, a charge set speeds data entry and helps with complete
coding by loading common ICD and CPT/HCPCS code combinations. Click the Chg Set,
then search for a set and use Select (Alt+L) to load. If necessary, set primary ICD and
CPT codes.

Note: You can use multiple panels, charge sets or other combinations on the same invoice.


Anesthesia Codes: If the type of service on the procedure is anesthesia (7 or 07), a
pop-up appears automatically. Enter the number of minutes or start and end times to
calculate these, and if necessary, change the base units (which are preset using the ABU
field in the CPT reference table). Then click OK. The system divides the number of
minutes by the Anesthesia increment in the primary insurance (usually 15), rounds up,
and adds to the base units to calculate total units. Changes can also be made in the
Edit CPT window where the NM button is activated and pops up this window when
clicked. By default the minutes are printed in Box 24G of the HCFA. It will also enter the
number of minutes in the Dosage field.

7. Review your entries. If you need to make changes to CPTs, there are several options:
○ Grid Entry & CPT Description Edits: Type directly into the grid by clicking the cell and
entering the data. The system will validate your entry. For example, you cannot enter an ICD
code linkage if the ICD is not one of the diagnoses on the invoice. Grid entry is also how you
can change a CPT description.
○ CPT/HCPCS Functions Menu: With a code select, click the CPT/HCPCS Functions button at
the bottom of the window (Alt+/ or menu button). This menu has options to change ICD
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ordering, POS & TOS codes, split charges into separate invoices or delete codes. These are
described in detail on page 155.
○ Edit CPT Window: With a code selected, click this button (Alt+E). If the code is a HCPCS,
the label changes to Edit HCPCS. Although this window is slower than typing into the grid, it
is also where you can enter a CPT narrative if needed on a claim; see appropriate modifiers
for the CPT using the Find buttons next to each modifier field; change the default revenue
code; and set the CPT as a purchased service for pass through billing. If you set the
purchased service you will be required to enter a purchasing provider in the claim prepare
window.
8. If you want to apply a payment, click the Payments tab (Ctrl+tab) and enter this (see extensive
information about payments in this chapter).
9. Click Save (Alt+S).
10. If the invoice has patient insurance, the claim prepare window appears automatically. It can also
be loaded using the Claim button. The claim prep contains extended information for the invoice
and one is required for every insurance invoice which is why it will appear automatically. Much of
it is defaulted using the patient file or other information so for most claims it is only necessary to
review it. Detailed information about the claim prep and the related Claim Default window can be
viewed on page 168. All posting staff should be familiar with the importance of many of these
fields and how they can affect claims filing and refiling.
11. Click Save (Alt+S) if you have made changes to the claim prep, or Exit (Alt+X). Either is
sufficient to satisfy the requirement for claim prep on an insurance invoice.
○ If there are any CPT/HCPCS alerts such as for authorizations, required modifiers, a global
period alert, missing forms and so on, the CPT/HCPCS alerts window will appear so that staff
is warned about possible problems that may result in claim denials. See the fee schedules
section for more information on this.
○ If the Print Patient Education option was checked, a window appears with a list of the patient
education documents linked to the ICDs and CPTs in the invoice. Select the ones you want or
search for additional ones. The language is set to the home language of the patient if a nonEnglish translation exists and you can double click a title to view it and make on-the-fly
changes.
○ If the Print Invoice/Receipt for New Invoice option in the invoice was checked a window
appears from which you can print a walk out invoice or receipt appears. Set options and click
Print (Alt+P), or exit (Alt+X).
When the invoice is saved, the following occurs:
•

The invoice appears in the posting ledger window. It is displayed based on filter settings.

•

Patient and guarantor balances are updated automatically.

•

If it is an insurance invoice, the claim is automatically queued based on the default filing status for
the primary insurance. If you are using the automated status codes/invoice notes function and
there is insurance, the invoice status might be set to P_INS (pending insurance).

Posting Charges Manually – Quick Steps
You should review the detailed instructions and field level help in the prior section to be sure you
understand all the nuances and power of the different functions in the posting window. These steps are
purely intended to show you that rapid entry is easily possible for common charge posting.

To use Quick Steps to post charges manually:
Open the posting window (Alt+P, L).
1. Load a patient (enter characters from last, a comma then characters from first, hit enter, then
select and enter again).
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2. Click New Invoice (Alt+W).
3. Enter diagnosis codes by typing each followed by the Enter key.
4. Tab to the CPT/HCPCS tab.
5. Enter charges by typing in known codes followed by the enter key. If necessary, use the
keyboard shortcuts to include modifiers, diagnosis linking, unit counts or panel codes.
6. Save the invoice (Alt+S).
7. If it’s an insurance invoice and the Claim Prepare window appears, review and make any
changes necessary then close (Alt+X).
8. Print patient education and/or an invoice/cash receipt if the options for these were checked.
That is really all it takes: Alt+W, enter diagnoses, Tab, enter CPTs, Alt+S, Alt+X, Alt+X!!

Auto-Posting Charges Using the Visits Window
The Visits utility lets you automatically post charges by selecting from a list of Chart notes. It is a great
time saver and you do not have to waste keystrokes loading the patient first.

To use the Visits window to auto post charges:
1. In the Posting Window, click Visits (Alt+I).
2. In the Visits window, ensure the filters are set correctly. They are remembered for a login session
so you can post out daily or provider batches. The visits window is automatically filtered for the
facility in which you are working. You can tab between the filters.
○ Visit Create Date Range: Set a date range for visits to see. The Dynamic Dates option
bases the list on the server date. If you send the Visits window to users as an automatic task
the system will send an updated list of work to do each time the task is fired because the
records are not within a fixed date range but on a “dynamic” one.
○ All Providers: When checked, lists all providers. Hit the space bar to uncheck the box, then
tab to the list box and enter the starting letter(s) from the last name of the provider you want.
○ All Facilities: You can uncheck this to only show invoices from a specific facility. Note that All
Facilities only includes those to which the user has been given security access.
○ Show Visits With Invoice Built: A filter that controls whether all visits or just ones that have
not been billed are displayed.
○ Only Show Nurse Visit: By default the window shows all visits. Checking this option only
shows nurse notes. You can also change the ALL setting to filter for a specific nurse.
○ Only Show Order Notes: Works the same as the above option, but checking this option
shows only Order Notes.
3. Review the visits information. Signed off notes are in black and unsigned ones in red. The
default sort order is the Patient name column but you can click on any other column heading to
sort ascending or descending.
○ Patient & DOB: Identifiers for the patient. The DOB is useful for distinguishing between
people of the same name such as when family members visit a clinic at the same time.
○ Provider/Nurse: The DOS provider on the Chart note or Companion visit. If it is a nurse note
then both the supervisor and nurse are displayed.
○ Visit DOS: Shows the date of service from the Chart note.
○ Ready to Bill?: A check indicates that the visit is ready. If a note is completely signed off or
where the provider sets the billable flag in an unsigned note, the box is checked. Trying to bill
unsigned or unbillable notes results in prompts to the user. Note that there is a setting in File
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> Options which can be set to prevent users from generating invoices for notes which are not
permanently signed off even if the provider has marked them as billable.
○ DOS: The date and time of the visit.
○ Invoice Built?: Checked if the invoice has already been built so you can see which ones still
need to be done.
○ Type: Can be Doctor Note or Nurse Note.
○ Facility: Displays the shortcut code for the facility in which the encounter was generated.
4. Tab to the list and use the up and down arrow keys to select the visit to bill.
5. Click Build (Alt+B). The system loads the patient and starts a new invoice. You might receive
prompts prior to the start of the invoice:
○ Patient Alerts and Block: If there are blocks or alerts in the patient file, these appear.
○ Required Demographics Check: If anything is missing, the system gives a warning from
which you can open the file and add missing information. After doing this, return to visits and
build again.
6. Check the invoice information:
○ Invoice Default Information: Verify referrals, etc. If the Chart visit is a nurse note, the DOS
Provider is set to whoever was listed as the supervisor on the progress note.
○ Diagnoses and Charges: You may need to ensure the ICD: CPT links are correct, and add
or change codes if the doctors did not do it correctly.
○ e-MDs Rounds Free Text Codes: If diagnosis or charge lines are red, these are because the
codes were unstructured free text entered by the doctor in the mobile charge capture PDA
software. The system synchs the free text as the code descriptors, with a 000 (ICD) or 00000
(CPT) code. Add the correct code using the red description as a key first, then delete the red
codes prior to saving the invoice.
7. Continue to the "Completing the Invoice" instructions below.
Note: If charges that come from Chart have the same mistakes all the time, this is a cue for billing
administrators to verify that the charge capture panels and plan templates in Chart have the correct
charge sets and linked CPT codes and to correct them if necessary. If there are a lot of free text codes
from mobile software, these need to be sent to the provider so that he/she can add them to his/her
specialty short list ensuring they are synchronized. The whole point of automation is to ensure
completeness, accuracy, and speed of entry, thus maximizing revenue and efficiency. This requires
monitoring, tweaking, and awareness education for both clinical and billing staff.

Auto-Posting Charges Using the Daily Work List
The Daily Work List (DWL) is an appointment-centric work flow tool that can be used to complete the
typical tasks each appointment generates. Its filtering, sorting and visual functionality make it a great tool
for completing daily charge entry. Expanded help on the DWL is available in a separate section of the
user guide.

To use the Daily Work List to auto post charges:
1. Go to Tools > Daily Work List in Bill or Schedule, or click the Daily Work List hyperlink on Bill’s
desktop.
2. Set filters to retrieve the appointments you want, then click Work List to open the list.
3. Review the list for appointments with no invoice. Those with an invoice have a number in the
Invoice # column.
4. Double-click the Invoice # cell for the appointment you want to enter charges. If there is a chart
note that is ready to bill, the invoice is started and all information entered automatically. If there is
no chart link, a blank invoice window opens so you can enter the charges manually. You can
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also use the Build All Invoices function which will generate an invoice for every appointment
where there is a completely signed off Chart note. Worth noting is that the Allow Unsigned Notes
to be Billed setting under File > Options in Bill will not have an effect in the Daily Work List.

Invoice Alerts
During posting or when an invoice is saved, there may be one or more alerts presented to the user based
on the charges entered or other rules:
•

Auto Import CPT/HCPCS Code: This will occur at the start of an invoice if there is a contract
linked to the primary insurance and with an auto code. This is typically used where almost 100%
of encounters under that insurance require this code. The typical example is RHC/FQHC clinics
that need an encounter code such as T1015 on every encounter.

•

Improper ICD Code: If the code is not specific enough (e.g. requires 4th or 5th digit), you will see
a red icon next to the code. There are also icons for unspecified (yellow), other specified (green)
and manifest codes that require the underlying diagnosis (blue). You can go to the ICD Search
and look up any billing rules, inclusions, exclusions and internal notes which are displayed in the
bottom right of the Details pane of the ICD Search window when you have the code highlighted.
Billable codes have a white icon.

•

Duplicate ICD Link: Occurs if a user tries to link an ICD to a CPT more than once. The duplicate
link can be removed using CPT/HCPCS Functions.

•

Duplicate CPTs: This warning appears if you try to enter duplicate CPTs which are not
distinguished by modifiers. You can override the warning and drop in the code if necessary
although one should generally change the unit count and add the ICD links on the first entry.

•

CPT/HCPCS Process Alerts/ABNs: This is a window that consolidates multiple warnings into
one screen. The warnings are based on multiple different setup options for referrals, fee
schedule rules, cases, policy requirements, provider credentialling, forms requirements (like
ABNs or LMNs), gobal periods, crossover codes, default modifier, and other modifier alerts. If the
rules are set as defaults you may not see this window because they will execute automatically.
These alerts are also displayed during scheduling and charting in an effort to get them taken care
of at the appropriate time. A particularly pertinent example is collection of an ABN prior to a
procedure being performed.

•

CCI Check Warning: The Medicare Correct Coding Policy edit checks are performed against
CPTs if the CCI Check box is set. The option remembers the user’s last setting. CCI checks are
updated quarterly and are posted to e-MDs web site for you to download and import. The alert
shows the codes that have triggered the alert, whether it is a component or mutually exclusive
code edit and whether modifiers can be added or not. Add modifiers or change coding if
necessary.

•

Capitated Codes: This notification may appear dependent upon several conditions. First, the
patient’s primary insurance company must be linked to a contract and the “Prompt for Cap
Adjustments?” setting in that contract must be checked. Then, procedure codes in the invoice
must be marked as capitated (“CAP” column set to Y). The notification asks if you want to
automatically adjust off the insurance balance on the cap codes and if so, adds a payment using
the adjustment codes specified in the contract.

•

Sliding Scale/Poverty Adjustment: This prompt appears if the Set Poverty Level box in the
Misc tab of the patients demographics is checked and and, based on the number of family
members and income the patient qualifies for a discount based on the Reference > Poverty
Guidelines and Reference > Sliding Scales information. The prompt shows the patient due
amount based on the sliding scales structure and gives you the option to create the adjustment
for the rest automatically. The adjustment code and, line item adjustment reason codes used are
based on the sliding scale setup and a statement comment “Sliding scale discount” is also added
automatically.
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Changing Invoice Information
When an invoice requires more information than the defaults, a little more work is required. These steps
dovetail in to the ones described above. The order of these possibilities follows the approximate order of
fields and buttons on the invoice screen:

Changing Diagnosis and Charge Information
You can change almost any item in the charges grid by typing directly into the cells. You can also click
Edit CPT to make additional entries. See Charges Grid Options.

Removing or Changing Invoice Insurance
If the insurance filing information needs to be changed to use updated insurance from patient file or to
cross bill to guarantor insurance (where the case management system is not being used), or is being
removed for non-covered visits, or if the filing status needs to be changed, this can all be done from within
the invoice.
When a new invoice is started, whatever current insurance is in the patient file is automatically loaded into
the invoice. The exception to this rule is if there is an active case linked to the invoice. This link is
automatic if the case is active. Whatever insurance is in the case is set for the invoice. The filing status
for the primary insurance is default to the setting in the insurance demographics file.

Notes:
•

It is important to note that upon saving an invoice, the insurance associated with the claim is also
saved. Thus, if a patient’s insurance changes, but a claim generated prior to this change needs to
be refiled, the system will still use the previous insurance unless it is removed and then updated.
Invoice insurance is displayed in the insurance tab of the invoice.

•

If a payment has been posted for an insurance company on a claim, you cannot remove that
specific company without deleting the payments linked to it first. Likewise, re-adding the patient
or guarantor insurance will add those in order after the insurance company that has made a
payment.

•

Delete Insurance: To delete individual insurance companies, highlight each in turn and click Edit,
then Delete. A prompt requests confirmation. Click Yes. Click - All Ins if required. In this case you
should change the invoice financial group to PVP to indicate a cash invoice.

•

Use Guarantor Insurance: Remove the patient insurance first, then click +Gurn Ins. The system
replaces the patient insurance with the insurance from the guarantor file. If you remove the existing
insurance first, the system appends the guarantor insurance to the list (if the guarantor is different to
the patient).

•

Change Insurance Filing Order: To change insurance filing order, highlight the company and use
the buttons with the blue up or down arrows.each insurance company in turn, then click Edit. Click the
applicable radio button in the Insurance Assignment section, and then click Save.

•

Change Co-insurance Responsibility: To change the co-insurance responsibility, highlight the
primary insurance and then modify either the % Insurance or Copay fields. This updates the line item
charges on the invoice. Bear in mind that if a copayment is not required on an invoice based on
CPTs in the invoice you can set up the fee schedule rules to do this automatically.

•

Change Insurance Filing Method: Select a method. The typical codes are listed below although
you can define your own for segregation purposes. If the current status is displayed with an X as the
second character, it has been filed previously. The system permit two insurances to be set to a
pending status simualtaneously unless it is reflagging a claim via the claims wizards when another
one has also been set.
○ EF/EX: Electronic.
○ NF/NX: Paper.
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○ UB/UX: Universal Bill used for hospital billing (HCFA-1450).
○ DP: Disk print.
○ NULL: Ignore this insurance company. Any claim set to null is not included in insurance
batches.

Deleting an Invoice
An invoice can be quickly deleted if it was started in error and nothing was added to it. This is more of a
cancel function. But to delete an invoice that has been entered properly you must:
•

Have the necessary user privileges.

•

Delete content added to the invoice first. This includes ICD, CPT, HCPCS, payments and
insurance. If payments have been distributed, then those must be deleted before the payment
can be deleted.

Note: Invoice edits and deletes are tracked to the audit trail.

CPT/HCPCS Process Alerts/ABNs Window
The process alerts window gives users warnings based on a variety of criteria. These might be things
linked to the patient such as referrals or cases, fee schedule rules triggered by codes used in an
encounter, forms requirements, policy requirements, demographics setup and so on.
The process alerts window appears in Schedule, Chart and Bill. The philosophies behind the alerts
window are to notify users when certain things need to be done to create a clean claim with the correct
documentation, as well as to consolidate several alerts into one window so that you get pop-up fatigue.
This section of the user guide describes when the window may appear and how to deal with each of the
warnings. To set up the alerts themselves, refer to the other sections of the user guide that describe how
to create referrals, cases, policies, etc.

Alert Window Work Flow and Accessing Alerts
The alerts process is based on the assumption that while some requirements may only manifest
themselves during the patient encounter or when a bill is generated, many can be taken care of in
advance of the appointment. The more things can be done prior to the encounter, the less likely that
there will be problems that could result in billing and payment problems.
The system has the ability to link appointments, chart notes and invoices together. This is done by
passing the appointment ID to each record. In most cases the link is established automatically by using a
combination of service date, provider and facility. You can also override the settings. In Chart, the
appointment linked to the chart is seen in the note details window which appears when a new note is
started. In Bill when an invoice is built from the chart note or using the daily work list, the appointment ID
is also passed.
The importance of this is that when a rule/alert is satisfied for the appointment, it can be done at any point
and the system knows not to warn the user again. For example, an appointment could be scheduled
using a visit reason that requires an authorization. The scheduler is alerted and can queue an
authorization alert for someone. If it is linked to the patient and satisfies the rule criteria, the doctor and
biller will not get the warning because the system recognizes that the information is there.
Bear in mind that at the appointment level one may not know all the details that the encounter itself may
involve. For example, the orders entered by the doctor may trigger alerts for forms like ABNs. Modifiers
might also be needed, or the system may automatically substitute one code for another (e.g. Medicare G
codes, or global follow up consult 99024).
Thus, the alerts window is available from several places in the system and also appears automatically.
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•

Schedule: Pops up automatically when an appointment is saved. Also accessed by clicking the
Alerts/ABN button at the top of the Edit Appointment window.

•

Chart: An icon with a yellow triangle that has a red exclamation mark in it automatically appears
next to ICDs or CPTs that trigger alerts. You can double-click the triangles to open the window.
The P (plan) button is outlined with a red border too. Clicking the arrow to the right of the P gives
access to a menu with a Process Alerts option.

•

DocMan: Although the alerts window is not available here, any forms requirements triggered by
alerts are queued to the ABN/Forms Manager which is part of the alerts window but a separate
utility in DocMan. There is a button for this on the DocMan toolbar and under the Tools menu.

•

Bill: Pops up automatically when an invoice is saved. It can also be accessed by clicking the
Process Alerts/ABN button at the bottom of the Charges tab of the main Charges & Payments
invoicing window.

Bill is the ultimate arbiter of CPT based rules. When these are entered into an invoice, a property set for
each code to indicate whether it is satisfied or not. The setting is visible in the CPT grid’s IsProcessed
column as well as in the Edit CPT window. The default is set to N. When the invoice is saved, the
system processes other rule types such as for referrals or case requirements and CPT based rules. If
there are any problems, the CPT/HCPCS Alert window pops up.
At this point, users have several choices. You can correct each of the alerts and then exit from the
window. You can also cancel or accept using the function buttons provided. There is a distinct difference
between the two. Clicking Accept changes the IsProcessed flag for each CPT to Y whereas Cancel
leaves them as is. Thus, if you clicked Cancel you will continue to get the alert every time the invoice is
saved until the rules are satisfied. Clicking Accept indicates that even if you have not satisfied the rules,
you want to be bothered by the prompts again. While this is useful if you intend to do more and thus will
not get irritated with the prompt whenever the invoice or payments for it are saved, it is not
recommended.
Note: In some cases, the system will not populate the complete alerts window but rather a single alert.
How the system determines which to use is based on where the alert is triggered and also the type. For
example, there are specific case management and referrals alerts. The end result and functionality is,
however, much the same.

How Alerts are Triggered
Alerts are triggered based on a patient’s primary insurance group fee schedule linkage. When a code is
used in Schedule (linked to visit reason), Chart or Bill, the system checks to see if the code and
modifier/provider, etc. combination is found in the allowed fee schedule. If not, it looks for the code by
itself. If a match is still not found, then it checks the billed fee schedule in the same manner. If there is
still no match, it will check the facility default fee schedule. The facility default is usually the same as the
billed fee schedule.
This hierarchy thus supports the creation of exception codes. If you want to set up a rule without creating
a complete new fee schedule, it can be done by creating a blank schedule and adding on the codes with
exception rules and ensuring that this is the allowed schedule for the patient’s group.
The AllowOverwrite in the CPT grid is also a way to override alerts. If you get a prompt but have a good
reason for overriding it, then set the flag to N. When the system processes alerts, it ignores those with an
N, even if there are rules which it does not satisfy. For example, you might decide not to fill out a form,
add a modifier, or make a global substitution.
Note that the system only processes alerts “one deep.” What this means is that when a rule is satisfied,
the system will not run additional rules on other CPTs that may have been added because of the first alert
since this could have the potential to create an endless loop.
Extensive information on fee schedule setup can be found starting on page 58.
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Satisfying Process Alerts
As explained above, for the most part alerts are easy to satisfy and can be done wherever they are
triggered. There are some exceptions which are described along with each alert type.
The CPT/HCPCS alert window is divided into two sections. The left side includes warnings for referrals,
coverage, forms, policies and cases and appears in Schedule, Chart & Bill. The right side shows global
alerts, modifier requirements and supervisor warnings. It only appears in Bill. Alerts may appear for any
of the following reasons:
•

Authorization/Referral Required: Shows CPT/HCPCS codes that triggered the rule in red.
Cause: This is a CPT/HCPCS based rule that is triggered when the “RA” column in the fee
schedule for the code is set to Y, but there is no active, inbound authorization for the patient. The
code could be entered by the provider in Chart, or a biller in an invoice. It may also be triggered
when selecting an appointment visit reason that is linked to a CPT with rules.
Remedy: Change the code, or add an authorization to the patient. If the alert occurred in Bill,
then make sure this authorization is linked to the invoice.

•

Not Covered By Insurance: Shows CPT or HCPCS codes in red in the box.
Cause: Occurs when the “Cov?” setting is N.
Remedy: Change the code.

•

Codes That Require Forms & Forms Needed: This section lists the codes that triggered the
rule. The ABN column shows if this is an ABN requirement and the Form shows the form name
in red. In the Forms Needed box, one or more form names are displayed. The system assumes
that if multiple codes require the same form, only one instance of the form is needed, so the
number of forms needed may not match the number of codes that triggered the alert since those
with the same form are consolidated.
Cause: The Word Form column in the fee schedule is linked to a specific form. The ABN column
is set to Y or N based on the “Cov?” setting. If the coverage is ABN, then it is Y.
Remedy: Click the Manage Forms/ABNs button at the bottom of the alert window to open the
ABN/Forms Manager for the patient. This shows the required forms and has options to open the
form, print and scan it. The received column has a checkbox and a space to display a form
name. It is these that satisfy the requirement. If you open the form on screen and fill it out then
save, or if a form is scanned back to the record, then the name is displayed and the completion
box checked. Since some offices might not be able to do it as cleanly and quickly as that, a user
can indicate that they have taken care of the form requirement by checking the box. It is the
check that satisfies the rule requirement.

•

Unauthorized Codes: This is a referral based alert which is not triggered by fee schedule
specific properties.
Cause: The referral for the patient has specific diagnosis or procedure code requirements but
different codes are used. The system shows the authorized ICDs and CPTs in the boxes at left
and the unauthorized ones to the right. Below these you can see the referring PCP or
Organization and authorization number for the referral which is being used for the check.
Remedy: Use a different referral, or change the codes being used.

•

Policy Alerts: Shows the names of any policies which apply to the codes used. The policies
have requirements which have not been satisfied.
Cause: There is a policy linked to one of the red columns in the fee schedule. Depending on
whether you areworking in Schedule, Bill or Chart, the policy could be different if separate ones
have been set up for the same CPT/HCPCS code. (Most practices probably create one policy
that is linked to all 3 fields in the CPT.)
Remedy: You can view the specific requirements by clicking the Details button. This shows the
policy names to the left. The requirements for the selected policy and the codes that triggered
the alert appear to the right. You can only satisfy requirements if there is a case linked to the
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patient. Click View Case in the CPT/HCPCS alert window. The patient case window has
functionality for completing requirements including scanning forms, setting dates, and so on. If
there is no case and you cannot satisfy the requirement, the system will not stop you from
continuing, but you can set the AllowOverwrite flag in the invoice CPT grid to Y to stop the alert.
•

Case Match: This appears if there is a case linked to the encounter.
Cause: When a case has a specific provider, specialty, facility or supervisor that is/are needed to
treat the patient, but the patient is scheduled, treated or billed under different information, this
warning shows which the information currently being used, with those that are incorrect in red.
Remedy: Schedule the patient for a different location or provider if you arein Schedule. If you
havealready started treating the patient, it may not be possible to change the other information,
but you can change the facility and provider on unsigned notes or on invoices. If the case is
incorrect, click the View Case button in the alert window and change settings that are causing the
alert.

•

Invoice Warning:
Cause: This appears when the supervisor on the invoice is not credentialled for the primary
insurance on the invoice.
Remedy: Change the invoice supervisor before filing. If the provider is credentialled and the
insurance file needs updating, open the insurance in edit mode (you can do this via the Edit Pat
button in the invoice, or under Demographics > Insurance. The Credentialed Providers tab
shows the providers for the insurance.

Other than the cross over code, the Code Modifications section of the CPT/HCPCS Alert window is where
modifier and global alerts requirements are displayed. Depending on how the fee schedule defaults are
set up, in some cases, the system will automatically add modifiers without showing the alert window. If
other alerts are triggered on the same invoice though, those defaults are still shown in the alert.
•

ABN Modifiers to be Added: This shows codes that are marked as ones needing an ABN as
well as the modifier.
Cause: The “Cov?” fee schedule setting for the CPT is set to ABN. This triggers a requirement
for a modifier to be added to the code. If the “ABN Mod” is populated with a default, then it is
used. If not, then “Not Found” appears.
Remedy: If there is a default, simply accept the alert to add it to the code. Otherwise, doubleclick the Not Found label and select a modifier from the panel linked to the code.

•

E&M Modifier to be added: Shows E&M codes that need a modifier because another code in
the invoice (which might be the E&M) require this.
Cause: The “E&MMR” column in the fee schedule is set to Y which means that when this
particular code is used on the invoice, the first E&M on the same invoice requires a modifier
(typically one that indicates the service is significant and separate). If a modifier is shown in the
alert it is the default from the “E&MM” column.
Remedy: Accept the default modifier, or double click “Not Found” and select a modifier from the
panel linked to the code. If the code is always the same then set the “E&MMR” option and you
will not get the alert window (e.g. modifier 25).

•

Default Modifier to be Added: Shows codes for which a default modifier will be added.
Cause: The “DMR” column in the fee schedule is set to Y which means that when this code is
used on an invoice a default modifier must always be added. If a modifier is shown in the alert it
is the one specified in the “DM” column.
Remedy: Accept the default modifier, or double-click “Not Found” and select one from the panel.
If the code is always the same one, just set the “DM” property so you get the alert window (e.g.
for CLIA-waived labs set QW).

•

Global Addition Codes: A global period rule.
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Cause: Appears when the code being used is within a global period and there is a code in the “GAdd” column of the fee schedule. This is used to add an additional code. The system displays
the code that will be added.
Remedy: Clicking Accept processes the rule. If you want this, click Cancel and consider setting
the AllowOverwrite property to Y for the code.
•

Modifiers for Addition Codes: Related to global addition codes.
Cause: The “GAMR” column is set to Y because the addition code being added to an invoice
requires a modifier. If the “GAM” column is populated with a default modifier it is shown.
Remedy: Accept the default modifier, or click “Not Found” and select one from the panel linked to
the code.

•

Codes to be Crossed Over: Shows the code which will be used instead of the
Cause: The “XO” column in the fee schedule is populated with a cross-over CPT or HCPCS
code. This often occurs when billing Medicare when the usual lab, handling or draw CPT code
has to be reported on a claim as a G code.
Remedy: This is a forced rule. The cross over/substitution is done automatically upon clicking
Accept.

•

Global Substitution Codes: Shows codes that will substitute. This overrides cross over codes.
An example of use is when E&M visit codes are substituted for a 99024 follow up consult when in
a global period.
Cause: The “Sub Code” column in fee schedules is populated with a code and the patient is in a
global period.
Remedy: This is a forced rule. The existing code in the invoice will be replaced with the global
substitution code when the alert is accepted.

•

Global Substition Mods: Shows modifiers that will be added to a global substitution code.
Cause: The “SMR” (substitution code modifier required) column in the fee schedule is set to Y
indicating that when this code is substituted for another, a modifier must be added. If the “SCM”
(substition code modifier) has a default modifier, it is displayed.
Remedy: Click Accept to add the default modifier to the code, or click “Not Found” and select one
from the panel linked to the code.

•

Overall Period Modifiers: Shows modifiers requirements for codes in an overall global period.
Cause: The patient is within the “MDays” (overall modifier days) number of days in the fee
schedule and the “MDMR” (modifier days modifier required) column is set to Y indicating that a
modifier is required regardless of whether this procedure is related to a prior one. If the “MDDM”
(modifier days modier required) has a default modifier, this is shown.
Remedy: Click Accept to add the default modifier to the code, or click “Not Found” and select one
from the panel linked to the code.

•

Conflict Resolution Modifiers:
Cause: The “CM” (conflict modifier) colum has a default modifier and the patient is in a global
period for the code, but the primary ICD link for the code is different to a prior instance of the
same procedure indicating that is was for a different reason so this modifier is being added to
indicate to the payor that it is for something different.
Remedy: This is a forced rule. Click Accept to add it to the code.

Click Accept to process all the rules, adding modifiers, substituting codes, and so on. If the alerts are in
an invoice which was built from a chart note and coding changes or modifiers were accepted, then the
system automatically adds a date/time stamped invoice addendum to the chart note. You can, of course,
also choose not to execute these rules, put the claim on hold after canceling from the alerts window, and
message the provider to make the changes. When done, delete the invoice and rebuild it. The easiest
way to do this is using the Daily Work List which makes it easy to attach the specific progress note.
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Printing Statements
You can print statements on paper and send them yourself, or you can print the statements to file and email or upload the file(s) to a clearing house if the clearing house sends the statements. The following
procedure describes the steps for printing statements for one or more guarantors.

To print statements for guarantors:
1. Go to Reports > Statement. The screen opens on the Options tab.
2. Select the values on the Options tab as needed. See the “Options Tab” table for a description of
the available options.
3. If you want to change the clinic address or other information that normally prints on a statement,
click the Addresses and Notices tab to set that information. See the “Addresses and Notices
Tab” table for details about those options.
4. Click the Print to File tab. On this tab you can preview the statement, set print options and save
the statement(s) to file for printing or transmission.
5. Click Change Directory to select where the statement print files should be saved.
6. Click Preview Summary to display a list of all guarantors that will receive a statement, the date
the last statement was sent to each guarantor, and the guarantor’s current balance.
7. Click Preview Statement to review the format of the statements to determine if you need to make
any changes.
8. Click Print Statements to select the printer to use.
9. Select All or specify a different value in the Print Range section, as needed.
10. Select the number of copies to print.
11. Click OK to generate the statement print file(s) and to update the Invoice Status to “STMT” on
each invoice included in the statement batch if the "STATEMENT Follow Up Action" was created.
Options Tab
Guarantor Selection

Guarantor Balance

•

All active guarantors: All guarantors will receive a statement based on the
other options selected on this screen.

•

Last Name Filter: Statements can be set up to run in groups by last name (AK, L-R, S-Z, and so forth).

•

This guarantor only: Click this option to select a single guarantor. (This
selection can also be done on the Posting screen and in the Collections
module.)

•

Balance is greater than zero: All patients with a cumulative balance greater
than zero will receive a statement based on the other options selected on this
screen.

•

Balance is negative: This will print only for guarantors with negative balances.

•

Balance is greater than: An account can be put in this field so that it is not
costing the clinic more money to process and mail statements than the actual
amount due.

Invoice Filters Section
Include 100% Patient
Balance Invoice

Select this box to print invoices that have a 100% patient balance.

Include 100% Insurance
Due Invoices

Select this box to print invoices that have a 100% insurance balance. (The balance
will print in the insurance-pending area.)
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Include Invoices with
Partial Insurance Balances

Select this box to print invoices that have a partial insurance balance. The
insurance may not have been paid on all line items.

Include Zero Balance
Invoices

Check this box to print invoices that have a zero balance (not recommended).

Statement Print Options
Print Payments

Check this box if you want to make payments on these statements.

Include CPT(s) & Include
CPT(s) Descriptions

Check these boxes to print the CPT codes and/or descriptions on the invoice.

Include ICD(s) & Include
ICD(s) Descriptions

Check these boxes to print the ICD codes and/or descriptions on the invoice.

Include Account Aging

Check this box if you want account aging to be included on statements.

Print Insurance Filed Date

Check this box if you want to include the date(s) of insurance filings.

Print Invoice Title

Check this box if you want to include the invoice titles.

Print Invoice Summary

Check this box to include a summary of each invoice in the printed statement.

Print Statement Format

If you select this option, lines and borders will print on the statements. Clear this
checkbox if the statements are being printed to file and uploaded to an outside
service that send the statements out for your faciity.

Print Provider

Check this box to include the DOS Provider for each invoice.

Include Reversed
Transactions

If transactions have been reversed for an account, they will be included in the
statement if you select this option.

Financial Groups

•

All: Print statements for all Financial Groups.

•

None: No Finanical Groups selected.

•

Financial Groups Drop-Down List: To select specific Financial Groups, click
the drop-down button and check the box for each Financial Group to be used.

Note: To print most groups but selectively exclude one or a few groups, click All to
check all groups (this is actually the default), then use the drop-down list to clear the
check box for the groups to be excluded.
Include Deceased
Guarantors

Select this option to check the guarantor account status.

Include Inactive Patients

Select this option to check the patient account status.

Filter by Facility

Check this box to print statements for a specific facility selected in the drop-down list
below the checkbox. Clear this option to print statements for all facilities.

Facility

To print statements for a specific facility, select the appropriate facility name(s) from
this drop-down list.

All Patients Assigned to
Guarantor

Check this box to combine all patients listed for a guarantor on a single statement
(that is, family billing) or clear this box to send separate statements for each family
member.

Invoice With This Case
Only

To print statements for all cases, select this option. To select a specific case for the
statement, clear this checkbox.

Last Statement On or
Before

Use this option to select the date statements were last printed. This prevents
guarantors from receiving multiple statements within a billing period.

Invoice Dates

The default value for this option is to print statements for all invoice dates. Clear this
checkbox to print statements for invoices that fall within a specific date range.
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Printed Statement Date

This option defaults to the current date. To print a different statement date, use the
drop-down button to select a date.

Comment

Type a general comment in this field if you want to print a message or notice at the
bottom of each statement (not required).

Addresses and Notices
Tab
Billing Address

Check this box to print the facility address listed below the checkbox on the
statements.

Name, Address, City, State
and Zip

If the Billing Address option is selected, you can print the information that appears
in these fields, or you can enter and save different information to print on all
statements from that point on. Note that you must have Administrator authority to
change the address information on this tab.

Make Checks Payable To

Type the name of the facility that guarantors should enter on their checks.

Positioning

These numbers control how the Billing, Guarantor, and Tear Line format for printing.
This allows addresses to be aligned when using windowed envelopes.

Dunning Messages
st

Check this box to include dunning messages from the Dunning Messages section.
th

1 statement through 4
statement (and Additional
statements)

Type the appropriate dunning messages for these time intervals of statements.
Keep in mind these are not aging dunning messages, but rather are based on how
many times the guarantor has received a statement for the associated invoice(s).

Payment Entry
Payment entry can be done in a number of ways. Users have the ability to take prepayments before
charges are entered and then apply them later, post payments at checkout, and also post insurance and
patient payments later on.
Payments must be distributed to specific line item charges (CPT and HCPCS codes). There are a
number of utilities that allow this to be done automatically, and you can also distribute manually.
The system calculates the patient and insurance due amounts on CPT’s using the patient’s primary
insurance group setup as well as fee schedules. For example, the insurance group includes any fixed
office copayment and/or patient percentage due. Fee schedules can also be set up in such a way that
certain charges may not require a copayment, or they might be capitated. Every payment is sourced from
either the patient or the insurance and can only be applied to the respective balances for each.
A very important point to note with payments is that you must create a payment source for every
payment. The source is simply how the payment was received and the total amount. For example, a
payment source can be check in the amount of $100.00. Only after the source has been saved can it be
posted to specific invoices. Source setup and payment posting are really the same process though. You
have to enter data in multiple places. The source system has a number of benefits including the ability to
post the source out to more than one invoice so you need to re-enter redundant information. When a pre
payment is posted to charges, the system automatically generates a patient source for this too.
Importantly, the financial reports focus on the actual payment itself, not the source amount since if you
have not applied the source. Thus, you must post the source amount to reflect it on activity reports.
This section of the user guide will describe how to post:
•

Prepayments and apply them to charges later on.

•

Copayments at check out/charge entry.

•

Insurance payments.

•

Patient payments.
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Pre Payments (Copay and Other)
Pre payments are payments posted before the charges they will apply to be entered. The best example
of a prepayment is a fixed insurance copay taken at check in which will later be applied to the primary
CPT/E&M code on the invoice generated as a result of the clinical encounter. Pre payments can be
posted in the Schedule check in module as well as from the posting ledger window in Bill.
A pre payment can be applied to more than one patient balance. You can use an automatic post function
to post to a patient balance on one invoice at a time, and can also set it to apply to multiple balances.
There are several advantages to using the pre payments function.
•

You can print a receipt for the patient at check in. This saves the time it takes to hand write one
and is generally a much more professional looking print out.

•

The pre payment report can be used to reconcile prepayments that have not been applied to
invoices.

•

Once a pre payment is in the system, the record cannot be deleted so this can also reduce
embezzlement because it acts as an ineditable audit function too.

It is extremely important to note that pre payments do NOT show up on the Till Reconciliation, Activity or
other financial reports. Only prepayments (all or part) that are applied will appear in those so when you
cash out at the end of the day, if there are unposted pre payments you should also factor the total of
those into your bank deposit. The prepayment report will include a summary of posted vs. unposted
monies for staff to reference as a “clean up” list.
The Pre Payments window used to both enter and track pre payments contains valuable information for
users. It is accessed using all of the entry and posting steps described below.
Select Patient Pre
Payment Options
Toolbar Buttons

The buttons at the top of the window include:
•

New: Used to create a new pre pay.

•

Edit: Used to edit an existing record.

•

Post: Posts the selected pre payment to a selected invoice.

•

Delete: Deletes a pre payment if it has not been posted.

•

Receipt: Prints a receipt for the selected record.

•

Report: A way to print the Pre Payment report which is also available under the
Reports menu.

•

Exit: Closes the window.

Facility

Users can collect pre payments for multiple facilites through the pre payment
window by checkig Show All, or you can filter to only show monies collected in a
particular location.

Patient Primary Insurance
Information

The insurance name, deductible amount, copay amount, and percent insurance and
patient are displayed to assist you with determining the amount.
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Pre Payment History

Distribution Detail

A list of all the prior pre payments for the patient. Columns displayed are:
•

Create Date: The date and time that the pre payment was initially entered.

•

Payment: Amount of the pre pay.

•

Type: How the payment was made using your payment type codes, e.g. CASH,
CHCK.

•

Adjustment: Amount of any adjustments on the pre pay.

•

Balance: Current balance on the pre payment.

•

Check No: Check or credit card number.

•

Classification: Informational type (copay, patient payment or deposit).

•

Posted?: Indicates if the pre pay has been posted to invoices. When set to
NO, no part of the pre pay has been applied to charges. When set to PART,
some of it has, and when set to YES, the pre pay balance is 0.00.

•

User: The user who originally created the pre pay and under whose name it
appears in the pre pay report.

•

Date: Date of first post to an invoice. This column is being discontinued in
future because of detail in lower half of window.

The bottom section of the window shows how the record selected in the top half has
been posted out. Each invoice to which parts of the pre pay have been moved as
well as the invoice patient name, when it was posted, the payment and adjustment
amounts and who applied it are shown.

To enter a pre payment:
1. Load the patient in the Posting window, or open the Check In module in Schedule (assuming that
the Collect Prepayment check in task has been enabled), or open the Daily Work List so that you
can see the patient.
2. From the posting window, click the Pre Payment button (Alt+Y). From the Check In module,
select the Collect Prepayment check in task and click the Prepayment button. From the Daily
Work List, double-click the C/P cell for the patient appointment. The Select Patient PrePayment
window described above appears.
3. Click New (Alt+N).
4. Enter pre payment information. The Date Posted is set to the current date by default. The
classification is for information purposes. If it is set to Copay and you tab to the Payment field the
system automatically replaces the default 0.00 amount with the copay it expects based on the
primary insurance group setup.
5. Click Save (Alt+S). The payment will appear in the table. If the prepayment does not match the
primary insurance copay a notification prompt appears if the payment type is a copayment. You
can continue without needing to change this – it is just a warning to check for a possible typing
error.
6. Click Receipt (Alt+T) and print a receipt for the patient.
7. Click Exit (Alt+X).
Note: Nothing posted in the Prepayment window will appear in the Till Reconciliation or Activity Analysis
reports which are your key “cash out” reporting tools (although there are some reports that will show
unapplied amounts). It is simply a holding area so you can collect monies up front when charges are not
yet known. For this reason, you post patient deposits here, but create a deposit invoice. Be sure to
reconcile all advance copayments to invoices before running these reports. The pre payment report
shows all posted and unposted prepays. You can print a patient schedule from e-MDs Schedule, a
superbill audit, or an activity analysis to find all patients for the day.
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Posting a Prepayment to Invoice Charges
Once the charges for the patient have been entered, you can apply a pre payment to them. When a pre
pay is applied, the system satisfies patient due balances in a specified order, regardless of how the pre
pay was set up. The amount is first applied to any fixed copay amount due on the primary CPT, then to
patient % due balances and finally to other patient due amounts. If there is no insurance on the invoice,
that too is treated like a normal patient due amount.
Thus, it does not matter whether there is a fixed copayment on the primary CPT, or percentage amounts
for each CPT, or even a combination (which is rare). The system will post the pre payment to all the
patient due balances until the prepayment balance is 0.00. If the pre pay amount is greater than the
balance, a partial payment is created and the pre pay can be applied to different invoices. In the event
that you try to post a pre pay balance to an invoice that does not have a patient due balance, a warning
message notifies you of this fact. If you still continue, the system applies the entire balance of the pre pay
to the primary CPT on the invoice since it does not know how to distribute it.
When a pre pay is posted to charges, the system automatically creates a payment source record using
the same post date (which is key for matching when reconciling cash which might be applied on different
dates to when it was actually collected). The source record is linked to the pre pay too so that from that
point forward, you can reference a history of how the pre pay was applied through both the Patient Pre
Payment window as well as through the patient Payment Source window. If you open the payment in edit
mode, you will also see that the Source Type radio button is set to Patient. The Pre Payment option is
really only a utility that lets you use a pre payment as a source for patient payments.
There are several ways to post a pre payment to an invoice and depending on where you are working;
you will receive a notification that there are unposted pre payments for the patient.

To post a pre payment to invoice charges:
•

From the Posting > Ledger window: The label on the Pre Payment button in the lower half
turns bold red if the selected patient has unposted prepayments.
1. After saving the invoice, click the Pre Payment button (Alt+Y).
2. Select the pre payment record.
3. Click Post.

•

From the Charges & Payments window:
1. After entering charges, go to the Payments tab by clicking it or using Ctrl+Tab.
2. Click the Prepayment Source Type radio button.
4. Click Get and select the pre payment.
5. Distribute the pre payment manually using the Dist button (Alt+I), or use the
automatic FIFO, LIFO or Prorate functions.

•

From the Daily Work List: After an invoice has been created for an appointment, the C/P
column shows the primary insurance fixed copay amount. If the number is red it means that a pre
payment has been taken but not applied yet. If it’s green, it has been applied, and if it’s black, no
pre payment exists for the patient.

•

Double-click the C/P cell (you can also select it using arrow keys and hit enter):
1. Select the pre payment.
2. Click Post.

Deleting a Pre Payment
A pre payment can be deleted if it was entered in error. However, deleted pre payments are only
removed for the patient. A record of these can still be printed using the Pre Payment report which acts as
an audit trail so that users cannot simply remove them without tracking.
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A pre pay can only be deleted if it has not been applied to any charges.

To delete a pre payment:
1. Load the patient into the posting window.
2. Open the Patient Pre Payment window (Alt+Y).
3. Select the pre pay.
4. Click Delete.

To print a pre payment audit report:
1. From within the Patient Pre Payment window, click Report (Alt+R).
2. Make filter selections then click Print or Preview.

Posting Payments at Check Out
If you take a copayment at check in using the pre payment tool, it is very easy to post it or other payments
at check out. If you did take a pre payment and want to know how to apply it to charges, refer to the
previous section.

To post a payment at checkout:
1. Enter the charges.
2. Review the P-Due column in the CPT grid. This shows any patient due amounts by CPT.
3. Before saving, click the Payments tab in the Charges & Payments window (use Ctrl+Tab to move
to the tab using the keyboard).
4. Make sure the Source Type is set to Patient (if you are applying a pre pay, see the previous
section).
5. Enter payment source information. Use the tab key to move between fields:
a. Enter the Check No/Credit Card No, if applicable.
b. Enter the Source Amount.
c. Select a payment Type.
Click Save Source (Alt+A). If you want to scan a check, use the Scan Check button.
Click FIFO, LIFO or Prorate to automatically distribute the source to the P-Due balances which can be
seen in the distribution grid. You can also distribute manually using the Dist (Alt+I) button and typing the
amounts directly into the Payment cells for the CPTs.
Save the invoice.

Posting Insurance Batch Payments
The manual insurance payment posting process is typically based on an EOB received from the payor.
Most EOB’s are sorted by patient last name and depending on how you choose to file claims, the number
that the EOB indicates as the patient account number could be this or the invoice number. (We
recommend using the invoice number on claims because it’s quicker to load the patient and select the
invoice into the posting window using this versus searching for the patient and then selecting the invoice.)
There are a number of utilities built into the payment posting process that are designed to expedite this
keystroke-intensive process and also to help you keep track of the payments for historical purposes. The
system also forces every payment to be distributed so that you can get accurate line-item reimbursement
analysis and also to take advantage of system alerts for underpayments. Further functionality includes
the ability to easily re-flag line items or an entire to file to insurance again in the event that they are
denied or omitted in the EOB.
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Note: The legend window in the Payments screen provides a number of tips on how to post rapidly into
the distribution grid using the keyboard. We strongly recommend that you are familiar with how to use the
keyboard/number pad since it will make you significantly more productive.
The following instructions assume that you have the EOB available and are posting it without scanning it.
(See below for a method of entering sources and scanning EOB’s for later on-screen posting.) The first
payment entered for an EOB check that has multiple claims is also the one where you will set up a source
which will be used for all of the payments so it does not have to be entered multiple times. The steps
show how to use that for the next payment.

To batch post an insurance payment:
1. Open the posting window (Alt+P, L). If it is already open, it’s always a good idea to click Clear
All (Alt+L) prior to starting a new EOB so that any prior searches are removed from the system’s
memory cache.
2. Using the EOB, select the first claim being paid. There are several ways to do this. With each,
you may get warning messages if the patient alert is set, or if there is a billing block.
a. If you send invoice numbers in the account number fields on claims, enter the number
on the EOB into the Invoice # field and immediately hit the Enter key. This loads the
patient and selects the invoice automatically. You have to search for the patient first.
b. If you send patient account numbers on claims, enter the account number on the EOB
into the Account # field and hit enter. Then select the invoice by matching to the EOB
date of service, etc.
c. Search for the patient by entering some, or all, of the last name followed by a comma
and some or all of the first name. Hit the Enter key to load the Find Patient window
and select the correct record. Then select the invoice. This method is the slowest.
d. If the insurance company prints the electronic claim batch number on the EOB, click
the Use Date Range option. Then set a date range that includes the claims (it’s
easiest to just set the year in the From field back a bit). Enter the number in the Claim
Batch # field and click Retrieve. Then, because most EOBs are sorted in patient
alphabetical order, click the Patient column heading – you will just be able to cycle
through the list.
Click Insurance Payment (Alt+S). The Charges & Payments window opens to the Payment tab and also
shows CPTs with an open balance.
Set up the source information in the darker gray area. All payments require a source.
The Source Type will be Insurance because you started an insurance payment.
The Insurance Name field is set to the last insurance with a filed status on the claim. If there is
no file status, it is set to the primary. You can set it to another insurance on the invoice if
necessary.
Payment & Adjustment Types: If the insurance company is linked to a contract which automatic
adjustment options set up, the type fields for payments and adjustments are defaulted to that
preference. They can still be changed.
Enter the Check No.
Enter the Source Amount. This is the total amount of the check/EFT, not the amount being applied to
this specific claim.
Enter the Check Date.
Review the information and click Save Source (Alt+A). At this point, you could also scan the EOB or
Check.
Verify that the Date Posted is set correctly. This should match your deposit date. The system sets the
date automatically to whatever the Default Date batching utility at the top of the window is set to by the
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user and retains it for subsequent postings until the session is ended or the date is changed manually.
This is a critical setting since all payments appear in reports under this date.
Click Dist (Alt+I). The distribution grid refreshes to show all the CPT’s including those with 0.00
balances. In the grid you will see the current insurance due balance in the I-Due column. The active cell
is the Payment one for the first CPT.
Enter the payments and adjustments by typing. Depending on the cell, it will only accept certain
characters. Using the keyboard, particularly the number pad is strongly encouraged. The legend in the
payments tab describes how to do this in detail. The key to remember is that hitting the Enter key after
entering data in a cell moves the cursor right one cell. Hitting it again without entering data moves it to
the first cell (Payment) of the next line. You can also use the arrow keys to move between cells unless
it’s a list box where up & down scroll the list. For most payments it’s a case of payment amount, enter,
adjustment amount, enter, reason code, enter and then enter again to start the next line. If you have
finished entering the core payment information but want to set another field such as the comment, refile,
or due by without going to the next line, use the arrow keys to navigate to the right, then enter, enter after
making the setting.
See the "Payments and Adjustments Options" table for more information.
Note the Fee Schedule Alert button when you are still on a line item. If the label turns bold and red, it
means that the sum of the payment and patient due amounts (copay or %) is not equal to the allowed fee
for the code (an allowed fee schedule must be linked to the insurance). Click the button to review the fee.
If you have the appropriate security privilege, you can update the fee schedule from this window.
If necessary, enter a Statement Comment using free text or using the Find button to load a standardized
message set up in the Comments table. This will print on a statement for the patient and is unique to this
claim. An example of use is telling patients that a balance is part of their annual deductible.
Click Save (Alt+S). If the EOB only paid off one claim, you are finished. Otherwise, continue for
additional payments.
Search for and select the next claim.
Click Insurance Payment (Alt+S).
Click Last (Alt+T) to load the last source. The source information appears with the Source Balance
updated to reflect the remaining amount. You have to re-enter all the source information.
Click Dist (Alt+I) and post the payments and adjustments. If all the I-Due amounts match the EOB
payments, you can use the FIFO function to set the Payment amount for each CPT.
Click Save (Alt+S).
Repeat steps 15 to 19 for all subsequent payments on the EOB. The source balance should be 0.00 after
you have finished. If not, it’s likely a typing error. You can quickly see a list of the payments and
compare to the EOB by clicking the Get button to access the Payment Source search window which
shows the invoice distribution summary, another advantage of posting by linked source check.
Note: You can also enter source payments without loading a patient. The source can be posted later on
and is a good way to do EOB scans. Do this under Posting > Payment Source. That is also a good
check search window.
Payments and
Adjustments Options
Payment

Type in the amount and hit enter. The cursor will move right one cell. The amount
can be set to the balance using the Pmt.Bal (Alt+B) button.

Adj1

If it has not already been filled out based on the contract setup, enter the amount
and hit Enter. The cursor moves right again. The amount can be set to the balance
using the Adj1 Diff button.
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Reason Code

If it has not already been filled out based on the contract setup, select a reason code
using the arrow keys, or by typing the characters and press Enter. The cursor
moves right one cell. For most insurance payments, this is where you will move to
the next CPT by hitting Enter twice. To see the reason code description, click the
RC Desc button when on the CPT line.

Adj2

Enter a second adjustment for the line. This is often where a withhold might be set
and saves having to create two payments for the same purpose.

D

This is the Due By status of the invoice. The value can be I or P. If it is changed for
one CPT, then all the codes are updated and is the same function as the ones
accessed by right-clicking an invoice in the posting window or using the Balance
Due By in the Charges tab. If this insurance is the last one on the claim and any
residual is due from the patient, setting the field to P will transfer the remaining
balance when the payment is saved.

Comment

Free text field that can be used to enter internal comments. These cannot print on
any reports.

FS

The File Status which can be set to reflag a specific line item. To reflag an entire
claim, it might be easier to edit the insurance at top right which will ask to reflag all
lines. Note that when you generate claims, you must set filters to pull the flagged
items. If you reflag the invoice insurance, you must set filters for filed insurance with
reflagged/unfiled line items, or you can set the invoice insurance too without flagging
all lines and filter accordingly.

Status

If necessary, set a status code for rejected, omitted, downgraded, short and long
payment. Usually not entered.

OthRC, OthGC and OthAdj

These “other” reason code, group code and actual adjustment amount fields are
used to report payor adjustments that are still on your receivable balance, but which
you have to report to a secondary payor. Depending on the payor if they are not
filled out you may have problems recouping all the money, or get claim denials, or
have to spend time doing your own recoupment’s. It is just an unfortunate data
entry burden that Medicare started requiring in 2006… No amounts entered in
these fields are used for any production reporting – they are “info only” for reporting
on additional claims, often for PR (Patient Responsibility) adjustments.

RevCode

Displays a revenue code associated with the CPT if applicable. This may be
required if posting an institutional claim payment that is paid by revenue code.

Patient/Guarantor Payments
This section refers to posting patient payments that are not covered under the pre pay system described
previously although you can use either method for any payment type. The assumption here is that you
are receiving payment for entered charges which might have been mailed to the clinic. Of course, this is
almost the same method as used when posting payments during check out, etc.
In many cases patient payments are posted to one specific invoice. However, the system also supports
automatic posting to more than one encounter and to different patients so that you need to load the
invoices individually. Each method is described separately.
Note that the system still forces you to distribute payments to line items even though it only takes a click.
Note: Refer to the legend in the Payment tab for tips on posting rapidly using the keyboard.

To post a patient payment to an individual invoice:
1. Go to Posting > Ledger (Alt+P, L).
2. Select the first invoice being paid. If you received the statement tear section with the payment,
enter the invoice # to rapidly load the patient with the appropriate invoice selected. Otherwise,
use the Account Number or Patient name searches and then click on the invoice.
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3. Click Patient Payment (Alt+A). The Charges & Payments window opens to the Payment tab.
4. Set up the Payment Source in the dark gray area of the window. All payments must have a
source.
○ Source Type: Verify that the Source Type is set to Patient.
○ Payment Classification. This is really only for internal reference since the system
automatically allots payments to fixed copay balances first, and then other payments.
○ Check No/Credit Card No: Enter as needed.
○ Source Amount: The total amount on the check.
○ Payment Type: Select from your internal payment types.
○ Adjustment Types: If adjustments or discounts will be applied, select from your internal
types.
Click Save Source (Alt+A) to save the source.
If desired, you can scan the check at this point or at any other time.
Verify that the Date Posted is set correctly. This should match your deposit date. The system sets the
date automatically to whatever the Default Date batching utility at the top of the window is set to by the
user and retains it for subsequent postings until the session is ended or the date is changed manually.
This is a critical setting since all payments appear in reports under this date.
Distribute the payment. You can do this manually or using the automated functions. Note that even if
you use the automatic functions, you can still make changes to any of the fields once the amounts are
applied:
○ Dist (Alt+I): This is used for manual posting and is the last option recommended for patient
payments since the automatic functions are much faster. The Payment cell for the first line
item is highlighted so you can start posting. Refer to the legend and the help on insurance
payments for more information about manual distribution.
○ FIFO (F2) & LIFO (F3): When posting to a single invoice, the First In, First Out and Last In,
First Out functions are the same. They automatically distribute the source to the P-Due
balances for each CPT from the first CPT downwards until the source balance is exhausted. If
the source is greater than or equal to the sum of the P-Due balances, it satisfies each and a
balance remains on the source.
○ Prorate (F4): The Prorate function is very useful when the source balance is less than the
sum of the P-Due amounts because it allocates a proportionate amount to each CPT. This is
good for CPT reimbursement analysis since if one always posts top down using the manual
Dist or FIFO/LIFO functions, it will skew reimbursement towards the first codes on invoices
which are typically E&Ms whereas a more accurate picture is that some of each code is
getting reimbursed.
Enter a Statement Comment if necessary using text or by looking up a standardized message from the
Comments table. This prints on subsequent statements to the patient.
Click Save (Alt+S).

Posting a Patient/Guarantor Payment to Multiple Invoices
Many times a guarantor may send a payment that is satisfying more than one invoice balance. One
example of this is a head of family paying for multiple family members’ balances. Another is when a clinic
contracts with a corporation to do occupational health (workers comp, corporate physicals, drug screens,
etc.) and bills the company on a monthly basis.
Much like an insurance EOB can be set up once and walked out to multiple invoices; patient payments
can be done in exactly the same way. However, there is a special function that lets you select multiple
invoices at one time and then, with a single click of a button, distribute a source payment balance to all
open line items on those invoices so you have to load one invoice after another.
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This is, of course, dependant upon receiving the tear slip for a statement with the payment so you know
where to apply the payments, but a built in posting window function assists with this.

To post a patient/guarantor payment in multiple invoices:
1. Load any of the patients into the Posting ledger window.
2. Select the invoices by clicking the first, then holding down Ctrl and clicking the other invoices.
There are several ways to do refine the view so that the invoices you need are easier to see and
select:
○ Show Guarantor Invoices: If the check is being posted to invoices for different patients with
the same guarantor, select the first, then click the Show Guarantor Invoices option in the
middle of the posting window. This loads all other invoices for the same guarantor. (The
guarantor name is listed in one of the columns to the right in the invoices section.)
○ Zero(0) Balance: When this box is unchecked, only invoices with a non-0.00 balance appear.
○ Column Sorting: Clicking on the column headings to sort ascending or descending can be
useful. For example, you might want to sort by reverse date of service (DOS) order to post
the payment to the oldest balances, or you may wish to sort by P-Due balance.
3. Click Patient Payment (Alt+A). The Charges & Payments window opens to the Payment tab.
The distribution grid is populated with the CPTs from all the invoices you selected, not just the
first one. You can show only the CPT’s for the first invoice number (displayed at top left of the
window) by un-checking the Show all open items box.
4. Enter the source information in the dark gray area. See the previous section for detail.
5. Verify that the Date Posted is correct. It should match your deposit date.
6. Distribute the source balance. Although you can use the Dist function to enter the amounts
manually, the automated functions are much faster. These automatically apply the source
balance to the CPT’s until the balance is exhausted or there are not more P-Due balances for the
selected codes. Note that even if you use the automatic functions, you can still make changes to
any of the fields once the amounts are applied:
○ FIFO (F2): First In, First Out is recommended. It posts to the oldest invoice first to ensure that
you get invoices with balances that are so old that they are hard to collect. Within each of the
invoices, it posts from the top down. Also invoked using the F2 function button.
○ LIFO (F3): Last In, First Out is not recommended because if payment source balances are
less than the due balances, certain invoices and codes will not be paid off so they will get
older and older and harder to collect. Also invoked using the F3 function button.
○ Prorate (F4): This is a recommended method when you plan to write off the remaining
balances of invoices since you will be able to reflect some payments against all of the CPT’s
thus helping with statistical analysis of reimbursement against codes. If you use this and
adjust of the remainder, the last CPT’s will always get the most adjustments so it will appear
as if they first codes on invoices (which are often E&M’s) are much better paid than others.
Also invoked using the F4 function button.
7. Enter a Statement Comment, if needed.
8. Click Save (Alt+S).

Reversing Transactions
Reversals provide the ability to reverse a misposted transaction and add a new one to cover both sides of
the accounting transaction. This will create a standardized transaction and ensure that reversed
transactions are not included in future claims and statements. A reversal will not affect financials in a
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closed period since those have already been reported for accounting purposes and cannot be changed.
Reversals apply to both payments and charges.

Security Privileges for Reversals
The Billing Reverse Transactions privilege controls access to the reversal functionality. This privilege is
part of the All Privileges (RWD), Billing Administrator (RWD), and Billing Supervisor (R) security groups.
Security: The security privilege to control access to the Charge Reversals.
•

Privilege not assigned, or set to Deny: The button is not visible.

•

Read: The button is available but only when in “Reverse Properties Mode.”

•

Read/Write, Read/Write/Delete: The button is available.

Charge Reversals
The reversals process provides the ability to replace a code which is later deemed to be incorrect without
affecting any closed period data. As part of the reversals process, there is the ability to reverse payments
and associate any payments and adjustments made against a reversed code to the new code.
•

Effect of Charge Reversal: A charge reversal will effectively remove the charge from sight in
the invoice CPT grid. The system will also post a debit using the post date. It will also add the
new code to the invoice. From an accounting and reporting standpoint, each transaction will still
be considered for all reports. The reversed transactions as well as the other side of the double
entry will still be a part of almost all reports except for statement printing and claims. When a
CPT code is reversed that already had a payment distributed, the system will allow the code to be
reversed but the money distributed will become unlinked. Once unlinked, you must reverse and
redistribute to a new CPT code

•

Invoice Charges and Balances Tools: Tools > Update Invoice Charges and Tools > Update
Invoice Balances functions both accommodate all reversal transactions. This can be done by
manually editing charge elements for the codes and then running the tools, verifying that
balances are updated accordingly to reflect the correct amounts.

To reverse a charge:
1. In Bill, click the Posting button.
2. Select a patient and open an invoice.
3. In the Bill Charges & Payments window, click the Charges tab.
4. On the Charges tab, click the Reverse Charge button above the CPT grid.

5. When opening the Reverse Charge window, all screen values are populated with the original CPT
values. Follow Steps 1-3 listed in the window.
○ In Step 1, verify that the code you have selected for reversal is correct, or select a different
code if necessary.
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○ In Step 2, if you will be reversing another CPT code, you have the option to enter or search for
a replacement CPT or HCPCS code. Pressing the Enter key on your keyboard will repopulate
the Modifiers, ICD, and Fee fields with new values.

○ In Step 3, users will need to create Reversal Comments. To add a new comment, click the
magnifying glass. This will open the Comment window.

In the Comment window, click New. Enter a Comment Group “REVS” and a Comment such as “Wrong
CPT Code Charged,” or “CPT Code Required a Modifier” and click Save. The code will now be an option
to Select in the future.
Click Exit to return to the Reverse Charge window.
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In Step 3 under Payment Distribution Summary, you must select Apply, Unlink, or Apply to different
code option before you can save the reverse.

Note: When a CPT code is reversed that already had a payment distributed, the money
distributed will become unlinked. Once unlinked, you must reverse and redistribute to a new CPT
code.

After completing Steps 1-3 in the Reverse Charge window, click Save.
In the Information pop-up window, “Are you sure you want to continue with this reversal?” Click Yes.

In the Bill Charges and Payments window, the newly added code will now show with a current
post date.
To show the Reversed code, right-click the invoice and select Show Reversed Transactions.
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The Invoice grid will now show the Reversed transaction in red.
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Payment and Adjustment Reversals
Payment and adjustment reversals are intended primarily for users to be able to account for mistaken
transactions that have occurred in a now closed accounting period. Much like a charge reversal, the
system will allow a user to select a specific record and apply a reverse to it. The payment and any
adjustments associated with a selected distribution line will be reversed. This is different from the
functionality of charge reversals where the user simply changes out the CPT code.

To reverse a payment or adjustment:
1. In Bill, click the Posting button.
2. Open a patient in the Posting window.
3. Under Payments, highlight the payment to be reversed and click the Reverse
Payment/Adjustment button.

In the Reverse Payment and Adjustment window, follow Steps 1-4 listed in the window.

Note: In Step 4, there must be an entry in the Comment field or an Error box will pop up. For
details on creating comments, see the following steps in this document.

As part of Step 4 in the Reverse Payment and Adjustment window, the user will need to create
comments for reversed payments and adjustments. To add a new comment, click the magnifying glass.
This will open the Comment window.
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In the Comment window, click New. Enter a Comment Group “REVS” and a Comment such as “Payment
Posted to Wrong Patient” and click Save. The code will now be an option to Select in the future.
Click Exit to return to the Reverse Charge window.

After completing Steps 1-4 in the Reverse Charge window, click Save.
In the Information pop-up window, “Are you sure you want to continue with this reversal?” Click Yes.

The reversed payment will now be shown under Payments in the Bill Charges and Payments window.

Deleting Payments
If you make a mistake and have the appropriate security privilege, you can delete individual distribution
records in a payment, or an entire payment. Note that the deletes are tracked in the audit reports.

To delete a distribution record:
1. Search for and select the payment in the Posting ledger window.
Click Edit Payment.
Select the specific CPT that you want to delete from the distribution grid.
Click the Delete button above the grid.
Click Yes in the verification prompt.

To delete an entire payment:
1. Search for and select the payment in the Posting ledger window.
2. Click Delete Payment.
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3. Click Yes in the verification prompt.

Posting Closeouts
Posting closeout functionality includes batch reversals and restricted editing capabilities in invoices,
reports, and audit trails related to a hard close. A hard close is defined as one that prevents users from
editing any transaction in a closed period.

Important! See the important notice in the Release Notes regarding the special requirements for
installing Solution Series 6.31.0 and implementing the hard close functionality. Do not proceed with
installing the upgrade and using this new functionality until you understand all potential impact to your
system.
The posting closeout functionality in e-MDs Solution Series allows you to close a financial period up to
and including a specific date and to select the facilities to which the hard close applies. When you apply
the hard close, changes which could affect the financial reporting for the defined period are restricted.
Once a period is closed, it cannot be reopened again, so any changes to charges or payments that occur
in a closed period must be handled by reversals. It is strongly recommended that closeouts are done as
an end of day task, when users have logged out for the day and are no longer creating invoices.
•

Impact on Filing Secondary Claim: If the allowed amount in the Fee Schedule is incorrect at the
time the invoice is created, it would be necessary to reverse the charge to change the allowed
amount in order to file a secondary claim. With the ability to close a financial period, maintaining your
allowed fee schedules becomes more important than ever!

Note: All posting closeout changes are written to an audit trail. The Posting Closeout Audit
Crystal Report tracks user activity related to changes to the posting closeout settings, including
activating/deactivating the closeout, closeout date ranges, exception dates, and the facilities to
which the settings are applied.
•

Security: The security privilege to control access to the Posting Closeout Options window is Billing
Posting Closeout:
○ Read: Allows users access to the window but all fields are grayed out.
○ Read/Write, or Read/Write/Delete: Allows users to enter information in the window that will
affect the closeout functionality.
○ No privilege, or Deny: Users cannot access the window. The Closeout Options menu
heading is grayed out.

Important! There are two update tools that have the potential to change balances. At the time of
closeout, the assumption is that users will run reports based on the information in the closed period.
Although the system updates balances using triggers and other mechanisms when charges and
payments/adjustments are applied, these update tools should be run in case there are some data
discrepancies. Before closing the financial period, select Tools and run the following utilities:
•

Update Invoice Balances

•

Update Invoice Charges.

To close a financial period:
1. In e-MDs Bill, click Posting > Closeout Options to access the Posting Closeout Options window.
2. In the Close all dates up to and including box, type in a date or click the DOWN ARROW to select
a date on the calendar.
3. Under Facilities, select the facility or multiple facilities to which the closeout is to be applied.
Upon clicking Save, you will not be able to change or add any transactions with a post date up to
and including the date specified. All posting closeout changes will be written to an audit trail.
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4. In the Bill Posting Closeout Confirmation window, verify the date and facility specified and click
Confirm.

When you implement a hard close, you should be aware of how various line-item charges are affected.
The following provides an overview of that processing:
•

Invoice CPT Post Date: The Posted date at the CPT level is used for reporting.

•

Date Setting When Posting Charges for a New Invoice: When a new CPT or HCPCS code is
added by generating an invoice from a Chart visit or by entering codes manually into the CPT/HCPCS
field, the line item post date is automatically set to the Post Date on the invoice.
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•

Date Setting When Posting Charges for a Closed Invoice: When charges are entered in an
invoice that is already closed, the line item post date is automatically set to the Default Date setting
for the user.

•

Batch Number Setting When Posting Charges:
○ Batch Number Setting on a New Invoice: When a new CPT or HCPCS code is added to an
invoice by generating an invoice from a Chart visit or by entering codes manually into the
CPT/HCPCS field, the line item batch number is automatically set to the batch number on the
invoice.


If the batch number on the last invoice is Inactive, the posting batch number on the new
invoice defaults to NONE.



If the batch number on the last invoice is Active, the posting batch number on the new
invoice defaults to the posting batch number from the last invoice.



If the batch number on the last invoice is NONE, the posting batch number on the new
invoice defaults to NONE.



When you make a copy of the invoice, the batch number on the new invoice defaults to
NONE.
If an existing Active batch number is made Inactive, that batch number will remain
unaffected on existing invoice, but it will not be available in the Posting Batch drop-down
list for new invoices.



○ Batch Number Setting on a Closed Invoice: When charges are entered in an invoice that is
already closed, the batch number is automatically set to the batch number currently in use, not
the original invoice batch number. You cannot change the line item batch number by editing
the invoice level batch number.
○ Edit Unclosed Invoice: If you change an unclosed invoice and change the invoice level
batch number, this can affect the line item batch number. Please note, if you change the line
item batch number, you may alter totals on reports that are run based on the batch number.

Electronic Remittance Advice
See page 255.

Posting a Deposit
A deposit that will be applied to future charges can be posted to an invoice. Because the payment will be
deposited in your bank account and therefore should be reflected on all activity and till reconciliation
reports, you simply enter a payment source or pre payment because those are not tracked on these
reports.
You must create a custom CPT code against which the deposit will be posted. Then when the deposit is
posted against this, you will be able to move the credit to other invoices as charges are incurred.

To create a deposit custom CPT:
1. Go to Reference > CPT Search.
2. Click Outline.
3. Expand the AAAA-ZZZZ Unofficial / Custom Codes branch in the tree.
4. Right-click the X0000-ZZZZZ Custom Billing Codes Folder (if you have created sub-categories,
you may want to branch out to one of those and right-click it instead).
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5. Click Add a CPT.
6. Enter a code and description. The code must be within the category folder range (that is, start
with X, Y or Z). For example, you might want to use ZDPST.
7. Press Enter to save the code.

To enter a deposit:
1. Load the patient and click New Invoice.
2. Delete any insurance on the invoice if this is a patient deposit.
3. Enter your custom deposit CPT code into the CPT/HCPCS field.
4. Enter a fee.
5. If you want, add descriptors so you know the purpose of the deposit. There are two ways:
○ Enter an invoice title, e.g. “Deposit for OB Care”.
○ Modify the CPT Description by clicking in the cell. If you do this, be aware that the description
will not necessarily appear on all reports (and it would clutter many of them if it did since
deposits can be for many reasons).
6. Click the Payment tab.
7. Enter and save the payment source information. The Source Amount value will be the total
deposit amount. Payment Classification can be set to deposit for reference purposes.
8. Click Dist. You will get a warning that there is no balance.
9. Type the amount of the deposit into the Payment cell.
10. Save the invoice. In the posting ledger window you will see the deposit invoice with the credit
balance. Credit invoices are in bold text.
Refer to "Moving Credits" for a description of how to apply the deposit to charges.

Moving Credits
The Move Credit utility is designed to expedite the movement of credits from one invoice to one or more
other invoices which may be for the same or different patients. With a few clicks two or more adjustments
with associated comments are generated. A typical example of moving credits is when a patient
overpays one invoice, but instead of sending a refund check, the practice moves it to another invoice with
an outstanding balance.
If necessary, you can manually add more information to automatically generated credits and of course
you can still create the entire transaction without using the move credit function. More advanced manual
credit and adjustment posting is covered on page 318.
It is important to stress that the Move Credit button transfers like balance to like balance. In other words,
you cannot move a patient credit balance to an insurance balance and vice versa unless you manually
change the payment type on each adjustment after using the Move Credit utility.
Credit moving is simply moving money from one invoice to another. There is no new deposit as such so
the adjustments show up on the till reconciliation report. The money is simply being moved around the
practice bank account. For example, a patient may deposit a check to cover future services. This creates
a credit balance on the account. The check will show up on the Till Reconciliation report for the day it was
posted. When you apply this credit to charges, you are moving money within the account, not adding
money to the bank.
Like all other transactions in the system, the move credit function requires amounts to be moved to
specific CPT’s so that balances.
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Setting Up the Default Move Credit Adjustment Code
Each credit requires an adjustment code. It is facility-specific. While this can be set for each transaction,
most will use the same code set up by the practice. For convenience sake you can set up a default to
speed up the process. Of course, this default can be changed for those transactions to which it does not
apply.

To set up the default move credit adjustment code:
1. Click File > Options.
2. Using the list box, select a Move Credit Default Adjustment Reason Code.
3. Click Save.
4. Repeat for each internal medical facility in your database.

To move a credit from one invoice to one or more other invoices:
1. Open the Posting window then search for and select the patient who has the credit invoice.
2. Click on the invoice in the top half of the posting window so it is highlighted, then select the
payment from which the credit/overpayment was created in the bottom half.
3. Click Move Credit. The Move Amount window appears. You can move this window to anywhere
on the screen that lets you see and work with other fields. It stays on top during this process.
4. The system automatically selects the payment highlighted in the posting window as the credit
source, using the dropdown arrow will allow you to change this source. This shows the check/cc
number and date/time it was posted. If you are not sure if this is the payment, look at the
payments for the invoice in the main posting window behind the Move Amount window. When
you select the payment source, the Payment Made By radio button is set automatically
(remember that you can only post a like payment source to a like credit balance).
5. Check that the adjustment type is correct. The default comes from the options window but can be
changed if needed.
6. In the posting window behind the Move Amount window, search for and click on the first invoice
to which the credit will be moved. If that invoice is for another patient, you can load that invoice
by doing a normal posting window search.
7. Click anywhere in the Move Amount window. You will see the CPT’s from the invoice appear on
the right side. The system shows the invoice number, code, original charge, payments &
adjustments, the current balance, and the move amount.
8. If the credit is being moved to multiple invoices, repeat steps 6 and 7. You can load as many
invoice CPT’s into the Move Amount window as you need.
9. Review the CPT’s that you have loaded into the window. Each has a checkbox in the leftmost
column and a Move Amount in the right one. Only CPT’s that have a check in the left AND a
move amount in the right will be posted to, and of course the system will only post out to the
balance of the credit regardless of how many CPT’s there are that have balances.
10. Determine which CPT’s will be credited. The quickest way to set the amounts is to click the
Calculate Total button above the list. This sets the amounts that can be applied to each CPT by
applying the credit balance from top to bottom against the CPT’s until the credit is 0.00 or there
are no more CPT’s. You can also set the amounts manually by clicking in the Move Amount cell
for a CPT and typing in the amount and hitting the Enter key.
11. Review the transactions. A summary of the amount to be moved is shown at left. When you click
the Calculate Total button, the Move Amount field to the left is recalculated to reflect changes
including the credit balance after the move.
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12. If everything is as you want it, click Accept. The system then posts the transactions including the
following information:
○ Post Date: The date you moved the credit, not the original payment date.
○ Source information: Check/cc, cash or other information is shown and a link to the original
source is created in the screens where you can view and print how a source amount has been
applied.
○ Credit Adjustment Code and amounts (total amount from and to each invoice is shown in the
posting window with the distribution detail available in the charges and payments window.
An automatically generated statement comment. On the credit invoice one adjustment is created
regardless of the number of invoices to which the credit was moved. The statement comment is
“x credit moved to invoice(s) …” with each invoice number. On each of the debit invoices you will
see “x credit moved from invoice …” with the credit invoice number.

Posting Batch Numbers
Although they are not required, the posting batch number system provides a useful method to track
posting activity by user. Many practices like to track production by user with a method other than posting
dates since those can be changed to meet other accounting requirements. All charges and payments
entered can be associated with a batch number. It provides a way to track and retrieve transactions by
user batch number.
The batch number is set using the field at the top of the Charges & Payments window. It is not, however,
invoice-specific. You can have a separate batch numbers for the charges, as well as each of the
payments made against the invoice. Opening the different payments in the Payments tab or the charges
in the Charges tab will change the number if it was different for the transactions.
The system remembers the batch number for the current user when subsequent transactions are posted
during the login session. Thus, it is important to note the number when entering transactions. It is quite
common for practices to require their users to assign a batch number on a daily basis or by work
assigned.

To create a batch number for a transaction:
1. In the Charges & Payments window, click the + sign to the right of the Posting Batch # filter.
2. Click Yes if prompted to change the batch number on the current invoice. The system creates a
new batch number and displays it in the field.

To use an existing batch number:
1. Click the list box arrow in the Posting Batch # field. A list of active batch numbers for the logged
in user appears.
2. Click the number you want. If you want a batch number, select the “NONE” option.

To activate or deactivate batch numbers:
After a batch is completed, it is a good idea to deactivate the number so that it is not used again by
mistake. You can also reactivate a batch in the event that it needs to be used again.
1. Click the search button to the right of the Posting Batch # in the Charges & Payments invoice
window. A list of active batch numbers appears.
2. If necessary, filter the list with the User Name filter. You can also show inactive users whose
batch numbers are hidden by default.
To deactivate a batch number, select it, then click the Active/InActive toggle button.
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To activate an inactive number, check the Show Inactive option to display the inactive numbers, then
select the one you want and click the Active/InActive toggle button.

To retrieve data by batch number:
1. Open the posting ledger window.
Click Clear All to be sure no prior filter settings are in memory.
Select a number from the Posting Batch # filter.
Click Retrieve. A list of invoices appears. Note that you even if charges were entered under a different
batch number, if a payment matches your search criteria, the invoice is loaded. The same applies to
payments. One invoice may have multiple different payments which were posted under different
numbers, but all will appear for the invoice.

Check Search
If you need to locate a check number for research purposes, this is easily done. As part of setting up a
payment source you can enter check, credit card number, or other information in the Check No/Credit
Card No fields in the source. You can also see how the check has been distributed and if you scanned a
copy of the check, can pull up the image. This can be very useful if you need to confirm an amount.

To search for a payment source by check number or credit card number:
1. Click Posting > Payment Source (Alt+P, S). (It is also located under Reports > Payment
Source although you cannot view the EOB or check scans from that entry point.)
2. Enter search parameters:
○ Source Type & Name: Although it’s not necessary, you can filter by either of these.
○ Insurance Class: Not currently used.
○ Assigned User: Not currently used.
○ Check Date Range: Enter a range in which the check was posted. You can also set a
Dynamic date range to find items by a time period.
○ Check No: Enter starting characters from the check number. You can also search for parts of
a number by starting the string with a % sign which is an “includes” wild card.
○ Balance Range: Self-explanatory. In tandem with the date range this is a useful way to find
any source checks which have not been fully posted.
3. Click Search. Matches appear below the search filters. Clicking a source updates the Source
Payment Detail below which shows a summary of the invoices to which the check has been
distributed thus far. If there is a check scan, the right Check button on the toolbar with the paper
and magnifying glass is available with a green button label. Click it to view the check image.
You can also search from the posting window. Load any of the patients to which you think the check was
posted. Then click Edit Payment on a payment. The Get button in the source window opens a patient or
insurance specific Payment Source window from which you can execute a search.

Printing an Invoice or Receipt
Users can print these reports at the same time as generating charges and taking copayments or at a later
date. After completing an invoice and insurance prep, the system presents a print options screen. To print
an item, ensure it is checked, then click OK. You can also specify if you wish to print ICD and CPT
information on invoices. Click Close to print nothing.
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To print an invoice at a later date, highlight the invoice in the Posting window and click the Print button.
The same window appears. Do not use this option to print a receipt at a later date. After highlighting the
specific payment for which the receipt is required, click the Print Receipt button on the payments side of
the Posting window. A Windows Print box appears from which you can select a specific printer.

Invoice/Collections Notes
Collections notes are a critical part of the collections process. They are used to document collections
activities on an invoice so that users can quickly remind themselves or other billers about what has
happened on an invoice, and what and when further action is expected. An unlimited number of
date/time and user stamped collections notes can be added to an invoice and you can copy a note to
multiple other invoices for the same guarantor. Notes give billers the ability to view a complete
chronological history of claims, statements and collections activity on a particular invoice. A report of
these can also be generated.
Invoice/Collections notes are invoice-specific. They can be accessed from anywhere that you may need
to document collections activities:
•

Invoice, Payment and Distribution windows (click the Notes button).

•

Posting window (select an invoice and click the Invoice Note button – you have to open the
invoice).

•

Collections module (Notes button).

•

Daily Work List (double-click the IS cell).

An extremely powerful part of collections notes is that users can enter customizable follow up actions
(see Follow Up Actions). These are predefined by billing administrators so that follow up dates and users
are assigned automatically. The Collections module includes filters that let users create work lists based
on follow up actions, dates and users.
Some of the follow up actions can be automated. You can have the system insert invoice notes
whenever a claim is filed or a statement is printed. The first advantage of doing this is that you can
review all activity on one screen (the invoice notes) instead of having to pull the claim File History in the
invoice insurance or patient file, or going to the guarantor file to review a statement print history (which
does not indicate the specific invoices). A second advantage is that you can also see the user who
generated the claim or statement. Finally, the follow up actions are a tickler system because the actions
are searchable fields in places like the collections module.

To enter and copy collections notes:
1. From within an invoice, payment or distribution, click the Notes button. If you are in the Posting
window, you have to open the invoice – just select it and click the Notes button. You can also
click the Notes button with the invoice highlighted in the collections module, or double-click the IS
cell in the Daily Work List.
2. Review existing notes if applicable.
3. Click New. The server date and logged in user are automatically displayed.
4. Select a follow up action from the list. If the action has a default number of follow up days or
user, the Follow Up Date and Assigned To user are automatically updated. If the follow up action
has an associated invoice status code, this will also be set.
5. If necessary, edit the Follow Up Date and Assigned To user, or invoice status code.
6. Enter up to 5,000 characters of free text. This memo window is enabled for macros (auto-fill) and
spell checking.
7. Click Save.
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8. If you want to copy this note to additional invoices for the same guarantor as is often the case
when doing collections activities on multiple outstanding tickets, click Copy with the note
highlighted. A list of all non-0.00 balance invoices for the same guarantor appears. Checking or
un-checking the Resort Invoice # box changes the order between ascending to descending.
Show Zero Balance Invoices loads those too. Check the boxes in the left column for each invoice
you want to copy the note to or use Select All, then click Accept to copy. Keep in mind that when
you copy a note with an invoice status to another invoice, it will update the status of that invoice.

To print an invoice notes history report:
1. Select the invoice (in posting, collections, daily work list).
2. Open the invoice notes window (click applicable function depending on where you are).
3. Click the Print All button for a complete history, or select a specific note, then click Selected to
print a single one.
The report includes:
•

Invoice Information: Patient, invoice #, date, DOS, financial group.

•

Invoice Insurance: Companies, group #, policy #, policyholder, status and filed dates.

•

Diagnoses: Code and description.

•

CPTs: Codes, modifiers, description, ICD linkages, units and fees.

•

Invoice Notes: Dates, create user, note, assigned to, follow up action & date.

Splitting Invoices
There are circumstances where you might need to create separate invoices out of charges that were
originally entered into one invoice. Some examples of this are where a payor might have a restriction on
the number of charges that can be submitted on an electronic claim, or you might want to put different
charges on different invoices for claims or reporting purposes. Worth noting is that if you want to split out
certain charges purely because they are not going to be filed to a payor, there is a property that can be
set for specific CPT’s in the fee schedules that will hold them out of the claim without needing to split.
The split function is CPT-based and can be done manually, or you can automate the process using
contracts. When the selected CPT’s are manually removed from the starting invoice and a new invoice is
generated for them, all other parts of the new invoice are populated automatically with the same
information as the originating one. Users may thus need to make minor modifications to one or both of
the invoices. If you use contracts to automatically split, the system may change financial group and
payors automatically so it is recommended to use this option since most splitting needs to be
standardized and automation will minimize errors, claims denials, and payment lag.
You cannot split out CPT’s that already have payments made against them.

To manually split charges into separate invoices:
1. Open the invoice in edit mode.
2. Click anywhere in the line of the first CPT that you want to split out.
3. Right-click or click the CPT/HCPCS Functions button at the bottom of the window (Alt+/).
4. Click Split. A window appears with the code listed.
5. Without closing this window, select other CPTs to split using the same method. Each will appear
in this window.
6. Verify the list. If a code was added by mistake, uncheck it by clicking the checked box to the left
of the code.
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7. Click Split.
8. Close the window. The CPTs disappear from the existing invoice.
9. If necessary, make any changes to this invoice such as removing ICDs that are not used because
they were linked to split CPTs.
10. Save this invoice. You will see the additional invoice appear in the posting ledger window.
11. If necessary, open the second invoice and make modifications.

Automatically Splitting Charges into Separate Invoices
This uses contracts. Please refer to this section in the References chapter. Briefly, this is how it works:
•

A contract must be linked to the primary insurance on the invoice.

•

In the Contract Maintenance window for that contract, there is a Misc tab under which you can define
which CPT codes will be split to another invoice. You can also define the financial group of that other
invoice. The value of the latter is very important since it can affect how the claim is filed as well as
reporting centers.

•

When a claim is saved, the system checks to see if there is a contract linked to the primary insurance
and if so, whether any of the codes in the invoices are set to split. It will then remove the codes from
the first invoice and create an additional claim with them. It will also set the financial group for the
second invoice to the one defined in the contract. If there is only one insurance on the invoice, then
that will be retained. If there is a secondary, then it is removed from the first invoice. On the second
invoice, the primary is removed and the one that was secondary on the original invoice becomes
primary. An example is that you can set up a patient with Medicare Part A and Part B carriers and
certain codes will go on a UB and other on a professional form (such as encounter vs. other codes for
RHC/FQHC billing). If there is supposed to be a secondary on these claims, then that should be
added to the patient file as a tertiary and it will move up the order to be secondary for both claims. All
other invoice information remains the same so it is possible that you might need to open the second
claim and add or remove items.
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9

Insurance Claims
e-MDs Bill assigns an insurance status indicator to all insurance claims based on the
default insurance filing method in the insurance company file. The indicator is almost
always NF or EF depending upon whether the claim is to be filed on paper (NF) or
electronically (EF), but users can also create other custom types. For example, you
can create institutional format defaults such as UB.
Continued on the next page ...
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Understanding Filing Status Indicators and Insurance
Flags
The filing status indicators are critically important for several reasons.
•

The system creates batches for all claims that cannot have X as the second letter of the
insurance filing status. Thus, all claims are automatically queued.

•

The status shows users whether a claim has been filed or not, and the method used. Users can,
at any time, look at an invoice or the insurance status report and see if it has been filed, how
many times, and the method.

•

Batch segregation. All electronic claims must be set to EF, but the paper claims wizard lets users
select from any of the types. It is sometimes easier to segregate based on default filing status
than on the other filters available in the wizards.

Insurance Flags
DP

The claim is printed onto disk. This is sometimes used if a billing service generates
claims.

UB

Typically used for UB (institutional) claim forms.

Blank/Null

If there is no insurance on an invoice, the null flag can be used.

The following claim formats are available to e-MDs Bill users.
CMS-1500

Used for most office/professional visits.

HCFA-1500 (12/90)

Used for most office/professional visits. This form was updated to the CMS-1500.

HCFA-1450/UB-92

The setup for e-MDs Bill is geared for rural health, nursing home and other similar
visits, not full-blown hospital billing.

UB-04

This is printed using Crystal Reports, but otherwise functions exactly the same as
other print outputs.

HCFA-1500 IDPA

Used for IDPA (Illinois Dept. of Public Aid) claims.

Massachusetts Division of
Medical Assistance Form 5

Mass Medicaid.

NSF

The National Standard Format electronic claims format. The most commonly used
version of this is 3.01, although our system includes a tool that permits other
versions such as 2.00 to be formatted. This format is rarely used as a result of
HIPAA changes.

ANSI X.12 837 Professional
(004010X098A1)

This is the version mandated by the HIPAA laws.

ANSI X.12 837 Institutional
(004010X096A1)

RHC, nursing home and similar.
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Paper Claims
Paper claims formats to be used are selected at the time of printing, either batches or individually. The
system currently supports the following paper claim formats:
•

HCFA-1500 (12/90)

•

CMS-1500

•

UB-92/CMS-1450 and UB-04 (printed using Crystal Reports)

•

HCFA-1500 IDPA (Illinois Department of Public Aid)

•

MassHealth Division of Medical Assistance Form 5 (this is done using a Crystal Report).

•

New York Medicaid e-MedNY-150001 (Crystal Report)

•

Colorado Medicaid CO-1500 (Crystal Report)

•

Ohio Medicaid 6780 (Crystal Report)

•

Custom: Although not as easy, you can build custom formats for printing one at a time using
Word Forms which has the ability to merge most elements typically seen on a claim form.

Most users will send electronic claims first and will set up insurance companies accordingly with a default
filing status code for that (typically EF). However, certain insurances can also be defaulted to be on
paper. The system assumes that the unfiled paper claims status is NF which is set automatically as the
filter in the claims wizard. This can also be changed on an insurance company basis making it a useful
way to segregate insurances which require different claim forms. For example, a rural health clinic may
set up Medicaid as NF and another Medicaid for RHC preventive encounters as UB so that it is easy to
generate a batch of claims on the standard professional form and another on the UB. In all cases the
second character of the file status is set to X when it is printed so that the system ignores printed claims
by default (but you can reprint them very easily).
The HCFA-1500 & CMS-1500 forms have complete “definitions” editors that allow you to set data printed
in almost all fields and also to have the system change the output based on insurance company, class or
financial group. The UB-92/UB-04, and state-based Medicaid claim formats do not have this level of
customization, but there are some fields that must be filled in elsewhere in the system that are used when
printing these forms.
The selection of the type of claim form to print is made in the HCFA wizard or when printing from within a
specific claim unless it is for the UB-04 or state-based forms which use Crystal Reports.
Further information on setting definitions is included later in this section and there is also an Appendix at
the end of the user guide which shows the default print settings for most boxes in each claim.

Printing Paper Claims
To make printing simple, e-MDs Bill makes use of a wizard for the process. A wizard is a stepped process
with instructions provided for each step. Users can go both forwards and backwards in a wizard.
There are five options in the HCFA Wizard:
•

Create and Print a New HCFA Batch: Where you can print batches of previously unprinted or
reflagged claims based on various user entered filters.

•

Reprint a Previous HCFA Batch: If a previous batch needs to be reprinted for any reason, use this
option. It lets you reprint a previous batch without having to reset all the claims.

•

Delete a HCFA Batch Previously Created: Rarely used – this also deletes the filing history. There is
some use in deleting the batch since the system creates a tracking record for each batch. Thus, the
file history for each claim may not be truly accurate. It’s an option that needs to be used with care,
since it’s better to have worthless references than to delete valid ones.
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•

Print a Single HCFA for a Selected Invoice: This is used to print one claim at a time. This can also
be done from within an invoice or various windows like the posting ledger or collections module.

•

Print a Summary of Invoices With a Hold on Them: This is where users can see a list of all NF
invoices which have a check in the Filing Hold field of the prep record. Users should check this on a
regular basis to make sure they forget about invoices.

Note: HCFA batching can be automated for overnight processing and also tasked to users in TaskMan.
See Report Manager and setting up tasks in Rule Manager.

To create and print a new claim batch:
1. Click Claims > HCFA Wizard.
2. Select Create and Print a New HCFA Batch, then click Next.
3. Step 1 includes some utility settings for the batch. Make changes if necessary according to the
explanations below, and then click Next.
○ Batch Number: Automatically set. This is a sequential number used for both paper and
electronic claims and need to be changed. The counter setting can be changed in E-Claims.
○ Form: Select the form to print.
○ Print HCFA Format: If this is checked it prints the boxes and data for most claim types. It
saves a couple of cents per claim if local payers accept non-OCR “red” forms, or if you print
courtesy forms for patients.
○ No Credits: Used if you cannot wish to reflect any credits made so far on invoices. It will only
show the charges. This is sometimes required if insurance companies ignore the assignment
indicator and send payments to patients if they have made a partial payment. Use of this may
also be determined by contractual requirements with insurance carriers. This filter is only for
use when filing primary insurance claims. If it is checked when there is an insurance payment
listed on the invoice, the system will only pick up the CPT items flagged for refiling in the
payment distribution window.
○ Include Adjustments: This box determines whether the total payments and adjustments and
balance boxes on different claims include any adjustments, or payments only. If the No
Credits option is set, this has no effect.
○ Total All Pages (CMS): When this boxed is checked and the claim is printing more then one
form, the grand total in Boxes 28-30 is for all the forms. When this box is unchecked, the totals
are for the CPTs on the specific form.
○ Spaces…: The spaces settings are used to align the form so that the boxes are filled out
correctly. The settings are remembered from the previous session, so it should only be
necessary to change these if you change printers. If you have not printed previously, or have
changed printers, go back to step one of the HCFA wizard and print individual claims until you
have perfected the alignment. Each line and column has about 10 point settings (i.e. entering
th
1 in a field moves the print 1/10 of a line or column. The alignment does not apply to the UB92 or IDPA.
○ Flagged Charges/All Charges: Option that lets you include only charges with an unfiled
status on a claim or all charges. Its usage depends on whether you only wish to resubmit
specific charges.
Step 2 gives you the option to filter the batch. To use a filter, uncheck the box and then, if applicable, click
one of the drop-down lists to make a selection. By default, the system prints claims in financial group
order.
○ Dates: Defaulted to all so the system pulls unfiled claims matching other criteria. If you are
setting up a repeating task, use the Dynamic Dates option so the system bases the batch on
the date the job is performed and not a fixed date range.
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○ All Financial Groups, All Providers, All Insurance Companies, All Insurance Classes, All
Facilities: Self-explanatory.
○ File Status and Line Status: Very important filters. Usually the insurance company file
status matches the line status (and changing the insurance status in the invoice prompts the
user to update the lines to match). However, you may have some scenarios where you have
reset specific lines to file without updating the insurance and will want to periodically check to
make sure you have covered these variations. You can systemize this by setting up HCFA
printing in Report Manager. The file status is set to NF by default unless printing HCFA1450/UB-92 which changes this to UB.
Click Next to continue. If any errors are found, the system presents an intermediate Errors step. All the
claims in the batch are displayed and those with errors appear in red. The error numbers are displayed
too. Click the Error Codes button to cross-reference an error code with its description. To fix errors,
double-click an error line to open the invoice and correct the mistakes. If you forget what the errors are
after opening the invoice, click the Check Err button in the invoice. Then click Save to return to the Error
window. The errors will still show. Continue fixing errors for all other invoices, then click Done. Click Back,
then Next to let the system review the changes. If there are no further errors, it will continue to Step 3.
Step 3 is where you can preview claims on screen. This is only available for the HCFA-1500 (12/90).
You can also print a summary report of claims in the batch.
○ HCFA Preview: Click the button with the picture of paper and a magnifying glass to load the
preview window. This shows what a printed HCFA-1500 claim will look like. Click Next and
Previous to scroll between claims. A count is displayed in the bottom left of the window.
○ Claim Summary: The summary is a hard copy of the claims in the batch. Although the
summary can be regenerated and a history is saved in the invoice and patient file, it is a useful
report that (in our experience) indicates that most users like to print and maintain a copy for
reference. It is also a good place to do a final check. For example, many insurance policy
numbers are the same length and the discrepancies will show up as a “dent” in the report’s
columnar format (e.g. Medicare numbers missing the letter). The summary includes:


Patient Name, Account #, Insurance Company, Class, Policy # and Financial Group.



# Forms: Shows the number of forms printed for each claim. Bill generates a separate
form for each 6 CPTs on a professional claim.



Invoice # & Date



Charges and Balance



Balance total, total claims by financial group and total count.

Step 4 is where you start the print job. After clicking the printer button you can select the printer from the
windows print manager if you use a specific printer (or printer tray) for paper claims. The system creates a
print job for each one and will print them as fast as your printer allows.
Note: As soon as each print job is created, the file status is changed so that the second letter is X (e.g.
NX, UX). A file history for each claim is also updated with the batch and date information. This can be
accessed by clicking the File History button in the insurance tab of an invoice, or the File History tab in
the patient demographic file.

To reprint a paper claim batch:
This option is used to reprint a batch without collecting any other claims that have been created since
this batch was created. You can also use it to reprint a summary for a batch.
1. Click Claims > HCFA Wizard.
The wizard asks what you wish to do. Click the radio button to Reprint a Previous HCFA Batch.
Step 1 requires you to enter the batch number. As soon as you enter a valid batch, the Next button can
be clicked. The Last 10 Batches field is a time saver that lets you select a number.
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Step 2 allows you to preview claims and reprint the summary for the batch. Click the applicable buttons
you need. When complete, click Next to continue.
Step 3 is where you start the print job. Click the button, then select a printer, then click the printer icon to
print the claims.

To delete a batch:
Only use this option if you are absolutely certain that the batch was not filed.
1. Click Claims > HCFA Wizard.
2. Click the radio button to Delete a HCFA Batch Previously Created, then click Next.
3. Enter the batch number and click Delete. If the batch exists, the system responds with a prompt
telling you how many invoices were in the batch, and asks for confirmation.
4. Click Yes. The system deletes the batch. The filing history for invoices in the batch is updated.

To print a single claim from the HCFA Wizard:
1. Click Claims > HCFA Wizard.
2. Click the radio button to Print a Single HCFA for a Selected Invoice, and then click Next.
3. Click Find Patient. The patient search window appears. Search for and select the patient in
question.
4. A list of all invoices for the patient appears, regardless of file status. Highlight the desired invoice.
5. Set the other options as required, then click the Print button near the top left of the window.
6. Continue until complete, then click Done.

To print a single claim from an invoice:
You can also print/reprint claims from the main Posting ledger window by clicking Print HCFA, or
when saving an invoice by checking the Print HCFA box.
1. Select the claim in the posting window or open it in edit mode (from posting, collections, daily
work list, etc.).
2. Click Print HCFA or check the Print HCFA on Save option if within an invoice. The Print Form
option can also be checked to print the claim with black and white boxes.
3. Select the insurance company to print if there is more than one on the claim. If there are multiple
insurances with the same name, be sure to distinguish them using the numbers that show which
are primary, secondary, tertiary, etc.
4. Check No Credits and/or Include Adjustments, if necessary. The preferences for these are
options remembered from the last time you printed paper claims.
5. Select the claim form type.
6. Click Print.

To print a list of paper claims with a filing hold:
1. Click Claims > HCFA Wizard.
2. Click the radio button to Print a Summary of Invoices With a Hold on Them, and then click
Next.
3. Click the printer button to view the summary. The list can be printed from the preview window.
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HCFA-1500 (12/90) Definitions and Setup
The HCFA Definitions is an extremely powerful that lets users define the data output for most of the fields
in a HCFA-1500 (version 12/90). This lets each group flex the system to meet the different insurance filing
needs of different payors. The system lets users “set it and forget it” by making a change that applies to
an insurance company or financial group. When claims are printed, the system prints boxes based on the
definitions set for each.
A typical example of definitions requirements are Boxes 24k, and 33PIN and 33GRP which require
different numbers by payor.

Notes:
•

The HCFA definitions file does not apply to the CMS-1500, Illinois HCFA-1500, UB-92/HCFA1450 forms or to electronic claims.

•

Refer to page 334 for default settings and definition table lookup data information.

Whenever a definition is created, it must be documented. There is a place to do this in each definition, but
users should also create a document or spreadsheet with all definitions. Keep them in this manual if
necessary. There are default settings for each box that are based upon the HCFA standard, and if you
make a mistake, you can always delete a definition, change it, or reset it to the default.
Upon printing claims, e-MDs Bill checks the invoice insurance and financial group to see if it has a
specific definition. If so, it will use the definition. If not, it prints the claim according to the definition for the
default “ALL” financial group. The hierarchy of definitions, in order of precedence is:
•

Definitions with both financial group and insurance company defined.

•

Insurance company only defined.

•

Financial group only defined.

Note: Where possible, set definitions based on Financial Group because one definition can apply to
multiple payors/insurance companies.

To change HCFA definitions:
1. Click Claims > HCFA Definitions. A screen similar to an actual HCFA-1500 (12/90) form
appears.
2. If the settings apply to all claims, leave the Invoice Financial Group field set to ALL. If the settings
are financial group or insurance company specific, select them from the drop down lists. You
cannot need to select both a financial group and insurance company, although there may be
situations where it is required.
3. Select the field you wish to change by double-clicking the field. The HCFA Definition Edit window
appears.
4. Make changes to fields according to the explanations of each described below:
○ Print?: Can be set depending on whether the field is required or not.
○ Only Use if Default Definition is Blank: This is used for certain fields where if there is no
data that meets the criteria of the normal definition, you can print something else. An example
is where you want to put the name of the primary provider in the patient file into Box 17 if there
is no referral in the claim prepare.
Field Types:


Variable Text, Date or Check Box: Used to set the data type for the majority of fields.
When this option is used, the system references the file and field names to look up the
data to print in the box.
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Variable Money or Diagnostic Code: Used for boxes that contain money (e.g. 24F, 28,
29 and 30) or diagnostic codes (e.g. 21, 24E in some states). This type also uses the
field and field names to determine what is printed.



Constant: A free form option that lets users enter a fixed constant that is the same for
every claim matching the financial group and insurance parameters. The Constant Value
is what will print.

○ Show Decimal Point, Eliminate Space: If the Money or Diagnostic Code option is selected,
users can also specify whether or not a decimal point is required. Un-checking Show Decimal
Point, removes this. Checking Eliminate Space will eliminate the space if no decimal point is
printed.
○ Date Mask: Users can set a date mask for every field in the system. The default settings for
the fields are determined by the specific field. Users can select from the list of date formats in
the list box, or type a mask using any of the 5 characters available: dd=day, mm=month,
yyyy=year with century (yy is just the year), / and space. If other characters are entered, they
will print on the form.
○ Constant Value: If the Field Type is Constant, type the constant/default into this field.
○ File Name: If a variable field type has been selected, click the drop down arrow in the File
Name and select the specific data entry screen in which the data element you require is
located. For example, if you want a specific provider number you know is entered in the
provider screen, select Provider. If you are creating a definition to use data from one of the
User Defined Alternate IDs in the provider file, select Provider Alternate IDs. A list of each file
name and what it contains can be found in the Appendix on page 340.
○ Field Name: Shows all the fields in the screen for the applicable File Name. Select the
required field. If the definition is for a User Defined Alternate ID, type the Internal Name in this
field with no spaces. For example, ALTID5.
○ Description: Use this field to document the reasons for your edits.
Click Save. This setting is now stored for each time that you print claims according to the financial group
and insurance setting.
Click Close in the main definition screen.

To reset HCFA definitions:
1. Access the specific field you want to reset as normal.
2. In the Variable Value File Name field, select Default.
3. Click Save.

To edit or delete HCFA definitions:
1. Click Claims > HCFA Definitions.
Click List Definitions. A table of custom definitions appears in field order.
To change or delete a definition, highlight the definition, then click Edit (or double-click the definition). The
HCFA Definition Edit window appears. Modify information and then save the changes or click Delete to
remove the definition.
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CMS-1500 Definitions and Setup
The CMS Definitions is an extremely powerful that lets users define the data output for most of the fields
in a CMS-1500. This lets each group flex the system to meet the different insurance filing needs of
different payors. The system lets users “set it and forget it” by making a change that applies to an
insurance company, financial group or insurance class. When claims are printed, the system prints boxes
based on the definitions set for each. There are two separate definition options for the CMS-1500 (08/05)
and (02/12) form types. Note: e-MDs will not plan active maintenance of the (08/05) form after
version 8.0.
A typical example of definitions requirements are Boxes 24J, and 33a, and 33b ID and Number which
require different numbers by payor, although hopefully the NPI transition will minimize this burden.

Notes:
•

The CMS definitions file does not apply to the HCFA-1500 (12/90), Illinois HCFA-1500, the UB92/HCFA-1450, UB-04, or to electronic claims.

•

Refer to page 337 for default settings and definition table lookup data information.

Whenever a definition is created, it should be documented. There is a place to do this in each definition,
but users should also create a document or spreadsheet with all definitions. Keep them in this manual if
necessary. There are default settings for each box that are based upon the HCFA standard, and if you
make a mistake, you can always delete a definition, change it, or reset it to the default.
Upon printing claims, e-MDs Bill checks the invoice insurance (by name or associated class), internal
medical facility (which covers the possibility of needing state-based identifiers too), and financial group to
see if it has a specific definition. If so, it will use the definition. If not, it prints the claim according to the
definition for the default “ALL” financial group. The hierarchy of definitions, in order of precedence is:
•

Definitions for Internal Facility override others, but may also be used in combination and will then
follow the order below.

•

Definitions with both financial group and insurance company and insurance class defined.

•

Insurance company only defined.

•

Financial group only defined.

•

Insurance class only defined.

Note: While it appears to be the lowest in precedence, using insurance classes is recommended for a
number of reasons. The class is linked to a company and thus users have less chance for error whereas
a definition for a financial group will work fine, but it’s very easy to either set the incorrect financial group
on an invoice, or to forget to change it at all (both scenarios are common when queuing secondaries). On
the other hand, using insurance companies would mean that you’d have to set up a new definition each
time a new iteration for the same company is added to your database. Examples of this are Blue Cross,
Aetna, United and so on which often have multiple entries for different addresses.

To change CMS definitions:
1. Click Claims > CMS Definitions. A screen similar to an actual CMS-1500 form appears.
2. If the settings apply to all claims, leave the Financial Group and Insurance Class fields set to ALL.
Otherwise set insurance-specific definitions. Doing this by insurance class is the best method.
3. Select the field you wish to change by double-clicking the field. The Edit Definition window
appears.
4. Make changes to fields according to the explanations of each described in the “CMS Options”
table.
5. Click Save. This setting is now stored for each time that you print claims according to the financial
group and insurance setting.
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6. Click Close in the main definition screen.
CMS Options
Print?:

Can be set depending on whether the field is required or not.

Only Use if Default
Definition is Blank

This is used for certain fields where if there is no data that meets the criteria of the
normal definition, you can print something else. An example is where you want to
put the name of the primary provider in the patient file into Box 17 if there is no
referral in the claim prepare.

Field Types

•

Variable Text, Date or Check Box: Used to set the data type for the majority
of fields. When this option is used, the system references the file and field
names to look up the data to print in the box.

•

Variable Money or Diagnostic Code: Used for boxes that contain money (e.g.
24F, 28, 29 and 30) or diagnostic codes (e.g. 21, 24E in some states). This
type also uses the field and field names to determine what is printed.

•

Constant: A free form option that lets users enter a fixed constant that is the
same for every claim matching the financial group and insurance parameters.
The Constant Value is what will print.

•

Show Decimal Point, Eliminate Space: If the Money or Diagnostic Code
option is selected, users can also specify whether or not a decimal point is
required. Un-checking Show Decimal Point, removes this. Checking Eliminate
Space will eliminate the space if no decimal point is printed.

•

Date Mask: Users can set a date mask for every field in the system. The
default settings for the fields are determined by the specific field. Users can
select from the list of date formats in the list box, or type a mask using any of
the 5 characters available: dd=day, mm=month, yyyy=year with century (yy is
just the year), / and space. If other characters are entered, they will print on the
form.

•

Constant Value: If the Field Type is Constant, type the constant into this field.

•

File Name: If a variable field type has been selected, click the drop down arrow
in the File Name and select the specific data entry screen in which the data
element you require is located. For example, if you want a specific provider
number you know is entered in the provider screen, select Provider. If you are
creating a definition to use data from one of the User Defined Alternate IDs in
the provider file, select Provider Alternate IDs.. A list of each file name and
what it contains can be found in the Appendix on page 340. Note that the list of
file names can vary depending upon the field you are in. An example is the
Totals Options which is used to show insurance or patient payments for boxes
11d and 29 because of some payor requirement anomalies.

•

Field Name: Shows all the fields in the screen for the applicable File Name.
Select the required field. If the definition is for a User Defined Alternate ID, type
the Internal Name in this field with no spaces. For example, ALTID5.

•

Description: Use this field to document the reasons for your edits.

To reset CMS definitions:
1. Access the specific field you want to reset as normal.
2. In the Variable Value File Name field, select Default.
3. Click Save.

To edit or delete CMS definitions:
1. Click Claims > CMS Definitions.
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2. Click List. A table of custom definitions appears in field order.
3. To change or delete a definition, highlight the definition, then click Edit (or double-click the
definition). The Edit Definition window appears. Modify information and then save the changes or
click Delete to remove the definition.

To remove Zip Code formatting:
1. Log in to e-MDs Bill.
2. In the Claims menu, click CMS Definitions.
3. In the CMS – 1500 Definitions window, double-click on a field containing a zip code (e.g. Box5
city/state/zip).
Warning: Double-clicking an unintended field and clicking Save will add the unintended change
to the Default List which could cause errors. Always click Cancel to exit an unintended change.
To remove a change, see Step 7.
4. In the Edit Definition window, under Field Type, confirm that Variable Text, Date, or Check Box
is selected.
5. Under Field Options, click the checkbox for Remove Zip Code Formatting.
6. Click Save.

Note: Build a CMS form. The hyphen between the 5 char base zip code and the 4 char
extended zip code should be eliminated (example "787580001").
7. To check and/or remove your changes in CMS – 1500 Definitions, click the List button.

UB-92 and UB-04
UB Setup
The current version of e-MDs Bill includes this form and has primarily been designed to work for several
ambulatory settings (RHC, some urgent care, etc.) As yet, it is not fully developed for full-blown hospital
claims.
Claims for UB printing can be segregated from others when you are printing using filters in the print
windows. Examples are by insurance company, by financial group, or by insurance status flag. Since
there may be a great deal of cross-over involved with insurance companies and financial groups, we
suggest the use of the insurance status code when setting up insurance companies. This can also be
modified at the invoice level in case some service lines need to be billed on the CMS-1500 professional
claim form in invoices where services may need to be split to bill on professional vs. institutional forms.
(This particular scenario can be automated with the use of contracts and fee schedule rules.)
Note: Refer to page 343 for a table that shows the sources of data printed in fields on the UB-92, and
page 345 for the UB-04. The following is a list of some of the primary items which differentiate institutional
from professional claims.
UB-92 and UB-04
Options
Box 4 Type of Bill

Type of Bill field in the File > Options window. This is facility-specific. If there is text
in the Office Number field for the insurance company it will override this options field
setting.

Boxes 24–30 - Condition
Codes

Condition codes fields in claim default window (opened from invoice claim prepare).
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Column 42 - Revenue
Codes

Box 43 – Description

Box 51 – Provider
Numbers

Default revenue codes are linked to CPTs and HCPCS in the master reference
tables for each. Upon entering the CPT in the invoice, the revenue code is also
retrieved and then printed on the claim. To associate a revenue code with the CPT
click Reference > CPT or HCPCS; search for the CPT in question and click Edit
CPT, then click the Find button next to the Revenue Code field, search for the
revenue code by Category Description and link it to the procedure. Although this is
rare in rural health billing, if you need to associate a different revenue code with a
procedure for a particular visit, you change this in the Invoice (CPT) Edit window
when generating a claim. The field is also heavily affected by the use of the
Revenue Code Rollup fee schedule rules for CPT’s which will combine like revenue
codes as needed. The rules are:
•

If there is a Rev code and the CPT is NOT set to rollup, it will print both Rev &
CPT codes.

•

If there is a Rev code and the CPT IS set to rollup and there is only 1 CPT for
this Rev code, it will print both Rev & CPT codes.

•

If there is a Rev code and the CPT IS set to rollup and there is more than 1
CPT for this Rev code, it will print only the Rev code.

•

If there is no Rev code and the CPT IS set to rollup, each CPT will print on it's
own line with the CPT code and CPT description.

•

If there is no Rev code and the CPT is NOT set to rollup, it will print the CPT
code and CPT description.

This is also affected by revenue code roll up rules in fee schedules as well as the
payor type:
•

Claim is being submitted to an insurance company with a payor type of MC,
MB, or MA: If there is a Rev code it will print the rev description. If there is no
Rev code it will print the CPT description.

•

Claim is being submitted to an insurance company that is not MC, MB, or MA: If
there IS a Rev code and the CPT IS set to rollup and there is only 1 CPT for
this Rev code, it will print the CPT description. If there is NOT a Rev code and
the CPT IS set to rollup, it will print the CPT description. If there IS a Rev code
and the CPT IS set to rollup and there is more than 1 CPT for this Rev code, it
will not print a description – only the Rev Code.

Special provider numbers may be issued for rural health by Medicare and Medicaid.
You can submit either facility-specific group numbers or provider-specific numbers.
•

If insurance company type code = MA or MB (Medicare Part A or B), first
checks internal medical facility linked to claim to see if there is an alternate ID
field specifically titled “Medicare Provider Number” and uses that. Otherwise it
will print the number in the Medicare Alternate field in the Licensure tab from
the provider file.

•

If insurance company type code = MC (Medicaid), first checks internal medical
facility linked to claim to see if there is an alternate ID field specifically titled
“Medicaid Provider Number” and uses that. Otherwise it will print the number in
the Medicaid Alternate field in the Licensure tab from the provider file.

•

If insurance company type code = BL (Blue Cross), it will print the number in the
Blue Cross Alternate field in the Licensure tab from the provider file.

All insurances commercial: Upin or NPI.
Box 85 – Provider
Representative (only UB92):

Pulls from the Data 2 field in the File > Options window. Typically set to
“SIGNATURE ON FILE”.
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Flagging Claims for UB Printing
Since UB claims are printed for particular payors, the default insurance filing method should be set to UB
or some other identifier you prefer to distinguish them from other carriers and make is easier to segregate
the UB batches in the printing wizard, daily work list or collections module.

To print UB-92 claims:
This is done using the HCFA Wizard.
1. In step 1 of the HCFA Wizard for either batch or individual printing, select UB-92/HCFA-1450
from the Form list box.
2. If printing batches, in Step 2, select claims with a file status of UB. If printing individual claims,
select the claim in question.
3. Continue as usual. Please note that the preview feature in Step 3 of the batch wizard show the
UB-92 layout.
4. After printing, the claim status for this payor is set to UX.

To print UB-04 claims:
1. Click Reports > Crystal Reports.
2. Search for the UB-04 report. It is in the ALL and BILL categories.
3. Click Run.
4. Set the printing parameters.
5. Click OK to generate a preview. Note: Even if you print a hard copy, the preview process also
updates the file status for the insurance being printed and the CPT line items and also inserts an
invoice note if your system is configured with the INSFILED follow up action.
6. Click the Print button to send the job to a printer.

Illinois Medicaid HCFA IDPA Setup and Printing
There is very little setup for this form since most of the output is hard coded.
•

Box 30 Provider Number: Rendering provider’s Medicaid Group number.

•

Box 31 Physician Name: Rendering provider’s ALTID3.

•

Box 33 Payee Number: Rendering provider’s ALTID2.

•

Box 35 Original DCN: Original ICN/DCN field in the invoice claim prepare Misc Options tab.

The form itself is printed by selecting this form name from the HCFA Wizard or using the Print HCFA
options in an invoice or the posting ledger.

MassHealth Form V
The claims output for the MassHealth (MA Medicaid) form is generated using the MassHealth Form 5
Crystal report. After selecting the report and clicking Run, the Enter Parameter Values window appears.
Be sure to select MA in the State filter so that you print the correct form. You can also filter by invoice
date range, invoice facility, rendering provider, insurance company, filing status and financial group.
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New York Medicaid e-MedNY-150001 Claim
The claims output for this is generated using the HCFA Form by State Crystal report. After selecting the
report and clicking Run, the Enter Parameter Values window appears. Be sure to select NY in the State
filter so that you print the correct form. You can also filter by invoice date range, invoice facility, rendering
provider, insurance company, filing status and financial group.

Colorado Medicaid CO-1500
The claims output for this is generated using the HCFA Form by State Crystal report. After selecting the
report and clicking Run, the Enter Parameter Values window appears. Be sure to select CO in the State
filter so that you print the correct form. You can also filter by invoice date range, invoice facility, rendering
provider, insurance company, filing status and financial group.

Ohio Medicaid 6780
The claims output for Ohio Medicaid form is generated going to Reports > Crystal Reports > Ohio
Medicaid HCFA Form. If it is not in your master content, it can be downloaded from e-MDs Support
Center. After selecting the report and clicking Run, the Enter Parameter Values window appears. You
can filter by invoice date range, invoice facility, rendering provider, insurance company, filing status and
financial group.

Electronic Claims
e-MDs Bill has the ability to create electronic claims in ANSI X12 837 (004010X098) Professional, ANSI
X12 837 (004010X096A1) Institutional, and National Standard Format Version 3.01. With some tweaking,
it is also possible to create NSF2.0 claims using the NSF Definitions file described below. Electronic filing
has many advantages over paper claims:
•

Faster Payment: Because electronic claims systems perform numerous edits on a claim to
ensure it is clean, and because accepted claims are sent directly to carrier’s computer systems
that can process claims and generate checks, payments are often mailed within days instead of
what can sometimes be months with a paper claim.

•

Better Audit Trails: Since the insurance carriers or clearinghouses generate a response when
you send in a batch.

•

Quicker Turnaround on Rejected Claims: If a paper claim is rejected, the clinic only finds out
several weeks later when they receive the EOB. With electronic claims, users find out within
days, and sometimes even within minutes. This makes it very easy to fix the problem and refile it
almost instantly.

•

Saves Money: Even the setup costs, monthly charges and per claim fees (if applicable) for
electronic claims is much less than the cost of the forms, envelopes, postage and time required to
send paper claims.

The only real difference between paper and electronic batches is the output and transfer method. The
rest of the process is exactly the same. You create claims, generate a batch, and send it.
It is strongly recommended that your clinic pursue the option to file electronically. e-MDs has partnerships
with several clearinghouses that can process the majority of payors. A list of recommended
clearinghouses is on our web site.
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Electronic Claims Setup
At each of these steps, e-MDs will work with your office. Make sure you designate a point person who is
responsible for this process.
1. Choose a clearing house or other direct connection and let e-MDs know about this. e-MDs has a
number of companies that we are familiar with and recommend. It is in your interests to
investigate each of these. Their staff are more than happy to demonstrate how they work. We
will also help you with other connections you may wish to use instead but be aware that setup
and support charges will still be levied and that our support staff will be less able to support a
connection with which they are not familiar.
2. Fill out enrolment forms (indicating all the options desired such as claims, remittances, statement
services, etc.). Once these have been processed, you will be issued with a submitter ID which is
a little like having an account.
3. Fill out EDI agreements for those payors that require them. " Until these are approved by the
payors, you will not be able to submit claims to these specific companies and must continue to
print, so it is important that you prioritize this task and check the accuracy of your work.
4. Enter setup information in the Claims > EDI Options and Claims > Clearing Houses windows.
5. Enter provider numbers and set NSF Definitions (if using NSF) to match the clearinghouse and
provider numbers.
6. Configure the connection. This may be dial up, browser or TCP depending on the options offered
by the receiver. Files may be uploaded and downloaded manually using tools provided by the
clearing house, or using the clearing house interface. This interface provides functionality that
allows you to set up automatic uploads and downloads to certain FTP and HTTPS connections.
7. If required, set up test batches and transmit them to the clearinghouse. Test batches generally
require real patient information and claims data but are not forwarded for payment. You can use
old claims for test purposes, and should make sure they are representative of your payor mix as
well as other special situations. A special test indicator in the claim batch is often required. See
Setting an Electronic Batch as a Test on page 239.
Note: The computer on which you file electronic claims must conform to our minimum system
specifications. Electronic claims generation, particularly recreating batches, is a system intensive process.
The next sections describe the setups required for the different filing methods, followed by actual creation
of batch files.

NSF Definitions
The NSF Format is not part of the HIPAA requirements. Unless deemed absolutely necessary, e-MDs no
longer sets up the NSF definitions for customers. The ANSI format is the HIPAA standard.
Although this is a “standard” format, over the years payors have made and continue to make many
modifications to NSF to meet their needs. The NSF Definitions is a tool that is used to modify the output
to meet these needs based on different filtering criteria.
When e-MDs sets up a user, a database script that matches the basic format required by your
clearinghouse is run as part of the setup process. Then, additional settings are made based on the
payors to which you submit and their needs; for example, payor specific submission numbers. Settings
create the ability to look up data in any field for specific insurance carriers, financial groups and providers.
If a definition is financial group, insurance company or provider specific, that group, etc. must be selected
as a filter when creating a batch. Otherwise, the system assumes the default settings for the output.
Once the settings for the definitions file meet the requirements of your clearinghouse or insurance
carriers, users need to worry about the output for each of these anomalies. Thus, the NSF Definition
offers significant time saving utility to a clinic because no per claim or per batch user intervention will be
required.
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A rudimentary understanding of an NSF file format is helpful for users setting up definitions. The National
Standard Format is much like a HCFA in that, just like a HCFA has boxes for particular information, the
electronic claim disk also requires data in set places. The NSF just has many more data elements than a
HCFA.
Each line (or record type) in a claim file has a specific function. Some lines only have information related
to the file itself, others to batches within the file, and others are for patient, insurance, diagnosis and
procedure related information.
Each line is 320 characters long, regardless of whether anything is actually placed in each space in the
line or not. This is known as a fixed width record. In fact, if you were to look at a claim file, you’d see
much of it is empty white space. Each element or field within a line, for example a diagnosis code, must
be in exactly the correct place, just like on a printed form. The NSF Definitions file allows you to create a
library of definitions that specify where that information is coming from.

To create an NSF definition:
1. Click Claims > NSF Definitions. The top left of the screen is where you locate a field within a
record.
○ State: Defaulted to XX, the system allows state-specific definitions to be created. This will key
off the state of the facility in the claim. Most clinics need to change this since they are only
located within one state. However, it is possible that some large groups will span state
borders. Since some carriers (particularly government and Blue Cross) have different claims
processing intermediaries or other filing requirements, a definition can be set by state.
○ Record Type: Each line in a claim file is called a record. Different records contain different
information. To locate a specific data element, the record must be located first by using the
drop down list.
○ Type, No and Description: After a Record Type is entered, all the elements within that record
are listed in this area. Users can scroll down the list until the specific element is found. Upon
highlighting the element, information pertinent to the element will fill the right and bottom of the
window. The top right of the window shows information about the highlighted field.
○ Length: The number of characters in the field.
○ Type: Indicates if it is an alphanumeric field (X) or a calculated numeric field (N).
○ From Pos, To Pos: Shows where the field falls within the record type line.
○ Active Detail: If set to N, the system check to see if there is a specific detail for the field.
Instead, it will look in the constant field.
○ Default Value: The default value field is not used.
○ Constant: The constant field is used to enter information when the field requirement is not
dependent upon a particular query or detail element listed below. If the active detail is set to N,
the system will insert the information in this field into every claim.
○ Data Initialize: These radio buttons let you set alignment and data fill criteria.
2. Enter the two-character state code specific to your definition. XX is the default and is used for
most definitions.
3. Tab to the Record Type field and select the one desired.
4. Scroll down the list of element fields in the record type and highlight the one desired. Information
pertinent to the field appears to the right and bottom of the screen. Enter fields as follows:
○ State, Field No, Description, Length, Type, From Pos and To Pos: For the most part, it is not
necessary to change these.
○ Data Initialize: Settings that define how a field is filled:


Blank Fill: Leaves the field blank if no data is entered.



Zero Fill: Fills the field with zeros if no data is entered.
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Zero Pad Left: Puts zeros to the left of any numeric data.



Zero Pad Right: Puts zeros to the right of any numeric data.



Active Detail: Set to Y if you are going to build insurance-, provider-, financial group- or
other claim dependant definitions. This tells the system to look at the Detail in the bottom
half of the window. If the same information is required in this field for every claim,
regardless of financial group, provider or insurance, you can set this to N and proceed to
the next step. If the field is set to N, it does not matter how many definitions you have in
the Detail section, the system use them.



Default Value: Not used.



Constant: Used if the same data is required in a field regardless of financial group,
insurance or provider and if the Active Detail is set to N. Type the constant into the field.

5. If a detail is required, the detail is entered at the bottom of the screen and is read by the program
if the Active Detail flag is set to Y. In many cases, a default detail is already present in the master
database. This is usually a reference to a particular field in a query or database. To add new or
additional detail definitions, click the New button at the bottom of the window, in the Detail area.
○ Seq: Required for all detail definitions. Enter the next number in the sequence. If this is the
first detail, enter 1.
○ Financial Group, Provider, Insurance, Constant: Select from the drop down lists if this
definition is specific to a particular entity, or type in a constant. The definition for a financial
group, provider or insurance will be used if that entity is selected as a filter when building a
claim file.
○ Table Name: Select a data table or query from which the data is going to be drawn when a
claim is created. If you are creating a definition for a provider alternate ID, select the table
qyEFProviderAlt, or qyEFRenderingAlt depending on which field is being used in the invoice.
Case is not important.
○ Field Name: Select or type the name of the field. Case is not important. If using a provider
alternate ID, the only option is “Value”. The list of field names is not necessarily alphabetically
sorted.
○ Field Type: Different fields store different data types. The system enters these correctly in the
claim based upon the field type setting.


I: Integer



R: Floating point integer. Used for monetary value fields.



S: String – used for most database lookup fields.



D: Date field – the system enters the date in ccyymmdd format.



M: Used for CPT fee units. Only used for FA0.18.



T: Time field.

○ Locate Field: Only used if the table name is qyEFRenderingAlt or qyEFProviderAlt (which
look up data in the provider user defined alternate ID fields). If so, enter “Internalname”.
○ Locate String: Also only used for provider alternate IDs. Enter the alternate ID field number in
the Internal Name column of the provider file alternate IDs (e.g. AltID1, AltID2, etc.).
6. Click Save.

EDI Options
The EDI Options screen is where clinics set up information required in each electronic claim file. This
identifies the source of the claim file, as well as the file type. The EDI Options file is facility-specific. Most
of this is used for the now nearly defunct NSF filing format, but some of the information is also used for
ANSI claims.
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To set EDI options:
All information in the EDI Options window should be entered in upper case. When you enter
telephone numbers and zip codes into this window use parentheses or hyphens.
1. Go to Claims > EDI Options.
2. Enter information in the fields as described in the “EDI Options” table.
Click Save.
EDI Options
Contact Name

The name of the billing person at your clinic or billing service who will be contacted
should there be any problems.

Submitter ID and
Password

Upon enrolling to send electronic claims, the clearinghouse or insurance carrier will
issue your clinic with a login ID and a password. These are used to get access to
the system. (If you are sending claims to multiple points, definitions can be created
for these fields.)

Tran Type

Enter ASY096 in this field.

Organization Tab

Enter your business information. The organization data can also be used to enter
billing service information for ANSI claims. The Type is your organization type. Not
all clearinghouses require this. Valid values are:
•

001 Solo Practice

•

002 Partnership

•

003 PA (Professional Association)

•

004 Clinic

•

005 Single entity facility/hospital (all hospital provided under a single provider
number or corporate entity).

•

006 Distinct part facility/hospital (a unit of a hospital or corporate entity billing
under a separate provider number) billing for professional service.

•

007 Individual (corporation filing under an individual provider or tax number
(SSN) (common with suppliers)).

•

008 Corporation.

Payment Tab

Enter the address to which payment for claims will be sent. It can be the same as
the organization data.

Service Tab

Enter the address at which services were rendered. It can be the same as the
organization data.
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Vendor Tab

Eligibility Tab

MIX Definition

•

Vendor ID: If using THIN, enter V00550. If using McKesson or others, enter EMDS. Otherwise, call e-MDs for the Vendor ID. All clearinghouses require a
vendor to be certified before claims can be sent to them and may reject claims if
this is not entered.

•

Version: Enter 6 in the Version field, then 0 and 0 in each of the two untitled
fields.

•

National Standard Format Version Level: Type 00301 in both the National
and Local fields unless you have tweaked your definitions file for another
version.

•

File Ind: If sending a test file to McKesson, set to T. If sending production
claims, set to N.

•

File Ind 2: If sending a test file to McKesson, set to N. If sending production
claims, set to 1. If filing ANSI claims as a solo provider where SSN is being
used and certain payor conditions apply to the group and rendering information
in the file, enter an S. Our staff will help you with this.

•

Customer Number: This field is only required if using McKesson for electronic
claims. Enter the 4-character customer number issued to your site.

Used when generating ANSI 270 eligibility check files in Schedule.
•

Perform Eligibility Checking: Enables the facility for checking. If this is
unchecked, the system do any eligibility checks for any appointments/patients
in this facility.

•

Contact, Telephone, Email: Contact information that is sent in the check file.

•

Number of Days Out to Run a Batch Eligibility Check: Eligibility checking is
appointment-based. This is the default for the number of days that are
automatically included, although it can be overridden by users. There are some
other rules such as how often to check for a payor which also come into play
(see Schedule user guide).

If sending mixed claims, you can specify which financial groups are included in a
MIX batch by checking the applicable financial groups. Do not include financial
groups that must be filed separately.

Setting Up ANSI Clearing Houses and Connections
Use the Clearing Houses window to set options for ANSI claims, remittances and eligibility checking.
Although the ANSI formats are far more rigid in terms of standardization of claims transmission formats
than NSF, there are still some variances. However, those variances are typically restricted to the types of
record delimiters and a few other fields in the claim file.
You can set up multiple clearing houses or connections (if filing directly to payors). In some cases, only
one setup may be necessary to accommodate all transaction types for a clearing house. In others you
may need to set up more than one to accommodate the other party’s requirements. Clearing houses are
used when generating claims, setting up eligibility checking, or importing remittance advice files. Much of
this information will be supplied at the time of setup by the clearing house and e-MDs during initial system
implementation.

To set up a Clearing House:
1. Go to Claims > Clearing Houses.
2. Click Add/Edit.
3. Search for an existing organization, or click New to add a new clearing house.
4. If you are entering a new clearing house, enter the required fields in Clearing House Maintenance
screen and click Save and Exit.
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5. On the Find Clearing House screen, search for the newly created Clearing House and click
Select.
6. Enter the values for the appropriate options as described in the Clearing House Options table.
7. Click Save.
Clearing House Options
Name

The name of the clearing house that will be checking eligibility, processing claims
and processing remittances.

ANSI Filing Characters

These delimiters will be used when building claim files as well as when parsing
inbound remittance/payment files.
•
Element Separator: Sets the main field delimiter for outbound claims.
•
Subelement Separator: The character used in fields that are sub-divided.
•
Segment Terminator: The character used to delimit segments/lines in a claim
file.
•
Repetition Separator: The character used when fields are repetitive.

Eligibility Options

Set the options in this section if you plan to generate ANSI 270 eligibility check files.
•
Directory: The directory is where a file is saved for insurances with this
clearing house used as their default (it might also be the facility default clearing
house where none is identified for the insurance). You can create different files
for different insurances that are saved to different directories.
•
Max Records: Batch eligibility files typically permit up to 99 requests each but
some payors may impose different counts. The system generates several files
automatically based on this setting and the number of patients for whom
eligibility is being checked.
•
Acknowledgement Request: Sets a flag in the file to receive an ANSI 997
acknowledgement file. In most cases these are sent regardless of the setting.
•
Test: Sets a flag in the file to indicate that it is in test mode. You may need to
use this for some connections when you set up an account. Be sure to uncheck
this when you are ready for production otherwise your files will not go beyond
the test system.
•
270 File Extension, 271 File Extension: These are appended to eligibility
check files you send to payors (the 270) and are what are expected in the
response (271). The settings are used by any automatic communication tools
so it knows which files to upload and which to import.
•
Use Insurance Payor ID for ISA08 and GS03: This will be checked if the
clearing house or payor requires this non-standard data instead of an assigned
interchange receiver ID or application receiver code.
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Setup for Current Facility

Enter the setup for the current facility. These become defaults in the ANSI 837
header segments.

•
•
•
•
•
•
•
•

Security Information (ISA04): The default for ISA04.
Interchange Receiver ID (ISA08): The default for the ISA08. This is
the code that will be used if there is no financial group specific receiver
ID set up in the Receiver IDs tab.
Application Receiver Code (GS03): The default for GS03.
Interchange ID Qualifier (ISA05): The default for ISA05.
Application Sender Code (GS02): The default for GS02.
Interchange Sender ID (ISA06): The default for ISA06.
Interchange ID Qualifier (ISA07): The default for ISA07.
Use National Provider ID for All Insurance Companies: This setting
works with the same option found in each insurance company file.
When this is set, the system will use the NPI provider identifiers instead
of other designated ones for ALL insurances. If it is not set, then the
system checks at the insurance company level to see which information
to put in the file. The option is here to accommodate the variable
schedule expected as insurances start accepting the NPI from 2006.

Use X12n v5010 for All
Insurance Companies

After all insurance companies that you work with are ready to receive transmissions
in ANSI 5010 format, check this option to submit transmissions in that format.
Because selecting this option will override any individual insurance company
settings for processing non-5010 format transmissions, you must be sure that all
insurance companies are ready for 5010 format before checking this box. See
Insurance Company Maintenance Options for a description of the option available
for using 5010 format for specific insurance companies only.

Receiver ID

Enter special Receiver IDs, if needed. This is used where a particular claim type
requires a different receiver ID. If a user selects a financial group when building
claim file, the matching receiver ID is used. If a specific financial group is not
selected when building, the generic one will be used, even if there are financial
groups in the claim file that have individual receiver IDs.

Provider 2nd ID

Set up Provider 2nd IDs (secondary identifiers). These are used to define custom
identifiers to insert into the REF segments of the different sections of claim and
eligibility files based on non-standard requirements. Examples are where a different
number than a tax ID or NPI is used to identify a rendering physician. There are a
number of these loops which differ depending on the file being generated. Typically
you will be setting the 2010AA (facility/group) and 2310B for professional claims,
and 2310E for institutional claim rendering physicians.
•
Financial Group: Select the group to which the payor is matched.
•
Loop Name: Select the pertinent loop in which the data is needed.
•
Reference ID Qualifier: Select from the list based on the payor’s requirement.
•
Alternative ID Type: Select the provider alternate ID that is to be used.
•
Medical Facility & State: Use these fields if you have different identifiers
based on your medical facility locations. This is typically used to accommodate
organizations that cross state lines with different credentialing in each. If you
only use state, the system will look at the state code for the medical facility
linked to a claim. Ensure that each facility and/or provider has the appropriate
alternate IDs set up in demographics so that this will pull correctly.
•
Insurance Class: Select the insurance class to be used.

Referral 2nd ID

These function exactly the same as provider IDs, but are used in the referral loops.
These are 2310A (professional referral), 2310C (professional purchasing provider),
2310B (institutional operating), and 2310D (institutional referring).

Facility 2nd ID

Same as above.

e-MDs Solution Series Bill User Guide 8.0 R00

235

E-Claims
To make electronic filing simple, e-MDs Bill uses a wizard for the process. A wizard is simply a stepped
process with instructions provided for each step. It’s an easy way to walk users through the task. Users
can go both forwards and backwards in a wizard.
User options in E-Claims are:
•

Create a New Electronic File: This is where you will go to create batches for all unfiled claims, as
well as those that have been reset to EF for refiling.

•

Build From a Previous Batch: If a previous batch needs to be rebuilt for any reason, use this option.

•

Reactivate a Previous Batch: This option will reset all filing statuses from EX to EF so they can be
included in the next batch built.

•

Batch Number: Every insurance batch, both paper and electronic, is assigned with a batch number.
This is extremely useful for internal tracking purposes. Additionally, batch numbers are often required
for electronic filing. If so, the batch number cannot be repeated for a certain period of time. If you get
rejections based upon duplicate batch numbers, you can set the counter to the next available
number, and from then on, the system will count from this. The first number with a new system is
1000, so it is possible that users who have been filing electronically with a previous practice
management system will need to reset this.

To create a new electronic claim file:
1. Click Claims > E-Claims.
2. In step 1 of 4, ensure the radio button for Create a New Electronic File is set and click Next.

Note: The Batch Number field is only active if you select Build from a previous batch or
Reactivate a previous batch. See the following section titled, “To rebuild an electronic batch file.”
3. Step 2 of 4 includes several ANSI X12 Claim Options for the batch. After you have made your
selections, click Next.
○ Clearing House: This field contains a list of all active clearing houses from the Claims EDI
options window. After first use, the clearing house selected will be stored as a preference and
will be the default the next time you run E-Claims.
○ Claim Type: This field is set to “Professional” the first time you run E-Claims. After first use,
the clearing house selected will be stored as a preference and will be the default the next time
you run E-Claims.
○ Original Claim: This option defaults to Yes, but No can be selected if this is not the first claim.
This will change the value in BHT02 within ANSI file.
○ Submission Type: Defaults to “Production.” Change to “Testing” only if Clearinghouse
requests.
○ Batch Type: Usually Z. Select from the list of available options. If filing all claim types in one
batch (for clearinghouses that permit this), or if you are creating a MIX batch, use F
Commercial or Z Multi-Pay Organization depending on the clearinghouse requirements. For
ANSI claims, pick anything.
○ Invoice Credits: Used if you do not wish to reflect any payments or adjustments made so far
on invoices. It will only show the charges if set to “Exclude.” This option is remembered from
the prior batch.
4. In step 3 of 4, the Batch Information field indicates whether the file you are creating is New or a
button to select a File Path for the ANSI
rebuild of a specific batch number. Use the browse
batch file and then name the file in the File Name field. This should always be the same for
consistency. The system remembers the path from the previous batch created. Unless another
path is requested by a clearing house we recommend the following folder for consistency:
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C:\Program Files\e-MDs\EF\Claims. If multiple users create batches on different computers,
create a shared network directory. Click Next.
5. In step 4 of 4, select the Invoice Filters and click Show Invoices.
○ File Status & Line Status: Critical filters. By default, the file status for CPT’s matches the
invoice file status. If they, only CPT’s with a line status matching the batch file status, are
included. This is used for situations where you might be refiling a line item for an insurance
previously filed. Note that if you change the insurance file status in an invoice you are
prompted to update the line items too in order to minimize the chance that you have a claim
flagged, but no line items (meaning nothing will be submitted). Be sure to check occasionally
that you are covering the variables that this filter provides. A good way to do this is to set up
these variables with prebuilt parameters in Report Manager.
○ Invoice Post Dates: Typically set to All so you can retrieve all claims to be filed based on the
other filters. If you are setting up an automated job that will run repeatedly as a Rule Manager
or Report Manager task, use All or Dynamic From and Thru dates so that only one job is
necessary and the system filters based on the current date when it is run.
○ Providers, Insurance Companies, Insurance Classes, Facilities and Financial Groups:
These filters are typically set to All, but you can file by other types by using the drop-down
menu to make individual selections in each category.
6. On the e-Claims Invoices screen, where the system has filtered the matching invoices. The
details of the batch are shown above the grid. There, the Batch Number, Total Invoices, Errors,
Warnings, and Selected # and $ amounts are shown. The invoices listed in the grid are coded by
color, with: Red indicating ANSI errors that must be fixed before the invoice can be included in
the batch, Yellow indicating file level errors that may or may not be true errors. They can be
included in the batch at user discretion, and Green indicating there are no errors on the invoice—
it will be included in the batch unless you choose to exclude it.

For invoices shown in red, the error must be corrected to include the invoice in the batch. To fix
the error, click the Select box of the invoice to be fixed and click Edit Invoice button or doubleclick the red text. The invoice appears on screen. Fix the error and then save. Upon returning to
the error screen, you notice that the error number has not disappeared. Fix the errors on all the
other invoices in the batch that are red, and then click the Error Check button. The list is
reevaluated for errors.
The system creates a claim file in the directory specified. A status bar shows the progress, and a
message line tells you how many claims are in the batch. A system prompt appears when it has
finished. Verify that it does not tell you there are any errors (see note below). Click OK, then
repeat the process for your next claim file if building in batches.
Upload the claims. The way this is done depends on the connection. Once you have configured
the clearing house interface you can use it at this point to upload valid files. Alternatively you
may log in to your clearing house web site or other system using alternative methods.
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Notes:
•

As soon as each file is created, the file status is changed so that the second letter is X (e.g. EX,
UX). A file history for each claim is also updated with the batch and date information. This can be
accessed by clicking the File History button in the insurance tab of an invoice, or the File History
tab in the patient demographic file.

•

Claims can be reactivated (set back to EF) by batch. See below.

To access batch history:
1. Click Claims > Batch File History.
2. The e-Claims Batch History screen will open. This is the same screen that opens when you
Rebuild or Reactivate a batch using the

button to search for the batch number.

3. Select a batch from the list and click OK.

To rebuild an electronic batch file:
This option is used when you wish to refile a previously created batch.
1. Go to Claims > e-Claims.
2. Click the radio button for Build from a previous batch.
3. Enter the Batch Number you wish to rebuild. Use the

button to search for the batch number.

4. Click the Next button to continue creating the batch as usual.

To reactivate previously built electronic claims:
This option is used when a previous batch needs to be refiled, or when the batch was created but
never filed. When the batch is reactivated, all that happens is that the claim status is changed from
EX back to EF. The claims in the batch will then be collected in the next batch created which matches
their criteria.
1. Go to Claims > E-Claims.
2. Click the radio button for Reactivate a Batch Previously Built, then click Next.
3. Enter the batch number of the previous batch, then click Reactive. The system reactivates all the
claims it can. A system prompt gives a summary of the number of invoices found and activated,
as well as failures. Failures are usually invoices that have been deleted.

To print a list of electronic claims with a filing hold:
1. In the Bill module, go to Reports > Invoice Hold Summary.
2. Click the printer button to view the summary. The list can be printed from the preview window.

Refiling Claims
When a claim is refiled, it uses the information that was created in the original invoice and prep. This is
extremely important because some claims are refiled months after the actual visit. In the interim, other
information in the patient file may have changed. Thus, if a patient changes insurance, the refiled claim
will still, correctly, reflect the insurance at the time of the visit. If the information has changed, you will
need to do this manually.
There are five ways to refile claims:
•

Individually change the filing status of each invoice back to NF or EF. See Changing the
Insurance Filing Method for instructions. This method is most often used after getting a claim
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rejected. After fixing the problem, the user changes the status back to the original filing method
and the claim is included in the next batch.
•

Recreate an entire batch. To do this, you will need to know the batch number. This is why we
suggest that you keep copies of your batch summaries, because this shows the batch numbers.

•

Change the filing status for all claims in an electronic batch. The claims are reactivated and will
be in the next batches set to include them.

•

Refile a line item or invoice. If a payment is distributed amongst line items, users can set the
Action Flag for each line item for refiling. Upon saving the claim, the invoice filing status is
changed to this status, and it will be included in the next electronic batch.

•

Reprint a paper claim after saving payment. If a claim needs to be refiled with a narrative, there
are benefits to printing it immediately after receiving the insurance rejection, since it will be fresh
in the mind. The payment window has a check box for doing this. Upon saving the payment, a
claim is generated immediately. Thus, you will be able to attach the narrative or other information
and put it in the mail, instead of putting a sticky note on the side of your computer to remind you
to pull the claim from your next batch.

Changing the Insurance Filing Method
Sometimes the default insurance filing method that e-MDs Bill sets for a claim needs to be changed. This
may be the case for a claim that would normally be filed electronically, but the invoice includes diagnosis
codes requiring a narrative to be filed. In this case, a paper claim with narrative attached would be the
easiest way to send the claim, so the EF flag needs to be changed.
Changing the insurance filing method can be done at the time of invoicing, or later in an edit mode.

To change the insurance filing method:
1. If changing the method after saving the invoice, load the patient, then double-click the invoice to
load it in edit mode. If changing the filing method during invoicing, you can do this after entering
diagnoses, charges, and any applicable copayment.
2. Go to the Insurance tab.
3. Highlight the insurance company and click Edit.
4. Click the radio button for the filing type desired.
5. Click Save, then save the invoice.

Setting an Electronic Batch as a Test
This requires the user to modify one of the NSF Definitions, or change a setting in the wizard for ANSI
claims.

To set an NSF batch as test:
1. Click Claims > NSF Definitions.
2. Select Record Type AA0.
3. Navigate to the Test/Prod Ind field 21 and highlight it.
4. Set the Active Detail to N.
5. Type the word TEST into the Constant field at the top right.
6. Click Save, then Exit.
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Once your clinic has passed the testing phase, you will then have to cancel this. The Test/Prod field is
usually set to PROD for production claims, or may be left blank depending upon the requirements of the
system to which the claims are going to be transmitted.
Note: If your clinic transmits NSF claims to McKesson, set the File Ind and File Ind 2 fields in the Claims
> EDI Options file.

To set an ANSI batch as test:
Set the Production/Test option in the first window of e-Claims to Test.

Correcting Claims Errors for Insurance Refiling
Claims can be rejected for many reasons. e-MDs Bill performs numerous edits for insurance purposes
when users enter patients, insurance companies, providers, invoices and so on, and also when you
generate claims batches. However, the system cannot catch everything. When a claim is rejected, it is
usually simple to fix the problem and resend it. However, you will need to know where to fix the problem.
There are four kinds of claim rejections:
•

Electronic File or Paper Claim Print Problems: These are errors related to the way a batch is
created or printed. They generally only occur with the first few batches a clinic files, since the
definitions files for each are then set to circumvent the rejections. Once these problems have
been corrected, you should be able to refile the claims.

•

Non-Invoice-Specific Data Errors: All claims include information that is not necessarily specific
to an invoice. For example, facility information. If this is incorrect, users must locate the data file
from where this information is being drawn and correct it before trying to recreate the insurance
batch.

•

Errors in Data Files Directly Related to Invoices: These are errors in files like the patient,
guarantor, insurance or provider files. If an insurance policy number is incorrect in the patient file,
all invoices created will reflect this. Because the information drawn from related invoices is
“frozen” in the invoice, users will need to correct the information in the root file first, and then the
invoices to which the error has been passed. Subsequent invoices will also reflect the correction.

•

Invoice Level Errors: These are for data fields specific to an invoice including ICD and CPT
information, or things like missing hospital information. These can be corrected by editing the
invoice and/or claim form and then resaving.

After correcting an error, forget to change the invoice insurance status from EX or NX back to EF or NF
so the claim is refiled.

Filing Supplementary Insurance
Some patients have more than one insurance plan. Their supplementary, or secondary, insurance takes
care of residual balances on invoices after the primary insurance has paid its percentage of the allowable
amount. It is important that clinics file the supplementary insurance because the collections can amount
to many thousands of dollars. For this reason, e-MDs Bill has some built in features to make the filing of
supplementary insurance simple for users.
•

Automated Flagging of Secondary/Tertiary Claims: When a user saves an insurance
payment, the system performs several checks. If there is a balance on the invoice, the insurance
against which the payment is being made has a filed status, and there is a another insurance, a
system prompt asks if the user wishes to file a secondary claim. The prompt also lists the
secondary insurance, as well as the insurance type. Based upon this information, the decision
can be made by the user. Click Yes to set the secondary insurance file status to EF or NF. The
secondary claim is in the next electronic or paper batch.
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•

Changing Invoice Financial Group: Changing the invoice financial group is often required for
insurance filing or reporting purposes due to definitions that pull provider numbers being based
on these. Another prompt upon saving a payment asks if the user wishes to change the invoice
financial group.

Notes:
•

The ability to change the invoice financial group at this stage is also important for reporting purposes.
For example, you can change the invoice financial group to PVP if the patient’s guarantor is
responsible for the invoice balance. At any time, you can print reports on all guarantor balances using
the financial group filter. By extension, you may then have to change it again to a financial group
designated for collections to make all the collections accounts a reportable entity.

•

Changing the invoice financial group does not affect the patient financial group.

Medigap Insurance
A Medigap policy is a type of supplementary insurance to Medicare Part B primary (although not all
secondary policies are Medigap). Unlike most other supplementary filings, Medicare usually forwards a
residual balance claim to the gap carrier. The Medicare EOB includes a reference to this. If this is the
case, it is not necessary to file the secondary yourself. However, it is still worth ensuring that the gap
insurance pays – the determination to file a gap payor is experience-based. Two issues arise with for
Medigap:
•

Claim Filing

•

Reporting

Filing Claims
If an electronic claim file is generated and the patient’s insurance type is MG, the system makes the
determination to insert the Medigap number instead of the payor ID in certain fields.
Paper claims are slightly different. Medicare has some requirements with respect to boxes 9c and 9d of
the CMS/HCFA-1500, if the secondary payor is Medigap. In short, these requirements state that if a
secondary payor is Medigap, the Medigap number must be printed in 9d, and 9c can be left blank. If the
Medigap number is not known, then the insurance name is required in 9d, and 9c must include the short
address of the payor. e-MDs Bill includes some special programming to take care of this. If the secondary
payor is type MG, then it will put the Medigap number into 9d, but if there is nothing in the Medigap field, it
will print the carrier name and put the short address in 9d. If the insurance company type is not MG, it
prints the payor name in 9d as usual and leaves 9c blank.

Reporting
When prompted to file secondary insurance after taking the Medicare Primary payment, the user will see
if the secondary insurance type is MG (assuming this has been set up correctly in the insurance edit
window when adding the gap insurance to the patient). If so, the user can click the No button in the
secondary filing prompt since the expectation is that Medicare will forward the claim. However, it is still
worth checking Medigap balances on a regular basis. One of the best ways of doing this is to create a
reportable entity. The invoice financial group classification can be used for this. If the clinic changes the
invoice financial group to GAP (or other designation), a regularly scheduled insurance status report (there
are two; the Crystal report is recommended) can be run on GAP invoices to ensure that secondary
balances are paid.

Tracking Insurance Claims
It goes without saying that it is extremely important to stay on top of insurance claim filing, not only to
ensure that claims are filed, but also to ensure timely payment and to track re-filings. This section
explains what to do in each of these circumstances.
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Checking to See if a Claim has Been Filed
By default, e-MDs Bill automatically places insurance claims in the electronic or paper queue, but if the
user does something which changes this, then the Insurance Status Report is a way to catch this. It
shows, among other things, if a claim has been filed or not, the method, and the last date it was filed. The
report is sorted by insurance carrier and date range and should be printed on a routine basis. We
recommend weekly or immediately after insurance claims have been printed and electronically filed. This
ensures timely filing of any claims which have slipped through the net, and also that the list and follow up
does not become too cumbersome.
If there is no date or method associated with an invoice (easily seen because these claims will show up
as blank white areas in the columns), then the user can check to see if insurance is required and, if so,
flag it for filing in the next batch.
You can also check an individual claim by clicking the Filing History button in the invoice Insurance tab. A
complete history of all filings on the claim is displayed. If you set the automatic invoice follow actions and
collections notes, you can also have the system automatically set the status code when a claim file or
form is generated and at the same time an invoice note with the filing history is added.

Checking for Timely Payment
To prevent delayed payment of claims, the Insurance Status reports (from Reports menu and Crystal
Report) can also be used to check if payment is being made within a reasonable amount of time. The
report can be printed for a prior period. For example, if payment from an insurance carrier is expected
within 60 days, print the report for a date range prior to this. By looking in the Ins Paid column and
comparing it to the invoice date, you can search for zero amounts and follow up on the claims.
You can also use some of the interactive work lists in the system. The collections module has a number
of follow up filters. The daily work list has a balance range filter and the main posting ledger window also
has these. You can also set invoice status codes or follow up actions (manually or automatically) that
give you an extra segregator for search filters since the status or action can be based on insurance filing.

Monitoring Claims History
There are several ways to view a claims history for an invoice or patient:
•

Insurance Filing History: Whenever a claim is filed for an insurance on an invoice, the system
stores this activity in a history table. The history can be viewed within a claim and from the
patient file. This file history shows the invoice #, the batch(es) in which it was filed, the item
number that it was in that batch, the number of forms printed if the claim output was CMS/HCFA1500, the date/time filed, the file status and financial group at the time the claim was generated,
the insurance to which it was filed, and any claims error codes that were not fixed when it was
filed.
○ Claim: Open the invoice in edit mode and click the File History button. You can also click the
Edit button with an insurance highlighted to view the First and Last File Dates. Note that if you
remove an insurance entry from an invoice and then read it, the history may not be available
again and must be viewed from the patient file.
○ Patient: Open the patient’s demographics file in edit mode and click the File History tab.

•

Invoice Notes: If you are using the master invoice follow up action of “INSFILED,” whenever the
claim is filed a note is automatically added to the invoice. It is date/time and user stamped and
also shows the file status, insurance filed to, batch number and financial group. Depending on
your setup, it might also show an assigned to user and date and a user defined invoice status.

Both histories can be printed. For the File History in the invoice and patient files click the Print button
available when viewing these. The invoice notes window has options to print a selected note or all the
notes on the invoice.
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Filing Secondary Insurance
As explained in other parts of this manual, secondary filing can be manually prompted, or automated. If a
patient has supplementary/secondary insurance, and there is a balance on the invoice after taking
primary insurance, the system will automatically prompt users to file secondary. Based upon claim
requirements (is it Medigap?), you can answer this to your preference.
If answered in the affirmative, the system automatically sets the secondary insurance file status to EF or
NF and it will be included in the supplementary claim. It is important to pay attention to the financial group
pop-up that appears after the secondary filing prompt. Since a lot of claims are filed by batch, and there
may be special NSF, CMS or HCFA definitions for a financial group, your invoice financial group must
match the requirements for filing the secondary claim.
If you are not filing secondary, you may still need to change financial groups. For example, Medigap
claims cannot have to be filed by offices since Medicare automatically forwards them to the relevant
carrier. It is still important to track these filings, so you may create a Medigap financial group purely for
reporting purposes. This allows you to generate reports, such as the insurance status, purely for gap
claims to ensure they are paid. If not, you should manually change the invoice filing status for the
supplementary and file in your next insurance batch.

Filing Insurance for a Company Other Than the Primary
If primary does not cover procedures, you can sometimes print claims for secondary insurance. In such
cases, you can delete the primary insurance from the claim (or set the status to Null), and set the
secondary insurance to the filing status you require.

Clearing House Interface
The Clearing House Interface (CHI) is a utility which can be used to automate the upload and download
of files. It can use HTTPS as well as FTP connections. There are some additional options to use third
party GPG and PGP encryption keys which can be licensed from those third party entities.
The CHI is already set up with some defaults based on e-MDs clearing house partners but it can be
configured by users to meet the requirements of some other direct or clearing house connections. The
CHI is available under Claims > Clearing House Interface.
In effect, the system is set up to poll locations which may be local or on 3rd party networks (FTP, HTTPS).
The main CHI window is where you can view settings for inbound and outbound transfers. This is
described in more detail in the sections below on sending and receiving files.
In the latest version of the CHI, you can either use the File Type Options and General Options buttons to
manually set up the software, or you can use the new Setup Wizard which will guide you through the
process.
The CHI is launched either by itself from a desktop or menu shortcut that you can set up, or from eClaims. The last step of the wizard has an option to launch the wizard after building a batch. This is very
useful because you can then click a button or two and have the file uploaded immediately without needing
to log in, etc. For downloading other files, you will need to ensure that you check for these regularly. The
CHI does have log files so that you can track activity. It is very important that you check these to ensure
that your claims are being uploaded.

Setup Wizard
Press the Setup Wizard button in the lower left corner of the main window to begin. Before beginning the
process, please read the first screen to determine if you have the information needed to complete the
process. If you close the window before getting to the end of the wizard and clicking finish, your changes
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will not be saved. Therefore it is very important to have all of the information mentioned in this window
before you begin or you may have to re-enter some information. Most of the information will come from
your clearing house or your internal IT department.
The tabs in the wizard will explain each field individually. Simply click the next button at the bottom of
each screen once you have filled out all of the requested information. Clicking previous will bring you
back to the previous tab, though you can also click on a specific tab to edit that information. If you click
on a previous tab and then click next, the following tabs will disappear due to the fact that some
information that you have changed may affect which tabs will appear in the wizard. Depending on your
answers to certain questions, you may not be presented with certain tabs. When you reach the end of
the wizard, click Finish to save.
The system will do some data validation to make sure you have filled out any required fields each time
you click the next button. When you click the finish button, several of these errors and warnings may
appear again if you do not correct them. Some warnings can be ignored if they do not apply to your
situation, but most warnings must not be ignored.

File Type Options
To configure the file type options:
1. Go to Claims > Clearing House Interface.
2. Select values for the File Type and Clearing House. The fields and functionality in the
Outgoing and Incoming sections will change based on prior settings if they exist.
3. Click File Type Options. The Claims Options window for the EDI connection opens. A dialogue
box also appears. It gives you the option to review information in read only mode so that
changes which could affect cash flow are not made inadvertently. Click No if you are sure you
want to continue in edit mode.
4. Set the options as described in the “File Type Options” table.
5. Click Save.
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File Type Options
Enable File Type Check
Box:

This enables or disables the ability to send files to the clearing house and file type
selected in the displaying in the window title bar above the box. If the box is
unchecked then the fields in the tabs below are not editable.

Transmission Options Tab

This tab includes options related to the connection to the clearing house’s servers.
•

Special Clearing House: This box is used for setting up to send to clearing
houses that need special coding or formatting to send files. If your clearing
house does not appear here, then select “Other”. The “Other” option will allow
you to send and receive from a standard FTP or HTTP server or to interface
with a custom application.

•

User Name and Password: Enter the user name and password supplied by
the clearing house to log into their system for transmitting. Enter the password
supplied by the clearing house to log into their system for transmitting.

•

Transmission Method: Select the appropriate transmission method used by
your clearing house. The choices are FTP, HTTP, or application.

•

Transmission Type: This automatically displays Batch or Real Time based on
your transmission method or special clearing house selections. At this time
FTP and Application can only send in batch mode and HTTP can only send in
real-time mode.

•

Outgoing Files Address: Enter the full URL path to the server that you send
files TO.

•

Incoming Files Address: Enter the full URL path to the server that you receive
files FROM.

•

Timeout: Enter a timeout period in minutes from 1 to 60. This is the amount of
time that the system will wait for your files to finish transferring. On a slow
internet connection you may wish to set this higher; otherwise, 1 to 2 minutes is
usually sufficient.
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Encryption Options Tab

•

Response File Extension: Enter the file extension you would like added to the
end of your file names. This will only change it if there is no extension on the
file you have received.

•

ENS Organization ID: If transmitting to ENS, you must include your
Organization ID. Contact ENS if you cannot know this ID.

•

ENS Transmission Mode: If transmitting to ENS, you must select a
transmission method, either Production or Test. Test can be used if you are
having issues with connectivity. Files sent in Test mode be processed.

•

Sent Files Archive: Use this to set up a folder to archive your files that you
send to your Clearing House. This is especially useful if you use wildcards or
use the same file name every time you send a file. It’s a good idea to manually
clean out this folder every so often to save hard drive space.

•

Response Archive: Use this to set up a folder to archive your response files
after a certain number of days. It’s a good idea to manually clean out this folder
every so often to save hard drive space.

•

Archive Responses After: Set this to a number of days. Every time you
download responses, the system will check for files that are older than this
number of days and archive them to the directory above.

This tab includes options related to encrypting files prior to transmission. Some
clearing houses cannot have an encrypted internet connection so the files
themselves must be encrypted. This information refers to GPG and PGP® software
packages. You can download GPG software free of charge from www.gnupg.org.
You can purchase PGP® from www.pgp.com. Disclaimer: e-MDs does not support
the GPG or PGP® software nor can e-MDs accept any liability related to installing
the software on your computer.

•

Enable Encryption Checkbox: Enables or disables all encryption functionality
for the clearinghouse and file type listed at the top of the screen.

•

Integrate with GPG: Enables or disables integration with GPG. If you are not
using GPG check this box.

•

Path to GPG: Using the browse button select the gpg.exe file from the directory
where you installed the GPG software.
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Encryption Key Setup Tab

•

File Extension: Enter the file extension that you would like your files to have
after they are encrypted.

•

Key Name: Enter the name of the key that you created either in GPG or using
the encryption key setup tab.

•

Public Keyring: Select the path to your secure keyring file. See above for
default location. By default GPG installs these files in a folder in the application
data folder in your windows user’s Documents and Settings directory. The path
will often be something like: “C:\Documents and
Settings\<username>\Application Data\gnupg” where <username> is your
windows login.

•

Secure Keyring: Select the path to your public keyring file.

•

Integrate with PGP Checkbox: Check this if you areusing a PGP key.

•

File Extension: Enter the file extension that you would like your files to have
after they are encrypted.

•

Key Name: Enter the name of the key that you created using your PGP®
software. For more information on creating a key please refer to your PGP®
userguide.

•

Secure Keyring: Select the path to your secure keyring file. By default this is
installed in the Windows user’s My Documents in a folder named PGP.

•

Public Keyring: Select the path to your public keyring file. By default this is
installed in the Windows user’s My Documents in a folder named PGP.

This tab includes options for setting up your encryption keys if you are using GPG to
encrypt your files. If you are using PGP, you must do this within the PGP software
at this time. Note: For more information about encryption keys, please refer to the
manual included with your encryption software. You must enable GPG and select
the GPG executable file and key rings on the Encryption Options tab to use these
functions. This information refers to GPG software package. You can download
GPG software free of charge from www.gnupg.org. Disclaimer: e-MDs support the
GPG software nor can e-MDs accept any liability related to installing the software on
your computer.
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Custom Application
Options

•

Create GPG Key: Selecting this button will run the GPG function for creating a
secure and public key for use with your clearing house if needed. This will bring
up a separate window which will prompt you to set up this key. For more
information about this function please refer to the GPG manual.

•

List Keys: Selecting this button will bring up a separate GPG window which will
display a list of keys in the keyrings selected on the Encryption Options tab.

•

Export Key: Selecting this button will create a public key file for sending to your
clearinghouse if required. A GPG window will open to ask you which key you
would like to export.

•

Browse: Used to select a public key received from your clearinghouse so that
you can encrypt files to send to the clearinghouse.

•

Import Key: Once you have selected the file using the Browse button in 4 you
must press this button to import the key.

This tab includes options for setting up a custom application, supplied by your
clearinghouse to transmit claims. This allows the clearing house interface to send
command line options to the other software. A list of these follows this section.

•

Application: Use this to select the application you would like the interface to
start when you click Send File from the main window.

•

Send Arguments: Enter the command line arguments for the application
selected above in 1 that need to be used when sending files. This information
can usually be obtained from the software publisher. The system can use
options to insert data from the software into the command line upon sending.
For a list of command line options see below.

•

Receive Arguments: Enter the command line arguments for the application
selected above in 1 that need to be used when sending files. This information
can usually be obtained from the software publisher. The system can use
options to insert data from the software into the command line upon receiving.
For a list of command line options see below.

•

Wait for Application to Exit: When this box is checked, the clearing house
interface will wait for your custom application to exit before allowing you to
continue. The amount of time it will wait is determined by the timeout entered
on the Transmission Options tab. If your application, does not exit after sending
files, leave this unchecked.
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Custom Application Command Line Options
Type this
%ad
%ap
%ou
%gk
%pk
%gf
%pf
%gs
%ps
%gp
%pp
%fp
%fd
%fn
%fe
%re
%un
%pa

To Insert
Transmission Address (If sending, it will insert the outgoing address from the transmission
options tab; if receiving, it will insert the incoming address.)
Application Path (path selected in the application box on the custom application options tab)
Output Directory Path (path selected in the Output Directory box on the main screen)
GPG Key Name (from Encryption Options tab)
PGP Key Name (from Encryption Options tab)
GPG File Extension (from Encryption Options tab)
PGP File Extension (from Encryption Options tab)
GPG Secure Keyring Location (from Encryption Options tab)
PGP Secure Keyring Location (from Encryption Options tab)
GPG Public Keyring Location (from Encryption Options tab)
PGP Public Keyring Location (from Encryption Options tab)
File Path (full path to the file being sent)
File Directory (full path to the directory in which the file being sent is stored)
File Name (name of the file being sent)
File Name without extension (name of the file being sent without the extension)
Response File Extension (from Transmission Options tab)
UserName (from Transmission Options tab)
Password (from Transmission Options tab)

General Options Window
The General Options window is where you can set up file paths and internet settings.

To configure general options:
1. Go to Claims > Clearing House Interface.
2. Select the File Type and Clearing House.
Click General Options and specify your options as described in “General Options.”
Enter the e-MDs username and password that you would like the system to use to log in when using the
auto transmit feature. Then click Setup. You must click Setup to save this. Clicking Save does not save
the username and password.
Click Save.
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General Options

File Paths Tab
Path to Log

This is the path to the log file. Certain operations, such as transmitting a file,
produce output which can be saved to the log file. This box sets the default location
for that log file so you have to be prompted every time.

Always Prompt to Save

Checking this box will force the system to prompt you before saving information to a
log file. This is ignored if using the auto-transmit feature.

Default Save Method

Select whether you would like the system to create a new log file every time
(Overwrite) or to add to the existing file (Append). Note: if you use the Overwrite
feature you will lose the data from the last time you saved a log. If you choose the
Append option you should delete this file every so often to prevent it from getting too
large.

Path to Store Temporary
Files

Certain operations, such as encryption, require the system to create a temporary
file. Use this box to specify where you would like those temporary files stored.
Note: In most cases these files are deleted immediately but if an error occurs the
files may be left behind. You can safely delete any temporary files after the program
closes if they are left behind.

Path to GPG

If you are using GPG for encryption, you can select the gpg.exe file here so that the
system knows where it is installed. You can also set this path in the Transmission
Options window.
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Internet Settings Tab
Enable Proxy Server

If checked, the system will attempt to use a proxy server for internet access. If you
are not sure if you have a proxy server, leave this unchecked or contact the person
responsible for your internet setup.

Proxy Server Address

Enter the network address of the proxy server you wish to use.

Port

Enter the network port used for proxy operations.

Proxy Server Username

Enter the username used to log into your proxy server.

Proxy Server Password

Enter the password used to log into your proxy server.

CHI Standalone Operation Command Line Options
The Clearing House Interface will log in automatically if you run it from the Bill software. However, if you
wish to create a shortcut to run it is as a standalone, you can use the below command line options to
allow the interface to log in without prompting the user. Some users may find this easier for uploading or
downloading files and you can also configure several different shortcuts for different transmission types.
Note: It is not recommended that you include a SQL password in the command line arguments as the
password will be stored in plain text which will allow anyone using the computer to see it. It is instead
recommended that you use WinNT Authentication to log into the database or use the login group option
instead. This requires that the Windows user is set up on the SQL server for read and write access to the
database. If using WinNT Authentication, the SQL username and password are not required.
The clearing house interface can be set up to automatically transmit using the Windows scheduled tasks
module. Below is a list of command line arguments that can be passed to the system to facilitate this
automated process. (For ease of setting up these options, a command line generator is provided from
the main window in the Clearing House Interface. This window is described in more detail below.) To
make the system transmit in automated mode you must use the -a command line option along with a
database, server, and authentication method (either WinNT or a SQL username and password) or a login
group which contains all of this information. If you cannot include a file type, clearing house, or path, the
system will attempt to use the defaults if they are already set up. If these defaults are not set up, the
system will add an error to the log file, and will not be able to transmit. (Always be sure to check the logs
after the system transmits when using the auto transmit feature to make sure it sent successfully.)
Short Option
-d
-s
-w

Long Option Name
-database
-server
-winnt
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Short Option

Long Option Name

-un
-pa

-username
-password

-g

-group

-a

-autotransmit

-l
-f
-c

-log
-filetype
-clearinghouse

-cid
-p

-clearinghouseid
-path

Command
username and password are required for automatic login)
SQL Username
SQL Password (Not Recommended. See note above.)
This is the name of a login group listed in the main e-MDs login
window. This is the recommended way to select a database as
you cannot need to use any of the above options since that
information is stored in the group.
Enables the AutoTransmit Feature (Always be sure to check the
logs after the system transmits when using this feature to make
sure it sent successfully.)
This will open your log files in Notepad after finishing the
autotransmit process. (This option does nothing if the
AutoTransmit feature is not enabled.)
File Type
Clearinghouse Name
This is the ID that the database uses for identifying a
clearinghouse. This option is for advanced users only.
File to Send

A sample command line may look something like this:
"C:\Program Files\e-MDs\Solution Series\Apps\ClearingHouseInterface.exe” -group=6.2 clearinghouse=Availity -filetype=Claims -path="C:\Program Files\e-MDs\Solution
Series\EF\Claims\claims01012008.txt" -autotransmit

The first part, within the quotes” is the location of the Clearing House Interface file. This depends on
where you installed your e-MDs software but the above is the most common location. Then there is group=6.2, which indicates that the system should use the login group named 6.2 which will tell the
system the information to log into the database. The next part is -clearinghouse=Availity, which tells the
CHI select the settings for the clearing house Availity. The next part is -filetype=Claims, which tells they
CHI to select the settings for Claims. The next part is, -path="C:\Program Files\e-MDs\Solution
Series\EF\Claims\claims01012008.txt", which tells the system to send the file named claims01012008.txt
which resides in the folder C:\Program Files\e-MDs\Solution Series\EF\Claims\. You must include the full
path to the file, not just the file name. Finally, the -autotransmit indicates that the system should use the
autotransmit settings which allow the system to send and receive files without user input.

Command Line Generator

To launch the Command Line Generator:
1. Press the button labeled Cmd. Line Generator on the main Clearing House Interface window.
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2. Complete the field values as described in the “Command Line Generator Options” table.
3. Click Generate and a string of data will appear in the box below.
4. To copy this information to your Windows clipboard you can either manually select the
information and then type Ctrl+C or you can click the Copy to Clipboard button to the right of
the box. This will allow you to then paste this into your shortcut or Windows scheduled task setup
window.
Command Line
Generator Options
Login Group

This is the same as the login groups that are located on the main e-MDs login
screen when you click the down arrow button directly under the password box. This
allows the system to log in using information already saved in your system. To edit
or add to this list you must use the main e-MDs login screen.

Clearing House

Select the clearing house that you wish to have the software select when launching.
Generally, this will be the same as your default that is saved on the main CHI
window.

File Type

Select the file type you wish to have the software select when launching. Generally,
this will be the same as your default that is saved on the main CHI window.

Outgoing File

Enter the full path to the file that you wish to have the system send. You can also
use wildcards in this box.

Auto Transmit

Select this option if you wish for the system to automatically send your file without
any feedback from the user. This is useful for scheduled tasks where there may not
be a person at the workstation when you wish to transmit.

Manually Sending Files with the Clearing House Interface

These instructions assume that you have already set up the File Type Options and General Options for
the type of communication you are doing. If not, refer to the instructions on previous pages.

To manually send files with the Clearing House Interface:
1. Select a “File Type” such as Claims or Eligibility:
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Select a Clearing House. Note: if you are sending claims to McKesson you will need to install additional
software that can be downloaded from McKesson. If sending to a connection that requires encryption
(such as THIN or Gateway) you will need to install either PGP® or GPG software.
To make this File Type and Clearing House come up by default the next time you log in, press the Save
Default button.
Next you will need to select a file or group of files to send. This can be done using wildcards and a
directory or selecting a specific file. To use wildcards simply select the check box and select the
wildcards from the dropdown or click Add to add new ones to the list. Then select a directory using the
Browse button next to the Outgoing Directory box. If you are unfamiliar with using wildcards for filenames
or simply want to send one file then leave the box unchecked and click the browse button by the Outgoing
File box.
Once you have selected the correct file or wildcards and directory, make sure you are connected to the
internet and press Send Files.
Finally, if you wish to save the settings in the outgoing box for the next time you send a file or group of
files press the Save Settings button at the bottom of the screen. These settings are specific to the
Windows user and the computer that the software is running on.

To manually receive files with the Clearing House Interface:
1. Select a File Type such as Claims or Eligibility:
2. Select your “Clearing House”
3. To make this File Type and Clearinghouse come up by default the next time you log in, press the
Save Default button.
4. Next you will need to set up the system to be able to transmit this file type to this clearinghouse if
you have not already done so. To do this, press the File Type Options button. If you are not sure
how to set this up, please contact support for assistance.
5. Next select the directory in which you wish your files to be stored.
6. Then, press Receive Responses to have the system download any files that are available to your
computer.
7. Pressing the View Responses button will then open a window which will display the directory that
the file(s) downloaded to.
8. Finally, if you wish to save the Incoming Directory for the next time you receive files; press the
Save Settings button at the bottom of the screen. These settings are specific to the Windows
user and the computer that the software is running on.
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10

Electronic Remittance
Advice
This is the system used to post payments electronically into the system by importing
an ANSI 835 remit file. Electronic post back may require separate enrollment with
payors. Call your clearing house or other connections to find out what is needed to
enroll and setup.
The electronic remittance system encompasses the following steps:
• Download the remittance file from either a bulletin board system or browser
based connection to the payor or clearinghouse. For some clearing houses or
other connections this process can be automated using the clearing house
interface.
• Import the file into e-MDs Bill.
• Select the file for posting.
• User processing is where the payments are actually posted. Users can also
perform a multitude of other functions that are typically done after posting. For
example, you can changing financial groups, print statements for residual
balances, or edit data.
Continued on the next page ...
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Overview of Bill Tools
The e-MDs Bill electronic remittance system includes some built in tools and reference tables for your use
to assist in ensuring correct posting, as well as reporting on activity. These tools include:
•

Adjustment Reason Codes: There are over 400 adjustment codes in the standard HIPAA/ANSI
set. Many of these are information only and are not posted. There is a reference table
(References > Adjustment Codes) that allows you to control the post vs. non-post setting of
each so that when an electronic remittance is processed, the system will adjust down correctly.

•

Process Status: This window shows how many invoices are in the payment batch, totals of billed
and paid amounts, and whether invoices have been matched or not. This is a handy tool to see
your progress.

•

Status Codes: Depending on the data sent by payors, Status codes may be received. The status
codes are shown on the main screen, and if there are problems, a crossed out dollar sign icon
tells that user to scan a particular payment more carefully.

•

Linking Tools: Not every payment in a remittance file can be linked automatically to an invoice.
The system tries to link by account number, date of service and insurance, but occasionally
payors will send corrected policy numbers back to the user. Upon selecting a file, e-MDs Bill
shows which are not linked and gives users tools to advance to each, with applicable methods to
link.

Application Setup for Remittance
Assuming that the rest of your system has been set up correctly, there is very little to do in terms of setup.
•

Clearing House Setup: A clearing house must be set up to receive remittance data. The system
uses the delimiters in the clearing house to parse out the file.

•

Clearing House Interface: This utility can be used to automatically download files to your local
network so users only need to import them into the system.

•

Payment Types: Each remittance file contains data concerning the payment method. In order for
these methods to show up on your Till Reconciliation and Activity Analysis reports, the types you
accept must be added to the Reference > Support Tables > Payment Type table. The system
matches the payment type received in the electronic remittance file to a payment type received in
the BPR04 of a remit file, otherwise it defaults to CHCK: Typically you will probably only use:
ACH: Automated Clearing House
CHK: Check.

•

Adjustment Types: The typical adjustment code which is linked to a payment is set up in the
same place as payment types. The system uses a default of AERN but you can configure this on
an insurance contract basis so that posted adjustments for each remit received for insurances
linked to that contract have their own reporting. There is more detail about contracts and their
linking elsewhere in this user guide. Simply put, set the Auto Adjustment Code 1 in a contract to
the one you haveset up, then ensure that each insurance company which falls under this contract
is linked to it.

•

Adjustment Reason Code Auto Post: As described above, the system is presupplied with the
ANSI transaction set. You can add your own for internal manual posting so long as they cross
into the required range. Verify the auto-post true or false settings for the adjustment codes
typically received. If false, the system assumes the adjustment is information only and does not
reduce the balance (e.g. for patient copayment amounts). True items are adjusted.

•

Download Folders: We recommend that your remittances are downloaded into a generic folder
called c:\program files\e-mds\ern (or a network path available to all). The system remembers the
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last folder. Depending on the number of payors from which you receive files, their file naming
conventions, and how often you process files, different sub-folders may be required to prevent
overwriting.

Windows in the Electronic Remittance System
There are two windows used by the remittance system.

Import/Select Electronic Remittance File Window
This is where you can see a list of remittance FILES imported into the system, and from where you can
browse for files that have been downloaded from payors. The file list shows the completion status, payor
creation date, control #, file location and name, date imported and the user who imported the file.
Users have options to show files by date imported and completion status. Files that have been completed
have a check mark in the left column.
This work list of imported files can be tasked to users in TaskMan, either as a manually generated task or
as one created automatically. Thus, someone can import files and then task them to someone else to
post. Use the Dynamic date filtering options for automated tasks so that the task can be run repetitively
based on then current information.

Electronic Remittance Window
This is the window where all the processing is performed. The window is divided into 4 display sections
and some functionality buttons. Right click menus in the top 3 display sections open additional windows
so that users can process files faster. Some of the columns display information from invoices in the
system, and some display information from the remittance file.
Electronic Remittance
Options
Payment

This section is an alphabetical list of invoices for which there are payments in the
remittance file:
•
Status/First Column: Is blank, has a green check mark, or a green $ sign
behind a red X. The crossed out dollar is displayed if a payor transmits a
special data flag within their file indicating that the claim has been denied. It is
used to draw user’s attention to these. A green check indicates that the
payment has been accepted and posted. After processing a file, all invoices
should have a green check. The icon is dependent upon the Claim Status code
received in the remit. The status is shown in the last column.
•

Patient Name, Account #, Invoice #, Policy #, Invoice Date, DOS, Billed
Fee, Allowed Fee, Balance: Data pulled directly from the invoice. If the patient
name, policy # or invoice date columns are yellow, the system is indicating data
that it match (see later).

•

Payment: The total payment for the claim in the remittance file. This is not a
saved payment, that is in the next column.

•

Posted Payment: This column is blank until the user accepts a payment, at
which time it displays the amount posted. If the number is red, it is because the
total posted payment does not match the total of all the CPT line item allowed
charges, warning the user that the fee schedules may need updating, or the
payor is not paying the contracted amount.

•

Posted Adjustment: The sum of all line item adjustments accepted by the
user.

•

Copay Balance: The current invoice copay balance. This column is shown so
that users can compare it to specific payor adjustments for copayments to
ensure they bill correctly for this. If it’s incorrect, the user can open the
insurance and modify the copay amount or %.
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Insurance/Group

Line Item Detail

Adjustment Detail

•

Due By: Shows the current status on this invoice.

•

Claim Status: Some payors send a status code in the remit file which is an
“overall adjustment”. The code is displayed in this column. A list of code
descriptions is available by clicking the Status Code button above the invoice
list.

This shows all insurances on invoices being paid. It is useful because users can see
if secondary can be filed, the method filed, etc. Users can right click an insurance to
open the invoice insurance window and change copay, flag a claim for refiling or
other information.
All the CPTs on the invoice are shown here. The system shows how much was
billed to the payor, and payment and adjustment information. If a payment amount is
shown in red, it is alerting you a discrepancy between the allowed fee and the
posted payment. The Posted Adj column shows the sum of adjustments that are
checked in the Adjustment Detail section. After a payment has been accepted, you
can right click any line item to open the CPT Distribution window with the specific
CPT highlighted. In this window, each payment and adjustment is a separate item.
This shows how the highlighted line item is being paid or adjusted. All adjustment
group and reason codes sent by the payor are displayed. Only codes with a green
check mark are posted against the balance of the line item. Other codes are
information only but will still be posted to the other adjustments columns in the
distribution so that they can be submitted on secondary claims. In the event that a
particular code should or be posted, but the setting is incorrect, use the Add
Adjustment/Revoke Adjustment button to change the setting for this particular line
item. For example, in order to submit Medicare secondary claims you must post
patient responsibility (PR group code amounts), but problem To change the method
permanently, a system administrator must update the Reason Code table.

Processing Remittance Files
There are several steps to processing a remittance file, each of which is described in detail below:
1. Connect to payor/clearing house and download files (this may be automatic or manual).
2. Select the file to process in the main remittance window.
3. Link any records that the system was not able to do automatically.
4. If necessary, change the posting date to match an electronic funds transfer, and filter by check.
5. Process the file according to the style you will develop (e.g. accept all then review, accept
individually). Make decisions and execute on things like appeals, transferring balances to
patients and printing statements, refiling, etc. This can be accomplished by answering prompts,
or by right-clicking records in the screen.
6. Continue processing other checks in the batch until the file is completely processed. Then go to
the Import/Select window and mark the file as completed so that you only see work to be done
the next time you go to the remittance system.

Electronic Remittance Reports
In addition to all the usual activity reports that include remittance data, there are two reports that are of
particular use for reviewing remit files:
•

EOB Report: An internal EOB report that shows how the report was printed and a summary of
adjustment reason codes. .

•

Adjustment Analysis: An analysis of line item reason codes. This can be used for follow up and
also features an interactive work list that lets you click through to underlying invoices on a work
list.
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Importing Remittance Files into e-MDs Bill
After files have been downloaded into a folder on your network, e-MDs Bill can import them.
1. Go to Claims > Electronic Remittance (Alt+C, R).
2. Click Browse. The system opens a browse window to the last folder browsed. First time users
establish this by navigating to the folder where remittance files are stored.
3. Select the file to import, then click Open.
4. Delete Select the Clearing House or other source of this file. This ensures the correct delimiters
are used to parse the file. See note below.
5. Click Import (Alt+I). The system imports the file into e-MDs Bill. A line count at the bottom left of
the window indicates activity. When the file is fully imported, it will appear as a record in the
Import window.

Posting Remittance Files
1. Click a file in the Import/Select list and click Select (Alt+S). The system returns to the main
Electronic Remittance window. Each invoice in the file is displayed as a record in Payment
section.
2. Set the Posting Date. The date displayed here is the date against which activity is posted. Keep
in mind that you cannot post data into a closed period.
The first task is to ensure all payments are matched to invoices. Where possible, e-MDs Bill does
this automatically. If there are problems, a field in the problem record is highlighted in yellow.
Resolve problems before posting payments, and in the following order:
○ Unlinked Patients. The Patient or Account No column is yellow. If the Unlinked Patient button
is available, click it to find the first one. Then click Link Patient. The system shows a list of
patients with similar demographics. It also shows the name received in the patient segment of
the remit file since the suggested list is based on specific segments that may not have been
populated by the payor, resulting in an apparently mismatched list. Select the most
appropriate one and click Link Patient. If none of the patients in the suggested list is a match,
use the Find Patient button to browse the patient database. Click the Unlinked Patient button
again to advance to the next unlinked patient.

Note: It’s worth noting that e-MDs has seen customers receive files with payments
completely unrelated to their practice. If you encounter this, you will not be able to use the
next patient button to advance to the next record automatically, so you will have to do it
manually.
○ Unlinked Invoices. The Invoice Date column is yellow. If the Unlinked Invoice button is
available, click it to find the first one. Click Link Invoice. A browse window of potential
matching invoices for the patient appears. The best method for matching is generally DOS. If
you are not sure, invoices can be opened in edit mode. Click Link to associate this invoice with
the remittance payment. Click the Unlinked Invoices button to advance to the next one and
continue until all unlinked invoices are resolved.
○ Unlinked Insurance. The Policy # column is yellow. Click the Unlinked Insurance button to
find the first one. Unlinked insurance generally means there is a policy number mismatch, a
frequent occurrence due to reporting of “dash” numbers for dependents on a policy. The
yellow policy number in the top section is the data received in the remit file. The policy number
in the second section is what is in the invoice. You have several choices. If you click the Link
Insurance Group button, it will link the payment to the invoice. If you check the Correct Policy
Number Automatically option and then click Link Insurance Group, the system updates the
patient policy number in both the invoice and the patient file.

Note: If you make a mistake when linking, right-click the record and click the Unlink Record
button above the list.
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3. If necessary, select the check number to post against using the list box at the top of the
remittance window. This filters the list of payments by check. Some payors send a separate
remittance file for each check, while others consolidate multiple checks into one batched file. This
filter is useful to maintain posting dates consistent with bank deposit dates.
4. Scroll to the top of the list and select the first payment. The Insurance/Group, and Line Item
Detail sections of the window show information from this invoice.
5. To see the adjustment detail for each line item, click the CPT codes and the Adjustment Detail
section will update. You have several action choices:
○ Accept the payment. Click Accept Payment or press the spacebar. A verification prompt asks
you to confirm, after which the system puts a check mark in the left column and moves to the
next item. If there is another insurance on the invoice, the system responds with another
prompt asking if you wish to file the secondary. Clicking Yes flags the next payor and also
gives you the option to change financial group, just the same as when posting manual
payments. You can always go back by clicking on the item. If you want to revoke the
payment, click the red Revoke Payment Button.
○ Refile the Primary Insurance. You still have to accept the payment, but can then right-click
the insurance and set the File Status back to EF or NF. Before doing this, you may need to
update patient or guarantor demographics, or the invoice itself. Options on the right-click
menu are available for this.
○ Change the balance Due By responsibility to the patient. Right-click the invoice and click
the option on the menu.
○ Print a guarantor statement. After a payment is accepted, you can use the right-click menu
option. This opens the new statement window with the guarantor already loaded. Add any
comments, etc. then preview/print. Close the statement window to return to the remittance
screen.
○ Accept Batch. This option processes the entire batch without further intervention. Only use
this if you are absolute sure you will not need to process claims further; or if your preference is
to post everything first and then revoke those that apply.
○ Add/Revoke Adjustment. This button in the Adjustment Detail section toggles depending on
the status of the adjustment highlighted. Only items with a check mark are posted into the
distribution adjustment fields which count against your A/R. Those which are “information
only” such as patient responsibility codes will be inserted into the Other Adjustment fields in
the payment, but cannot affect your A/R. The rest are treated as information only. Should an
item be incorrectly marked, it can be manually set to post or not for this line item. If the change
is permanent, update the master adjustment reason code reference table.
After the payment has been accepted, the right-click menu in the Payment section adds the
options to edit the payment. Here you can see check and other information about the
payment. It is important to understand that each remittance file may contain payments that are
being made with multiple paper checks mailed to your office, or EFT’s. Each is separated on
the Till Reconciliation report.
When a remittance is posted, all posted adjustments are summarized in the payment window
using the AERN adjustment code unless the first insurance in the list is linked to a contract
which has a different default adjustment reason code set up. The Activity Analysis reports
reflect these. The Adjustment Analysis reports are used to see the detail breakout of each
code received in an electronic remittance.
6. If you are unable to complete processing the file, e-MDs Bill will let users return to it later and
remembers which items were accepted. An important consideration here is that the posting date
for payments or adjustments is the date the payment is accepted. After completing the batch, the
file can be marked as completed in the Import/Select window.
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7. Select the file and click Set Completed. A checkmark appears in the left column. This does not
affect the file but is useful for display purposes and can be revoked if necessary.
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11

Tools
This section provides information on some tools and utilities that are unique to
Solution Series Bill. They are used primarily for working with invoices, payments, and
similar practice management functionality. For information on other Solution Series
tools that are also used in other applications, see the e-MDs Solution Series Utilities
Guide.

Continued on the next page ...
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Charge Sets
Charge sets expedite data entry and help ensure complete charge capture for commonly seen visits or
orders that use the same set of codes every time. Examples are flu shot visits in October, physicals, or a
single laboratory order that comprises multiple procedure codes. Sets allow users to create a panel of
these codes. The panel can be inserted into an invoice on its own, or can be supplemental to other codes
manually entered in the invoice.
By creating charge sets, users can save a great deal of repetitive keystrokes. This repetitiveness lends
itself to the degree of automation supplied by creating and using sets. A set can include diagnosis codes,
procedure codes and HCPCS codes. Users invoke the set by name when creating the invoice.
Charge sets are also synched to e-MDs mobile software used for remote charge entry. The system only
synchronizes charge sets that are linked to the same specialty as the owner of the device’s short list
specialty which is set up in the provider demographics.
Note: A similar tool to charge sets is CPT panels. See CPT Panels on page 75.

To create a charge set:
1. Go to Tools > Charge Sets. (This feature is also accessible by clicking the Chg Set button on the
invoice screen.)
2. Click New.
3. Enter a name for the set in the Description field.
4. If ICD codes are used in the set, click Add ICD. Search the ICD database for the applicable
codes, highlight them and click OK.
5. If CPT codes are used in the set, click Add CPT. Then click Find CPT to search the CPT
database for the applicable codes, highlight and click OK. Check modifiers, place of service, type
of service, fees and other information then click Close or Save.
6. Add HCPCS the same as CPT codes, except you click Add HCPCS.
7. To link the charge set to specialties for mobile synching, click the yellow + sign button in the
Specialties section, then select the specialty. To link to all specialties, click the blue + sign
button.
8. Click Save.

To use a charge set:
1. Start an invoice as usual. You may enter any information you need in advance or after invoking
the charge set.
2. Click Chg Set.
3. Click Find to display a list. To narrow the list, enter some of the start letters in the charge set
description before clicking Find.
4. Highlight the set, then click OK. The system returns to the invoice and adds the ICD’s, CPT’s and
HCPCS codes after any others that may have already been entered.
5. Check and, if necessary, update CPT to ICD links and other information.
6. Ensure primary ICD and CPT codes are displayed in bold. If necessary, set these manually using
the Set Prim. buttons.
7. Continue with the invoice as usual.
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Invoice Payment Due by Tool
This feature is a simple way to transfer the total balance of an invoice from insurance to patient or to reset
assignment according to insurance group. The display shows a list of patient invoices in alpha order as
well as a summary of financial information on the invoice and the current payment due by setting. This
setting is the equivalent of the Payment Due By radio buttons in the payment window. If the insurance
balance on an invoice is 0.00, the system sets the remaining responsibility to the patient.
This utility is also extremely useful if you have ignored e-MDs Bill’s strict assignment of invoice
responsibility according to the patient insurance group setup. If this has happened and you have created
problems with patient and insurance responsibilities, this utility can rectify the situation.

To transfer invoice responsibility:
1. Go to Tools > Invoice Payment Due By.
2. Click All Invoices to show a list of every invoice in the database.
○ Click Filter By Patient to search for and display invoices for a single patient.
○ Click Filter By DOS to show invoices for any patient within a date range.
3. Scroll down to the invoice you wish to change.
4. Double-click the invoice. The responsibility changes.
The Payment Due By information will not refresh unless you click Refresh Grid, but you can see
the new setting in the New Payment Due By display box at the bottom of the window.

Invoice Status Administration
This tool is used to set status codes for multiple invoices based on various filters such as date, balance,
current status, facility, collections, etc. Right-click and multi-select options are available within the grid.
This makes it a very useful tool to set multiple invoices very quickly so that collections staff are able to
find these in batches using tools like the Collections Module and the Daily Work List. Collections menu
items such as Edit, Set and Release are restricted to users with the Bill: Invoice Collections Status R/W/D
privilege.
The Invoice Status Administration interface can be sent to users as a TaskMan attachment. This is a very
useful way for staff to quickly detect invoices meeting a certain criteria so that follow up work can be
done. If you create an automated repeating task in Rule Manager to do this, be sure to use the Dynamic
date filter option.

To update invoice status codes:
1. Go to Tools > Invoice Status Administration.
2. Set filters to retrieve invoices (Facility, Patient, Provider, Balance, Dates and Current Status).
Note that Current Status has options to retrieve by specific status code, all status codes, or
invoices with no status code so that you can locate very specific records.
3. Click Search.
4. Select a Set to Status code.
5. Click Update.

e-MDs Solution Series Bill User Guide 8.0 R00

264

Superbills
The Superbill printer is an extremely powerful utility. There are many advantages to using the e-MDs Bill
superbill system if you cannot use e-MDs Chart:
•

Saves Printing Costs: It gives the clinic the ability to create its own route slips and print them
inexpensively using the network printers, thus saving having to get them done at an expensive
print shop.

•

Includes Patient, Insurance and Balance Information: Each superbill has header information
drawn from the patient record including copayment and deductible amounts, a warning comment
and other important information. This helps with more accurate copayment collection, as well as
easier collection of guarantor balances.

•

Billing Warnings: Superbills print the superbill comment from the patient file in bold at the top of
the form. These can be patient-specific or standardized warnings. Thus, the provider is alerted, at
the point-of-care, about things that could be important for billing and clinical purposes.

•

Superbills Can Be Printed in Batches Using e-MDs Schedule: If you have the scheduler,
superbills can be printed in batches in addition to individually. This saves time.

•

Provides an Audit Trail: This is one of the primary benefits. Each superbill is printed with a
unique number. This number can be associated with the invoice for the visit. The Superbill Audit
report shows the billed ones and the missing ones. This ensures that all visits are posted. The
number is automatically inserted into the invoice if the superbill is printed on the same date as the
invoice.

•

Multiple Superbills: The clinic is not limited to one superbill. Superbills can be created for each
physician. This is especially useful in multi-specialty clinics. In addition, superbills can also be
specific to insurance classes. Thus, if a particular carrier linked to the class has particular
payment rules in its contract, then a superbill can be created to cater for this. For example, if a
carrier does not pay for in-house lab, then a superbill can be created which excludes lab codes
found on the default, or which carries a warning. This can save an office from performing costly
procedures that will not be reimbursed. A further example is Workers’ Compensation visits. These
usually differ significantly from usual office visits.

The Superbill feature is something that every office without an integrated EMR should consider using. In
cases where there is an integrated EMR such as e-MDs Chart, then the billing codes from the chart will
automatically be posted to the billing system. However, some clinics will still make use of both charting
and Superbills since there is an element of comfort associated with the superbill. In addition, a superbill is
a good tool to ensure physicians using the EMR have billed all codes they should.
Note: If you are using Chart Superbills are really not necessary. However, if you feel the need for
paper you may also want to review two reports based on charges entered in Chart:
•

Chart Superbill: This can be printed from the visit print window (sign off) and includes a
summary of charges.

•

Charge Capture: This Crystal report includes a detail of every code entered in Chart as well as a
high level of information about the patient, guarantor and insurance demographics although that
is redundant in an integrated system. It is more typically used by practices which use Bill and
outsource to a billing service.

Creating Superbills
Before creating a Superbill, users should spend some time planning the elements they require. The
format of the Superbill is fixed, but users can put in any codes they wish. The ICD and CPT/HCPCS
codes are laid out in three columns. The system will try to even out the columns, but users should be
aware that as new categories (described below) are added, there may be some unevenness that can only
be countered by experimentation. There is no limit to the number of pages in a Superbill.
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Superbills cannot have to have ICDs, CPTs and HCPCS codes. You can choose just the elements you
want. These instructions also assume that each type is added in order, but you can go back and forth.

To create a Superbill:
1. Go to Tools > Superbill (Alt+T, S), or click the Superbill button on the toolbar.
2. Make sure you are in the Superbills tab and click New (Alt+W).
3. Enter a Superbill description. If the Superbill is specific to a provider or insurance class, select
from the drop-down lists. Class and provider names are not required.
4. Click Save (Alt+S).
5. Click the ICD, CPT or HCPCS Tabs to add codes to the superbill. The top half is where
categories or groupings are added. The bottom half is where the codes in each group are
displayed.
6. Click New at the top. Give the category a description. If necessary, add a footer message. The
footer could be a message to providers. For example, you can enter “Auth. Req. # __________”,
or “Add 5th digit!!!” Click Save. Add other categories if required.
7. Add codes to a category by clicking the description at the top, then click the New button at the
bottom to load the appropriate code search. You have to select codes individually.
○ Selecting a Consecutive Range of Codes: Click the first, then hold down the Shift key and
press the down arrow until the last code in the range is highlighted. Right-click anywhere in
the highlighted range and click Add Code(s) to Select List. A small box appears on screen with
all the ICD codes selected.
○ Selecting Non-Consecutive Codes: Click the first, then hold down the Ctrl key and click
additional codes. Then add the codes to the select list by right-clicking anywhere in the
highlighted range and click Add Code(s) to Select List.
8. Click Accept to put the codes into the superbill category. Codes are loaded in the order selected.
9. If necessary, change the category display order. Select the category, and click the Up or Down
buttons.
10. Edit code descriptions if necessary. In addition to changing descriptions, you might wish to add
things on the end. For example, the preventive codes for adults over 65 (99386 and 99387) might
not be allowed by an insurance company, so you can follow the description with “Not xyz ins!!!”.
11. Preview your superbill by clicking the Superbills tab and clicking Preview. If you want to change
codes, you can edit them. You can also change the ICD, CPT and HCPCS category or code
orders by using the applicable Up and Down buttons.
12. Once you have created a superbill, right click the superbill in the Superbills tab list and click Set
as Default Superbill. You can also click File > Setup Options and select a default superbill in the
Superbill ID field. A default superbill is required for each facility, even if the clinic only creates
one. The default superbill is displayed in bold.

Changing\e the Superbill Output and Including “Non-Code” Elements
For reasons such as saving space, you can alter ICD, CPT and HCPCS codes on a superbill to suit your
print requirements. You can even change a line in the superbill to be something completely different,
including spaces for blank lines. This is a useful way to add things such as lines for recall dates, follow up
items or to save space.
The best way to illustrate this is through the use of an example. We will use the standard office visit E&M
codes (99201 through 99215). If these are entered as is, you will use up 10 lines of the superbill. This can
be cut down to 5 by putting the new and established codes in columns. Here’s how it’s done.
•

Add a CPT category description. Using our example we could change it to “E&M New
Spaces are added between each to allow for columns.
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•

Add 5 CPT codes. Then edit each in turn to match the columns, i.e. “Level 1 99201 99211” or
“Level 2 99202 99212” and so on. Preview the superbill regularly to ensure that you have set
the correct number for each CPT, so they line up with the column headings created in the
category description.

As you can see, once you have created a category and put entries in the category, you can then change
those elements.

To delete a Superbill:
Before a superbill can be deleted, all the codes must be deleted first, then the categories.
1. Select the superbill description.
2. Delete all ICD, CPT and HCPCS codes.
3. Delete all ICD, CPT and HCPCS categories.
4. Click Delete in the Superbills window and click Yes on the confirmation prompt.

Superbill Print Controls (Defaults, Options, etc.)
Once Superbills are created, it makes sense to automate printing as much as possible, particularly if the
clinic uses multiple Superbills. Automation takes the decision as to which superbill is needed out of the
hands of the front office staff. There are some fields elsewhere in the system to assist with this.

Default Superbill
As described in the final step of creating a superbill above, the default is displayed in bold as well as in
the Setup Options screen. A default superbill is required for batch superbill printing from the appointment
scheduler. The default will print unless another superbill is selected.
Note: Default Superbills are facility-specific. A default must be set for each facility in the system. This
gives each clinic in multi-site operations the flexibility of default printing.

Superbill Print Output and Options
The superbill header includes a number of standard and optional information such as facility
demographics and tax ID, the superbill identifying information including unique superbill number and, if
printed from an appointment, the appointment information. There are fields to write in check in and check
out times.
The patient information includes name and nickname (bold), dob and age, gender code, address, ssn,
financial group, superbill comment (bold) and current balance. It also shows the guarantor name and
account number as well as balance and aged balances.
There are several print control options at the bottom of the Superbills tab. These are checkboxes that let
you decide if you want to include or exclude the sections. They remember the last setting used by user
and are adopted when printing from within the Superbills tool, the check in module, or the daily work list.
Superbill Options
Show Insurances

Includes or excludes a section with patient insurance information. The section
displays up to 3 insurances including name, group #, policy holder, policy #,
relationship, copay and deductible. It only shows current insurance. If the patient
has no insurance, the system prints “No current insurance”.

Show Payment

Includes a Payment Information section into which staff can manually write
payments received at check in so check out staff who might be in a different location
in the office can see what was done.

Print All Balances

When checked, the balances at the top of the printed superbill will reflect the total for
all facilities, not just the current one.
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Show Lab

Prints a blank area above the ICD categories. Doctors can write lab orders in this
section.

Hide Tax ID

If you want to print the facility tax ID on the superbill header, check this option.

Facility, Provider, Patient and Insurance Class Specific Superbills
As mentioned above, you can create multiple Superbills. A superbill can be:
•

Facility Specific: Every facility has a default. This is set in the superbills module or under File >
Options and is used whenever a more specific one is not found when printing superbills for the
facility.

•

Insurance Class or Provider Specific: They can also be both (class and provider). This is used
when a physician wants a different superbill to others, something that is common in a multispecialty practice. An insurance class specific one would be used when something that is
normally on the superbill might not be allowed by the companies linked to the class, or there is a
special situation like workers comp, airline physicals, MVA, etc.

•

Patient Specific: You might even wish to link a very specific superbill to a patient (done in the
Misc tab of patient demographics).

For the most part, practices will not go into these special iterations but if you do, you should understand
the hierarchy of printing. This only applies when printing Superbills for appointments (batch mode). If
you print Superbills from the main Superbills tab in the Superbills processing window, then it prints
whichever superbill is selected at the time.
If a patient has a specific superbill in his/her Misc. tab, that overrides all others. Then a provider AND
insurance class specific one is checked for, followed by insurance class, then provider, then facility
specific.

Printing Superbills
Superbills can be printed in batches based on appointments in e-MDs Schedule, or individually from the
Superbills module, the daily work list, or the check in module. Batch printing requires e-MDs Schedule,
but individual Superbills can be printed in several places. When appointments are printed based on
appointments the top right of the form also includes the appointment date/time, and visit reason, and the
resource at the top center.
The batch printing option is only available if you use e-MDs Schedule. It allows the clinic to print a
superbill for all patients with appointments on a particular day. Thus, the Superbills could be printed as
the first order of the day, and then individual ones printed for walk-in and new patients. The superbill
batch is printed in order of appointment.
Note: When printing from the scheduler, the superbill header includes the provider for whom the patient
is scheduled, as well as the appointment date and time. If printing individually, the date is the print date.

To print Superbills in batches or ranges:
1. Go to Tools > Superbills (Alt+T, S).
2. Select the superbill you wish to print. If no selection is made, the facility-specific default superbill
will print for all patients except those who have a specific superbill identified in their demographics
file.
3. Click the Printing for Appointments tab.
4. Select the date for which you want to print the batch.
5. Select a specific provider or check the All Providers box according to your need. As soon as a
selection is made, the system displays all patients with appointments in the current facility.
6. Click All to print all the Superbills displayed.
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7. Alternatively, select a range of Superbills to print. Click the appointment, hold down the shift key
then press the down arrow key until you reach the end of the range.
8. Click Selected to print.

Notes:
•

After a superbill has been printed from the scheduler, its display color changes to red.

•

If you leave the Printing for Appointments tab open, use the Refresh button to update the display
if additional appointments are added to e-MDs Schedule. Refreshes are automatic if you select
different providers, tabs, etc.

To print individual Superbills using e-MDs Schedule Check In module:
This option can be used to prevent Superbills being printed for no show patients. It requires superbill
printing to be set up as one of the check in tasks. See the e-MDs Schedule user guide for more
assistance.
1. Select the appointment, then right-click and click Check In.
2. Click Print Superbill in the task list.
3. Click Print. The preview loads from which it can be printed.
4. Click Complete to mark the task as completed.

To print single Superbills from the Daily Work List:
1. Go to Tools > Daily Work List.
2. Set filters to load an appointment list and click Work List.
3. Double-click the SB cell for the patient appointment. The superbill opens in a preview mode from
which it can be printed.

To print single Superbills in e-MDs Bill:
1. Go to Tools > Superbills (Alt+T, S).
2. Click the Superbills tab.
3. Click the Search button with the picture of a hand next to the Name field at the bottom of the
screen. Select the patient.
4. Click Print (or Preview if you want to look at the superbill on screen before printing).

Superbill Audit
The superbill audit is an extremely valuable feature that can be used to reconcile Superbills printed with
invoices generated, thus ensuring complete charge capture. Each superbill printed is given a unique
sequential number that can be entered in the Superbill field found at the top of each invoice window. The
Superbill No field only accepts numbers that have been printed. An error prompt appears upon saving the
invoice if this is not the case. If the superbill was printed on the same date that the invoice was
generated, the number is automatically entered in the invoice based on the best match.
At the end of the day the audit shows all Superbills and the invoices to which they are linked. The
advantages of the audit are:
•

Shows invoices that have not been billed, thus ensuring all visits are billed.

•

Shows that invoices have been billed to the correct patient.

•

Shows patients that show (assuming you printed from e-MDs Schedule) so further action can be
taken.
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To view and print a Superbill Audit:
1. Go to Tools > Superbill Audit (Alt+T, A).
2. Use the calendar to select the date for which the audit is to be conducted. If Superbills have been
printed, a list of these will appear.
3. Click Print if a hard copy is required.
The audit report shows:
•

Superbill ID and description.

•

Provider and patient for whom it was printed. The provider only shows if the superbill was printed
from the Printing for Appointments tab in the Superbill window.

•

Invoice number for the superbill

•

Patient attached to invoice. Check that the patient in the Provider/Patient column matches the
one in the Attached to Invoice No/Patient column to ensure correct billing.

If the last column is blank, it means there is no invoice for the superbill. Check to see if the patient was
checked in or was a no show and then take appropriate action is the invoice is missing.

Referral and Authorization Management
The referral/authorization management system gives users the ability to track multiple referrals per
patient. This section of the user guide describes how referral management works in e-MDs Bill.
Note: The referrals/authorizations work-list can be sent as a TaskMan task attachment and this can be
done automatically using Rule Manager or manually. Refer to TaskMan for more help on using this
powerful utility to make referrals easier to manage.

Referral Tracking by Type and Status
When a referral is added to a patient in e-MDs Bill or Schedule, it is given a Type and a Status. These
affect how the system and users work.
The system asks users if they wish to make the referral active. Outbound/External referrals are
information only, e.g. for primary care clinics getting referrals on behalf of their patients. Likewise, the
Pending and Inactive status indicators are used to classify referrals for work list creation, or for historical
tracking, although it is possible to include pending/inactive inbound referrals on invoices for insurance
reporting.

Referrals/Authorizations on Invoices and Claims
When an invoice is generated for a patient that has an inbound, active referral for the specific facility, eMDs Bill automatically adds the referral to the claim. The referral name displays at the top right of the
invoice. Upon saving, it is added to the Claim Prepare, along with the authorization number.
If a patient has multiple referrals, the system defaults to the last one used. The selection process can
occur at appointment or invoice level. If the referral needs to be changed, a Find button on the invoice
and claim prepare windows lets you browse the list of referrals for the patient and select other active
referrals, or add a new one. Remember that only inbound referrals can be used on invoices. If the referral
is pending, then e-MDs Bill does not automatically associate it with a claim. However, you can still click
the Find button in the invoice and select it. A pop-up verification will ask for confirmation that you wish to
use a pending referral the first time. Thereafter, it is remembered as the last referral.
The browse window has the added benefit of showing the user a history of the invoices that have been
generated against this referral.
Note: If the referral on an invoice needs to be changed due to incorrect data entry, it must be changed
on both the invoice and claim prepare windows if the claim prepare has already been loaded.

e-MDs Solution Series Bill User Guide 8.0 R00

270

Default Referring Physician on Claims
Many users only want a referring physician on a claim in Bill – there is no authorization as such. The
typical example of this is the Medicare requirement of identifying a referring physician whenever a lab or
diagnostic test is ordered, even if the “referring” physician is the same as the treating physician. If there is
no referral being tracked for the patient, this referring physician’s name is used on the claim. In such
cases, it is not necessary to add an authorization.
•

Manual: From within an invoice, click the Find button next to the Referral field and search for a
referral in the selection window (or add a new one). Then select it. This sets the referring
physician in the claim prepare window.

•

Patient Demographics Default Referral: If there are no authorizations for treatment, but there is
a default referral in the patient file, this is added to claims. (It’s worth noting that the system uses
the same place to store default referrals/physicians for patients and authorizations. The defaults
are the ones displayed in red in the authorizations window.)

•

Patient Demographics Primary Provider: If there is no default referral in the patient file and the
User Provider as Referral if None Set option in Bill’s File > Options window is set, the patient’s
primary provider is used.

•

Case Referral: If a case is linked to an invoice, the Referral/Authorization on the case overrides
all other possible links.

Important! If the referral on an invoice needs to be changed due to incorrect data entry, it must be
changed on both the invoice and claim prepare windows if the claim prepare has already been loaded.

Automatic Referral Tracking
Referrals are tracked by invoice and by facility. If the boundaries of a referral have been exceeded users
are warned at various points in both e-MDs Schedule and e-MDs Bill. Referral boundaries include:
•

Number of visits authorized.

•

Date range.

•

Allowed amount.

•

Authorized ICD codes.

•

Authorized CPT codes.

An option setting in File > Options gives users the ability to determine whether visit counts are
decremented by checked in appointment or saved invoice. When an appointment or invoice is started or
saved, the system checks the referral’s remaining count, service date range (against the first date of
service in the invoice), remaining allowed amount, and ICD and CPT codes in the invoice. If any of them
are out of range, on screen warnings appear.
The on-screen warning for count, date range, and allowed amount and status (if pending) shows details
about the authorization. Anything displayed in red is out of range. Users have several options.
•

Continue: Tracks this invoice against the referral. The count and remaining allowed amount are
decreased. Note that this is the allowed, not billed amount.

•

Use a Different Referral: Lets you browse referrals for this patient. Here you can see a history of
invoices against the referral, edit existing referrals, create new ones, or select another. This
option is useful for groups managing patients that have multiple concurrent referrals.

•

Continue Without Using a Referral: Lets you continue with the process, but without reducing
the authorized visit count or remaining allowed amount. This is useful where you have patients
with different case types e.g. acute care and workers comp.

•

Cancel: Takes the user back to the invoice.

•

ICD and CPT warnings: Show codes that are not authorized and give users the option to correct
them, or continue.
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In e-MDs Schedule, users receive the count, date range and pending status warning when an
appointment is scheduled. There they have the option of cancel or continue. Additionally, if an
appointment is copied or rescheduled and this will cause a problem with the authorization, another
warning appears.
In e-MDs Bill the same warnings appear when starting a new invoice. If unauthorized ICDs or CPTs are
added to the invoice, a warning appears when you save. The warning will also appear if the referral
linked to a case has expired. At this point you can open the case and select another one linked to the
case, or you can switch from within the invoice.

Referral/Authorization Manager Work Lists
The Referral/Authorization Manager in e-MDs is designed as a work list function. Whether the clinic is
managing in or outbound referrals, the nature of referral processing can be very repetitive. Many clinics
have designated staff members who process certifications, while other staff members (nurses, scheduling
staff) enter referral “requests,” almost like creating an order. The requests are quickly entered as pending,
with the barest information about the referral needed (e.g. reason and the physician needing the referral).
Depending on the user’s preference, referrals can be entered in several places:
•

Go to Tools > Referrals/Authorizations (available in Bill and Schedule).

•

Schedule Check In Module (shows referrals filtered for specific patient).

•

Bill Daily Work List (shows referrals filtered for specific patient).

•

From within an invoice in Bill (shows list of referrals with summary statistics).

•

From within Chart by clicking the button on the toolbar (shows referrals filtered for specific
patient). This is a good place because it is quite often the doctor who initiates the referral “order”.

•

Click the Referrals button on the Bill toolbar.

•

Click the Referral/Authorization button in the Chart toolbar to load referrals for the specific patient.

The referrals specialist then uses the tool to create a work list of referrals to match the task to be done.
For example, a pending list shows all the patients who require a referral. The user can work this list on
screen, entering referral information as it is received. When the status is changed, the referral may drop
off the list if it no longer meets filtering criteria. This dynamic nature means that the work list will shorten
to the point that it is empty, meaning the work has been completed. That same user can then schedule
appointments, or another scheduler could filter the list for all referrals received in a date range and use
the list to call patients to make appointments. Yet other users could create a work list for referrals that are
about to expire, but who need more treatment.
Thus, the referrals/authorizations window acts as a reporting tool, and interactive processing tool, and a
revenue generator.
Note: The referrals/authorizations work list can be sent as a TaskMan task attachment and this can be
done automatically using Rule Manager or manually. Refer to TaskMan for more help on using this
powerful utility to make referrals easier to manage.

The Referral/Authorization Manager Window
The Referrals/Authorizations Manager window is designed to be an on-screen processing tool, although a
hard copy printout of data can also be generated.
Functions include:
•

Retrieve: Retrieves a list of referrals based on filter settings.

•

New: Click this to create a new referral.

•

Edit: Opens the highlighted referral in edit mode.

•

Select: Used when selecting a referral from other parts of the system.

•

Print: Prints the referral list report.
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•

Edit Pat: Opens the patient demographics form for the patient whose referral is currently
highlighted.

•

Print Form: Opens the Word forms module. The system automatically selects the patient in the
referral/authorization highlighted at the time the button is clicked.

•

Reset Filter and Filter: These are the buttons in the filtering section . If a work list has already
been retrieved, the Reset Filter button can be used to return filter settings to their defaults. The
Filter button is used to update the list if any filter criteria have been changed with a list already
loaded.

•

Complete/Incomplete: These two buttons are only visible if you opened the window from a
TaskMan task attachment and are used to check off the records you complete so that the system
can update the completion percentage of the task. A green check is displayed in the left column
which is also only enabled from TaskMan.

Work List Creation
Options
Authorization Start Date
Range and Authorization
End Date Range

By default the system will sets these to retrieve for all dates. You can use both
filters at the same time.. The Exclude with no date option eliminates authorizations
that are not date based and were not saved with any date information. The dynamic
date option can be used to search by a time period based on the current server
date. These should be used when setting up an automatic task in the tasks tab of
Rule Manager.

Appointment Date Range

You can build worklists based on an appointment range.

Facility

Shows referrals for this facility, or all facilities to which the user has access rights.

Patient

Shows referrals for a specific patient. In addition to the Find button, you can search
by entering characters from the last and first and then hitting enter to open the
search with matches already loaded.

PCP/Referring Physician &
PCP/Specialty

On the referral.

Insurance

Patient primary insurance.

Provider

Patient’s primary provider.

Specialist

The first specialist on a referral.

Organization

Some referrals are from organizations – this filters for those.

Show Default Referral

Default referrals are entered in the patient demographics file but are still stored in
the authorizations tables. They are displayed in red in the referrals module but are
excluded from the search list unless this box is checked.

# Days Until Expiration

Tracks against the authorized date range of a referral. This can be filtered for any
number of days, referrals with at least or less than a number of days, and a specific
count. This filter is useful for finding referrals that are expiring, but may have a high
count of visits authorized remaining.

# of Remaining Visits

Tracks against the authorized visit count. This can also be filtered by any number of
remaining visits, referrals with at least or less than a number of visits, or a specific
visit count remaining.

Type

Filters by the inbound and outbound classifications.

Status

Filters by the Active, Inactive or Pending classifications.
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Referral Workflow
This section is a brief explanation of how you might use the referral/authorization tool in your office. This
can be done by building manual or automatic (TaskMan) referrals work lists, or by using the Daily
Worklist.
•

Create a Referral “Order”: The office needs to get a referral for a patient (inbound, or on behalf
of a patient being sent to another specialist). Nurse or other staff member goes to the referral tool
and creates a pending referral.

•

Convert Pending Referrals by Getting Authorization: The staff member assigned to this
functional task creates a work list in the referrals window and calls the insurance companies listed
for each pending referral. Information required by the insurance is looked up from within the
window by opening the patient or the pending referral order. When the authorization is received,
the number and other data is added to the referral, and the referral is changed to Active.

•

Notify Patient and Specialist: When the authorization is received (or denied), the staff member
can contact the patient and schedule an appointment, or tell them to contact a recommended
specialist in their network. A referral authorization information sheet can be printed for the patient
to take with him/her. It includes information about the patient, insurance and referral and is useful
for staff members in other offices.

•

File Claims: The active referral is linked to invoices and tracked automatically.

•

Ensure Compliance: If necessary, someone can generate a referral work list to find referrals that
are expiring but where there are still authorized visits remaining.

Adding Referrals/Authorizations
An unlimited number of referrals can be added to a patient. Referrals are either inbound/internal
(applicable to this organization for tracking purposes), or outbound/external. They can also be tracked as
pending, active or inactive. These classifications affect whether the referral is a work list for a user,
tracked by the system, or historical.

To create a referral authorization:
1. Go to Tools > Referral/Authorization. Alternative methods of accessing the referrals module
which may be more convenient depending on work flow are:
○ Click the Referrals button in the Schedule Check In module. This saves having to search for
a patient when creating the new referral since the person is already known.
○ Right-click the main schedule and select Referrals/Authorizations. If an appointment was
right-clicked, the window opens with this patient loaded automatically.
○ Double-click the A column in the Bill daily work list. This also filters for the patient, saving
keystrokes.
○ From within an invoice, click Find (next to the Referral field).
○ Use the Referrals button on the toolbars in Bill or Schedule.
2. Click New. If loaded from the Tools menu, a patient must be searched for and selected first.
3. In the Patient Referral window, fill out fields described in the "Patient Referral Options" table as
required.
4. Click Save to store the referral. The system will ask if this is the Active referral. If so, click Yes.
Subsequent invoices for the patient will be tracked against it. If the referral status is not Active,
another pop-up asks for verification.
You can print or fax an authorization sheet from the referral window using the Print button. This is a
convenient way to send referral information to other specialists or give to the patient. The
referral/authorization sheet is described in more detail in a few pages.
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Note: A custom referral form can also be generated using Word forms and then printed by clicking
the Print Form button in the Patient Referrals window.
Patient Referral Options
Medical Facility

Defaulted to the facility in which you are working, but another can be selected if
necessary.

Type

This is set automatically based on the New Referral Default option in File >
Options. You can modify the setting based upon whether the referral will be
tracked for billing purposes in this office (Inbound/Internal) or by another clinic to
which the patient is being referred (Outbound/External). Only inbound referrals are
tracked for warnings.

Status

Pending indicates a referral that needs to be authorized by insurance. Users can
run a report of all pending referrals and use it as a work list. Active referrals can be
used for billing and schedule tracking. Inactive referrals are retained for historical
tracking. The status type is summarized in the referral view with codes of A, I and P.
If a the End Date passes, the Visit Count Remaining or the Allowed Amount
Remaining fields reach zero, then the referral will automatically update to an
inactive status.

Authorization Number

The number issued by the insurance company for the treatment.

Referral Number

Additional referral identifier that may be assigned by the insurance company.

PCP/Referring Physician

The person that will be identified on claims as the referring physician. This can be
defaulted to the patient’s primary provider using the Set New Referral Provider to
Patient Provider option in File > Options.

Organization

If the referring entity is an organization, set it here. You cannot set both the PCP
and organization fields.

Insurance

Select the patient insurance for which this referral is applicable.

Specialist, Second
Specialist

Up to two physicians authorized to perform treatment can be entered, e.g. a surgeon
and an anesthesiologist.

Approved Visit Count

Set to the number of visits authorized for the treatment. Based on the Setup Options
to track authorizations by appointment or invoice, the Remaining field decrements
by 1 for each invoice tagged to this referral. When the number remaining reaches
zero (0), the status of the referral will automatically update to Inactive.

Start and End Date

Enter the date range within which treatment must be rendered. When the End Date
has passed, the referral will automatically update to an inactive status.

Allowed Amount

Enter the maximum allowed amount. If an invoice allowed balance exceeds the
Remaining amount, a warning appears upon saving. If the remaining amount is <=
0.00, a warning will also be issued when trying to schedule an appointment. The
referral status will automatically update to an inactive status when the allowed
amount remaining is zero (0).

Out Patient

Check the box. This is for information only.

Comment

Type a comment into the field to give more information about the referral, or click
Find to select a standardized comment from the comment reference table. A
combination of a standard comment and free text is permitted.

ICDs

Type ICD codes into the field then press Enter or click Add for the codes to appear
in the list. When an invoice is created with codes that are not part of a referral linked
to the invoice, the system warns users upon saving. To remove an ICD, click
Remove.
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CPTs

Enter CPT code ranges for the procedures authorized. For a single code, enter the
same code in both the start and end fields, then click add. Custom sets of
authorized codes can be created in a Referral Types support table. Click Find to
browse and select a type. To remove a CPT, click Remove.

Create By, Created On

You cannot set these fields. They show the original user and date for when the
referral was added.

Referral/Authorization Report
This report is printed from within the Referral/Authorization window where the records retrieved can be
“worked” as a list.
•

Referral Work List: More applicable to primary care practices that get referral authorizations on
behalf of patients. Using the pending referrals filter, the user can see which insurances need to
be called for referrals/authorizations, and then can add the information to the referral and change
it’s status.

•

Compliance Report: Users can track which patients are compliant with number of treatments
authorized, date range, etc. This is a useful way to make sure patients come back and complete
their course of treatment.

•

Clean Up: If users maintain the status of their referrals, filters can be set to search for these. For
example, one might look for all active referrals that have expired or the visit count is zero.

The report displays the insurance, patient name, PCP/referring physician, authorization number, type and
status of the referral, date range, insurance phone number, visits authorized and remaining.

To print the Referral Compliance Report:
1. Go to Tools > Referral/Authorization.
2. Set filters:
○ Authorization Start and End Date Ranges: Filters based on the date range of the referral.
○ Appointment Date: Lets you find referrals based on an appointment range, typically used to
find problems with authorizations on upcoming appointments.
○ Facility, Patient, PCP/Referring Physician, PCP/Specialty, Insurance, Provider,
Specialist, Organization: Filters based on the information in the referral itself. Provider is the
patient’s primary provider, not the provider in the referral which is the PCP or Specialist.
○ Show Default Default: An authorization record is automatically generated when a default
referral is added to the patient file. Typically this is not a true “authorization” and is excluded
from referral work list searches and reports but checking this box includes them. Default
referrals appear in red on the work list.
○ # Days Until Expiration: Can be set for >= and <= days until the referral expires. This tracks
against the End Date of a referral.
○ # Remaining Visits: >= and <= count of visits left.
○ Status: Can be Active, Inactive or Pending.
○ Type: Lets you see which referrals are being tracked in the clinic vs. ones that are outbound.
Click Retrieve. The system retrieves all referrals matching the date range. To update the data by the filter
settings if you change them with a list already loaded, click the Filter button.
Click the Print button. A preview appears from which the report can be printed to paper.
Note: In addition to the referral compliance report, it may be useful for the practice to print the referral
detail itself. It has all information about the referral including clinic, patient and insurance demographics,
provider numbers, and referral information. This can be given to a patient to take with them or faxed to
the clinic to which they are being referred. That clinic will appreciate the information in a clear, legible
format.
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Referral Authorization Sheet
The referral authorization sheet is a one page report that shows details of a particular
authorization/referral for a patient. It is a useful summary that can be given to the patient, or faxed to a
referral to assist them with their data entry. This has the potential to reduce phone calls to the practice
from that other location requesting the information.
If the patient is on an insurance plan or is being referred to a facility that requires a specific referral form,
either the Word forms can be used to generate these.

To print an authorization sheet:
1. Go to Tools > Referral/Authorization.
Search for the referral and highlight it and click Edit (or create a new one).
Click Print.

Collections Module
The collections module may be the most important tool that a practice has at its disposal. It retrieves a list
of invoices based on a multitude of different criteria set by users and then shows users extended
information about the invoice and related account information. The ability to access almost any record
related to the invoice is also available from within this one screen. It is designed for use as a centralized
place for users to perform billing related tasks. These tasks can be quite different depending on the filters
used to retrieve records.
Some examples of collections lists:
•

To collect outstanding guarantor balances (filter by age, number statements, days since last
payment, balance and invoice responsibility).

•

To ensure all invoices have been filed (filter by filing status and age).

•

To refile invoices that have been filed a certain number of days in the past, but have not been
paid (filter by filing status, age, days since last payment and invoice responsibility).

•

To review credit balances and see if refunds are due (filter by balance, but check the account
balance to see if it cannot be applied to another invoice).

•

To ensure follow up tasks entered into invoice notes are acted upon.

•

To find all invoices with a particular status code.

Work lists are designed to be exactly that. Once records are retrieved, users can perform almost all billing
functions without having to leave the collections window since a large amount of information related to the
invoice is displayed on screen and you can open just about every window from which the data is
extracted for updating and reference purposes. Each record can be worked in a sequential fashion. For
example, users can update demographics, change invoice information including adding to the invoice and
patient notes, post payments, change the insurance/patient responsibility, flag a claim for refilling or print
a paper claim, print a statement, or print a letter from the notice processor that is already mail-merged.
A collections work list can be sent as a TaskMan attachment. This can be done by creating a work list
manually, or it can be done on an automatic, repetitive basis using Rule Manager. The power of the latter
is that you can set up a task with commonly used collections parameters and the system automatically
assigns it to designated users who can accept and work the task while administrators can see the status.
Because the tasks are repeated frequently, each work list is manageable and becomes part of the routine
instead of being put off and then growing into a large, less manageable and avoided list.
There are two kinds of lists:
•

Ad Hoc: This is a list that is retrieved on the fly and is not saved. As each invoice on the list is
marked as complete, it drops off the list, and the system adds another one until there are no more
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invoices that match the search criteria. Invoices retrieved are not available to other users, even if
they are marked complete and drop off the list until the list is cleared.
•

Saved Work List: A list can be saved so that it can be retrieved from any workstation and
worked until it is completed. Invoices retrieved are not available to other users until the work list is
deleted.

Invoice Agency Collections History
This window shows the detailed chronological status of an invoice’s collection history. All of the
transactions associated with the invoice are listed in the grid from most recent to the oldest. Depending
on whether or not an invoice is currently set in Collections, the buttons to change the status (Set and
Release) are available accordingly.

To set an invoice to collections status:
1. On the Charges and Payments screen with the invoice highlighted, click Collections.
2. On the Invoice Agency Collections History screen, click Set. The Set button will only be active if
the invoice is not currently set to collections.

3.
4. On the Set Collections Status screen, use the drop-down menu to select the Collections
Agency.

5. Click OK.

To release an invoice from collections status:
1. On the Charges and Payments screen with the invoice highlighted, click Collections.
2. On the Invoice Agency Collections History screen, click Release. The Release button will only be
active if the invoice is currently in collections.

3. Confirm the invoice release, click Yes.
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To create a collections work list:
1. Go to Tools > Collections, or click the Collections button on the toolbar. The last work list used
in this session is loaded.
Click Filters and enter your parameters:
Click Search to retrieve invoices. Matches are shown at the bottom of the Collections window.
Set ordering options. See the "Record Retrieval Sort Options" for more information.
Note: Although the principal is the same, section does not cover automatically tasking a collections
work list. We strongly suggest to our users that automatic tasking is set up for routine collections
tasks. Many collections tasks are very repetitive and use the same criteria; being able to have those
sent to users and to track them is an enormously powerful function that can make a significant
difference in ensuring that collections tasks are taken care of in a timely manner.
Record Retrieval Sort
Options
Order By

The system provides five different ordering/sort options for the records
retrieved. Set the numbers to sort in the order you desire. To sort in
descending order, check the box to the left of the sort order.

Facility

Create a list for one or all. To clear the fields, click the C button. The magnifying
glasses let you browse the applicable databases for a specific record.

Provider

Select ALL or specific providers by checking their names.

Maximum Records

The maximum number of records in the list. By default, the system sets this field to
999. It is possible to set filtering criteria that will retrieve every invoice in the
database. This would take a long time, not to mention create a near impossible work
list for a user so it is good practice to limit the records found. On the flip side be
careful not to set a number that excludes invoices.

Guarantor

Lists can be filtered by the start letter of the guarantor last name. * to * is all records.
Invoice Filter, Invoice Date Range/Age >=, Date Range/Dynamic and Invoice
Age >=: You can search by invoices that have a specific date range, or for invoices
that are greater than or equal to a particular age in days. Set the invoice filter radio
button option to Date Range or Age, then set the applicable date range or number of
days. The Dynamic option is used to search by a Current or Last period (month,
quarter, etc.). This or the age options should be used when creating an automatic,
repeating task since the work list will then be built based on the server date when
the task is generated instead of a fixed date range that generates the same
information again and again.

Insurance

Create a list for one or all. To clear the fields, click the C button. The magnifying
glasses let you browse the applicable databases for a specific record.

Financial Group

Uses the current INVOICE financial group, not patient. Select ALL or filter by one or
more groups.

Insurance Class

Select ALL or from one or more classes. This is based on the class linked to the
primary insurance company on a claim.

Invoice Status

Select from ALL or specific invoice status codes in the system.

Filing Status

Select a filing status method, filed or unfiled, from the list.

Assigned To

Searches on biller assigned for the next collections activity entered in an invoice.
This only searches the last invoice note entered.

Reason and Group Codes

Select one or more Reason or Group Code(s). If any line in the payments matches
the RC/GC filter, it will show the invoice in the work list.

CPT and HCPCS Codes

Select the code range for the CPT and HCPCS filters.
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Bill Comments

Select 0 to multiple comments.

Statement Count

Keys off the statement count field in the payment tab of an invoice and retrieves
invoices with a count great than or equal to this value. The statement count is
automatically incremented by the system each time an invoice is included on a
statement. When a patient payment of any amount is received against the invoice, it
is automatically reset to 0. Users do have the ability to modify this counter
manually.

Days Since Last Payment

Self-explanatory.

Minimum and Maximum
Balance

Enter whole dollar amounts only. Negative amounts can also be entered if you are
looking for credit balance invoices for refund checks.

Invoice Responsibility

This is a useful filter for those working insurance or patient responsibilities.

Follow Up Action

Searches on the last follow up actions set for an invoice.

Follow Up Date

Searches on follow up date set in an invoice note. Check the box and enter a date
range. Dynamic dates should be used for automatically repeating tasks.

Last Filed Date range

Keys off the Last Filed Date that is in the invoice insurance. It is based on the last
date for any of the insurances in the invoice. Dynamic dates should be used for
automatically repeating tasks.

Filing Hold

Select to include or exclude invoices with a filing hold.

Invoice Post Date

Searches the invoice post date range by month day and year. Dynamic dates should
be used for automatically repeating tasks.

Invoice Age

Searches invoice age by date range from 0 to 999 days old.

Last Worked

Searches the last worked date range by month day and year. Dynamic dates should
be used for automatically repeating tasks.

Agency Collections

Select to include or exclude invoices in agency collections.

Statement Hold

Select to include or exclude invoices with a statement hold.

A collections work list is a set of invoices that match filters in the collections window. Because many
billing functions are routinely repeated, the e-MDs Bill collections module lets users save a work list so
that you can do other functions, then return to the work list and, because the completed items are
checked, easily continue from where you left off.
Any work list which is attached to a task must be named.

To save a collections work list:
1. Open the Collections window and set filters according to the work list desired.
Click the Create button. The system responds with a Work List dialogue box. Enter a name for the work
list. Some suggestions: include specific user names and/or filter settings. Alternatively, name it according
to the day of week or other time period when this should be processed.
Click OK. The work list is saved and the name entered in the work list box in the main collections window.
The creator of the work list might then create a task in TaskMan which is assigned to a specific person
and ensures they know there is a work list with a desired date of completion.

To retrieve a saved work list:
1. Open the Collections window.
2. Click the Search button on the Work List field.
3. Search for and highlight the work list, then click OK. The system returns to the collections window
and retrieves the data on the list.
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Note: If you retrieve a work list that is already in process, the system shows which records have
been processed and which have not. This allows the user to continue processing. To update the list
to include new records that may now fall within the filtering criteria, click the Search button at the top
left of the window.

To edit or delete a work list:
1. Open the Collections window.
2. Click the Search button on the Work List field.
3. Search for and highlight the work list, then click Edit.
4. In the Edit Work List window, change any of the elements then click Save. To delete the work list,
click Delete.

Using a Collections Work List
When a record is highlighted, details about the individual invoice are displayed in the middle of the
window. In addition, patient and guarantor information as well as total balances, account status and
patient type are shown. Insurance information includes the number of days since the claim was last filed
to a particular carrier. The invoice color is red if there is an invoice note. At the bottom of the window are
statistics on the number of invoices and their total balance, as well as a breakout by number processed
and number remaining. Users can:
•

Edit Patient Demographics: Click the Edit button to the left of the patient information line to view
full patient demographics.

•

Edit Guarantor Demographics: Click the Edit button to the left of the guarantor information line
to view full guarantor demographics.

•

Edit Invoice Information: You can do anything to which you have security rights in the invoice
window including post payments, change insurance and queue for refiling, add a memo, etc. Click
the Edit Inv button, or double click the record in the list. Once the invoice is open, you can change
any of the invoice information.

•

View Payments: Click the payments button to see a summary report. The maroon date for each
is a hyperlink that opens the payment detail window.

•

Print a Claim: Click Print HCFA. The system will print a paper claim for the insurance company
selected in the window that appears. You can select from different claim types. The system asks
if you wish to print all charges regardless of filing status before the printer selection window
appears. When the claim is printed the preferences last set in the HCFA wizard are used.

•

View File History: Shows a list of the claims files generated or print if you want to see more than
the most recent filing shown in the insurance companies on the main collections window.

•

Print a Notice: Click the Notice button to open a Notices window. On the left you will see a list of
all the notices. Highlight the applicable notice. The system mail merges the applicable fields into
the preview on the right. Click the Print button to print the notice. To return to the collections
window, click the Back button. To exit from collections too, click the X in the windows title bar of
the Notices window.

•

Print a Guarantor Statement: Upon clicking the Statement button, the system opens the
Statement window with the guarantor already loaded in the “This Guarantor Only” field. You can
add comments and set other options before printing/previewing the statement. Any statement
printed will include ALL outstanding invoices due, not just the one from the collections window.

•

Print a Word Form: Click the Print Form button to load the Word forms processor from where
you can select and print a letter/form.

•

View Patient Alert: The button label is bold red if there is an alert in the patient file.

•

View and Add Invoice Collections Notes.
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When an invoice has been dealt with, click the Mark Complete button. Depending on how the work list
was generated, the system will perform several actions:
•

If the list of invoices was created without using a saved work list, the item is removed from the list.

•

If a pre saved work list is being used (see below), a check mark appears in the left column and
the system highlights the next invoice. When three or more invoices are completed, the system
scrolls the list upwards.

•

If the invoice was already marked as complete, the button label changes to Mark Incomplete.
Clicking it unchecks the invoice.

•

If the work list was sent as a TaskMan attachment with the worklist function enabled, the
percentage completion status is automatically updated in the task list.

There are two additional function used for work list maintenance:
•

Clear Complete: It’s possible for multiple users to be working different collections jobs with
filtering criteria that have an overlap, so to avoid the potential problems associated with having
multiple people working the same invoice, once an invoice is on a work list, it appear on other
ones until a work list is deleted. The Daily Work List, which has some collections type filtering,
can be used if overlap is needed.

•

Reset Worklist: This is used to regenerate the list of invoices in a saved worklist. An example of
where it might be used is if you have not been able to start the worklist in a timely manner and
want to see if new invoices now qualify or existing ones no longer do based on the filters. You
can also use this to create a “perpetual” worklist using dynamic dates. For example, you may
want to see all invoices with a balance which are older than 90 days and have saved filters to
meet this need. Every few days you can open it and reset to query for an updated list.

Note: Click the Refresh button on the collections window toolbar to update the list of statistics at the
bottom of the window.

Printing a Collections Work List
There are two ways to print a hard copy of a collections list:
•

Collections Report: This report is printed from the collections module and includes basics about
the invoices in the work list. To print this report, retrieve a work list, then click the Print button in
the collections window. A nice interactive feature of this report is the ability to click invoice
numbers or patient names to open the associated windows.

•

Collections Work List Crystal Report: This crystal report can only be used to print saved work
lists. It’s advantage is that users can list all saved work lists with grand totals, and then have the
flexibility to double-click a specific work list in the on screen preview to generate a separate drilldown report with the underlying invoice detail.

Daily Work List
The Daily Work List is a very significant tool that can be used to manage a multitude of tasks and access
data from one appointment-centric window. This means that it displays data for any appointment within a
date range. If there is no appointment created for a visit, nothing will appear on the work list. It should be
used all the time. Depending on the e-MDs modules used by your clinic, it consolidates several work list
tools/daily functions into a single window:
•

Appointment list, appointment confirmations (Appointment Reminder Results)

•

Appointment Check In Module, and checking out

•

Eligibility Work List

•

Invoicing. Users can bill manually or directly from Chart and Companion (like using the Visits
button), either one at a time or in batches
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•

Superbill printing

•

Referrals/Authorizations

•

Copayments/Prepayments

•

Collections Module

•

Case Management.

The Work List also gives easy access to data with quick drill-down to detail, sorting, and reporting. For
example, users can open and update appointments (Schedule), invoices & prepayments (Bill), patient
charts (Chart) or scanned documents (DocMan).

Notes:
•

Note that although the work list gives access to many modules in e-MDs Solution Series, users
cannot require all of these to use the tool. The Daily Worklist interface can be sent as a TaskMan
attachment.

•

You may see more than one entry for an appointment in the work list. This occurs when there are
multiple chart notes or invoices for the appointment, a not uncommon occurrence. The Daily
Work List report will also show these, but for totals that are appointment-based such as checkins, the counts are based on distinct appointments, not the number of invoices, etc.

Using the Work List
Many different functional positions in a clinic can use the work list. It can be filtered and sorted to fit many
needs such as appointment confirmations, verifying authorizations for scheduled patients, check in,
printing Superbills, checking claim status and verifying payments, etc.
More advanced uses include the ability to track claims batches, verify that all appointments have charges,
all progress notes are signed off and so on. Billers who post payments and send in appeals have direct
access to Chart and DocMan, speeding up this time-consuming task.
Some examples of work lists are included at the end of this section to give users some ideas on how to
use this extremely powerful tool.

To create a work list:
1. Click the Daily Work List link on the blue background in Bill, or click Tools > Daily Work List
(Alt+T, D) in either Bill or Schedule. The work list appears. If no work list was loaded during this
login it opens to the Filters window, otherwise it goes to the previous work list. Note that if you
have already been using the work list for this session, it will reopen and will still have the last cell
you clicked highlighted. Users can open a work list and then click any other function (e.g. add
insurance) without having to create a new list.
2. In the Filters window, set the parameters for the work list as described in the "Work List Options"
table.
Click the “Work List” link at the top of the Daily Work List window to show the list. Note that the “Reset
Filters” link at the bottom is a quick way to start from scratch.
Work List Options
Appointment Date

Set a date range. The work list is 100% appointment centric. If there is no
appointment for a progress note or invoice, it cannot be used. The Dynamic option
gives you the ability so search by Last/Current/Next time periods (months, days,
quarters, years). This is also used extensively when setting up an automatic task in
Rule Manager since the dynamic date is based on the server date when the job is
run, not a fixed date range.

Facility

Displays facility to which logged in user has access rights. Click to select a facility.
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Resource

Displays all Schedule resources for the facility selected. Select ALL, or particular
resources. To multi-select, hold down the Ctrl button and click each resource
required.

Referral Status

Work lists can be created to ensure all upcoming appointments have an
authorization, or to process outbound authorizations.

Insurance Batch Number

Also used for claims follow up. When the batch number is not 0, all other filters
except for Balance are ignored.

Appointment Status

Use the Confirmed, Check In and No Show options to generate lists.

Chart/Invoice Status

Users can locate based on signed off (S), ready to bill but unsigned (RU), not ready
to bill and unsigned (NU), or no chart. Likewise, users can search for visits with or
without an invoice. This creates a useful follow up tool to ensure all visits are
documented, all visits are signed off, and all visits are charged for.

Claim Status

Select one or more claim filing methods (filed and unfiled) to generate follow up
work lists (e.g. “Show me all claims that have not been filed).

Invoice Status

Searches based on the current status for an invoice.

Case Status

This filter lets you retrieve appointments linked to a case and also based upon case
types or dispositions.

Superbill Printed?

Work lists to show appointments with or without a superbill can be printed.

CoPay

Build worklists to find appointments where the copayment has been prepaid but is
not walked into an invoice, where it is paid, or where it is unpaid.

Balance Range

A collections type filter, similar to those in the e-MDs Bill Collections Module. An
example of the use of this filter is “Show me all claims in Insurance Batch x that still
have a balance between y and z”.

Eligibility

Filter to locate patients by primary insurance eligibility status.
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Work List Columns and Functions

Daily Work List Screen Shot
Many different functional positions in a clinic can use the work list. It can be filtered and sorted to fit many
needs such as appointment confirmations, verifying authorizations for scheduled patients, check in,
printing Superbills, checking claim status, verifying payments, building case work lists, etc.
More advanced uses include the ability to track and post payments by claim batch number, verify that all
appointments have charges, all progress notes are signed off and so on. Billers who post payments and
send in appeals have direct access to Chart and DocMan, speeding up this time-consuming task.
Once a work list is created, you can view and manipulate information to suit your needs. It’s important to
note that although the system automatically refreshes, you must click the Linking options at the bottom of
the window to view charts and invoices linked by other users.
The current work list is retained in memory for easy use. Users can do something in the work list and
then, without closing it, click on another function such as the toolbar buttons for insurance demographics
or electronic claims. The work list will “disappear,” but as soon as the user clicks the link on the Bill
desktop (or goes to Tools > Daily Work List in Bill or Schedule), it returns with the same cell selected as
before.
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Work List Columns and
Functions
Sorting

You can sort by any column, ascending or descending by clicking the column
heading. In the screen shot above, the first column App Date/Time is the sort order.
This is indicated by the black triangle in the column heading. Sorting is useful
because work lists can be created for many different reasons. The system will
automatically resort the list when information is updated, so users can constantly
“work” the top record without having to waste time scrolling up and down. Uses can
also set filters for the daily work list such that as the data is changed, the work list
shortens. For example, if sorting by confirm status, or chart sign off status, when an
appointment is confirmed or signed off the list reduces in size because the records
no longer match the list criteria.

Sizing and positioning

The Work List window columns widths can be changed by dragging. The window
can also be sized by pointing the mouse at the edges of the windows. When it turns
into a double-sided arrow drag the borders to your preference. A recommendation
is to fit this window to the extreme right and left edges of the window, and the tops
and bottoms so you can see the toolbar allowing easy tasking to other Bill functions.
The window was designed to work optimally at a minimum resolution of 1024 x 768.

Header Functions

There are several buttons at top right which can be used when in the DWL:

Columns, Drill Through &
Functionality

•

Complete Item/Mark Incomplete: The green check and red X are only visible
when opening the DWL from a TaskMan task and are used to mark records in
the worklist as completed or not so that automatic % completion can be
calculated for the task.

•

Balance Buttons: You can view aged balances, last payment and last
statement dates for patients and guarantors.

•

Refresh: Updates information in the worklist to reflect activity elsewhere on the
network. Use this if you have left the window open for a while without working
in it. The worklist refreshes automatically when you sort, drill through to other
functions, etc.

Refer to the screen shot above. You can also click the ? at the top right of the work
list view for a legend. Users can double-click or tab to a cell and hit Enter for most
of the cells in the work list to enter or review data, or to change a status:
•

Status: The left column is only visible when the DWL is opened as a TaskMan
task attachment. Double-clicking the cell or using the Complete Item/Mark
Incomplete buttons at top right add or remove a green check mark to indicate
that this record has been completed and so that TaskMan can update the %
completion on the task.

•

App Date/Time: Opens the Edit Appointment window. Also a good place to
view patient balance. If there are alerts in the patient file, these also appear.

•

Resource: Opens the Bill Provider Maintenance window if the Schedule
resource is a provider. If an equipment or service resource, nothing happens.

•

Patient: Opens Schedule Patient Maintenance window. Color of the patients
name indicates if the Patient or Guarantor have invoices in Collections status.
Black: Indicates account status is Active. Red: Indicates invoice is set to collect
for either Patient or Guarantor.

•

Visit Type/Reason (Detail): Opens the appointment in edit mode.

•

E: Icons denote the current eligibility status of patient primary insurance. Green
is eligible, red is ineligible and yellow is unknown. Double-clicking opens the
Eligibility check window for the patient from where you can view all the
insurance and drill through to the detail about it, as well as generate a real time
check.

•

Confirmed: Enters current time and updates the appointment reminder results
for this appointment.

•

Check In: Opens the check in module. This is another way to process
appointments, take pre pays, or access forms and other check in functions.
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•

Check Out: Sets a check out time and changes the appointment status for the
patient to checked out.

•

NS: No Show. This columns display a red X if the appointment has been
marked as a no show in e-MDs Schedule.

•

A: Authorization (referral). Displays a red X if there are no active inbound
authorizations for the patient, a green check mark if there are, and an orange
“P” with a blue arrow from the left or to the right for inbound or outbound
pending authorizations. Double-clicking opens the referrals/authorizations
window filtered to show data for this patient. Users can update an existing
referral, or this is a quick way to add a pending referral that needs be processed
by someone else later on. This duplicates the Tools > Referrals/Authorizations
function which can also be accessed from the check in module.

•

SB: Superbill. Displays a red X if no superbill has been printed for the
appointment, or a green check mark if there is one. Double-clicking opens a
print preview with a superbill loaded for the patient, from which users can print
the superbill. This duplicates the functionality of the Superbills Printing for
Appointments Tab.

•

D: Demographics Verified. Double-clicking changes the red X to a green check
mark to indicate that demographics have been verified by the user. This is the
same as clicking the Verified button in the Schedule Check In module.

•

C: Chart status. Different icons indicate whether there is no chart, an unsigned
chart, an unsigned chart that is ready to bill, and a signed off/ready to bill chart.
If the chart is not permanently signed off, double-clicking opens the user directly
into the specific progress note. If not, a message notifies the user that the
progress note is signed off but it still opens the patient chart. This is an easy
way for billers to access and print progress notes narratives for appeals, etc.

•

FF: FastForm status. Requires e-MDs Chart. FastForms are paper forms that
patients fill out in the waiting room which are then scanned in to the system to
automatically populate the chart. A red X indicates that no FastForm has been
printed. A printer icon indicates one has been printed, and a scanner indicates
that patient answers have been scanned back into the system. Double-clicking
a FF cell tasks to the FastForm processor. The scanner must be on the
computer for this to function correctly.

•

Invoice #: Displays an invoice number if charges have been entered for this
appointment. Double-clicking may cause several things to happen. If there is
no chart linked to the appointment, a blank invoice opens into which a user can
enter charges. Since the patient is already loaded, this may be a quicker way
for users without chart to enter charges compared to using the posting window
that requires searching for each patients and then clicking the New Invoice
button. If there is a chart linked to the appointment but it is not ready to bill, a
prompt notifies the user.
If there is a chart that is ready to bill, this works like using the Build button in the
Visits tool. An invoice is started and the charges are automatically posted.
Note that if patient demographics are incomplete, users will still be warned by
the system.

A red Invoice # indicates it is in Collections status. It can only be
opened by a user with the proper security privilege.
•

IS: Invoice Status. Shows the current invoice status code with its color.
Double-clicking opens the invoice notes.

•

FS: File Status. Displays the current file status of the invoice. The number in
parentheses after the status indicates the order of insurance.

•

Charges: Shows total billed charges on the invoice.

•

Balance: Shows current balance of the invoice.

•

C/P: Copay Status. Indicates copayment on an invoice. This is read from the
primary insurance copay on an invoice. The number will always show the fixed
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copay, regardless of whether it has been satisfied or not. If the number is
black, there is no prepayment involved. If the number is red, there is an
unposted prepayment. If the number is green, there is a prepayment that has
been posted. Double-clicking the cell opens the Patient Pre Payment window
allowing a prepay to be entered or posted to an invoice.
Other Work List Functions

A series of buttons at the bottom of the work list expand the capabilities of this tool.
•

Link Chart to App, Link Invoice to App: The system matches appointments
automatically to visits and/or invoices generated for the same facility, and
resource on the same date. The link is seen in the Visit Details window when
starting a new note in chart (it can be changed here) and that link is automatic
when an invoice is created from the note. You can also link manually using the
Link Chart to App button. If the system is able to find charts, the icon in the C
column changes. Likewise, clicking the Link Invoice to App button will match
those which is necessary if you use Chart or ’ build the invoice from the daily
work list. If a user builds an invoice (with manual charge entry or automatically
from a progress note), the list automatically links this and updates the view. If
the Build All Invoices function is used, the system performs both the linking
functions before and after the process to avoid duplicating data and then to
update the display. You can also unlink an invoice or chart from an
appointment by right-clicking the row and clicking the applicable function.

•

Build All Invoices: The Build All Invoices function is a huge time saver. With
one click, it will enter all ICD, CPT and HCPCS charges entered in e-MDs
Chart. There are some important things users should understand about this
function:

○ It only builds invoices/claims for signed off, ready to bill progress
notes.
○ The claim prepare form is added automatically.
○ The system verifies completeness of patient demographics prior
to building the invoice. If it finds a problem with an invoice, it
stops and notifies the user (who can drill through directly to the
applicable patient demographics to make edits). After saving,
the user must click the Build All Invoices button again to
continue building.
○ This is a keystroke saver. If there is additional data that needs
to be added or edited after building all invoices, you must still do
this.
○ As a precaution, e-MDs recommends that users run the Code
Match report to protect against discrepancies due to manual
edits by providers or billers.
○ All rules created within the fee schedule will run when building
all invoices.
•

Check Claims: Check claims runs the same edits on the invoices in the work
list as are done in the HCFA or e-Claims. If errors are found, the system shows
the dynamic error window from which corrections can be made. This tool is
useful particularly if Report Manager is used to build claims batches overnight.
If that is done, a user will not see the errors. Thus, it’s a good practice to use
either this batch process, or the error checking option from within an invoice.

•

Code Match (Chart Visit/Invoice Compare) Report: This report compares
CPT, ICD and HCPCS codes and linkages between the progress note and the
claim. It is a very useful tool to ensure that your practice can survive audits.

•

Launch DocMan: This function at the bottom of the work list opens DocMan for
the specific patient loaded.

•

Print Work List: Generates the Daily Work List report. This report is a hard
copy version of the on screen tool. It also includes total by resource and by
different data types such as total appointments, total check ins, total charges,
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etc.
•

Launch Chart: Opens a patient search so you can find a patient chart for
someone not on the work list.

•

Eligibility: Provides a menu to either build eligibility batch files for patients in
the list or to import a file. The build option opens the eligibility worklist window
and the import opens a file browser so you can search for and select an ANSI
271 file.

Some examples of work lists are included at the end of this section to give users some ideas on how to
use this extremely powerful tool.

Work List Examples
The following are some sample scenarios to give users an idea of the power of using the daily work list to
ensure all tasks are completed:
•

Locate all appointments that have not been confirmed.

•

Locate all appointments where there was no check in so a user can follow up on no show
patients.

•

Locate all patients for an appointment date range where there is a pending referral so
authorization can be requested from insurance.

•

Locate all checked in visits where there is a chart but it is not signed off so providers can be
notified.

•

Locate all signed off visits that have not been billed.

•

Locate all appointments that have a superbill printed.

•

Locate all visits where the codes in the progress note match those in the invoice/claim due to
user edits.

•

Locate all visits where the associated claims were filed in a specific batch number to check that
balances have been paid off.

•

Locate all visits in a date range that have a non-zero balance so staff can follow up.

•

Locate all visits for a particular insurance batch to post payments, or correlate with an EOB and
thus provide easy access to documentation (Chart or DocMan) for appeals, etc.

•

Look up all invoices with a particular invoice status code which could have been set because the
claim is on appeal, or on hold until a coding correction is made in the chart by the provider.

Linking and Unlinking Charts and Invoices
The work list links appointments to Chart notes and Invoices using a combination of facility, appointment
date/progress note date, patient and resource. It is possible that it may link data incorrectly so users can
remove the link manually.

To unlink a chart or invoice from an appointment:
1. Right-click any cell in the row for the appointment. A menu appears.
2. Click Delete Link to Chart Visit or Delete Link to Invoice depending on the need.

Spell Check Configuration
The spell check configuration tool is a 3rd party dictionary that has been integrated into the e-MDs
Solution Series. It can be used in many different text fields (also known as “blobs” or memo fields).
Examples of these are the patient alert, the Notes field for appointments, collections notes, phone note
and free text boxes in Chart, and TaskMan messages.
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In addition to the spell check capabilities, a secondary function of the dictionary is its Auto Correct
feature. This is much like the correction functions seen in main stream word processing applications like
Word which automatically change the words or characters entered by a user into something else, such as
to correct common typing keystroke errors. This makes it a very useful tool for setting up macros to enter
commonly used comments and can thus save users literally thousands of keystrokes and a great deal of
time. For example, nlab6 can be used to enter “Normal labs, follow up in 6 weeks,” or 3col for “Mailed 3rd
collection letter, turn over to agency.”
Note: Custom spell-check options are user and work station specific. The advantage of this is speed
and reduced network traffic, but the disadvantage is that any custom changes to the dictionary for a user
need to be done on all workstations that the person uses. This is less of an issue for administrative staff
(e.g. billers) who tend to use the same computer, but must be considered for users like doctors who move
from one workstation to another. It is possible to set up macros that push the dictionary files out to
multiple workstations on the network. The default name for a user dictionary is the Windows login name.
The file extension is .adu, so changes to the dictionary can be made on one workstation, then pushed to
others where the user works.

Choosing Dictionary Options and Adding Words and Macros
The spell check configuration tool includes both a standard dictionary and a medical dictionary. The
standard dictionary is enabled by default, but the medical and user defined dictionaries can also be
added. The system will check all of them when verifying spelling, but there may be an effect on system
speed.

To set dictionary options and enable/disable dictionaries from the Tools menu:
1. Go to Tools > Spell Check Configuration.
2. Review and check/uncheck the Options at the top of the Spelling Options window. If you are
going to add your own options (word, auto-correct/macros), you must uncheck “Suggest from
main dictionaries only”.
3. Check the box to the left of the standard dictionary names in the Dictionaries section. These are
typically English and Medical. If you check Locate Dictionaries, you can browse for other
dictionaries on the network (which is one way to network them, although e-MDs has not tested
this).
4. Click OK.

To set dictionary options on the fly:
This method tends to be faster and more convenient than from the Tools menu.
1. Right-click a misspelled word in an enabled memo window and select Spelling.
Click Options.
Follow steps 2 through 4 from the instructions from the Tools menu above.

To add custom words and macros from the Tools menu:
1. Go to Tools > Spell Check Configuration.
2. Click Dictionaries. The Custom Dictionaries window opens.
3. Select the dictionary to which words or macros are to be added or excluded. The dictionary
name must be highlighted for it to be selected – just checking the box does not select it.
4. Click Edit.
5. To add words, click the Added Words tab, enter the word(s) in the Ignore this word field, and
click Add.
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6. To create Auto-Correct Pairs/Macros, click the Auto-Correct Pairs tab. In the Replace field,
enter the macro keystrokes you will use, then enter the full phrase that you want to appear in the
With field. When the Replace keystrokes are entered in memo fields, the system automatically
replaces them with the With phrase.
7. To exclude words, click the Excluded Words tab and enter the word(s) in the Exclude this word
tab.

To create auto-complete pairs/macros on the fly:
1. Enter the macro code you want to use. Assuming it’s not a word, the system underlines it to
indicate a spelling error.
Right-click and select Spelling. Your code appears in the Not Found box.
Type the phrase you want in the Replace With box.
Click Auto-Correct.

To select a custom dictionary:
Selecting a custom dictionary adds it to the ones the system checks for spelling errors. It is much the
same as checking default dictionaries (English and Medical).
1. Go to Tools > Spell Check Configuration.
Select a custom dictionary from the list in the Custom Dictionary field.

Correcting Spelling Errors

Example of spelling errors and correcting them
As users type into free text fields where the spell checker is enabled, misspelled words are underlined
with a red line. To correct the errors:

To correct spelling errors:
1. Right-click the misspelled word.
2. Review the list of suggested alternatives in the top part of the right click window and click one if
it’s the one needed. If there are multiple instances of the same error, click Change All, then
select the word to correct all the errors.
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3. If the word does exist but is not in the dictionaries, click Add
4. To add this word to an auto-correct pair, click Auto Correct then select the word with which to
replace it. Every time this same spelling error is made in future, then system will then
automatically correct it.
5. The Spelling option opens a window from which additional options including access to the
dictionary setup is available.

Patient Case Management
The patient case management system gives you the ability to link multiple visits together to achieve
billing, clinical, and other efficiencies. Cases can be set up to include demographics for other responsible
parties (guarantors, and insurances). You can also link multiple referrals/authorizations to a case and
switch them as each terminates. The case can also be set up with various rules including required
providers, specialties and locations. You can also link policies with their associated requirements to a
case so that staff can follow designated protocols to ensure appropriate standards of care, take care of
paperwork and other requirements, and expedite billing. Appointments, chart notes and invoices for each
encounter related to a case as well as any DocMan scans/forms are also available from within a single
interactive window as well as a report. This ability to access all information without having to bounce
around to different modules is extremely efficient.
Some examples of the use of the case management system include:
•

Cross Billing: The demographics elements that you can set up for a case will override the
patient’s defaults when invoices are generated. This makes it a useful tool for cross billing
scenarios like workers comp (WC or WMC), motor vehicle accident (MVA), personal injury (PI)
litigation or other scenarios. Defaults set up in a case override normal patient defaults. These
include:
○ Injury/Illness Date: You have to look this up for each encounter.
○ Guarantor and Insurance: You have to switch this each time you generate an encounter for
the case, and then back again for other encounter types.
○ Referrals/Authorizations: Can also be case based and override other patient defaults.
○ Copay, Patient %: This overrides the defaults from the insurance.
○ Financial Group: Depending on claims filing and reporting requirements, you may need a
special financial group on an invoice.

•

Clinical case grouping: If you want to link visits of a particular type together so you have
another dimension to track and view the case history. An example is for clinical research patients
(drug trials) who may be receiving other medical care at your office. The multiple referral
capability of a case system also lends it to normal treatments where there may be multiple
authorizations required for each visit (e.g. B12 shots). You can also use it for things like
pregnancies.

•

Ensuring policy requirements are met: If you have demanding administrative and clinical
requirements associated with certain visit types, the requirements for the policy are tracked when
they have not been met. Requirements can be simple prompts, or can be forms based where a
scan or Word Form must be linked to the requirement and saved in DocMan.

The case management system is accessible from many places in e-MDs Solution Series:
•

Schedule: The current patient case for the encounter can be seen in the Edit Appointment
window. You can also access the full case management system to view details for the patient or
set up additional cases from this window, the Check In module and the Tools menu. Any case
alerts are also presented when scheduling. These may be in the CPT/HCPCS alert window, or a
case specific alert.
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•

Chart: All notes that were done for a specific case can be viewed together in the Cases tab under
Chart View.

•

Bill: The current case is seen when generating an invoice. As with appointments, you can
access all cases from this field and case based alerts may appear when starting or saving the
invoice. Cases are also availab le under the Tools menu.

•

Demographics: This Misc tab in the patient’s demographics gives access to the complete case
management system. This, technically, means you can review case information from anywhere
that you can access a patient.

•

DocMan: Although there is no direct link to cases in DocMan other than from the patient
demographics, form or scan case requirements are added to the ABN/Forms Manager work list.

•

Daily Work List: There are case oriented filters so that you can generate work lists based on
cases, case status and case disposition.

•

Reports: The Daily Work List Report, Work Restrictions, Injury & Ilness, Case Tracking, and
Accounts Receivable/Sources of Revenue reports all have case filtering to give you the ability to
generate global lists to analyze cases in your practice. Patient statemens and the case report are
ways to report on a detail of one case.

How Encounter Data is Linked and Satisfying Requirements
The case management system can link all information related to a case together so that you can review it
all from one screen. Depending on where and how the data is entered, there are a few ways that it
accomplishes this:
•

Appointments and Chart Notes: An appointment has a field from which you can select the case
for the encounter. When the appointment is saved the case ID is saved with it so this part is
relatively simple. A chart progress note is linked to the case via the appointment. The Note
Details window that is used to start a note and identify the provider also has a field to link an
appointment. This is typically set automatically based on date and other parameters although
you can change it. Thus, if you want to align cases to progress notes, you must create
appointments in Schedule. Likewise, if you change the case for an appointment, you arealso
doing it for the linked chart note.

•

Invoices: These also have a field that lets you select the case manually. However, if you build
invoices from Chart or use the Daily Work List, the system automatically sets the case to the one
for the appointment.

•

Documents: A case can have a number of requirements if you link it to a policy. When forms,
scans or other files are linked to requirements that need these, they appear in the patient’s
DocMan folders in the specified category folders for those requirements. The case management
window also gives you direct access to the forms via the requirements. You can fill out or print
and scan forms from a case or from the ABN/Forms manager described on page 302.

This appointment ID-based linking is important because of any requirements or other rules related to the
case (including one that may be fee schedule based). By default, the system sets the case for a new
appointment to the last active case used for the patient. When the case has requirements, they might be
satisfied in Schedule, Chart or Bill, or using the ABN/Forms manager which is also available in DocMan.
The common link means that users will not get prompted for rules and requirements when they have
already been taken care of.
Thus, if a scheduler or check in staff member managed to get a form filled out, the doctors and billers will
not be prompted to get this information again. This obviously has significant ramifications for how you set
up requirements and office work flow to accommodate the collection of information. In general, it is better
to gather information in advance of a visit or at check. If clinicians are trying to get this information it is
likely to take longer because they might not have access to the necessary forms, etc. Using physician
time to take care of administrative tasks is also costly due to relative reimbursement rates. Likewise,
some requirements may require direct interaction with a patient (filling out a form, answering questions)
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so expecting a biller to do that makes that person’s job much harder too and may delay claims
processing.
Thus, having a good understanding of how the system tracks cases through an encounter and designing
your policies, cases and workflow to optimize productivity and data collection is well worth the effort.

Case Work List
The Case Search window is also an interactive work list that gives you the ability to pull up lists of cases
by a number of different criteria. This makes is a useful tool. For example, new cases might be given a
disposition classification of New/Temporary until additional information is gathered and thus users can
pull up a list of all the new cases and complete the work.
Go to Tools > Patient Case Management in the Bill, Chart or Schedule modules to open the work list.
You can also use the Cases toolbar button in Bill.
Case Work List Options
Create Date Range

Based on the system date on which cases were entered)

Guarantor

All or a specific guarantor/employer)

Active or all cases

Self explanatory.

Case Description

Filters based on the starting letters of a case but you can also use the % wildcard to
search for any text. For example “%back pain” would retrieve: Back pain, Lower
back pain, etc.

Injury/Illness Date Range

Self explanatory.

Patient Name

Search for a patient or use last to quickly load the last patient used in the system.

Case Disposition

Self explanatory.

Case Type

Self explanatory.

You can sort by any of the columns. The work list shows:
•

System Case #

•

Patient Case #

•

Patient Name

•

Case Description

•

Create Date

•

Claim #

•

File #

•

Create User

•

Active

•

# Appointments linked to the case

•

# Invoices linked to the case

•

Disposition.
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Patient Case Window

The Patient Case window gives you the ability to review and manage almost everything related to the
case from one window. The toolbar at the top of the window has buttons to open the patient in edit mode,
print or fax a detailed case report, and print Word Forms that are non policy specific.
This window also has tabs. Regardless of the tab you are on, the case policies and case notes/history
are always visible.
Patient Case Window
System Case Number

Automatically set sequential number. A new case will appear as <New> until the
case is saved and the next sequential number is identified by the system. This field
can not be altered or selected.

Patient Case Number

Automatically set sequential number for the patient. You can change this to another
numeric value.

Description

Should provide some detail about the case, for example: Back Pain or Asthma Drug
Trial. Free text up to 30 characters. This is a search option in the case worklist
window.

Case Type

The type is an additional identifier which you can set up for reference and to classify
a case. Examples are “WMC” or “WC” for workers comp, “MVA” for auto accident,
“Research,” and so on. To set up your types, click the Edit Case Types button and
add them when the editor opens. This is a search option in the case worklist
window.

Required DOS Provider,
Specialty, Supervising
Provider and Medical
Facility

If there is a specific treating, supervising/billing physician, or location requirements
on the case, select from the list. If users attempt to schedule appointments or
generate claims for different providers, specialties or locations they will be warned
about these requirements.

Claim Number

A number that may be assigned by a third party or your clinic. This can be used on
claims.

File Number

A number that may be assigned by a third party or your clinic. This can also be
used on claims.
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Injury/Illness Date

This is the first date for the case. This field is very important. It will save you from
having to look up the injury date when billing because it sets this date in claims for
the case. Also a search option.

Active?

When the box is checked, the case is available on list boxes in appointments and
invoices. Once a case is completed, this should be unchecked so that it is not
picked by mistake. By default, the system automatically links the last active case for
the patient for new encounters.

Disposition

The current status of the case (e.g. cured, new/temporary). This is a useful way to
track cases and is a filter in the case worklist, daily work list and some reports so
that you can generate lists based on your needs. Select one from the list.

Guarantor Tab
Name

This is a required field. Use the Find button to perform a search in the Find
Guarantor screen, or the New button to open a new Guarantor in the
Guarantor/Policyholder Maintenance screen.

Address

This field is not editable and corresponds to case’s Guarantor address in
demographics.

Phone Number

The phone numbers in will display only if assigned in the Guarantor demographics.
This field is not editable.

Case Policy Requirements

A case can be linked to one or more policies which have requirements.
Requirements are tasks that should be done to ensure the case progresses
smoothly. If requirements are not satisfied there are prompts in Schedule, Bill and
Chart to ensure that they are dealt with. Examples of requirements are getting
referrals, filling out forms or contacting certain people. Policy and requirement setup
is described on page 88. To link a policy click Link Policy and select one from the
list. If you want to link multiple policies the system will ask if you wish to replace or
append. When two or more policies are selected which share common
requirements, the system merges these on the case.
•

Requirements: The requirements are listed in the middle section of the
window. The list shows the requirement itself along with a due date, form or
image scan requirements with the scan category; whether it is required
(mandatory) or not; if it’s been completed and by whom and when; and also the
actual name of the image linked to the requirement.

•

Due Date: Each policy requirement can have a due date. This is set in the
case by adding the number of days in the requirement master file to the date
that the case is created. When the current date/time is after the Due Date, it is
displayed in red. You can change the due date details for a specific
requirement by selecting it, setting the date above the list and clicking Change
Due Date.

•

Scanning/Forms Functions: If a requirement requires a Word Form or other
image scan/file import, you can do this from within the case management
window using the Load Word Form, Scan and View buttons.

•

Complete/Incomplete Requirements: When a requirement is satisfied, you
can select it and click the Complete button at right. This changes the
Completed setting to Yes and also adds the user name and date/time. The
Complete button changes to Incomplete if a completed requirement is selected
so you can reverse the status and clear this information.

•

DocMan Access: The Open/Scan Documents button opens the patient’s
complete document folders in DocMan if you have licensed this module.
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Insurance Tab
Financial Group

This will set the financial group (FGP) for invoices under the case. It is extremely
important that this is set correctly since many paper and electronic claims definitions
are based on the financial group. It can also be used as a reports segregator.

Change Group

This button launches the Select Insurance Group and Company screen.

Change Policy

This button launches the Change Case Insurance Policy window. The policy
number can be edited and saved, then immediately reflected in the insurance grid.

Move Up and Move Down

Each button will allow you to change the numerical order (up or down) of the
highlighted insurance name listed in the grid.

Remove

This button will allow you to remove the insurance of the respective highlighted row.

Refresh Guarantor
Insurance

This button opens the Refresh Guarantor Insurance window. In this window, you
will be allowed to choose, up to a maximum of three, insurance companies to be
linked to the case. To save changes, at least one insurance company must be
selected.

Insurance Grid

Up to three insurance companies will display in this grid with the full list stored in the
Guarantor’s demographics file. You can drag and drop columns to change their
order of appearance in the grid.

Guarantor & Insurance

For a new case these fields are defaulted to the patient’s guarantor and insurance.
If another party is responsible for the visits such as for workers comp or a third party
auto accident, click Find Guarantor and select that person or organization. The
insurances in the case are set to those for the guarantor. When a case is linked to
an invoice, the guarantor and insurance override the patient defaults. Since there
may be different groups and policies for different cases under the same guarantor,
you can replace the guarantor defaults, but only for existing insurance companies
linked to that guarantor. A free text policy number is also acceptable. Both the
case-specific group and policy numbers are what will be used on claims.

Referral/Authorization

You can link multiple referrals to a case. An example of this is where some
insurances might authorize multiple encounters or procedures like B12 shots, but
require a separate referral number to be sent on each claim for each one. The one
used by default is the one in the Referral/Authorization. It overrides any other
authorizations that the patient might have. If one is already used and you forget to
switch it on the next claim, a system warning will appear based on the remaining
visit count, date range, etc. See below for how to switch referrals for different
encounters.

Attorney

If an attorney is involved in the case, link one here using the Find Person tool. This
person is added as the Legal Referral in the claim prep for invoices generated under
the case.

Copay, Patient %

These will override the defaults in the primary insurance on any claims generated
under the case. This can save you from having to manually modify patient due
responsibilities if they are not always the same.

Deductible

This is an information only field.

Referral Authorization
Tab
Select
Referrals/Authorizations

This button opens the Referrals/Authorizations window to allow you to associate
existing patient referrals to a case.

New

This button opens the Patient Referrals window to allow entry of a new referral. The
window opens with the case patient field pre-populated with the existing case.

Edit

This button opens the Patient Referrals window with the selected referral in edit
mode.
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Set as Working Referral

This button sets the referral as a working referral. Only an inbound referral can be
selected as a working referral. The grey star in the left column indicates a nonselectable outgoing referral.

Contact Tab
Add Contact

This button opens the Find Person window. Once a person is selected, the New
Contact Description window opens. You can set up one or more contacts on a
case and designate a Case Attorney. These are used for both look up/reference
purposes for your staff as well as by the case report faxing system. All contacts that
have a work fax can be faxed with one click. Examples of case contacts are a
claims adjuster or nurse manager.

Remove Contact

This button will remove case association of the highlighted contact.

Change Description

This button will open the Change Contact Description window, allowing you to
change the contact description

Contact Grid

The grid contains all case contacts. The star symbol at the left of the contact name
can be clicked (changing the color to yellow) to designate a contact as the primary
case contact. This is the person you will most frequently speak with about the case.
A primary contact is not a required designation.

Primary Case Contact

This is the person you will most frequently speak with about the case. Click Find
Contact, then select someone from the person search then enter the description. If
you used this function when another contact was already listed as the primary, upon
saving the case you will be prompted to add the previous primary contact to the list
of other contacts.
•

Case Notes

Other Contacts: A window where you can add and view a list of other contacts
and their description can be accessed via this button.

The case notes section of the patient case window is where you can view
appointments, chart notes and invoices that are linked to the case. These include
the user who created or last updated the record and the activity date so you can sort
by user, type, or chronologically. You can also create manual case notes. The list
can be sorted ascending or descending by clicking any of the column headings.
•

Appointments: The note shows who made the appointment and the resource..
For example: “Appointment created for 09:30am on 12/31/2005 for Smith, John
resource.” To open the actual Edit Appointment Detail window, click Open
Appointment.

•

Chart Notes: Note shows the doctor. For example: “Chart note created by
Smith, John”. To open the patient chart with this specific note selected in Chart
View, click Open Chart.

•

Invoices: Note shows the invoice number. For example: “Invoice #1234
created”. To popen the invoice, click Open Invoice.

•

Notes: Manual notes to document other activity on the case are added by
clicking the Add Case Note button to the right. The window that appears
permits up to 5,000 characters of free text. The window is also spell check and
macro enabled.

Depending on your screen resolution and personal preferences, you can size the whole Patient Case
window. You can also set the requirements and case notes section columns by dragging the vertical bars
between each column. After setting your preferences, click the X at the top right of the window to save
the preference.
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Case Maintenance
Cases can be added for a patient from any of the access points described above. You can also add and
edit cases on the fly where needed. Copy functions that speed up the process are also available.

To add or edit a case:
For specific descriptions of each field, refer to the Patient Case Window section above.
1. Go to Tools > Patient Case Management in Chart, Bill or Schedule.
Search for and select the patient.
Click New in the Case Search window. If you are editing a case, select it from the list and click Edit.
Fill out the Case Info, Guarantor and Insurance fields.
Add a Referral/Authorization information necessary for the case by clicking the Find Authorization
button and then adding and selecting a referral from the main authorizations window.
Add an attorney, if needed (e.g. personal injury cases).
Add Required DOS Provider, Specialty, Supervisor or Medical Facility information, if necessary, by
selecting values from the list boxes. Users are warned if they schedule or bill for invalid entries.
Set a financial group which will be used on claims.
Add case dates for tracking, claims and reporting purposes. Remember that the dates automatically
populate the invoice claim prepare.
Add case Contacts. The primary contact is added by clicking Find Contact and selecting the person from
the person search. The person’s work phone and e-mail are shown on screen. To add additional
contacts, click the Add/Remove Other Contact button. In the Contacts Manager window click New, then
Find Person and search. A description such as “Benefits Adjuster” can be added for each contact. If you
think you are going to fax a case report to contacts, make sure they have an Office Fax in their files.
If you need to link a policy to the case, click Link Policy and select the appropriate one. Any requirements
for the policy are listed in the middle of the screen. The due dates for each are set based on their default
Days Due property from the current date. You can change this for a specific requirement by selecting it,
setting the due date and clicking Change Due Date.
If you need to add a New Contact, click Add Contact, then Find Person. In the New Contact Description
window, you may indicate if this contact is the Case Attorney and enter the Contact Description.
Click Save.

Copying Cases
The copy functions are very useful for adding new cases that are very similar to other ones. You can
copy a case for the same patient, and from one patient to another. Examples of the usefulness of
copying are treating patients for WC injuries where the employer is the same, or multiple patients for the
same clinical trial.
The following elements of the case are copied:
•

Description.

•

Guarantor and insurance.

•

Contacts.

•

Required providers and facility.

•

Copay, patient %, deductible and financial group.

•

Policies and requirements.

There are three ways you can copy:

e-MDs Solution Series Bill User Guide 8.0 R00

299

•

Copy to same patient: Tools > Patient Case Management, search for patient, select case and
click Copy.

•

Copy to another patient: Tools > Patient Case Management, search for patient who has case,
click Copy To, search for other patient and select who needs the case.

•

Copy from another patient: Tools > Patient Case Management, search for patient who needs
the case setup, click Copy from, search for and select patient who has the case.

Reviewing Cases
There are multiple ways that you can review patient cases. These range from simply reviewing a list of
cases for one or more patients to a complete detail with total access to all case related data. Bear in
mind that you can access cases from demographics (Misc. tab), the Tools menu in Bill & Schedule,
appointments, invoices, the daily work list and also Chart View. You can also open them from the
CPT/HCPCS Alert warning window.
•

Case Search Window: This work list is a way to load a list of cases for one or more patients
based on one or more case based filters. Click Tools > Patient Case Management. You can
filter the search by create date range, active or active and inactive cases, and description. The
list includes the case #, description, create date, claim and file numbers, create user, active
status, number of appointments and invoices on the case, and the current disposition. Of course
you can open each case in edit mode to see the detail. The work list can be printed from
Reports > Case Tracking.

•

Case Detail: As described previously, the Patient Case window provides a complete detail of all
case setup data as well as links to forms, scans, appointments, chart note and invoices
generated under the case.

•

Chart View: The Cases tab in Chart view groups displays progress notes by specific case. Each
case has a gold “book” in the tree with the case description. Expanding the tree shows the
progress notes, diagnoses, orders, etc. It’s similar to the Visit Notes or Chronology views but you
have to wade your way through any other data in the tree which is not pertinent to the case.

•

Daily Work List: The appointment-centric interactive DWL in Bill & Schedule has filters that give
you the ability to pull up a list of appointments based on whether they are linked to cases, the
case type and the case disposition. You can also use any other combination of the DWL filters to
generate worklists that make it easier to access information.

Case Alerts
If a patient has a case where certain requirements are not met or other parameters are not met, users will
get warnings at different places to let them know. Keep in mind that if a patient has multiple cases, the
last one used is retrieved by the system.
•

Referral Warnings: If the referral on the case has expired an alert appears when scheduling and
appointment or saving an invoice. You can change the case from here too. Per an example
described previously, it is possible to have multiple referrals on a case which need to be switched
for each appointment. Because each referral is set up with a specific date or visit count
parameter, the warning appears and lets you know that you need to set the correct one. You can
do this by opening the case, then click the Ext button for the case Referral field and selecting the
next one.

•

CPT/HCPCS Alert: This appears when saving an appointment or invoice for the patient, or when
an order is made in Chart where the P button (for Plan) gets a red border and/or the specific ICD
or CPT entered is displayed with a yellow triangular icon. You can click the icon or the plan menu
Process Alerts option. Any case alerts are displayed in the Case Match section. You can switch
cases using the View Case button at the bottom of the alert window. The same window also
shows and policy requirements. You can deal with these by opening the case from here.

•

Invoice Case Warning: This prompt updates the filing status on all line items and may appear
anytime an invoice has a change of insurance. If you continue, you will be prompted to update
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the filing status on all CPT line items. Select Yes to update to update the filing status of all line
items to the default filing status of the primary insurance. If you select No, the system will not
perform any update to the filing status of the CPT line items.
•

Update Fees (Billed & Allowed): CPT line item billed fees and allowed fees can be updated at
one time, automatically, when insurance has changed. When prompted, click Yes, and the
system will use the fee schedules attached to the primary insurance to populate the Fee column
and All-Fee column on an invoice.

Case Reports
There are multiple reports that can currently be used to show a case history for a patient:
•

Patient Case Report: This report is printed using the button within a specific case and includes
all the details of the case as well as case requirements and case notes. If the case notes include
invoices, details such as ICD and CPT codes are shown. The report can be printed and also
faxed automatically to all the contacts on a case.

•

Statement: A statement for a patient can be filted for a specific case. This is a good way to
present billing only data for a case.

•

Daily Work List (Tools > Daily Worklist): Because this tool has case-specific filters it can give
you a different view of appointment-based case data.

•

Patient/Guarantor Accounts Receivable: You can generate a case specific A/R using filters
and options such as only including invoices linked to cases, case type, and account name.

•

Case Tracking Report (Reports > Case Management > Case Tracking): This is essentially a
printed version of the case worklist window. There are a large number of filters and you can sort
by any column.

•

Injury & Illness (Reports > Case Management > Injury/Illness): Generates lists of cases by
various criteria and shows summary information including return to work, lost work, total and
partial disability days as well as total charges by case.

•

Work Restrictions (Reports > Case Management > Work Restrictions): A guarantor/employer
grouped list of cases with appointments and whether these were checked in, no shows or
cancelled. The report also pulls the work restrictions from the most recent note in Chart for a
patient where either the WC LINK WORK STATUS or WORK STATUS plan templates were
used.

Retrieving Case Information on Claims
Data set up in a patient case can be used in claims. In many cases there is nothing extra that needs to
be done because the system populates fields in an invoice or the claim prepare from the case. An
example of this is the injury date, or the disability and other dates. In some cases though you may need
to set up a custom “definition” to pull data into specific boxes on printed CMS claim forms (12/90 or 08/05
versions). For more detail about setting up claim definitions, refer to the Bill user guide.
In addition to all the fields that can be pulled from other parts of the system, there is a specific “Case
Management” file type of definitions to include:
•

Case ID

•

Case Number

•

Case Description

•

Case Type

•

Claim Number

•

File Number
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For the most part electronic ANSI claims pull this information anyway based on the conditional logic of
this setup. If you run into scenarios where this is not happening, contact the EDI support team at e-MDs
who can look into getting this added for you.

Financial Audit Trails
Financial audit trails are used to ensure that audit integrity, for all elements in a transaction, is enforced.
The system uses these strong audit trails to track changes made to any financial transaction, or the
elements around it, which may be important.

Billing Audit Report Preview and Printout
Auditing functionality tracks changes to every field that affects posting. This includes the invoicing (with
invoice insurance, ICDs, CPT grid, Edit CPT, reversals), payments (including sources, insurance,
prepayments, electronic remittances, and distribution data), claim prepare, and claim defaults. Users
have the ability to filter down the data to only show what is important for their purposes, and also have
access to legacy audit functionality. See the Reports User Guide for reporting details.

Important! This report will NOT include any transactions posted before you upgraded to 6.31 even if
you select a From date that is before the date you upgraded to 6.31. To view transactions in the Bill
module before that date, go to Reports > Audit Trails > Legacy.
Financial Audit Options
Search

Retrieves all audit events based upon user parameters for the current date, starting
at 00:00:00.001 a.m. (Note that unlike the demographics and chart audits, there is
no today function). The financial audit details will populate in the bottom of the
Financial Audit window.

Preview

Generates a preview of the print output based upon the parameters. Users do not
need to click Search first to generate the data.

Print

Generates a hard-copy of the audit data. The Windows Print manager will appear
for users to select a printer.

Preview Summary

Generates a print preview of the Financial Audit Summary Report. The summary is
populated with the user selected filter criteria.

Print Summary

Generates a hardcopy of the summary information.

Exit

Closes the audit window.

To view the filters for auditable events in the Financial Audit window:
In the Bill module, go to Reports > Audit Trails > Billing Audit.
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Financial Audit Report Parameter Options
There are numerous areas in the system where users can enter and edit data which is financial in nature.
Auditors can generate an audit trail, either filtered (events of a specific type) or globally (events of any
type). Other filtering criteria allow for further drill down and include: dates, event types, users, patients,
invoices, guarantors, etc.
Financial Audit Report
Options
Activity Date

Reports on the audit date/time stamp for each event. This is a date range and
dynamic filter option. Users can select a start and end date, or can check the
“Dynamic” option and then select the period of Current/Last and
Day/Week/Month/Quarter/Year. Last references the last complete period for the
time selected. For example, if the current date is in March, and the user selects a
dynamic option of “Last Month,” then this will report for the full month of February
st
th
(1 -28 if non-leap year). If the user then selected “Current Month,” the system will
st
st
report from March 1 to 31 , including any future transactions.

Post Date

Reports on the post date of any audit events that have a post date. This includes
payments, prepayments, and charges as well as related tables. If an event does not
have a post date, then activity for these IS included in an audit trail filtered by post
date.

Service Date

Reports on the service date of any audit events that have a service date. Follow
rules for Post Date.

Note: Having multiple date types to query on simultaneously provides users with
options to query for activity events that occurred on a particular date, but which
affected a different date. For example, a user modifies a transaction with a post
date of last year, on today’s date.
User

Gives users the ability to query based upon which person triggered the audit event:

Patient

Gives users the ability to search for transactions for a particular patient.
•

Default Settings: The field is blank by default when loaded from the Reports
menu and will therefore search on all patients. It is populated with the name of
the patient on an invoice when loaded from within the invoice context.

•

Search Button: Users can type a known last, first combination into the field
then hit Enter to automatically open the patient search from which they can
select a patient into the filter. If there are characters in the field, those will be
passed to the patient search.

•

Delete Button: A button with a red X will give users the ability to clear out the
field. Users can also manually delete the characters.

•

Patient Name Display: The field format is last, first.
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Invoice Guarantor

Search for transactions for a particular guarantor. This will be the guarantor on an
invoice (not a patient default guarantor, or case default guarantor). An example of
the usefulness of this and also why users can clear the patient field from an invoice
context is that a biller might be answering questions related to an account while in
an invoice context, and then want to look up other audit entries for the same
guarantor account that is responsible for other patients.
•

Default Settings: The field is blank by default when loaded from the Reports
menu and will therefore search on all patients. It is populated with the name of
the guarantor on an invoice when loaded from within the invoice context.

•

Search Button: Users can type a known last, first combination; or organization
name into the field then hit Enter to automatically open the guarantor search
from which they can select a guarantor into the filter. If there are characters in
the field, those will be passed to the guarantor search.

•

Delete Button: A button with a red X will give users the ability to clear out the
field. Users can also manually delete the characters.

•

Guarantor Name Display: The field format is last, first, or just organization
name.

Invoice #

This will retrieve a specific invoice. The field is blank when loaded from the reports
menu. If loaded from within an invoice or payment, then the field is populated with
the invoice #.

Transaction Classification

Provides options for each event type that a user can execute when running the
application.
•

Insert: Covers new invoices, payments (including remittance and prepayment
application), claim prepare generation (including automatic), etc.

•

Update: Will cover changes at the field level. Every field must be tracked with
a Prior and After value in all forms/windows/grids and would also include
changes where a user accepted a system prompt (e.g. a rule edit). The update
will also be used when using a global tool/function to apply a change across
multiple invoices (e.g. reversals and invoice status update). This will log the
function applied with settings, in addition to an event for each invoice or
payment updated.

•

View: Any view of a record.

•

Print: Any print. Print types include: Print Claim (include type selected and
insurance name); Invoice, Receipt (payment and prepayment).

•

Deny Access: Logged any time a user attempts to access a record but is
denied due to user security.

•

Attempted Delete: Logged if a user tries to delete something but is
unsuccessful due to system prompts, constraints (e.g. a dependency) or
security.

•

Delete: Would immediately follow an attempted delete if a user deletes
anything associated with a transaction including invoice, payment, prepayment,
invoice insurance, CPTs, etc.

•

Audited: Logs any time a view accessed the audit.

•

Search: Logs searches from posting-related windows.

Financial Record Type

This filter will give users the ability to narrow their focus to a particular type of event.

Field Search

This gives users the ability to search by any field name that is logged in the audit
trail.

Description

Gives users the ability to search the audit description so that they can drill down on
specific changes. This is a text search.

Show User Summary on
Print Out

This is an option setting that will add a table of data posted by users in the printed
version of the report.
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Audit Report Access
Audit report can be accessed through a Reports menu function and from within the invoices and
payments, where users might wish to query a history as part of researching a claim or payment that is
already open.
To access the audit report from the Bill Charges & Payments window or the Posting Ledger window, click
the Audit button.

To generate an audit trail from the Reports menu:
1. Click Reports > Audit Trails > Billing Audit
2. In the Financial Audit window, select a start and end date, or select the Dynamic checkbox and
then select the period of Current/Last and Day/Week/Month/Quarter/Year.
3. Click Search to view results
Security: Note that the audit report is only visible to users with the Billing Invoice Audit security privilege
with R, RW, or RWD access levels. It is not visible to users that only have Deny, or are not assigned to
the privilege.

Printed Audit and User Productivity Report
A printed audit report will replicate what is seen in the on screen list and shows a chronological list of
events that have occurred in the financial system. The audit also tracks all events by user and activity
count. See the Reports User Guide for reporting details.

To use the report to track user productivity:
1. In the Bill module, click Reports > Audit Trails > Billing Audit.
2. In the Financial Audit window, choose filters for Date of Activity and any other user or invoice
search criteria. Click Search.
3. The details of the search criteria will populate at the bottom of the window.
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Previewing the Printed Report
Data fields in the Printed Report include:
•

Date, Login Name, Workstation: The data is sorted in descending order (i.e. most recent
transaction at the top).

•

Field: The name of the field affected.

•

Action: (see event types listed under Transaction Classifications in the list of parameter options).

•

Type of Record: See financial record type.

•

Invoice #: Shows the invoice # against which the change was made (for payments, it is the
invoice number to which the payment was applied, and for prepayments this is blank where the
prepayment transaction is not being applied).

•

Patient: The name of the patient on the invoice.

•

Form Name: Name used when a query is executed which is not patient specific and would
include the name of the window from where the search was started instead (Posting Ledger,
Prepayments, Payment Source, Collections, Invoice Status, or Rule Editor).

•

Description: All possible activities (General, General Queries, Audit Accesses)

To preview a Billing Audit Report:
1. In the Bill module, click Reports > Audit Trails > Billing Audit.
2. In the Financial Audit window, choose filters for Date of Activity and any other user or invoice
search criteria. Click Search.
3. Click the Preview button to view the detailed Billing Audit Report.
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To preview a Summary Productivity Report:
1. In the Bill module, click Reports > Audit Trails > Billing Audit.
2. In the Financial Audit window, choose filters for Date of Activity and any other user or invoice
search criteria. Click Search.
3. Click the Preview Summary button to view the detailed Financial Audit Summary Report.

ABN/Forms Manager
The ABN/Forms Manager is a work list that is populated when CPTs and HCPCS linked to forms are
used, or when a case with policy requirements requiring forms or scanned are linked to patients. These
effectively queue up a requisition list of placeholders for documents that are needed.
The ABN/Forms Manager is one of two ways that these forms requirements can be satisfied. The other is
by opening the patient case window and using the tools available in that window. Each has its
advantages depending on work flow. Where this tool is most useful is for generating work lists or missing
form- or scan based tasks to enter forms from a stack that might have been collected through the day
because you have scanners available at convenient locations and times for all people in your clinic. The
case management tool is best suited to filling out the forms when the patient is in the office.
This is not always practical given that you may not have a scanner readily available. Thus, you might
deal with the form and put it in a box that your scanning staff deals with later on. Another real world use
of this is to generate a work list of tasks that need to be completed based on date range. For example,
you might want to find all patients who need to have a specific form filled out.
The forms manager is available from the CPT/HCPCS Alerts window as well as from DocMan. When
used in an alert it is a work list for a patient that lets you open, save, view and scan forms. When used in
DocMan, it lets you link a document that has already been scanned for the patient using the normal
DocMan scanning functionality. The list in DocMan can be global or patient-specific depending on
whether you have a patient opened or not.
In order to use the document storage capabilities of the forms manager, you must have licenses for
DocMan.

e-MDs Solution Series Bill User Guide 8.0 R00

307

To satisfy forms-based tasks:
These instructions will show you how to use the tool to generate a work list and why you might use
some of the functionality.
1. Access the forms manager in one of the following ways:
○ CPT/HCPCS Alerts prompts in Schedule, Chart and Bill: Click Manage Forms/ABNs from
the CPT/HCPCS Alert which is loaded via the buttons and icons in the Edit Appointment
window, the Chart alert icon next to a CPT or on the Plan button, or the invoice CPT/HCPCS
Alert button in Bill.
○ DocMan ABN/Forms Manager: If a patient is already loaded this automatically filters the list.
If you have a patient loaded, then the list is global. There is a button on the main DocMan
toolbar or use Tools > ABN/Forms Manager.
2. By default the system loads a list of forms-based tasks that are incomplete and the form missing.
You can filter the list as follows:
○ Task Date: This is the date that the task is due. As part of a requirement’s setup you can set
the number of days due before or after a specific base date which can be set by whomever
creates the patient case.
○ Facility: Depending on where the case was created, a requirement is linked to a facility
although it does not have to be scanned from that location. If you arenot sure of which facility
it is, set this filter to All Facilities.
○ Show Incomplete Tasks: When this is checked (the default), the list only shows tasks that
have not been completed. You might want to view a list of all tasks ever completed for a
patient or find one that was marked as such by mistake. If so, uncheck the box.
○ Show Missing Forms: This is also checked by default so you get a short list of entries with
which to work but you can also generate a list of all forms ever scanned for requirements by
un-checking the box.
○ Form: If the form you arescanning is one that was printed using Word forms and you
recognize it, you can set this filter to only find entries for this. It’s not likely to be used when
scanning forms but is a good tool to find and view prior Word forms that were filled out and
either saved on line, or scanned in.
3. Review the forms that charge entry or case activities. Each entry in the work list represents a
forms-based task that needs to be completed. It is a “placeholder” which is required for the
document and which helps label and categorize it in the patients’ document folders. If you are
familiar with scanning or importing images and files in DocMan, you will understand this concept.
4. Use the function buttons and Received checkbox in the list itself to add, review or modify forms
and complete the task:
○ Load Form: If this is a Word form based task, the button is available. Click it to open the
form. You can fill it out on screen and save it without printing if the form is set up with a
default DocMan category. The name you are prompted to enter (which defaults to the form
name) is what it will appear as in the patient DocMan files and the Received column. If you
need to print the form and will scan it later, click Cancel when prompted to save. If you use
this for a task that already has a form, you will be prompted first to ensure you want to
overwrite it.
○ Scan Image: This can be used for scanning Word forms that were printed, or any other form.
You can also use it to import a file (e.g. PDF, Word document, etc.). You will be prompted to
give the document a name which is how it will appear in the patient folders. Then if the
requirement was not set up with a default DocMan scan category you have the option to select
that. The standard DocMan Image Viewer tool is then used to capture or import the file. Save
it and exit back to the forms manager. If you use this for a task that already has a form, you
will be prompted first to ensure you want to overwrite it.
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○ View Image: If there is a form or scan associated with a task this button is available. When
you close the image or file, you will be taken to the complete list of DocMan files for the patient
and will need to exit from that to return to the forms manager.
○ Delete Entry: This is used to completely remove the task from the list.
○ Received check box: You will see a box in the Received column. This caters for the real
world workings of most practices. In an ideal scenario a form may be filled out and signed on
screen by staff and patients and immediately saved back into the system without ever printing,
thus satisfying the task. Another desirable scenario is to have several scanners that are easily
accessible to any staff who are dealing with forms and if the form is not a built in Word form, it
is quickly pulled by staff so it can be completed almost as soon as the requirement alert
appears. It’s immediately scanned thus satisfying the task. Unfortunately, in most cases a
form is printed, filled out by someone who does not have ready access to a scanner and
maybe put into an inbox or other stack for later scanning, possibly by someone who is the
dedicated scanner. Thus, the form required for the task might not be in the system even
though it has been filled out. This is where the check box comes in. Once you have
completed the form and handed it off, you can check this box to note that the task is
completed and to stop alerts that are now redundant and would therefore be annoying.
The following instructions assume that the form has already been scanned into the patient’s folders in
DocMan. This tool lets you link the document to a task so you have to delete it and then rescan.

To link a form scanned in DocMan to an alert task:
1. Open the patient in DocMan.
2. Select the document you need to link.
3. Click Tools > ABN/Forms Manager. You can also click the toolbar button which looks like a piece
of paper with a red $ sign over it. Another option is to open the scan and click the same button in
the image viewer.
4. Review the outstanding tasks in the list for the patient. These are loaded by default.
5. If the task you are looking for is not in the list, you can change filters like Show Incomplete Tasks
or Show Missing Forms to see if the task is in the list and has maybe been linked to another form,
or has already been completed.
6. Select the task you want to link this document to.
7. Review the document name in the Image field. This is the document you selected. If it is the
correct one, click Link Image. (Note that if you make a mistake, you can select another document
and replace the link.)
That is how alerts can be satisfied and because the requirement is linked to a case, it does not matter
how many more times the patient visits the clinic or in the modules in which staff work. The requirement
is taken care of for the duration of this case.

Image Capture Tool
The Image Capture tool is used in several places in e-MDs Solution Series such as capturing patient
photos and insurance cards. The tool gives you access to TWAIN compliant scanners or cameras.
When it is launched from another part of the system (e.g. patient insurance), you will see a window with
several buttons:
•

Take: This button will start the software or hardware depending on the Options setting (see
below). The image will either appear directly in the place holder, or the system will load the other
device’s software from where you can capture and select the image.

e-MDs Solution Series Bill User Guide 8.0 R00

309

•

Select: Gives you the ability to select a specific image capture device to use for this image if you
have more than one installed on your computer. The system remembers the last one used.

•

Options: Gives you the option to use the hardware manufacturer’s software to take the image
and then pull it into Image Capture, or to take it “natively” by reading directly from the camera’s
memory. When the latter is used, clicking the Take button immediately captures the image into
this window.

•

Accept: When the image that is displayed is satisfactory for your needs, Accept takes you back
to the place from where you started (e.g. patient driver license) and puts the image into that field.
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12

Miscellaneous
Functionality and
Information
This section of the user guide covers additional features in Bill, as well as how to
handle some different billing situations. Many of these topics overlap with the
extensive help provided in the Posting section. We recommend that users read all
these topics regardless. If a situation arises in your office that is not covered here, the
chances are that the greater understanding you will have of e-MDs Bill will help you
deal with the problem.
Continued on the next page ...
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Correct Coding Initiative (CCI) Edits
The Correct Coding Initiative is a program developed by CMS/HCFA and Administar to prevent
overpayment of Medicare claims by detecting fraudulent and inadvertent coding errors that result in
higher charges. CCI edits check for comprehensive/component and mutually exclusive pairs of codes in
invoices.
Very simply, comprehensive/component errors are where a clinic uses multiple codes to bill for services
when a code exists that covers all the charges. Mutually exclusive errors occur when the services billed in
an invoice cannot reasonably be performed by the same provider on the same date.
Clinics that regularly send in claims with these errors will see more claims denied because they cannot
meet filing requirements. This can have a serious effect on your cash flow. In addition, the chances of
being audited may be higher.
The e-MDs Bill program includes a utility that checks codes in an invoice for these errors. In order for the
utility to be effective, you must keep the CCI edit data files up to date by checking the e-MDs Bill support
pages of www.e-MDs.com for quarterly updates.

To download CCI edit updates:
1. Connect to the Internet, open your web browser and navigate to www.e-MDs.com.
2. Click the link to Support, then go to e-MDs Bill Customer Support. The list of pages under this
section of our web site includes one for CCI edits.
3. Click on the link to CCI Table Updates. The page contains information about CCIs. A table at the
bottom of the page shows the files that are available for download. CCI edits are updated
quarterly.
4. Click the file you need. Most browsers will automatically present a File Download window.
Choose the option to save the file to disk, then click OK.
5. Browse to the folder where you want to store the file. You should create a folder on your server
where you keep e-MDs data files and downloads (c:\program files\e-mds\data).
6. Click Save. The file will download into your directory.

Working with CCI Data and the Solution Series Database
There are a few key steps you should perform before adding or updating CCI data when dealing with the
Solution Series database:
•

Always back up your database before running queries.

•

The update will ask for a database name and login information, thus this task is best started by a
system administrator.

•

Depending on the speed of your processor and memory installed, the component code edit database
update can take some time to run. As a benchmark, a P400 with 256MB of RAM was measured at
nearly 3 hours. Thus, this is better run overnight. If your system has much lower resources, the
update time can go up exponentially.

To add/update CCI data to the e-MDs Solution Series database:
1. Back up your database.
2. Although not necessary, it is recommended that all users close e-MDs Solution Series
applications.
3. Browse to the folder where you downloaded the CCI Update program file and double-click it. An
installation program will start. Click Next.
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4. A window appears asking for a DATABASE ADMINISTRATOR username, password and
database name. This is NOT your normal login. If you know what the database administrator
login is, contact your network administrator. It is vital that you enter these correctly. Click Next.
A message appears telling you the service operation completed successfully. Click OK. The update
process begins. You will see a series of queries being run one after the other. Each has a name for the
type of CCI data it is entering, and then a query number. A status bar with steps indicates the execution
progress of each query. There are over 40 queries that will be run automatically. This will take some time,
so it’s not necessary to watch.

When the update is complete, a message tells you that the database log file has been updated. Continue,
and exit when prompted.

Note: Once again, the CCI data files are quite large, thus the update may take a while,
particularly on older, slower computers. Run this process overnight and be patient!
To audit invoices for CCI errors:
The audit is initiated at the time of invoicing. In each invoice, there is a CCI Check checkbox to the
right of the Set Prim. CPT button. When this is checked, the system will run the CCI audit after the
invoice is saved. If any errors are present, a warning pop-up will appear. This will detail each CCI
error it finds in the invoice, and will also tell you if a modifier can be used that allows the two codes to
be billed together.

Provider Assignment
Provider assignment flags in e-MDs Bill refer to the insurance payment assignment. In other words, if a
provider accepts assignment for a particular insurance carrier, payment for claims should be sent to the
provider’s office, not to the patient. By default, most practices set the provider assignment flags to Yes
indicating that they wish to receive payments. This simplifies collections. If a patient has not paid a bill,
and they also get the check from insurance, there is a greater chance of bad debts in the practice.
Assignment is set by provider (Accept Assignment field in provider file) and by Insurance Company (PAR
checkbox setting). When an insurance invoice is created, the system checks these settings and sets the
Assignment flag in the Claim Prepare window. If the patient paid for the services, the box can be
unchecked.
You can always change assignment at invoice level by checking or un-checking the box provided in the
Claim Prepare screen that appears after each insurance invoice. See To modify an invoice prep on page
173. The setting in this screen is dependant upon the setting in the provider file.

e-MDs Solution Series Bill User Guide 8.0 R00

314

Recall
The recall system is made up of several components:
•

Recall Types: These are why you want the patient to return.

•

Patient Recall Dates: This is where the recalls are added to patients.

•

Retrieve Patients With a Recall: There are multiple reports in the system for this. Note that if
you have Chart, you can also use the clinical rules engine to automate recalls using best
practices, etc.

To set up recall types:
You can add as many different recall types as needed.
1. Go to Reference > Patient Recall Types.
Click New.
Enter the Internal Name and description. The description is used for the recall report filter and on the
print out.

To set a recall for a patient:
There is no limit to the number of recalls that can be added to a patient. The same recall type can
also be added multiple times for the same patient using different dates.
1. Open the patient file in edit mode.
2. Click the Misc. tab.
3. Click the Add button above the Recall Dates grid.
4. Select a recall type.
5. Enter the date. You can also select a staff provider who requested the recall and can add a short
memo. These items print in the Patient Recall Dates report.
6. Click Save.
Even though this is really a check out task, the Schedule check in module also has a custom check in
task to set a recall because it’s another easy way to get to the patient file. When the button to set the
recall is clicked in the check in module, it opens the patient’s demographics directly to the Misc. tab.

Generating Recall Reports
There are several reports in the system that can be used to retrieve patients with a specific recall in a
date range. Each is described in more detail in the reports section of this user guide.
•

Patient Recall Dates: This report lets you filter by date range and then select from one or more
recall types and the requesting doctor. The output lists patients, their telephone contacts, the
recall date, provider and memo. Showing all the recalls together for the patient is nice because
when someone calls to schedule an appointment, they can allow for extra time, or schedule
multiple appointments with one call.

•

Notice Processor: This report has many more filters such as provider, insurance, etc. You can
select a recall date range and one recall type on which to generate a notice. The letter editor lets
you print a mail merge letter that can be sent to the patient. You can also generate a patient list
from this window.

•

Patient List: Use the notice processor to generate a patient list.

Again, if you have Chart and use the clinical rules/reminders engine, this gives another full blown patient
recall system with reporting.
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Patient and Insurance Responsibility and Payment Order
of Expectation
Understanding how e-MDs Bill deals with invoice balances is critical.
Each insurance group is set up to calculate the responsibilities of insurance and patient on subsequent
invoices. As has been explained elsewhere in this manual, the system divides invoice balances into three
types of responsibility. These are insurance, patient copay, and patient payment.
When setting up group information, you need to be aware that this will affect how the system apportions
responsibility. Until that responsibility is met, the system will continue to prompt users about the missing
balance. For example, if no copayment is taken, the system will always assume the next payment on an
invoice is the copay, and will also put a comment in the patient statement that states the copay has not
been made on the invoice. The expected order of payments is:
1. Copayment or patient percentage responsibility.
2. Insurance Payments.
3. Balances transferred to the patient.
The insurance group settings can be overridden for each invoice. For example, some visits cannot require
a copayment. On others, a deductible may not have been met. You can also transfer an insurance
balance to the patient after insurance has met its contractual obligations. You can also change the
copayment or percentage responsibility at invoice level by clicking the Edit button in the Insurance tab of
the invoice and manually overriding the settings displayed. Finally, you can change patient Payment
Classifications if you are making a different kind of payment.
Just remember that you cannot post insurance payments as patient payments and vice versa. Separate
insurance and patient payment buttons are in the system to reduce the chances of this occurring.
Likewise, you cannot post a copayment as a simple Patient Payment because this does not satisfy e-MDs
Bill’s copayment requirements. Even though the invoice balance is apparently reduced, the system will
still have non-zero internal balances, i.e. those balances will still be reflected on statements, etc.
Some examples of balance responsibility:

EXAMPLE 1:
Insurance Group is set up with $10 copay, 100% insurance.
Invoice Grand Total = $100.00
Patient Copay Balance: $10.00, Insurance Balance: $90, Patient Balance: $0.
Possible User Errors and Results: Insurance Check is classified as Patient Payment. The result is still a
zero balance invoice, but the insurance balance is still $90, while the patient balance is ($90).

EXAMPLE 2:
Insurance Group is set up with $10 copay, 50% insurance, 50% patient.
Invoice Grand Total = $100.00
Patient Copay Balance: $10.00, Insurance Balance: $45.00, Patient Balance: $45.00
Possible Errors and Results: Copayment is posted, but is classified as Patient Payment. The result is that
insurance is unaffected, but e-MDs Bill still thinks $10 copay is outstanding and will print a comment to
this effect in guarantor statements, while the outstanding patient balance is $35.

EXAMPLE 3:
Medicare Insurance Group is set up as 0% insurance, 100% patient.
Invoice Grand Total = $100.00
Insurance Balance: $0, Patient Balance: $100.
This is obviously a set up error because it should be 100% insurance (assuming normal Medicare). If
insurance payments are then posted with the correct classification, you are simply creating a credit
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insurance balance and not doing anything to the patient balance. The chances are strong that guarantors
be happy to receive some very high bills
Of course, you can simplify by setting up every insurance group with only the copay amount and 100%
insurance. Since you can really only bill guarantors for their responsibility after insurance settles, the
balance transfer can be made after the insurance payment is received. (To prevent billing a percentage
responsibility on a charge that is not the insurance allowable, make sure you select the No Print Invoice if
Amount Due Awaiting Insurance Option when printing statements.) Charges in the invoice are adjusted
after receiving the insurance allowable. In this case, the residual balance can be written off, or transferred
to the patient, in which case the patient balance will increase while the insurance balance is reduced.
There is a utility in e-MDs Bill allowing users to change invoice balance assignment with a simple doubleclick. This is described below.

Transferring an Invoice Balance to a Patient
After taking insurance payments (or rejections for non-covered procedures), the patient’s guarantor
becomes responsible for the balance. In such cases, the normal group responsibility setup no longer
applies, so you need to tell e-MDs Bill to assign the balance to the patient. If you do not, the system
continues to expect the insurance responsibility and print guarantor statements. There are several places
where you can change the responsibility of the invoice to the patient.
•

Payment Window: In the payment window, where you post all insurance payments and
adjustments, there are two radio buttons towards the bottom left. These are to specify from whom
the Invoice Balance Due is by. After posting the EOB comments, click the Patient radio button
and save the payment/adjustment. 100% of the balance then becomes the patient responsibility.

•

Invoice Insurance Edit Window: If you know in advance that insurance will not cover charges,
you can transfer the balance to the patient during invoicing (without deleting insurance so you can
still file just in case). Click the Insurance tab, highlight the insurance and click the Edit button.
Change the % Insurance field to 0 (and thus patient to 100%).

•

Invoice Window: Set the financial group to PVP and save. This moves the insurance balance to
patient balance. It cannot be reversed by changing the financial group back to something else.
For that, you must use the Invoice Payment Due By tool

•

Invoice Payment Due By: This is an onscreen utility used to review invoice statistics. See on
page 262.

Credentialing
e-MDs Bill tracks credentialed providers by insurance carrier. Each insurance company can have multiple
credentialed providers. If a provider is not credentialed, users are alerted when they save an invoice that
the supervising provider is not authorized to provide services for the insurance company. This is an
extremely useful function, especially for larger groups.
A default credentialed provider can be linked to all insurance companies. This provider is defined in the
Internal Medical Facility window. When a new insurance is created, this provider is automatically linked to
the insurance.
There is a shortcut to add all providers set up in a facility to an insurance company by clicking the Link All
button in the insurance company credentialed providers tab. Any provider that has been set up in the
internal medical facility is then linked.
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Rendering/Performing Providers
When filing claims under a group identification, insurance companies require the provider who performed
the services to be identified since the group see the patient. Since the group identification is filled into the
main insurance identification fields, the rendering provider information has to be linked to the claim.
Rendering provider numbers are stored in the related fields of the provider files. It is the clinic/group’s
responsibility to ensure that they apply for and receive rendering identification numbers for each physician
credentialed to provide services for a carrier.
e-MDs Bill automatically inserts the Supervising Provider from the invoice into the Rendering field in the
Claim Prepare screen. You can change this if necessary. Extreme caution is advised since you must be
sure that the rendering provider is permitted to provide services for the payor.

To change the rendering provider on a claim:
1. Create an invoice as usual and click Save after entering all information. The Claim Prepare
screen appears.
2. Click the Find button by the Rendering Provider field.
3. Search for and select the applicable provider.
4. Continue adding other information as required.

Understanding Credits and Adjustments
It is very important that you understand the terms used here and how the elements work together.

The Bank
Credits and adjustments are similar in process to payments. In fact, the payment window is used to post
these. The main thing that users must keep in mind when making changes that affect the balance of
accounts is “where is the money going?” In e-MDs Bill, if money is coming into or leaving the system
(effectively the facility bank account), the payment field is used. If money is moved around within the
system (thus, the bank balance is not being affected), then the adjustment field is used.
To illustrate this point, imagine that a payment has been made on an invoice. Since this payment will be
deposited into the bank at the end of the day, it will affect the bank balance so it will be posted into a
payment field. Later on, the clinic might discover that this was an overpayment, and part of it needs to be
applied to another invoice. Now the money is moving around within the system. It is not going to be put
into the bank again. Thus, the movement of the money from one invoice to another is an adjustment. On
the other hand, if this extra amount was credited to the patient and the clinic actually gave the patient the
amount, the bank balance will be affected so this entry would be entered in the payment field (even
though it is a negative payment).
Note: Some clinics still post changes in the adjustment field and reflect the bank change in their
accounting software.

Double Entry
As with any accounting system, double entry is required. In many cases, the double entry is implied and
does not need to be entered by the user since this is a patient accounts receivable system only. For
example, when you post a payment to an invoice, you are reducing your total debtor balance. The other
side of the transaction (increasing your bank balance) will happen when you put that payment into the
bank account. Of course, in this situation, the double entry is favorable since you actually have the money
‘in the bank’ so to speak, not somewhere out there on the ‘never-never’! Your liquidity is improved.
When posting adjustments, the rest of the clinic accounting system (overhead, salaries, bank balance,
etc.) is not affected. Thus, you must post both sides of the transaction yourself. This is much simpler than
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it sounds. For example, if you make a credit adjustment to increase the balance of an invoice, the
adjusted amount has to reduce the balance of another invoice. This is simply an example of rectifying an
overpayment on an invoice, but the same principal applies to a credit invoice.
The point is, post an adjustment to one side only. The only time you should do this is if a mistake was
made in the original entry (payment, charges, or another adjustment). In fact, when you do this, you are
really adding a missing second entry.

Posting a Balance Forward
If you are transferring balances for another computer system, you need to post these as normal invoices.
A balance forward invoice consolidates all invoices from the previous system into one. However, a special
code must be created to do this. Just set up a special CPT code in the CPT database. After this is
completed, generate an invoice for the patient to whom the balance forward is being posted. No ICD code
is required. If you are posting a balance with both patient and insurance responsibilities still outstanding,
go to the Insurance tab, click the Edit button and set the insurance: patient percentage ratio to reflect this.
Set the insurance status to Null.

Indigent/Poverty Discounting
There is built in functionality that lets you set up discounts based on a sliding scale. The discounts can
be taken automatically when an invoice is saved for patients who qualify. When the system requirements
are met, users are prompted to apply an automatic discount adjustment and the patient due amounts are
also set accordingly.
In order for the automatic adjustment prompt to be presented to a user, several requirements must be
met:
•

Poverty Guidelines: This reference table is populated with master data from the federal poverty
guidelines table. However, you can modify it if you want to set up your own means-based
discounting structure.

•

Sliding Scales: The sliding scales are where you set up your discounting levels. You can set up
as many levels as you wish. Each level is based on a percentage of the poverty guidelines and
you can set up a copay and discount percentage along with invoice and line-item level discount
codes for tracking purposes.

•

Poverty Level information must be set in the patient’s demographics. The fields for this are in
the Misc tab. They are # Family Members, and Income. A Set Poverty Level checkbox displays
the sliding scale level, copay and discount amounts based on cross-referencing to the sliding
scales and poverty guidelines tables.

When charges are saved for a patient who falls within a sliding scale level based on percentage of the
poverty guidelines in which their family income and number of family members falls, the following occurs:
•

If the patient has insurance with a fixed copay amount, this may be adjusted to match the sliding
scale copay.

•

A prompt appears upon saving an invoice. This prompt notifies the user that the patient qualifies
for a discount. It shows the remaining amount owed by the patient. Note that this is in addition to
any fixed copay that has been set up in the sliding scale. If you answer the prompt in the
affirmative:
○ A patient payment/adjustment is added to the invoice.
○ The payment/adjustment level adjustment code is set to the default using the one set up in the
sliding scale table.
○ It has a statement comment of “Sliding scale discount”
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○ It has line item distribution comments of “Sliding scale discount” for each code adjusted.
○ It applies the discount as an adjustment to each code using the adjustment reason code set
up in the sliding scales table. This also cross-references the poverty guidelines table so that
the applicable state is also used.

Refiling Line Items on Claims
If an insurance EOB does not pay all procedures in a claim, downgrades line items, or omits them, you
may want to refile those line items.
In the distribution screen, on the line in which payment and adjustment amounts are entered, there are
cells for the file status (FS) and Status. The status codes are for reference only. You can also use the
line item comment and invoice notes to document the refiling reason. The status code definitions are as
follows:
•

DG: Downgrade (e.g. insurance downgraded a 99214 to a 99213)

•

RJ: Rejected

•

OM: Omitted (the line item was not mentioned on the EOB)

•

SP: Short payment

•

LP: Long payment

In the payment distribution grid, enter the refiling file status (e.g. NF, EF) for the CPT. There are two
ways to ensure these are filed:
•

Flag the invoice insurance so the claim is in your normal batches: Select the specific
insurance in the invoice, click the Edit button, and change the invoice status. When you save this
change, you will be prompted to update the file status for all lines. Click Yes, otherwise all codes
will be included in the claim. The next time you generate “normal” batches for unfiled claims,
these will be caught by the default File and Line Items status filter settings in the EF or HCFA
Wizards.

•

Build Special Batches: In the EF or HCFA wizards, you can set the File Status filter to pick up
insurances that were filed previously (e.g. NX or EX), but a Line Item status to unfiled. You may
wish to create pre set report or file generation parameters in Report Manager to ensure this is
done on a regular basis.

Because refiled claims usually require an accompanying narrative or other documentation to justify the
billing, they are usually on paper. In such cases, printing them in the batch of paper claims might not be
advantageous. You will have to search for the claim in the batch, and if you print large batches at irregular
intervals, they can be hard to find, assuming you remember.
To prevent this, check the Print HCFA on Save box near the top of the invoice and save. Put the printed
copy in our in tray. The stack of printed HCFAs is a work list for you.
Note: If you wish to reprint all the line items in a claim, the line item utility be used. Rather, reset the
insurance status flag in the invoice itself and click Yes in the prompt to file all lines.

Changing Posting Dates
The ability to change the posting date of invoices and payments can be very useful. e-MDs Bill is
extremely date sensitive. All financial reports key off date ranges. Thus, if charges or payments are
posted to the wrong date, it will affect your statistical tracking.
Medical offices often run behind in postings. On a busy day it is possible to receive several large EOB
checks that cannot be posted on the day. Since the checks are deposited in the bank account on that
day, the activity should reflect this. Users can manually change the posting date for each invoice and
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payment, but this adds keystrokes. The Default Date feature permits users on one computer to post
multiple invoices and payments on different days to the current date. Thus, you can reflect deposit dates
and activity on the day they occurred.
The default date feature is workstation-specific. While the rest of the network is working on the current
day’s activity, you can set one terminal to post information for another day. The field is available in both
the Invoice and Payment windows. It is important to note that it is not the date in this field that is used for
statistics. It is simply a utility that affects the posting date and the dates of service.
After selecting the correct default date, the system updates the other date fields. The default date on the
terminal will remain at the date set until you change it back or close and reopen Bill. Thus, it can be used
to set the date for multiple invoice and payment postings, but do not forget to change it back when you
post the current day’s activity! The default date is reset to the system date every time you close and
restart the application.

Insurance Applies All or Part of an Invoice Balance to
Deductible
If a patient has a deductible (i.e. a fixed amount per year which they must pay before insurance pays
benefits) it is impossible to track the outstanding amount until the EOB returns, because the patient is free
to visit other physicians. By filing the insurance claim, the carrier will apply the amount of the claim to the
deductible, thus reducing it for further claims. The balance of the invoice is thus due from the patient.
In the event that the patient is honest and pays the due amount at the time of the visit, the claim must still
be filed.
After receiving notification that a balance is being applied to the deductible, the following procedure
should be followed to reflect it in the accounts and bill the patient for the balance.

To apply a balance to the deductible:
1. Load the patient in the Posting window.
2. Highlight the invoice in question. Click New Payment.
3. Ensure the Payment Made By / Insurance radio button is on.
4. Enter a zero amount in Payment and Adjustment field. Attach an appropriate comment (it is
recommended that a unique comment be created in the Reference database for deductible
adjustments). If part of the invoice is also being paid, enter this amount in the distribution screen.
5. Click the Invoice Balance Due / Patient radio button.
6. If desired, check the Print After Save / Statement check box to immediately print a bill for the
patient.
7. Click Save.

Procedures Not Covered By Insurance
Some insurance company plans pay benefits dependant upon the type of procedures performed. For
example, a copayment may not be due on lab services, but is due for other care, or insurance does not
cover minor surgery. In such cases, the predisposition of e-MDs Bill’s insurance company setup in which
the carrier and patient are assigned percentage responsibilities may not apply. In these cases, it is up to
the staff to be aware of what the covered benefits are.
•

If the entire responsibility of the invoice is now the guarantor’s, but the patient insurance group setup
has made e-MDs Bill expect an insurance payment, users should transfer this balance to the patient
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using the utility described on page 213, and should also associate a comment with this “adjustment.”
The comment will print in patient statements, thus reducing the possibility of them contesting the bill.
•

If the copayment is not due, refer to the "Writing Off a Copayment" section. If the services are not
covered and the responsibility is now the patient’s, follow these instructions.

To transfer an invoice balance to the patient:
1. In the Posting window, highlight the applicable invoice and click the New Payment button.
Click the radio button marked Invoice Balance Due Patient.
Enter an applicable comment.
Click Save.

Courtesy Discounts
These types of discounts usually refer to writing off money in some way.

Writing Off a Copayment
Sometimes clinics waive the patient copayment (where payor contracts permit). This write-off must still be
reflected in the system for accounting purposes. Users will also recall that if a patient has an insurance
group with a copay setup, e-MDs Bill will continue to expect that copayment until told otherwise. If users
cannot enter an adjustment to reflect the copayment write-off, the system assumes each new payment on
the invoice as a patient copayment. It will also reflect an outstanding copayment on guarantor statements.
Thus, you must manually remove the copayment responsibility from the invoice.
It is important to understand that you cannot take a copayment, and then enter an adjustment. From an
accounting standpoint, this would falsely reflect that money entered the system. Thus, the practice
management system and clinic bank account would differ.

To write off a copayment:
1. Start an invoice and immediately click the Insurance tab.
2. Highlight the primary insurance and click Edit.
3. Change the amount in the invoice Copay field to 0.00.
4. Click Save.
5. Continue as normal with the invoice.

Charges Write Off/Courtesy Discounts
Before making an adjustment to a patient/guarantor balance, it is important that you understand that this
is significantly different from an insurance adjustment. Insurance adjustments are usually contractual
write-offs (i.e. the fee in the insurance claim may have been the office fee for service, but when billing
there was never an expectation to receive this amount). Courtesy discounts are not significantly different
in that the amount is also being ‘given away’. However, the amount being written off is now from the
amount for which the guarantor is responsible. Thus, it is critical that clinics cannot make a courtesy
discount on a balance that the system believes to be an insurance responsibility.
Since e-MDs Bill is very strict in the determination of the insurance and the guarantor responsibility,
ensure that you make the courtesy adjustment to the patient balance.

To make a courtesy adjustment:
1. Highlight the invoice and click New Payment.
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2. Check the patient balance at the top of the window. Make sure the Payment Made By Patient
and Patient Payment Classification of Payment radio buttons are selected.
3. Click the Differential button, or enter the courtesy adjustment amount in the Adjustment field.
4. Select an adjustment type to reflect this (you should create a special type for courtesy
adjustments).
5. Enter an associated comment for internal tracking and communication purposes, as well as to
show the patient that you have done him/her a favor since the comment prints on statements.
6. Click Save.

Insurance Company Overpayments
Insurance companies sometimes pay an insurance claim, but then realize they have overpaid and, in a
later EOB, make a downward adjustment. For example, the insurance company realized that there was a
supplemental policy. What usually happens is that the adjustment is shown on a later EOB that includes
benefits paid on other claims. The total of the payment associated with this EOB is for all the claims paid
less (or occasionally plus) the adjustment. Thus, the system must reflect the totals paid, but must also
reflect that money has left the clinic bank account.
You could just modify the amount of the original payment, but there are two problems associated with
doing this:
•

The reconciliation amounts for the days involved will differ from what actually happened, i.e. on
the original day the clinic will have deposited the insurance check in the bank, but now, by
modifying that payment, the amount of the check has ‘changed’ while on the current day the
reconciliation will be over what it should be. The overall bank totals for both days will still be
correct because the debit side of the transaction still occurred, but it’s not accurate.

•

The audit trail on the invoice will be incorrect.

The correct method is to post all payments as listed on the EOB. Then, make a downward adjustment on
the original, incorrect payment as follows.
1. Highlight the patient invoice in the Posting window.
Click the New Payment button.
Ensure the Insurance radio button in the Payment Made By section is on, and that the correct insurance
company is shown.
Type the amount of the adjustment into the Payment or Adjustment field as a negative number.
It is important to realize that you are trying to increase the invoice balance, so the invoice is
debited by entering negative numbers (you can enter them in parentheses, or by putting a minus
sign before the number). The Payment field is a good choice here because your end of day Till
Reconciliation Report will be accurate (since you have posted all the other amounts on the EOB
as payments). If you enter them in the adjustment field, you must remember to allow for this when
balancing the cash register at the end of the day.
Use the drop-down list to select the adjustment type (you should have a description in the reference table
associated with this field). If the adjustment applies to a specific line item, post the adjustment in the
Distribution window.
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Printing Courtesy Claims for Cash Patients
If a patient files his or her own insurance, you can print a paper claim for them as a courtesy. This is just a
nice touch that can help with patient retention.
From a system standpoint, you then need to set up the patient with their insurance company information
entered. However, you should set them up with the financial group PVP. You should also set up group
details with a 100% patient responsibility on the invoice. A patient alert can also be set to warn users that
even though there is insurance on the patient account, they should treat it as cash and request payment
from the patient.
Additionally, with the 100% patient responsibility group setup, the system automatically prompts users for
payment at invoicing when they go to the Payment tab. They should always do this after entering
charges.
After entering the charges, make sure the Print HCFA after Save box is checked and that the appropriate
claim form is loaded in a network printer. You can select the printer from the dialogue box that appears
after you save the invoice.
Note: If patients are filing their own insurance, it is usually not necessary to print the Signature on File
comments in boxes 12 and 13 of the HCFA, or the Assignment flag in box 27. You should create a
special definition for PVP claims that sets box 12 and its date, box 13, and box 27 to not print.

Transferring Accounts to Collections
There are two ways to track accounts turned over to collections:
•

Use a Financial Group: By changing invoice and patient financial groups, a reporting “center” is
created. When running reports, this financial group can be subtracted from the totals.

•

Create a dummy account for external collections tracking. Create a patient and/or guarantor
to represent a collections agency. Then either write off invoice balances and create new ones
under the collections account with an invoice note indicating the source; or simply change the
guarantor on the invoices to the collections agency.

Notes:
•

Collections agencies typically charge a percentage of what they collect as their fee. You can
either create a custom CPT code to track this, or a custom adjustment code. When you get a
payment, post it to the specific invoice, then adjust off the balance. This will give a measurable
cost of collections.

•

Create a financial group to represent in house and external collections accounts. This will show
up in Schedule.

•

When an account is sent to collections, put a billing block as well as a pop-up alert in the patient
file (for all Solution Series modules). This will prevent staff from inadvertently scheduling the
person again.

Changing Insurance Information at Invoicing
Insurance may need to be changed at the time of invoicing for several reasons. These may be:
•

Different guarantor such as for Workers’ Compensation claims.

•

Insurance filing order needs changing.

•

The visit is not covered by insurance and is being treated as a cash visit.
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•

The visit type does not require the usual copayment.

In situations such as these, normal insurance be filed. It wastes time and money, and results in a longer
collection cycle.
Whenever invoice insurance needs arise, users should change these when starting the invoice. This is
because of some built in functionality keys of the insurance. For example, a copayment may not apply,
but if you complete the usual cycle, the system is expecting one and posts it to the guarantor balance.
These are some of the key elements you may need to change, in the order you should check them:
•

Invoice Financial Group: Workers’ Comp, EPSDT, Cash (PVP) and other visits can affect
assignment of responsibility and insurance filing.

•

Guarantor: This can be changed if cross-billing to other responsible parties.

•

Insurance: Change or delete insurance by highlighting each company on the invoice. You can
delete it, change the insurance filing order, or alter the method. Additionally, you may change the
percentage responsibility or copayment.

The key thing to consider when changing invoice responsibility is, quite simply, who is responsible. Make
the invoice reflect this.

Splitting Technical and Professional Codes Automatically
Some payors like Medicare require practices to bill individual codes with modifiers for professional and
technical services rather than the comprehensive code. Given that physicians using Chart templates to
document the order (not the components which is not really necessary), or charge entry personnel in Bill
may just be entering the procedure, it is useful to be able to automate the split to reduce claims error
rates when staff forget to split codes.
Note that you can also split professional and technical components to separate claims which are billed on
separate professional (CMS-1500) and institutional (UB-04) formats. See the next section.
Here is how this is done. The example will use 71020 Chest X-Ray but obviously you can apply this to
any code.
•

Code Setup: First, you must set up instances of the codes which will be used for the purposes of
mapping to the modifiers. Go to Reference > CPT, click Outline, and navigate to the 71010 –
71555 category. Right-click the category and add the 71020 code followed by an asterisk then a
custom code value. This will be repeated for both the professional and technical components and
for consistency’s sake we suggest 71020*P and 71020*T so that the T & P are used for all codes
which will be set up this way. Add appropriate descriptions and save, then be sure to add the
Type of Service and Place of Service and any other properties you want in the Details section.

•

Panel Setup: Go to Reference > CPT Panels. Create a new panel code (you may simply want to
use the code “71020” although a slight variation is suggested so these are easy to spot when we
manage fee schedules. For example: P71020. Now add the 71020*T and 71020*P to this panel
in the bottom half of the window.

•

Fee Schedule Setup: You must now do a couple of things in fee schedules. Open up the fee
schedule which you are going to manage. We recommend that you filter your search to only
show 71020-71021 (71020-71020 will exclude the * codes because they are “after” 71020). Click
New CPT Fee and enter 71020*T in the code and hit enter. It automatically loads. Enter the fee.
Then click the Options tab and enter the TC modifier into the Default Modifier field, then save and
repeat for 71020*P (using the 26 modifier). Now select the 71020 code and click Edit CPT Fee.
Go to the Options tab and in the Crossover code field enter “/P71020”. The forward slash is
critical because this calls the panel as opposed to only looking for the basic code. Save. You ice
in the grid that the slash is not displayed – this is why we recommended that you use the “P” for
the panel so you can distinguish a panel crossover from a simple 1:1 code change.
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Now you are ready to go. If an invoice is built using automatic from Chart or manual data entry, upon
saving the invoice the system will automatically convert it to 71020*P-26 and 71020*T-TC. Remember
that the *P and *T will not be included in claims. If you get another other rule alerts, you will see
notification of what will happen, but because it is assumed that this is default it will not bother you with
that window if nothing else is triggered.

Splitting Claims
You can automatically split an invoice into multiples to accommodate a number of scenarios. The most
common of these may be the need to split encounter codes from other orders/services for RHC/FQHC
clinics. The encounter codes are billed using the UB format and the others on professional, possibly to
the same carrier or to different ones (e.g. Medicare Part A and Part B).
You must use the contracts function to do this. See this section of the user guide in the References
chapter. Also refer to the description of how splitting automatically works on page 214.
One can also split invoices manually using the CPT/HCPCS Functions menu in an invoice. Instructions
for this are available just above the steps for automatic splitting.

Capitation
Capitation contracts are a good way for new and established practices to build patient volume, but they
can also expose practices to the risk of loss. Thus, it is important for a practice to be able to track income
(copayments, monthly capitation checks and carve out fees) against write offs (capitated fees) while
balancing the sometimes irreconcilable goals of reducing the cost of overall care by improving preventive
care. Situations can also occur in which a capitation plan is essentially good, but the nature of your
patient panel is such that expensive procedures are required more than might be the case in other areas.
In such cases, having solid statistics to back up carve-out negotiations and other management decisionmaking about a capitation plan is extremely useful.

Capitation Setup
There are some things that will help you use and understand how to bill and monitor capitation correctly.
•

Fee Schedules: You can set up fee schedules for each insurance. One of the properties that can be
set is a Capitation Carve Out option. The default value for this is set to N, but you can set capitated
codes (e.g. preventive & office visit CPTs) to Y. If the fee schedule is linked to a contract, the system
can automatically adjust off the capitated codes.

•

Contract Capitation Properties: In the Reference > Contracts window, you can set:
○ An Allowed/Exception Fee Schedule which should be the one with the capitated and carve
out codes.
○ Capitation Auto Adjustment Properties: The default payment/adjustment level and line item
default codes which will be used for consistent reporting of capitation adjustments can be set
up. You can also set a flag that gives you a prompt to apply the auto adjustment. If this flag is
not set, it is done anyway.

•

Insurance: Although this is not required, you may wish to set up specific insurance company records
for capitated plans. They can have the same address as other plans for the same insurance
company (POS, PPO), so to distinguish them from each other, use either the network or name (e.g.
“Aetna” and “Aetna HMO”). Both will still be linked to the same insurance class so that you can
aggregate reporting for them if necessary, while retaining the flexibility of being able to filter out data
by the company in almost all reports (see later for some examples). Depending on payor filing
requirements, you might need to use the HM (health maintenance organization) ANSI insurance type
classification instead of C1 (commercial). You should also:
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○ Link the insurance company to a contract if you have set one up.
○ Link the insurance company to an allowed fee schedule which has the cap and carve out
codes and rates. This is done automatically if you linked the fee schedule to a contract and
then linked the contract to the company.
•

Insurance Group: Set up a unique “CAP ACCOUNT” insurance group within the insurance company
with a zero copay, etc. This is going to be linked to a “dummy” patient record that will be used for
posting monthly cap checks. As has been explained in other parts of this manual, e-MDs Bill expects
payments on insurance invoices in the order of patient copayment, insurance payments, and then
further patient payments. Thus, to prevent e-MDs Bill prompting for a copayment on a cap check,
ensure this special group has no copayment, no deductible, and an insurance responsibility of 100%.

•

Create Dummy Capitation Accounts For Check Posting: Accounts must be created for when
monthly cap checks are posted to the system. This is achieved by creating a dummy patient account
for each capitation plan. There are several key elements to remember when creating the dummy
account.
○ Last Name should always be ZZZCAP. This groups all capitation dummy accounts together at
the end of lists in reporting.
○ First Name is name of the insurance company/plan.
○ Social Security Number can be left blank.
○ Account Number should be consistent with the last name, but add 4 characters to identify the
plan. Using ZZZ will guarantee that all cap accounts will appear together at the end of all
rosters.
○ Guarantor can be self, or you can set up one central guarantor account for all cap accounts.
The guarantor account status should be set to Hold so that no statements are printed for these
dummy accounts.
○ Insurance should be the same capitation one set up for patients, although you can also use a
special class. Since a capitation plan may apply to multiple groups, it might be simpler to set
up a special capitation check group within the insurance company. The policyholder is the
same as the dummy patient.
○ Account status should be set to hold since statements are not required.

•

CPT Charge Code: Set up a dummy CPT code against which capitation checks will be posted.
CAPCK is suggested. There is no need to set a CPT fee for the code since the amount of a cap
check will vary depending on your panel size. When posting an invoice, you can change the fee since
it will be a simple panel size indicator the next month. Alternatively, you can set it to you per member
per month rate and when the charge is entered, you can change the unit count to reflect the number
of members which gives you an extra dimension on the reporting.

•

Capitation Adjustment Code: Create an adjustment code under Reference > Support Tables >
Payment Type. This will be used when posted capitation checks. It will also be linked to contracts if
you want to use these for automatic adjustments.

Capitation Charge Entry, Copayments and Adjustments
Entering charges does not require any special procedure once you have set up the capitation system.
•

Invoicing & Copayment Posting:
○ Charge Entry: Enter charges as usual.
○ Copayment: If you take pre payments, continue this practice. If it you take it at check out, tab
to the Payments tab after entering charges and enter the payment as usual. You can also
apply the pre payment in the same way.

•

Adjusting Capitated Codes: You can do manually or automatically:
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○ Automatic Adjustment: If you have set up the fee schedules and contracts for the primary
insurance on the invoice, the system will adjust off the CPTs flagged as capitated in the fee
schedule when the invoice is saved. Depending on an option in the contract, this might be
automatic or you can get a prompt. When the adjustment is made, it’s using your default
capitation adjustment codes so that you can track these against monthly cap checks.
○ Manual Adjustment: If you prefer to enter adjustments manually, this can be done at the time
of entering the charges or when you post the EOB. Although you may have an inflaged A/R,
the latter is recommended simply because it fits the same pattern as FFS posting and will not
take up more time since most capitated insurances appear to send an EOB for each
encounter as well as monthly check. The first method adds a step to the charge entry process
and also creates a lot of 0.00 payment sources. If you get an EOB for each encounter, we
recommend that you try to negotiate this into your contract since a detail is a great assistance
in analysis of the plan.
○ Charge Entry: After entering charges, go to the Payments tab (you can save the charges
then start a new insurance payment too). Enter a source of 0.00, set the adjustment codes
and then manually adjust off the capitated codes.
○ EOB Posting: Post exactly as you do for other payments, but apply an adjustment to the
capitated codes. If you have a separate adjustment code, you can set the Adj 2 code and
enter the cap adjustments in that cell for each line item while entering the normal contractual
adjustments for other codes in the Adj 1 cell.

Posting Capitation Checks
Capitation checks are posted against the dummy accounts created for the particular insurance. Follow
these steps:
1. Load the capitation dummy account in the Posting window and click New Invoice.
Make sure the DOS provider is the one on the cap check if it is broken out by doctor. This ensures that
you can assign the payments and reimbursement correctly.
Skip the ICD field and enter the internal code you have created for cap checks in the CPT field.
Enter the dummy capitation CPT code that you set up for this purpose.
If you set up this code with a 0.00 fee, click in the Billed Amount cell and enter the total amount of
the cap check.
If you set up a code with a PMPM rate, verify that this matches the amount on the cap check
statement, then look up the number of members, click in the Units cell and set the unit count to
this.
2. Ctrl+Tab to the Payment tab and enter an insurance payment for an amount equal to the charge
(and cap check).
3. Edit the insurance on the invoice and set the file status to blank or a filed status.
4. Click Save.

Capitation Reporting
The most important numbers when analyzing a capitation plan are revenue against cost/write off. When
you have entered charges and payments as described above, you now have the following numbers:
•

A list of patients on the capitation plan.

•

The charges and CPTs against the plan.

•

The payments (copays, carve outs and capitation checks) and adjustments.

Once you have a statistically valid reporting period, you can start analyzing the plan. Since cap checks
are generally paid monthly, this is a good starting point. However, in some months you may have
abnormal utilization and adjustments that make the plan look unprofitable when it is actually not bad
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overall. There are a number of reports that can be used to make this analysis. The list below is
recommended, but you may decide that there are other useful reports that can assist you in analyzing the
plan.

Activity Analysis Report
Run the report filtered by the insurance company. Although there are multiple activity analysis reports,
you might wish to start by viewing the summary by provider and/or summary by insurance company. The
summary by provider is nice if you wish to see how each doctor is doing with the plan and compare them
against the totals. You may discover that some doctors have best practices that can be followed, or that
there are other practices that can be corrected.
In this report, you are focusing on total charges against receipts and adjustments. In short, what you
should hope to see is that the sum of copayments, carve outs and capitation checks puts you at or above
what you would have received for the same number of patient visits. This is where you have to be aware
of the inherent risk in cap contracts: if the number and complexity of patient visits is high, the only major
income change you are likely to see is the increase in copayments but this will probably be more than
offset by the adjustments for capitated codes. The monthly cap check stays the same.
If you notice anomalies with what you expected, it is a warning to run other reports to see where this
“loss” is occurring.

Profit Center & CPT Reimbursement by Provider Crystal Report
The Profit Center reports can be used to see if you are performing and writing off procedures you hadn’t
budgeted for when you signed the contract with the carrier. If you have to write off a lot of expensive
procedures with high labor and supplies/materials costs, it is time to evaluate how profitable this plan is to
your clinic. This is yet another reason to have a good estimate of your cost per procedure and to enter
this in the CPT master file. You may also be able to negotiate a carve-out with the insurance company.
The Profit Center can be run on a periodic basis filtered for the insurance company. This will give you a
good idea of what the usual utilization is.
The CPT Reimbursement by Provider highlights loss making charges in yellow and red if you have
entered a cost.

ICD Frequency and CPT Frequency Crystal Report
The ICD report may draw your attention to particular problems suffered by patients in the panel which
may be more expensive to treat. The CPT report is another report that shows utilization. Both are sorted
by frequency making it easy to spot the top codes.

Patient Roster & Patient Master List Crystal Report
These reports can be used to see how your patient panel has changed. Of particular interest may be the
age and gender summaries available at the end of both reports. It may indicate that you are suddenly
seeing a population demographic that requires more care than average. forget to exclude the dummy
capitation patient.

Withhold/Disallowance Adjustments and Tracking
You can track third party withholds, withhold costs, and expected reimbursements based on the days
withheld. The withhold tracking and reporting comes into play at several points.
•

Contracts: The contracts system described on page 83 has fields that let you set up a withhold
percentage, a cost percentage, the withhold period in days, and default withhold adjustment
codes. There is also an option to automatically adjust withholds. If this is not set, then the rest of
the functionality does not come into play and the other data is information only.

•

Charge Entry: When the primary insurance on an invoice is linked to a contract where the
withhold auto adjust option is set a payment/adjustment is created when the invoice is saved.
The adjustment amounts for each CPT on the invoice are calculated by multiplying the allowed
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fee schedule for each code by the withhold % in the contract. The payment and line item level
adjustment codes are set to the defaults created in the contract. The Statement Comment and
line item billing Comments are also set automatically to “Withhold adjustment.”
•

Withhold Report: This report is based on charges and adjustments taken under a withhold
contract. The report shows, by provider or contract, the expected payment that the practice
should receive based on the withhold days against the service dates, and the total withheld
amounts originally adjusted off less the withhold cost % of allowed.

EPSDT Claims (Healthy Child, Health Steps, etc.)
EPSDT stands for Early and Periodic Diagnosis, Screening and Testing, a program sponsored by
Medicaid which ensures that minors receive preventive health care such as immunizations. The
delineation of EPSDT claims is important from an insurance and reporting standpoint. Additionally,
EPSDT claims are not usually billed on the same invoice as other Medicaid visits. For example, a child
may come to the clinic with a complaint, but it is noticed that an immunization is also due, so this is
administered while treating the main complaint. These must be treated as separate visits and billed on
separate invoices. In some cases, the insurance company details might be different requiring multiple
companies to be set up for the patient.
EPSDT claims, while paid by Medicaid, sometimes have different insurance filing requirements. This is
because many state Medicaid programs issue providers with a special EPSDT identification number in
addition to their Medicaid number. Before implementing the recommendations below, check to see what
the state filing requirements are. For example, you may be able to file EPSDT claims under the normal
Medicaid number, or a special modifier is used to delineate EPSDT from Medicaid.
Depending on the state and the Medicaid carrier, the placement of an EPSDT number on a claim can
also differ. e-MDs Bill stores the number in the EPSDT field found in the provider file. The placement of
the number on a claim is often in the field reserved for the PIN in Box 33 of the professional claim. There
are also fields in the electronic claims formats for EPSDT information.
If you have to set up separate insurances for filing normal vs. EPSDT Medicaid claims, consider setting
up a patient case for one insurance company and the default insurance in the patient file. You can even
add a policy with requirements to ensure staff follows this requirement. The case can be linked or
unlinked on an appointment or case specific basis.
Electronic claims are also filed depending upon state or clearinghouse requirements. In some cases, you
can build a claim file including all claims (or both Medicaid standard and EPSDT visits), and in others you
may have to create separate batches for each.
The following summarizes the requirements for EPSDT delineation.
1. Insert EPSDT number in the provider file.
2. Create a special financial group or insurance company for the claims if you have to pull different
numbers in paper claims. For electronic claims the EPDST requirements can be pulled
automatically based on the EPSDT options settings in the claim prep window.
3. If applicable, set CMS or HCFA definitions and ANSI clearing house alternate ID pointers to pull
the correct numbers.
4. Change the invoice financial group when billing for EPSDT visits if you have to do this or want to
use it for reporting (which can also be accomplished by filtering reports based on EPDST
preventive CPT codes). This can be done using a case.
5. Generate printed or electronic claim batches that reflect the provider EPSDT number in the
correct fields.
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The CMS or HCFA Definitions edit is only for those states requiring the default group number in the field
33 Pin field of the HCFA-1500 to be replaced with the EPSDT number.
1. Go to Claims > HCFA Definitions or Claims > CMS Definitions depending on the claim version
you need to print.
2. Select the EPSDT insurance class, financial group (e.g. EPS) or insurance.
3. Double-click the red field at the bottom right of the Definitions screen.
4. Click the File Name drop-down list and select Provider.
5. Click the Field Name drop-down list and select EPSDT.
6. Enter a description of the edit in the Description field.
7. Click Save, then click Close.
The EPSDT number will now print on the claims. It is not necessary to filter batches by the class or
financial group when printing. So long as EPS claims fall within any other filtering criteria you set, the
number will be printed correctly.

Anesthesia Billing
The system has the ability to automatically generate anesthesia fees and calculate units during posting.
The following bullets describe how each part works. The detail of entering information into the various
windows is described elsewhere in this user guide.
•

Fees: Anesthesia fees can be set manually just like any other CPT, or you can use the
automated functionality that takes advantage of anesthesia billing units for specific codes as well
an anesthesia conversion factor: These are used in the algorithm to calculate the fees.
○ Anesthesia Billing Units (ABU): Each CPT or HCPCS code can be set up with the ABU
which is roughly described as a “weight.” The field is located in the Details section of the
Reference > CPT or Reference >HCPCS tables.
○ Anesthesia Conversion Factor: This is set in the File > Options window. It is a
geographically weighted index that reflects the cost of delivering anesthesia in your part of the
country. You can find the conversion factor for your Medicare locality in the GPCI tables
published on the support pages at www.e-mds.com. This is used when the automatic fee
calculation options are used in Reference > Fee Schedules & Rules to generate fee
schedules. If a code has a type of service code of 7 or 07, the system uses the anesthesia CF
in the algorithm as opposed to the general conversion factor.

•

Charge Entry Units Calculation: When entering charges, Bill can calculate the unit count
automatically based on a combination of the ABU for a code, the duration, and the anesthesia
minutes increment for the primary insurance on the invoice. Depending on the claim type you
aretransmitting and, if it’s paper, any CMS or HCFA Definitions you haveset up. The unit count
for an anesthesia CPT is the sum of the ABU and the time taken. The time is divided by an
increment which is usually 15 minutes (but some payors use 10 or other amounts). The result is
then rounded up. For example, if the ABU for a code is 3, the number of minutes is 23 and the
increment is 15, the unit count is 5. This is calculated as ABU (3) + (Minutes (23) / Increment
(15) rounded up), or 3 + 2.
○ Primary Insurance AN Increment: The AN Increment setting in an insurance company’s
demographics file is the default minutes which will be used as the denominator.
○ Minutes: As soon as a charge is entered in an invoice where the TOS code is 7 or 07, the
system will prompt the user to enter the minutes. You can enter a known number of minutes,
or the start and end time which then calculates the minutes.
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Workers’ Compensation and MVA
Workers’ Comp and MVA visits generally present a different set of billing requirements for a clinic than
normal. Instead of the patient’s insurance being billed for the visit, the guarantor is usually a corporate
entity that may or may not have insurance. It is not necessary to duplicate a patient account if that patient
already sees the clinic for other kinds of care. This is very important because all clinical information on the
patient is kept in one place.
The key to rapid and accurate claims filing is the ability to be able to rapidly cross bill to different
responsible parties and also be able to look up and set related information like the injury date. In some
cases a patient may present to your clinic only for WC treatments in which case the default guarantor and
insurance in the patient file could be the employer. For MVA treatment this would be the at fault party’s
auto insurance. In others the patient might also see your clinic for other acute and preventive care so you
will need to cross bill.
While you can manually set or change the injury date, guarantor, insurance, copay, financial group and
other data each time you bill, it’s easy to forget to do this every time, or to set some fields incorrectly.
This is why you should use the case management system. A case can be set up with all of these data
elements which override the patient defaults when the case is linked to the encounter.
•

Injury/Illness, disability, return to work and other dates

•

Guarantor and guarantor insurance

•

Referral/Authorization (you can have more than one per case)

•

Attorney

•

Case contacts (e.g. claims adjuster, case nurse manager)

•

Required treating and supevising (billing) providers, specialties and locations

•

Copay

•

Financial group for claims filing and reporting segregation

You can also create policies with requirements that need to be satisfied in order to treat the patient and
process claims. The requirements may be internally designed to make sure your office flows smoothly, or
they might be requirements laid out by the responsible party and insurance. For example, you might
need to get a referral, or fill out specific forms.
A further benefit of the case system is that it automatically links appointments, chart notes and invoices
generated under the case so that they can be viewed interactively from the case management window as
well as in other places. There is a case management report which can be printed or faxed to all the
contacts on the case.
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Appendix A
Data Tables
CMS-1500/HCFA-1500 (12/90 and 08/05)
HCFA-1500 (12/90) Field Data Source Lookup
The following table lists the fields in the HCFA-1500 (version 12/90), and the sources of data for each.
Note: Keep in mind that many of the fields in the HCFA can be set to pull information from any field
using the HCFA Definitions.
1

Type Of Insurance

Based on origin ID/indicator code in the
demographics for the insurance company
being filed. Medicare = C, MD & 16;
Medicaid = D, MC; Champus: H, CH,
ChampVA = V, VA; Group Health Plan = F,
G, I, N, P, 12, 13, 14, BL, CI, HM; FECA =
41 or fingrp FEC; Other: A, B, E, J, K, L, M,
T, Z, 09, 10, 11, 15, AM, DS, LI, LM, OF,
TV, WC, ZZ.
EXCEPTION: Printing Medicaid Secondary
(MC indicator code) in FL where Medicare is
primary (MB), sets both Medicare and
Medicaid boxes.

1a

Insured’s ID Number

Policy number for insurance being filed
(primary, secondary, etc.).

2

Patient’s Name

Patient Demographics.

3

Patients’ Birth Date And Sex

Patient Demographics.

4

Insured’s Name

Primary Policy Holder Demographics.

5

Patient Address

Patient Demographics.

6

Patient Relationship To Insured

Policy Holder Relationship In Patient Or
Guarantor Insurance Maintenance (Not
Guarantor Relationship)

7

Insured’s Address

Policy Holder Demographics

8

Patient Status

Patient File, Employment Tab

9

Other Insured’s Name

Secondary Policy Holder Demographics

9, 9a-d

Insurance Information (secondary claims only)

When printing for a secondary (where the
secondary information is in Box 1a, etc), but
the “Print in Secondary When Primary” box
in the demographics window for the primary
is checked, the primary information prints in
these boxes.

9a

Other Insured’s Policy Or Group Number

Secondary Policy Information. If Insurance
Is Medigap Type MG, Number Is Preceded
By This. When printing a claim for Maryland
Medicaid, the number printed in Box 1a is
also printed here if the insurance company
type and indicator codes are D or MC, the
insurance being filed is not the primary, and
the state code for the facility is MD.

9b

Other Insured’s Date Of Birth And Sex

Secondary Policy Holder Demographics.
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9c

Employer’s Name Or School Name

Employment Information. Left Blank If
Insurance Type Is MG And There Is A
Medigap Number, Otherwise Enters The
Abbreviated Insurance Company Address.

9d

Insurance Plan Name Or Program Name

Insurance Group Name. If MG, Enters
Medigap Number.

10a-c

Employment, Auto Accident, Other Accident

Drop Down Box In Claim Prepare Window.

10d

Reserved For Local Use

None – Set HCFA Definition

11

Insured’s Policy Or Feca Number

Primary Policy Group Number.
EXCEPTION: If printing Medicaid (MC) as
secondary, 11 contains the primary
insurance policy #.

11a

Insured’s Date Of Birth And Sex

Primary Policy Holder Demographics

11b

Employer’s Name Or School Name

Primary Policy Holder Demographics:
Employment Tab.

11c

Insurance Plan Name Or Program Name

Primary Insurance Group Name.
EXCEPTION: EXCEPTION: If printing
Medicaid (MC) as secondary, 11c contains
the primary insurance name.

11d

Is There Another Health Benefit Plan

System Field Based On Whether Another
Insurance Is On The Invoice.

12 and 13

Patient’s Or Authorized Person’s Signature
Insured’s Or Authorized Person’s Signature

Assignment check box in Claim Prepare. If
checked, both boxes will read “SIGNATURE
ON FILE”. If not, both will be blank. The
Date in box 12 is from the Patient Signed
field in the Misc. tab of the Patient
Maintenance window.

14

Date Of Current Illness Or Injury Or Pregnancy (Lmp)

Symptom Date In Invoice – This Sets The
st
1 Illness Date In The Claim Prepare.

15

Same Or Similar Illness

Similar Illness Date In Claim Prepare

16

Dates Patient Unable To Work In Current Occupation

Unable To Work Dates Fields In Workmen
Comp Tab Of Claim Prepare

17

Name Of Referring Physician Or Other Source

Provider In Referral Field Of Invoice Tab In
Claim Prepare. This Is Set If There Is A
Referral/Authorization On The Invoice, Or If
There Is A Default Referral In The Patient
File.

17a

Id Number Of Referring Physician

Upin Of Referral In Box 17.

18

Hospitalization Dates Related To Current Services

Admission Date And Discharge Date In
Claim Prepare

19

Reserved For Local Use

Custom Field. Often Set For CLIA Number
In The File > Options Window.

20

Outside Lab? $ Charges

Check Box In Claim Prepare, And Lab
Charge Field Next To This.

21

Diagnosis Or Nature Of Illness Or Injury

ICD Codes In The Invoice. Primary ICD Is
st
Always Placed In The 1 Field, Others Are
In Order Of Entry.

22

Medicaid Resubmission Code

Claim Prepare Medicaid Resubmission
Code field in Misc. Options tab. A definition
can also be set to pull the original reference
number from another field in the invoice.

23

Prior Authorization Number

Prior Authorization Field In Claim Prepare.
Set From Referral/Authorization, Or Manual
Entry.

24a-G

Dates Of Service, Pos, Tos, Cpt/Hcpcs, Modifier, Icd, Charges, Units

Invoice Cpts And HCPCS.

24h

EPDST/Family Plan

E, F, or B based on check boxes In Claim
Prepare

24i

Emg

Visit An Emergency List Box In Claim
Prepare

24j

Cob

Custom Setting
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24k

Reserved For Local Use

Custom Setting, Typically Provider PIN

25

Federal Tax I.D. Number & Type

The type is pulled from the Rendering
Provider’s demographics file Misc. tab Tax
Type setting. If this is set to SSN, then it
uses this provider’s social. If set to Federal
Tax ID it prints the provider’s EIN.

26

Patient’s Account Number

Patient In File, Or Can Use Invoice Number.

27

Accept Assignment

Accept Assignment Box In Patient File.
Based On Setting In Insurance
Demographics.

28

Total Charge

Sum Of All Charges On Invoice.

29

Amount Paid

Sum Of All Payments On Invoice. If No
Credits Option in HCFA Wiz Is Set, Will Be
0.00. If Include Adjustments is not set, only
payments and not adjustments are shown.

30

Balance Due

Box 28 Minus Box 29. If No Credits option
in HCFA Wiz is set, then the balance =
charges. It’s also affected by the Include
Adjustments option setting.

31

Signature Of Physician Or Supplier

Rendering Provider In Claim Prepare.
EXCEPTION: TN Blue Cross, If the person
printed here needs to be different to the
identifiers printed in Box 33, the operating
physician in the claim can be set to print if
the insurance is BL and the insurance state
code is TN.

32

Name And Address Of Facility Where Services Were Rendered

Set To “SAME” If POS Is Home Or Office,
Otherwise Set To Hospital, Lab Or HPSA In
The Claim Prepare. If it is a Medicare claim
and there is a POS code in the invoice that
is not 12, the internal medical facility
information is entered.

33

Physician’s, Supplier’s Billing Name.

Facility Name

33

Physician’s Supplier’s Address, Zip Code & Phone #

Facility Billing Address and Work phone
number.

33 PIN#

Pin #

Defaults to rendering provider identifiers
based on insurance company indicator
code. MB, MA, C = Medicare PIN; MD, D;
Medicaid PIN; CI, F, CH, H, Other: Upin

33 GRP#

Grp #

Defaults to rendering provider identifiers
based on insurance company indicator
code. MB, MA, C = Medicare Group; MD,
D; Medicaid Group; BL, G, P: Blue Cross
Group; CH, H: Champus #; CI, F, Other:
Tax ID
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CMS-1500 (08/05) Field Data Source Lookup
The following table lists the fields in the CMS-1500 (version 08/05), and the sources of data for each.
Note: Keep in mind that many of the fields in the CMS-1500 claim can be set to pull information from
any field using the CMS Definitions.
1

Type Of Insurance

Based on origin ID/indicator code in the
demographics for the insurance company
being filed. Medicare = C, MD & 16;
Medicaid = D, MC; Champus: H, CH,
ChampVA = V, VA; Group Health Plan = F,
G, I, N, P, 12, 13, 14, BL, CI, HM; FECA =
41 or fingrp FEC; Other: A, B, E, J, K, L, M,
T, Z, 09, 10, 11, 15, AM, DS, LI, LM, OF,
TV, WC, ZZ.
EXCEPTION: Printing Medicaid Secondary
(MC indicator code) in FL where Medicare is
primary (MB), sets both Medicare and
Medicaid boxes.

1a

Insured’s ID Number

Policy number for insurance being filed
(primary, secondary, etc.).

2

Patient’s Name

Patient Demographics.

3

Patients’ Birth Date And Sex

Patient Demographics.

4

Insured’s Name

Primary Policy Holder Demographics.

5

Patient Address

Patient Demographics.

6

Patient Relationship To Insured

Policy Holder Relationship In Patient Or
Guarantor Insurance Maintenance (Not
Guarantor Relationship)

7

Insured’s Address

Policy Holder Demographics

8

Patient Status

Patient File, Employment Tab

9

Other Insured’s Name

Secondary Policy Holder Demographics

9, 9a-d

Insurance Information (secondary claims only)

When printing for a secondary (where the
secondary information is in Box 1a, etc), but
the “Print in Secondary When Primary” box
in the demographics window for the primary
is checked, the primary information prints in
these boxes.

9a

Other Insured’s Policy Or Group Number

Secondary Policy Information. If Insurance
Is Medigap Type MG, Number Is Preceded
By This. When printing a claim for Maryland
Medicaid, the number printed in Box 1a is
also printed here if the insurance company
type and indicator codes are D or MC, the
insurance being filed is not the primary, and
the state code for the facility is MD.

9b

Other Insured’s Date Of Birth And Sex

Secondary Policy Holder Demographics.

9c

Employer’s Name Or School Name

Employment Information. Left Blank If
Insurance Type Is MG And There Is A
Medigap Number, Otherwise Enters The
Abbreviated Insurance Company Address.

9d

Insurance Plan Name Or Program Name

Insurance Group Name. If MG, Enters
Medigap Number.

10a-c

Employment, Auto Accident, Other Accident

Drop Down Box In Claim Prepare Window.

10d

Reserved For Local Use

None – Set HCFA Definition

11

Insured’s Policy Or Feca Number

Primary Policy Group Number.
EXCEPTION: If printing Medicaid (MC) as
secondary, 11 contains the primary
insurance policy #.

11a

Insured’s Date Of Birth And Sex

Primary Policy Holder Demographics

11b

Employer’s Name Or School Name

Primary Policy Holder Demographics:
Employment Tab.
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11c

Insurance Plan Name Or Program Name

Primary Insurance Group Name.
EXCEPTION: EXCEPTION: If printing
Medicaid (MC) as secondary, 11c contains
the primary insurance name.

11d

Is There Another Health Benefit Plan

System Field Based On Whether Another
Insurance Is On The Invoice.

12 and 13

Patient’s Or Authorized Person’s Signature
Insured’s Or Authorized Person’s Signature

Assignment check box in Claim Prepare. If
checked, both boxes will read “SIGNATURE
ON FILE”. If not, both will be blank. The
Date in box 12 is from the Patient Signed
field in the Misc. tab of the Patient
Maintenance window.

14

Date Of Current Illness Or Injury Or Pregnancy (Lmp)

Symptom Date In Invoice – This Sets The
st
1 Illness Date In The Claim Prepare.

15

Same Or Similar Illness

Similar Illness Date In Claim Prepare

16

Dates Patient Unable To Work In Current Occupation

Unable To Work Dates Fields In Workmen
Comp Tab Of Claim Prepare

17

Name Of Referring Physician Or Other Source

Provider In Referral Field Of Invoice Tab In
Claim Prepare. This Is Set If There Is A
Referral/Authorization On The Invoice, Or If
There Is A Default Referral In The Patient
File.

17a

Id Number Of Referring Physician

Upin Of Referral In Box 17.

17b

NPI of Referring Physician

NPI of Referral in Box 17

18

Hospitalization Dates Related To Current Services

Admission Date And Discharge Date In
Claim Prepare

19

Reserved For Local Use

Custom Field. Often Set For CLIA Number
In The File > Options Window.

20

Outside Lab? $ Charges

Check Box In Claim Prepare, And Lab
Charge Field Next To This.

21

Diagnosis Or Nature Of Illness Or Injury

ICD Codes In The Invoice. Primary ICD Is
st
Always Placed In The 1 Field, Others Are
In Order Of Entry.

22

Medicaid Resubmission Code

Claim Prepare Medicaid Resubmission
Code field in Misc. Options tab. A definition
can also be set to pull the original reference
number from another field in the invoice.

23

Prior Authorization Number

Prior Authorization Field In Claim Prepare.
Set From Referral/Authorization, Or Manual
Entry.

24a

Dates of Service

Invoice CPTs And HCPCS.

24b

Place of Service

Invoice CPTs and HCPCS

24c

EMG

Visit an Emergency listbox in Claim Prepare

24d

CPT/HCPCS and Modifiers

Invoice CPTs and HCPCS

24e

ICD Pointer

Invoice CPTs and HCPCS

24f

Charges

Invoice CPTs and HCPCS

24g

Units

Invoice CPTs and HCPCS

24h

EPDST/Family Plan

E, F, or B based on check boxes In Claim
Prepare

24i

Emg

Visit An Emergency List Box In Claim
Prepare

24j (shaded)

Qualifier for ID in 24j

1G for UPin

24j (shaded)

Non-NPI Rendering Provider Number

Upin from Rendering Provider
Demographics

24j

Rendering Provider NPI

NPI from Rendering Provider Demographics

24k

Reserved For Local Use

Custom Setting, Typically Provider PIN
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25

Federal Tax I.D. Number & Type

The type is pulled from the Rendering
Provider’s demographics file Misc. tab Tax
Type setting. If this is set to SSN, then it
uses this provider’s social. If set to Federal
Tax ID it prints the provider’s EIN.

26

Patient’s Account Number

Patient In File, Or Can Use Invoice Number.

27

Accept Assignment

Accept Assignment Box In Patient File.
Based On Setting In Insurance
Demographics.

28

Total Charge

Sum Of All Charges On Invoice.

29

Amount Paid

Sum Of All Payments On Invoice. If No
Credits Option in HCFA Wiz Is Set, Will Be
0.00. If Include Adjustments is not set, only
payments and not adjustments are shown.

30

Balance Due

Box 28 minus Box 29. If No Credits option
in HCFA Wiz is set, then the balance =
charges. There is an option to allow Box 30
to show the billed amount minus payment
and adjustments, whether or not
adjustments are included in Box 29.

31

Signature Of Physician Or Supplier

Rendering Provider In Claim Prepare.
EXCEPTION: TN Blue Cross, If the person
printed here needs to be different to the
identifiers printed in Box 33, the operating
physician in the claim can be set to print if
the insurance is BL and the insurance state
code is TN.

32

Name And Address Of Facility Where Services Were Rendered

Set To “SAME” If POS Is Home Or Office,
Otherwise Set To Hospital, Lab Or HPSA In
The Claim Prepare. If it is a Medicare claim
and there is a POS code in the invoice that
is not 12, the internal medical facility
information is entered.

32a

Service Facility NPI

NPI from demographics of facility listed in
Box 32

32b

Service Facility Other ID

EI qualifier followed by Tax ID of facility
listed in Box 32.

33

Billing Provider Name.

Facility Name

33

Billing Provider Address, Zip Code & Phone #

Facility Billing Address and Work phone
number. To change the primary office phone
number, open the Edit Definition window by
double-clicking in Box 33. Edit the definition
to pull an alternate phone number for
specific circumstances.

33a

Billing Provider NPI

NPI of facility listed in Box 33

33b

Billing Provider Other ID

EI qualifier followed by Tax ID of facility
listed in Box 33.
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CMS-1500 (02/12) Field Data Source Lookup
The following tab/le lists the fields in the CMS-1500 (version 02/12), and the sources of data for each.
Note: Keep in mind that many of the fields in the CMS-1500 claim can be set to pull information from
any field using the CMS Definitions.
1

Type Of Insurance

Based on origin ID/indicator code in the
demographics for the insurance company
being filed. Medicare = C, MD & 16;
Medicaid = D, MC; Champus: H, CH,
ChampVA = V, VA; Group Health Plan = F,
G, I, N, P, 12, 13, 14, BL, CI, HM; FECA =
41 or fingrp FEC; Other: A, B, E, J, K, L, M,
T, Z, 09, 10, 11, 15, AM, DS, LI, LM, OF,
TV, WC, ZZ.
EXCEPTION: Printing Medicaid Secondary
(MC indicator code) in FL where Medicare is
primary (MB), sets both Medicare and
Medicaid boxes.

1a

Insured’s ID Number

Policy number for insurance being filed
(primary, secondary, etc.).

2

Patient’s Name

Patient Demographics.

3

Patients’ Birth Date And Sex

Patient Demographics.

4

Insured’s Name

Primary Policy Holder Demographics.

5

Patient Address

Patient Demographics.

6

Patient Relationship To Insured

Policy Holder Relationship In Patient Or
Guarantor Insurance Maintenance (Not
Guarantor Relationship)

7

Insured’s Address

Policy Holder Demographics

8

Reserved for NUCC Use

9

Other Insured’s Name

Secondary Policy Holder Demographics

9, 9a

Insurance Information (secondary claims only)

When printing for a secondary (where the
secondary information is in Box 1a, etc), but
the “Print in Secondary When Primary” box
in the demographics window for the primary
is checked, the primary information prints in
these boxes.

9a

Other Insured’s Policy Or Group Number

Secondary Policy Information. If Insurance
Is Medigap Type MG, Number Is Preceded
By This. When printing a claim for Maryland
Medicaid, the number printed in Box 1a is
also printed here if the insurance company
type and indicator codes are D or MC, the
insurance being filed is not the primary, and
the state code for the facility is MD.

9b

Reserved for NUCC Use

9c

Reserved for NUCC Use

9d

Insurance Plan Name Or Program Name

Insurance Group Name. If MG, Enters
Medigap Number.

10a-c

Employment, Auto Accident, Other Accident

Drop Down Box In Claim Prepare Window.

10d

Claim Codes

Claim Prepare screen > Claim Default>
Condition Codes

11

Insured’s Policy Or Feca Number

Primary Policy Group Number.
EXCEPTION: If printing Medicaid (MC) as
secondary, 11 contains the primary
insurance policy #.

11a

Insured’s Date Of Birth And Sex

Primary Policy Holder Demographics

11b

Other Claim ID

Claim number from associated case.
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11c

Insurance Plan Name Or Program Name

Primary Insurance Group Name.
EXCEPTION: EXCEPTION: If printing
Medicaid (MC) as secondary, 11c contains
the primary insurance name.

11d

Is There Another Health Benefit Plan

System Field Based On Whether Another
Insurance Is On The Invoice.

12 and 13

Patient’s Or Authorized Person’s Signature
Insured’s Or Authorized Person’s Signature

Assignment check box in Claim Prepare. If
checked, both boxes will read “SIGNATURE
ON FILE”. If not, both will be blank. The
Date in box 12 is from the Patient Signed
field in the Misc. tab of the Patient
Maintenance window.

14

Date Qualifier

Contains a qualifier stating what date is
being used. The qualifier will be pulled from
Invoice > Indicator on Symptom Date. The
following qualifiers are valid in this field:
431 Onset of Current Symptoms or Illness
484 Last Menstrual Period

14

Date Of Current Illness Or Injury Or Pregnancy (LMP)

Symptom Date In Invoice – This Sets The
st
1 Illness Date In The Claim Prepare.

15

Date Qualifier

Contains a qualifier stating what date is
being used. The qualifier will be entered in
the Invoice > Claim Prepare > Other Date
Description. The following qualifiers are
valid:
454 Initial Treatment
304 Latest Visit or Consultation
453 Acute Manifestation of a Chronic
Condition
439 Accident
455 Last X-ray
471 Prescription
090 Report Start (Assumed Care Date)
091 Report End (Relinquished Care Date)
444 First Visit or Consultation

15

Same Or Similar Illness

Similar Illness Date In Claim Prepare

16

Dates Patient Unable To Work In Current Occupation

Unable To Work Dates Fields In Workmen
Comp Tab Of Claim Prepare

17

Name Of Referring Physician Or Other Source

Provider In Referral Field Of Invoice Tab In
Claim Prepare. This Is Set If There Is A
Referral/Authorization On The Invoice, Or If
There Is A Default Referral In The Patient
File.

17a

Id Number Of Referring Physician

Upin Of Referral In Box 17.

17b

NPI of Referring Physician

NPI of Referral in Box 17

18

Hospitalization Dates Related To Current Services

Admission Date And Discharge Date In
Claim Prepare

19

Reserved For Local Use

Custom Field. Often Set For CLIA Number
In The File > Options Window.

20

Outside Lab? $ Charges

Check Box In Claim Prepare, And Lab
Charge Field Next To This.

21

Diagnosis Or Nature Of Illness Or Injury

ICD Codes In The Invoice. Primary ICD Is
st
Always Placed In The 1 Field, Others Are
In Order Of Entry.

22

Resubmission Code

Claim Prepare Medicaid Resubmission
Code field in Misc. Options tab. A definition
can also be set to pull the original reference
number from another field in the invoice.

23

Prior Authorization Number

Prior Authorization Field In Claim Prepare.
Set From Referral/Authorization, Or Manual
Entry.

24a

Dates of Service

Invoice CPTs And HCPCS.

24b

Place of Service

Invoice CPTs and HCPCS
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24c

EMG

Visit an Emergency listbox in Claim Prepare

24d

CPT/HCPCS and Modifiers

Invoice CPTs and HCPCS

24e

ICD Pointer

Invoice CPTs and HCPCS

24f

Charges

Invoice CPTs and HCPCS

24g

Units

Invoice CPTs and HCPCS

24h

EPDST/Family Plan

E, F, or B based on check boxes In Claim
Prepare

24i

EMG

Visit An Emergency List Box In Claim
Prepare

24j (shaded)

Qualifier for ID in 24j

1G for UPin

24j (shaded)

Non-NPI Rendering Provider Number

Upin from Rendering Provider
Demographics

24j

Rendering Provider NPI

NPI from Rendering Provider Demographics

24k

Reserved For Local Use

Custom Setting, Typically Provider PIN

25

Federal Tax I.D. Number & Type

The type is pulled from the Rendering
Provider’s demographics file Misc. tab Tax
Type setting. If this is set to SSN, then it
uses this provider’s social. If set to Federal
Tax ID it prints the provider’s EIN.

26

Patient’s Account Number

Patient In File, Or Can Use Invoice Number.

27

Accept Assignment

Accept Assignment Box In Patient File.
Based On Setting In Insurance
Demographics.

28

Total Charge

Sum Of All Charges On Invoice.

29

Amount Paid

Sum Of All Payments On Invoice. If No
Credits Option in HCFA Wiz Is Set, Will Be
0.00. If Include Adjustments is not set, only
payments and not adjustments are shown.

30

Reserved for NUCC Use

31

Signature Of Physician Or Supplier

Rendering Provider In Claim Prepare.
EXCEPTION: TN Blue Cross, If the person
printed here needs to be different to the
identifiers printed in Box 33, the operating
physician in the claim can be set to print if
the insurance is BL and the insurance state
code is TN.

32

Name And Address Of Facility Where Services Were Rendered

Set To “SAME” If POS Is Home Or Office,
Otherwise Set To Hospital, Lab Or HPSA In
The Claim Prepare. If it is a Medicare claim
and there is a POS code in the invoice that
is not 12, the internal medical facility
information is entered.

32a

Service Facility NPI

NPI from demographics of facility listed in
Box 32

32b

Service Facility Other ID

EI qualifier followed by Tax ID of facility
listed in Box 32.

33

Billing Provider Name.

Facility Name

33

Billing Provider Address, Zip Code & Phone #

Facility Billing Address and Work phone
number. To change the primary office phone
number, open the Edit Definition window by
double-clicking in Box 33. Edit the definition
to pull an alternate phone number for
specific circumstances.

33a

Billing Provider NPI

NPI of facility listed in Box 33

33b

Billing Provider Other ID

EI qualifier followed by Tax ID of facility
listed in Box 33.
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CMS-1500 (08/05 and 02/12) Definitions File and Field Name Data
Sources
File Name

Source

Default

If there is no other definition for a field, the default collects data from a variety of
sources.

Case Management

Case attached to invoice. Fields of note: Case Number, case description, claim number
and file number.

Claim Form

Fields in the invoice claim prepare.

CPT Details

CPT/HCPCS Search under References menu. This definition currently only provides
the ability to pull an NDC code.

Facility

Demographics from the facility linked to the invoice.

Facility Alternate IDs

Custom fields from the internal medical facility linked to the invoice.

Guarantor

Guarantor demographics, demographics for guarantor employment.

Guarantor Alternate IDs

Custom fields in the guarantor demographics file.

Insurance

Insurance company demographics.

Invoice

Invoice summary data and primary ICD and CPT codes.

Invoice CPT

CPT line item data.

Patient

Patient demographics.

Patient Alternate IDs

Custom fields in the patient demographics.

Policy Holder

Policyholder (guarantor) demographics and employment data.

Provider

DOS Provider demographics. Use the rendering before using this.

Provider Alternate IDs

Custom fields from the provider demographics.

Provider Alternate IDs

DOS provider alternate IDs. Users must type the internal name into the field.

Referral

Invoice Claim Prepare referral demographics.

Referral Alternate IDs

Custom fields from the referral demographics.

Rendering

Demographics of rendering provider on the claim prepare.

Rendering Alternate IDs

Custom fields from the rendering demographics.

Setup Options

Data from File > Options window for invoice facility.

UB-92/HCFA-1450 Field Data Source Lookup
1

Provider Name, Address And Telephone

3

Patient Control No.

Patient Account Number.

4

Type Of Bill

Type of Bill field in File > Options.

5

Fed. Tax No.

Tax ID In File > Options For Facility In
Which Claim Was Created.

6

Statement Covers Through

First And Last Dates Of Service For Line
Items In The Claim.

12

Patient Name

Patient File

13

Patient Address

Patient File

14

Birthdate

Patient File

15

Sex

Patient File

16

Ms

Marital In Patient File

17

Admission Date

Admission Date In Claim Prepare.

19

Admission Type

Admission Type in Claim Prepare

20

Admission Source

Admission Source in Claim Prepare

22

Patient Status

Patient Status in Claim Prepare

24-30

Condition Codes

Claim Default Condition Codes
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32a-36b

Occurrence Codes and Dates

Claim Prepare Occurrence tab

37A, B, C

Internal Control Number/Document Control Number

All From Fields In Misc. Options Tab Of
Invoice Claim Prepare. 37A – Upin; 37B –
Group No; 37C – Print K Column.

42

Revenue Code

Only Printed If Claim Is MDC. Revenue
Code Linked To Cpts.
Line 23 Will Have 001 To Indicate That This
Is The Summation Line.

43

Description

CPT Description If Claim Is Commercial. If
MDD Or MDC Shows Revenue Code
Description. Line 23 Says “Total Charges”

44

Hcpcs/Rates

CPT/HCPCS Codes On Invoice.

45

Serv. Date

First DOS On The CPT

46

Serv. Units

Number Of Units In Claim.

47

Total Charges

Unit Fee Multiplied By Number Units. Line
23 Is The Sum Of All Charges In This
Column.

51

Provider No

Facility-specific group numbers can be
pulled by adding alternate ID fields to
internal medical facilities. These must have
the exact description of “Medicare Group
Number” or “Medicaid Group Number”.
Otherwise the defaults are physicians
specific numbers and are:
If Insurance Type Is MB, Prints Medicare
Alternate In Provider File.
If Insurance Type Is MC, Prints Medicaid
Alternate In Provider File.
If Insurance Type Is CH, Prints Champus
Number.
If Insurance Type Is BL, Prints Blue Cross
Alternate.
If Claim Is MDC, Will Use Number In
Provider’s Medicare Alternate Field, If MDD,
Will Use Number In Medicaid Alternate ID
Field, Otherwise Will Enter Upin.
If MDC And Secondary Insurance Is Type
OT, Will Put Medicaid In 51B; MDD And
Secondary Is OT, Puts Medicare In 51B.

52

Release Of Information

Y, R Or N Based On Information Release In
Claim Prepare Which Is Defaulted To
Setting In Patient File.

53

Assignment Of Benefits

Y Or N Based On Checkbox In Claim
Prepare Which Is Defaulted To Insurance
PAR Setting.

54

Prior Payments

Claim Total Payments Unless No Credits
Option In HCFA Wizard Is Set.

55

Est. Amount Due

Claim Total Balance (Charges – Payments)
Unless No Credits Option In HCFA Wizard
Is Set. If So, This Equals Total Charges.

58

Insured’s Name

Policyholders For Insurances.

59

P. Rel

Code Based On Patient Relationship To
Policyholder.

60

Cert. – Ssn – Hic. – Id No.

Policy Number For Applicable Insurance.

61

Group Name

Group Name Linked To Group.

62

Insurance Group No.

Group Number.

63

Treatment Authorization Codes

Prior Authorization Number In Claim
Prepare.

64

Esc

Code Based On Policyholder’s Employment
Status.
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65

Employer Name

If Claim Financial Group Is WMC, Or
Insurance Is WC, Then Name Of
Policyholder’s Employer.

66

Employer Location

If Claim Is WMC, Or Insurance Company Is
Type WC, Then City, State, Zip Of
Employer.

67

Prin Diag Code

The Primary Diagnosis Code.

68 – 75

Code(S)

Other Diagnosis Codes On The Invoice In
Order Of Entry.

82

Attending Physician

Rendering Provider Upin And Name.

84

Remarks

Name And Address Of Insurance To Which
This Claim Is Being Filed.

85

Provider Representative

Data Field 2 In File > Options.

86

Date

Date Of Service On Claim.

UB-04 Field Data Source Lookup
1
2
3a
3b
4

5
6
7
8a
8b
9a-d
10
11
12
13
14
15
16
17
18-28
29
30
31-36
37
38
39-41
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Invoice facility name, address and office
phone number
Currently blank
Invoice #
Patient account number
Type of Bill field in File > Options for the
facility linked to the invoice. Any text
entered in the Office Number field of the
insurance being printed will override this
option.
Tax ID field in File > Options for the
facility linked to the invoice
First and last service dates from detail
lines
Currently blank
Currently blank
Patient name
Patient home address & telephone
Patient DOB
Patient gender code
Admission Date from invoice claim
prepare
Currently blank
Admission Type from invoice claim
prepare
Admissions Source from invoice claim
prepare
Currently blank
Patient Status from invoice claim prepare
Condition Codes from patient invoice
Claim Defaults
Accident State from invoice claim prepare
Currently blank
Occurrence codes and dates from Invoice
claim prepare
Currently blank
Currently blank
Currently blank
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42

43

44

45
46
47
48
49
Line 23 of Charge Detail

50a, b, c
51a, b, c
52a, b, c
53a, b, c
54a, b, c
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Revenue code associated with CPTs or
HCPCS. Roll Up rules set in fee
schedules will have a major influence on
the output. Printing will use the following
settings:
- If there is a Rev code and the CPT is
NOT set to rollup it will print both Rev &
CPT codes.
- If there is a Rev code and the CPT IS
set to rollup and there is only 1 CPT for
this Rev code, it will print both Rev & CPT
codes.
- If there is a Rev code and the CPT IS
set to rollup and there is more than 1 CPT
for this Rev code, it will print only the Rev
code.
- If there is no Rev code and the CPT IS
set to rollup, each CPT will print on it's
own line with the CPT code and CPT
description.
- If there is no Rev code and the CPT is
NOT set to rollup, it will print the CPT
code and CPT description.
Revenue code description if insurance
origin is MA, MB or MC (Medicare Part A,
Part B or Medicaid). Prints CPT or
HCPCS description for others. There is
also a dependence upon the Revenue
Code roll up rules in fee schedules and
how that affects Box 42:
- Claim is being submitted to an
insurance company with a payor type of
MC, MB, or MA: If there is a Rev code it
will print the rev description. If there is no
Rev code it will print the CPT description.
- Claim is being submitted to an
insurance company that is not MC, MB,
or MA: If there IS a Rev code and the
CPT IS set to rollup and there is only 1
CPT for this Rev code, it will print the
CPT description. If there is NOT a Rev
code and the CPT IS set to rollup, it will
print the CPT description. If there IS a
Rev code and the CPT IS set to rollup
and there is more than 1 CPT for this Rev
code, it will not print a description – only
the Rev Code.
CPT or HCPCS Code (only first 5
characters in case you use custom star
(*) codes
Start DOS
Unit count
Billed Fee
Currently blank
Currently blank
Page count if > 1 page; current date when
printed in column 45; total charges in
column 47; revenue code is 0001
Primary, secondary and tertiary insurance
on the invoice
Payor ID for each insurance
Information Release from invoice claim
prepare
Assignment box from invoice claim
prepare. Y if checked, N if unchecked.
Sum of payments from the specific
insurance. 0.00 if No Credits option when
printing is checked
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55a, b, c

56
57a, b, c

58a, b, c
59a, b, c
60a, b, c
61a, b, c
62a, b, c
63
64
65
66
67

68
69
70
71
72
73
74
75
76

77

78
79
80
81

Claim total charges less Box 54 values.
0.00 if No Credits option when printing is
checked
NPI for facility linked to invoice.
Values from specifically named alternate
IDs linked to the invoice facility. If
insurance company origin ID is:
- MA or MB=pulls value from “Medicare
Provider Number” alternate ID; if this
does not exist then it uses the Medicare
Alt value from the rendering provider
demographics Licensure tab.
- MC=pulls value from “Medicaid Provider
Number” alternate ID, if this does not
exist then it uses the Medicated Alt value
from the rendering provider
demographics Licensure tab.
Policyholder for applicable insurance
Patient relationship code to policyholder
for applicable insurance
Policy number for applicable insurance
Group name for applicable insurance
Group number for applicable insurance
Prior authorization number from invoice
claim prepare
Patient employer if insurance origin ID =
WC
Always “9”
Primary ICD from invoice in first position,
additional ICDs in order of incidence on
the invoice
Currently blank
Currently blank
Currently blank
Currently blank
Currently blank
Currently blank
Currently blank
Currently blank
Numbers from licensure tab of rendering
provider from invoice claim prepare. If
insurance company origin ID is:
- MA or MB (Medicare), Qual=1C,
Medicare Alt
- MC (Medicaid), Qual=1D, Medicaid Alt
- BL (Blue Cross), Qual=1B, Blue Cross
Alt
Same as for 76 but based on the
operating provider in the invoice claim
prepare.
Currently blank
Currently blank
Name and address of insurance company
for which the claim is being printed
Currently blank

NSF (National Standard Format) Definitions Table and
Field Lookup Source
This table lists tables (queries) available in the NSF Definitions along with the location of the data that is
pulled for each. There are many different fields for each.
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Table Name

Information Source

Qyefguarantor

Policyholder/S On The Claim

Qyefhospital

Demographics From Hospital/Lab/Hpsa Linked To Claim.

Qyefinscomp

Insurance Company/Ies On The Claim.

Qyefinsgroup

Demographics From Insurance Group/S Linked To Claim.

Qyefinsprep

Data From Claim Prepare Form For The Invoice

Qyefinvoice_Cpt

Data From Cpt And Hcpcs Code/S On The Invoice.

Qyefinvoice_Ins

Policy And Other Data From The Insurance/S On The Claim And In The Patient
Insurance Window (Where You Add Insurance To A Patient).

Qyefinvoice_Ins2

Same As Qyefinvoice_Ins, But This Is Used To Put Information Specific To The
Secondary Policy Into The First Da0, Da1 Loop Which Would Otherwise Automatically
Pick Up The Data For The Primary.

Qyefinvoice1

Data From The Top Section Of An Invoice, E.G. Title.

Qyefinvoicepay

Summary From Any Payments That Have Been Made On The Invoice.

Qyefopt

Data From The Claims > EDI Options Window For The Facility In Which The Claim File
Is Generated.

Qyefoptions

Data From The File > Options For The Internal Medical Facility In Which The Claim Was
Created.

Qyefordering

Ordering Provider Demographics

Qyeforgfacility

Internal Medical Facility On The Invoice. Facility Address Line 1

Qyefpatient

Basic Demographics For Patient On The Claim

Qyefpatientbill

Extended Demographics For Patient On The Claim

Qyefprovdspec

Specialty Information For Invoice Dos Provider.

Qyefprovider

Dos Provider On The Claim.

Qyefprovideralt

Alternate Ids For Dos Provider On Invoice.

Qyefpurchasing

Purchasing Provider Demographics.

Qyefreferral1

Rendering Provider Demographics.

Qyefreferral2

Legal Referral Demographics.

Qyefreferralalt

Alternate Ids For Referring Physician In Claim Prepare Window.

Qyefrenderingalt

Alternate Ids For Rendering Physician In Claim Prepare Window.

Qyefrerral

Referring Provider Demographics.

Qyefwork

Calculated Fields. These May Be Fields That Satisfy Things Like Loop Logic Sequence
Numbers, Date Type Indicators That Are Based On Dates Pulled From Claims And
Demographics, Icd-Pointers, And Record And Line Totals Required In Certain Nsf
Fields.

Qyfileelc

Data From Options Selected In E-Claims, Some Of Which Is Calculated Based On This
And Other Claim Information.

ANSI 837 Claim File Matrix and Embedded Error
Messages
Data Matrix
In addition to header and footer records, the ANSI 837 claim file matrix contains many segments (records
or lines) that are repeated, but fall in different hierarchical loops. This matrix refers to the data sources for
the loops within each hierarchy. A great deal of data is dependent upon correct user entry. Segments and
fields not mentioned are typically hard coded into the application. Both X098 (professional) and X096
(institutional) references are included here.
Location/Segment/Record/Line

Description

Information Source(S)

ISA

Interchange Control Header

Hard Coded, Claims > Clearing Houses,
And Selections In e-Claims.

ISA05

Interchange ID Qualifier

Claims > Clearing Houses
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Location/Segment/Record/Line

Description

ISA07

Interchange ID Qualifier

Information Source(S)
Claims > Clearing Houses

ISA.14

Acknowledgement Requested

Acknowledgment Request Box In Ef Wiz, 0
If Unchecked, 1 If Checked.

ISA.15

Usage Indicator

Production/Test Field In Ef Wiz.

GS

Functional Group Header

Hard Coded, Claims > Clearing Houses

ST

Transaction Set Header

Hard Coded.

BHT

Beginning Of Hierarchical Transaction

Hard Coded, Selections In e-Claims.

REF

Transmission Type Identification

Hard Coded.

LOOP 1000A NM1, PER

Submitter Information

Claims > EDI Options

LOOP 1000B NM1

Receiver Information

Claims > Clearing Houses

LOOP 1000B NM109

Interchange Receiver ID

Claims > Clearing Houses Interchange
Receiver ID unless a specific receiver ID is
set up in the clearing houses Receiver IDs
tab AND a batch is built filtering for the
fingrp linked to this special value.

LOOP 2010AA NM1, N3, N4, REF

Billing Provider Information

Facility In Which Claims Are Created. Ref01
And Ref02 Numbers And Types Are Pulled
Based On The 2ndary Id Setup In The
Clearing House Window.

LOOP 2000B SBR

Subscriber Information

Invoice, Patient Insurance, Insurance
Company, Insurance Group.

LOOP 2000B PAT

Patient Information

Patient Demographics.

LOOP 2010BA NM1, N3, N4

Subscriber Information

Patient Insurance Policyholder.

LOOP 2010BB NM1, N3, N4

Payor Information

Insurance Company And Group.

LOOP 2010BC NM1, N3, N4

Responsible Party Name

Provider Linked To Legal Referral In Claim
Prepare.

LOOP 2000C PAT, NM1, N3, N4, DMG,
REF

Patient Information

Patient, Claim Prepare, Patient Insurance

2300 CLM, DTP

Claim Information

Invoice, Claim Prepare
*Clm01 Uses Invoice Number.
*Dtp Incidences Are Dependent Upon
Whether There Are Dates In Fields. Dtp
Type Abc Is The Lmp In The Claim + 280.

2300 CLM05-3

Frequency Type

Claim Prepare

2300 CLM12

Special Program Code

EPSDT Program Code in Claim Prepare

2300 CLM20

Delay Reason Code

Claim Prepare

2300 PWK01

Report Type

Claim Prepare

2300 AMT (F5)

Patient Amount Paid

Sum Of Patient Payments And
Copayments. No Credits In Wizard Will
Ignore These.

2300 AMT (NE)

Purchased Service Amount

Invoice. Total Cost Of Cpt/Hcpcs Marked
As Purchased Services.

2300 REF (EW)

Mammography Certification Number

Conditional If Provider Has Mmg #

2300 REF (G1, 9F)

Prior Authorization Number

Claim Prepare.

2300 REF (X4)

CLIA Number

Options File For Facility. Only used if
insurance type is MP, MB or MC.

2300 REF (EA)

Medical Record Number

Patient Account Number.

2300 CL1

Institutional Claim Code

Claim Prepare Admission Type, Source &
Patient Status

2300 CRC

ESPDT Referral Type

Claim Prepare EPSDT list boxes

2300 CRC

Home Health Functional Limitations

Claim Default Functional Limitations

2300 CRC

Home Health Permitted Activities

Claim Default Activities

2300 CRC

Home Health Mental Status

Claim Default Mental Status

2300 CR6

Home Health Care Information

Claim Default Prognosis, Skilled Nursing
Facility Indicator, Certification Date Range
& Type, etc.
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Location/Segment/Record/Line

Description

Information Source(S)

2300 HI

Health Care Diagnosis Code

1 8 ICD codes on Invoice.

st

2300 HI

Condition Codes

Claim Default Condition Codes

2300 K3

Louisiana KIDMED screening codes

Group No field in Misc. Options tab of Claim
Prep.

2300 SV111

EPSDT

Claim Prepare EPSDT checkbox

2310A NM1, PRV (professional)

Referring Provider

Demographics for provider linked to
referring field in Claim Prepare.

2310A REF (professional)

Referring Provider

Demographics and alt IDs for the provider
linked to the referral field in the claim
prepare. Alt IDs are specified in the referral
nd
2 ID tab in clearing house.

2310A NM1, PRV, N3, N4 (institutional)

Attending/Rendering Provider

Demographics for provider in the rendering
field of claim prepare (Used If Not Same As
Billing Provider In 2010AA).

2310A REF (institutional)

Attending/Rendering Provider

Demographics and alt IDs for the provider
linked to the rendering field in the claim
prepare. Alt IDs are specified in the
nd
Provider 2 IDs tab in the clearing house.

2310B NM1, PRV, N3, N4 (professional)

Rendering Provider

Demographics for provider in the rendering
field of claim prepare (Used If Not Same As
Billing Provider In 2010AA).

2310B REF (professional)

Rendering Provider

Demographics and alt IDs for the provider
linked to the rendering field in the claim
prepare. Alt IDs are specified in the
nd
Provider 2 IDs tab in the clearing house.

2310B NM1, PRV, N3, N4 (institutional)

Operating Provider

Demographics for provider in the operating
provider field of claim prepare (Used If Not
Same As Billing Provider In 2010AA).

2310B REF (institutional)

Operating Provider

Demographics and alt IDs for the provider
linked to the operating provider field in the
claim prepare. Alt IDs are specified in the
nd
Provider 2 IDs tab in the clearing house.

2310C NM1 (professional)

Purchased Service Provider

Demographics for purchasing provider
linked in Claim Prepare.

2310C REF (professional)

Purchased Service Provider

Demographics and alt IDs for the
purchasing provider linked to the referral
field in the claim prepare. Alt IDs are
nd
specified in the referral 2 ID tab in clearing
house.

2310D NM1, N3, N4 (professional)

Service Facility Location

Claim Prepare Lab, Hpsa, Hospital

2310D REF (professional)

Facility Reference Identifications

Can be set using facility alternate IDs in
clearing houses.

2310E, NM1, REF

Supervising Provider

Invoice (Used If Supervising Not Same As
Rendering In 2310b)

2310 REF (institutional)

Facility Reference Identifications

Can be set using facility alternate IDs in
clearing houses.

2320 SBR,

Other Subscriber Information

Invoice, Patient Insurance, Insurance
Company, Insurance Group.

2320 AMT (D)

Cob Payor Paid Amount

Insurance Payments. Not Used If No
Credits In Ef Wiz Is Checked.

2320 DMG

Subscriber Demographic Info

Policyholder.

2320 OI

Other Insurance

Claim Prepare. Used If Filing Secondary Or
Tertiary.

2330A NM1, N3, N4

Other Subscriber Secondary Info

Patient Insurance And Policyholder On
Supplementary Insurances.

2330B NM1

Other Payor Name

Supplementary Insurance Company.

2330B N3, N4

Other Payor Address (these are custom
fields for Gateway EDI, not part of
Implementation Guide)

Secondary insurance company address, but
only if clearinghouse name used when
building claims starts with “Gateway”
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Location/Segment/Record/Line

Description

2400 LX

Service Line

Information Source(S)
Invoice Cpt

2400 SV1

Professional Service

Invoice Cpt, Claim Prepare

2400 SV111

EPSDT Indicator

EPSDT Checkbox, Claim Prepare

2400 SV112

Family Planning Indicator

Family Planning Checkbox, Claim Prepare

2400 DTP (472)

Date – Service Date

Invoice Cpt

2400 DTP (431)

Date – Onset Of Current Symptom/Illness

Invoice

2400 DTP (438)

Date – Similar Illness/Symptom Onset

Claim Prepare

2400 REF

Line Item Control Number

Cpt Database Record Number.

2400 NTE

Line Note

Invoice CPT Edit Narrative. If the first 3
characters are ADD, CER, DCP, DGN,
PMT and TPO.

2410 LIN

NDC Code

Invoice CPT NDC Code.

2420E NM1, N3, N4, REF

Order provider

Demographics for ordering provider in
Claim Prepare

2430 AMT, SVD, CAS, DTP

COB Payor Information

Insurance payments and adjustments. Not
used if No Credits option in e-Claims is
checked.

SE

Transaction Set Trailer

Hard Coded

GE

Functional Group Trailer

Hard Coded

IEA

Interchange Control Trailer

Hard Coded

Embedded Error Messages
In addition to the normal formatting errors, e-MDs Bill will embed error messages into a claim file when it
cannot locate lookup information. At the completion of building the file, it will tell the user that there were a
certain number of errors that caused it to miss segments/lines that are dependent upon these. There is an
option to view the file. If this is clicked, the ANSI file viewer opens with the last file’s .chk version
displayed. The .chk is file is easier to read because it lays out each segment as a separate line.
After opening the file users can locate the errors by immediately clicking the Find button. The default
search string is [?. Errors are inserted into brackets with a question mark. The list below is the different
error types.
•

[?DOS is blank?] – Date of service on a claim is blank.

•

[?DOS/EOS is blank?]

•

[?Relation Code is blank?] – Policyholder relationship code is not entered.

•

[?Last Name is blank?]

•

[?First Name is blank?]

•

[?Ins Policy # is blank?]

•

[?Address is blank?]

•

[?City is blank?]

•

[?State is blank?]

•

[?Zip is blank?]

•

[?Patient Last Name is blank?]

•

[?Patient First Name is blank?]

•

[?Patient Address is blank?]

•

[?Patient City is blank?]

•

[?Patient State is blank?]

•

[?Patient Zip Code blank?]
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•

[?Patient Date of Birth is blank?]

•

[?Patient Gender is blank?]

•

[?Taxonomy Code is blank?] – one of the providers on the claim (rendering, referring, etc.) does
not have a taxonomy code.

•

[?Organization Name is blank?] – one of the organizations is blank (e.g. organization guarantor,
hospital, clinic)

•

[?Policy# is blank?]

•

[?Insurance Company Name is blank?]

•

[?Payor ID is blank?] – the primary insurance on the claim does not have a payor ID.

•

[?Claim Filing Indicator Code cannot be blank?] – the indicator code for one of the insurances on
the claim is blank. Go to Demographics > Insurance and open the insurance file(s) for the
insurance(s) on the invoice. Check that the Origin ID/Indicator code is filled in. Also check the
patient insurance. If changes are made, remove the insurance from the invoice then readd it.

•

[?DOB is blank?]

•

[?Sex is blank?]

•

[?Facility Name is blank?]

•

[?No ICD?] – no diagnoses on the invoice.

•

[?No CPT or ICD linkage invalid?] – A CPT is linked to an ICD which is not on the claim. This
typically refers to situations where the ICD has been deleted (although the system has an invoice
edit for this when a user tries to make the deletion).

•

[?Tax ID is blank?]

•

[?Security Info is blank?] – The security information in the Claims > Clearing Houses window is
blank. This must be set up for each facility.

•

[?SID is blank?] – The submitter ID in the Claims > Clearing Houses window is blank. This must
be set up for each facility.

•

[?RID is blank?] – The Receiver ID in the Claims > Clearing Houses window is blank. This must
be set up for each facility.

•

[?ASC is blank?] – The Application Sender Code in the Claims > Clearing Houses window is
blank. This must be set up for each facility.

•

[?ARC is blank?] – The Application Receiver Code in the Claims > Clearing Houses window is
blank. This must be set up for each facility.

•

[?Purpose Code is blank?] – It is highly unlikely that you will get the error. It will occur if the
original or reissue field in e-Claims is not picked up.

•

[?Transmission Type is blank?] – This is hard coded by the system to pick up the ANSI version
number. Call e-MDs if you get this error.

•

[?Submitter Name is blank?] – The Submitter name in Claims > EDI Options is blank. This must
be set up for each facility.

•

[?Cust# is blank?] – The Customer Number in the Vendor tab of Claims > EDI Options is blank.
This must be set up for each facility.

•

[?Contact is blank?] – The Contact information in Claims > EDI Options is blank. This must be
set up for each facility.

•

[?efOpt_VendorID is blank?] – The Vendor ID in Claims > EDI Options is blank. This must be set
up for each facility.

•

[?Clearing House Name is blank?] – The name of the clearing house is blank. This must be set
up for each facility.
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•

[?Billing Provider is blank?] – The Submitter Name in Claims > EDI Options is blank. This must
be set up for each facility.

•

[?Subscriber is blank?] – The policy holder on the claim is blank. Check the insurance tab of the
invoice.

•

[?Claim is blank?] – There is no information in this claim.

•

[?Surgery date is blank?] – Institutional claim error. If there are surgery codes, a surgery date is
required in the claim.

•

[?Verbal Order Date is blank?] – Institutional claim error. If a verbal order date is required, it can
added in the claim defaults.

•

[?Security Info is blank?] – Security information in Claims > Clearinghouses is blank. This must
be set up for each facility.

•

[?No Patient?]

•

[?No CPT?]
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Data Dictionary
Some users have more advanced computer skills and need to understand the data structure in order to
write interfaces to the system, or reports based on the data within the tables. Although e-MDs does not
publish a comprehensive data dictionary, the list of tables below, the highly rated database design, and
the tools supplied with the widely used Microsoft SQL Server DBMS (database management system)
make the task of understanding the database structure relatively easy.
Tables are typically named according to the data type stored, or module that uses those tables. In most
cases, relational fields have the same name (although there are exceptions such as where multiple
providers are linked to a particular record like an invoice).

Notes:
•

Some of the data in the tables is proprietary or licensed. Users are cautioned that the license to
use the system does not give carte blanche to export data for other purposes.

•

Users are strongly advised to work on backup versions of their live system. e-MDs support
cannot be responsible for errors that are created by users attempting to write into the tables. Any
work required to correct errors will be billed at programmer rates. These are extremely high and
will typically run much more than requesting a custom programming project to be completed by
the e-MDs development department. This is in addition to the cost of not being able to use your
system.

Tables
The following list explains prefixes that precede table names that might be relevant to users, as well as
some of the more commonly used tables. If you are querying the database, we recommend that you look
at the views first (see later). These are built in “virtual tables” of commonly queried data that already
include many of the joins that you would need to create on your own. For example, some of the patient
views include names, etc. that are stored in several tables.
Whenever you query tables or views, you ice that there is always a field labeled xxxx_recordstate (where
xxxx is a table name). Always exclude records with a value of 1 – these are soft deleted records.
•

APP: Appointment data.
○ APP_Appointment: Majority of appointment information including patient id, facility id,
resource id, appointment start and end times, status times, visit type id, visit reason id, detail
and notes.
○ APP_AppointmentCall: Confirmation tracking table.
○ APP_AppointmentType: The reference table of appointment types.
○ APP_Appresource: Resources for appointment facilities. This includes a healthcare id link to
the provider table for provider resources.
○ APP_Apptemplate: Where time grids are stored.
○ APP_Rounds: Where rounds lists are stored.
○ APP_Slot: Where the system keeps iterations of time grids applied to days.

•

BILL: Billing data.
○ BILL_Authorization: Stores referrals/authorizations records.
○ BILL_AuthorizationCPT: Authorization CPT code sets.
○ BILL_BillComment: Comments used for invoice titles, statement comments and superbill
comments.
○ BILL_Distribution: Distribution/line item payments and adjustments.

e-MDs Solution Series Bill User Guide 8.0 R00

354

○ BILL_EF….: All the tables that begin with this are where claim batch histories (ef and paper)
are stored.
○ BILL_Followuptype: A reference table of follow up actions.
○ BILL_Insprep: Data stored in the invoice insurance prep form.
○ BILL_Invoice: Invoice data.
○ BILL_InvoiceCPT: Invoice CPT data.
○ BILL_InvoiceICD: Invoice ICD data.
○ BILL_InvoiceIns: Invoice insurance data.
○ BILL_Payment: Payment data.
○ BILL_Paymenttype: Reference table of payment and adjustment types.
○ BILL_Prepayment: Prepayment data.
○ BILL_Worklist: Saved collections work lists. These link to the specific invoices in the worklist
via the worklist_id in the invoice.
•

CHRT: Charting data.

•

CPT: CPT data.

•

DRUG: Prescription information.

•

ENTY: Demographic information.
○ ENTY_Address: Addresses stored in the database.
○ ENTY_AddressDetail: How the system links an address to a specific entity. The
addresstype_id is used to determine what kind of address.
○ ENTY_BillPatient: Demographic information about patients that is mostly used in the billing
module (but not exclusively).
○ ENTY_ChartPatient: Demographic information about patients that is mostly used in the
charting module.
○ ENTY_Entity: The base record for every entity, person or organization.
○ ENTY_Guarantor: Guarantor demographics.
○ ENTY_Healthcare: Demographic data for any healthcare person.
○ ENTY_InsuranceCompany: Insurance company demographics.
○ ENTY_Nurse: Nurse demographics.
○ ENTY_NursePract: Nurse practitioner demographics.
○ ENTY_Organization: The base record for any organization entity.
○ ENTY_Patient: Patient basic demographics.
○ ENTY_Person: The base record for any master person entity.
○ ENTY_Pharmacy: Where pharmacies used in prescriptions are stored.
○ ENTY_Phone: Phone numbers.
○ ENTY_PhoneDetail: How the system links a phone number to an entity. The phonetype_id is
used to indicate what kind of phone.
○ ENTY_Physician: Staff providers.
○ ENTY_PhysicianAssistant: Physician assistant record.
○ ENTY_Provider: Extended information about staff and non-staff providers.
○ ENTY_Statelicense: Table of provider state license numbers.

•

FLOW: FlowSheets.

•

HCPC: HCPCS data.
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•

ICD: ICD data.

•

IMG: DocMan scanning data.

•

INSR: Insurance company link tables.
○ INSR_Insurance: Where patient insurance data is kept including policy numbers, effective
dates, sequence, card scans, etc.
○ INSR_InsuranceCoProvider: Credentialling links between insurance companies and
providers.
○ INSR_InsuranceGroup: Insurance group demographics.

•

LINK: Link tables that establish relationships between tables.

•

LKUP: Reference data.
○ LKUP_Accountstatus: Patient account status codes.
○ LKUP_AdditionalIDType: Provider alternate ID types.
○ LKUP_AddressType: List of address types that are used in the ENTY_Addressdetail.
○ LKUP_Degree: Degree codes and descriptions.
○ LKUP_EmployeeStatus: Employment status codes and descriptions.
○ LKUP_FinancialGroup: Financial group codes and descriptions.
○ LKUP_Handicap: Handicap codes and descriptions.
○ LKUP_InsuranceClass: Insurance class codes and descriptions.
○ LKUP_InsuranceFileMethod: Insurance filing method codes and descriptions.
○ LKUP_InsuranceType: ANSI & NSF insurance type codes and descriptions.
○ LKUP_InvoiceStatus: Invoice status codes and descriptions.
○ LKUP_Language: Language codes and descriptions.
○ LKUP_Livingarrangement: Patient living arrangements.
○ LKUP_Livingdependency: Patient living dependencies.
○ LKUP_MaritalStatus: Codes and descriptions.
○ LKUP_MedicalFacilityType: Place of service codes and descriptions (see also
lkup_placeofservice).
○ LKUP_Nationality: Person nationalities.
○ LKUP_PatientKind: Patient types.
○ LKUP_PayorType: ANSI & NSF insurance origin ID/indicator codes and descriptions.
○ LKUP_PhoneType: Phone types used in ENTY_PhoneDetail.
○ LKUP_PlaceofService: Place of service codes.
○ LKUP_Prefix: Person prefixes.
○ LKUP_Race: Person races.
○ LKUP_ReferralType: Referral types that are linked to bill_authorization to create the
bill_authorizationcpt records.
○ LKUP_Relation: Patient, guarantor, policyholder and contact relationship codes.
○ LKUP_Religion: Religions.
○ LKUP_Specialty: Provider specialty codes.
○ LKUP_State: State codes used in address records.
○ LKUP_Suffix: Person suffixes.
○ LKUP_Taxonomy: Provider specialty taxonomy.
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○ LKUP_TypeofService: Type of service codes on CPTs and HCPCS.
○ LKUP_Userfield: Patient recall date types. The actual dates are in the patn_uservalue table.
○ LKUP_Visittype: Appointment visit reasons.
•

MSG: Messaging data.

•

PATN: Patient link data.
○ PATN_EmergencyContact: Emergency contacts for patients.
○ PATN_GuarantorStatement: Statement filing history.
○ PATN_MarketingReferral: Marketing referrals that can be linked to patients.
○ PATN_Uservalue: Recall dates for patients.

•

PLOT: Graphing used by clinical applications.

•

RNDS: Tables used by e-MDs Companion.

•

RULE: Health maintenance rules data.

•

RVU: RVU tables.

•

TASK: Tasking data.

•

TMP: Electronic remittance import tables.

Views
e-MDs has added some views to the database to make it easier to retrieve commonly used data such as
patient demographics without needing to know how to link all the tables in which this information is stored.
Views can be accessed by queries and reports in exactly the same way as tables. A list of views is in the
Views folder below the System Tables folder (under the TopsData folder in the SQL Server database
tree).
•

VIEW_Address: Entity address information. Join to entity on view_entity and lkup_address type
on addresstype_id.

•

VIEW_Appointment: Appointment data. Join to view_patient on patient_id, app_appresource on
resource_id, view_medicalfacility on medicalfacility_id, app_appointmenttype on
appointmenttype_id, lkup_visittype on visittype_id. Appointment status codes are: 0=Normal,
1=Blocked, 2=New Patient, 3=No Show, 4=Not used any more, 5=Cancelled.

•

VIEW_Authorization: Authorization/Referral data. Join to view_billpatient on patient_id.

•

VIEW_Bilinvoice: Invoice data. Join to view_billpatient on patient_id, view_medicalfacility on
medicalfacility_id, view_provider on provider_id.

•

VIEW_BillInvoiceBalance: Invoice balance data for fast totaling queries.

•

VIEW_BillPatient: Extended patient demographics. Join to view_guarantor on guarantor_id,
view_provider on provider_id, view_provider (referral) on provider2_id.

•

VIEW_Guarantor: Guarantor demographics.

•

VIEW_Healthcare: Healthcare staff demographics.

•

VIEW_Insprep: Invoice Claim Prepare window data. Join to invoice on invoice_id.

•

VIEW_Insurance: Patient insurance data. Join to view_patient on insurance_entity_id and to
view_guarantor on insurance_policyholder_id joining to entity_id in view_guarantor.

•

VIEW_InsuranceCompany: Insurance company demographic data.

•

VIEW_InvoiceCPT: Invoice procedure data. Joins to view_invoice on invoice_id.

•

VIEW_MedicalFacility: Internal and external medical facilities.

•

VIEW_Organization: Organization entity data.

•

VIEW_Patient: Patient demographics. Join to view_entity on entity_id.
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•

VIEW_Person: Person entity data. Join to view_entity on entity_id.

•

VIEW_Pharmacy: Pharmacy data.

•

VIEW_Phone: Entity phone information. Join to view_entity on entity_id and to lkup_phonetype
on phonetype_id.

•

VIEW_Physician: Provider data (use view_provider first).

•

VIEW_Provider: Provider data.

Database Diagram
Microsoft SQL Server’s database management tool, Enterprise Manager includes many tools that can be
used to understand the relationships between tables. One of those tools is a database diagram tool that
can be used to create a visual representation of the relationships between different tables.

To create a database diagram:
1. Open Enterprise Manager.
2. Expand the Console Root tree until the TopsData database is seen.
3. Open the tree for the TopsData database.
4. Right-click Diagrams, then click New Database Diagram on the context-sensitive menu.
5. Click Next in the first step of the Create Database Diagram Wizard.
6. Select tables that you want to see in the diagram. Click the “Add related tables automatically”
box and set the number of levels to have SQL Server add additional tables that you might have
missed. Be aware that this may create a very complex diagram depending on the number of
tables found.
7. Click Next.
8. Click Finish. SQL Server generates the diagram in a new window.
9. Use the toolbar in the main SQL Server window to change the view options or work with the
tables.
10. Click the button with the disk icon to save the diagram for future use.
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Appendix B
Glossary
The following describes some of the commonly used terms in this guide:
Alphanumeric: This refers to the type of data that can be entered in fields. An alphanumeric field allows
both letters and numbers.
ANSI: American National Standards Institute. In the medical billing world, this refers to a format laid out
for EDI transactions.
Check Box: A square field that can be set (displays black check mark) or not (white). Some checkbox
fields give users multiple options from which one or more can be selected.
COB: Coordination of Benefits (where insurance companies send information used by secondary payors
to determine benefits).
Cursor: This is the flashing bar (usually upright, but it can be horizontal). It signifies the point at which
data will be entered on a screen. When a key is pressed, the letter, number, punctuation mark or operator
will appear where the cursor was. The cursor moves to the next position.
Double-click: Refers to pointing the mouse at an icon, a selection in a list of records, or other graphic
object and then clicking twice with the left mouse button to proceed with an action.
Drag: Dragging is used to move a window around the computer screen. To drag a window, point the
mouse to the title bar of the window, hold down the left mouse button, and then move the window to the
position desired and release the mouse button.
Drop Down Arrow: This is the arrow found to the right of a list box. Clicking on the drop down arrow
displays all or part of a list of options that can be selected.
Flag: This is the equivalent of marking, or highlighting. For example, a patient could be flagged in a
special way by attaching an alert, or being set up with a particular financial grouping.
Highlight: A highlighted item is one that is ‘illuminated’ with a bar or other form of graphic effect to
indicate that it is selected. In e-MDs Bill, most items such as records in a search screen are highlighted
using a mouse click.
Input Mask: This is where a field has a required data entry format. For example, date fields are entered
as mm/dd/yyyy and telephone number fields as (###) ###-####. A system warning will tell users if they
have attempted to enter data that does not conform to the mask requirements.
List Box: A field with an attached list of options aiding data entry into that field. A drop down arrow to the
right of the field indicates a list box.
Lookup Table: This is a table of data used elsewhere in the system to expedite data entry. For example,
a list of appointment types is considered to be a lookup table.
NSF: National Standard Format. An electronic claims filing format (being replaced by ANSI as part of
HIPAA).
Radio Button: A circular field that is on (black) or off (white). Radio button fields typically contain more
than one option (radio button), but selecting one deselects another, whereas a checkbox option may
permit multiples.
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Right-click: Refers to pointing at an item and then clicking once with the right mouse button. As per
Windows standards, a menu usually appears.
Scroll bars: These are the bars with arrow pointers on the bottom, or to the right of screens or selection
menus. Clicking on the arrow buttons will scroll the window or list in the direction of the arrow, thus
displaying previously hidden elements. A scroll bar also has a ‘slider’ which can be used to scroll through
the list quickly by selecting the slider and, while continuing to hold down the left mouse button, moving up
or down in the scroll bar. To move up or down a page at a time in the scroll bar, click in the bar on either
side of the slider.
Select: Similar to highlight.
String: A series of keystrokes. For example, when searching for records, users enter a string of letters or
numbers corresponding to the information they want to see. Users might enter part of a last name (a
string) to find all patients corresponding to this string.
Tool Bar: This is a row of buttons, usually located at the top of a Windows™ program. The buttons are
shortcuts to commonly performed tasks.

e-MDs Solution Series Bill User Guide 8.0 R00

361

Index
ABN
linking form to cpt ............................................................ 63
modifiers to be added alert............................................ 185
setting up codes requiring ............................................... 63
ABN/Forms Manager .................................................. 91, 307
using to satisfy cpt/hcpcs alert ...................................... 184
Accept Payment
electronic ..................................................................... 260
adding patients.................................................................. 106
Address Types .................................................................... 95
Addresses ........................................................................... 97
Adjustment Group Codes.................................................... 77
Adjustment Reason Codes
auto post.......................................................................... 77
reference table ................................................................ 77
Adjustment Type ...................................... See Payment Type
Adjustments ...................................................................... 318
Age
gestational age at birth .................................................. 108
AllowOverwrite
invoice cpt ..................................................................... 183
Anesthesia Billing.............................................................. 331
Anesthesia Minutes........................................................... 176
ANSI
element separator ......................................................... 234
segment terminator ....................................................... 234
subelement separator.................................................... 234
ANSI 837
embedded error messages ........................................... 351
GS02 - app sender code ............................................... 235
GS03 - app rec code ..................................................... 235
ISA03 - sec info ............................................................. 235
ISA06 – interchange sender id ...................................... 235
ISA07 - interchange id qualifier ..................................... 235
ISA08 - interchange rec id............................................. 235
version supported.......................................................... 228
App Sender Code
ansi 837......................................................................... 235
Application Rec Code ....................................................... 235
Archive
contracts .......................................................................... 87
Assignment ....................................................................... 314
Audit
button in posting screen ................................................ 147
matching chart to claim ...See Chart Visit/Invoice Compare
super bill ........................................................................ 269
Authorization
setting codes requiring .................................................... 63
tracking by status .......................................................... 270
tracking by type ............................................................. 270
window .......................................................................... 272
Authorization Tracking ...................................................... 271
Authorizations
adding............................................................................ 274
worklists......................................................................... 272
Auto Post
reason codes ................................................................... 77
BA0-YA0/2010AA-2310B
checkbox ....................................................................... 236
Balance Due By
changing in remittance .................................................. 260
Balance Forward............................................................... 319

e-MDs Solution Series Bill User Guide 8.0 R00

Batch #
retrieving invoices in ......................................................145
Batch Numbers
posting ...........................................................................210
Billing Chart Visits
using visits button ..........................................................147
Birth
normal/premature/time...................................................108
Build All Invoices
in daily work list..............................................................288
Build Invoice Button...........................................................147
Burst Codes................................................. See Charge Sets
Capitation ..........................................................................326
monthly check posting ...................................................328
notification on saving invoice .........................................180
posting visit invoices ......................................................327
reporting.........................................................................328
setting automatic adjustment codes ................................85
setting capitated/carve out codes ....................................63
setting up auto or prompted adjustment ..........................85
Case
dispositions reference table .............................................95
match alert in cpt/hcpcs alert .........................................185
reports............................................................................301
Case Management ............................................................292
adding and editing..........................................................299
alerts ..............................................................................300
copying cases ................................................................299
how system links data....................................................293
patient case window.......................................................295
retrieving data on claims ................................................301
reviewing cases .............................................................300
worklist ...........................................................................294
CCI Check .........................................................................314
edit warning....................................................................180
CCI Edits ...........................................................................313
auditing invoices ............................................................314
downloading data...........................................................313
updating database .........................................................313
Champus
provider number.............................................................132
setting HCFA box 1..........................................................30
ChampVA
setting HCFA box 1..........................................................30
Charge Entry
adding modifiers using keyboard ...................................175
auto from daily work list .................................................179
auto from visits window..................................................178
custom/starred codes.....................................................175
icd linking using keyboard..............................................175
manual ...........................................................................173
modifying cpt information ...............................................176
panels/explosion/burst ...................................................175
quick steps .....................................................................177
steps in detail .................................................................173
windows .........................................................................150
Charge Sets..............................................................176, 263
Charges
writing off........................................................................322
Charges & Payments Window
charges tab ....................................................................155
insurance information.....................................................161
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payments tab ................................................................. 161
Charges and Payments
header fields & buttons.................................................. 151
Charges and Payments Window
sizing and positioning .................................................... 151
Check
scanning & viewing........................................................ 166
Check Claims
in daily work list ............................................................. 288
Check In
worklist .......................................................................... 284
Check Out
payment posting ............................................................ 193
Check Search ................................................................... 211
Checks
filtering remittances by .................................................. 260
City, State, Zip
maintenance.................................................................... 80
City, State, Zip Table .......................................................... 28
Claim
excluding code from ........................................................ 63
filing history ................................................................... 242
formats available ........................................................... 216
in claim property for code .............................................. 159
Claim Default Window....................................................... 173
Claim Defaults
from case management................. See Case Management
Claim Files
creating electronic ......................................................... 236
Claim Printing
new batch ...................................................................... 218
single ............................................................................. 220
Claims ............................................................................... 215
adding a referral ............................................................ 270
colorado medicaid co-1500 ........................................... 228
creating electronic ......................................................... 236
electronic ....................................................................... 228
illinois medicaid idpa ..................................................... 227
masshealth form V ........................................................ 227
new york medicaid e-medny-150001 claim ................... 228
ohio medicaid dhs 6780 ................................................ 228
patient case information ................................................ 301
refiling............................................................................ 238
refiling line items............................................................ 320
tracking.......................................................................... 241
Workers' Comp.............................................................. 332
Claims Refiling
correcting errors ............................................................ 240
Clearing House Interface .................................................. 243
file type options ............................................................. 244
general options .............................................................. 249
sending files .................................................................. 253
standalone command line options................................. 251
Clearing Houses ............................................................... 233
Clinical Trials
forms prompting using rules ............................................ 63
CMS 1500 (12/90) Definitions........................................... 221
CMS 1500 Definitions ....................................................... 223
CMS Definitions
case management......................................................... 301
editing/deleting .............................................................. 224
re-setting to default........................................................ 224
setting............................................................................ 223
CMS Remove Zip Code Formatting.................................. 225
CMS-1500 ......................................................................... 223
box 09c, 09d - employer & plan..................................... 241
box 11b - employer........................................................ 116
box 14 - first illness date................................................ 168
box 16 - disability dates ................................................. 172
box 17, 17a - referring physician ................................... 171
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box 18 - hospital dates...................................................171
box 24g anesthesia units ...............................................176
box 24j epsdt..................................................................170
box 27 - assignment.......................................................169
box 32 - hospital.............................................................171
boxes 29 & 30 incl adjustments .....................................218
CMS-1500 (12/90) .............................................................221
CMS-1500 Field Lookup............................................337, 340
COB...................................................................................115
Code Linker .........................................................................55
Code Match .......................................................................288
Co-insurance
changing/removing responsibility...................................181
Collections
ad hoc list.......................................................................277
follow up actions ..............................................................80
saved work list ...............................................................278
transferring to.................................................................324
Collections Module ............................................................277
Collections Notes...............................................................212
Collections Report .............................................................282
Collections Work List Report .............................................282
Comments ...........................................................................28
Companies ..................................................... See Employers
Compliance
referrals..........................................................................276
Confirmation
worklist ...........................................................................284
Conflict Resolution Modifiers
satisfying ........................................................................186
Contact
adding to patient file.......................................................116
Contacts ............................................................................136
Contract
linking to insurance company ..........................................87
scanning...........................................................................84
setting capitation properties .............................................85
setting contractual adjustment automatically ...................85
Contracts .............................................................................83
comparing ........................................................................87
update/archive .................................................................87
Conversion Factor
updating ...........................................................................74
Copay
posting in advance of entering charges .........................190
waiving for cpt ..................................................................63
write-off.........................................................................322
Copy
button in patient search screen......................................118
Correct Coding Policy
medicare .....................................................See CCI Check
Correct Policy Number Automatically ................................259
Cost
setting in invoice ............................................................158
Cost Plus
building fee schedule .......................................................61
Courtesy Discounts
charges write-off ............................................................322
copayment write-off.....................................................322
Coverage
setting for cpt ...................................................................63
CPT
conflicts ..........................................................................180
description - changing in invoice....................................176
using custom starred codes ...........................................175
CPT Code
alternate descriptions.......................................................46
short list............................................................................45
CPT Codes
adding and deleting..........................................................47
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adding, editing, deleting .................................................. 47
custom............................................................................. 48
star .................................................................................. 48
CPT Default Units ............................................................... 63
CPT Fees
updating RVUs ................................................................ 73
CPT Panels
creating............................................................................ 75
using to bill -26 and -TC automatically .......................... 325
CPT Search ........................................................................ 42
keyword ........................................................................... 43
keywords ......................................................................... 46
outline.............................................................................. 43
CPT/HCPCS Alert
case match .................................................................... 185
using to satisfy policy requirements ................................ 90
CPT/HCPCS Alert Window ............................................... 180
CPT/HCPCS XE "Process Alerts/ABN:warning window"
Alerts ............................................................................. 182
CPT/HCPCS Alerts
how fired ........................................................................ 183
CPT/HCPCS Alerts
satisfying prompts ......................................................... 184
CPTs
duplicated in invoice ...................................................... 180
Credentialing..................................................................... 317
Credits
manual........................................................................... 318
moving between invoices .............................................. 208
Cross Over Code
in cpt/hcpcs alert ........................................................... 186
Cross Over Codes
setting up......................................................................... 63
Crystal Reports
data dictionary ............................................................... 354
Custom CPTs...................................................................... 48
Daily Work List .................................................................. 282
build all invoices ............................................................ 288
click through .................................................................. 285
creating.......................................................................... 283
linking chart/invoice to app........................................ 288
sorting............................................................................ 285
use examples ................................................................ 289
using.............................................................................. 285
Dashboard
log in and preferences..................................................... 22
options ............................................................................. 24
sessions .......................................................................... 24
Data Dictionary ................................................................. 354
Data Entry ........................................................................... 13
Database
data dictionary ............................................................... 354
diagram ......................................................................... 358
relational .......................................................................... 17
tables ............................................................................. 354
views ............................................................................. 357
Date
change posting .............................................................. 320
Date Fields
deleting/clearing .....................................See Deleting Data
Deductible ......................................................................... 321
Default
internal medical facility .................................................. 103
Default Filing Method
insurance......................................................................... 94
Deleted Invoices
finding............................................................................ 147
Deleting Data ...................................................................... 14
Demographics
doctors........................................................................... 130
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facilities ..........................................................................100
insurance .......................................................................124
patients ..........................................................................105
physicians ......................................................................130
providers ........................................................................130
verification. See Schedule check in module, See D column
in daily work list
Deposit
posting ...........................................................................207
Dictionary
medical, enabling ...........................................................290
options ...........................................................................290
Discounting
indigent care ..................................................................319
Distribution Grid
cells................................................................................164
DocMan
opening from Bill ............................................................288
Doctors ..............................................................................130
Downloads ...........................................................................4
Duplicated CPTs................................................................180
E&M
setting required modifier ..................................................63
E&M Modifier
cpt/hcpcs alert................................................................185
E-Claims
Electronic Claims ...........................................................236
EDI Options .......................................................................231
Electronic Claims...............................................................228
clearing houses..............................................................233
creating a test batch.......................................................239
creating batches.............................................................236
setting up state/facility-based identifiers ........................235
setup described................................................................18
setup steps.....................................................................229
Electronic Filing
creating a claim file ........................................................236
reactivate batch..............................................................238
rebuild a batch ...............................................................238
test McKesson files ........................................................233
Electronic Remittance........................................................255
payment date .................................................................260
set completed.................................................................261
Element Separator
ansi ................................................................................234
Emergency Contact
adding to patient file.......................................................116
Emergency Contacts .........................................................136
Employees.........................................................................136
Employers..........................................................................137
linking to patient .............................................................116
Employment Status
setting ............................................................................116
Encounter Forms ............................................ See Super Bills
Entering Charges
auto from daily work list .................................................179
auto from visits window..................................................178
manually.........................................................................173
Entities
organizations....................................................................97
person ..............................................................................97
EOB
posting payment with .....................................................167
scanning & viewing ........................................................166
EPSDT Claims...................................................................330
ERA ...................................................................................255
ERN ...................................................................................255
ERN/A............................................................ See Remittance
Error Messages
ANSI 837........................................................................351
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Facilities
active and inactive......................................................... 103
adding internal ............................................................... 101
Facility
change on invoice ......................................................... 148
external.......................................................................... 105
Family Contacts ................................................................ 136
FECA
setting HCFA box 1 ......................................................... 30
Fee Schedule Rules............................................................ 58
Fee Schedules
auto-generate from payments ......................................... 85
deleting............................................................................ 74
Fee Schedules & Rules
archive/update................................................................. 74
copying fee schedule....................................................... 61
Fee Schedules and Rules
alerts and correcting........................................................ 71
changing properties for ranges........................................ 62
changing properties for single code ................................ 62
hierarchy of precedence.................................................. 58
linking to insurance.......................................................... 67
setting up a fee schedule ................................................ 60
setup................................................................................ 62
window ............................................................................ 59
FIFO
using to post patient payments ................................. 198
File History for Claims....................................................... 242
File Ind .............................................................................. 233
File Status
line item ......................................................................... 159
types defined ................................................................. 181
Filing Hold
printing list of electronic claims on hold......................... 238
printing list of paper claims on hold ............................... 220
Financial Group
changing........................................................................ 240
changing during billing cycle ........................................... 30
Financial Groups ................................................................. 29
Financial Groups - Special
WMC ............................................................................. 332
FlowSheet ......................................................................... 355
Follow Up Action
automatic ......................................................................... 80
reference table ................................................................ 80
Form
printing from authorization window................................ 273
Forms
abn/forms manager ....................................................... 307
printing from posting...................................................... 147
Forums
on-line support and chat ................................................ 4
Getting Started.................................................................... 17
Global Period Alert.............................................................. 66
Global Periods
automatic content ............................................................ 66
GPCI
updating........................................................................... 74
Group Codes....................................................................... 77
Guarantor .......................................................................... 122
adding............................................................................ 122
payments ....................................................................... 196
Guarantor Insurance
using instead of patient ................................................. 181
Handouts
patient education ............................................................. 78
HCFA
batch summary report ................................................... 219
print from posting window.............................................. 147
HCFA Definitions ...................................See CMS Definitions
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editing/deleting...............................................................222
hierarchy ........................................................................223
re-setting to default ........................................................222
setting ............................................................................221
HCFA-1450..........................................See UB-92 and UB-04
HCFA-1500
box 01 - setting champus, champva, feca .......................30
box 01 - type of insurance..............................334, 337, 340
box 09c, 09d - employer & plan .....................................241
box 11b - employer ........................................................116
box 14 - first illness date ................................................168
box 16 - disability dates .................................................172
box 17, 17a - referring physician ...................................171
box 18 - hospital dates...................................................171
box 24g anesthesia units ...............................................176
box 24k epsdt.................................................................170
box 27 - assignment.......................................................169
box 32 - adding facility ...................................................103
box 32 - hospital.............................................................171
box 33 - changing default pin & group ...........................172
boxes 29 & 30 incl adjustments .....................................218
HCFA-1500 (12/90) Field Lookup .....................................334
HCFA-1500 Claim .......................................... See CMS-1500
HCFA-1500 IDPA
box 30 - prov number.....................................................227
box 31 - name ................................................................227
box 33 - payee no. .........................................................227
box 35 – original dcn ...................................................227
HCPCS Code
alternate descriptions.......................................................51
short list............................................................................51
HCPCS Codes
adding and deleting..........................................................52
adding, editing, deleting ...................................................53
HCPCS Search....................................................................48
keyword............................................................................49
keywords..........................................................................52
outline ..............................................................................49
Help
knowledge base ...............................................................4
newsgroups........................................................................4
online dowloads...............................................................4
online forums ...................................................................4
online troubleshooter ......................................................4
Hold Summary Report
paper claims...................................................................218
Home Health
claim information.......................See Claim Default Window
Hospitals................................ See External Medical Facilities
adding ............................................................................104
linking to claim ...............................................................105
ICD Linkage
reverse ..........................................................................160
shift right or left ...........................................................160
ICD Linkages
in invoice ICD1-4 fields ..................................................159
ICD Linking
in charge entry using keyboard......................................175
ICD-9
alternate description/synonym .........................................39
keywords..........................................................................40
search by code.................................................................37
search by keyword ...........................................................36
search by outline..............................................................36
ICD-9 Category
add, edit, delete ...............................................................41
ICD-9 Code
add, edit, delete ...............................................................41
ICD-9 Codes
adding and deleting..........................................................41
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ICD-9 Details....................................................................... 38
ICD-9 Search ...................................................................... 34
customization options...................................................... 35
icon colors defined .......................................................... 37
parent button ................................................................... 37
short list ........................................................................... 39
Image Capture Tool .......................................................... 309
Import
patient education ............................................................. 78
Include Inactive Patients? ................................................. 111
Indicator Codes
insurance......................................................................... 94
Indigent Care Discounting................................................. 319
Insurance
adding to patient............................................................ 114
changing for invoice ...................................................... 181
default filing method ........................................................ 94
indicator code .................................................................. 94
origin ID ........................................................................... 94
Insurance Cards
scanning ........................................................................ 117
Insurance Claims .............................................................. 215
checking for timely payment.......................................... 242
checking to see if filed ................................................... 242
print filing history ........................................................... 242
refiling line items............................................................ 320
tracking.......................................................................... 241
Insurance Classes .............................................................. 92
Insurance Companies
adding............................................................................ 125
deleting.......................................................................... 129
editing............................................................................ 129
Insurance Company
search window................................................................. 11
Insurance Company Overpayments ................................. 323
Insurance Contracts............................................................ 83
Insurance Filing
changing filing method .................................................. 239
changing method........................................................... 181
refiling claims................................................................. 238
supplementary/secondary ............................................. 240
Insurance Groups
adding............................................................................ 129
Insurance Information
invoice ........................................................................... 161
Insurance Refiling
correcting errors ............................................................ 240
Insurance Type
changing for Medicaid secondary.................................. 115
Insurance Type Codes........................................................ 94
Interchange Rec ID ........................................................... 235
Internal Medical Facility
setting default ................................................................ 103
Invoice
alerts on save ................................................................ 180
change facility................................................................ 148
creating.......................................................................... 173
deleting.......................................................................... 182
printing........................................................................... 211
Invoice Agency Collections History................................... 278
Invoice Facility
changing........................................................................ 147
Invoice Insurance.............................................................. 161
changing........................................................................ 181
Invoice Lock
setting........................................................................... 148
Invoice Notes .................................................................... 212
n column display in posting ........................................... 147
Invoice Number
using to post payments ................................................. 145
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Invoice Payment Due By ...................................................264
Invoice Responsibility
changing in main posting window ..................................147
Invoice Searches .................................................................12
Invoice Split .......................................................................160
Invoice Splitting
automatic code range setup ............................................33
Invoice Status
display in posting window ..............................................147
Invoice Status Administration ............................................264
Invoice Status Codes
administration tool..........................................................264
automatic .........................................................................82
linking to invoice...............................................................82
reference table .................................................................81
retrieving invoices with.....................................................82
Invoice Title
display in posting window ..............................................147
Invoices
building all in daily work list............................................288
deleted, finding...............................................................147
editing information..........................................................181
locked.............................................................................147
splitting out charges .......................................................213
IsProcessed
cpt grid flag ....................................................................159
Keyboard Shortcuts .............................................................14
Keyword Search
icd-9 .................................................................................36
Knowledge Base..................................................................4
Laboraties
linking to claim ...............................................................105
Laboratories........................... See External Medical Facilities
adding ............................................................................104
Launch DocMan
in daily work list..............................................................288
Lawyer/Law Firm
setting up using guarantor .............................................122
Legend
icd-9 .................................................................................37
License Key
activation..........................................................................18
LIFO
using to post patient payments ......................................198
Link Insurance Group ........................................................259
Link Invoice........................................................................259
Link Patient........................................................................259
Linkage
icd-cpt ............................................................................159
Locked Invoices
l column in posting .........................................................147
Logging In......................................................................25, 26
Macros
adding ............................................................................290
Mark Up
building fee schedule on fixed or %.............................61
Medicaid
children's programs........................................................330
defining as secondary ....................................................115
Medical Dictionary .............................................................290
Medical Facilities
external ..........................................................................105
Medical Facility
default ............................................................................103
type ................................................................................101
Medical Facility Type ...........................................................94
Medical Records Fee
creating charge item ..............................See Custom CPTs
Medicare
correct coding policy ...................................See CCI Check
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Medicare Secondary
defining ANSI type......................................................... 115
Medigap
filing status and reporting .............................................. 241
Merge
patient records............................................................... 118
Modifier
default............................................................................ 185
e&m default ................................................................... 185
setting requirement for abn ............................................. 63
setting requirement for e&m ............................................ 63
Modifiers ............................................................................. 57
billing professional and technical automatically.... See CPT
Panels
billing technical and professional codes automatically .. 325
default for an order ....................................................... 63
in charge entry using keyboard ..................................... 175
Move Credit....................................................................... 208
default adjustment code ................................................ 209
MVA .................................................................................. 332
Narrative
cpt.................................................................................. 158
in edit cpt window .......................................................... 158
Navigation ............................................................................. 6
Main Window..................................................................... 7
Newsgroups .......................................................................... 4
NM Button ......................................................................... 176
No Credits
checkbox ....................................................................... 236
No Show
creating charge item.............................. See Custom CPTs
worklist .......................................................................... 284
Non-Staff Providers........................................................... 134
Notes
collections/invoice/payment........................................... 212
NSF
hao record narrative ...................................................... 158
NSF Definitions ................................................................. 229
field types defined ......................................................... 231
NSF Fee
creating charge item.............................. See Custom CPTs
Nursing Homes ...................... See External Medical Facilities
adding............................................................................ 104
linking to claim............................................................... 105
Occurrence Codes ............................................................ 172
Open Item Accounting ...................................................... 145
Order Routing
default facility/department............................................ 63
specifying in-house/send-out........................................... 63
Origin ID .............................................................................. 94
Panel
hcpcs, creating ................................................................ 56
Parent Button
icd-9 search..................................................................... 37
Pass Through Billing ............... See Purchased Services, See
Purchased Services
Patient
copying patient files....................................................... 118
insurance....................................................................... 114
merge ............................................................................ 118
payments ....................................................................... 196
photograph .................................................................... 117
Patient Case Management ............................................... 292
Patient Education................................................................ 78
adding search keywords.................................................. 79
adding translations .......................................................... 79
adding, copying and importing ........................................ 78
printing............................................................................. 79
Patient Employers............................................................. 116
Patient Recall Types
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master table .....................................................................78
Patient Types.......................................................................31
adding ..............................................................................32
linking to patients .............................................................32
Patients
editing ............................................................................112
patients, adding .................................................................106
Payment
accept electronic..........................................................260
distribution grid cells ......................................................164
posting using eob...........................................................167
red electronic remittance................................................258
revoke electronic............................................................260
Payment Date
electronic remittance......................................................260
Payment Entry ...................................................................189
Payment Type .....................................................................32
Payments
check search..................................................................211
deleting ..........................................................................204
electronic........................................................................255
fifo function.....................................................................198
insurance batch..............................................................193
lifo function ..................................................................198
patient - posting to multiple invoices ..............................197
patient - posting to one invoice ......................................196
patient/guarantor............................................................196
posting at check out .......................................................193
posting to multiple invoices ..See Show Guarantor Invoices
prorate - when to use...................................................197
prorate function ..............................................................198
Payments Tab ...................................................................161
Pending Referral Work List ...............................................276
Performing Provider.......................... See Rendering Provider
Person Merge
suspect lists ...................................................................119
Persons .............................................................................136
Phone Numbers...................................................................99
Photograph
patient ............................................................................117
Physicians .........................................................................130
Policies ................................................................................88
Policy
category ...........................................................................89
Policy Alerts
in cpt/hcpcs alert ............................................................184
Policy Requirement
marking as complete/incomplete ...................................296
Post-back
electronic........................................................................255
Posting Batch Numbers.....................................................210
activating/deactivating....................................................210
Posting Charges
auto from daily work list .................................................179
auto from visits window..................................................178
manually.........................................................................173
Posting Date
changing ........................................................................320
Posting Window
invoice column headings................................................147
Poverty
adjustment prompt when saving invoice........................180
Poverty Discounting...........................................................319
Poverty Guidelines ..............................................................92
Pre Payment......................................................................190
deleting ..........................................................................193
entering ..........................................................................191
post to invoice ................................................................192
printing report.................................................................193
Precertification...................... See Referrals or Authorizations
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Primary ICD
setting invoice................................................................ 175
printing statements............................................................ 187
Procedure
unlisted .......................................... See Unlisted Procedure
procedures
access demographics organization insurance .............. 142
access Demographics Organization/Empoyers ............ 138
access demographics person insurance ....................... 141
access demographics provider...................................... 139
access guarantor/policy holder organizations ............... 140
activate or deactivate batch numbers............................ 210
add a policy requirement ................................................. 89
add a provider ............................................................... 131
add a recall type .............................................................. 78
add a revenue code......................................................... 76
add category for custom CPTs........................................ 48
add contact information ................................................. 116
add CPT codes to Short List ........................................... 45
add custom words and macros ..................................... 290
add guarantor manually................................................. 122
add HCPCS codes to Short List ...................................... 51
add ICD 9 ccodes to short list ......................................... 39
add insurance class......................................................... 93
add insurance companies ............................................. 125
add insurance groups.................................................... 130
add internal medical facilities ........................................ 101
add new patient after searching .................................... 107
add or delete a CPT keyword.......................................... 46
add or delete HCPCS keyword ....................................... 52
add or delete ICD 9 keyword........................................... 40
add or edit a case.......................................................... 299
add or edit a medical facility .......................................... 104
add or edit comments...................................................... 28
add or edit contact and link to patients.......................... 136
add or edit employer...................................................... 137
add or edit financial groups ............................................. 31
add or edit medical facility types ..................................... 94
add or edit modifiers........................................................ 57
add or edit payment or adjustment type .......................... 33
add or edit specialty codes.............................................. 93
add or edit telephone and address types ........................ 95
add or update an insurance contract............................... 84
add patient employment information ............................. 116
add patient insurance coverage information ................. 114
add patient types ............................................................. 32
add provider fax contact to patient account................... 113
add referral type/invoice split range ................................ 33
add referring physician or rendering provider................ 134
add self guarantor while adding patient......................... 122
add, edit or delete case dispositions ............................... 95
add, edit or delete CPT Alternate Description ................. 46
add, edit or delete CPT categories.................................. 47
add, edit or delete CPT codes......................................... 47
add, edit or delete HCPCS Alternate Description............ 51
add, edit or delete HCPCS categories ............................ 53
add, edit or delete HCPCS codes ................................... 53
add, edit or delete ICD 9 Alternate Description ............... 39
add, edit or delete ICD categories................................... 41
add, edit or delete ICD codes.......................................... 41
add, edit or remove a modifier from a group ................... 57
add/update CCI data to Solution Series database ........ 313
apply a balance to the deductible.................................. 321
apply Alternate ID for financial groups ............................ 31
archive a contract ............................................................ 88
archive fee schedules...................................................... 75
audit invoices for CCI errors .......................................... 314
batch post insurance payments..................................... 194
build insurance fee schedule and manually enter fees ... 69
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build insurance fee schedule and use alert button to add
fees...............................................................................69
build insurance fee schedule based on Medicare fee
schedule .......................................................................68
change city/state association with zip code .....................28
change CMS definitions .................................................223
change HCFA definitions ...............................................221
change insurance filing method .....................................239
change reason code auto post setting.............................77
change the rendering provider on a claim .....................318
close a financial period ..................................................205
configure file type options ..............................................244
configure general options ..............................................249
copy a policy ....................................................................90
copy CPT keywords to other codes .................................46
copy fee schedule ............................................................61
copy HCPCS keywords to other codes............................52
copy HCPCS links............................................................57
copy keywords to other codes .........................................40
correct spelling errors ....................................................291
create a charge set ........................................................263
create a collection work list ............................................279
create a CPT panel ..........................................................76
create a CPT/HCPCS link or panel..................................56
create a database diagram ............................................358
create a deposit custom CPT.........................................207
create a new electronic claim file ...................................236
create a referral authorization ........................................274
create a Superbill ...........................................................266
create a suspect list .......................................................119
create a work list ............................................................283
create an invoice status code ..........................................82
create an NSF definition ................................................230
create and print new claim batch ...................................218
create auto-complete pairs/macros on the fly................291
create batch number for a transaction ...........................210
create new fee schedule ..................................................60
create or import patient education handouts ...................78
create patient records using Copy key ..........................118
create sliding scale discount structure .............................91
delete a batch ................................................................220
delete a distribution record.............................................204
delete a panel or code in a panel.....................................76
delete a pre payment .....................................................193
delete a Superbill ...........................................................267
delete all CPT fees in a schedule ....................................74
delete an HCPCS link ......................................................56
delete entire payment ....................................................204
delete fee schedule..........................................................74
delete insurance companies ..........................................129
delete people from a suspect list ...................................119
delete providers .............................................................134
delete single CPT fee.......................................................74
designate a patient's race as multi-racial.......................113
download CCI edit updates............................................313
edit insurance companies ..............................................129
edit or delete a patient account......................................112
edit or delete a work list .................................................281
edit or delete CMS definitions ........................................224
edit or delete HCFA definitions ......................................222
edit providers .................................................................133
enable/disable dictionaries from the Tools menu ..........290
enter a deposit ...............................................................208
enter a follow-up action....................................................81
enter a pre payment.......................................................191
enter and copy collections notes ...................................212
enter insurance company information..............................94
generate an audit trail from Reports menu ....................305
launch the Command Line Generator............................252
link a class to a company.................................................93
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link a default revenue code to a CPT/HCPCS code........ 77
link a medical facility to a claim ..................................... 105
link fee schedules to insurance ....................................... 67
link form scanned in DocMan to alert task .................... 309
link patient types to patients ............................................ 32
link to patients or guarantors ......................................... 137
log in and out of dashboard............................................. 22
log in/open Schedule....................................................... 26
log out of dashboard........................................................ 22
make a courtesy adjustment ......................................... 322
make a provider inactive ............................................... 134
manually receive files with Clearing House Interface.... 254
manually send files with Clearing House Interface........ 253
manually split charges into separate invoices ............... 213
merge people using the suspect list .............................. 119
merge persons .............................................................. 120
modify a zip code ............................................................ 80
modify invoice preparation ............................................ 173
move a credit between invoices .................................... 209
obtain RVU table update ................................................. 73
post a patient/guarantor payment in multiple invoices .. 198
post a payment at checkout .......................................... 193
post a pre payment to invoice charges.......................... 192
post patient payment to individual invoice..................... 196
preview Billing Audit Report .......................................... 306
preview Summary Productivity Report .......................... 307
print a pre payment audit report .................................... 193
print a single claim from an invoice ............................... 220
print a single claim from the HCFA Wizard ................... 220
print an invoice notes history report .............................. 213
print authorization sheet ................................................ 277
print individual Superbills using Schedule Check In module .... 269
print list of electronic claims with filing holds ................. 238
print list of paper claims with a filing hold ...................... 220
print patient education documents .................................. 79
print Referral Compliance Report.................................. 276
print single Superbills from Daily Work List ................... 269
print single Superbills in Bill........................................... 269
print statements for guarantors ..................................... 187
print Superbills in batches or ranges ............................. 268
print UB-04 claims ......................................................... 227
print UB-92 claims ......................................................... 227
reactivate an inactive facility.......................................... 103
reactivate previously built electronic claims .................. 238
rebuild an electronic batch file............................... 236, 238
remove application from dashboard bar.......................... 23
remove Zip Code formatting.......................................... 225
replace a scan ............................................................... 167
reprint a paper claim batch............................................ 219
reset CMS definitions .................................................... 224
reset HCFA definitions .................................................. 222
retrieve a saved work list............................................... 280
retrieve data by batch number....................................... 211
reverse a charge ........................................................... 199
reverse a payment or adjustment.................................. 203
satisfy forms-based tasks.............................................. 308
save a collectons work list............................................. 280
scan or import an EOB or check ................................... 166
search before adding new patients ............................... 106
search by ICD 9 code...................................................... 37
search for CPT codes by keyword .................................. 43
search for CPT codes by outline ..................................... 43
search for HCPCS codes by keyword ............................. 49
search for HCPCS codes by outline................................ 49
search for payment source by check number ............... 211
search for payment source by credit card number ........ 211
search for records in a database..................................... 11
search ICD 9 codes by keyword...................................... 36
search ICD 9 codes by outline ........................................ 36
select a custom dictionary ............................................. 291
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set a recall for a patient..................................................315
set ANSI batch as test ...................................................240
set default internal medical facility .................................103
set dictionary options .....................................................290
set dictionary options on the fly .....................................290
set EDI options...............................................................232
set NSF batch as test.....................................................239
set personal window position .........................................167
set size preferences.......................................................167
set up a Clearing House ................................................233
set up and view subsequent payments..........................167
set up code-based rules and rule types ...........................62
set up dashboard applications .........................................23
set up dashboard preferences .........................................23
set up default move credit adjustment code ..................209
set up electronic claims and remittances .........................18
set up policy and requirements ........................................89
set up recall types ..........................................................315
take patient photograph .................................................117
track user productivity with report ..................................305
transfer invoice balance to patient .................................322
transfer invoice responsibility.........................................264
unlink a chart or invoice from an appointment ...............289
update GPCI and conversion factors in RVU formula .....74
update invoice status codes ..........................................264
use a charge set ............................................................263
use a CPT panel ..............................................................76
use an existing batch number ........................................210
use Daily Work List to auto post charges ......................179
use Quick Steps to post charges manually....................177
use Visits window to auto post charges .........................178
view a scan ....................................................................167
view and print Superbill Audit ........................................270
view data for an inactive facility .....................................103
view filters for auditable events......................................302
write off copayment........................................................322
Procedures
not covered by insurance...............................................321
Process Alerts
how fired ........................................................................183
Process Alerts/ABN
satisfying prompts ..........................................................184
warning window .....................................................180, 182
Production Tracking
using posting batch # .....................................................210
Professional
billing automatically with technical ............ See CPT Panels
Professional Modifier
billing automatically........................................................325
Prorate
using to post patient payments ......................................198
when to use ..................................................................197
Provider
alternate ID HCFA Definition..................................222, 224
credentialed with insurance ...........................................317
supervisor ......................................................................130
Provider 2nd ID..................................................................235
Provider Alternate IDs
creating an NSF definition..............................................231
Provider Not Approved
invoice error message....................................................317
Providers
deleting ..........................................................................134
editing ............................................................................133
Purchased Services
flagging charges.............................................................158
setting manually in edit cpt window................................177
Reason Codes.....................................................................77
Recall.................................................................................315
reporting options ............................................................315
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setting for patient........................................................... 315
setting up types ............................................................. 315
Recall Types
master table..................................................................... 78
Receipt
print button in posting .................................................... 148
printing........................................................................... 211
Receiver ID
ansi clearing house ....................................................... 235
Red
codes in invoice............................................................. 179
electronic remittance payment ...................................... 258
Red Icon
in posting M column ...................................................... 147
Reference
city, state, zip................................................................... 80
follow up action................................................................ 80
specialty codes ................................................................ 93
Reference ID Qualifier ...................................................... 235
Reference Tables
city, state, zip................................................................... 28
comments ........................................................................ 28
financial groups ............................................................... 29
modifiers .......................................................................... 57
payment type ................................................................... 32
referral types ................................................................... 33
Referral
unauthorized codes cpt/hcpcs alert .......................... 184
window .......................................................................... 272
Referral Compliance ......................................................... 276
Referral Management ....................................................... 270
Referral Report ................................................................. 272
Referral Status
tracking.......................................................................... 270
Referral Tracking .............................................................. 271
Referral Type
tracking.......................................................................... 270
Referral Types .................................................................... 33
Referral Workflow ............................................................. 274
Referral/Authorization Report ........................................... 276
Referrals
adding............................................................................ 274
adding to invoices.......................................................... 270
linking to claims ............................................................. 136
work list ......................................................................... 276
worklists......................................................................... 272
Referring Physician
adding............................................................................ 134
Refresh Button
in super bill printing ....................................................... 269
Refund Checks
finding credits in collections........................................... 280
Relationship Codes............................................................. 95
Reminder Cards .....................................................See Recall
Remittance
basic steps .................................................................... 258
electronic ....................................................................... 255
importing files ................................................................ 259
posting........................................................................... 259
setup.............................................................................. 256
Rendering Provider
adding............................................................................ 134
attaching to a claim ....................................................... 171
explained ....................................................................... 318
Report
referral ........................................................................... 272
Reports ................................................................................. 9
code match.................................................................... 288
collections list ................................................................ 282
collections work list crystal report.................................. 282
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daily work list..................................................................288
hcfa batch summary.......................................................219
invoice............................................................................211
invoice notes history ......................................................213
receipt ............................................................................211
referral sheet..................................................................277
referral/authorization ......................................................276
Requirement, Policy
marking as completed....................................................296
Requirements
policy................................................................................88
Reset Worklist ...................................................................282
Responsibility
change on invoice ..........................................................148
Responsible Party ........................................... See Guarantor
Revenue Code
setting roll up .................................................................63
Revenue Codes...................................................................76
Revoke Payment ...............................................................260
Route Slips .....................................................See Super Bills
Rural Health Claims.............................See UB-92 and UB-04
RVU
fee schedule based on ..................................................61
total in cpt grid................................................................159
RVU Tables
updating ...........................................................................73
Scan
replacing existing ...........................................................167
viewing and posting at same time..................................167
Scanning
abns and forms ..............................................................307
checks & eobs................................................................166
contracts ..........................................................................84
insurance cards..............................................................117
Schools
adding for patient ...........................................................116
Search Screens ...................................................................10
Searching ............................................................................10
Secondary Insurance
filing................................................................................240
medigap .........................................................................241
Security Information...........................................................235
Segment Terminator
ansi ................................................................................234
Self Button
in patient file...................................................................122
Sender ID
ansi 837 .........................................................................235
Services Not Covered........................................................321
Set Completed
electronic remittance file ................................................261
Setup
CMS-1500......................................................................223
CMS-1500 (12/90) .........................................................221
Shortcuts .............................................................................14
Show Guarantor Invoices ..................................................145
using to post payments ..................................................198
Show Locked .....................................................................145
Sliding Scales ......................................................................91
adjustment prompt when saving invoice........................180
Snapshot ...........................................................................117
Spanish
patient eduction handouts................................................78
Specialty Codes...................................................................93
Spell Check .......................................................................289
adding words..................................................................290
choosing dictionaries .....................................................290
excluding words .............................................................290
macros ...........................................................................290
options ...........................................................................290
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Split
codes into separate invoice........................................... 160
Splitting Charges............................................................... 213
Splitting Claims
professional/technical.................................................... 326
Splitting Codes
professional/technical.................................................... 325
Star Codes
cpt.................................................................................... 48
Starred Codes
entering in invoice ......................................................... 175
Statement
printing from remittance............................................. 260
Statement Comment
display in posting window.......................................... 149
Statements
mailing to non-home address ........................................ 124
statements, printing........................................................... 187
Status Codes .................................See Invoice Status Codes
Subelement Separator
ansi ................................................................................ 234
Super Bill
audit............................................................................... 269
entering audit number in invoice ................................... 269
Super Bills
creating.......................................................................... 265
print controls .................................................................. 267
print selected/range....................................................... 269
printing at check in ........................................................ 269
printing from daily work list ............................................ 269
printing individually ........................................................ 269
red display ..................................................................... 269
Supervisor Field in Provider File ....................................... 130
Tax
setting taxable codes....................................................... 63
Technical Modifier
billing automatically ....................................................... 325
Telephone Numbers ........................................................... 99
Telephone Types ................................................................ 95
Testing Electronic Claims ................................................. 239
Title
invoice ........................................................................... 147
To release an invoice from collections status ................... 278
To set an invoice to collections status .............................. 278
Tools
charge sets .................................................................... 263
invoice payment due by................................................. 264
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invoice status administration..........................................264
topsSearch ICD-9 ................................................................34
Troubleshooter ....................................................................4
Type
insurance .........................................................................94
medical facility..................................................................94
patient ..............................................................................31
UB-04
field data sources...........................................................345
UB-92
box 42 - revenue code .....................................................76
boxes 32-36 - occurrence codes ...................................172
data lookup table............................................................343
revenue codes .................................................................76
UB-92 and UB-04 ..............................................................225
box 51 - provider numbers .............................................226
box 85 - prov rep ..........................................................226
flagging claims for printing .............................................227
printing ub-04 claims......................................................227
Unlinked Insurance .........................................................259
Unlinked Invoice ..............................................................259
Unlinked Patient ..............................................................259
Unlisted Procedure
setting description in invoice ..........................................159
Unofficial CPT Codes ..........................................................48
Utilities
Super Bills......................................................................265
Visit Reasons
creating alerts/rules......................See Fee Schedule Rules
Visits Button.......................................................................147
Warnings
duplicated cpts ...............................................................180
Window Sizing & Positioning ...............................................14
Withhold
system described ...........................................................329
WMC..................................................................................332
Word Forms
linking to cpt .....................................................................63
Work List
abn/forms manager........................................................307
columns....................................See Daily Work List Sorting
Workers' Compensation ....................................................332
Workflow
billing..............................................................................149
referrals/authorizations ..................................................274
Zip Code Maintenance ........................................................80
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